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Preface

This content describes WebFOCUS App Studio, a Windows®-based GUI development
environment for creating WebFOCUS applications. App Studio provides innovative features and
functions that simplify development, thereby allowing you to concentrate on interface design,
business logic, and data manipulation. Features include data visualization, color exception
reporting, intelligent drill downs, and the ability to generate HTML pages without writing code.

How This Manual Is Organized

This manual includes the following chapters:

Chapter/Appendix Contents

1 Introducing WebFOCUS App
Studio

Introduces WebFOCUS App Studio.

2 Navigating in App Studio Identifies the main components of the App Studio
interface.

3 Creating Metadata Describes how to create and edit metadata in App
Studio.

4 Creating Reports Describes how to launch the Report Wizard to
create reports, the types of reports you can create
with App Studio, and the tabs and panels that are
available when you are developing reports in the
Report canvas.

5 Creating Charts and
Visualizations

Describes how to launch the Chart Wizard to create
charts and the types of charts you can create with
App Studio.

6 Creating Procedures Describes the Join tab, creating and working with
joins, creating procedures, and the Procedure View
panel.

7 Creating HTML Pages Describes how to launch the HTML/Document
Wizard, and how to create and edit HTML pages.

8 Creating Documents Describes how to launch the HTML/Document
Wizard, and how to create and edit documents.
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Chapter/Appendix Contents

9 Creating Maintain Data
Applications

Describes how to use the Maintain Data App and
create Maintain Data applications using the HTML
canvas.

10 Creating Esri Maps Describes how to create Esri maps in App Studio.

11 Working With Source Control Describes how to implement Source Control in App
Studio.

A Creating, Viewing, and Editing
Source Syntax

Describes the Text Editor that is available when you
are developing the source syntax for procedures,
procedure components, and other types of files.

B Selenium Browser Support Describes Selenium browser support and tier setup.

C Troubleshooting Provides troubleshooting tips and information on
using verification and tracing tools.

Conventions

The following table describes the conventions that are used in this manual.

Convention Description

THIS TYPEFACE

or

this typeface

Denotes syntax that you must enter exactly as shown.

this typeface Represents a placeholder (or variable) in syntax for a value
that you or the system must supply.

underscore Indicates a default setting.

this typeface Represents a placeholder (or variable), a cross-reference, or
an important term. It may also indicate a button, menu
item, or dialog box option that you can click or select.

Key + Key Indicates keys that you must press simultaneously.

Conventions
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Convention Description

{  } Indicates two or three choices. Type one of them, not the
braces.

[  ] Indicates a group of optional parameters. None are
required, but you may select one of them. Type only the
parameter in the brackets, not the brackets.

| Separates mutually exclusive choices in syntax. Type one of
them, not the symbol.

... Indicates that you can enter a parameter multiple times.
Type only the parameter, not the ellipsis (...).

.

.

.

Indicates that there are (or could be) intervening or
additional commands.

Related Publications

Visit our Technical Documentation Library at http://documentation.informationbuilders.com. You
can also contact the Publications Order Department at (800) 969-4636.

Customer Support

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a
message board. It is an interactive network of more than 3,000 developers from almost every
profession and industry, collaborating on solutions and sharing tips and techniques. Access
Focal Point at http://forums.informationbuilders.com/eve/forums.

You can also access support services electronically, 24 hours a day, with InfoResponse
Online. InfoResponse Online is accessible through our website, http://
www.informationbuilders.com. It connects you to the tracking system and known-problem
database at the Information Builders support center. Registered users can open, update, and
view the status of cases in the tracking system and read descriptions of reported software
issues. New users can register immediately for this service. The technical support section of 
www.informationbuilders.com also provides usage techniques, diagnostic tips, and answers to
frequently asked questions.

Preface
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Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212)
736-6130. Customer Support Consultants are available Monday through Friday between 8:00
a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can
also give you general guidance regarding product capabilities. Please be ready to provide your
six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders
representative about InfoResponse Online, or call (800) 969-INFO.

Information You Should Have

To help our consultants answer your questions effectively, be prepared to provide the following
information when you call:

Your six-digit site code (xxxx.xx).

Your WebFOCUS configuration:

The front-end software you are using, including vendor and release.

The communications protocol (for example, TCP/IP or HLLAPI), including vendor and
release.

The software release.

Your server version and release. You can find this information using the Version option
in the Web Console.

The stored procedure (preferably with line numbers) or SQL statements being used in
server access.

The Master File and Access File.

The exact nature of the problem:

Are the results or the format incorrect? Are the text or calculations missing or
misplaced?

Provide the error message and return code, if applicable.

Is this related to any other problem?

Has the procedure or query ever worked in its present form? Has it been changed recently?
How often does the problem occur?

What release of the operating system are you using? Has it, your security system,
communications protocol, or front-end software changed?

Information You Should Have
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Is this problem reproducible? If so, how?

Have you tried to reproduce your problem in the simplest form possible? For example, if you
are having problems joining two data sources, have you tried executing a query containing
just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do
you just have questions about functionality or documentation?

User Feedback

In an effort to produce effective documentation, the Technical Content Management staff
welcomes your opinions regarding this document. You can contact us through our website, 
http://documentation.informationbuilders.com/connections.asp.

Thank you, in advance, for your comments.

Information Builders Consulting and Training

Interested in training? Information Builders Education Department offers a wide variety of
training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit
our website (http://education.informationbuilders.com) or call (800) 969-INFO to speak to an
Education Representative.

Preface
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Chapter1
Introducing WebFOCUS App Studio

WebFOCUS is a complete, web-ready data access and reporting system that connects
users to data. It accesses and processes information located in any format, on any
platform, and presents that information to end users through a web browser.

Business intelligence (BI) needs continue to evolve, as organizations seek to make more
information from more sources available to more people inside and outside the
enterprise. Developers need powerful, yet flexible tools in order to satisfy the increasingly
sophisticated BI content demands posed by a growing number of employees, customers,
suppliers, partners, and other stakeholders.

WebFOCUS App Studio is the Windows-based graphical user interface (GUI) environment
for creating advanced ReportCaster applications. WebFOCUS App Studio is the most
robust BI application development platform on the market today.

In this chapter:

What Is App Studio?

Launching App Studio

Documentation Overview

What Is App Studio?

Building on the industry-familiar Microsoft Office Ribbon Interface, App Studio offers a
simplified user experience and workflow, empowering developers to create application content
immediately, without a costly and time-consuming learning curve. Additionally, it dramatically
increases development efficiency by eliminating the need for developers to utilize multiple
tools to piece together a BI application.

App Studio provides:

Rapid deployment. Installation and setup are fast and simple.

Ease of use. A familiar ribbon interface, which can be customized to individual preferences,
allows users to get up to speed quickly.
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Maximum flexibility. Build and deploy ad hoc or instant queries that go beyond the
prescriptions of any particular application. Developers can also add dimensions to data
structures at any time without affecting other queries, since the underlying data source is
not changed.

Support for complex requests. Unlike other BI development environments, which require
the use of complex code to handle anything more than the most simple of requests, App
Studio allows users to create any request, no matter how sophisticated, using the same
intuitive interface.

App Studio eliminates the complex multi-tool paradigm that exists with most other
development solutions, providing a single, fully-integrated environment for rapidly designing
and creating reports, dashboards, InfoApps, and other types of BI apps and content, including:

Income statements, balance sheets, and other types of tabular or financial reports.

Charts and visualizations. A library of more than 120 HTML5 chart types meet the needs of
every information consumer.

Dashboards that draw data from one source, or multiple disparate systems. Dashboards
can be viewed online or offline in disconnected mode, with full interactivity and analytical
capabilities.

Documents for print, including Adobe PDF, interactive PDF, Microsoft PowerPoint, and more.

InfoApps, business intelligence applications that are form-driven and extremely simple to
use, providing the most effective way to make information accessible to all stakeholders,
as well as for custom and SaaS implementations.

Mobile BI applications that run on any device and on any platform.

Responsive designs that conform to the device form factor, maximizing the user
experience.

Metadata creation and modeling, such as multifact star schemas, joins, and business
views.

App Studio Capabilities

In App Studio, you can do the following:

Access data and descriptions. Using the Metadata canvas, you can create new synonyms,
and view or modify existing synonyms, in a graphical user interface. Synonyms enable you to
access and interpret data sources for use in reporting applications. Capabilities include
metadata design and development, with full visual modeling of schemas.
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Create reporting applications. Build reporting procedures in the Report Canvas, Chart Canvas,
HTML Canvas, or Document Canvas, which can include the following components.

Reports. Display your data in a tabular format. You can create stand-alone reporting
procedures, or add the report to a document or an HTML page.

Charts. Communicate your data in a more illustrative format. You can translate complex
data into an easy-to-read and understandable visual format. This often provides a new
perspective to the information that users view. You can create stand-alone charting
procedures or add the chart to a document or an HTML page.

HTML pages. Build webpages for users to launch, view, and analyze data. You can add
multiple reports and charting procedures to an HTML page, in addition to the controls that
enable you to manipulate the data. You can also apply styling through the use of cascading
style sheets (CSS), JavaScript files, and jQuery animations.

Documents. Combine multiple report and charting procedures in a single output that you
can organize and format. You can also add pre-process and post-process codes to
customize how your document is executed.

Visualizations. Create charts, maps, and grids to visually represent your data. You can add
multiple visuals to the canvas to create a complete visualization, and you can update,
change, or revise the visualization at any time to account for shifts in data needs.

Alerts. Create event-driven procedures that apply test conditions and then trigger
customized reports if the test conditions are true. You can schedule an Alert using
ReportCaster Distribution Methods.

Reporting Objects. Transform complex views of data into simple objects that are labeled
with common business terminology for users to understand and use as templates to create
their own reports.

Customize reporting applications. In addition to customizing your reporting applications by
applying styling and color, you can add the following components to a procedure.

Virtual fields (DEFINE or COMPUTE statements). Create temporary fields that are treated
as real fields stored in the data source.

Define functions. Create user functions that you can use in components of a procedure.
You can retrieve your stored functions from the Functions Arguments dialog box.

Joins. Define relationships between two or more data sources so that a report can use the
data from all sources at once. You can also merge data sources by creating logical
expressions on the Match canvas.
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Manage your environment. You can apply the following functions to your reporting applications
to change the behavior of your environment.

Set. Control the way that reports and charts appear on the screen or printer, the content of
reports and charts, data retrieval characteristics that affect performance, and system
responses to user requests. The Set component also helps you to set up your metadata
and manipulate information, such as dates. Use the Set component to override default
settings for your procedure.

Allocation. Assign logical names and storage locations to the files that you create and use
in WebFOCUS.

Use. Identify a FOCUS data source to use in your procedure.

WebFOCUS Architecture

This topic briefly explains the main WebFOCUS components and implementations. For a
complete description of WebFOCUS, see the WebFOCUS documentation.

WebFOCUS and Your Network

WebFOCUS integrates into your existing network by connecting your web server to your data.
End users access WebFOCUS applications through a web browser, so they need only the
following elements:

Web browser. To access WebFOCUS applications, users need a browser and a TCP/IP
connection to a web server.

Web server. Web servers handle requests by returning files to a browser or by executing
processes that provide additional functionality. You can provide WebFOCUS functionality by
connecting to the web server using Java servlet calls.

Data. WebFOCUS can access data from almost anywhere. Once you have configured data
access and described that data, you can report on it.

WebFOCUS Components

There are two main WebFOCUS components.

WebFOCUS Client. The WebFOCUS Client resides on the web server and connects
WebFOCUS to the web through Java servlets. When a user makes a request from App
Studio or a browser, the WebFOCUS Client receives and processes the request by passing
it to the Reporting Server.
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Note: When you perform a full App Studio installation for stand-alone development, you do
not have to install the WebFOCUS Client separately because it is packaged with App
Studio.

A stand-alone development environment is typically one in which all software components
(the web server, WebFOCUS Client, and Reporting Server) are installed on the same local
machine. This configuration gives you access to all your application files and data from a
single machine. You do not need a physical network connection to access any other
machine in order to accomplish your development tasks.

WebFOCUS Reporting Server. The Reporting Server resides on machines that can access
your data. The Reporting Server provides data access, number crunching, and report
generation functionality. 

WebFOCUS Configuration

WebFOCUS employs a distributed architecture, so the WebFOCUS Client, Reporting Server, and
your data can be located on any platform, anywhere in your network.

You can easily connect an Apache® web server running on UNIX to SQL Server data on
Windows, or Db2 data on z/OS. Any number of WebFOCUS Reporting Servers can be
connected to the WebFOCUS Client. WebFOCUS can report on all of them. 

Configuring a distributed architecture requires the following:

The WebFOCUS Client must reside on a machine with a web server.

An instance of the Reporting Server must be installed on machines with your data, or
machines that have access to your data.

App Studio Architecture

This topic briefly explains the main App Studio components and implementations. 

WebFOCUS App Studio includes the following components:

App Studio Graphical User Interface (GUI). Graphical development and code generation
features for application development.

WebFOCUS Reporting Server. A basic Reporting Server for local processing, stand-alone
development, access to data, report generation, chart generation, and running requests.

WebFOCUS Client. A scaled-down WebFOCUS Client with available functionality that is
based on the App Studio edition you license.
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Derby database. An embedded database that stores user accounts and policies required
for the connection of App Studio to its local WebFOCUS Client. Derby is only installed in
App Studio editions that are licensed for local/stand-alone development. It is used for
authentication, and comes with preloaded user IDs that possess developer and
administration permissions.

Note: If you install App Studio on the same machine as WebFOCUS 8, you can configure
App Studio to utilize the WebFOCUS 8 Derby database.

Reference: App Studio Directory Structure

This topic references the App Studio directory structure created after installation. The default
directory is drive:\ibi. 

\apps

Contains directories and data. By default, this is the Application Root directory (APPROOT
directory) in which WebFOCUS searches for application files. Sample files are provided in
the \ibinccen and \ibisamp directories.

The Application Root directory is created during the installation of App Studio and the
WebFOCUS Reporting Server.

It is defined by the APPROOT variable in the server configuration file, edaserve.cfg, and the
IBI_Approot_Directory variable that is defined during the WebFOCUS installation. These
variables point to the Application Root directory for applications that reside on the web
server where WebFOCUS is installed.

For Project-based development (optional), the Application Root directories must point to
the same location. 

\AppStudio82

Contains the graphical front-end components for creating App Studio content.

\AppStudio82\srv\home

Contains the local Reporting Server files.

\AppStudio82\derby

Contains the Derby database files.

For more information, see the App Studio Directory Structure topic in the WebFOCUS App Studio
Installation and Configuration Guide.
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WebFOCUS and App Studio Processing

The following figure illustrates how WebFOCUS and App Studio process requests. Each step is
explained below the figure.

1. A user makes a request and passes parameters by calling a WebFOCUS Servlet through
links and forms on a webpage, or through App Studio.

2. The request and parameters come to the WebFOCUS Client on the web or application
server, which processes the parameters and creates a request for the Reporting Server.

3. The Reporting Server receives the request, processes it, and accesses any necessary data.

4. Data is retrieved from data sources to process the request.

5. The Reporting Server processes the user request using the retrieved data.

6. The response is returned to the WebFOCUS Client on the web or application server.

7. The response is returned to the user.

App Studio processes requests the same way that WebFOCUS does:

To access WebFOCUS or a remote Reporting Server, App Studio calls a servlet on a remote
web or application server.

To process requests using the local WebFOCUS Client and Reporting Server installed with
App Studio, App Studio calls the local Reporting Server through a local web or application
server using a servlet. Therefore, to run reports locally, your machine requires a web server.

App Studio Development Modes

App Studio allows local (stand-alone) development and development against a remote
environment. From the Environments Tree panel, you can develop applications locally on your
machine, or against a remote WebFOCUS environment.

In App Studio, you build applications consisting of different kinds of files. You can create the
application as a stand-alone application in a development environment or as a web-based self-
service application.
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With a full App Studio installation, you can do the following:

Locally develop self-service applications from the Projects area (optional).

Stand-alone Project-based development requires installation of a Reporting Server on the
same machine as App Studio. A WebFOCUS Client is also required for Project-based
development. The files that you create for a local project reside in a subdirectory under
APPROOT as described earlier. In Project-based development, the Application Root
directories (APPROOT directories) must point to the same directory.

Connect to one or more remote servers and modify existing self-service applications on
those servers. For example, you can add a reporting procedure to an existing application.

Configure access to one or more WebFOCUS environments so you can manage resources
on the WebFOCUS Client and Reporting Server, and in the domain (if Managed Reporting is
installed). For example, you can create and edit procedures, metadata, HTML files, and
more.

Note: If you do not have a Reporting Server and WebFOCUS Client on your development
machine (for example, the Managed Reporting Application edition of App Studio), your
environment allows the last two capabilities.

Project-Based Development

Note: The Projects development node is hidden, by default. To show the Projects node in the
Environments Tree panel, from the App Studio Options dialog box, on the Environments tab,
select Show Projects area.

App Studio supports two configurations for Project-based development (optional): 

In the first configuration, App Studio, Reporting Server, and WebFOCUS Client are installed
on the same machine (a full installation). This WebFOCUS environment is referred to as
localhost, which describes your local machine.

Note: When configuring a WebFOCUS environment, provide a full domain for the host name,
including top-level domain name, second-level domain, and subdomains as specified by
your organization (for example, hostname.companyname.com). This format is recommended
to ensure that requests are properly resolved and redirected. In this environment, the
project files that you create reside in a subdirectory under the Application Root directory
(APPROOT directory).

For information about other required components that you must install, such as Java SDK
and a servlet engine, see the WebFOCUS App Studio Installation and Configuration Guide. All
required components are packaged with App Studio.

What Is App Studio?
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A full App Studio installation also allows Project-based development (optional) against a
remote WebFOCUS environment. In this case, App Studio does not utilize the local
Reporting Server or its local WebFOCUS Client. It utilizes these components from the
remote WebFOCUS environment.

In the second configuration, you can use a remote WebFOCUS installation for Project-based
development (optional). App Studio is installed on a local machine (a thin installation), and
the WebFOCUS components (which includes a Reporting Server and WebFOCUS Client that
resides on the web server) are installed on remote machines.

Use of a remote environment for Project-based development requires the following:

The Reporting Server must be at a supported release level.

The Reporting Server must be installed on a supported Windows or UNIX platform.

The Reporting Server and the WebFOCUS Client must be properly configured and the
APPROOT variable must point to the same physical location.

You must have read/write permission to the Reporting Server and the WebFOCUS Client.

Reference: Summary of Steps for Project-Based Development

To create a new project in the Projects node (optional), follow these steps:

1. Install App Studio. Use the installation program to install App Studio (this includes a
Reporting Server for stand-alone development) on your Windows machine.

2. Configure the web server. For local/stand-alone development, configure aliases and servlet
functionality on the local web server.

3. Configure communications and data access. Set up remote access to Reporting Servers,
and create or copy data source descriptions. You must also set up data adapters to access
other data sources, such as relational databases.

4. Create a project in the Projects node of the desired environment. Before you begin
Project-based development, you must create a project directory to store the associated
files. You create this directory using the Project Wizard.

Use the Project Wizard to name the project, designate a directory for it, and optionally, add
other directory paths from which the project can retrieve information or paths to other
resources.

Sample projects are provided for editions that allow local/stand-alone development. When
working against a remote WebFOCUS environment you do not see any sample projects, by
default.
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5. Create, develop, and test the project components. Open the project, create its
components (procedures, data source synonyms, HTML files, and related files), and
develop and test them on the Reporting Server and web server.

For more information about installing App Studio, configuring the web server, and configuring
communications and data access, see the WebFOCUS App Studio Installation and Configuration
Guide.

Remote Development

App Studio provides the following scenarios for remote development: 

Use the Data Servers area to develop applications directly on the Reporting Server and edit
resources in place against remote environments.

Use the domain area to access the Managed Reporting domain. From here, you can
develop and manage Managed Reporting applications against a configured WebFOCUS
environment.

Use the Web Applications area to manage resources on the web tier, and edit the
resources in place against remote environments. HTML pages, cascading style sheets
(CSS), and other web components can be stored in the Web Applications node. You can
view and modify files with an editor.

Reference: Summary of Steps for Remote Development

To create a new application on a server platform:

1. Install App Studio. Use the installation program to install App Studio on your Windows
machine.

2. Add a WebFOCUS environment. Add an environment from the WebFOCUS Environment
Properties dialog box. For more information, see How to Add a WebFOCUS Environment on
page 104.

3. Create an application folder on the server. Create the application folder in the Data
Servers area, or develop directly against the domain.

4. Create, develop, and test the application components. Open the application, create its
components (procedures, data source synonyms, HTML files, and related files), and
develop and test them on the Reporting Server and WebFOCUS Client.

Launching App Studio

Once you have installed App Studio, you can launch the product and begin developing
applications.

Launching App Studio
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You can launch App Studio in one of the following ways:

Launch App Studio and the App Studio Reporting Server at the same time. From the Start
menu, expand the Information Builders program group, expand the WebFOCUS App Studio
folder, and then click WebFOCUS App Studio. Both App Studio and the App Studio Reporting
Server start at the same time.

When App Studio starts, the Reporting Server installed with App Studio is started with
Security OFF.

Start your Reporting Server and then launch App Studio. If you have installed a stand-
alone version of App Studio, or a stand-alone Reporting Server for use with WebFOCUS, you
can start your Reporting Server before launching App Studio.

Stand-alone App Studio. From the Start menu, expand the Information Builders program
group, expand the WebFOCUS 82 App Studio folder, and expand the WebFOCUS 82
Server for App Studio folder. Select Start Security OFF to start the Reporting Server
without security, or Start Security ON to start the Reporting Server securely. The
Reporting Server opens a command window. Once the process is complete, launch App
Studio.

Stand-alone Reporting Server. From the Start menu, expand the Information Builders
program group, and expand the WebFOCUS 82 Server folder. Select Start Security OFF to
start the Reporting Server without security, or Start Security ON to start the Reporting
Server securely. The Reporting Server opens a command window. Once the process is
complete, launch App Studio.

Note: Additional configuration steps are required if you choose to start the Reporting Server
with Security ON. For more information, see the WebFOCUS App Studio Installation and
Configuration Guide.

When App Studio first opens, you may be prompted to sign in to your local host environment.
You can enter the ID, wfdesktop, with no password. For more information, see Navigating in
App Studio on page 39.

Note: If you have previously configured WebFOCUS environments on your machine, those
environments appear when you launch App Studio.

Documentation Overview

The following documentation components are available for App Studio users:

WebFOCUS App Studio Installation and Configuration Guide

WebFOCUS App Studio User’s Manual
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Context-sensitive online Help system

You can access the online Help system through the product. Press F1 on your keyboard or
click Help throughout the interface to open the Help window. The online Help system is
designed to provide you all of the information that you need to develop content in App
Studio.

Help Wizard

You can access the Help Wizard by selecting the Help Wizard check box in the View group
on the Home tab of the App Studio ribbon. By default, the Help Wizard panel opens in the
bottom-right corner of the interface. The Help Wizard content dynamically changes,
depending on where you are in the interface.

Documentation Overview
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Chapter2
Navigating in App Studio

App Studio provides an easy-to-use interface for creating applications, such as reports,
charts, HTML pages, and documents.

The first time you launch App Studio, a default interface opens. You can modify the
default interface by customizing the appearance of the application window and
rearranging the placement of the main interface components.

These changes are automatically saved and made available the next time you launch the
product.

In this chapter:

The App Studio Interface

Initiating App Studio

Opening the Application Menu of File-Related Commands

Accessing Frequently Used Commands

Developing Applications in the Canvas Area

Accessing Features With the Ribbon

Working With the Environments Tree Panel

Working With the Environments Detail Panel

Viewing File and Folder Properties

Editing Areas of Functionality Using the View Tabs

Customizing the Panels

The App Studio Interface

The main components of the default App Studio interface are shown in the following image. 
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The App Studio interface components are identified as follows:

Welcome screen. Provides access to resources that help you get started with the product
as you develop content. For more information, see Initiating App Studio on page 41.

Application button. Provides access to the Application menu of file-related commands. For
more information, see Opening the Application Menu of File-Related Commands on page
41.

Quick Access Toolbar. Displays frequently used commands, such as Open, Save, Quick
Print, Undo, Redo, Cut, Copy, Paste, and Run. For more information, see Accessing
Frequently Used Commands on page 59.

Ribbon. Displays both static and contextual tabs of commands that you can use to build
and customize applications. For more information, see Accessing Features With the Ribbon
on page 73.

Environments Tree panel. Provides access to the WebFOCUS environments you configure
and files you create under each development area. For more information, see Working With
the Environments Tree Panel on page 86.

Canvas. Provides an active preview of your application development. For more information,
see Developing Applications in the Canvas Area on page 63.

The App Studio Interface
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Initiating App Studio

When you initiate App Studio for the first time, the Welcome screen opens.

From the Welcome screen, you can access the Getting Started video, and a suite of how-to
videos that open within the software window. It also provides a direct link to the App Studio
resources that are available on the WebFOCUS 8.2.x Information Center.

You can select the Don’t show this dialog again check box to prevent the Welcome screen from
opening the next time you launch App Studio.

Note: You can also control the appearance of the Welcome screen through the Options dialog
box. For more information, see Setting User Preferences Using the Options Dialog Box on page
45.

Opening the Application Menu of File-Related Commands

The Application button, represented by the App Studio icon , opens the Application menu
of file-related commands. You can open an existing document, save an active document, and
print an active document. The Options button opens the App Studio Options dialog box, where
you can set user preferences. The Application menu also lists recently opened documents. The
Application button is always available. It is located in the upper-left corner of the App Studio
interface. 

Tip: Double-click the Application button to exit App Studio. If you exit App Studio in this way,
active (open) applications will not be saved.

From the Application menu, you can perform the following actions:

Open. Open an existing document. You can open a file from the list of configured
WebFOCUS environments.

Save. Save the active document.

Save As. Save the active document with a new name.

Save All. Save all open documents with the current file names. There will be no prompting
for file names.

Run. Run the report, chart, HTML page, or document. When you click the Run menu, the
Message Viewer Options submenu opens.
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From the Message Viewer Options submenu, you can select from among four Message
Viewer Options that affect the App Studio Viewer display when a report, chart, HTML page,
or document is run. The options are:

When you select Message Viewer OFF and run a report, the App Studio Viewer window
displays the report without any messages.

When you select Message Viewer ON and run a report, the App Studio Viewer window
displays the report and a message.

When you select Display command lines, the App Studio Viewer window displays the
report and the command lines.

When you select Display Dialogue Manager commands, the App Studio Viewer window
displays the report and the Dialogue Manager commands, and the result of their
evaluation.

Print. Print the active document. When you click the Print menu, the Preview and print the
document submenu opens.

From the Preview and print the document submenu, you can print the active document
using the current print options, preview the active document before printing, and configure
your print options.

Note: The Print and Quick Print options are only available when you edit content in the Text
Editor, or when the Source view tab, in the Report canvas, is active.

Close. Close the active document.

Close All. Close all open documents. If changes were made to a file, you will be prompted
to save the changes.

Options. Open the Options dialog box, where you can set user preferences.

Exit. Close the active document and exit App Studio.

Note:

In the Application menu, the terms document and active document represent all files which
you can create in App Studio.

Opening the Application Menu of File-Related Commands
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Spaces are not allowed in file names. When naming a report, chart, HTML page, or
document in their respective wizards or in the Save As dialog box, spaces are replaced with
underscores (_). When naming a procedure, spaces and underscores are not permitted,
and when you press the Space bar, nothing happens. If the domain is set to display by title,
the wizards, Open dialog box, and Save As dialog box will still expect a proper name, with
no spaces, to be entered.

Reference: Open File Dialog Box

The Open File dialog box opens when you click Open from the Application menu or the Quick
Access toolbar.

The Open File dialog box displays files that you can open and edit in App Studio.

Configured Environments list

Contains a list of currently Configured Environments. You can navigate to different
environments and development areas to display different files in the file list.

File list

Displays all files of a specific type in a selected folder and includes the name, size, type,
last modified date, location, database type, title, and status of the file.

Note: Instead of the regular Master File icon, Master Files that have a DEFINE use the
DEFINE icon and Master Files that have a Join use the JOIN icon.

Preview
Displays a preview of the contents in a selected file or a thumbnail preview of a selected
image.

File name text box

Use this text box to type the name of a file you want to open.

Note: If you are in the Domains area and the Configured Environments tree is set to
display by title, the Open File dialog box will only require a name to be entered.

File Type drop-down list

Filters to display all files of a specified file type. You can filter
for .fex, .htm, .js, .css, .prtl, .page, .blog, .sch, .adr, .ad, .sty, .mnt, .txt, and .lib. You can
also choose to display all files.

Use Qualified Path 

When selected, the fully qualified path name of the file you select will be used.

Note: This check box appears only in the Report and Chart Wizard.
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Show Tree

When selected, displays the Configured Environments tree. This option is only available
when opening a file using commands and features in the Report canvas, HTML canvas,
Document canvas, Join canvas, and the Procedure View panel.

Details Toggle

Toggles between displaying the files in the file list with details (date modified, size, and so
on) or in a list. Displaying files with details is the default.

Note: App Studio remembers your choice and will keep the setting you chose the next time
the Open File dialog box is open. For example, if you choose to display file details the first
time you invoke the Open File dialog box, then the next time you invoke the Open File
dialog box, file details are shown.

Refresh Button

When clicked, refreshes the list of available files.

Show All Files in Associated Paths

Available for files in Project folders only. Displays all files that are associated with the
parent folder, when selected. Only one option, Show all Files in Associated Paths or Show
Files in Selected Path Only, can be selected at a time.

Show Files in Selected Path Only
Available for files in Project folders only. Displays only files in the current, selected folder.
This option is selected by default. Only one option, Show all Files in Associated Paths or
Show Files in Selected Path Only, can be selected at a time.

Reference: Save As Dialog Box

The Save As dialog box opens when you click Save As from the Application menu. You can use
this dialog box to save a file to another location or to provide a different file name.

Configured Environments list 

Contains a list of currently Configured Environments. You can navigate to different
environments, development areas, and project folders to display different files in the file
list.

File list

Displays all files of a specific type in a selected project folder.

File name text box

Use this text box to type the name of a file you want to open.
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Note: If you are in the Domains area and the Configured Environments tree is set to
display by title, the Save As dialog box will only require a name to be entered.

File Type drop-down list

Displays the filter based on applicable file type.

Details Toggle

Toggles between displaying the files in the file list with details (date modified, size, and so
on) or in a list. Displaying files with details is the default.

Note: If you choose to display details or not, App Studio remembers your choice and will
keep the setting you chose the next time the Open File dialog box is open. For example, if
you choose to display file details the first time you invoke the Open File dialog box, then
the next time you invoke the Open File dialog box, file details are shown.

Refresh Button

When clicked, refreshes the list of available files.

Setting User Preferences Using the Options Dialog Box

You can customize App Studio by setting specific user preferences, using the following tabs in
the App Studio Options dialog box. To open the Options dialog box, click Options in the
Application menu. 

Reference: General Tab

The General tab contains options for starting App Studio, minimizing the main window, and
other settings. The following options are available. 

Main Window Options

Option Description

Maximize main window Maximizes the application window when you begin
each session.

Smart Context

Option Description

Set new column type based on
metadata/surrounding fields

Sets new column types by using metadata and
surrounding fields.
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Option Description

Activate Field ribbon tab when
selecting a field on the report
canvas

Activates the Field tab on the ribbon upon selection of
a field within the report canvas.

Activate Layout ribbon tab when
no selection is made on the report
canvas

Activates the Layout tab on the ribbon when no
selection is made on the report canvas and you click
the white space.

Other Settings

Option Description

Show Welcome Screen Controls the appearance of the Welcome screen
when App Studio is launched.

Confirm close Displays a prompt for users to confirm that they
want to exit App Studio.

Start local WebFOCUS Server Starts the local Reporting Server when App Studio is
launched.

Stop local WebFOCUS Server on exit Stops and closes the local Reporting Server when
you exit App Studio.

Recent file list limit Allows you to set the number of recently used files
that appear in the Recent file lists. The default value
is 25.

Ping Interval (minutes) Sets the frequency at which requests are sent to the
web or application server so your connection does
not time out. The default is 5.

Reset All Message Boxes Resets all message boxes to their default state. For
example, if you selected the Don’t show this
message again check box in any message box,
clicking this button will reset all message boxes.
Once you click this button, it becomes inactive until
you choose not to display a message box in the
product.

Opening the Application Menu of File-Related Commands

46  Information Builders



Option Description

Reset All Options to Default Restores all options in App Studio to the default
settings.

Default file editor Lists file editor options, such as:

Edit in App Studio canvas

Edit in Text Editor

Edit in Windows registered tool

Note: The Edit in Windows registered tool option is
only visible if the file type you are accessing has
been associated with a Windows application.

The file editor used determines which shortcut menu
options are available and controls the default
behavior for double-clicking and right-clicking files.

Language Provides a drop-down list that allows you to change
the language of the App Studio screen text. After you
change the language, restart App Studio to make the
change effective. The languages listed are selected
in the Dynamic Language Switch setting in the
WebFOCUS Administration Console.

The Sync with WebFOCUS check box is selected, by
default. When this check box is selected, the
language used for App Studio and WebFOCUS are
synced with the language selected in the Language
drop-down list. If this check box is not selected, App
Studio uses the language selected in the Language
drop-down list and WebFOCUS uses the language
selected in the Environments dialog box. If you make
changes, restart App Studio to make the change
effective.
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Reference: Reporting Tab

The Reporting tab contains format options for output, field list displays, formatting a report for
the web, and setting the record retrieval limits. The following options are available. 

Field List Options

The following options affect the appearance of the Fields tab of the Object Inspector.

Option Description

Sort the list by field name Sorts any list of field names alphabetically.

Show fully qualified field
names

Displays any list of field names as qualified field names,
which include data source and table names,
alphabetically.

Display the field name Displays the full field name in the Fields tab, as specified
in the file description.

Display the field alias Displays the alternate field name in the Fields tab, as
specified in the file description.

Display field titles Displays the titles for columns, filters, and computes in
the Fields tab, as specified in the file description.

Display field descriptions Displays descriptive information about the field in the
Fields tab, as specified in the file description.

Display the data formats Displays the field length and format type in the Fields tab,
as specified in the file description.

Expand field tree Displays fields in expanded mode when using a Field tree.
If this option is not selected, segments appear collapsed
wherever a Field tree appears.

Note: This option can also be accessed from the Field tree
shortcut menu.
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Option Description

Display Filters in Filters Folder Displays Filters in a separate Filters folder of the Field
tree. If this option is not selected, Filters appear with the
rest of the fields in the segment.

Note: This option can also be accessed from the Field tree
shortcut menu.

Authoring Mode

The Authoring Mode options determine how field names in a procedure (.fex) are written in the
App Studio source code. These options are not affected by the selected Field List options.

Option Description

Qualified fieldname Writes the source code using qualified field names, for
example:

BY 'GGSALES.SALES01.CATEGORY'

Unqualified fieldname Writes the source code using unqualified field names, for
example:

BY CATEGORY

Alias fieldname Writes the source code using alias field names, as defined in
the ALIAS field of the Master File. The ALIAS field assigns an
alternative name for a column.

The following example shows source code in which the
Category field name is assigned E02 in the ALIAS field of the
ggsales.mas Master File:

BY E02
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Other

Option Description

Default Report Format Sets a report format to use as the default format by the
Reporting feature.

Select the display format for your reports. You can select from
the following options:

HTML

Active Report

Active PDF

PDF

Excel XLSX

Excel XLS

PowerPoint PPTX

PowerPoint PPT

Default (This option is the FOCUS default. It applies to
whichever of the previous formats was set as an
environment parameter.)

User

Maximum number of
records to retrieve

Specifies a limit on the number of records to retrieve from the
data source. Setting a retrieval limit creates selection criteria
for both Retrieval Limit and Read Limit dialog boxes.

Specify a retrieval limit when you need only a few records to
test the design of a new report, or you know how many records
meet the test criteria and want to stop a search after those
records are retrieved. This reduces total retrieval time.

Maximum number of
readings to make

Specifies a limit on the number of readings that can be made
against the data source.
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Option Description

Default Style Template Specifies the default styling template when you open the Report
feature.

Default Report Template Specifies the default report settings when you open the Report
canvas. Click Browse to select user-created templates.

Retrieve master file
descriptions

Displays Master File suffix and description in the Environments
Tree, and in the Chart Wizard and the Report Wizard. System
performance may be affected if there are a large number of
Master Files. This option is not selected, by default.

If you change this option, you must exit App Studio and reopen
it for the change to take effect.

Enable OLAP Activates the use of OLAP within App Studio.

This option is not selected, by default.

Display Styling Toolbar Specifies the click option to trigger the mini styling toolbar,
which enables you to style content. You can access the toolbar
by selecting one of the following options:

On left-click selections only.

On right-click selections only. This is the default value.

On both left-click and right-click selections.

Reference: HTML Page Tab

The HTML Page tab enables you to set grid settings for an HTML page, preview reports and
charts, set single or multiple layers, and alter the frequency in which you refresh thumbnails.

Note: If you make changes to the HTML Page settings in the App Studio Options dialog box
(Grid Settings, Preview Settings), you need to press F5 to refresh an HTML page that is
currently open in order to see the changes.

The following options are available.
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Grid Settings

Option Description

Show Grid Enables you to view a grid while you create an HTML
page. The Show Grid check box is selected, by default.
Clear this check box if you do not want to develop with a
grid.

Snap to Grid Enables you to snap to grid on demand. The Snap to Grid
check box is selected, by default. Clear this check box if
you do not want to enable the snap to grid option.

Width Customizes the width of your grid. The default is 10
pixels.

Height Customizes the height of your grid. The default is 10
pixels.

Form type

Option Description

None Specifies no form object in the HTML page.

Single layer Specifies a single layer form in the HTML page. This is
the default setting.

Multiple layer Specifies a multiple layer form in the HTML page.

Form Settings Opens the Form settings dialog box.

Tab Characters

Option Description

Insert spaces Indicates that, when the Tab key is pressed, the
number of spaces specified in the Tab size option is
inserted.
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Option Description

Keep tabs Indicates that, when the Tab key is pressed, a tab
character is inserted.

Tab size Specifies the number of spaces inserted when you
press Tab.

Check boxes

Option Description

Show 'New Parameters' dialog Sets the New Parameters dialog box to appear in the
HTML page. This is the default setting.

Default caching option Sets the Default caching option to run in the HTML
page. By default, this option is not selected.

Auto Arrange Objects Sets the objects in the HTML page to arrange
automatically. This is the default setting.

Preview settings

Option Description

Reports and Charts Preview Enables you to preview reports and charts before saving
and deploying the HTML page. This is the default setting.

Simulated Data Enables you to view the HTML page based on simulated
data from WebFOCUS.

Live Data Enables you to view reports and charts using live data in
the HTML page. This is the default setting.

Record limit for reports Sets the record limit for reports. Values range from -1 to
999. The default setting is 500.

Record limit for input controls Sets the record limit for input controls. Values range from
-1 to 999. The default setting is 10.
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Option Description

Use Prefix Sets a prefix to run before each report or chart
component on an HTML page.

Refresh thumbnails every
seconds

Sets the time interval for refreshing thumbnails. Values
range from 0 to 999 seconds. The default setting is 20.

Default Theme Sets the default theme for an HTML page. The
Information Builders theme is the default theme.

Reference: Form Settings Dialog Box

The following table describes the options available in the Form Settings dialog box.

Option Description

To the left of the input Sets the prompt orientation to appear to the left of the
input controls.

Above the input Sets the prompt orientation to appear above the input
controls. This is the default setting.

Distance between prompt and
input

Sets the distance between prompt and input. The range
is from 0 to 99 pixels. The default setting is 5 pixels.

Horizontal distance between
controls

Sets the horizontal distance between controls. The range
is from 0 to 99 pixels. The default setting is 10 pixels.

Vertical distance between
controls

Sets the vertical distance between controls. The range is
from 0 to 99 pixels. The default setting is 10 pixels.

Number of columns Sets the number of columns in the form object. The
default setting is 4.

Add schedule button Adds a schedule button to the form object. This is the
default setting.

This button can also be inserted from the New
Parameters dialog box.
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Option Description

Add defer button Enables deferred running of a report. This is the default
setting.

This button can also be inserted from the New
Parameters dialog box.

Start each chain on a new line Starts chains on a new line. This is the default setting.

Reference: Document Tab

The Document tab enables you to set grid settings for a document, preview reports and charts,
and alter the frequency in which you refresh thumbnails. The following options are available.

Grid Settings

Option Description

Show Grid Enables you to view a grid while you create a document.
The Show Grid check box is selected, by default. Clear
this check box if you do not want to develop with a grid.

Snap to Grid Enables you to snap to a grid on demand. The Snap to
Grid check box is selected, by default. Clear this check
box if you do not want to enable the snap to grid option.

Width Customizes the width of your grid. The default is 10
pixels.

Height Customizes the height of your grid. The default is 10
pixels.

Tab Characters

Option Description

Insert spaces Indicates that, when the Tab key is pressed, the
number of spaces specified in the Tab size option is
inserted.
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Option Description

Keep tabs Indicates that, when the Tab key is pressed, a tab
character is inserted.

Tab size Specifies the number of spaces inserted when you
press Tab.

Preview Settings

Option Description

Reports and Charts Preview Enables you to preview reports and charts before
saving and deploying the document. This is the default
setting.

Simulated Data View the document based on simulated data from
WebFOCUS.

Live Data View reports and graphs using live data in the
document. This is the default setting.

Record limit for reports Sets the Record limit for reports. Values range from -1
to 999. The default setting is 500.

Use Prefix Sets a prefix to run before each report or chart
component on a document.

Refresh thumbnails every seconds Sets the time interval for refreshing thumbnails.
Values range from 0 to 999 seconds. The default
setting is 20.
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Reference: Environments Tab

Note: The Environments options are used to control the development areas that are visible in
the Configured Environments tree. At least one option must be selected and applied to all
configured environments.

The Environments tab enables you to change the viewable contents of the Configured
Environments tree. The following options are available. 

Environments settings

Option Description

Show Projects area If selected, displays the Projects area in the Configured
Environments tree.

Show Data Servers area Displays the Data Servers area in the Configured
Environments tree.

Show domain area Displays the domain area in the Configured Environments
tree.

Show Web Applications area Displays the Web Applications area in the Configured
Environments tree.

Reference: Help Configuration Tab

The Help Configuration tab enables you to configure the location of the web-based Help system
for App Studio. It provides the fields in which you can modify the App Studio Help configuration
information to access the online Help system from your environment. The following options are
available. 

Option Description

Protocol Specify the protocol, either HTTP or HTTPS.

Host Type the name of the machine where the Help resides.

Port Type the port number of the web and/or application server.

Help Context Root Type the context root for the location where the Help is
hosted.
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Reference: Output Viewer Settings Tab

The Output Viewer Settings tab enables you to set a specific browser to use for output, and to
set the navigation options for the output (run in new window, run in same window). The
following options are available.

Browser Setup

Option Description

Browser Setup Select a browser to use for output.

Note:

The Browser Setup section is populated with a list of
browsers that are installed on the App Studio machine.

App Studio works with Mozilla Firefox®, Google
Chrome™, Microsoft Internet Explorer®, and Microsoft
Edge® browsers. Microsoft Edge is the default browser
for Windows 10 operating systems. Internet Explorer is
the default browser for all Windows operating systems
prior to Windows 10.

The browser that is highlighted when you close the
dialog box is the browser that will be used for execution.

Browser executable path Sets the location of the browser executable. This field box
is populated based on the browser selection.

Web driver location Sets the location of the web driver for the browser. This
field box is populated based on the browser selection.

Test URL Indicates the test URL for testing the browser setup. The
default URL is http://www.ibi.com.

Test browser setup Tests the browser setup, using the test URL. If the test is
successful, the webpage will display in the browser and you
will receive a success message. If the test is unsuccessful,
you will receive a failed message.

Save selected browser
setup

Saves the setup information for the selected browser.
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Navigation Options

Option Description

Run in new window/tab* Sets the output to run in a new window or tab.

Run in same window Sets the output to run in the same window.

Reference: File Extensions Tab

The File Extensions tab lists the currently supported file extensions. They are all selected, by
default, and you can clear the check box for any file types that you do not want retrieved from
the server.

Note: You must exit and restart App Studio for your selections to take effect.

Option Description

File Type The file extension for a specific type of file.

Display If selected, displays this file type throughout App Studio.

Accessing Frequently Used Commands

The Quick Access Toolbar provides access to frequently used commands, and the option to
customize the toolbar with the commands that you use most often. By default, the Open, Save,
Save All, Quick Print, Undo, Redo, Cut, Copy, Paste, Run, and Customizing Quick Access
Toolbar buttons appear on the Quick Access Toolbar, as shown in the following image. 

Note:

When using the undo and redo commands, consider that these actions may not take effect
on options or information that is changed in every panel. In addition, if you change multiple
options in one panel, for example, the undo or redo command will reverse all of those
indicated changes in one action.

The Cut, Copy, and Paste commands can be used on text, objects on the HTML canvas and
Document canvas, and fields on the Report canvas.
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The Customize Quick Access Toolbar button (down pointing arrow) appears on the Quick
Access Toolbar and opens the Customize Quick Access Toolbar menu. This menu contains a
list of the default commands on the toolbar. You can clear these commands to hide them from
the toolbar. There are also options to add more commands with the Customize dialog box,
move the Quick Access Toolbar below the ribbon, and hide the ribbon.

You can also add commands using the Customize dialog box. To access the Customize dialog
box, select More Commands from the Customize Quick Access Toolbar menu. From the
Customize dialog box, you can choose which commands you want to add to or remove from the
Quick Access Toolbar, as well as the order in which the commands appear.

The Quick Access Toolbar is always available. By default, it is located in the upper-left corner
of the App Studio interface. To move the Quick Access Toolbar below the ribbon, click the
arrow button, and then click Show Below the Ribbon.

Reference: Customize Dialog Box

Using the Customize dialog box, you can add or remove commands from the Quick Access
Toolbar. By providing access to the Customize Keyboard dialog box, you can also customize
the keyboard by setting keyboard shortcuts for commonly performed tasks. 

Choose commands from

Opens a list of available areas in App Studio. The Commands section dynamically
repopulates with the commands that are associated with your selection.

Commands

A list of commands from a specific area of App Studio. You can select commands and use
the Add or Remove buttons to add or remove them from the Quick Access Toolbar.
Commands are represented by the icon that displays on the ribbon. Commands that have
no icon and a vertical arrow are command groups. Commands that have an icon and a
horizontal arrow are commands with submenus. You can add all commands, command
groups, and commands with submenus to the Quick Access Toolbar.

Add

Adds a selected command from the Commands list to the Quick Access Toolbar.

Remove

Removes a selected command from the Quick Access Toolbar. If no command is selected,
the last command on the Quick Access Toolbar is removed.

Up

Moves a command up in order on the Quick Access Toolbar.
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Down

Moves a command down in order on the Quick Access Toolbar.

Reset

Reverts the Quick Access Toolbar to use the default commands (Open, Save, Quick Print,
and Run).

Show Quick Access Toolbar below the Ribbon

Displays the Quick Access Toolbar below the ribbon when selected.

Customize

Opens the Customize Keyboard dialog box. For more information on the Customize
Keyboard dialog box, see Customize Keyboard Dialog Box on page 62.

OK

Applies the changes you made to the Quick Access Toolbar.

Cancel

Exits the Customize dialog box without applying any changes you made to the Quick
Access Toolbar.

Help

Opens the App Studio Help.

Procedure: How to Add Commands to the Quick Access Toolbar

You can quickly add commands to the Quick Access Toolbar by right-clicking the ribbon,
groups, or the individual commands, and selecting Add to Quick Access Toolbar, or you can
follow the procedure below. 

1. On the Quick Access Toolbar, click the arrow, and then click More Commands.

The Customize dialog box opens.

2. In the Choose commands from list, select a command group.

3. Select a command name, and then click Add.

The command name appears in the Quick Access Toolbar list.

If you select a command group or a command with a submenu, all associated commands
are accessible from the Quick Access Toolbar.

To remove a command name from the Quick Access Toolbar list, select the command, and
then click Remove.
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4. Click the arrow buttons to rearrange the order of command names in the list.

This also rearranges how the command buttons appear in the Quick Access Toolbar.

5. Click OK to save your changes.

Reference: Customize Keyboard Dialog Box

The Customize Keyboard dialog box is used to create and edit keyboard shortcuts to
commands. You can access the Customize Keyboard dialog box by clicking the Customize
button in the Customize dialog box from the Quick Access Toolbar. 

Categories

A list of the available areas in App Studio. The commands associated with that area are
displayed in the Commands section.

Commands

A list of commands from a specific area of App Studio. You can select commands and then
assign a keyboard shortcut to them.

Current Keys

Displays the current keyboard shortcuts associated with the selected command.

Press new shortcut key

Press the keyboard shortcut you want to assign to a specific command. Once the Assign
button is clicked, this keyboard shortcut will then be displayed in the Current Keys list for
the selected command.

Set Accelerator for

Enables you to set an accelerator for one of the following: Default, HtmlPage, or
Document.

Description

Provides a description of the selected command.

Assign

Allows you to assign a keyboard mapping to a command.

Remove

Allows you to remove an assigned keyboard mapping.

Reset All

Resets all keyboard mapping assignments for every command. A warning displays to
ensure that want to perform this action.
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Close

Exits the Customize Keyboard dialog box and return to the Customize dialog box.

Procedure: How to Create Keyboard Shortcuts

1. To open the Customize dialog box, do one of the following:

Click the drop-down arrow on the Quick Access Toolbar and then click More Commands.

Use the shortcut menu on the ribbon or Quick Access Toolbar and then click Customize
Quick Access Toolbar.

2. Click Customize.

The Customize Keyboard dialog box opens.

3. From the Categories list, select an area that contains the command that you want to
create a shortcut for.

4. From the Commands list, select a command.

5. In the Press new shortcut key area, enter the key combination that you want to use with
the command you selected.

You can make a shortcut up to three keystrokes long (For example, Ctrl+Shift+R).

6. Click Assign.

A shortcut is now assigned to the command you selected.

7. Click Close to exit the Customize Keyboard dialog box.

Developing Applications in the Canvas Area

You can use App Studio features and functions to develop applications in the canvas area. The
canvas is designed to maximize your design-time options. At run time, elements appear in the
browser based on the order in which they were added to the canvas, left to right, and top to
bottom. Your canvas may have the same appearance as the browser at run time, but it is not
required. You can drag elements to areas of the canvas as needed to make it easier to work
with them. 

The size of your canvas depends on the placement and location of panels around the interface
window.

As you develop in App Studio, tabs open in the canvas area. Since you can develop an HTML
page at the same time that you create a report, each canvas opens with a different colored
tab. The colored tab at the top of each canvas displays the name of the file you are
developing.
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If you chose to name the file after you develop the content, a default file name, such as
Report1, appears on the tab, as shown in the following image.
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A second set of tabs opens when you create procedures with multiple components. For
example, you can add Set, Define, and Join components to a procedure at any time. These
canvases open as tabs below the report or chart procedure, as shown in the following image.
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In addition to colored tabs, some canvases also contain View tabs. A View tab appears at the
bottom of the canvas and changes the display of information on the canvas. View tabs, which
display different views of the same component, are shown in the following image.

View tabs, such as those on the HTML canvas, also enable additional features and functions
that you can use to customize an application. For example, in the HTML canvas, you can add
JavaScript functionality to an HTML page through the Embedded JavaScript view tab.

You can develop App Studio content in the following canvases.

Creating and Scheduling an Alert Using the Alert Assist Canvas

The Alert Assist canvas enables you to distribute an entire report or selected sections of a
report when certain test conditions are met.

To access the online Help for the Alert Assist canvas, click the Alert Assist Help icon ,
located within the Alert Assist canvas.

Alert Assist Button

The Alert Assist button opens a menu that contains the Save, Save As, Run, and Close
buttons.
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Alert Assist Quick Access Toolbar

You can access frequently used commands on the Alert Assist Quick Access Toolbar, such as
Save, Undo, Redo, View code, and Run.

Alert Assist Home Tab

You can use the Alert Assist Home tab to access the features and functions necessary to
create, open, edit or run an Alert Test or Alert Result. The Alert Assist Home tab contains the
Navigation group.

Navigation Group

You can create a new Alert Test or Alert Result, open a previously created Alert Test or
Alert Result, edit a previously created Alert Test or Alert Result, and run the report in a new
browser window. The commands are:

New

You can create a new Alert Test or Alert Result by selecting Test or Result, and then
clicking New. This opens a menu from which you can choose to create a new
WebFOCUS Report or Test for File Existence. New provides the same functionality as if
you right clicked the Test node and created a report from the menu.

Open

You can open a previously created Alert Test or Alert Result. This invokes the Chart
canvas so that you can make changes to the chart. The Open option is activated only
after a report test is created.

Edit

You can edit an Alert Test or Alert Result. This opens the Report on FILENAME data
source dialog box. Here, you can edit the report in the Text Editor canvas.

Run

You can run the report in a new browser window.

Delete Group

You can remove the report from the Alert Test or Alert Result. The command is:

Delete

You can remove the report from the Alert Test or Alert Result.
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Creating Charts Using the Chart Canvas

The Chart canvas enables you to create different types of charts. You can select from a variety
of chart types and output formats, and add custom features to a chart. To access the Chart
canvas, on the Home tab, in the Content group, click Chart. The Chart Wizard opens.

Creating Cascading Style Sheets Using the Cascading Style Sheet Canvas

The Cascading Style Sheet canvas allows you to create a cascading style sheet. To access the
Cascading Style Sheet canvas, right-click any folder or file in the Environments Tree panel and
in the shortcut menu click New, and then click Cascading Style Sheet.

Accessing the ESRI Configuration Utility Canvas

The ESRI Configuration Utility canvas allows you to edit configuration options associated with
ESRI, the ArcGIS Server, and the GIS Adapter. To access the ESRI Configuration Utility canvas,
right-click an Application folder in the Data Servers area, point to New, and click XML Document
with ESRI Configuration.

Working With the JavaScript and CSS Canvas

The Embedded JavaScript canvas and the Embedded CSS canvas have a built-in Auto
Complete feature to assist in the creation of code segments, similar to functionality offered by
Microsoft IntelliSense® and other code editors. When you begin typing a string, array, number,
or user-defined object, a list of available JavaScript methods, related to those code segments,
displays.

The Auto Complete feature is on by default. To turn it off, right-click in the Cascading Style
Sheet canvas and clear Auto Complete from the shortcut menu.

Note: If there is a syntax error, the Auto Complete features will not display.

Editing Component Code Using the Text Editor Canvas

The Text Editor canvas allows you to edit component code. To access the Text Editor canvas,
right-click a component in the Procedure View panel, point to Open With, and then click Text
Editor.
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Combining Layouts Within a Single Document Using the Document Canvas

The Document canvas enables you to design reports, and to coordinate and distribute layouts
made up of multiple reports and charts in a document. You can position reports and charts
anywhere on a single page or combine a series of layouts within a single document. To access
the Document canvas, on the Home tab, in the Content group, click HTML/Document. When
the HTML/Document Wizard opens, select Document from the available options. The
Document canvas opens.

Creating HTML Pages Using the HTML Canvas

The HTML canvas enables you to create HTML pages for WebFOCUS. Designed for business
users, you do not need to have experience in HTML, CSS, XML, or JavaScript. The HTML
canvas is a graphical interface that is easy to use.

Note: HTML canvas files are intended to be created and edited with the HTML canvas only.
You can either modify HTML pages created in the HTML canvas or create HTML pages using a
text editor. When these pages are opened in the canvas, a message displays that allows you
to decide whether to open the file in the canvas or the text editor.

If you are a web developer and want to write your own code instead of using the HTML canvas,
you can use the authoring tool of your choice and also use RESTful Web Services. To do so,
you must license the WebFOCUS Web Services Enablement Option. For more information on
RESTful Web Services, see the WebFOCUS Embedded Business Intelligence User's Guide.

Note: When opening an HTML file that was not created in the HTML canvas, you will be
prompted to open the file only in a Windows Associated tool.

To access the HTML canvas, on the Home tab, in the Content group, click HTML/Document.
When the HTML/Document Wizard opens, select HTML Page from the available options. The
HTML canvas opens.

The HTML canvas uses HTML 5 Document Type Definitions (DTD).

Creating OLAP Hierarchies Using the Olap Dimensions Canvas

The OLAP Dimensions canvas allows you to create temporary OLAP hierarchy and dimensions.
To access the OLAP Dimensions canvas, right-click a procedure folder or component in the
Procedure View panel, point to New, and then click Olap Dimensions.

Note: This option only appears if you select the Enable OLAP check box in the Reporting tab of
the App Studio Options dialog box.
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Creating and Styling Reports Using the Report Canvas

The Report canvas provides you with many features that enable you to create and style
reports. To access the Report canvas, on the Home tab, in the Content group, click Report. The
Report Wizard opens. Follow the prompts in the Report Wizard to create a report. The Report
canvas opens.

Creating Reporting Objects Using the Reporting Object Canvas

The Reporting Object canvas enables you to present available data using different terms and
formats. You can then use Reporting Objects as templates for the creation of a wide range of
reports and charts.

To access the online Help for the Reporting Object canvas, click the Reporting Object Help icon

, located within the Reporting Object canvas.

Reporting Object Button

The Reporting Object button opens a menu that contains the Save, Save As, Run, and Close
buttons.

Reporting Object Quick Access Toolbar

You can access frequently used commands on the Reporting Object Quick Access Toolbar,
such as Save, Undo, Redo, View code, and Run.

Reporting Object Home Tab

You can use the Reporting Object Home tab to access the features and functions necessary to
create, open, edit or run an item. The Reporting Object Home tab contains the Navigation
group.

Navigation Group

You can create a new item, open a previously created item in the respective canvas, edit a
previously created item, rename an item, and run the item The commands are:

New

You can create a new join, DEFINE statement, filter, or WHERE statement.

Open

You can open a previously created item in the appropriate canvas.

Edit

You can open the item source code in the Text Editor canvas.
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Properties

You can rename the selected filter or filter group.

Run

You can run the selected item.

Delete Group

You can delete a selected item or all items of a specific type. The commands are:

Delete 

You can delete the selected item.

Delete All

You can delete all items of the selected item type. For example, all WHERE
statements, all filters in a particular group, or all filters in every group.

Working With Synonyms Using the Metadata Canvas

The Metadata canvas provides a graphical interface that enables you to work with synonyms
and perform tasks, such as creating, viewing, and modifying synonyms. To access the
Metadata canvas from the Environments Tree panel, right-click a Master File and select
Metadata Canvas. To access the Metadata canvas from the ribbon, on the Home tab, in the
Content group, click Data, and then click Synonym via Metadata Canvas.

Joining Data Sources Using the Join Canvas

The Join canvas allows you to temporarily join two or more data sources and use data from
them as if they were one data source. Joined files remain physically separate but are treated
as one data source. To access the Join canvas, right-click a procedure folder or component in
the Procedure View panel, point to New, and then click Join.

Changing Environment Settings Using the Set Canvas

The Set canvas provides you with a graphical option for issuing a SET command. You can use
the SET command to change parameters that govern App Studio and your environment. To
access the Set canvas, right-click a procedure folder or component in the Procedure View
panel, point to New, and then click Set.
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Specifying the Name and Location of a Data Source Using the Use Canvas

The Use canvas enables you to specify the name and location of a WebFOCUS data source.
This is helpful if the default naming convention is not used, the data source cannot be found
on the standard search path, or an explicit extra option is desired. To access the Use canvas,
right-click a procedure folder or component in the Procedure View panel, point to New, and
then click Use.

Customizing Canvases

You can switch between the canvases by clicking the colored tab at the top of the canvas. You
can also develop in the canvases side by side.

The following image shows an HTML canvas next to a Report canvas.

Procedure: How to Move Canvases for Side-by-Side Development

To create side-by-side canvas development, follow these steps:

1. Drag one canvas tab away from its original position.
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A pointer with a document icon  appears.

2. Drag the pointer with the document icon to the upper-right corner of the canvas.

The canvases now appear side by side.

Tip: Repeat the preceding steps to develop on additional canvases side by side.

Accessing Features With the Ribbon

The App Studio ribbon replaces traditional toolbars with a single command bar that organizes
commands and controls into a series of static and contextual tabs. From the ribbon, you can
also access the WebFOCUS Administration menu, the Style menu, and the Help menu. 

The default ribbon is shown in the following image.

Each tab on the ribbon, whether static or contextual, contains commands and controls that are
organized into groups, according to their function or relationship. All tabs are named and all
groups are labeled. Icons are used to represent the commands or controls in each group. By
default, all icons are labeled. There are a few styling icons in the Style group that are not
labeled. Rest your pointer over an icon to view the tooltip that identifies it. An example of this
is shown in the following image.
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In addition to single-click commands, some commands on the ribbon contain a submenu of
options that opens when you click the arrow associated with the command. These arrows can
appear below or next to a label. An example of this is the Data command, which opens a
submenu of options, as shown in the following image.

Note: There is no default ribbon size. As your monitor or application window size changes, the
commands and controls on the ribbon resize themselves to fit the available space. Large
monitors or application windows will display larger icons and entire groups. Smaller monitors or
application windows may display groups as a single, labeled icon that opens a submenu.

Building an Application Using the Home Tab

The Home tab enables you to access the features and functions necessary to build an
application, create new components, open existing components, run existing components, and
edit components. The Home tab contains the Content, Utilities, View, and Window groups. The
Home tab is always available and is static. It is located in the upper-left corner of the App
Studio interface, below the Quick Access Toolbar, as shown in the following image. 

Note: The Home tab is the only static tab in App Studio.
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Creating an Application Using the Content Group

The Content group contains the components or tools that you can use to create an application.
These include: Data, Report, Chart, and HTML/Document. The Content group is shown in the
following image.

The commands in the Content group are:

Data

Contains the Synonym via Metadata Canvas, Synonym, Manage Adapters, Data Source
Password, and Rebuild Data Source commands. These provide you the options you need
to create and edit synonyms for existing adapters, configure a new adapter, or add a
remote server.

If you click Synonym via Metadata Canvas, the Data Source Definition Wizard opens.
Navigate to the location of the data source you want to create or edit and click OK.

If you click Synonym, the Select Server Node dialog box opens. Navigate to the application
folder where you want to create your synonym and click OK. After the location of the
synonym is determined, the Select Adapter dialog box opens. Select the adapter you want
to use and click OK. You will then be able to edit the synonym details.

If you click Manage Adapters, the Select Server Node dialog box opens. Navigate to a valid
server location to begin configuring a new adapter or edit the settings of an existing
adapter.

If you click Data Source Password, the Password Dialog box opens. You can enter the
password for the data source you have selected in your Environments Tree panel.

If you click Rebuild Data Source, the Rebuild dialog box opens. You can rebuild a
disorganized file, index a specific field from a file, or check the integrity of a file.

Note: To index a specific field from a file, the field must have FIELDTYPE=I, specified in the
Master File. You can do this from the Metadata canvas using the FIELDTYPE property, I-
Index check box.
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Report

Opens the Report canvas in report mode after you enter a procedure name and select a
location for your report from the Report Wizard. 

In report mode, you can create and style simple or complex reports, add data to the Report
canvas, and style that data creating a graphical representation of the report page. This
allows you to view how the report displays at run time.

Using report mode, you can:

Display and sort data.

Select records.

Include totals, subtotals, column calculations, headings, footings, and images.

Format columns.

Style fonts, colors, and grids.

Add drill downs to detailed reports and URLs.

Save output in many types of formats for display and reuse.

Create active reports.

Perform predictive analysis (an RStat license is required).

Chart 

Opens the Chart canvas after you enter a procedure name and select a location for your
chart from the Chart Wizard. 

In chart mode, you can easily transform almost any type of data into effective custom
charts. You can create a variety of charts, such as bar charts, line charts, scatter charts,
or pie charts, to help users analyze data in a different way. You can include selection
criteria by defining parameters for your data. Additionally, you can apply drill-down
capabilities and conditional styling to highlight specific data on a chart.

The Chart canvas contains a ribbon of features and options that allow you to add and style
the data in your chart. Contextual tabs open within the Chart canvas, rather than on the
App Studio ribbon.

HTML/Document

Opens the HTML/Document Wizard. You can choose the type of page that you want to
create from the following options: HTML Page, Guided Report Page, or Document.
Depending on your selection, the corresponding canvas will open. 
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HTML mode provides the features you need to create HTML pages so that end users can
interact with your data. You can build and customize an HTML page in the HTML canvas,
using the contextual tabs on the ribbon to add objects to the page. HTML mode is fully
integrated with JavaScript and cascading style sheets (CSS).

In the HTML canvas, you can:

Build an HTML launch page.

Add push buttons, hyperlinks, and other controls to launch WebFOCUS reports in your
application.

Create a launch page for one or more reports that contain parameters.

Create a complete HTML page by adding multiple reports and charts.

Create an advanced report layout by including images, frames, and other web objects.

Modify the location, size, and properties of all objects in your page layout.

Set background, font, and other page properties.

In the Document canvas, you can coordinate and distribute layouts made up of multiple
reports and charts in a single document. You can position reports and charts anywhere on
a single page or combine a series of layouts within a single document. When creating
compound reports in the Document canvas, PDF, HTML, active reports, PowerPoint, and
Excel are available as output formats.

Creating a New Environment and Accessing the Command Console Using the Utilities
Group

The Utilities group enables you to create a new environment and to access the Command
Console, where you can send commands to the server. The Utilities group is shown in the
following image. 
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The commands in the Utilities group are:

Environments

Opens the Environments List dialog box. A WebFOCUS environment consists of a web
server, a WebFOCUS Client, and a Reporting Server. Adding WebFOCUS environments
allows you to create and manage multiple environments, such as development, test, and
production instances. You can set a new development environment, add a new
environment, edit an existing environment, or remove an environment.

Command Console

Opens a command tab for editing and enables you to send commands directly to a server
from App Studio. For more information on creating, viewing, and editing source syntax, see 
Creating, Viewing, and Editing Source Syntax on page 979.

Sending Commands to the Server Using the Command Console

The Command Console enables you to send commands directly to a server from App Studio.
This benefits users who have worked with Information Builders products and are already
familiar with the command syntax.

The Command Console sends output to your web browser or App Studio Viewer. Output can
include error messages, responses to query commands, and report output. The Command
Console can also serve as a troubleshooting and debugging tool.

The following are a set of rules that you should follow when entering commands in the
command console.

The Console is case sensitive. Therefore, you must enter text in the case required for
processing. For example, keywords must be entered in uppercase characters.

The Command Console is not interactive. Therefore, you must enter all required commands
in sequence and execute them as an entire process. For example, you must enter all steps
required to execute the WebFOCUS REBUILD command. The Console does not prompt you
for information.

You can copy or cut text from the Command Console or an outside window, and paste it in
the Command Console.

You can drag command syntax within the Command Console.

The following groups are available in the Command Console Ribbon tab.
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Listing the Available Paths Using the Execution Path Group

The Execution Path group contains a list of paths that are available for you to use when you
execute commands. The Execution Path group is shown in the following image.

The command is:

Execution Path List 

Contains a list of available paths for you to execute commands.

The list of available execution paths is determined by the selected nodes in the
Environments Tree panel. When you open App Studio for the first time, you must expand
and select a node from the Environments Tree panel to populate the Execution Path List.

When you run the content of the console, it will be executed using the selected execution
path and the Reporting Server associated with that selected path.

Loading Commands Using the Edit Group

The Edit group allows you to load commands, clear the console, and clear the input stack. The
input stack is a series of commands that you enter using the Command console. The Edit
group is shown in the following image.

The commands are:

Back

Loads the previous command from the input stack.

Forward

Loads the next command from the input stack.

Clear Console

Clears the current commands from the console.
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Clear Input Stack

Clears the previously entered commands from saved memory. This option is unavailable if
you do not have previously entered commands available for recall.

Auto Clear Console

When selected, automatically clears the console after your commands are executed.

Note: The Command Console tab shares the following groups with the Text Editor tab: Find,
Bookmarks, Position, Case/Comment, and Options. For more information on these remaining
groups, see Creating, Viewing, and Editing Source Syntax on page 979.

Deploying an RStat Scoring Routine Using the Modeling Group

The Modeling Group is only available when RStat is installed. You can deploy an RStat scoring
routine or estimate future values based on selected data. 

WebFOCUS RStat is a statistical modeling workbench embedded in App Studio. It allows you to
perform common statistical and data mining tasks, and develop models that can be deployed
as scoring applications on every platform. RStat enables data miners and Business
Intelligence developers to collaborate with the same tools used to access, manipulate, or
transform data, develop predictive models, and create and deploy scoring applications along
with associated reports to any worker within their organization. The Modeling group is shown in
the following image. 

The commands in the Modeling Group are:

Model Deployment

Opens the Model Deployment dialog box. This functionality enables you to deploy existing,
stored routines.

You can deploy an RStat scoring routine in any application directory within your app path
on any WebFOCUS server. The process of deployment includes compiling the routine and
placing the executable file in a location that can be accessed by a WebFOCUS scoring
application.
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Predictive Modeling

Opens RStat, a statistical modeling workbench that is embedded in App Studio. When you
select the Predictive Modeling command, the RGui window is opened and the R Console
and RStat are activated.

You use RStat to derive expected and predicted values from data observations. Decision
trees, regression, and the other algorithms are used to generate estimates. For example,
you can estimate whether a prospect is a good target for a particular marketing campaign,
or you can estimate the expected sales revenues for different stores in order to determine
whether store layout and product mix have an impact on sales.

Controlling the Display of the Screen Using the View Group

The View Group enables you to control what displays on your screen. For example, you can
choose whether to display or hide the Environments Tree or Help Wizard. The View group is
shown in the following image. 

The commands in the View group are:

Environments Tree

Displays or hides the Environments Tree panel, which displays on the left side of the
screen and displays environment information.

Environments Detail

Displays or hides the Environments Detail panel.

File/Folder Properties

Displays or hides the File/Folder Properties panel.

Procedure View

Displays or hides the Procedure View panel.

Context Bar

Displays or hides the Context Bar. The Context Bar displays under the ribbon.

Status Bar

Displays or hides the Status Bar. The Status Bar displays along the bottom of the screen.
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Help Wizard

Displays or hides the Help Wizard. By default, the Help Wizard panel opens in the bottom-
right corner of the interface. The Help Wizard content dynamically changes, depending on
where you are in the interface.

Viewing and Manipulating Windows Using the Window Group

You can view and manipulate all opened windows. The Window group is shown in the following
image. 

The commands in the Window group are:

New Window

Opens another view of the same document, enabling you to have multiple canvas views of
the same document. You can edit in any one of multiple views, each reflecting the changes
made to the document. This option is only available when using the Text Editor. This option
is not enabled for all other canvas tools.

Windows

Manipulates all opened windows. You can view and manipulate the windows using the
Windows dialog box. The Windows dialog box enables you to Activate or Save an open
window.
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Using the WebFOCUS Administration Menu

From the WebFOCUS Administration menu, you can access the WebFOCUS Administration
Console, the Reporting Server Console, the Security Center, the BI Portal, the Deferred Status
console, the ReportCaster Console, and the Session Viewer. You can also create deferred
status reports from this menu. The WebFOCUS Administration menu is shown in the following
image.

The WebFOCUS Administration menu is only available when you select an environment in the
Environments Tree panel. The options available to you change, depending on the development
area that you select in the Environments Tree panel. Deferred Status is only available when
you select a Domains node in the Environments Tree panel. The Reporting Server Console is
only available when you select a Web Applications node in the Environments Tree panel.

Note: App Studio always uses Microsoft Internet Explorer for all the tools available on the
WebFOCUS Administration menu. This is true even if you have selected another browser as the
default viewer.

WebFOCUS Administration Console

Opens the WebFOCUS Administration Console. Here you can add remote Reporting
Servers, configure application settings and client settings, and use WebFOCUS diagnostic
tools.

Reporting Server Console

Opens the Web Console. where a server user with the required metadata privileges can
configure and manage adapters, and can create synonyms through the Reporting Server
Console. You can use the Server Console as an alternative to App Studio to configure
adapters, add remote servers, and create synonyms. In addition, many other configuration
options are available through the Server Console.
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For a full understanding of configuration options and server capabilities, see the Server
Console Help system or the following manuals: Server Administration and Adapter
Administration.

Note:

The Reporting Server Console is sometimes referred to as the Web Console.

For App Studio installations that allow stand-alone development, the local, default
Reporting Server normally runs with security OFF, and the user who installed App Studio
is the default administrator.

Security Center

Opens the WebFOCUS Security canvas. Here you can set user privileges and roles for
users and groups.

BI Portal

Opens the WebFOCUS BI Portal. Here you can create dynamic websites using the content
you create in App Studio.

Deferred Status

Opens the Deferred Report Status console. Here you can defer running a report until a
specified time. This option is only available in the Domains node.

ReportCaster Console

Opens the ReportCaster Console. Here you can schedule and distribute WebFOCUS
reports, the content of URLs, and files.

Session Viewer

Enables you to review system events that took place during recent work sessions and
export them to system administrators or customer support staff. Traces of system events
and error messages captured by the Session Viewer provide a clear picture of system
operations, and enable you to investigate the causes of system disruptions or
performance issues.
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Customizing the Appearance of the Interface Using the Style Menu

You can customize the appearance of the App Studio interface from the Style menu. From this
menu, you can select a theme with which to customize the App Studio interface. The themes
available to you are determined by the themes that you have installed for Microsoft® Office.
The Style menu is always available. It is located in the upper-right corner of the App Studio
interface, as shown in the following image. 

Note:

When you close App Studio, the theme that you have selected is saved and used the next
time you launch the product.

When you change to the Office 2007 styles, the drop-down arrow is removed from the
panels. You can still access the menu by right-clicking the top frame of the panel.

Accessing App Studio Help Content

You can access the App Studio Help content, Focal Point Forums, App Studio licensing
information, and other product options from the Help menu. The Help button is always
available. It is located in the upper-right corner of the App Studio interface, as shown in the
following image.

From the Help menu, you can do the following:

Access the online Help system. Click Help Topics to open the App Studio Help window.
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Access the Focal Point community. Click Focal Point Forums to access our online developer
center and more than a message board. It is an interactive network of developers from
almost every profession and industry, collaborating on solutions and sharing tips and
techniques.

Reopen the Welcome screen after it has been closed. Click Display Welcome Screen to
reopen the Welcome screen.

Reset the interface layout. Click Reset Layout to return the App Studio interface settings,
such as the ribbon, Quick Access Toolbar, panels, and styling, to their default. This change
will not occur until App Studio is restarted.

View license and product information. Click About to open the About WebFOCUS App Studio
dialog box.

Working With the Environments Tree Panel

The Environments Tree panel is the primary navigational aide in App Studio. Using it, you can
always stay oriented to the domain or web application that you are working in. You can use the
panel to move or copy objects between folders, share content with other App Studio users, or
hide content. 

Note:

Do not copy and paste Content folders from one environment to another. The use of
Change Management packages is recommended to move Content folders from one
environment to another in App Studio.

When you copy and paste from the Domains area to the Data Servers area, the IBFS
properties (metadata) are lost and InfoAssist cannot function. The same issue occurs if you
copy and paste from the Domains area to your desktop, and then copy and paste from your
desktop back to the Data Servers area.

From the Environments Tree panel, you can:

Customize the appearance of the panel.

Filter content listed under the WebFOCUS environments in the Configured Environments
tree.

Access configured WebFOCUS environments to create new content or modify existing
content.

Refresh an application or folder in the Configured Environments tree, to view new files and
updated file information, and omit deleted files.
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The Environments Tree panel is shown in the following image. 

The Environments Tree panel opens with App Studio.

Reference: Environments Tree Toolbar

The Environments Tree toolbar contains the buttons and menus that you need to navigate,
filter, and sort the information that appears in the Configured Environments tree. 

View Options

Presents options for viewing items (for example, alphabetical sorting or grouping), as
described in the following table.

Option Name Function

View items sorted in
Alphabetical order

Sorts the files alphabetically from A to Z.

View items sorted in reverse
Alphabetical order

Sorts the files alphabetically from Z to A.

View items sorted in
Chronological order

Sorts the files by the last saved time, in descending order.

View items sorted in reverse
Chronological order

Sorts the files by the saved time, in ascending order.

View Items grouped by File
Type

Sorts the files by file type.
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Option Name Function

Respect Sort Order Property Respects the Sort Order property value specified in the
File/Folder Properties panel. This is the default.

View items by Title Displays the files by title and sorts the files by title. If an
item does not have a title, its name is shown.

View items by Name Displays the files by name and sorts the files by name. If
an item does not have a title, its name is shown.

Refresh View Refreshes all of the files and folders that you see in the
Configured Environments tree. Refresh View also shows the
dependencies of the file or folder that you have selected.

Show All Content files Filters the tree to show all content file types, except for
Master Files. To view Master Files, click Show only Master
files.

Show only Procedure files Filters the tree to show only this file type.

Show only Master files Filters the tree to show only this file type.

Show only HTML files Filters the tree to show only this file type.

Show only Maintain files Filters the tree to show only this file type.

Show only Image files Filters the tree to show only this file type.

Show only ReportCaster files Filters the tree to show only this file type.

Show only Library files Filters the tree to show only this file type.

Other files Filters the tree to show other file types.
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Viewing Nodes in the Configured Environments Tree

The Configured Environments tree displays the WebFOCUS Environments, Data Servers,
Domains, and Web Applications nodes. These are the development areas where you can
create content. If you have the Managed Reporting version of App Studio and WebFOCUS
installed on your machine, or configured a remote WebFOCUS 8 environment, a domain node
also appears. 

If a node under the Configured Environments Tree has been populated and contains content, a
green dot is shown on the node icon. If a node has been populated and does not contain any
content, a red dot is shown on the node icon. If a node has not been populated, App Studio
does not know if there is any content in that node and no dot is shown on the node icon. If you
create a new content in a node with a red dot on it, that node now has content in it and will
change to a green dot. If you delete all content in a node with a green dot, that node now has
no content in it and will change to a red dot.

Note: By default, the Configured Environments tree sorts files and folders by title. If you
change the sorting options to View Items by Name, the names of your files and folders will
display. Whether you display content by title or by name, the Domains, Data Servers, Projects
(optional), and Web Applications nodes do not display differently.

You can expand the nodes on the Configured Environments tree to view your configured
environments, folders, and application files. Use the filtering commands on the toolbar to sort
files alphabetically, display by name or title, or include the associated paths.

From the Configured Environments tree, you can manage content for each of your WebFOCUS
environments. This includes creating new folders or files, opening existing files, and copying
files. Right-click a node, folder, or file to view the shortcut menu of options. You can also open
files by double-clicking them.

You can also use the Refresh Descendants option to refresh a specific application or folder.
Right-click the application or folder that you want to refresh, and then click Refresh
Descendants.

Note:

You can use the shortcut menu on any file, select New, and click the type of content you
want to create, to create new content in the same location.

If a Master File is located in a nested folder (for example, folder xyz is within folder abc),
you must first use the Reporting Server Console to map the nested application folder as a
new application.

You can copy files from your desktop to the Configured Environments Tree.
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From the Configured Environments node, you can access the following shortcut menu option:

Add. Opens the WebFOCUS Environments Properties dialog box where you can add
additional environments.

From your WebFOCUS environment, in the Environments Tree panel, you can access the
following shortcut menu options:

Sign In. Allows you to sign in to your WebFOCUS environment. This option is only available
if you are not already signed in to your WebFOCUS environment.

Sign Out. Allows you to sign out of your WebFOCUS environment. This option is only
available if you are already signed in to your WebFOCUS environment.

Note: You can copy files that are not in App Studio and paste them in the Configured
Environments tree to use those files when creating your application.

Reference: Data Servers

The Data Servers node lists each Reporting Server that the WebFOCUS Client can access. This
node expands to display the files that you can use to develop WebFOCUS applications
successfully. 

The process of populating the application paths of the files in the Data Servers node is done
on a background thread. While this background thread is running, you can navigate on the tree,
open a folder, and create files. However, you will be unable to save a new file, or do anything
that requires a path list, such as create a new style sheet, until the background thread
completes. This section of the Configured Environments tree, which is visible, will populate.

From a data server, you can access the following shortcut menu options:

Manage Adapters. Opens the Select Server Node dialog box from which you can configure
a new adapter or edit the settings of an existing adapter.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and file information, such as
date, time, and size.

From the Applications folder, you can access the following shortcut menu options:

New Application. Creates a new application folder.

Configure Application Path. Opens the Application Path dialog box from which you can
create applications, add applications to the search path, map and reorder applications,
delete applications or mappings from the path.
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Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

From an application folder or a file, you can access the following shortcut menu options:

New. Creates a new folder or file. The following shortcut menu options are available when
pointing to New:

Procedure. Creates a new procedure folder in your current application folder.

Report. Creates a new report.

SQL Report. Creates a new SQL report.

Chart. Creates a new chart.

SQL Chart. Creates a new SQL chart.

HTML/Document. Creates a new HTML page or document.

Synonym. Creates a new Master File after you have selected a configured adapter, or
configure a new adapter.

Synonym via Metadata Canvas. Creates a new Master File in the Metadata canvas.

Define Function Library. Creates a user-defined function library. Any user-defined
functions created in this library are available for use in any content created within the
same folder as the library. After the creation of the first function, you can create
additional functions or edit existing ones. Once the initial function library is created,
future additions or modifications are done through the Procedure View panel.

Upload Data. Connects to the Upload Desktop File utility in the Reporting Server
Console. Using this utility, you can upload new data to an application. The data is
converted using default master data options, and is displayed for your verification
before the load is initiated. For details, refer to the Server Console Help system.

WebFOCUS StyleSheet. Creates a template WebFOCUS StyleSheet.

Text Document. Creates a text document that can be saved to a local project. You can
use the Add Comment or Remove Comment commands to comment on the file.

XML Document with ESRI Configuration. Creates a new XML document using an ESRI
configuration.

Application. Creates a new application folder in your current application folder.
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Duplicate. Creates a copy of the selected file in the Data Servers node.

Copy. Copies the selected file to the clipboard where you can paste it to a different node.

Paste. Pastes the cut or copied file.

Rename. Changes the name of the selected folder or file.

Delete. Deletes the selected folder or file. You will be prompted to confirm your deletion.
Click No if you do not want to delete an item, or click Cancel to abort the delete operation.
If you choose to abort the delete operation while deleting a list of items, Cancel will prevent
all subsequent items from being deleted.

Properties. Displays the folder properties in the Data Servers node.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

Reference: Projects

You can use the Projects node (optional) to develop content if, during installation, you used a
serial number that allows project development. The Projects node is part of the Configured
Environments tree. It helps you organize, develop, maintain, and deploy WebFOCUS
applications as a project.

Projects does not require the web-tier APPROOT and the Reporting Server APPROOT to match.
This is only necessary if you are developing content that requires the use of the Reporting
Server. An example of content that uses the Reporting Server would be an HTML Page that
runs procedures

If the APPROOTs do not match you will still see the Projects node and can create new projects.
However, the content you create can only be saved on the web tier and cannot access
Reporting Server files. An example of this type of content would be an HTML page that does
not run procedures.

You can clear the option, Start local Reporting Server, in the App Studio Options dialog box,
and if you try to create Reporting Server content, such as a report, you will receive an error
when selecting a Master File.

You can specify a Reporting Server to use for project development in the Environments List
dialog box.
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From the Projects node, you can access the following shortcut menu options:

New Project. Creates a directory in which you store your procedures. Opens the New
Project dialog box which facilitates the creation of your new project.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

From a project folder, you can access the following shortcut menu options:

Rename. Changes the name of the selected folder or file.

Delete. Deletes the selected folder or file. You will be prompted to confirm your deletion.
Click No if you do not want to delete an item, or click Cancel to abort the delete operation.
If you choose to abort the delete operation while deleting a list of items, Cancel will prevent
all subsequent items from being deleted.

New. Creates a new file. The following shortcut menu options are available when pointing
to New:

Procedure. Creates a new procedure folder in your current application folder.

Report. Creates a new report.

SQL Report. Creates a new SQL report.

Chart. Creates a new chart.

SQL Chart. Creates a new SQL chart.

HTML/Document. Creates a new HTML page or document.

Synonym. Creates a new Master File after you have selected a configured adapter, or
configure a new adapter.

Synonym via Metadata Canvas. Creates a new Master File in the Metadata canvas.

Define Function Library. Creates a user-defined function library. Any user-defined
functions created in this library are available for use in any content created within the
same folder as the library. After the creation of the first function, you can create
additional functions or edit existing ones. Once the initial function library is created,
future additions or modifications are done through the Procedure View panel.
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Upload Data. Connects to the Upload Desktop File utility in the Reporting Server
Console. Using this utility, you can upload new data to an application. The data is
converted using default master data options and is displayed for your verification before
the load is initiated. For details, refer to the Server Console Help system.

JavaScript File. Creates a new JavaScript file from which you can create original
JavaScript.

Cascading Style Sheet. Creates a base template from which you can create a unique
cascading style sheet (CSS).

WebFOCUS StyleSheet. Creates a template WebFOCUS StyleSheet.

Text Document. Creates a text document that can be stored to a project. You can use
the Add Comment or Remove Comment commands to comment on the file.

Properties. Displays the folder properties in the File/Folder Properties panel.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

Reference: Domains

The Domains node is storage space for data or information, and allows you to use App Studio
to administer and develop against a Managed Reporting environment. The Domains node lets
you manage resources and applications on remote servers, as well as on your local machine if
you have performed a full installation of App Studio. You can create and edit application files
on all remote servers from one easily accessible interface. You can also create and administer
reports for Managed Reporting from a Windows application rather than a web browser. 

From a Domains node, you can access the following shortcut menu options:

Impact Analysis. Enables you to generate a list that identifies the procedures that access
a specific Master File or field within a Master File.

New Folder. Creates a new folder in the specified Domains node.

Note: Using this option is not the same as creating a new domain.

To create a new domain, use the BI Portal New - Enterprise Domain option. This option
triggers the domain template, which creates domain-specific user groups and sub-folders
such as My Content. For more information, see the WebFOCUS Business Intelligence Portal
manual.

Using the New Folder option in App Studio does not trigger the domain template.
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Mode Manager. Allows you to edit private files, if you have the proper authorization setting.

Physical View or Shared View. Enables you to toggle between the two. Shared View
displays all folders (including empty folders) in the hierarchy that includes shared content.
Physical View suppresses empty folders in the hierarchy that includes shared content.
Physical View displays all folders that contain shared content.

Security. Enables you to control user permissions, which limit what development areas a
user can access. The options are:

Rules. Opens the Security Rules dialog box, where you set up simple and advanced
security rules for groups and users.

Rules on this Resource. Opens the Rules on this Resource dialog box, where you can
view and run reports on the security rules defined for the domain.

Effective Policy. Opens the Effective Policy dialog box, where you can view the effective
policy by privilege and user.

Owner. Opens the Set Resource Owner dialog box, where you can set the portal user,
set the group to which the user belongs, and publish the portal. Since ownership is set
at the Domain level, this option is not available for the folders and files under a
Domain.

ReportCaster Explorer. Opens the ReportCaster Explorer.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

From a folder or file, in the Domains node, you can access the following shortcut menu
options:

Impact Analysis. Enables you to generate a list that identifies the procedures that access
a specific Master File or field within a Master File.

New. Creates a new folder or file. The following shortcut menu options are available when
pointing to New:

Procedure. Creates a new procedure folder or file in your current application folder.

Report. Creates a new report.

SQL Report. Creates a new SQL report.

Chart. Creates a new chart.
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SQL Chart. Creates a new SQL chart.

HTML/Document. Creates a new HTML page or document.

Visualization. Creates a new chart, map, or grid.

Alert. Creates a new alert.

Reporting Object. Creates a new reporting object.

URL. Creates a new URL.

Collaborative Portal. Creates a new portal, in a tab within App Studio, using the Portal
Designer. For more information on the Portal Designer, see the Business Intelligence
Portal manual.

Page. Creates a new portal page, in a tab within App Studio, using the Page Designer.
For more information on the Page Designer, see the Business Intelligence Portal manual.

JavaScript File. Creates a new JavaScript file from which you can create original
JavaScript.

Cascading Style Sheet. Creates a new cascading style sheet.

WebFOCUS StyleSheet. Creates a new WebFOCUS StyleSheet.

Text Document. Creates a new text document.

Schedule. Creates a new schedule.

Distribution List. Creates a new distribution list.

Library Access List. Creates a new library access list.

Folder. Creates a new folder.

Blog. Opens the Blog Viewer, in a tab within App Studio, where you can manage and
read your blog posts. For more information on the Blog Viewer, see the Business
Intelligence Portal manual.

Upload Data. Connects to the Upload Desktop File utility in the Reporting Server Console.
Using this utility, you can upload new data to an application. The data is converted using
default master data options and is displayed for your verification before the load is
initiated. For details, refer to the Server Console Help system.

Publish/Unpublish. Allows or suppresses public access to every file within the selected
folder. Multiple folders can be selected at one time by pressing the Ctrl key while selecting
the desired folders.
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Hide/Show. Hides or shows every file in the selected folder, to users who are permitted to
access the folder. Multiple folders can be selected at one time by pressing the Ctrl key
while selecting the desired folders. You can specify which users can see this content by
changing the Do not show on user’s list property in the File/Folder Properties panel.

Security. Enables you to control user permissions, which limit what development areas a
user can access. The options are:

Rules. Opens the Security Rules dialog box, where you set up simple and advanced
security rules for groups and users.

Rules on this Resource. Opens the Rules on this Resource dialog box, where you can
view and run reports on the security rules defined for the domain.

Effective Policy. Opens the Effective Policy dialog box, where you can view the effective
policy by privilege and user.

Owner. Opens the Set Resource Owner dialog box, where you can set the portal user,
set the group to which the user belongs, and publish the portal. Since ownership is set
at the Domain level, this option is not available for the folders and files under a
Domain.

Duplicate. Creates a copy of the selected file in the Domains node.

Copy/Paste. Copies or pastes a folder or file.

Rename. Changes the name of the selected folder or file.

To ensure that all instances of the original name and references are updated, it is
recommended that you use the Save As option to rename an HTML page.

Delete. Deletes the selected folder or file. You will be prompted to confirm your deletion.
Click No if you do not want to delete an item, or click Cancel to abort the delete operation.
If you choose to abort the delete operation while deleting a list of items, Cancel will prevent
all subsequent items from being deleted.

ReportCaster Explorer. Opens the ReportCaster Explorer.

Source Control. Enables Source Control for the folder or file.

Properties. Displays the folder properties in the Domains node.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.
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Note: For more information on publishing and unpublishing folders and items within the
Domains, see the WebFOCUS Security and Administration manual.

Reference: Scheduling

Scheduling allows you to indicate the method and time at which the procedure should run. You
can schedule a procedure using one of the following options: 

Email

FTP

Printer

Report Library

domain

For more information, see the ReportCaster Guide.

Reference: Web Applications

The Web Applications node allows you to open files with the Text Editor, or the mode you used
to create them. 

Note: Based on the file type, different options may display.

From the Web Applications node, you can access the following shortcut menu options:

New Application. Creates a new application folder.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

From an application folder, you can access the following shortcut menu options:

Rename. Changes the name of the selected folder or file.

Delete. Deletes the selected application folder. You will be prompted to confirm your
deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete
operation. If you choose to abort the delete operation while deleting a list of items, Cancel
will prevent all subsequent items from being deleted.

New. Creates a new file. The following shortcut menu options are available when pointing
to New:

HTML File. Creates a page in html format. You can import existing HTML content, as
well.
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JavaScript File. Creates a new JavaScript file from which you can create original
JavaScript.

Cascading Style Sheet. Creates a base template from which you can create a unique
cascading style sheet (CSS).

Folder. Creates a new folder.

Properties. Displays the folder properties in the File/Folder Properties panel.

Refresh Descendants. Refreshes the contents of the application or folder in the Configured
Environments tree to omit deleted files, and show new files and updated file information,
such as date, time, and size.

From a file, you can access the following shortcut menu options:

Open. Opens the file.

Edit in Windows Associated Tool. Edits the file in your Windows associated tool.

Print. Prints the file.

New. Creates a new file. The following shortcut menu options are available when pointing
to New:

HTML File. Creates a page in html format. You can import existing HTML content, as
well.

JavaScript File. Creates a new JavaScript file from which you can create original
JavaScript.

Cascading Style Sheet. Creates a base template from which you can create a unique
cascading style sheet (CSS).

Duplicate. Creates a copy of the selected file in the Web Applications node.

Copy/Paste. Copies the selected file to the clipboard where you can paste it to a different
node.

Rename. Changes the name of the selected file.

Delete. Deletes the selected application folder. You will be prompted to confirm your
deletion. Click No if you do not want to delete an item, or click Cancel to abort the delete
operation. If you choose to abort the delete operation while deleting a list of items, Cancel
will prevent all subsequent items from being deleted.
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Properties. Displays the folder properties in the File/Folder Properties panel.

Reference: Node Population

Population is a check to see what content, if any, is contained within a node in the Configured
Environments tree. Node population occurs when you select a node in the Configured
Environments tree. The node icon will be different depending on whether population has
occurred. If a node contains files after population a green dot appears on the node icon. If a
node does not contain files after population, a red dot appears on the node icon.

If a node has been populated and contains content, deleting that content will change the green
dot to a red dot. Conversely, if a node has been populated and contains no content, creating
content in that node will change the red dot to a green dot.

Reference: Master File Shortcut Commands

The following shortcut menu options are available for a Master File:

Open. Opens the Master File in the Metadata canvas.

Create Report. Opens the Report Wizard, where you can create a new report.

Create Chart. Opens the Chart Wizard, where you can create a new chart.

Open in Text Editor. Opens the Master File in the Text Editor canvas.

Edit in Windows Associated Tool. Opens the Master File in your Windows associated tool.
Note that this only appears if you have a Windows associated tool in which to open the file.

Refresh Synonym. Regenerates the synonym. Use this option if the underlying object has
been altered.

Sample Data. Displays sample output for the Master File.

Impact Analysis. Enables you to generate a report that identifies the procedures that
access a specific Master File or field within a Master File.

Print. Prints the Master File.

Check. Tests the validity of the Master File.

Edit Access File as Text. Enables you to view and manually edit the Access File synonym.
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New. Creates a new folder or file. The following shortcut menu options are available when
pointing to New:

Procedure. Creates a new procedure folder in your current application folder.

Report. Creates a new report.

SQL Report. Creates a new SQL report.

Chart. Creates a new chart.

SQL Chart. Creates a new SQL chart.

HTML/Document. Creates a new HTML page or document.

Synonym. Creates a new Master File after you have selected a configured adapter, or
configure a new adapter.

Synonym via Metadata Canvas. Creates a new Master File in the Metadata canvas.

Define Function Library. Creates a user-defined function library. Any user-defined
functions created in this library are available for use in any content created within the
same folder as the library. After the creation of the first function, you can create
additional functions or edit existing ones. Once the initial function library is created,
future additions or modifications are done through the Procedure View panel.

Upload Data. Connects to the Upload Desktop File utility in the Reporting Server
Console. Using this utility, you can upload new data to an application. The data is
converted using default master data options and is displayed for your verification before
the load is initiated. For details, refer to the Server Console Help system.

WebFOCUS StyleSheet. Creates a template WebFOCUS StyleSheet.

Text Document. Creates a text document that can be stored to a local project. You can
use the add or remove comment to comment the file.

XML Document with ESRI Configuration. Creates a new XML document using an ESRI
configuration.

Application. Creates a new application folder in your current application folder.

Duplicate. Creates a copy of the selected file.

Copy/Paste. Copies the selected file to the clipboard where you can paste it to a different
node.
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Rename. Changes the name of the selected file.

Delete. Deletes the selected file. You will be prompted to confirm your deletion. Click No if
you do not want to delete an item, or click Cancel to abort the delete operation. If you
choose to abort the delete operation while deleting a list of items, Cancel will prevent all
subsequent items from being deleted.

Properties. Displays the folder properties in the File/Folder Properties panel.

Note: When a Master File is opened in the Text Editor canvas or the Metadata canvas, all other
open options from the shortcut menu are unavailable.

Opening Files in the Configured Environments Tree

In addition to opening files through the Application menu, or from the Quick Access Toolbar,
you can also open files from the development areas in the Configured Environments tree. 

To open a file in its native canvas, double-click the file or right-click the file, and then click
Open.

To open a file in the Text Editor canvas, right-click the file and then click Open in Text Editor.

To open a file in a Windows Associated Tool, right-click the file and then click Edit in
Windows Associated Tool. This option appears only if a Windows associated tool is
available. When you access this functionality, the file will open in a separate dialog box
using the relevant Windows tool.

Note: Files can only be opened in one area of App Studio at a time to ensure that your
changes are not overwritten by another opened version of the file. However, you are able to
open a file in App Studio and in a Windows Associated Tool at the same time. To ensure that
your changes are saved properly, you should only modify one opened version of the file at a
time.

Viewing Shared Files in the Configured Environments Tree

There are two ways of sharing contents in App Studio.

Publish. Allows you to share all the contents of a published folder with all users who have
access to that folder. A bold folder icon in the Configured Environments tree indicates a
published folder. A light folder icon in the Configured Environments tree indicates an
unpublished folder.

To publish a folder, right-click it and select Publish from the shortcut menu.
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Share. Allows you to share a content file created in the BI Portal, with a single App Studio
developer. When a file is shared, both the file icon and the folder icon appear with a shared
icon overlay in the Configured Environments tree.

Procedure: How to Share a Content File Between Two Developers

Using the BI Portal, an Advanced user can designate a content file to share with an App Studio
Developer user. This overview procedure gives the general steps needed to share a file.

1. In the BI Portal, an Advanced user creates a file in the My Contents folder of a domain
created in the BI Portal.

2. The Advanced user right-clicks the file and selects Share With from the shortcut menu. The
Advanced user designates an individual App Studio Developer to share with.

For more information, see the WebFOCUS Business Intelligence Portal manual.

3. In App Studio, the designated Developer user views or opens the file from the Configured
Environments tree.

Setting Up Access to WebFOCUS Environments

As you set up access to WebFOCUS environments, your settings are retained in a file named
wfscom.xml. WebFOCUS environment settings are typically stored in the following locations. 

Windows 7:

drive:\Users\user_id\AppData\Roaming\Information Builders\wfscom.xml

where:

user_id 

Is your Windows user ID.

Note:

This file and directory might not be visible, by default. To see this directory, open the
Windows Control Panel, click Folder options, and then click the View tab. Select Show
hidden files, folders, and drives, and click OK.

User IDs and passwords stored in wfscom.xml are encrypted to keep them confidential.

WebFOCUS environment properties apply to your current App Studio configuration.

To ensure access to the WebFOCUS tools that create charting procedures, alert
procedures, and Reporting Objects, you must develop against WebFOCUS environments
that are Release 8.0 Version 0.5 or higher. When App Studio connects to a WebFOCUS
environment, of a prior release, you will receive a WFSCom message.
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You can choose to remove this environment from your configuration files or leave the
environment, and continue to develop against other environments that you configure. If you
choose to remove the environment from your configuration files, you must restart App
Studio.

Procedure: How to Add a WebFOCUS Environment

A WebFOCUS environment consists of a web server, a WebFOCUS Client, and a Reporting
Server. Adding WebFOCUS environments lets you create and manage multiple environments,
such as development, test, and production instances.

To add a WebFOCUS environment, do the following: 

Specify a web server that includes a host name and port number.

Configure the HTML alias/context root to access the WebFOCUS Client. If you develop
applications in the Data Servers area and need to deploy the application to an environment
that has a different alias, see Working With the HTML Alias Property on page 107.

Provide the appropriate user credentials if web server authentication is required.

The following procedure provides the information you need to add a WebFOCUS Environment.

1. On the Home tab, in the Utilities group, click Environments.

The Environments List dialog box opens. This dialog box lists all WebFOCUS environments
defined for App Studio.
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2. Click Add.

The WebFOCUS Environment Properties dialog box opens, as shown in the following
image.

At the top of the dialog box is the Description field, followed by the Environment Settings
area. The Environment Settings area contains a series of buttons that represent
components in a WebFOCUS environment, and the required parameter fields to configure
that environment. When you configure an environment, the areas below the buttons can
change according to the parameters that are required.

3. In the Description field, type a description for the WebFOCUS environment. This
description appears in the Configured Environments tree.
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Note: The description cannot contain special characters, such as ., /, \, ?, *, and others.
A message with characters not allowed appears if one of the restricted characters is
detected during validation.

4. In the Web Component area, specify the web server information.

For some environments, once you specify the web server, all other settings default. If the
WebFOCUS environment you are accessing does not use default settings, or the
components require authentication, click the appropriate button in the Environment
Settings area to provide the parameters. The areas that follow explain the parameters
available for each component.

Note: WebFOCUS environment properties must be supplied in a specific order. For
example, if web server security is enabled, you cannot set the WebFOCUS Client script
name until you have provided valid web server credentials. Similarly, you cannot retrieve a
list of Reporting Servers until you have provided a validWebFOCUS Client Path.

As you select a component button in the WebFOCUS Environment Properties dialog box,
App Studio ensures that it has the necessary information before it displays the properties
of that component in the lower part of the dialog box. If the required information is not
available, you cannot proceed to the next component.

5. Click OK.

The WebFOCUS Logon - WebFOCUS dialog box opens and prompts you for a WebFOCUS ID
and password.

The WebFOCUS Logon - WebFOCUS dialog box populates the ID wfdesktop, by default. This
user ID is configured with WebFOCUS and allows self-service development: development
from the Projects (optional), Data Servers, and Web Applications area.

Access to the domain is restricted, and you cannot create new content with this user ID.
You can only see and run published content.

There is a check box option on the logon dialog box for remembering the ID or password.
By default, it is not selected. If you select this box, your credentials are stored and
encrypted in the wfscom.xml file, the local configuration file that stores information
processed by the App Studio communication layer.

To clear stored credentials, open the WebFOCUS Environment Properties dialog box and
select the environment that users need to make changes. Click WebFOCUS Client. Under
WebFOCUS Credentials, delete the User ID and Password information, and then clear the
Supply Credentials check box. 
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Note: A logon dialog box can also open for connection to the web server, application
server, or Reporting Server, depending on the security implemented in theWebFOCUS
environment that is being accessed.

6. Type the appropriate user name and password, and then click Logon.
The WebFOCUS Environment Properties dialog box closes.

7. In the Environments List dialog box, click OK.

Working With the HTML Alias Property

If you develop applications in the Data Servers area and need to deploy the application to an
environment that has a different alias, it is necessary to use a Generic alias. For existing
pages, open the HTML pages and change the alias. The pages will not work if you do not
change the alias to Generic.

Note: This option is only applicable to the Data Servers area.

To set an alias for a new page or change the alias for an existing page, you can:

Set the HTML alias property in the Properties panel for the DOCUMENT object.

Set the HTML Alias property value globally in the HTML Page section of the App Studio
Options dialog box.

For the DOCUMENT object, the HTML alias property on the Properties panel contains the
following values:

Custom. In the HTML page, the alias (szHtmlAlias) will have the value of the HTML Alias
from the settings in the WebFOCUS Environment Properties dialog box. Custom is the
default value, since applications developed in the Data Servers area are meant for self-
service applications.

Generic. In the HTML page, the alias (szHtmlAlias) will have a generic value. This allows for
files to be moved from one environment to the other.

2. Navigating in App Studio

WebFOCUS App Studio User’s Manual  107



The HTML alias property on the Properties panel is shown in the following image.

The HTML Alias property on the HTML Page section of the App Studio Options dialog box has
the same values and functionality as the Properties panel. When the value is changed for this
property, new pages will inherit the setting from the App Studio dialog box. This option is global
and will be available for each HTML page.
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Note: For existing non-self-service applications that need to be moved from development to
production, you can set the value of HTML Alias as Generic in the App Studio Options dialog
box. All existing pages will have to be opened and then saved with this setting before they are
moved to Production.

The HTML Alias property on the HTML Page section of the App Studio Options dialog box is
shown in the following image.

Note: To test the property, open the HTML page in the editor and verify the value of the HTML
Alias, szHtmlAlias. For Custom, the value should be the same as in the HTML Alias property in
the Environments dialog box, for example, szHtmlAlias=/ibi_apps/. For Generic, the value
should be szHtmlAlias=/ibi_html/.

Setting Up Local Machine Properties

Local Machine properties are optional. Click the Local Machine button to access the
WebFOCUS Environment Caching area. Select the options in this area to cache remote
directory and file information, and enable file-content caching.

The file content caching location path is for a Windows 7 machine.
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In caching, copies of files or information stored on a remote machine are temporarily stored on
your local App Studio machine. App Studio then works with the locally stored files.

Caching speeds App Studio performance because remote machines are not accessed and
queried every time you request information. This is especially useful when accessing
mainframes or when a network connection is slow.

However, caching should not be used when multiple developers are working with the same
files because they could overwrite changes made by other developers. By default, caching is
not enabled.

Two properties are available:

Cache remote directory and file information. This option caches information about files
stored in the WebFOCUS environment. This does not actually cache files, only information
about them. If you select this property, App Studio does not requery the Reporting Server
every time it needs a list of files stored in the WebFOCUS environment.

Enable file content caching. This option caches files typically stored on the server. App
Studio only retrieves files once. When you want to read or edit your files, App Studio uses a
cached copy. When you edit a cached file, the edited cached file is returned to the server
and replaces the actual file on the server.

App Studio retrieves information and files the first time you request them and then caches
them locally. App Studio then uses the cached copies until App Studio is restarted, or you click
the Clear buttons for each level.

Note:

If you create a new synonym, you have to perform a refresh to view the new files in the App
Studio Environments Tree panel when caching is enabled.

You cannot use the caching options for the local development environment if the Source
Control feature is enabled.

Specifying Web Component Properties

The Web Components button is typically selected by default. Web Component properties
specify how App Studio accesses the web server. The web server must be identified before any
other components. 

The following properties are available:

Host Name/IP Address. Specifies the host name or IP address where your web server is
running. This field is required and has no default value.
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Allow Host Aliases. If checked, enables you to configure multiple WebFOCUS instances
that have been installed on the same host machine.

Protocol. The protocol to use for accessing the web server (HTTP or HTTPS).

Port. The TCP/IP port for accessing the web server. Port 8080 is the default.

HTML Alias. Identifies the alias used to access content from the WebFOCUS environment
directory, ibi_html. In App Studio, there is no need to configure an ibi_html alias. The
ibi_html content is accessed through the ibi_apps alias. The configuration of this alias is:

/ibi_apps/ibi_html

where:

ibi_apps

Is customizable.

ibi_html

Is constant.

Client Path. Specifies how calls are made from App Studio to the web server. By default,
when you add a new WebFOCUS environment, it is set to use the WebFOCUS Servlet with
the default ibi_apps context path: 

/ibi_apps/WFServlet

where:

ibi_apps

Is customizable.

WFServlet

Is constant.

If the WebFOCUS environment uses a non-default context path, clear the Use Default check
box and provide the correct Client Path. For example:

/ibi_apps8/WFServlet

If the Client Path is incorrect for the environment, you receive an error when you click the
WebFOCUS button at the top of the page, or when you click OK to exit and save your
changes.
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If you do not know your path, ask your WebFOCUS Administrator or check the WebFOCUS
Administration Console of the environment to which you want to connect. The Client Path
settings for the environment are located under Utilities and Client Selection.

Use Default. Specifies that the default ibi_html alias is used. Keep this option selected
unless you change the HTML Alias value.

Note:

If the Client Path field is empty, and the Use Default check box is selected, there is a
problem connecting to theWebFOCUS Client. Ensure your web server is started and that
you typed the correct properties on the Web Components page. If you cannot connect,
contact your WebFOCUS Administrator.

If while providing a custom HTML Alias and Client Path, your connection fails because of
incorrect information and the Client Path is deleted, you can clear Use Default to restore
the values you entered. Click the Use Default check box to edit the HTML Alias and
Client Path, and type the correct information. If a custom ibi_apps alias or context path
is used, it needs to be entered in both the HTML Alias and Client Path fields. For
example:

HTML Alias:

/ibi_apps8/ibi_html

Client Path:

/ibi_apps8/WFServlet

Connection Timeout. The default time to connect to a WebFOCUS environment is 60
seconds. However, in some slow systems this needs to be increased to avoid connection
failures when the timeout period is reached. If timeout issues are experienced, please
increase this to 240 or higher. Also, increasing the timeout can address issues with slow
environments or environments that have many resources (Applications/files) during
development.

Login Timeout. Specifies how long App Studio should wait for the login credentials to be
validated. The default time is 15 seconds. You can set this to a higher value, if necessary.
You can configure this setting for each environment.

Web Component Authentication. Specifies whether authentication is required on the web
server. To set security, select Basic in the drop-down list, and type a web server user ID
and password. If this is set to None, the web server allows anonymous access.

For more information, see the WebFOCUS Security and Administration manual.
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WebFOCUS Properties

When you click the WebFOCUS button, App Studio makes a connection to your web server to
retrieve information about the WebFOCUS environment. Therefore, you have to first specify
Web Component properties, and your web server must be running. 

You are prompted to sign in to WebFOCUS to verify your configuration. You will also be
prompted to sign in to WebFOCUS if you click OK to exit the dialog box.

The following properties are available:

Client Path. Is specified in the WebFOCUS Component properties area, and only appears in
this pane for reference. This field is read-only and can only be changed in the WebFOCUS
Component properties area.

Select Language. Specifies the language of the WebFOCUS Client.

Supply Credentials. Specifies whether to supply and store credentials when you connect to
WebFOCUS and access the environment.

When the correct WebFOCUS Client Path is provided, you can specify properties for the
remaining component.

Data Server Properties

You can set authentication and view available Reporting Servers by clicking the Data Servers
button. When you select Data Servers, App Studio connects to the WebFOCUS Client and
retrieves a list of servers from its communication configuration file (odin.cfg).

The following property is available:

Supply Credentials. If selected, you can type a WebFOCUS Server ID and password for the
server highlighted in the list. Clicking Set stores the credentials with the environment
properties, and the ID entered is shown next to the server in the list. The credentials are
checked the next time you use a feature on that server, not when you click Set.

Specifying the Project Development Server

Note: These properties only apply to self-service application development, and when
performing project development.

If you use remote Project-based development and your remote environment has multiple
Reporting Servers, click the Project Development button to specify which server to use when
processing requests. This server is referred to as the Project Development Server. The Project
Development Server and the WebFOCUS Client must be installed on the same machine or use
the same Application Root directory (APPROOT directory) as each other.

2. Navigating in App Studio

WebFOCUS App Studio User’s Manual  113



The following property is available:

Project Development Server. This specifies which server to use for Project Development.
All servers defined in the WebFOCUS Client appear in the drop-down list.

Procedure: How to Edit an Existing WebFOCUS Environment

1. On the Home tab, in the Utilities group, click Environments. 

The Environments List dialog box opens.

2. Select the environment that you want to edit.

3. Click Properties.

The WebFOCUS Environment Properties dialog box opens.

4. Edit the WebFOCUS environment accordingly, and then click OK to accept your changes.

5. In the Environments List dialog box, click OK.

Procedure: How to Add a New Project

To add a project to the Projects node: 

1. In the Configured Environments tree, right-click the Projects node, and select New Project.

The Create a Project wizard opens.

In the Create a Project - Step 1 of 2 dialog box, you can:

Type a name for the new project you are creating.

Select a different directory name, or browse for an existing directory.

View the location and name of the new project.

2. In the first input field, type a name for the new project. The name can be a maximum of 18
characters in length including spaces.

3. The Create a Project wizard displays the project name as the default directory in the
second input field. You can optionally enter the name of a subdirectory associated with
another project file, so that the new project shares project files with the existing project.

The location and name of the new project displays at the bottom of the dialog box.

4. Click Next.

A message displays if the directory does not exist.

5. Click Yes to create the new directory.

The Create a Project - Step 2 of 2 dialog box opens.
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From this dialog box, you can add other directories to the project path. Project files in
those directories are visible to the project and are accessible for development.

6. Click Add to add other directories to the project path.

7. Select a folder you want to add to the project path, and then click OK.

Repeat this step to add more directories to the project path.

To change the order of the directories, select the directory, and click Move Up or Move
Down.

To remove a directory from the list, select the directory, and click Remove.

8. When you are satisfied with the order of the directories, and have no other changes, click
Finish.

The new project now appears under the Projects node.

You can update the directory folders associated with a Project after you create it by right-
clicking the Project and selecting Properties. The Properties dialog box opens, click the
Paths tab. In the Related Application Paths area, you can add, delete, and reorder the
directory folders. Click OK to accept the changes.

Mode Manager

If you have the manage private resources permission, you can use Mode Manager to view and
edit private files. To enable Mode Manager, right-click on the domain node and click Mode
Manager. Your view refreshes, displaying all private files in the domain. You can open and
make changes to these private files as needed. When you are finished, right-click on the
domain node and click Mode Normal. Your view refreshes, hiding the private files in the domain
node.

Note: When a file in the domain is marked as shared, and you do not have permission to save
the original file, you will only be allowed to use the Save As command to save the file. This will
allow you to save the file under a different name, leaving the original file untouched.

Working With the Environments Detail Panel

The Environments Detail panel is an optional panel, which contains panel customization
commands, the Environments Detail toolbar, the Configured Environments tree, and the
Details pane. To display the Environments Detail panel, on the Home tab, in the View group,
select the Environments Detail check box. 

The Environments Detail panel is similar to the Environments Tree panel except that content is
displayed in the Details pane rather than under the Configured Environments tree.
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From the Environments Detail panel, you can:

Customize the appearance of the panel.

Filter content listed under the WebFOCUS environments in the Configured Environments
tree.

Access configured WebFOCUS environments to create new content or modify existing
content.

Refresh an application or folder in the Configured Environments tree, to view new files and
updated file information, and omit deleted files.

When you select a folder in the Configured Environments tree, the content within that folder is
shown in the Details pane.

Reference: Environments Detail Toolbar

The Environments Detail toolbar contains the buttons and menus that you need to navigate
and filter the information that appears in the Configured Environments tree.

View Options

Presents options for viewing items (for example, alphabetical sorting or grouping), as
described in Environments Tree Toolbar on page 87. Note that the available icons for the
Environments Detail toolbar and the Environments Tree toolbar are the same.

Note: To sort content in the Environments Detail panel, you do not use the View Options
command. Instead, you would click the columns at the top of the Details pane to sort content
by name, size, type, last modified, or location.

Viewing File and Folder Properties

The File/Folder Properties panel shows overview properties of a folder or file selected in the
Environments Tree panel. For example, if you highlight a folder in the Environments Tree panel,
the File/Folder Properties panel shows information like the name and title of the folder and the
date it was last modified. If you highlight a report file in the Environments Tree panel, the File/
Folder Properties panel shows things like whether the report is enabled for Auto Link or Auto
Drill. 
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The File/Folder Properties panel is shown in the following image.

The options within this panel change according to the type of file or folder you select. You can
view the properties of a file or folder in the Data Servers, Projects (optional), and Domains
areas of the Configured Environments tree.
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Copying Property Values in the File/Folder Properties Panel

You can copy a property value from the File/Folder Properties panel. Right-click a property
value and click Copy to copy it to the clipboard. This is particularly useful if you want to capture
the full path of an open file.

Editing Properties in the File/Folder Properties Panel

The following table defines the properties that you can change for each node within the File/
Folder Properties panel.

Note: The changes that you make in the File/Folder Properties panel are not reflected in the
Configured Environments tree until you click outside of the panel.

Data Servers

Element Editable Panel Properties

Node Title. Changes the title of the Data Server node in the Configured
Environments tree.

Server Path. Indicates the fully-qualified path to the server.

Primary Folder Title. Changes the title of the primary folder in the Configured
Environments tree.

Server Path. Indicates the fully-qualified path to the server.

Subfolder Name. Changes the name of the selected subfolder in the
Configured Environments tree.

File Name. Changes the name of the selected file in the Configured
Environments tree.
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Projects

Element Editable Panel Properties

Node Title. Changes the title of the Projects node in the Configured
Environments tree.

Server Path. Indicates the fully-qualified path to the server.

Project Folder Name. Changes the name of the selected project folder in the
Configured Environments tree.

Application Paths. You can manually modify the name of the current
application path or you can select a new path using the ellipsis (...)
option.

Files Name. Changes the name of the file in the Configured Environments
tree.

Domains/domain

Element Editable Panel Properties

Node Title. Changes the title of the domain node in the Configured
Environments tree.

Server Path. Indicates the fully-qualified path to the server.
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Element Editable Panel Properties

Folder Name. Changes the name of the folder in the Configured
Environments tree.

Title. Changes the title of the folder in the Configured Environments
tree.

Summary. Adds summary information to the folder properties.

Sort Order. Specifies the order in which to list the folder or item in
the tree.

Do not show on user’s list. This value is set to No, by default. If
Yes is selected, this folder will display on the user’s list.

Auto Create My Content Folders. This value is set to Yes, by
default, to create a My Content folder for saving personal reports,
charts, or documents. You can optionally set this to No to disable
this functionality.

Automatically Open. This value is set to No, by default. If Yes is
selected, this folder will automatically be open in the next session
of App Studio.

Source Control Status. Displays whether or not Source Control is
set.

Server. This value defaults to the server that is currently in use. You
can use the drop-down list to affiliate a different server with the
folder.

Application Paths. This value defaults to the application path
indicated for the selected folder. You can modify this value as
needed.
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Element Editable Panel Properties

File Name. Changes the name of the file in the Configured Environments
tree.

Title. Changes the title of the file in the Configured Environments
tree.

Summary. Adds summary information to the folder properties.

Sort Order. Specifies the order in which to list the file in the tree.

Do not show on user’s list. This value is set to No by default. If Yes
is selected, this file will display on the user’s list.

Prompt for parameters. This value is set to Yes, by default. If No is
selected, you will not be prompted for parameters.

Run with OLAP. This value is set to No, by default. If Yes is
selected, you can run the report or procedure with OLAP.

Only run as deferred report. This value is set to No, by default. If
you select Yes, the report or procedure will run only as a deferred
report.

Use Title for Deferred Report Description. This value is set to No,
by default. If you select Yes, the title is used instead of the name,
as the description for a deferred report.

Schedule only. This value is set to No, by default. If Yes is selected,
you will only be able to schedule the report or procedure.

Enable Auto Linking. This value is set to No, by default. If Yes is
selected, Auto Linking enables you to develop and maintain
numerous referenceable reports and charts that can be linked
together.

Auto Link Target. Indicates whether the file is set as a target for an
Auto Link drill down. This value is set to No, by default.
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Element Editable Panel Properties

File Enable Auto Drill. This value is set to No, by default. If Yes is
selected, Auto Drill allows you to navigate through different levels
within the dimension hierarchy of your data source.

Source Control Status. Displays whether or not Source Control is
set.

Server. This value defaults to the server that is currently in use. You
can use the drop-down list to affiliate a different server with the file.

Application Paths. This value defaults to the application path
indicated for the selected file. You can modify this value as needed.

Procedure: How to Enter Titles and Summaries in Multiple Languages

In App Studio, you can dynamically switch to another language to display screen text in that
language. Available languages are determined by your settings in the WebFOCUS
Administration Console.

In addition, you can enter your file and folder titles and summaries in multiple languages using
the Language Properties title and summary dialog boxes. So, when you dynamically switch
languages, the titles and summaries automatically appear in the selected language. This can
help streamline your collaborative, multi-language development work.

Note: In order to enable the Language Properties dialog box, you must select the Enable
Dynamic Language check box in the Dynamic Language Switch area of the Configuration tab in
the WebFOCUS Administration Console. For more information, see the WebFOCUS Security and
Administration manual.

1. In the Configured Environments tree, right-click a file or folder and select Properties from
the shortcut menu.

The File/Folder Properties panel opens. The Title property value is the same as the Name
value, by default. The Summary property value is blank, by default.

2. Click in the Title property field to edit the title.

An ellipsis button appears on the right side in the Title property field.

3. Click the ellipsis button.

The Language Properties dialog box for titles opens.
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The Default column is where you specify the title that displays unless it is explicitly
overridden by another language title.

The Language column displays the languages that are enabled in your installation of App
Studio.

4. Enter titles as needed in the Title column and click OK.

The Language Properties dialog box closes. The titles are saved.

5. Click in the Summary property field to edit the summary. Repeat the steps above to enter
and save the summary language text.

Application Paths Dialog Box

If the Projects node is selected (optional), the Application Paths of a project folder (.gfa)
display in the File/Folder Properties panel when you select the project from the Projects area.
You can add, remove, or reorder the associated application paths in the Application Paths
dialog box.

Open the Application Paths dialog box by clicking the ellipsis button next to the Associated
Paths information. The Application Paths dialog box displays a list of applications that you can
associate with your project and a list of projects that are currently associated with your project.

Adding or Removing Applications

To add an application to the project, click the name of the application in the Available list, and
then click add. Click OK to view your changes in the File/Folder Properties panel.

To remove an application from the project, click the name of the application in Selected list,
and then click remove. Click OK to view your changes in the File/Folder Properties panel.

Reordering Applications

To reorder an application in the Available list, click the name of the Application and then click
up or down. Click OK to view your changes in the File/Folder Properties panel.

Editing Areas of Functionality Using the View Tabs

You can use the view tabs to edit different areas of functionality for the same document.
These tabs show information that would be inaccessible from any other view tab.

Designing the Layout of a Page Using the Design View Tab

The Design View tab is accessible when you are creating an HTML page or document. From
here, you can design the layout of your page by adding controls and components to the
canvas. This is tab is selected by default when you are creating an HTML page or document.
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Creating and Modifying Parameter Values Using the Parameters View Tab

The Parameters View tab is accessible when you are creating an HTML page or active
dashboard. From here, you can create and modify parameter values, input controls, and
customize parameter conditions. You can also bind parameters to controls and chain controls
to one another.

The Parameters tab consists of the following components:

Input control objects.

You may select the input control object to view and edit the Properties and settings of the
control.

Creating an input control from the Design view prompts you to create a bound
parameter on the Parameters tab.

Editing an input control, which is inserted when setting input controls for new
parameters.

Add new parameters.

Right-click anywhere on the Parameters tab to add a new parameter.

Note: Manually adding a parameter creates an unbound parameter.

Refresh unresolved parameters.

All parameters on the parameters tab are parsed every two minutes to check if any are
unresolved. If there are any unresolved parameters, their surrounding polygon is colored
red. If you want to check for unresolved parameters on demand, right-click and select
Refresh unresolved.

Binding controls and parameters.

Input controls and parameters can be bound and unbound from the Parameters tab.

You may bind a parameter to an input control, or bind an input control to a parameter.

Binding a parameter to a control makes it an incoming parameter that will populate the
control. Drag a parameter object to a control object on the Parameters tab.

Binding a control to a parameter will populate the parameter. Drag a control object to a
parameter object on the Parameters tab.

Chain one control to another.
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Chaining will populate controls based on the selected value from the prior control in the
chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create
conditions on links in a chain. Chains are represented by lines connecting control objects
on the Parameters tab. By clicking the arrow head in a link of a chain, the Properties and
settings dialog box enables you to modify and set properties and conditions of the chain.

Note: Chaining is applicable only for controls, not parameters.

Creating JavaScript and Cascading Style Sheets Using the JavaScript and CSS View Tabs

The Embedded JavaScript and Embedded CSS View tabs are accessible when you are creating
an HTML page. From here, you can create JavaScript code and cascading style sheets (CSS)
for use in your HTML page. You can reference existing cascading style sheet files and
JavaScript files by typing the URL in the URL/Find File area of the Settings panel. You can also
search for these files by using the CSS or JavaScript commands.

Embedded code is used only in the host HTML file. External code is available to be used by
multiple files.

Procedure: How to Customize Titles Using jQuery Tooltips

The following procedure describes how to customize titles, using jQuery and Internal CSS.

1. Create an HTML page.

2. Add a component or control to the page.

3. Navigate to the Properties panel.

4. Type a value for the Title property, under the Core attributes section.

5. Click the canvas to select the DOCUMENT object.

6. On the Properties panel, click the lightning bolt icon on the toolbar to show the events.
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7. For the Load event, click the column on the right to display the ellipsis button, as shown in
the following image.

8. Select the Embedded JavaScript view tab on the HTML canvas.

9. After the comment lines, add a new line, and type the following code, as shown in the
following image.

$(document).tooltip();
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10. Navigate to the Embedded CSS tab, as shown in the following image.

11. Enter a new line after the first class definition and type the following as the new class
name.

.ui-tooltip

12. Add the following CSS Styles, as shown in the following image.

Color: white;

Font-size: small;

Background: black;
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Border-radius: 20px;

Note: You can add any styling that you want.

13. Save and run the HTML page. You can hover the mouse over objects to show the styled
tooltips.

Customizing the Panels

Similar to the ribbon tabs, App Studio features open panels that provide additional options to
assist in the development of your application. Not all panels open at the same time, nor do
they provide the same options. When you launch App Studio for the first time, only the
Environments Tree panel appears docked to the edge of the canvas. The File/Folder Properties
panel also appears, but is auto hidden. 

All panels, except the Environments Tree panel, are auto hidden by default. You can control the
visibility of the panels in the View groups on the Home tab and Utilities tab. You can also
customize the appearance and placement of each panel around your canvas.

By default, all panels, except the Environments Tree panel, are auto hidden when they first
open. You can use the panel customization options, which are located in the upper-right corner
of the panel, to change the appearance and location of the panels around the canvas.

Procedure: How to Rearrange Panels on the Canvas

To rearrange a panel on your canvas using the panel properties menu, follow these steps:

1. Click the Window Position button .

The panel properties menu opens.

2. Select an option from the panel properties menu.
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The options available are:

Floating. Undocks the panel and allows you to move it freely around the canvas.

Docking. Docks the panel onto the edge of your canvas where it last appeared.

Tabbed Document. Opens the panel in the canvas area, as a tab. This option is
unavailable in App Studio.

Auto Hide. Hides the panel as a tab on the edge of your canvas. When you pause over
the tab, the panel reopens. 

Hide. Closes the panel. 

Note: You can also open the panel properties menu if you right-click the top of the panel.

Procedure: How to Pin and Unpin Panels to the Canvas

You can pin a panel to the canvas to keep it open while you develop your application. When
you unpin the panel, it becomes auto hidden again, and appears as a tab on the edge of the
canvas. When you hover the mouse over this tab, the panel reopens. 

To pin a panel to your canvas, click the Auto Hide horizontal pin button .

To unpin a panel to your canvas, click the Auto Hide vertical pin button .

Procedure: How to Close and Reopen Panels

To close a panel, click Close  in the upper-right corner of the panel.

To reopen the panel, go to the Home tab, and in the View group, and select the appropriate
check box.

To reopen a panel in the HTML canvas, go the Utilities tab, and in the View group, select
the appropriate check box.

Using Handles

You can dock floating panels within the canvas to ease accessibility. When you drag a panel
across the App Studio canvas, a set of handles appears. These handles guide the placement
of the panel, and automatically dock the panel to the edge of the canvas upon which you rest
the mouse. 
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The following image shows an example of the handles that appear when you drag the
Environments Tree panel across the canvas.

Procedure: How to Dock Panels Around the Canvas Using Handles

1. From the panel customization toolbar, click the arrow, and then click Floating.

2. Drag the panel across the canvas and rest the mouse on a handle.
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When you rest the mouse over a handle, a shaded area appears. This shaded area
provides a preview of where the panel will dock if you release the mouse, as shown in the
following image.

3. Release the mouse when you are satisfied with the previewed location of the panel.

The panel automatically docks to the edge of the canvas.

2. Navigating in App Studio

WebFOCUS App Studio User’s Manual  131



Additional panels open as you develop applications throughout the product. To conserve space
around the canvas, you can combine these panels. When you mouse over a docked panel, a
tabbed handle option appears, as shown in the following image.

This handle option combines the panels into a single container with tabs. You can switch
between the panels by clicking the appropriate tab at the bottom of the container. An example
of the Environments Tree tab and File/Folder Properties tab, in a combined panel container,
are shown in the following image.
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Chapter3
Creating Metadata

Defined simply, metadata is data about data. Metadata describes the characteristics of
your data sources to App Studio and gives it the information it needs to access those
data sources. This insulates you from the need to know how to optimally access the
data, so that you can concentrate on using the data for reporting, charting,
visualizations, and applications. Examples of metadata components are data type, data
location, and data content and information about how to connect to it. Metadata can be
generated whenever data is created, acquired, added to, deleted from, or updated in any
data source within an enterprise.

In this chapter:

Understanding Data Terminology

Accessing Data

Generating a Synonym

Changing Views in the Metadata Canvas

Viewing and Editing Synonym Attributes

Viewing Data Profiling Characteristics

Enhancing a Master File with
Expressions

Describing Group Fields and Repeating
Fields in a Synonym

Parameterizing a Synonym with Variables

Adding Indexes to a Synonym

Creating Cluster Joins

Creating a Synonym for Cube Data
Sources

Defining a Business View of a Master
File

Applying Database Administrator (DBA)
Security

Implementing DBA Security Using
WebFOCUS Language

Analyzing Procedures Using Impact
Analysis
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Understanding Data Terminology

The smallest meaningful element of data in a data source is referred to as a column (for
relational data sources) or a field (for non-relational data sources). Column and field are used
interchangeably throughout this content. Every column or field has several characteristics,
such as the data type (character, date, integer, or some other type) and length or scale. Field
characteristics can also include output display options, such as comma inclusion, currency
symbol, date display, and so on. For consistency, all fields should be included in the
metadata, so all users get the same view of the data. However, you can create a logical view
of the data in which only a subset of the fields are available.

Certain fields in a data source may have a one-to-one relationship with each other and
describe a group of related characteristics. For example, each unique ID number represents
only one employee. These fields can be grouped together into a segment or, in relational
terms, a table. You can relate segments to each other by creating a multi-segment data source
or by joining segments together. Segments are the building blocks of larger data structures.

Fields can be categorized as measures (facts) or dimensions based on how they will be used
in a request.

A measure or fact is a numeric value, such as Gross Profit or Cost of Goods Sold, that you may
want to aggregate. All numeric values that can logically be summed are measures. Numeric
fields that cannot be summed, such as product number and order ID, are not treated as
measures. Instead, they may be used in the same way as dimension fields to analyze
measures. It is up to you to understand your data and determine whether each numeric field
should be summed. Related measures can be organized into measure groups. For example,
Gross Profit and Cost of Goods Sold can be part of a Sales measure group.

A dimension is a way to categorize data. You can use a dimension to analyze and compare
measures. Generally, any field that is not a measure, usually an alphanumeric field such as
product, is a dimension. Dimensions can be organized into hierarchies to define the
relationships between the fields in the hierarchies. For example, a Geography hierarchy can
contain the Continent, Country, State, and City dimensions. You can also define dimension
fields that are not part of a dimension hierarchy.

An attribute is a collection of related objects in a dimension. For example, in the Model
dimension, there are attributes for Brand, Brand Type, and Product Name. Attributes are
specific to a dimension and are typically more specific than general in nature.
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Accessing Data

When your App Studio application accesses data, App Studio needs to know how to interpret
the data that it finds. A Master File, which is the primary component of metadata, is a map of
the segments in the data source and all of the fields in each segment. The Master File also
identifies the name of the data source and the type of data source it is.

For some types of data sources, the Master File is supplemented by an Access File. An Access
File includes additional information that completes the description of the data source. For
example, it includes the full data source name and location. You require one Master File and,
for some data sources, one Access File to describe a data source. These metadata files
(Master File and Access File) are referred to as a synonym.

Synonyms are stored separately, apart from the associated data source. Your App Studio
application uses a synonym to interpret a data source as follows:

1. It identifies the data sources available and their respective fields.

2. It examines the security rules, if Information Builders data source security (DBA) has been
specified for the data source, and ensures that user access is allowed based on any DBA
security specified.

3. It identifies the Access File for the data source, if that data source requires an Access File.

The data source content is interpreted based on the information in the Master File and, if
applicable, the Access File.

Working With Data Adapters

With the appropriate WebFOCUS Data Adapters, you can access data from many different
sources, including the following:

Relational data sources, such as Db2 and Oracle.

Hierarchical data sources, such as IMS and FOCUS.

Indexed data sources, such as ISAM and VSAM.

Network data sources, such as CA-IDMS.

Sequential data sources, both fixed-format and delimited format.

Multi-dimensional data sources, such as SAP BW and Essbase.

XML data sources.
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Every adapter is specifically designed for the data source that it accesses, and, as a result, is
able to translate between SQL or WebFOCUS and the data management language (DML) of the
data source. The adapter manages the communication between the data interface and the
data source and returns either answer sets or messages to the requestor. Adapters provide
solutions to product variations, including product differences in syntax, functionality, schema,
data types, catalogs, data representations, message processing, and answer set retrieval. It is
the adapter that manages the synonym creation process. 

The parameters required to configure supported adapters and to create synonyms for the
corresponding data sources are described in detail in the Adapter Administration manual.

Generating a Synonym

A synonym defines a unique logical name (also known as an alias) for each web services
operation. Synonyms are useful because they insulate client applications from changes to the
location and identity of a request. You can move or rename a request without modifying the
client applications that use it. You need to make only one change, redefining the request
synonym on the server. Synonyms provide support for the extended metadata features of the
server, such as virtual fields and security mechanisms. Creating a synonym generates a
Master File and an Access File.

Often, a synonym already exists on the server, and reporting can begin at once. However, if the
synonym you require does not exist on the server, an authorized server or application
administrator can create it directly using the Metadata canvas in App Studio.

To begin creating a synonym, you use the Data Source Definition Wizard, which guides you
through the steps that you need to follow to open a recently used synonym, create a new
synonym, or edit an existing synonym. You use the Metadata canvas, and the available tab and
panels, to develop your synonym. This enables you to explore DBMS catalogs and select the
objects for which you wish to create synonyms. The Metadata canvas prompts for the
information it needs to create a synonym for a particular data source and stores the generated
synonym on the server.

In order to generate a synonym, you must be authorized to use the data against which you plan
to report and you must have configured an adapter to access that type of data. When you
begin to create a synonym, App Studio opens the Select adapter to configure or Select
connection to create synonym window. The option to create the synonym becomes available
only after the adapter is successfully configured.

Once you have generated a synonym, you can report against the synonym. In many instances,
the configured adapter and the generated synonym are all you need to access your data and
create reports and graphs.

Generating a Synonym

136  Information Builders



However, you may wish to enhance the synonym in order to implement particular capabilities
that are supported in the WebFOCUS data description language. To do this, you can use the
Metadata canvas.

When you use the Metadata canvas, there is no need to know the data description language.
All viewable and editable attributes of the synonym components display. If you make changes
to the generated synonym, the Metadata canvas validates your entries and displays messages
if they violate the underlying syntax of the data description language.

Note: If you are comfortable working directly with syntax, you can open the synonym
components in a text editor. For detailed information about the underlying syntax, see the
Describing Data With WebFOCUS Language manual.

Enhancing a Synonym

The following are some of the attributes you might want to add to the synonym to enhance your
data access and reporting capabilities. You can: 

Apply security rules for fields and values to ensure that user access is based on
Information Builders data source security (DBA) specifications.

Add virtual columns (DEFINE fields) and columns for aggregated values (COMPUTE fields).

Add filters to specify data selection criteria.

Add group definitions for data sources that support groups.

Add meaningful titles and descriptions, including multilanguage variations.

Change the format of fields (for example, the size of an alphanumeric field or the format of
a date field).

Create a cluster join view by linking available synonyms to create a multisegment
(multitable) file for reporting.

Create business views of the metadata in order to limit the fields available to any retrieval
request that references the business view and to group fields together based on their roles
in an application.

Define parent and child hierarchies for cube data sources.

Procedure: How to Access the Metadata Canvas

In App Studio, you create new synonyms and edit existing synonyms using the Metadata
canvas. You can access the Metadata canvas through the Data command, in the Content
group, on the Home tab.
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This launches the Data Source Definition Wizard, where you can open a recently used Master
File, create a new Master File, or edit an existing Master File. The Data Source Definition
Wizard is shown in the following image.

Click Create New Synonym, which opens the Select Application pane of the Data Source
Wizard. Select a location to create your synonym and click Finish to open the Metadata
canvas.

Click Open Existing, which opens the Select Data Source pane of the Data Source Wizard.
Select a data source to edit and click Finish to open the Metadata canvas.
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The Metadata canvas opens, as shown in the following image.

Note: The examples in this document use a multi-fact structure containing multiple Fact tables
that have corresponding Dimensions described in the Master File.

Building a Synonym Using the Metadata Tab

The Metadata canvas displays the Metadata tab, which contains all the commands necessary
to build your synonym.
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The Metadata tab contains groups and commands that provide quick access to commonly
performed functions while working in the Metadata canvas. You can use the Metadata tab to
undo or redo actions, manipulate selections of data, find and edit text, switch to different view
tabs, insert notes, run different reports, and switch between different view modes. The
behavior of the command is determined by the selected object. Therefore, certain tab
components may be inactive. The Metadata tab is shown in the following image.

Restoring Actions Using the Undo/Redo Group

You can undo and redo actions. The Undo/Redo group is shown in the following image.

The commands are:

Undo

Undoes the last action.

Redo

Restores a previously undone action.

Deleting, Cutting, Copying, and Pasting Using the Clipboard Group

You can delete, cut, copy, and paste sections from the canvas. The Clipboard group is shown
in the following image. 

The commands are:

Delete

Deletes your selection.
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Cut

Cuts your selection.

Copy

Copies your selection.

Paste

Pastes from your clipboard to the designated area.

Searching and Revising Text Using the Editing Group

You can find specific text, select the entire canvas, replace specific text, move to a specific
point in the canvas, apply case formatting to text, and add comments. The Editing group is
shown in the following image.

The commands are:

Find

Finds specified text.

Find Next

Finds the next instance of specified text.

Find Previous

Finds the previous instance of specified text.

Select All

Selects the entire canvas.

Replace

Replaces the specified text with different text.

Go To

Moves your view of the canvas to the specified area.

Invert Case

Inverts the case of the selected text.
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Upper Case

Upper case the selected text.

Lower Case

Lower case the selected text.

Comment Selection 

Comment the selected text.

Uncomment Selection

Uncomment the selected text.

Switching Between Views and Aerial View Using the View Group

You can switch between the different views and switch Aerial view on or off. The View group is
shown in the following image.

The commands are:

Field

Switches to the Field View. The Field View shows a list of objects on the left, with the
attributes and values of the selected item on the right.

Segment

Switches to the Segment View. The Segment View shows the segments that the synonym
contains. The Segment View shows a list of objects on the left, with the attributes and
values of the selected item on the right.

List

Switches to the List View. The List View shows a list of objects on the left, with the
attributes and values of the selected item on the right.

When you right-click a column heading in the List View, a shortcut menu provides options
to sort the display based on ascending or descending column values. The display can be
sorted by any column.

Modeling

Switches to the Modeling View.
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Text

Switches to the Text View tab.

You can print the Master File code by selecting Print from the Application menu, performing
search operations, and making changes, if necessary.

Access File Text

Switches to the Access File Text View tab.

The Access File Text View shows the description of the Access File for a synonym, which is
used to access the database.

Note: You can print the Access File code by selecting Print from the Application menu,
performing search operations, and making changes, if necessary.

Aerial View

Switches between showing and hiding Aerial view. This view is only available when in the
Modeling View tab.

Inserting Nodes Using the Insert Group

You can insert a node. The Insert group is shown in the following image.

The commands are:

Insert

Enables you to insert one of the following:

Reference to Existing Synonym as Child

The reference is a pointer to the source synonym using the synonym as a child. If you
subsequently make changes to the source synonym, reopening the current synonym
will reflect those changes.

Reference to Existing Synonym as Root

The reference is a pointer to the source synonym using the synonym as a root. If you
subsequently make changes to the source synonym, reopening the current synonym
will reflect those changes.
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Copy of Existing Synonym

Adds a static copy of an existing synonym to the current synonym. If you subsequently
make changes to the source synonym, the current synonym will not reflect those
changes.

Segment via Metadata Import

Enables you to create and add a new synonym to the current synonym using the
Create Synonym dialog box.

Segment Manually

Adds a synonym that must be coded manually.

DBA

Adds DBA security to the segment.

Field

Adds a general column to the segment.

Define

Adds a virtual or defined column to the segment.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.

Sort Object

Adds a Sort Objects folder and a sort object. This option is available only if Support
extended options is selected.

Variable

Adds a Variables folder and a variable to the segment.

Style

Adds a Styles folder and a style object. This option is available only if Support
extended options is selected.

Subquery

Adds a subquery to the fields list.
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Running a Sample Data, Data Profiling, or Impact Analysis Report Using the Reports
Group

You can run a Sample Data report, Data Profiling report, or Impact Analysis report. The Reports
group is shown in the following image.

The commands are:

Sample Data

Enables you to view and refresh sample data for the selected segment or synonym.

Data Profiling

Runs a Data Profiling report, which provides the data characteristics for synonym columns.
The Statistics, Count, and Key Analysis options are available.

Impact Analysis

Runs an Impact Analysis report for the particular column in the workspace. An Impact
Analysis report identifies the procedures that access a Master File or column within a
Master File.

Showing Properties, Data Flow, and View Panels Using the Tools Group

You can switch between showing or hiding the Properties, DBA, and Business View panels. You
can also recreate the default Business View structure and edit the user options. The Tools
group is shown in the following image.

The commands are:

Properties

Switches between showing and hiding the Properties panel.
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Quick Copy

Generates a simple Data Flow without using the Data Flow designer. For the selected
tables, all rows and columns are copied to new tables.

Although no transformations or where conditions are generated, the Data Flow can still be
opened as such and additional criteria can be added.

DBA

Switches between showing and hiding the DBA panel.

Business View

Switches between showing and hiding the Business View panel. Enables you to create a
Business View and a custom Master File that can use selected columns from the original
synonym. In addition, you can customize field names, titles, and descriptions.

Options

Allows you to edit the user options. When you click Options from the Tools Group, the
Options dialog box appears. It enables you to set preferences and customize the look of
the Metadata canvas.

Setting Preferences for the Metadata Canvas Using the Options Dialog Box

Click the Options button in the Tools group to open the Options dialog box.

Reference: Synonym Editor Options Settings

When you click Options from the Tools group, the options dialog box appears. It enables you to
set preferences and customize the look of the Metadata Canvas.

The Synonym Editor settings page has the following fields and options:

Use application directory name with synonym

If this check box is selected, an application directory name is used when you select a
synonym name for both referencing an existing synonym and a transformation with
db_lookup.

Undo/Redo Limit

Specifies the maximum number of undo and redo operations allowed in the Synonym
Editor.

Support extended options

If this check box is selected, both the Sort objects and Styles folders appear when you edit
a synonym.
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Enable insert copy of existing synonym

If this check box is selected, this option will be available in the shortcut menu when a
synonym or segment name is selected.

Insert child segment with snowflakes

Inserts a reference to the selected table and any tables that the base synonym references
through foreign keys.

Automatically arrange segments/folders in Modeling View

If you select or drag multiple or individual tables while in Modeling View, they will be
automatically arranged for you.

Show parent segments in Join Editor

If this check box is selected, it controls whether or not columns in parent segments are
displayed in the Join Editor for a cluster join or a synonym that references or includes,
other synonyms.

Automatically detect entry segment

This information is not yet available.

Default Join Type

Sets the default Join type.

Unique. This join indicates a single instance (one-to-one) type of join. At run time, each
host record has, at most, one matching record in the cross-referenced file. This value is
the default.

Multiple. This join indicates a multiple instance (one-to-many) type of join. At run time,
each host record can have many matching records in the cross-referenced file.

Auto Calculate Missing

Allows you to adjust the MISSING attribute.

Prompt. Prompts before adjusting the MISSING attribute.

ON. Adjusts the MISSING attribute without prompting.

OFF. Does not adjust the MISSING attribute.

Modeling View Line Colors

Allows you to set colors for connector lines in the Modeling View.

Default. Changes the color lines in the Modeling View.
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Highlighted. Changes the color of the highlighted lines in the Modeling View.

No keys. Changes the color of lines with no keys in the modeling view.

Reset Colors

Restores the default colors.

Reference: Synonym Editor Format Options Settings

The Format pane is available from the Options dialog box. To open the Options dialog box,
select Options from the Tools group. Expand the General node, and select Format.

The Fonts section has the following fields and options:

Category

Allows you to set the font for text in the process flow workspace, reports, text views, and
log views.

Font

Launches a dialog box for specifying font settings.

Reset Font to Defaults

Restores the default fonts.

Reference: Synonym Editor Column Management Settings

The Column Management pane is available from the Options dialog box. To open the Options
dialog box, select Options from the Tools group. Expand the General node, and select Column
Management.

Column Management user preferences enable you to choose which columns to display on the
grids for transformations, column selection, joins, and sorts. You can also set the column
display order. The settings apply to all column-related dialog boxes. 

The Column Management pane has the following fields and options:

Customize column display

Lists the column-related dialog boxes that can be customized. Expanding a folder will
display check boxes that can be used to add columns to each dialog box.

Reset to default

Restores the default values.
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Column name display strategy 

Controls the information that appears in trees and grids. The available options are Name,
Title, Description, and Alias. If no Title, Description, or Alias exists, the display will default
to the Name.

Note: It is recommended that you use Title when working with Business Views.

Function display strategy
Controls how functions are identified on the functions tab in the calculators. By default,
the function syntax is displayed. It can be changed to a short description, which displays a
brief description of what the function does instead.

Use segment to qualify field reference

Indicates whether to qualify field names with the segment name in which they reside for
duplicate field names only or always.

Expand any of the available Customize column display options to see default settings. Not all
columns are on every grid. The following columns can be added:

Alias

Assigns an alternative name for a column or the real column name for a DBMS synonym.

Application

Indicates the application where the synonym resides.

Belongs To Segment

Shows the parent segment in the base synonym.

Connection

Indicates the adapter connection name used.

Data Origin

Indicates the date the synonym was created.

Date Modified

Indicates when the synonym was last modified.

Description

Is a description or comments about the column.

Expression

Is the expression for the column.
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Extension

Indicates the suffix (data source type) of the synonym.

Field Type

Indicates that a column is an index (I) or is read-only.

Format

Is the type and length of a column data as stored.

Function

Indicates the name of the function.

Geographic Role

Describes the geographic role of the column.

Has Foreign Keys

Indicates that the synonym includes foreign keys.

Index

Indicates an index column.

Join Condition

Indicates the condition for the join.

Join Parent

Indicates the parent of the join.

Join Status

Out of the candidate list, indicates the strongest candidate or candidates for insertion.

Join Strategy

Indicates the strategy for the join.

Join To

Indicates whether you can join to the column.

Keys

Indicates the keys in the synonym.

Length

Is the column length.
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Name

Indicates the column name.

Nulls

Indicates whether or not the column can contain null data.

Number of Segments

Indicates the number of segments in the synonym.

Order

Indicates the order of the column in the segment.

Parent(s)

Indicates the parent or parents on the active Metadata canvas.

Prefix

Indicates a prefix for the column.

Primary Key Tables

Indicates the primary key for the synonym.

Property

Indicates whether the column is an attribute or a measure.

Real Table Name

Indicates the actual name of the table or the physical file name.

Reference

Indicate a reference for the column to an index column.

Scale

Is the maximum number of digits to the right of the decimal.

SCD Type

Used for processing slowly changing dimensions.

Segment

Indicates the segment name.

Sequence Number in Key

Indicates the sequence number of the field within the key.
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Size

Indicates the size of the synonym.

Source

Indicates the source of the synonym.

SQL Conversion Notes

Indicates how SQL is converted.

Table

Is the synonym that contains the column.

Title

Supplies a title to replace the column name normally used in reports.

Type

Is the type of object in an application directory.

Reference: Synonym Editor Run Options Settings

Run Options user preferences include determining the number of rows and columns to retrieve,
as well as the default format when sampling data.

The Run Options settings pane has the following fields and options:

Maximum number of rows for test reports

Sets the number of rows retrieved to produce sample data when testing transformations or
SQL. The default is 50.

Maximum number of columns for test reports

Sets the number of columns retrieved to produce sample data when testing
transformations or SQL. The default is to retrieve all columns (with a highest value setting
of 999999).

Test reports default format

Sets the format of reports for retrieving sample data when testing transformations or SQL.
The default is Default. The following report formats are available:

Default. Formats numeric and date columns based on edit options in the synonym.

HTML. Produces the report in HTML format.

HTML - plain text. Produces the report in plain text format.
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active report. Produces an HTML active report designed for offline analysis.

Excel. Produces the report in Excel format.

PDF. Produces the report in PDF format.

Unformatted. Does not apply formatting to numeric and date columns.

Stop after DBMS error

Sets the number of DBMS-related errors allowed before the server stops running the
procedure.

Changing Views in the Metadata Canvas

The Metadata canvas displays Field View, Segment View, Modeling View, Text View, and
Access File Text View tabs. You can switch to different views in the Metadata canvas to edit
different aspects of your data source more efficiently.

Displaying Fields in a Synonym Using the Field View Tab

The Field View tab is accessible when you are creating or editing a synonym. From this tab, you
can see a table with all available fields. As shown in the following image, the Field View tab
shows a hierarchy of segments and columns on the left, with the attributes and values of the
selected item in the Properties window, which displays, by default, on the right side of the
canvas. This is the default view tab when you are creating or editing a synonym. The Properties
panel can be resized, positioned in different areas, or hidden.

Note: The attributes available depend on the type of synonym.
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The following image is an example of a multi-fact structure with a key column selected.

Note: Information about the attribute that has focus is displayed at the bottom of the attribute
list. In this case, an explanation of the FIELDNAME attribute appears.
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Displaying Segments in a Synonym Using the Segment View Tab

The Segment View tab is accessible when you are creating or editing a synonym. As shown in
the following image, the Segment View tab shows a hierarchy of segments that the synonym
contains on the left, with the attributes and values of the selected item in the Properties
window, which displays, by default, on the right side of the canvas. The Properties panel can
be resized, positioned in different areas, or hidden.

Note: Information about the attribute that has focus is displayed at the bottom of the attribute
list. In this case, an explanation of the SEGMENT attribute appears.

Reference: Segment Shortcut Menu

When you right-click a segment in the Metadata canvas, the following options are available: 

Properties

Opens a pane showing the properties of the selected segment.
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Insert

Enables you to insert one of the following:

Reference to Existing Synonym as Child

The reference is a pointer to the source synonym using the synonym as a child. If you
subsequently make changes to the source synonym, reopening the current synonym
will reflect those changes.

Reference to Existing Synonym as Root

The reference is a pointer to the source synonym using the synonym as a root. If you
subsequently make changes to the source synonym, reopening the current synonym
will reflect those changes.

Copy of Existing Synonym

Adds a static copy of an existing synonym to the current synonym. If you subsequently
make changes to the source synonym, the current synonym will not reflect those
changes.

Segment via Metadata Import

Enables you to create and add a new synonym to the current synonym using the
Create Synonym dialog box.

Segment Manually

Adds a synonym that must be coded manually.

Field

Adds a general column to the segment.

Define

Adds a virtual or defined column to the segment.

Filter

Adds a filter to the segment.

Compute

Adds a calculated value to the file.

Sort Object

Adds a Sort Objects folder and a sort object. This option is available only if Support
extended options is selected.
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Variable

Adds a Variables folder and a variable to the segment.

Style

Adds a Styles folder and a style object. This option is available only if Support
extended options is selected.

Subquery

Adds a subquery to the fields list.

Add/Remove Parent Links

If applicable, enables you to add or remove segments in the current cluster synonym.

Data Profiling

Provides the characteristics of the data for a segment. The following options are available:

Statistics

Shows statistic values for the selected segment only.

Count

Shows a count of the number of rows in the selected source table. For a multi-
segment synonym, it shows the count for each segment.

Statistics with parent segment

This option is available only when viewing a lower segment of a hierarchy (cluster join).

Key Analysis

Allows you to select the columns that you would like to analyze as potential keys to
the source table.

Values

Shows unique values and their percentages.

Duplicate Values

Shows identical values and their percentages.

Sample Data

Displays sample data in the workspace for the selected segment or synonym.

Sample Data with parent key

Displays sample data for the selected segment joined to the parent segment. This option
is only available when a child segment is selected in a multi segment synonym.
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Delete

Deletes the segment.

Rename

Allows you to rename the segment.

Edit All Properties

Allows you to edit adapter specific properties, such as the delimiter value in a delimited
flat file.

Open Base Synonym

Opens the base synonym for the current synonym.

Edit Parent Links

Indicates the parent segment or segments of the selected child that you can edit.

Reference: Column/Field Shortcut Menu

When you right-click a column in the Metadata canvas, the following options are available. 

Note: If you multi-select columns and right-click them, an abridged version of the shortcut
menu opens.

Properties

Opens a pane showing the properties of the selected column.

Insert

Enables you to insert one of the following:

Field

Adds a general column to the synonym.

Define

Adds a virtual or defined column to the synonym.

Filter

Adds a filter to the segment.

Filter (New)

Adds a filter to the segment using the Advanced Filter dialog box.

Compute

Adds a calculated value to the file.
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Group

Indicates the name used to reference the element of data (group of columns) in a
request.

Sort Object

Adds a Sort Objects folder and a sort object. This option is available only if Support
extended options is selected and is not used with DataMigrator.

Variable

Adds a Variables Folder if needed.

Style

Adds a Styles folder and a style object. This option is available only if Support
extended options is selected and is not used with DataMigrator.

Subquery

Adds a subquery to the fields list.
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Impact Analysis

Displays an Impact Analysis report for the particular column in the workspace. An Impact
Analysis report identifies the procedures that access a Master File or field within a Master
File.

Data Profiling

Provides the characteristics of the data for a column.

Statistics

Shows statistic values for the selected segment only.

Patterns

Shows a patterns report for the selected column.

Hex View

Shows the Hexadecimal value of the selected field.

Values

Shows a values report for the selected column.

Values Graph

Displays a graph for both alpha and numeric field types.

Values Pie Graph

Displays a pie graph.

Duplicate Values

Shows identical values and their percents.

Outliers

Shows outlier report for the selected column.

Sample Data

Displays sample data in the workspace.

Delete

Deletes the column.

Rename

Allows you to rename the column.
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Displaying Fields and Properties in a Synonym Using the List View Tab

The List View tab is accessible when you are creating or editing a synonym. As shown in the
following image, the List View tab shows the fields and properties displayed next to their
name, with the attributes and values of the selected item in the Properties panel, which
displays, by default, on the right side of the canvas. The Properties panel can be resized,
positioned in different areas, or hidden. The List View tab is accessible when you are creating
or editing a synonym.

Note: Information about the attribute that has focus is displayed at the bottom of the attribute
list. In this case, an explanation of the FIELDNAME attribute appears.
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Showing a Graphical Representation of a Synonym Using the Modeling View Tab

The Modeling View tab is accessible when you are creating or editing a synonym. As shown in
the following image, the Modeling View tab shows a graphical representation of the synonym.
You can use the Modeling View tab to view join properties, create cluster joins, and add or edit
segments. The following image shows the Sales Dimension of a multi-fact data source.

Reference: Modeling View Shortcut Menu

When you right-click a synonym or segment in the Metadata canvas Modeling View tab, the
following options are available:

Collapse/Expand

Changes the view from a file icon to a table view, which enables you to see columns,
sample data, and sample data parent keys.

Tip: You may also double-click a file icon to open the table view. Double-click the table to
close the table view, or click the X button from the toggle toolbar to close.

Properties 

Opens a pane showing the properties of the selected segment.

Insert 

Reference to Existing Synonym as Child. Enables you to reference an existing
synonym using the synonym as a child.
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Reference to Existing Synonym as Root. Enables you to reference an existing synonym
using the synonym as a root.

Segment via Metadata Import. Enables you to create a new synonym through the
Create Synonym tool and add it to the current synonym.

Segment Manually. Inserts a segment to the current synonym, that must by coded
manually.

Data Profiling 

Provides the characteristics of the data for a segment.

Sample Data 

Displays sample data in the workspace.

Sample Data with parent key 

Displays sample data with parent key in the workspace.

Delete 

Deletes the segment.

Rename 

Enables you to rename the segment.

Displaying the Contents of a Master File Using the Text View Tab

The Text View tab is accessible when you are creating or editing a synonym. The Text View tab
shows the Master File of the underlying table in a text editor. You can print the Master File
syntax by selecting Print from the Application Menu.
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The following image is an example of a multi-fact structure in the Text View tab.

Displaying the Contents of an Access File Using the Access File Text View Tab

The Access File Text View tab is accessible when you are creating or editing a synonym. The
Access File Text View tab shows the Access File for a synonym, which is used to access the
data source. You can print the Access File syntax by selecting Print from the Application Menu.
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The following image shows an example of an SQL data source in the Access File Text View tab.

Note: The text views are read-only. You cannot edit the underlying description from these tabs.
However, you can right-click a synonym from the navigation pane and click Edit in Windows
Associated Tool (for relational synonyms).

Viewing and Editing Synonym Attributes

The Metadata canvas enables you to view and edit the field attributes in a synonym. For
example, a geographical field may have a role attribute that you want to change. You can do
this using the Metadata canvas. Then, all subsequent reports derived from the synonym will
include the edited geographical role.

Procedure: How to View and Edit Synonym Attributes

To view and edit synonym attributes:

1. Double-click a synonym, or right-click it and select Open.

The Metadata canvas opens to the Field View tab, which shows a hierarchy of segments
and columns on the left, with the attributes and values of the selected item on the right.

The attributes available depend on the type of synonym.

The values for Display Name (Title), Format, Expression, Description, and Nulls are
viewable in the hierarchy with the columns. To edit these values, use the corresponding
attribute fields in the Properties panel on the right-hand side of the Metadata canvas.
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2. You can change the attribute values by typing in new values or by using the drop-down
menus and check boxes.

The Properties panel does not let you make any changes that would render the synonym
unusable. Therefore, you cannot edit any value field that is highlighted gray. In addition, if
a change does not have proper syntax or format applied, the field may appear in red text.
Messages and warnings appear if you try to save a file that contains an error.

3. Save changes by clicking Save from the Quick Access Toolbar.

Note: You can multi-select fields to change attributes for multiple fields in a single
operation. The display changes to show only those attributes that can be changed.

4. Close the Metadata canvas.

Note: If you close the Metadata canvas without saving your changes, you are prompted to do
so.

Reference: File Attributes Summary

Synonyms can have the following file attributes: 

General

SUFFIX

Identifies the type of synonym or data source.

MFD_PROFILE

Identifies the name of the FOCEXEC that will be executed before running a request
based on the Master File.

FDEFCENT

Defines the default century value, specifying a century number for handling cross-
century dates.

Note: Use the default setting (0) unless you wish to retrieve data from an earlier
century (for example, 19xx).

FYRTHRESH

Defines the base years, to represent the lowest year to which the century value
applies (FDEFCENT).

Note: Use the default setting (0) unless you wish to retrieve data from an earlier
century (for example, 19xx).
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REMARKS

Enables you to include descriptive information at the file level and specify multiple
language descriptions for the synonym. Remarks are displayed along with the file
name during reporting.

DATASET

Identifies the location of the data source to be used in the file name, including the
extension and the location of the data file.

Note: The attributes available depend on the type of synonym.

Codepage

CODEPAGE

Defines the language to use for the synonym.

Note: Information about the attribute that has focus is displayed at the bottom of the attribute
list. In this case, an explanation of the REMARKS attribute appears.

Reference: Segment Attributes Summary

If a synonym segment is selected, the attributes listed below are available. 

Note: Information about the attribute that has focus is displayed at the bottom of the attribute
list.

General

SEGMENT

Is the name of the segment.

ENCRYPT

Check this box to scramble field values in the current segment in order to protect it
from unauthorized examination.

SEGTYPE

Specifies the type of relationship that a segment has to its parent, and indicates
which of the segment fields are key fields and in what order they are sorted.

Type. Identify the segment type and sorting options from the Type drop-down list.

Keys. Records are sorted in a data source by key fields. Enter the names of key fields
that you want to use for sorting. For example, no two employees can have the same
employee ID number, so you can use that field as the key. A segment instance can
have more than one field that makes up the key. That is, two or more field values may
be used to distinguish records.
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Miscellaneous

SEGSUF

SEGSUF is used when part of the data source being described by the synonym is of a
different data source type than that declared for the entire structure.

DESCRIPTION

Contains a description or comments about the segment.

SEG_TITLE_PREFIX

An optional attribute that enables you to provide the title prefix for the segment fields
that appear in reports. You can split the text across up to five separate title lines by
separating the lines with a comma.

CRFILENAME

Is the name of the cross-referenced data source.

CRSEGNAME

Is the name of the cross-referenced segment.

CRKEY

Identifies the common join field for the cross-referenced segment.

Note: These cross-referenced values (CRFilename, CRSegname, CRKey) are available
for WebFOCUS data sources.

OCCURS

Describes repeating fields or groups of fields in a data source. OCCURS can be based
on an integer value showing the number of occurrences (from 1 to 4095), a field
name, which names a field in the parent segment or a virtual field in an ancestor
segment whose integer value contains the number of occurrences of the descendant
segment, or a variable, which indicates that the number of occurrences varies from
record to record.

POSITION

Specifies the name of the field in the parent segment that specifies the starting
position and overall length of the multiply occurring fields.
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Adapter Specific

Adapter Specific fields are shown if an Access File component has been generated with
the synonym.

CARDINALITY

Defines how many members of a dimension can be retrieved for a report.

TABLENAME

Identifies the table or view. It may contain the owner ID, as well as the table name. For
some synonyms, it must also contain the data source name. This value may be a
variable.

CONNECTION

Indicates the host server or data source for synonyms. This value may be a variable.

KEY

Identifies the names of the columns that constitute the primary key.

KEYORDER

Identifies the logical sort sequence of data by the primary key.

WRITE

Specifies whether write operations are allowed against the table.

FOREIGN_KEY

Specifies the type of table persistence and related table properties. This is optional
for database management systems that support volatile tables, and required
otherwise.

DBSPACE

Identifies the storage area in which the table resides.

PERSISTENCE

Specifies the type of table persistence and related table properties. This is optional
for database management systems that support volatile tables, and required
otherwise.

Note: The attributes available depend on the type of synonym.
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Reference: Column/Field Attribute Summary

If a column or field in a synonym is selected, the attributes listed below are available. The
available attributes depend on the type of synonym. Information about the attribute that has
focus is displayed at the bottom of the attribute list.

General

FIELDNAME

Is the name of the column.

ALIAS

Assigns an alternative name for a column, or the real column name for a DBMS
synonym.

For file data sources, a special reserved ALIAS of INSTANCE means the associated
FIELD will show the name of the file when it is read.

When a FIELDNAME of RECTYPE is used the ALIAS contains the value that identifies
the record type.

KEY COMPONENT

Indicates whether the field is part of the primary key for the table.

KEY SEQUENCE NUMBER

Indicates the sequence number of the field in the primary key for the table.

MISSING

Controls how null data is handled, that is, if no transaction value is supplied.

TITLE

Supplies a title to replace the column name that is normally used in reports and
enables you to specify multiple language titles for the column or field.

ACTUAL

Describes the type and length of data as it is actually stored in the data source.

USAGE

Describes the data type and format for the column for usage or display.
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Note: Additional attributes, DEFCENT and YRTHRESH, are available if the Usage field
is set to Date, Time, or DateTime (Timestamp) format. Use these attributes to enter
the century and year threshold values for the column or field.

Miscellaneous

DESCRIPTION

Contains a description or comments about the column or field.

ACCEPT

Specifies criteria for validating data.

OR enables you to specify an acceptable value.

SYNONYM enables you to specify a synonym as the source of the accept list.

FOCEXEC enables you to specify a FOCEXEC as the source of the accept list.

FROM-TO enables you to specify a range of acceptable value fields.

FIND enables you to supply file and field names to instruct where to search for a
data source and for a list of acceptable values. You supply the field name of the
data field for which the validation criteria are being assigned, the file name of the
target WebFOCUS data source where the field can be found, and the field name of
the target data field that contains the validation criteria.

FIND is only available for WebFOCUS data sources and does not apply to OLAP-
enabled synonyms. Also note that, in the Maintain environment, FIND is not
supported when developing a synonym.

WITHIN

Contains the name of a field to be included in a dimension.

PROPERTY

Describes which hierarchy property the column represents.

REFERENCE

Points to the field that is the unique identifier for the hierarchy.

FIELDTYPE

I - Index identifies an indexed column in a WebFOCUS data source.

R - Readonly indicates a read-only column. This setting is useful for columns that
are automatically assigned a value by the RDBMS.
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ACCESS_PROPERTY

Specifies access options for the column data.

INTERNAL defines a column that does not appear in sample data or in the list of
available columns. Restricts the field from showing in any of the field Lists in the
reporting tools.

NEED_VALUE defines a column that requires a value to access the data.

Select By defines a column by value, range, or multi-values.

AUTHRESP defines a column that describes the result of an authentication
operation. Correct response values must be provided in the ACCEPT attribute
(using the OR predicate if more than one value is acceptable).

AUTHTOKEN defines a column that contains a response token to be passed as an
input value to the operation to be executed.

HELPMESSAGE

Appends a help message to a column.

This attribute is not used by WebFOCUS.

GEOGRAPHIC_ROLE

Describes the geographic role of the column.

TEMPORAL_PROPERTY

Inserts virtual fields in the Master File to show how selected totals progressed through
a time period for specified intervals.

USE_STYLE

Are the styles (for example, font and color) to apply to the field.

The attributes available depend on the type of synonym.

Adapter Specific

AUTOINCREMENT

Indicates that the field is automatically incremented by the relational database when rows
are inserted. This option is only available for selected relational databases. When
selected, the field must also be identified with a field type of read-only.

The following attributes are only used if AUTOINCREMENT is checked.

START. Indicates the starting value for this AUTOINCREMENT field. If not specified, 1 is
used.
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INCREMENT. Indicates the increment value for this field. If not specified, 1 is used.

SEQUENCE. Is the name of the corresponding database SEQUENCE object for this
field. This option is only available for ORACLE tables.

Setting Up Multilingual Titles and Descriptions

You can open a synonym in the Metadata canvas and provide text for the title, caption, and
description in multiple languages. These descriptions appear in the specified language in
reports generated against the synonym. 

The Multilingual Titles dialog box is available from the Remarks, Title, and Description attribute
value fields in the Metadata canvas.

Note: The attributes available depend on the type of synonym.

Procedure: How to Set Up Multilingual Titles and Descriptions

1. From the Projects or Data Servers area, double-click the Master File.

The Master File opens to the Field View tab in the Metadata canvas.

2. To add multilingual text:

For Remarks, click the root level of the Master File (application/filename) on the left.

For Title, click a column from the Master File hierarchy of columns on the left.

For Descriptions, click a column, segment, or custom field from the Master File
hierarchy of fields on the left.

The corresponding attributes and values appear on the right.

3. Click the browse (...) button at the end of the value field for Remarks, Title, or Description.

The Multilingual dialog box opens.

4. From the Specify for different languages drop-down list, choose the language in which you
want the titles or remarks (descriptions) to be displayed.

5. Click Add.

The selected language is added below the default language (which is determined by your
code page selection).

6. Type a description or title in the Text field.
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7. You may add, edit, or delete additional titles or descriptions.

To add an additional language:

a. Select another language from the drop-down list.

b. Click Add.

c. Type a title or description for the field.

To edit an existing specified title or description:

a. Select the title or description and click Edit.

You may also double-click the title.

b. Manually type a title or description name.

To delete a specified title:

a. Select the title or description and language to be deleted.

b. Click Delete.

8. Click OK to close the Multilingual Remarks dialog box.

9. Click Save from the File menu to save the synonym.

Viewing Data Profiling Characteristics

Data Profiling provides data characteristics for the columns in a synonym. You can display the
characteristics for all the columns in a synonym or segment, or for an individual column. 

For alphanumeric columns, Data Profiling provides the segment, format, count of distinct
values, total count, patterns count, maximum, minimum, and average length, minimum and
maximum values, and number of nulls. Patterns count shows the number of patterns found in
each alphanumeric column.

For numeric columns, Data Profiling provides the segment, format, count of distinct values,
total count, maximum, minimum, and average values, and number of nulls.

Data Profiling for an individual column provides access to Statistics, Patterns, Values, and
Outliers reports.

Procedure: How to View Data Profiling for a Synonym or Segment

To view the Data Profiling information for a synonym or segment:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.
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2. Right-click the synonym or segment name, select Data Profiling, and then Statistics.

The Data Profiling information displays in the workspace.

You may use the Data Profiling Results toolbar to view server messages, print the report,
copy data as text, and export the report.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to
drill down to the Values or Patterns reports, respectively.

This is a partial Values report produced by clicking a column name.

For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an
a represents any lowercase letter. All printable special characters are represented by
themselves and unprintable characters are represented by an X.

Viewing Data Profiling Columns

Data Profiling can be done for all the columns in a synonym or segment (press the Shift or Ctrl
key while selecting multiple columns), or for an individual column. Data Profiling for an
individual column provides access to the following reports: 

Statistics. Shows the same information as a Data Profile report for a synonym or segment.

For alphanumeric columns, the Statistics report provides the segment, format, count of
distinct values, total count, patterns count, maximum, minimum, and average length,
minimum and maximum values, and number of nulls.

For numeric columns, the Statistics report provides the segment, format, count of distinct
values, total count, maximum, minimum, and average values, and number of nulls.

Hex View. Shows values in Hexadecimal format.

Patterns. Only available for alphanumeric columns, shows patterns of letters, digits, and
special characters, as well as counts and their percents.

Values. Shows unique values and their percents.

Values Graph. Displays a graph for alphanumeric field types.

Values Pie Graph. Displays a pie graph for alphanumeric field types.

Duplicate Values. Shows identical values and their percents.

Outliers. Shows the ten highest and lowest distinct values and their counts.

These reports are available by right-clicking a column in the Metadata canvas and selecting
Data Profiling.
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Procedure: How to View Data Profile Statistics

To view the Statistical Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Statistics.

The Statistical Data Profiling information opens in the workspace, as shown in the
following image.

3. Optionally, you can click a column name or patterns count (for alphanumeric columns) to
drill down to the Values or Patterns reports, respectively.

Procedure: How to View Data Profile Hex View

Data Profile Hex View shows values in Hexadecimal format.

To view the Hex View Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Hex View.
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The Patterns Data Profiling information displays, as shown in the following image.

Procedure: How to View Data Profile Patterns

Data Profile Patterns shows patterns of letters, digits, and special characters, as well as
counts. This is only available for alphanumeric columns.

To view the Patterns Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Patterns.
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The Patterns Data Profiling information displays, as shown in the following image.

For pattern analysis, a 9 represents a digit, an A represents any uppercase letter, and an a
represents any lowercase letter. All printable special characters are represented by themselves
and unprintable characters are represented by an X.

Procedure: How to View Data Profile Values

Data Profile Values shows unique values.

To view the Values Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Values.
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The Values Data Profiling information displays, as shown in the following image.

Procedure: How to View the Data Profile Values Graph

The Data Profile Values Graph displays values as a bar graph.

To view the Values Graph Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Values Graph.
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The Values Graph Data Profiling information displays, as shown in the following image.

Procedure: How to View the Data Profile Values Pie Graph

The Data Profile Values Pie Graph displays values as a pie graph.

To view the Values Pie Graph Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Values Pie Graph.
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The Values Pie Graph Data Profiling information displays, as shown in the following image.

Procedure: How to View Data Profile Duplicate Values

Data Profile Duplicate Values shows identical values.

To view the Duplicate Values Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Duplicate Values.

The Duplicate Values Data Profiling information displays, as shown in the following image.
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Procedure: How to View Data Profile Outliers

Data Profile Outliers shows the ten highest and ten lowest distinct values.

To view the Outliers Data Profiling information for a single column:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Right-click a column, select Data Profiling, and then select Outliers.

The Outliers Data Profiling information displays, as shown in the following image.

Note: Outliers produce a maximum of the ten highest and ten lowest distinct values, if
they exist.

Enhancing a Master File with Expressions

Using an expression, you can create virtual columns and store calculations and selection
criteria in a synonym. For example, using the Revenue measure, you can create a calculation
for Revenue per Square Foot. This is saved in the synonym as an object and is available for
use in all subsequent reports derived from the synonym.

Adding Virtual Columns (DEFINE) in a Synonym

You may create a DEFINE field as a custom field in a synonym. A custom field can be used in a
request as though it is a real data source field. Virtual columns (DEFINE fields) are available
when the data source is used for reporting.

A virtual column can contain an expression, a constant, or a column name.
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Procedure: How to Create a Virtual Column in a Synonym

To create a virtual column in a synonym:

1. From an application directory in the navigation pane, double-click a synonym, or right-click
it and click Open.

The Metadata canvas opens.

2. Right-click a segment (or column), point to Insert, and then click Define.

The Define Calculator opens, as shown in the following image.

3. From the Define Calculator, type a name for the column in the Name input field, or use the
default define name.

4. Type a format for the column in the Format input field, or click the browse (...) button at
the right of the Format input field to launch the Properties dialog box to enter the
information.

5. You may enter a descriptive title for the virtual column (DEFINE) in the Title input field.

Tip: From the Metadata canvas, click the browse (...) button at the right of the TITLE and
DESCRIPTION value fields to specify multiple language titles.

6. Specify the Missing Data option for columns that allow null data. You can allow all missing
data.
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7. Use the Expression tab and the calculator buttons to build the expression for the virtual
column (DEFINE).

or

Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, use the drop-down lists to select the filter
Column, Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.

c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational
Expression tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables
tab on the right side of the Virtual Column Calculator.
The filter is added to the Relational Expression tab, where you can add the expression
value.

f. To delete an expression, click in the row number column of the expression that you
are deleting, right-click, and select Delete Selected Row(s). The expression is removed
from the Relational Expression tab.

8. You may select the Check Expression and Sample Data buttons, located on the top right of
the Virtual Column Calculator, to verify that the expression is valid and to view sample
data for the filter.

9. Click OK to close the Define Calculator and return to the Metadata canvas.

Note: To edit the Define, Title, or Expression, you may do so directly from the Metadata
canvas, or you may click the browse (...) button at the right of the EXPRESSION value field
to relaunch the Define Calculator.

10. If no columns from the synonym are used in the expression or have been defined, you can
use the WITH option to identify the logical home of the defined calculation. You can also
use the WITH option to move the logical home for the virtual column to a lower segment
than it would otherwise be assigned (for example, to count instances in a lower segment).

Tip: You can click and drag the DEFINE field and move it to a different segment in the Tree
View tab, which also changes the segment association.

11. Click Save from the Quick Access Toolbar to save the synonym.
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Adding Computed Fields (COMPUTE) in a Synonym

You may create a Computed field as a custom field in the Metadata canvas. The procedure for
adding a custom field is similar to the procedure used to add a Defined field. The Computed
field is identified as the Master File Computed field and is differentiated from the Defined
fields and the other Computed fields. 

Procedure: How to Create a Computed Field in the Metadata Canvas

To create a computed column in a synonym

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

The Metadata canvas opens.

2. Right-click a segment (or column), point to Insert, and click Compute.

The Compute Calculator opens.

3. From the Compute Calculator, type a name for the column in the Column input field or use
the default compute name.

4. Type a format for the column in the Format input field, or click the browse (...) button at the
right of the Format input field to launch the Properties dialog box to enter the information.

5. You may enter a descriptive title for the computed field (COMPUTE) in the Title input field.

Tip: From the Metadata canvas, click the browse (...) button at the right of the TITLE and
DESCRIPTION value fields to specify multiple language titles.
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6. Specify the Missing Data options for columns that allow null data. You can allow all
missing data.

7. Use the Expression tab and the calculator buttons to build the expression for the
computed field (COMPUTE).

or

Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, click the Add New Row button  and use the
drop-down lists to select the filter Column, Relation, and Type.

Note: Parameters are not supported.

b. Click the browse (...) button at the right of the Value input field.

c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational
Expression tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Columns/Variables
tab on the right side of the Compute Calculator.

The filter is added to the Relational Expression tab, where you can add the expression
value.

f. To delete an expression, select the number or field column of the expression and click
the Delete button, or right-click it and select Delete Selected Row(s). The expression is
removed from the Relational Expression tab.

8. You may click the Check expression and Sample Data buttons, located on the top right of
the Compute Calculator, to verify that the expression is valid and to view sample data for
the filter.

9. Click OK to close the Compute Calculator and return to the Metadata canvas.

Note: To edit the Compute, Title, or Expression, you may do so directly from the Properties
section of the Metadata canvas or you may click the browse (...) button at the right of the
EXPRESSION value field to relaunch the Compute Calculator.

10. Click Save from the File menu to save the synonym.

For more information about expressions and COMPUTE attributes, see Defining Attributes and
Creating Expressions for Custom Fields on page 189.
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Creating Filters in a Synonym

Filters are created in the Master File through the Metadata canvas and can be used in a
Business View file or in reporting tools. You can also use filters to perform other data checking
and validation, and sort data based on the conditions that you create. 

Filters are created under a specific segment and, by default, they have association with the
selected segment. Filters can also be created without segment association.

Procedure: How to Create Filters in a Synonym

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder, or right-click the synonym and select Edit in Synonym Editor.

The Metadata canvas opens.

2. Right-click a segment or field, point to Insert, and click Filter.

The Filter Calculator opens, as shown in the following image.

3. From the Filter Calculator, type a name for the filter in the Name input field or use the
default filter name.

Note: It is recommended that filters have a descriptive name to help identify the filter
action during reporting.
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4. The Format field shows a default value of I1.

Note: The Format field cannot be changed. Values for filters return 0 for false and 1 for
true.

5. You may enter a descriptive title for the filter in the Title input field.

Tip: From the Properties panel in the Metadata canvas, click the browse (...) button at the
right of the TITLE and DESCRIPTION value fields to specify multiple language titles.

6. Use the Expression tab and the calculator buttons to build the expression for the filter.

or

Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, click the Add New Row button  and use the
drop-down lists to select the filter Column, Relation, and Type.

Note: Parameters are not supported with Master File Filters.

b. Click the browse (...) button at the right of the Value input field.

The Value Selection dialog box opens.

c. Select from the available values and use the arrows to add or remove values.

d. Click OK to close the Value Selection dialog box and return to the Relational
Expression tab.

The expression is added to the value field.

e. To add another filter, double-click a column or variable from the Fields/Variables
section on the right side of the Filter Calculator.

The filter is added to the Relational Expression tab where you can add the expression
value.

f. To delete an expression, select the number or field column of the expression and click
the Delete button, or right-click it and select Delete selected row(s).

The expression is removed from the Relational Expression tab.

7. You may click the Check Expression and Sample Data buttons, located on the top right of
the Filter Calculator to verify that the expression is valid and to view sample data for the
filter.

8. Click OK to close the Filter Calculator and return to the Metadata canvas.

Note: To edit the Filter, Title, or Expression, you may do so directly from the Properties
panel in the Metadata canvas or you may click the browse (...) button at the right of the
EXPRESSION value field to relaunch the Filter Calculator.
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9. To create a Filter without segment association, use the WITH drop-down list in the
Properties panel to select a blank segment.

Filters are created under a specific segment and by default they have association with the
selected segment. Filters can also be created without segment association.

Note: If you are using a field that appears in multiple segments, the WITH segment
associated should be the lowest level segment or it should be left empty to prevent errors.

In addition, if no fields from the synonym are used in the expression or have not been
computed, you can use the WITH option to identify the logical home of the filter
calculation. You can also use the WITH option to move the logical home for the filter field
to a lower segment than it would otherwise be assigned (for example, to count instances
in a lower segment).

10. Click Save from the File menu to save the synonym.

The filter is saved as part of the synonym.

Defining Attributes and Creating Expressions for Custom Fields

A custom field is a field whose value is not stored in the data source but can be calculated
from the data that is there. You can create a custom field in your synonym by adding a virtual
column (DEFINE), a Computed Field (COMPUTE), and a Master File filter (FILTER). The fields are
available whenever you access the corresponding data source in a reporting tool. 

You can define attribute values and create expressions for custom fields using the Metadata
canvas.

Reference: Custom Field Attributes

The following attributes may be available for custom fields (DEFINE, COMPUTE, and FILTER) in
the Metadata canvas.

Note: The attributes available depend on the type of synonym and the type of custom field
selected.

Custom fields (DEFINE, COMPUTE, and FILTER) typically have the following attributes:

General

DEFINE 

Is the name of the virtual column.

Note: This attribute only appears when a virtual column (DEFINE) is selected.

COMPUTE 

Is the name of the computed field.

3. Creating Metadata

WebFOCUS App Studio User’s Manual  189



Note: This attribute only appears when a virtual computed field is selected.

FILTER

Is the name of the Master File Filter field.

Note: This attribute only appears when a virtual filter field is selected.

EXPRESSION 

Is the expression that creates the virtual column.

TITLE 

Supplies a title to replace the column name that is normally used in reports and enables
you to specify multiple language titles for the virtual column.

FORMAT 

Describes the data type and format for the virtual column.

Note: This attribute only appears for DEFINE and COMPUTE custom fields.

MISSING 

Allows missing data. If not, the transaction value is supplied.

Note: This attribute only appears for DEFINE and COMPUTE custom fields.

Miscellaneous

REDEFINES

A DEFINE expression may not contain qualified field names. REDEFINES enables you to
redefine or recompute a column whose name exists in more than one segment.

Note: This attribute only appears for DEFINE custom fields and cannot be used by
WebFOCUS.

WITH 

If no columns from the synonym are used in the expression or have been defined, you can
use the WITH option to identify the logical home of the defined calculation. You can also
use the WITH option to move the logical home for the virtual column to a lower segment
than it would otherwise be assigned (for example, to count instances in a lower segment).

Note: This attribute only appears for DEFINE and FILTER custom fields.

DESCRIPTION 

Contains a description or comments about the virtual column.
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ACCESS_PROPERTY 

Specifies access options for the column data.

INTERNAL defines a column that does not appear in sample data or in the list of available
columns. Restricts the field from showing in any of the Field Lists.

NEED_VALUE defines a column that requires a value to access the data. Indicates that a
selection is needed in the report request (WHERE condition).

Select By defines a column by value, range, or multivalues:

If Value is checked, only one value should be defined for selection in the report
request.

If Range is checked, a range selection should be defined in the report request.

If Multivalues is checked, multiple values are allowed for selection in the report
request.

GEOGRAPHIC_ROLE 

Defines the geographic role of the column.

WITHIN

Contains the name of a field to be included in a dimension.

These WITHIN statements are added to the synonym through the Dimension Builder to
OLAP-enable WebFOCUS files and relational tables.

Note: This attribute only appears for DEFINE and FILTER custom fields.

TEMPORAL_PROPERTY

Inserts virtual fields in the Master File to show how selected totals progressed through a
time period for specified intervals.

USE_STYLE

Are the styles (for example, font and color) to apply to the field.

Note: The attributes available depend on the type of synonym.

Reference: Calculators for Custom Fields

The Define Calculator, Compute Calculator, and Filter Calculator have the following fields and
options: 

Name

Is the name of the object being created (virtual field (DEFINE), filter, computed field).
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Format 

Is the field format.

Title

Is the title of a new target table created by a data flow. The title will be included in the
synonym that is created.

Missing

Indicates if missing (null) values are allowed in this field. The following options are
available:

OFF. The result is never missing.

ON. The result is missing only if all missable fields are missing.

ON ALL. The result is missing if any missable fields are missing.

Expression tab 

Location for typing an expression. You can add data source fields from the Columns/
Variables tab, functions from the Functions tab, and numbers and operators from the
calculator as you type.

Relational Expression tab 

Displays the expression building window from which you can add and delete columns,
choose the relation and type, and select values for your filter.

Fields/Variables tab

Displays a hierarchical list of available source columns and System Variable folders that
you can use in creating an expression.

Functions tab 

A function is a program that returns a value. This tab lists the built-in functions that you
can use to derive the value of a temporary field.

Function Assist button 

Enables you to specify parameters for the function through a dialog box when creating or
editing a transformation.

Calculator buttons 

Enables you to insert numbers and operators.
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The following operators are available:

| (single concatenation bar) 

Concatenates two values, retaining any trailing blanks after the first one. For example,
if FIRST_NAME and LAST_NAME were both in A15 format, the expression

FULL_NAME = FIRST_NAME | LAST_NAME

would produce a column like the following:

MICHAEL      SMITHSONJ
ANE         JONES
.
.
.

|| (double concatenation bar) 

Concatenates two values, suppressing any trailing blanks in the first. For example, to
construct the full name and insert a comma (,), the syntax

FULL_NAME = LAST_NAME || (', ' | FIRST_NAME) 

would produce a column like the following:

SMITHSON, MICHAEL 
JONES, JANE
.
.
.

The concatenation in the parentheses is done first (preserving the blank space after
the comma), and the result is then concatenated to LAST_NAME, suppressing the
trailing blanks of LAST_NAME.

IF

Establishes a conditional test.

THEN 

Specifies the action to perform if the result of a conditional test is TRUE.

ELSE 

Specifies the action to perform if the result of a conditional test is FALSE.

LT

Returns the value TRUE if the value on the left is less than the value on the right.
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NOT 

Returns the value TRUE if the operand is false.

LE

Returns the value TRUE if the value on the left is less than or equal to the value on
the right.

EQ

Returns the value TRUE if the value on the left is equal to the value on the right.

AND 

Returns the value TRUE if both operands are true.

GT

Returns the value TRUE if the value on the left is greater than the value on the right.

GE

Returns the value TRUE if the value on the left is greater than or equal to the value on
the right.

NE

Returns the value TRUE if the value on the left is not equal to the value on the right.

OR

Returns the value TRUE if either operand is true.

**

Raises a value to the specified power.

( ) 

Adds parentheses.

''

Inserts two single quotation marks. Enter alphanumeric test values between the
quotation marks.

a->A 

Converts selected text to uppercase.

A->a 

Converts selected text to lowercase.
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Date 

Opens the Date dialog box, where you can change the format for the Date field.

Datetime 

Opens the Date Time dialog box, where you can change the format for the Datetime field.

Check expression button 

Verifies the validity of the expression.

Sample data button 

Produces sample data for the expression.

Describing Group Fields and Repeating Fields in a Synonym

For data sources that support groups, you can assign a unique name to multiple fields to
create a group field. A group field is created by two or more alphanumeric fields, physically
next to each other. A group field provides an efficient means for grouping similar or logically
connected fields that will be accessed as a single unit, but do not warrant a separate
segment. 

Procedure: How to Add a Group Field to a Segment

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

The Metadata canvas opens.

2. Right-click a segment (or column), select Insert, and click Group.

Note: The group option may not be available for some data sources.

A group is added to the synonym and its attributes and values appear on the right.

3. Type a name for the group in the GROUP field.

4. Select the USAGE Type value for the group. Specify the length, the decimal places (if
applicable) and any display options for the group.

5. Select the I - Index check box if you want the group to be indexed.

6. Select the ACCESS_PROPERTY values to specify access options for the group data.

INTERNAL defines a column that will not appear in sample data or in the list of
available fields.

NEED_VALUE defines a column that requires a value to access the data.

Select By defines a column by value, range, or multivalues.
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7. Optionally, you can specify the TITLE and DESCRIPTION display options.

8. Click Save from the File menu to save the synonym.

Note: When you add a group, a field is automatically added to the group.

Procedure: How to Add a New Field to a Group Field

1. Right-click the group field to which you want to add a new field, select Insert, and click
Field. 

A field is added to the group and its attributes and values appear on the right.

2. Supply the required information for the group field. For more information about field
attributes, see Viewing and Editing Synonym Attributes on page 165.

Procedure: How to Add an Existing Field to a Group Field

1. Click the field you want to add to the group field. 

2. While holding the left mouse button down, drag the field and drop it on the group field
name.

The field is added to the group field.

Procedure: How to Delete a Group Field From a Segment

1. Right-click the group and select Delete. 

A confirmation appears stating that all columns (fields) within the group will be deleted.

2. Click Yes to delete the group and move the fields (within the group) under the root
segment of the synonym.

Click No to delete the group and all of the fields within the group.

Click Cancel to close the Confirm dialog box and return to the Metadata canvas.

Procedure: How to Delete a Field From a Group Field

Right-click the field, then select Delete. 

Reference: Group Field Attributes

Group fields in a synonym can have the following attributes: 

General

GROUP

Is the name of the group.
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ALIAS

Assigns an alternative name for a group.

If you create a report, the group name appears as a column heading unless you have
specified an alternate title for the group. Aliases cannot be used as column titles.

TITLE

Supplies a title to replace the group name that is normally used in reports and enables you
to specify multiple language titles for the group.

USAGE

Contains the format for the group field. Since the group field is made by concatenating
together several other fields, the Metadata canvas determines what this format needs to
be. For example, if the group field has two alphanumeric fields in it, each 20 characters
long (A20), then the group field must be alphanumeric and 40 characters long (A40). The
group field is always alphanumeric, regardless of the fields that make it up.

Miscellaneous

DESCRIPTION

Contains a description or comments about the group. The description displays in Field lists
and on the status bar.

Field descriptions also appear as bubble help in OLAP-enabled reports. If you do not
include a description, bubble help shows the field name (column title).

FIELDTYPE

Identifies an indexed group. You can index the values of a field to enhance data retrieval
performance. To do so, select the Index check box when you add a field and before you
add the data. An index is an internally stored and maintained table of data values and
locations that enhance the performance of data retrieval. A Master File can have several
associated indexes, but the combined total of indices and segments cannot exceed 64.

Note: FIELDTYPE=R indicates a read-only column. This setting is useful for columns that
are automatically assigned a value by the RDBMS.

Tip: You can turn on the index after adding data to a field, however, you will have to use
the Rebuild Index option to create the index.

ACCESS_PROPERTY

Specifies access options for the column data.

INTERNAL defines a column that does not appear in sample data or in the list of available
columns. Restricts the field from showing in any of the Field Lists.
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NEED_VALUE defines a column that requires a value to access the data. Indicates that a
selection is needed in the report request (WHERE condition).

Select By defines a column by value, range, or multivalues:

If Value is checked, only one value should be defined for selection in the report
request.

If Range is checked, a range selection should be defined in the report request.

If Multivalues is checked, multiple values are allowed for selection in the report
request.

USE_STYLE

Are the styles (for example, font and color) to apply to the field.

Note: The attributes available depend on the type of synonym.

Storing the Number of Repetitions of a Repeating Field in a Virtual Field

The OCCURS attribute in a Master File describes repeating fields or groups of fields in a data
source. The repeating group of fields is described as a descendent segment in the Master File,
and the OCCURS attribute for that segment specifies how to determine the number of
repetitions. 

The number of repetitions does not have to be the same for every record instance. Sometimes,
the number of repetitions can be derived from a field in the data source. In that case, you can
create a virtual field in the Master File that indicates the number of repetitions for each record
and use that virtual field as the value of the OCCURS attribute.

Syntax: How to Specify an OCCURS Segment Using a Virtual Field

SEGNAME = parent, SEGTYPE = segtype,$
    .
    .
    .
  DEFINE definefield/In = expression;
  SEGNAME = osegname, SEGTYPE=S0, PARENT = parent,
     OCCURS = definefield ,$
  FIELDNAME = rfield, ALIAS = ralias,
     USAGE = rufmt, ACTUAL = rafmt,$
    .
    .
    .
 [FIELDNAME = orderfield, ALIAS = ORDER,
     USAGE = In, ACTUAL = I4,$]
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where:

parent 

Is the name of the parent segment.

segtype 

Is the SEGTYPE of the parent segment.

definefield 

Is the virtual field that indicates the number of repetitions of the repeating field or group of
fields. This field must be defined in a segment that is an ancestor of the segment
containing the repeating fields.

n 

Is the format of the virtual field that describes the number of repetitions. It must be an
integer format.

expression 

Is a valid expression that derives the number of repetitions for each record instance.

osegname 

Is the name of the descendent OCCURS segment.

rfield 

Is the name of a repeating field in the OCCURS segment.

ralias 

Is the alias of a repeating field in the OCCURS segment.

rufmt

Is the display format for a repeating field in the OCCURS segment.

rafmt

Is the actual format for a repeating field in the OCCURS segment.

orderfield 

Is the name of an internal counter field that you can specify as the last field in the
OCCURS segment. The ORDER field associates a sequence number with each occurrence
and is useful when the order of the repeating data is significant. For example, the values
may represent monthly or quarterly data, but the record itself may not explicitly specify the
month or quarter to which the data applies. The USAGE format must be integer and the
ACTUAL format is I4.
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Note: The virtual field used as the OCCURS value cannot be redefined inside or outside of the
Master File.

Example: Using a Virtual Field With an OCCURS Segment

The following request against the EMPLOYEE data source creates a fixed-format sequential file
with a repeating field. The request:

Counts the number of FICA deductions for each employee.

Creates a calculated field that contains the length of all FICA deduction fields for each
employee.

Creates a HOLD file in which each record contains the calculated length of the deduction
fields for the employee, the identifying information for the employee, and all FICA
deductions for the employee.

Note that the number of deductions will vary for each employee. The part of the record that
contains the deductions will constitute the OCCURS segment. The number of repetitions will
have to be derived from the length field created in the TABLE request.

The procedure to create the file with the repeating deduction field follows:

DEFINE FILE EMPLOYEE
  CTR/I5 WITH DED_AMT = IF EMP_ID NE LAST EMP_ID THEN 1 ELSE LAST CTR + 1;
END
TABLE FILE EMPLOYEE
  SUM CNT.DED_AMT NOPRINT EMP_ID LAST_NAME FIRST_NAME CURR_SAL
  COMPUTE DEDLEN/I5 = 12 * CNT.DED_AMT;
  BY EMP_ID NOPRINT
  SUM DED_AMT
  BY EMP_ID NOPRINT
  ACROSS CTR NOPRINT
  WHERE DED_CODE EQ 'FICA'
  ON TABLE SET HOLDLIST PRINTONLY
  ON TABLE HOLD AS OCCURS1 FORMAT ALPHA
END
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The OCCURS1 file has one record per employee with a variable number of DED_AMT fields.
The total length of the number of actual instances of DED_AMT is stored in the field named
DEDLEN. The Master File generated by the HOLD command lists 10 DED_AMT fields:

FILENAME=OCCURS1 , SUFFIX=FIX     , $
  SEGMENT=OCCURS1, SEGTYPE=S0, $
    FIELDNAME=EMP_ID, ALIAS=E01, USAGE=A9, ACTUAL=A09, $
    FIELDNAME=LAST_NAME, ALIAS=E02, USAGE=A15, ACTUAL=A15, $
    FIELDNAME=FIRST_NAME, ALIAS=E03, USAGE=A10, ACTUAL=A10, $
    FIELDNAME=CURR_SAL, ALIAS=E04, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DEDLEN, ALIAS=E05, USAGE=I5, ACTUAL=A05, $
    FIELDNAME=DED_AMT, ALIAS=E06, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E07, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E08, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E09, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E10, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E11, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E12, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E13, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E14, USAGE=D12.2M, ACTUAL=A12, $
    FIELDNAME=DED_AMT, ALIAS=E15, USAGE=D12.2M, ACTUAL=A12, $

You can edit the Master File to describe these repeating DED_AMT fields with an OCCURS
segment. The DEFINE field named NUMOCC derives the number of occurrences from the
DEDLEN field. The ORDER field is not actually in the file. It is an internal counter populated by
App Studio.

FILENAME=OCCURS1 , SUFFIX=FIX     , $                             
  SEGMENT=OCCURS1, SEGTYPE=S0, $                                  
    FIELDNAME=EMP_ID, ALIAS=E01, USAGE=A9, ACTUAL=A09, $          
    FIELDNAME=LAST_NAME, ALIAS=E02, USAGE=A15, ACTUAL=A15, $      
    FIELDNAME=FIRST_NAME, ALIAS=E03, USAGE=A10, ACTUAL=A10, $     
    FIELDNAME=CURR_SAL, ALIAS=E04, USAGE=D12.2M, ACTUAL=A12, $    
    FIELDNAME=DEDLEN, ALIAS=E05, USAGE=I5, ACTUAL=A05, $          
    DEFINE NUMOCC/I2 = DEDLEN/12;,$                               
  SEGNAME=DEDUCTION, SEGTYPE=S0, PARENT=OCCURS1, OCCURS=NUMOCC,$
    FIELDNAME=DED_AMT, ALIAS=E06,   USAGE=D12.2M, ACTUAL=A12, $   
    FIELDNAME=ORDER,   ALIAS=ORDER, USAGE=I2    , ACTUAL=I4 , $

The following request uses the ORDER field to select and print the first occurrence of the
repeating field for each employee. Since every employee has at least one deduction, every
employee is represented on the report output:

TABLE FILE OCCURS1
  PRINT NUMOCC LAST_NAME CURR_SAL DED_AMT
  WHERE ORDER EQ 1 
END 
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The output is:

NUMOCC  LAST_NAME               CURR_SAL          DED_AMT
------  ---------               --------          -------
    10  STEVENS               $11,000.00           $64.17
     8  SMITH                 $13,200.00          $100.10
     4  JONES                 $18,480.00          $247.94
     8  SMITH                  $9,500.00           $60.96
     1  BANNING               $29,700.00          $519.75
     8  IRVING                $26,862.00          $626.78
     4  ROMANS                $21,120.00          $317.62
     1  MCCOY                 $18,480.00          $161.70
     5  BLACKWOOD             $21,780.00          $444.67
     7  MCKNIGHT              $16,100.00          $187.88
     4  GREENSPAN              $9,000.00           $52.50
    10  CROSS                 $27,062.00          $631.40

If you print the tenth occurrence of the repeating field, only two employees are displayed on
the report output:

TABLE FILE OCCURS1 
  PRINT NUMOCC LAST_NAME CURR_SAL DED_AMT
  WHERE ORDER EQ 10 
END

The output is:

NUMOCC  LAST_NAME               CURR_SAL          DED_AMT
------  ---------               --------          -------
    10  STEVENS               $11,000.00           $58.33
    10  CROSS                 $27,062.00          $526.20

Parameterizing a Synonym with Variables

You can define variables in a synonym in order to specify synonym attributes, such as the
connection name or the table name. The variable is saved in the synonym as an object and is
available for use in all subsequent reports derived from the synonym.

Procedure: How to Add a Variable to a Synonym

1. Right-click an object in the Metadata canvas, point to Insert, and then click Variable.

2. A new folder named Variables is added to the object tree, with &&VARIABLE1 as an entry.
The Properties panel shows the attributes of the variable.

3. If desired, change the name of the variable and enter a default value in the appropriate
fields.
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Reference: Variables Attribute Summary

Variables in a synonym can have the following attributes:

VARIABLE

The name of the variable. A double ampersand (&&) is automatically inserted in the name
to indicate a global variable.

DEFAULT

The default value for the variable. If no value is set, the default value is used.

QUOTED

When selected, single quotation marks are added around the assigned string for the
variable. A single quotation mark within the string is converted into two single quotation
marks.

FORMAT

Optional description of the prompt value format for the variable. The format type can be
Alpha fixed, Integer, or Decimal Packed.

PROMPT

The text that appears when prompting for a value for the variable.

ACCEPT

Allows you to select the method used to specify values that can be accepted for this
variable. The following options are available:

OR

DECODE

FIND (applies to Maintain only)

SYNONYM

FOCEXEC

FROM-TO

Select Type

Allows you to specify whether you can select from a single or multiple list of values.

Values

Lists the values that are acceptable.
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Procedure: How to Use a Variable in a Synonym

Variables in a synonym are commonly used to represent a table name or connection name.

1. In a synonym for a relational database where variables have been established, click a
segment to open the Properties panel that shows the Adapter Specific attributes.

2. In the fields for TABLENAME and CONNECTION, enter the names of the variables to be
used.

3. Click Save to save your changes.

Adding Indexes to a Synonym

Indexes are used to quickly locate data when a database table is queried, providing efficient
access to ordered records. Indexes can be created using one or more columns of a database
table.

When you use New, Synonym to create a synonym for a relational database table with more
indexes than just the primary key, they will be included in the synonym.

For WebFOCUS files, additional indexes are useful when you anticipate using a column in a
JOIN operation, a WHERE condition, or as an argument to DB_LOOKUP. You can add multiple
indexes. Each index can be on one or more columns. You can specify if the index is sorted,
and whether it is a unique index.

Example: Adding an Index to a Column

1. Right-click the field name .

2. In the Properties panel, select the I - Index check box.

3. Select Rebuild Data Source from the Data button on the Home tab to rebuild the data
source.

Creating Cluster Joins

Cluster joins enable you to create a new file structure by linking existing synonyms of two or
more relational tables using the same or mixed data sources. For example, you may join a Db2
table and an Oracle table, and so on. Use cluster joins to create new views in the metadata by
linking together physical tables and easily report against the new view or structure. You can
create cluster joins by using the Metadata canvas Modeling View.

The Master File that is created combines the fields of the joined tables within a single file. The
Access File from the combined file contains information about the actual location of the data
sources and the Join information. It also shows how the tables are linked.
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The total number of tables that you can add to the tool is 512 (using 511 joins), which results
in a new Master File that has a maximum of 512 segments.

The Cluster Join tool enables you to create a Star Schema which consists of a fact table
referencing a number of dimension tables. Optionally, you can also create a view that has
more than one fact table.

Procedure: How to Create a Cluster Join by Enhancing Existing Synonyms

Use the Modeling View to enhance an existing synonym by adding a segment.

1. From the Projects or Data Servers area, open a synonym by double-clicking a Master File
from the Master Files folder.

The Metadata canvas opens.

2. Click the Modeling View tab.

The Modeling View tab opens in the workspace.

3. Right-click a segment in the workspace and select Insert.

4. Insert tables (segments) through one of the methods listed:

To insert a segment from an existing synonym as child or root:

a. Select Insert, then Reference to Existing Synonym as Child or Reference to Existing
Synonym as Root.

The Insert Reference to Existing Synonym dialog box opens.

b. Select a synonym to be inserted and click Select.

Note: Use this method if you are creating a cluster join with an existing table or
synonym.

Tip: Click Save As from the Modeling View File menu if you do not want to modify the
original synonym.

To insert a segment via Metadata Import:

a. Select Insert, then Segment via Metadata Import. This enables you to add segments
by using the Create Synonym tool. This tool creates a synonym and includes it as a
segment in the synonym from which the tool was launched.

Note: Use this method if you are creating a cluster join and need to use a synonym
that does not exist. This option enables you to create the synonym and continue to
create the cluster join.

b. When this option is selected, you are first presented with the Adapter dialog box
where you can select a configured adapter connection to continue or configure a new
adapter, if necessary.
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To insert a segment manually:

Select Insert, then Segment Manually. This enables you to assign values to segment
attribute fields.

Note: Use this method if you are coding a new Master File, as you would for a WebFOCUS
data source.

The segment is added in the Modeling View.

5. Right-click the join line between the segments.

Note: This option is only available when using relational tables.

6. Select a Join Type from the shortcut menu.

The Join Condition field automatically creates a Join if identical fields exist in both segments.

Creating a Synonym for Cube Data Sources

The Metadata canvas enables you to make further modifications to your Cube synonym
definitions. The Cube synonym is displayed in the Cube View tab. If you select a component of
the synonym, its properties appear in the Properties panel. 

You can use the Metadata canvas to:

Edit field names and titles for measures, properties, and variables. You may also edit the
field prefix for the defined fields.

Edit titles for multiple languages, delete titles, and add titles for additional languages if you
are using code page UTF-8.

Delete measures, dimensions, or parent/child hierarchies.

View the USAGE and ACTUAL formats and change the USAGE display format for the field.

Change an internal attribute value.

Change the access property for variables.

Change the field prefix used to create the field names, mandatory property names, and
DEFINE field names generated for parent/child hierarchies by the Synonym Wizard.

Create virtual measures (this is implemented with COMPUTE fields in the Master File).
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The following image is an example of a Cube data source in the Metadata canvas.

Procedure: How to Edit Field Names and Titles

To edit field names and titles: 

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master
File from the Master Files folder.

Note: You may also right-click the synonym and select Edit in Synonym Editor.

By default, the Metadata canvas opens to the last view used.

2. Select an attribute from the Cube View tab.

Note: The attributes available depend on the type of synonym.
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3. Click FIELD NAME, TITLE, or CAPTION on the right-hand side of the workspace.

Note: The Properties panel does not let you make any changes that would render the
Master File unusable. Therefore, you cannot edit any value field that is highlighted gray.

4. Manually edit the Field Name, Title, or Caption by typing in the value field.

The edits are updated instantaneously in the Cube View tab.

5. Click Save to save the synonym.

Procedure: How to Edit Titles for Multiple Languages

To edit the title for multiple languages: 

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master
File from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Select an attribute from the Cube View tab.

3. Click the browse (...) button, located on the far right of the TITLE or CAPTION value field.

The Multilingual Titles dialog box opens.

4. You may add, edit, or delete a title for this field.

To add an additional language for the title:

a. Select a language from the drop-down list.

b. Click Add.

c. Type a description for the title field.

To edit an existing specified title:

a. Select the title and click Edit.

You may also double-click the title.

b. Manually type a title name.

To delete a specified title:

a. Select the title and language to be deleted.

b. Click Delete.

5. Click OK to close the Multilingual Titles dialog box.

6. Click Save from the File menu to save the synonym.
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Procedure: How to Delete Measures, Dimensions, or Parent/Child Hierarchies

To delete measures, dimensions, or parent/child hierarchies: 

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master
File from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Select the attribute name that you want to delete.

3. Right-click and select Delete from the shortcut menu.

The attribute is deleted from the Cube View tab.

4. Click Save to save the synonym.

Procedure: How to Create Virtual Measures With COMPUTE Fields

To create virtual measures with COMPUTE fields:

1. From the Projects or Data Servers area, open a synonym by double-clicking a Cube Master
File from the Master Files folder.

By default, the Metadata canvas opens to the last view used.

2. Open the Measures folder from the Cube View tab.

3. Right-click the Virtual Measures folder, select Insert, and then select Virtual Measure.

The Compute Calculator opens.

4. From the Compute Calculator, type a name for the column in the Name field.

5. You may type a descriptive title for the measure (COMPUTE) in the Title field.

6. Use the Expression tab and the calculator buttons to build the expression for the Measure
(COMPUTE field).

or

Use the Relational Expression tab to build the expression.

a. From the Relational Expression tab, click the Add New Row button.

b. Use the drop-down lists to select the Field, Relation, and Type.

Note: Parameters are not supported.

c. Click the browse (...) button at the right of the Value input field.
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The Value Selection dialog box opens.

d. Select from the available values and use the arrows to add or remove values.

e. Click OK to close the Value Selection dialog box and return to the Relational
Expression tab.

The expression is added to the virtual measure.

f. To add another expression, double-click a measure or dimension from the Fields/
Variables tab on the right side of the Compute Calculator.

The expression is added to the Relational Expression tab, where you can add the
expression value.

g. To delete an expression, select the number or field column of the expression and click
the Delete button, or right-click it and select Delete selected row(s). The expression is
removed from the Relational Expression tab.

7. You may click the Check expression and Sample Data buttons, located on the top right of
the Compute Calculator, to verify that the expression is valid and to view sample data for
the filter.

8. Click OK to close the Compute Calculator and return to the Metadata canvas.

Note: To edit the Compute, Title, or Expression, you may do so directly from the Metadata
canvas or you may click the browse (...) button at the right of the EXPRESSION value field
to relaunch the Compute Calculator.

Defining a Business View of a Master File

By defining a Business View of a Master File, you are creating an alternative view of the Master
File and can limit the fields available or create a subset of fields from the original Master File.
Fields can be grouped into meaningful folders. Field names, titles, and descriptions can be
customized for each Business View.

Fields in a Business View are organized into folders. Each folder contains a group of fields. The
fields in a folder can come from different segments in the original Master File. The Business
View may contain existing fields and can include existing custom fields for DEFINE, COMPUTE,
and Filters. Custom fields are associated with a specific segment in the original Master File
and are subject to the same rules as real fields. A report can reference fields from multiple
folders if they all lie along a single path in the original Master File.

When opening a Master File in the Synonym Editor and clicking the Business View button on
the toolbar, a Business View pane opens inside the Synonym Editor where Business View
attributes can be added. Adding Business View attributes at this point would update the
Master File by inserting the Business View attributes at the end of the file, and once the file is
saved, the Business View becomes the active view when the file is used for reporting.
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If you do not wish to turn your Master File into a Business View, it is recommended that you
save the Business View using a different name or preferably start by creating a new Master
File by selecting New, then Synonym via Metadata Canvas. Then, insert a reference to an
existing synonym and continue to build the Business View. In this case, the Business View
points to the cross-referenced Master File, and all of the actual fields and security information
comes from the referenced file when the Business View is used in WebFOCUS tools (such as
Joins and Defines) and in reports.

You may create a Business View for an existing Master File by using the Synonym Editor.

Procedure: How to Create a Business View Using the Metadata Canvas

1. From the Content group, click Data and then click Synonym via Metadata Canvas. Select a
Master File and click OK.

2. Right-click a segment, point to Insert, and then click Reference to Existing Synonym.

3. From the Insert Reference to Existing Synonym dialog box, select the synonym for which
you want to create a Business View.

The referenced file is added to the new synonym and its fields are visible in the left frame.

4. Select Business View from the Tools group to open the Business View panel.

Note: A Business View Master File may contain only one root folder.

Tip: Right-click a node in Business View and select Properties to open the Properties panel
and view additional information for items selected in the Business View pane. Use the
Properties pane to change titles, descriptions, or field names. Items that cannot be edited
are grayed out.

5. In the Business View panel, right-click the file name and select Create Default Business
View or New Folder.

The Create Default Business View option duplicates the segments and fields that are
available in the Master File. You can reorganize the view as necessary. The New Folder
option creates a root folder to which you can add fields from the Master File on the left
pane by selecting them and then dragging them inside the folder. You can create
additional folders to create the structure you want.

6. To add additional folders for the Business View, right-click the Business View root folder
that was created in the Business View pane and select New Folder.

Note: Multiple subfolders can be created and folders may be empty for organizational
purposes.

3. Creating Metadata

WebFOCUS App Studio User’s Manual  211



7. Select fields from the Master File on the left and drag them to the appropriate folder in the
Business View pane. Press the Shift or Ctrl key while selecting multiple fields.

Note: If needed, fields may be duplicated by placing them in multiple folders, but any given
folder may contain a field only once.

The selected fields appear in the Business View pane.

Reference: Usage Notes for Business Views

When creating a Business View using a referenced Master File:

The detailed information about fields, such as USAGE and ACTUAL formats or indexes
remain in the referenced Master File.

All information about Cluster Master Files remain in the referenced Master File.

DBA attributes specified in the referenced Master File are respected by the Business
Views

When a Master File contains more than one field with the same name, as can occur when
files are joined, the BELONGS_TO_SEGMENT attribute identifies which instance of the field
name is being referenced in the Business View.

Folders can be empty for organizational purposes. For example, Region can have empty
folders called North, South, East, and West.

You can issue an SQL SELECT command against a Business View. However, a Direct SQL
Passthru request is not supported against a Business View.

Business Views support alternate file views and fully qualified field names.

The SEG. operator against a Business View folder displays all of the fields in that folder,
not all of the fields in the real segment.

Requests against a Business View cannot reference any fields or segments not in the
Business View.

All HOLD formats are supported against a Business View.

All adapters for non-WebFOCUS data sources support retrieval requests against a Business
View.

Business Views are not supported with data source maintenance commands, such as
Maintain or REBUILD.
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The referenced Master File or the Master File currently being used to create the Business
View, may contain Defines, Computes, Filters, and other fields for use in the Business
View.

When creating a DEFINE field with a constant expression, in order to see the DEFINE field in
a specific folder in the Object Inspector, you must use WITH syntax.

Note: For more information on Business Views, see the Server Administration Manual.

Reference: Using a Business View Master File

When you use the Business View Master File with WebFOCUS tools and reports, the field
formats, descriptions, and titles will be retrieved from the original Master File, unless they are
customized and a title and description is available through the Business View.

The Table List shows all available Master Files, including the Business Views, that are
available. The Remarks column shows a description from the original Master File unless the
Business View file contains its own remarks.

Applying Database Administrator (DBA) Security

You can secure Master Files on a file-by-file basis. For each data source, security can be
maintained at two different levels. 

Database Administrator Level. You specify the Database Administrator (DBA) password for
the data source. The DBA has unlimited access to the Master File and data source and can
set up or change security restrictions for individual users. Only the Database Administrator
can encrypt or decrypt a data source.

User Level. You specify user passwords for the data source. A user password identifies a
user who has access to that data source. When you specify a user password, you must
also set at least the type of file access: read, write, read/write, or update. Security for each
user can be further limited by restricting access to segments, fields, or field values. For
more information, see Limiting Data Source Access: The RESTRICT Attribute on page 222.
Once a user password has been established, you can apply the same restrictions to
multiple users. For more information, see Applying Security Restrictions for Multiple Users
on page 217.

Note: You cannot specify a Database Administrator (DBA) password during the Create
Synonym process. You must use the Metadata canvas.

When security is specified, the Database Administrator or user must enter a password to get
access to the data source. When the user no longer needs access to the data source, you can
delete their security.
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Before adding any type of security to a data source, the Database Administrator must be aware
of certain DBA guidelines. See DBA Guidelines on page 215.

Procedure: How to Set Up Security for the Database Administrator

1. In the Metadata canvas, click DBA from the Tools menu or click the DBA button  from
the Synonym toolbar.

The DBA pane opens, as shown in the following image.

Note: The DBA pane is available from the Field View, Segment View, List View, and
Modeling View tabs.

2. Right-click the file name in the DBA window, point to Insert, then click DBA.
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A default DBA password will be created for the Master File. You can change this value,
delete it, add users to specify file restrictions, or add file names to specify data source-
specific restrictions to the current data source. You can also specify a separate DBA file
that contains DBA security restrictions.

Note: When the password is created and the cursor is in that field, you can right-click and
use the edit options to undo, select all, cut, copy, paste, or delete the password.

Procedure: How to Set Up Security for a User

1. In the DBA pane, right-click the DBA icon to insert user restrictions or specify a DBA file.

2. Once you add a user, you can continue to insert file access restrictions by right-clicking the
user field and selecting Insert.

3. Select the type of access: Read, Write, Read/Write, or Update.

4. Specify the type of restriction for each option: Restriction to Field, Value, Segment,
Noprint, or Same Restriction.

Note: The Same Restriction option is activated when there are multiple users.

5. Click OK to save the Master File with the user password and restrictions.

Note: To add WebFOCUS language security declarations to the Master File using the Text
Editor, see Implementing DBA Security Using WebFOCUS Language on page 219.

Reference: DBA Guidelines

You can ensure that the security restrictions you place on Master Files are correct by adhering
to the following guidelines:

Every file with access limits must have a DBA password.

No segment, field, or field value restrictions may be specified at the Database
Administrator level. The Database Administrator must have unlimited access to the data
source and all cross-referenced data sources.

Once security restrictions have been applied, the Database Administrator should conduct
thorough testing of every restriction before the data source is used. It is particularly
important to check field values to make sure they do not contain errors. If they are in error,
user access to the field data will be unnecessarily restricted.

All groups of cross-referenced data sources should have the same security restrictions.

You must have a DBA password to encrypt and decrypt or restrict existing data sources.

The Database Administrator can change any type of security restriction.
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Access levels affect the fields users can access. The Database Administrator must
consider what commands each user will need. If a user does not have access rights, that
user will receive a message.

Reference: DBA Pane

The following options are available from the DBA pane when the DBA password is selected.

DBA password 

By default, the DBA password is the same as the user ID used to connect to the Reporting
Server. Using the Rename option from the DBA password shortcut menu, you may enter a
different password of up to 64 characters. This is the password of the DBA who will be
creating and maintaining the current data source. The DBA has full access to the data
source and the corresponding Master File, controls the access rights of other users, and
has encryption privileges. For more information, see Encrypting and Decrypting a Master
File on page 218.

DBAFILE

Select the name of the Master File that contains your DBA security restrictions. Other
Master Files can use the DBA security restrictions in this Master File.

Insert Filename 

Enter the name of the Master File to which user security will be applied. This option is
used to add data source-specific restrictions to the current data source. It includes a
FILENAME attribute for the selected Master File. The FILENAME attribute in the referenced
Master File must be the same as the FILENAME attribute in the DBA section of the current
data source.

Insert Users 

Enter the passwords (up to 64 characters) of users whose access rights will be granted for
the current data source.

File Access 

For user access, select one of the following options:

Select Read Access for full viewing rights.

Select Write Access to permit additions or changes to the data source.

Select Read/Write Access for both of the above.

Select Update Access to permit changes to field values.
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Restrictions: Segment, Field, Value, Noprint, Same 

When the file access is selected, continue to select the type of restriction you wish to
apply.

Select Segment to grant access to individual segments.

Select Field to grant access to individual fields.

Select Value to limit access to values that meet a test condition.

Select Noprint to specify fields you do not want to display in a report.

Select Same to apply the same restrictions as other users that are already set up.

Applying Security Restrictions for Multiple Users

You can specify restrictions for one user and apply the same restrictions to other users. This
helps when you want to set the same restrictions for a group of users.

Procedure: How to Apply Previously Defined Restrictions to Another User

1. In the DBA pane, right-click the DBA password, point to Insert, and then click User.

2. Right-click the newly added user and select Insert to specify the desired type of access
restriction you would like to apply.

Available access types are Read Access, Write Access, Read/Write Access, and Update
Access.

3. Right-click an access type and select Insert, then Same Restriction.

Note: The Same Restriction option is only available when there are multiple users. A drop-
down combo box is activated in the Properties panel with a NAME attribute.

4. Click the arrow on the drop-down combo box next to the NAME attribute in the Properties
panel, and then select the user with the security restrictions that would apply to the new
user.

Security restrictions from the user selected in the drop-down combo box are applied to the
new user. You can apply the security restrictions to other users by repeating steps 1 to 4.

Note: You must have created at least one user security restriction to apply security
restrictions to multiple users.

Deleting a DBA or User Password

The DBA can delete a DBA password or security for a user when it is no longer needed. 
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Procedure: How to Delete a User Password

1. On the DBA pane, select the user password you wish to delete.

2. Right-click and select Delete or press Delete on the keyboard.

If you delete the user based upon whom you have assigned security restrictions for other
users, you must reset security restrictions for all users attached to the user you deleted.

Procedure: How to Delete a DBA Password

Deleting a DBA password will delete all user security for that data source.

On the DBA pane select the DBA password, then right-click and select Delete or press the
Delete key.

All security information is removed.

Encrypting and Decrypting a Master File

The DBA may use the Encrypt and Decrypt attributes from the Metadata canvas to scramble
and unscramble some or all of the contents of a data source. When you encrypt Master Files,
they are secure from unauthorized examination. 

Encryption at the data source level scrambles the entire contents of that Master File so it is
unreadable. When you encrypt a Master File, you can decrypt it. Decrypting unscrambles the
contents to its readable state.

Before you can encrypt or decrypt any Master File, you must specify the DBA password. If you
do not specify a DBA password, you will not be able to encrypt or decrypt the file.

Procedure: How to Encrypt a Master File

1. In the Metadata canvas, click DBA from the Tools menu or click the DBA button  from
the Synonym toolbar.

The DBA pane opens.

2. Create and save the Master File with the DBA password.

3. From the Metadata canvas Field View tab, select a segment from the Master File hierarchy
(left pane).

The values for the selected segment appear in the Properties panel on the right.

4. Select the ENCRYPT check box.

5. Click Save from the File menu to encrypt the Master File.
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Procedure: How to Decrypt a Master File

1. At the encrypted segment level in the Master File hierarchy, clear the ENCRYPT attribute.

2. Click Save from the File menu to decrypt the Master File.

Implementing DBA Security Using WebFOCUS Language

The declarations (called security declarations) follow the END command in a Master File and
tell WebFOCUS that security is needed for the data source and what type of security is needed.
The word END on a line by itself in the Master File terminates the segment and field attributes
and indicates that the access limits follow. If you place the word END in a Master File, it must
be followed by at least a DBA attribute. Each security declaration consists of one or several of
the following attributes:

The DBA attribute gives the name or password of the Database Administrator for the data
source. The Database Administrator has unlimited access to the data source and its
Master File.

The USER attribute identifies a user as a legitimate user of the data source. Only users
whose name or password is specified in the Master File of a WebFOCUS data source with
security placed on it have access to that data source.

The ACCESS attribute defines the type of access a given user has. The four types of access
available are:

RW, which allows a user to both read and write to a data source.

R, which allows a user only to read data in a data source.

W, which allows a user to only write new segment instances to a data source.

U, which allows a user only to update records in a data source.

The RESTRICT attribute specifies certain segments or fields to which the user is not
granted access. It can also be used to restrict the data values a user can see or perform
transactions on.

The NAME and VALUE attributes are part of the RESTRICT declaration.

Describe your data source security by specifying values for these attributes in a comma-
delimited format, just as you specify any other attribute in the Master File.
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Example: Implementing DBA Security in a Master File

The following is a Master File that uses security features:

FILENAME = PERS, SUFFIX = FOC,$
SEGMENT = IDSEG, SEGTYPE = S1,$
 FIELD = SSN          ,ALIAS = SSN    ,FORMAT = A9   ,$
 FIELD = FULLNAME     ,ALIAS = FNAME  ,FORMAT = A40  ,$
 FIELD = DIVISION     ,ALIAS = DIV    ,FORMAT = A8   ,$
SEGMENT=COMPSEG, PARENT=IDSEG, SEGTYPE=S1,$
 FIELD = SALARY       ,ALIAS = SAL    ,FORMAT = D8   ,$
 FIELD = DATE         ,ALIAS = DATE   ,FORMAT = YMD  ,$
 FIELD = INCREASE     ,ALIAS = INC    ,FORMAT = D6   ,$
END
DBA=JONES76,$
USER=TOM    ,ACCESS=RW, $
USER=BILL   ,ACCESS=R  ,RESTRICT=SEGMENT  ,NAME=COMPSEG    ,$
USER=JOHN   ,ACCESS=R  ,RESTRICT=FIELD    ,NAME=SALARY     ,$
                                           NAME=INCREASE   ,$
USER=LARRY  ,ACCESS=U  ,RESTRICT=FIELD    ,NAME=SALARY     ,$
USER=TONY   ,ACCESS=R  ,RESTRICT=VALUE    ,NAME=IDSEG,
   VALUE=DIVISION EQ 'WEST' ,$
USER=MARY   ,ACCESS=W  ,RESTRICT=VALUE    ,NAME=SALTEST,
   VALUE=INCREASE+SALARY GE SALARY,$
                                           NAME=HISTTEST,
   VALUE=DIV NE ' ' AND DATE GT 0,$

Identifying the DBA: The DBA Attribute

The first security attribute should be a password that identifies the Database Administrator.
This password can be up to 64 characters long and, by default, is not case-sensitive. It can
include special characters. If the DBA password contains blanks, it must be enclosed in single
quotation marks ('). Since nothing else is needed, this line is terminated by the usual delimiter
(,$).

Example: Identifying the DBA Using the DBA Attribute

DBA=JONES76,$

Identifying Users With Access Rights: The USER Attribute

The USER attribute is a password that identifies the users who have access to the data
source. A USER attribute cannot be specified alone. It must be followed by at least one
ACCESS restriction (discussed in Specifying an Access Type: The ACCESS Attribute on page
221) to specify what sort of ACCESS the user is granted. 
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Before using a secured data source, a user must enter the password using the SET PASS or
SET USER command. If that password is not included in the Master File, the user is denied
access to the data source. When the user does not have a password, or has one that is
inadequate for the type of access requested, a message appears.

Syntax: How to Set the USER Attribute

Any user whose name or password is not declared in the Master File is denied access to that
data source. The syntax of the USER attribute is 

USER = name

where:
name

Is a password of up to 64 characters for the user. The password can include special
characters and is not case-sensitive. If the password contains blanks, it must be enclosed
in single quotation marks (').

You can specify a blank password (default value if not previously changed). Such a password
does not require the user to issue a SET PASS= command. A blank password may still have
access limits and is convenient when a number of users have the same access rights.

Example: Setting the USER Attribute

USER=TOM,...

An example of setting a user password to blank, and access to read only follows:

USER= , ACCESS=R,$

Establishing User Identity

A user must enter his or her password before using any WebFOCUS data source that has
security specified for it. A single user may have different passwords in different files. For
example, in file ONE, the rights of password BILL apply, but in file TWO, the rights of password
LARRY apply. Use the SET PASS command to establish the passwords. 

Specifying an Access Type: The ACCESS Attribute

The ACCESS attribute specifies what sort of access a user is granted. Every security
declaration, except the DBA declaration, must have a USER attribute and an ACCESS attribute. 

The following is a complete security declaration, consisting of a USER attribute and an ACCESS
attribute.
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USER=TOM, ACCESS=RW,$

This declaration gives Tom read and write (for adding new segment instances) access to the
data source.

Access levels affect what kind of commands a user can issue. Before you decide what access
levels to assign to a user, consider what commands that user will need. If a user does not
have sufficient access rights to use a given command, a message appears.

ACCESS levels determine what a user can do to the data source. Use the RESTRICT attribute
(discussed in Limiting Data Source Access: The RESTRICT Attribute on page 222) to limit the
fields, values, or segments to which a user has access. Every USER attribute must be
assigned an ACCESS attribute. The RESTRICT attribute is optional. Without it, the user has
unlimited access to fields and segments within the data source.

Limiting Data Source Access: The RESTRICT Attribute

The ACCESS attribute determines what a user can do with a data source.

The optional RESTRICT attribute further restricts a user access to certain fields, values, or
segments. 

The RESTRICT=VALUE attribute supports those criteria that are supported by the IF phrase. The
RESTRICT=VALUE_WHERE attribute supports all criteria supported in a WHERE phrase,
including comparison between fields and use of functions. The WHERE expression will be
passed to a configured adapter when possible.

Syntax: How to Limit Data Source Access

...RESTRICT=level, NAME={name|SYSTEM} [,VALUE=test],$

or

...RESTRICT=VALUE_WHERE, NAME=name,  VALUE=expression; ,$

where: 

level

Can be one of the following:

FIELD, which specifies that the user cannot access the fields named with the NAME
parameter.

SEGMENT, which specifies that the user cannot access the segments named with the
NAME parameter.
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SAME, which specifies that the user has the same restrictions as the user named in
the NAME parameter. No more than four nested SAME users are valid.

NOPRINT, which specifies that the field named in the NAME or SEGMENT parameter
can be mentioned in a request statement, but will not display. You can use a VALUE
test to limit the restriction to values that satisfy an expression. For example, consider
the following RESTRICT=NOPRINT declaration. User MARY can only display the IDs of
those employees whose salaries are less than 10000.

USER=MARY   ,ACCESS=R  ,RESTRICT=NOPRINT  ,NAME=EMP_ID ,
   VALUE=CURR_SAL LT 10000;,$                            

name

Is the name of the field or segment to restrict. When used after NOPRINT, this can only be
a field name. NAME=SYSTEM, which can only be used with value tests, restricts every
segment in the data source, including descendant segments. Multiple fields or segments
can be specified by issuing the RESTRICT attribute several times for one user.

Note: With value restrictions, NAME=segment restricts the named segment and any
segment lower in the hierarchy, whether or not an alternate file view changes the retrieval
view. This means that if a parent segment has a value restriction, and a join or alternate
file view makes a child segment the new root, the value restriction on the original parent
will still apply to the new root.

VALUE

Specifies that the user can have access to only those values that meet the test described
in the test parameter.

test

Is the value test that the data must meet before the user can have access to it. The test
is an expression supported in an IF phrase.

VALUE_WHERE

Specifies that the user can have access to only those values that meet the test described
in the expression parameter.

expression;

Is the value test that the data must meet before the user can have access to it. The test
is an expression supported in a WHERE phrase.

Note: The semicolon (;) is required.

3. Creating Metadata

WebFOCUS App Studio User’s Manual  223



Example: Limiting Data Source Access

USER=BILL ,ACCESS=R ,RESTRICT=SEGMENT ,NAME=COMPSEG,$

Placing Security Information in a Central Master File

The DBAFILE attribute enables you to place all passwords and restrictions for multiple Master
Files in one central file. Each individual Master File points to this central control file. Groups of
Master Files with the same DBA password may share a common DBAFILE which itself has the
same DBA password. 

There are several benefits to this technique, including:

Passwords only have to be stored once when they are applicable to a group of data
sources, simplifying password administration.

Data sources with different user passwords can be JOINed. In addition, individual DBA
information remains in effect for each data source in a JOIN.

The central DBAFILE is a standard Master File. Other Master Files can use the password and
security restrictions listed in the central file by specifying its file name with the DBAFILE
attribute.

Syntax: How to Place Security Attributes in a Central Master File

END
DBA=dbaname, DBAFILE=filename ,$

where: 

dbaname

Is the same as the dbaname in the central file.

filename

Is the name of the central file.

You can specify passwords and restrictions in a DBAFILE that apply to every Master File that
points to that DBAFILE. You can also include passwords and restrictions for specific Master
Files by including FILENAME attributes in the DBAFILE.
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Hiding Restriction Rules: The ENCRYPT Command

Since the restriction information for a WebFOCUS data source is stored in its Master File,
encrypt the Master File in order to prevent users from examining the restriction rules. Only the
Database Administrator can encrypt a description. You must set PASS=DBAname before you
issue the ENCRYPT command.

Syntax: How to Hide Restriction Rules: ENCRYPT Command

ENCRYPT FILE filename

where: 

filename

Is the name of the file to be encrypted.

Example: Encrypting and Decrypting a Master File

The following is an example of the complete procedure: 

SET PASS=JONES76
ENCRYPT FILE PERS

The process can be reversed in order to change the restrictions. The command to restore the
description to a readable form is DECRYPT.

The DBA password must be issued with the SET command before the file can be decrypted.
For example:

SET PASS=JONES76
DECRYPT FILE PERS

Encrypting Data

You may also use the ENCRYPT parameter within the Master File to encrypt some or all of its
segments. 

Encryption takes place on the segment level. That is, the entire segment is encrypted. The
request for encryption is made in the Master File by setting the attribute ENCRYPT to ON.

Example: Encrypting Data

SEGMENT=COMPSEG, PARENT=IDSEG, SEGTYPE=S1, ENCRYPT=ON,$
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You must specify the ENCRYPT parameter before entering any data in the data source. The
message NEW FILE... must appear when the encryption is first requested. Encryption cannot
be requested later by a change to the Master File and cannot be removed after it has been
requested or any data has been entered in the data source.

Analyzing Procedures Using Impact Analysis

You can use Impact Analysis to generate a report that identifies the procedures that access a
specific Master File or field within a Master File. Impact Analysis helps you analyze the
potential impact of modifying or deleting Master Files or fields and enables you to analyze
data, control search criteria, save reports, and interactively open and edit procedures based on
search results. 

Impact Analysis searches Business Views in addition to WebFOCUS procedures. This enables
you to see if changes in the original Master File will impact fields used in the Business View.

Impact Analysis is accessible from the Domains and Data Servers development areas of the
Configured Environments tree.

Note: You can launch Impact Analysis from the Configured Environments tree or from the
Metadata canvas. When Impact Analysis is launched from the Metadata canvas, it searches
files based on the application path of the Reporting Server. From the Configured Environments
tree, it enables you to select applications or folders to be searched.

Procedure: How to Use Impact Analysis From the Configured Environments Tree

1. You can use Impact Analysis from the Configured Environments tree in the following ways: 

From the Domains area, right-click a folder and then click Impact Analysis to limit the
search to the selected folder and its subfolders.

Right-click the Domains node and then click Impact Analysis to search all folders within
that node.

From the Data Servers area, expand an application, right-click a Master File, and then
click Impact Analysis from the shortcut menu.

The Impact Analysis canvas opens with the New Report tab displaying the selected Master
File Name and default Search Paths.

2. To search for all procedures that access a specific Master File or field, perform one of the
following:

Selected Master File. The Master File you selected when opening the canvas will be
searched, by default. Proceed to step 3.
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Different Master File. Click the ellipsis button (...) to the right of the File Name search
field and select a different Master File in the Select a Master File dialog box that
opens.

Single Field Within a Master File. After you select the desired Master File, click the
ellipsis button (...) to the right of the Field Name search field and double-click a field
name in the Master File shortcut menu.

3. Optionally, to search for procedures in directory paths not listed by default in the Search
Paths pane, add more search paths by clicking the folder icon above the Search Paths
area and selecting one or more folders in the Select Folder dialog box that opens.

Note: You can also delete search paths by highlighting a search path and clicking the
Delete icon above the Search Paths area.

4. Click Analyze to display a report in the Impact Analysis Result pane.

The following image shows the New Report tab of the Impact Analysis canvas populated
with File Name search criteria, multiple Search Paths, and a report displayed in the Impact
Analysis Result pane.

You have options to edit procedures, delete a report item, export a report, and print the
report.

Exported reports are XML-formatted, have an .IAR extension, and are saved in the
following default directory (unless you specify a different location):

drive:\ibi\AppStudioreleasenumber\bin 

3. Creating Metadata

WebFOCUS App Studio User’s Manual  227



5. Click the Saved Reports tab to access all previously created reports.

All Impact Analysis reports are automatically saved in the following XML-formatted file:

drive:\ibi\AppStudioreleasenumber\bin\IARepository.xml

Information is appended to this file as new analysis reports are performed. You have
options to view reports, import previously exported reports, and delete reports.

Note: You can select an Impact Analysis report and click the Report Description icon to
display details of the report.
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Chapter4
Creating Reports

Reports are the foundation of business intelligence and business analytics, enabling you
to gain valuable insights and make improved business decisions. In App Studio, you can
create and edit reports using the Report canvas. When you create a new report, you use
the Report Wizard. In report mode, you can create and style simple or complex reports,
add data to the Report canvas, and style that data creating a graphical representation of
the report page. This allows you to view how the report displays at run time.

This topic provides an overview of reporting, the types of reports you can create with App
Studio, how to launch the Report Wizard to create reports, and a sample GUI procedure,
with its associated WebFOCUS syntax, that you can use to create each type of report.

For information on the Report Wizard, see Launching the Report Wizard on page 231.

For information on the tabs and panels that are available when you are developing
reports in the Report canvas, see Accessing Reporting Components on page 303.

In this chapter:

Building Reports Overview

Report Types

Launching the Report Wizard

Creating Reports Using the Report Wizard

Creating Precision Reports

Joining Data

Blending Data

Styling Reports

Accessing Reporting Components

Linking Reports with Auto Linking and Auto Drill

Reporting Syntax Summary
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Building Reports Overview

App Studio provides you with the toolset and resources you need to create, edit, and view
reports online or offline. App Studio allows users from beginner to advanced skill levels to
independently create their own reports or modify existing reports without writing complex code
or requiring the assistance of IT staff. Once your reports are developed, you can add them to a
reporting application that can be made available throughout your enterprise internally,
externally to the field on mobile devices, or both. App Studio allows you to deploy, manage,
and expand your reporting application as required.

Business intelligence reports are usually designed to answer such questions as:

What happened in the first quarter of this year? How does it compare to the first quarter of
last year?

When is the best season to roll out our new inventory to our stores?

How many products were sold in a given year, month, week, or day?

Who was the best performing seller for these products?

Reports designed for business analytics can answer such questions as:

Why did the southern region exceed third quarter revenue estimates?

Will this event or result occur in the future?

What will happen if we introduce a new product line in the Spring?

What else does the data tell us that we never thought to ask?

Report Types

Using App Studio, you can create the following report types using graphical tools or the
WebFOCUS syntax:

Tabular report. Displays information in rows and columns. This is the basic report type,
incorporating the fundamental reporting concepts. Most of the other report formats build on
these concepts. You can drill down or roll up data hierarchies, pivot fields from columns to
rows (or vice versa), and separate information by filtering or querying data sources based
on specified criteria or thresholds. You can also create drill through reports that contain a
summary report and detail reports, where the detail reports contains all the detail data for
designated fields in the summary report. You can display these reports in many different
formats, including HTML, Excel®, PowerPoint, and PDF. For more information, see Creating
a Tabular Report on page 238.
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Active report. Designed for offline analysis. When using an active report, you can interact
with data, using analysis options similar to those found in an Excel workbook. Since no
connection to a server is required to view the data or use the analysis options, you can
save and use the report anywhere. Analysis options include filtering, sorting, charting, and
much more. For more information, see Creating an Active Report on page 240.

Excel Compound and Table of Contents reports. Provides a way to generate multiple
worksheet reports using the XLSX output format. By default, each of the component reports
from the compound report is placed in a new Excel worksheet. A Table of Contents report
provides a way to generate a multiple worksheet report where a separate worksheet is
generated for each value of the first sort field (BY) in the report. For more information, see 
Creating an Excel FORMULA Table of Contents Report on page 245.

Financial report. Specifically designed to handle the task of creating, calculating, and
presenting financially oriented data, such as balance sheets, consolidations, and budgets.
You design the content of the report on a row-by-row basis using a field (called a FOR field)
that identifies each row, such as an account field. Once you have created the FOR field, you
can build these reports from the Matrix tab. This organization provides a number of
advantages, including easily defined inter-row and inter-column calculations. For more
information, see Creating a Financial Report on page 246.

Precision report. Gives you an additional set of tools that make it easy to control the
precise placement of objects and data in the report output. For example, with a precision
report, you can quickly create a layout that is perfectly aligned for a preprinted form (such
as a Bill of Sale or a tax form) and that automatically breaks out one record per report
page. You can convert an existing report into a precision report or you can create a new
precision report. For more information, see Creating a Precision Report on page 251.

SQL request. You can retrieve information using the SQL reporting language, and can
directly incorporate WebFOCUS formatting commands. For more information, see Creating a
Tabular Report Using an SQL Request on page 255.

Launching the Report Wizard

The Report Wizard allows you to create a new report procedure or SQL report procedure, and
open an existing report. 

To open the Report Wizard:

On the Home tab, in the Content group, click Report.

In the Environments Tree panel, right-click an application folder, point to New, and click
Report.
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Note: If you choose to create a new report using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify
whether you are creating a report or SQL report. You will instead be brought to the Select
Data Source window, with the location for your report already selected.

The Report Wizard opens, as shown in the following image.

From the Report Wizard, you can create a new report or SQL report procedure or open a recent
procedure.

Procedure: How to Create a Report Using the Report Wizard

After you launch the Report Wizard, you can begin to create your report procedure. 

Note: If you choose to create a new report using the shortcut menu in the Environments Tree
panel, you will skip the first screen of the Report Wizard. You will not have to specify whether
you are creating a report or SQL report. You will instead be brought to the Select Data Source
window, with the location for your report already selected.

1. Click Create Report.

The Report Wizard - Select Procedure Location window opens.

2. Navigate to where you want to create the new report and click Next.
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The Select Data Source window opens.

3. Choose an application folder in the application folder tree, and select a Master File in the
Master files list. You can select the Use Qualified Path check box if you only want to
display the data sources in the application folder and generate a qualified file name
reference.

4. Click Finish.

The Report canvas and the Procedure View panel open.

5. Double-click fields in the Object Inspector, or drag them on to the canvas to add them to
the report.

6. Format your report by using the options on the Report, Format, Data, Layout, Images,
View, Field, and Appearance tabs.

Tip: The Field and Appearance tabs appear when you select a data column on the Report
canvas.

7. To save your report, click Save on the Quick Access Toolbar, or click Save or Save As from
the Application menu.

8. To run your report, click Run on the Quick Access Toolbar, or click Run from the
Application menu.

Procedure: How to Create an SQL Report From an External .sql File

After you launch the Report Wizard, you can begin to create your SQL report procedure. This
enables you to browse and select external procedures that exist in the domain. 

Note: If you choose to create a new SQL report using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify
whether you are creating a report or SQL report. You will instead be brought to the SQL Report
Wizard - Welcome window.

1. Click Create SQL Report.

The Report Wizard - Choose location for the new SQL Report window opens.

2. Select a location for your SQL report and click Next.

The SQL Report Wizard - Welcome window opens.

3. Click the Included from an external ‘.sql’ file option.

4. Click Next.

The SQL Report Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list.
The drop-down list changes depending on your server configuration.
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6. In the Select connection area, choose a connection from the drop-down list generated
from the engine you selected.

7. Click Next.

The SQL Report Wizard - Include external SQL file window opens.

8. Click Browse to select an external SQL file name or type the external SQL file name in the
field.

Optionally, you can run with limited records by clicking Run SQL. By default, the Run with
limited records check box is selected so you can test your procedure with a read limit if the
engine supports it. There is a field box next to the check box in which you can enter the
number of records to be read. The default limit is 100.

9. Click Next. The SQL Report Wizard - Summary of SQL options window opens. Review your
options and click Next, which opens the Report Wizard - SQL Data Source window.

10. Navigate to where you want to create the new procedure.

11. In the Enter a Procedure Name field, type a name for the SQL report.

Note: Typing a procedure name is not required to create a new report. If you do not type a
procedure name in the Enter a Procedure Name field, a default procedure name will be
provided until you save the procedure.

12. Click Finish.

The Report canvas and the Procedure View panel open. You can now add data to your
report and format the data using the tabs on the ribbon.

Procedure: How to Pass SQL Commands to the RDBMS Using SQL Passthru

After you launch the Report Wizard, you can begin to create your SQL report procedure by
typing SQL commands that will be passed on to the RDBMS with the SQL Passthru feature.

Note: If you choose to create a new SQL report using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify
whether you are creating a report or SQL report. You will instead be brought to the Report
Wizard - Choose location for the new SQL Report window, with the location for your report
already selected.

1. Click Create SQL Report.

The Report Wizard - Choose location for the new SQL Report window opens.

2. Select a location for your SQL report and click Next.

The SQL Report Wizard - Welcome window opens.
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3. Click Type SQL statements in the report request.

4. Click Next.

The SQL Report Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list.
The drop-down list changes depending on your server configuration.

6. In the Select the connection area, choose a connection from the drop-down list generated
from the engine you selected.

7. Click Next.

The SQL Report Wizard - Enter SQL statements window opens.

8. In the field box, type the SQL statements you want to pass to the RDBMS.

Optionally, you can run with limited records by clicking Run SQL. By default, the Run with
limited records check box is selected, so you can test your procedure with a read limit if
the engine supports it. There is a field box next to the check box in which you can enter
the number of records to be read. The default limit is 100.

9. Click Next.

The SQL Report Wizard - Summary of SQL options window opens.

10. Review your options and click Next.

The Report Wizard - SQL Data Source window opens.

11. Navigate to where you want to create the new procedure.

12. In the Enter a Procedure Name field, type a name for the SQL report.

Note: Typing a procedure name is not required to create a new report. If you do not type a
procedure name in the Enter a Procedure Name field, a default procedure name will be
provided until you save the procedure.

13. Click Finish.

The Report canvas and the Procedure View panel open. You can now add data to your
report and format the data using the tabs on the ribbon.

Procedure: How to Import SQL Commands From an Existing .sql File

You can import commands from existing .sql files. This enables you to modify SQL code after
importing it from an external file to the procedure being built. You can modify the request using
bits of the code.
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Note: If you choose to create a new SQL report using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Report Wizard. You will not have to specify
whether you are creating a report or SQL report. You will instead be brought to the Report
Wizard - Choose location for the new SQL Report window, with the location for your report
already selected.

1. Click Create SQL Report.

The Report Wizard - Choose location for the new SQL Report window opens.

2. Select a location for your SQL report and click Next.

The SQL Report Wizard - Welcome window opens.

3. Click Import from an existing ‘.sql’ file and click Next.

The SQL Report - Data access information window opens.

4. In the Select SQL database engine area, select a database from the drop-down list. The
drop-down list changes depending on your server configuration.

5. In the Select the connection area, choose a connection from the drop-down list generated
from the engine you selected.

6. Click Next.

The SQL Report Wizard - Import external SQL file window opens.

7. Type the SQL file name that you want to import or click Browse to select it.

Optionally, you can run with limited records by clicking Run SQL. By default, the Run with
limited records check box is selected, so you can test your procedure with a read limit if
the engine supports it. There is a field box next to the check box in which you can enter
the number of records to be read. The default limit is 100. You can edit these options
here or in the next step.

8. Click Next.

The SQL Report Wizard - Enter SQL statements window opens.

9. In the field box, type the SQL statements you want to pass to the RDBMS.

10. Click Next.

The SQL Report Wizard - Summary of SQL options window opens.

11. Review your options and click Next.

The Report Wizard - SQL Data Source window opens.

12. Navigate to where you want to create the new procedure.

13. In the Enter a Procedure Name field, type a name for the SQL report.
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Note: Typing a procedure name is not required to create a new report. If you do not type a
procedure name in the Enter a Procedure Name field, a default procedure name will be
provided until you save the procedure.

14. Click Finish.

The Report canvas and the Procedure View panel open. You can now add data to your
report and format the data using the tabs on the ribbon.

Creating Reports Using the Report Wizard

In App Studio a report is a WebFOCUS procedure (with a .fex extension) that returns data from
a selected data source, and displays it in a column/row format. You create an App Studio
report using the Report Wizard. The wizard lets you specify the location where the report is
saved and the data source. It then opens the Report canvas. The Report canvas includes the
Object Inspector pane than contains the measures and dimensions of the selected data
source. You can drag and drop objects from the Object Inspector to populate the columns and
rows of your report.

When you make selections in the Report Wizard, WebFOCUS syntax is automatically generated
to produce the report output. You can create reports easily, with no knowledge of the syntax.
However, for a summary of WebFOCUS reporting syntax, see Reporting Syntax Summary on
page 413.
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Creating a Tabular Report

The following image shows a tabular report, which displays cost of goods and revenue sorted
across brand types and by product category, creating a matrix report. When you include both
BY and ACROSS sort phrases in a report request, information is sorted vertically and
horizontally, turning the report into a matrix of information that you read like a grid. A matrix
report can have multiple BY and ACROSS sort fields.

Note: The default stylesheet is used to format the report. You can create your own stylesheet
or choose from other stylesheets that are available in the product.

Procedure: How to Create a Tabular Report Using the Report Canvas

1. On the Home tab, in the Content group, click Report or in the Environments Tree panel,
right-click the desired folder, point to New, and click Report.

The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For this
example, click wf_retail.mas.

The Report canvas opens.

4. Add the following fields to your report in the following order. You can double-click the fields
in the Object Inspector, or drag them to the Report canvas.

PRODUCT_CATEGORY

BRANDTYPE

COGS_US
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REVENUE_US

5. Select the BRANDTYPE field and from the Column Type group, select Sort Across to sort
the report across brand type values.

6. To add a heading to the report, on the Report tab, click Header & Footer and select Report
Header.

7. Type Cost and Revenue in the Heading text box.

8. In the Procedure View panel, right-click the Comment component, point to New, and click
Set.

The Set canvas opens.

9. In the Available Settings area, use the scrollbar to locate the NODATA setting.

10. Double-click NODATA or select NODATA and click Add.

The NODATA setting now appears in the Used Settings area.

11. Type N/A in the Current Value area to change the default missing data character from a
period (.) to N/A to indicate the missing data in the report.

12. Run the report.

Procedure: How to Create a Tabular Report Using WebFOCUS Syntax

You can create the tabular report using the following WebFOCUS syntax, which you can type
into a procedure using the Text Editor.

TABLE FILE WF_RETAIL
HEADING
"Cost and Revenue"
SUM COGS_US REVENUE_US 
BY PRODUCT_CATEGORY
ACROSS BRANDTYPE
ON TABLE SET NODATA N/A
END
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Creating an Active Report

The following image shows an active report designed for offline analysis. The request uses the
ON TABLE PCHOLD FORMAT AHTML command to create the active report. Analysis options
include filtering, sorting, charting, and much more. You click an arrow next to a column heading
to gain access to the analytic options. For more information on active reports, see the Active
Technologies User's Guide.

Procedure: How to Create an Active Report Using the Report Canvas

1. Create the tabular report outlined in How to Create a Tabular Report Using the Report
Canvas on page 238.

2. On the Format tab, click active report.

3. Run the report.

Procedure: How to Create an Active Report Using WebFOCUS Syntax

You can create the active report using the following WebFOCUS syntax, which you can type into
a procedure using the Text Editor.
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TABLE FILE WF_RETAIL
HEADING CENTER
"Cost and Revenue"
SUM COGS_US REVENUE_US 
BY PRODUCT_CATEGORY
ACROSS BRANDTYPE
ON TABLE PCHOLD FORMAT AHTML
ON TABLE SET NODATA N/A
END

Procedure: How to Select the Sort Order for a Control for Active Formats

You can select the sort order of display for a control for Active formats in the HTML and
Document canvas. You can select Ascending or Descending from the Sort order option in the
Settings panel. Ascending is the default value selected. At run time, the values will be sorted
based on the sort order selected.

1. Create an active report that includes a filter control (for example, a date filter).

When you run the report, as shown in the following image, notice that date values are
sorted in ascending order. Ascending is the default value.
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2. Open the report and select the control, as shown in the following image.
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3. From the Settings panel, select Descending for the sort order, as shown in the following
image.
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When you run the report, as shown in the following image, notice that the date values for
the control are now sorted in the descending order.
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Creating an Excel FORMULA Table of Contents Report

The following image shows an Excel Workbook with multiple worksheets (tabs) for each value
of the major sort field (BY) and with formulas for the column totals. The request uses the ON
TABLE PCHOLD FORMAT XLSX FORMULA BYTOC command to create the multiple worksheets.

Procedure: How to Create an Excel Formula Table of Contents Report Using the Report Canvas

1. Create the tabular report outlined in How to Create a Tabular Report Using the Report
Canvas on page 238.

2. Select the Brand Type field and from the Column Type group, select Sort Down to change
the field from an Across field to a By field.

3. Drag the Brand Type field before the Product Category field so that Brand Type is the first
By sort field.

4. From the Report group, click Column Total and select Column Totals to create totals for
each of the numeric columns (Cost of Goods, Revenue) and to show the formula
capability.

5. On the Format tab, in the Output Types group, click Excel and select Excel XLSX Formula.

The Output Format Options dialog box opens.

6. Select On for the Create separate worksheets for each primary sort value option.

7. Run the report.
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Procedure: How to Create an Excel Formula Table of Contents Report Using WebFOCUS Syntax

You can create the Excel Formula Table of Contents report using the following WebFOCUS
syntax, which you can type into a procedure using the Text Editor.

TABLE FILE WF_RETAIL
HEADING
"Cost and Revenue"
SUM COGS_US REVENUE_US 
BY BRANDTYPE
BY PRODUCT_CATEGORY
ON TABLE SUBTOTAL
ON TABLE PCHOLD FORMAT XLSX FORMULA BYTOC
END

Creating a Financial Report

In a financial report, specific rows can be placed anywhere in the report.

Rows can be displayed for selected values in the data source (TAG rows).

Rows can be displayed for values calculated from that data (RECAP).

Values can be inserted directly or picked up from another file (POST and PICKUP).

Text rows, blank rows, and rows of bars (BAR) can be inserted at any point in the report for
clarity.

Inter-row and inter-column calculations can be performed at any point in the report.

The following image shows a financial report with cost and revenue for specific products.
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Procedure: How to Create a Financial Report Using the Report Canvas and Matrix Tab

1. On the Home tab, in the Content group, click Report or in the Environments Tree panel,
right-click the desired folder, point to New, and click Report.

The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For this
example, click wf_retail.mas.

The Report canvas opens.

4. Add the following fields to your report in the following order. You can double-click the fields
in the Object Inspector, or drag them to the Report canvas.

ID_PRODUCT

COGS_US

REVENUE_US

5. To add a heading to the report, on the Report tab, click Header & Footer and select Report
Header.

6. Type Cost and Revenue in the Heading text box.

7. Select the ID_PRODUCT field, and from the Column Type group, select For Row.

8. Click the Matrix tab, to open the Matrix canvas.

Note: The Matrix view tab is only visible when a FOR field exists.

9. Create a text row to introduce the Entertainment group:

a. Click Text from the Insert group to make the row a text row, or right-click row R1
(except on the label) and select Change Type to, and then select Text.

The TEXT dialog box opens.

b. Type the following in the text box:

Entertainment:

c. Click OK.

Entertainment appears in the Title column on the matrix.

10. Create a row for the Stereo Systems product codes:

a. In the For field values panel, multi-select 2001 to 2167 and drag the values to row R2
in the ID_PRODUCT column.

Notice that the TAG row type is entered in the Row Type column. You can also select
Tag from the Insert group and type the tag values into the dialog box.
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By default, for a tag row, the tag values will display in the left on the report. However,
you can change the row title on the report. In addition, if you want to use this row in
calculations in the report, you can assign it a label to use as a name in the
calculations.

b. Right-click 2001 TO 2167 in the ID_PRODUCT column and select Row Properties.

The TAG dialog box opens.

c. On the General tab, type an optional label and title for the 2001 TO 2167
ID_PRODUCT values, for example SS and Stereo Systems, respectively.

d. Click OK to return to the matrix.

11. Create a row for the Televisions product codes:

a. In the For field values panel, multi-select 4012 to 4018 and drag the values to row R3
in the ID_PRODUCT column.

Notice that the TAG row type is entered in the Row Type column. You can also select
Tag from the Insert group and type the tag values into the dialog box.

b. Right-click 4012 TO 4018 and select Row Properties.

The TAG dialog box opens.

c. On the General tab, type an optional label and title for the 4012 TO 4018
ID_PRODUCT values, for example TV and Televisions, respectively.

d. Click OK to return to the matrix.

12. Place an underscore under the Entertainment rows:

a. Click Bar from the Insert group to make the row a bar row, or right-click row R4 (except
on the label) and select Change row type to, and then select Bar.

The BAR dialog box opens.

b. Click OK to accept the default underline character.

13. Add a row that totals the Entertainment products:

a. Click Recap from the Insert group to make the row a recap row, or right-click row R5
(except on the label) and select Change Type to, and then select Recap.

The RECAP dialog box opens at the Options tab.

b. Type SS + TV in the Recap box.

c. Click the General tab and type the label and title for the Recap calculation, for
example, ENTERTAIN and Total Entertainment, respectively.

14. Create a text row to introduce the Accessories group:

a. Click Text from the Insert group to make the row a text row, or right-click row R6
(except on the label) and select Change Row Type to, and then select Text.
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The TEXT dialog box opens.

b. Type the following in the text box:

Accessories:

c. Click OK.

Accessories: appears in the Title column on the matrix.

15. Create a row for the Headphones product codes:

a. In the For field values panel, multi-select 5001 to 5007 and drag the values to row R7
in the ID_PRODUCT column.

Notice that the TAG row type is entered in the Row Type column. You can also select
Tag from the Insert group and type the tag values into the dialog box.

b. Right-click 5001 TO 5007 and select Row Properties.

The TAG dialog box opens.

c. On the General tab, type an optional label and title for the 5001 TO 5007
ID_PRODUCT values, for example HP and Headphones, respectively.

d. Click OK to return to the matrix.

16. Create a row for the Remote Controls product codes:

a. In the For field values panel, multi-select 5008 to 5009 and drag the values to row R8
in the ID_PRODUCT column.

Notice that the TAG row type is entered in the Row Type column. You can also select
Tag from the Insert group and type the tag values into the dialog box.

b. Right-click 5008 TO 5009 and select Row Properties.

The TAG dialog box opens.

c. On the General tab, type an optional label and title for the 5008 TO 5009
ID_PRODUCT values, for example RC and Remote Controls, respectively.

d. Click OK to return to the matrix.

17. Place an underscore under the Accessories rows:

a. Click Bar from the Insert group to make the row a bar row, or right-click row R9 (except
on the label) and select Change Type to, and then select Bar.

The BAR dialog box opens.

b. Click OK to accept the default underline character.
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18. Add a row that totals the Accessories products:

a. Click Recap from the Insert group to make the row a recap row, or right-click row R10
(except on the label) and select Change Type to, and then select Recap.

The RECAP dialog box opens at the Options tab.

b. Type HP + RC in the Recap box.

c. Click the General tab and type the label and title for the Recap calculation, for
example, TOTACC and Total Accessories, respectively.

19. Place an underscore under the Total Accessories row:

a. Click Bar from the Insert group to make the row a bar row, or right-click row R11
(except on the label) and select Change row type to, and then select Bar.

The BAR dialog box opens.

b. Click OK to accept the default underline character.

20. Add a row that totals both the Entertainment and Accessories products:

a. Click Recap from the Insert group to make the row a recap row, or right-click row R12
(except on the label) and select Change Type to, and then select Recap.

The RECAP dialog box opens at the Options tab.

b. Type ENTERTAIN + TOTACC in the Recap box.

c. Click the General tab and type the label and title for the Recap calculation, for
example, TOTAL and Total.

21. Run the report.

Procedure: How to Create a Financial Report Using the WebFOCUS Syntax

You can create the financial report using the following WebFOCUS syntax that defines the
report output on a row-by-row basis.

Creating Reports Using the Report Wizard

250  Information Builders



TABLE FILE WF_RETAIL_SALES
HEADING CENTER
"Cost and Revenue"
" "
SUM COGS_US REVENUE_US
FOR ID_PRODUCT
"---Entertainment---" OVER
'2001' TO '2167' AS 'Stereo Systems' LABEL SS     OVER
'4012' TO '4018' AS 'Televisions' LABEL TV        OVER
BAR                                               OVER
RECAP ENTERTAIN=SS + TV; AS 'Total Entertainment' OVER
"---Accessories---"                               OVER
'5001' TO '5007' AS 'Headphones' LABEL HP         OVER
'5008' TO '5009' AS 'Remote Controls' LABEL RC    OVER
BAR                                               OVER
RECAP TOTACC=HP+RC; AS 'Total Accessories'        OVER
BAR                                               OVER
RECAP TOTAL=ENTERTAIN+TOTACC; AS 'Total'
ON TABLE NOTOTAL
ON TABLE SET STYLE *
TYPE=REPORT, GRID=OFF ,$
ENDSTYLE
END

Creating a Precision Report

The precision report is a report type that gives you an additional set of tools that make it easy
to control the precise placement of objects and data in the report output. For example, with a
precision report, you can quickly create a layout that is perfectly aligned for a preprinted form
(like a Bill of Sale or a tax form) and that automatically breaks out one record per report page.
Other benefits of precision reports include:

Select multiple objects to size identically, or space evenly.

Enhance headers and footers by including fields as display variables.

Create Composition Templates to run the same precision report with different attribute
values.

You can convert an existing report into a precision report or you can create a new precision
report.
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The following image shows an example of a precision report. Precision reports are built in the
Precision Report canvas. You can output them in PDF, DHTML, and PostScript formats.

For more information on creating a precision report using the Precision Report canvas, see 
Creating Precision Reports on page 258.

Procedure: How to Create a Precision Report Using the Precision Report Canvas

The following example shows how to create a precision report showing Revenue by Vendor and
Product Category.

1. On the Home tab, in the Content group, click Report or in the Environments Tree panel,
right-click the desired folder, point to New, and click Report.

The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For this
example, click wf_retail.mas.

The Report canvas opens.

4. On the Report tab, in the Report group, click Precision Report.

A styling warning message appears indicating that the report will be converted to a
precision report. Click Yes to close the message and open the Precision Report canvas.
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5. Create a report in the Data Matrix layer:

a. In the Layers tab, under the Data Matrix layer, click REGION. The region object is
displayed as a highlighted square in the Precision Reports canvas.

b. Click the Fields tab. In the Dimensions folder, expand the Product cube. Expand the
Product hierarchy and click Product,Category. Drag it into the region object.

c. In the Dimensions folder, Product cube, expand the Vendor hierarchy and click
Vendor,Business,Region. Drag it into the region object.

d. In the Measures folder, expand the Sales hierarchy and click Revenue. Drag it into the
region object.

e. Drag the region placeholder to resize the region.

6. Add a Where clause filter in the report to show only non-zero revenue amounts:

a. On the Report tab, in the Filter group, click Filter. The Filter drop-down menu opens.

b. From the drop-down menu, click Where. The Expression Builder opens.

c. In the Measures folder, expand the Sales hierarchy and double-click Revenue. It now
displays in the Column to filter field.

d. In the Logical Relation drop-down list, click is greater than.

e. In the Compare Type drop-down list, click Value.

f. In the Compare Value field, type 0. The filter criteria appears as follows.

g. Click OK to save the filter and close the Expression Builder. The report will now
suppress all rows with zero revenue.

7. Add a Report Heading layer to the report with text and an embedded field:

a. Select the Report Heading layer from the Layers tab.

b. On the Tools tab, in the Objects group, click Add Text. The pointer becomes an arrow

over a letter T .

c. Click the canvas to add a text box. You can also drag the pointer on the canvas to
create a text box in the size that you want.

Note: Use the options in the Default Style group of the Tools tab to select the desired
font, size, and style of the text.

d. Type Revenue by and place the pointer after by.

e. In the Fields tab, in the Dimensions folder, Product cube, expand the Vendor hierarchy
and double-click Vendor,Business,Region. The field is added to the text object as
<Vendor,Business,Region.
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8. Add a Page Header layer to the report:

a. Click the Page Header layer from the Layers tab.

b. On the Tools tab, in the Objects group, click Add Line. The pointer changes to an arrow

over a line segment .

c. Drag the pointer on the canvas to create a line below the text added in step 7.

9. Click Save.

The Precision Report canvas will appear similar to the following image.

Procedure: How to Create a Precision Report Using the WebFOCUS Language

You can create the precision report using the following WebFOCUS syntax, which you can type
into a procedure using the Text Editor.
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TABLE FILE WF_RETAIL
SUM REVENUE_US
BY BUSINESS_REGION 
BY PRODUCT_CATEGORY
WHERE REVENUE_US GT 0;
ON TABLE SUBHEAD 
"Revenue by <12 <BUSINESS_REGION "
ON TABLE SET NEWLAYOUT ON
ON TABLE PCHOLD FORMAT PDF
ON TABLE SET STYLE *
     INCLUDE = endeflt,
$
TYPE=TABHEADING,
     LINE=1,
     POSITION=(1.1 1),
     WRAP=ON,
     DIMENSION=(6 1),
     NAME=TEXT, FONT='ARIAL', COLOR='RED', 
$
TYPE=TABHEADING, OBJECT=TEXT, SIZE=15, STYLE=NORMAL ,$
TYPE=TABHEADING, OBJECT=FIELD, SIZE=15, STYLE=ITALIC ,$
$
TYPE=HEADING,
     OBJECT=Line,
     POSITION=(1.055556 1.402778),
     ENDPOINT=(4.3 1.4),
     NAME=LINE,
     BORDER-TOP=1.00,
$
TYPE=DATAMATRIX,
     NAME=Data Matrix,
     POSITION=(1.1 1.5),
     DIMENSION=(5 3),$
ENDSTYLE
END

Creating a Tabular Report Using an SQL Request

You can retrieve information using the SQL reporting language, and can directly incorporate
WebFOCUS formatting commands into the procedure. The following request uses the SQL
SELECT statement to create a simple tabular report.

SQL
SELECT BRANDTYPE, PRODUCT_CATEGORY, SUM(COGS_US), SUM(REVENUE_US)
FROM WF_RETAIL
GROUP BY BRANDTYPE, PRODUCT_CATEGORY;
END
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The output is:

Generating an SQL Script as a Subquery to Another Request

The following request uses the ON TABLE HOLD FORMAT SQL_SCRIPT command to
automatically generate a file containing an SQL SELECT statement that can be used as a
subquery in another request. The request includes a WHERE phrase to exclude the
Accessories product category.

TABLE FILE WF_RETAIL
SUM MSRP_US
BY PRODUCT_CATEGORY
WHERE PRODUCT_CATEGORY NE 'Accessories'
ON TABLE HOLD AS app1/sql1 FORMAT SQL_SCRIPT
END 

The following is the Master File that is generated by the ON TABLE HOLD FORMAT SQL_SCRIPT
command:
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FILENAME=SQL1, SUFFIX=SQLMSS  , $
  SEGMENT=SQL1, SEGTYPE=S0, $
    FIELDNAME=PRODUCT_CATEGORY, ALIAS=E01, USAGE=A40V, ACTUAL=A40V,
      MISSING=ON,
      TITLE='Product,Category', $
    FIELDNAME=MSRP_US, ALIAS=E02, USAGE=D20.2, ACTUAL=D8,
      MISSING=ON,
      TITLE='MSRP', $

The following is the Access File that is generated by the ON TABLE HOLD FORMAT SQL_SCRIPT
command:

SEGNAME=SQL1, 
   CONNECTION=wfretail, 
   DATASET=APP1/SQL1.SQL, 
   KEY=PRODUCT_CATEGORY, 
   SUBQUERY=Y, $

The following is the SQL SELECT statement that is generated by the ON TABLE HOLD FORMAT
SQL_SCRIPT command and that you can use as a subquery:

SELECT T18."PRODUCT_CATEGORY" AS "E01", SUM(T1."REVENUE_US") AS "E02",
SUM(T1."COGS_US") AS "E03 FROM (wrd_wf_retail_sales T1 LEFT OUTER JOIN
  wrd_wf_retail_product T18 ON T18."ID_PRODUCT" = T1."ID_PRODUCT")
GROUP BY T18."PRODUCT_CATEGORY"

The following is a TABLE request that uses the sql1 file:

TABLE FILE wf_retail
SUM REVENUE_US
BY PRODUCT_CATEGORY WHERE DB_INFILE(sql1, PRODUCT_CATEGORY, 
PRODUCT_CATEGORY) 
END

The following is the generated SQL request in which the sql1 file is used as a subquery:
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SELECT
  T18."PRODUCT_CATEGORY",
   SUM(T1."REVENUE_US")
   FROM 
  wrd_wf_retail_sales T1,
  wrd_wf_retail_product T18
   WHERE
  (T18."ID_PRODUCT" = T1."ID_PRODUCT") AND 
  (T18."PRODUCT_CATEGORY" IN (SELECT "E01" 
   FROM 
  (SELECT T18."PRODUCT_CATEGORY" AS "E01",
   SUM(T1."MSRP_US") AS "E02
   FROM
  wrd_wf_retail_sales T1,
  wrd_wf_retail_product T18
   WHERE 
  (T18."ID_PRODUCT" = T1."ID_PRODUCT") AND 
  (T18."PRODUCT_CATEGORY" <> 'Accessories')
   GROUP BY 
  T18."PRODUCT_CATEGORY") S1))
   GROUP BY
  T18."PRODUCT_CATEGORY
   ORDER BY
  T18."PRODUCT_CATEGORY";

The output is shown in the following image. Note that the Accessories product category is
omitted from the report because of the subquery.

Creating Precision Reports

The Precision Report feature gives you an additional set of tools that make it easy to control
the precise placement of objects and data in the report output. For example, with a precision
report, you can quickly create a layout that is perfectly aligned for a preprinted form (such as a
Bill of Sale or a tax form) and that automatically breaks out one record per report page.
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You can access the Precision Report canvas by converting an existing report or by creating a
new precision report. 

Note: All of the tabs and panels that you use to develop regular reports are also used in
precision reports. The additional tools found in the Precision Report canvas are available only
for precision reports.

Procedure: How to Access the Precision Report Canvas By Converting an Existing Report

1. Open the procedure (.fex file) for a selected report. To do this, you may use one of the
following methods:

On the Home tab, in the Content group, click Report. The Report Wizard opens.

In the Environments Tree panel, navigate to the desired folder and double-click the
report.

2. If the selected procedure was created with the Report canvas, it will automatically open in
the Report canvas.

If the selected procedure was not created with the Report canvas, it will automatically
open in the Procedure Viewer. In this case, double-click a report component to open it in
the Report canvas.

3. On the Report tab, in the Report group, click Precision Report.

A style warning message appears, indicating that the report will be converted to a
precision report.

4. Click Yes to convert the report and open it in the Precision Report canvas. The next time
the report is opened, the Precision Report canvas will automatically be active.

Similar to the Object Inspector in the Report canvas, the Precision Report canvas includes
a window containing tabs used for creating and building Precision Reports. This window
has the Fields, Sort Groups, Properties, and Columns tabs found in the Object Inspector,
but also includes the Layers tab and Navigate tab, which are unique to the Precision
Report canvas.

By default, the report output is PDF. To change the output format, on the Format tab, in the
Output Types group, click Output Format. In the drop-down menu that appears, point to Styled
report formats, and click the desired output.

You may edit the report by changing the alignment and position of the objects in the report.
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Reference: Usage Notes for Converting Existing Reports to Precision Reports

The following conditions apply when converting existing reports to precision reports: 

If you are converting a report component that was created using the Document canvas and
the output format is not supported by the precision reports feature, the following message
displays:

Your report is using a locked format that is not supported by Precision 
Reports.

In this case, you may want to create a new precision report to replicate the original, using a
supported output format.

The existing report heading and report footing will not convert to the precision report. You
can create them in the Precision Report canvas.

The subheading and subfooting will convert to the precision report, including the alignment
grid options set in the Report canvas. You can edit them in the Data Matrix layer of the
Precision Report canvas.

Reports with images, parameters, and drill downs will convert to the precision report, but
you cannot edit them in the Precision Report canvas.

Procedure: How to Access the Precision Report Canvas for a New Report

1. To access the Precision Report canvas for a new report, do one of the following:

On the Home tab, in the Content group, click Report.

In the Environments Tree panel, right-click the desired folder, point to New, and click
Report.

The Report Wizard opens.

2. Navigate to the desired folder, choose a data source, and click Finish. For more
information on the Report Wizard, see How to Create a Report Using the Report Wizard on
page 232.

The Report canvas opens.

3. On the Report tab, in the Report group, click Precision Report.

A style warning message appears, indicating that the report will be converted to a
precision report. Click Yes to close the message and open the Precision Report canvas.
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Accessing Precision Report Components With the Precision Report Canvas Tools Tab

The Precision Report canvas Tools tab contains commands that provide quick access to
commonly performed functions. This tab is only available when creating Precision Reports. The
availability of the commands is context-sensitive to the object that is highlighted in the canvas.

The Tools tab contains the Objects and Default Style groups, as shown in the following image.

Selecting and Adding Objects in a Precision Report Using the Objects Group

The Objects group contains commands to select and add objects to precision reports, as
shown in the following image.

The commands are:

Select Object

Allows you to select (single-click) or edit (double-click) an object.

Tip: Click Select Object after inserting a box, line, image, or text to return to select mode.

Add Box

Allows you to add a box to the Precision Report canvas. When this command is active, the

pointer becomes an arrow with a box . Click the canvas to add a box. You can also
drag the pointer on the canvas to create a box in the size that you want.

When you add a box, the Default Style group on the Tools tab becomes active with options
to set the pen size, line style, fill color, and line color.
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Add Line

Allows you to add a line to the Precision Report canvas. When this command is active, the

pointer becomes an arrow over a line segment . Drag the pointer on the canvas to
create a line and adjust it to the size that you want.

When you add a line, the Default Style group on the Tools tab becomes active with options
to set the pen size, line style, fill color, and line color.

Add Image

Allows you to add an image to the Precision Report canvas. When this command is active,

the pointer becomes an arrow over a flower . Click the canvas or drag the pointer on
the canvas to create a box in the size that you want.

The Open File dialog box opens. Select the desired image and click OK.

Add Text

Allows you to add text to the Precision Report canvas. When this command is active, the

pointer becomes an arrow over a letter T . Click the canvas to add a text box. You can
also drag the pointer on the canvas to create a text box in the size that you want.

When you add text, the Default Style group on the Tools tab becomes active with options
to set the font, size, color, and formatting.

Customizing Objects in a Precision Report Using the Default Style Group

The Default Style group contains commands and options to customize the box, line, and text
objects added to a precision report. The Default Style group is shown in the following image.

Pen Size

Sets the default pen size for box and line objects.

Line Style

Sets the default line style for box and line objects. The options are Solid, Dotted, and
Dashed.
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Color

Sets the default color for box, line, and text box objects.

Fill Color

Sets the default fill color for box and text box objects.

Font Name

Sets the default font type for text boxes. This option is only available for a text box.

Font Size

Sets the default font size for text boxes. This option is only available for a text box.

Bold

Sets bold font formatting as the default for text boxes. This option is only available for a
text box.

Italic

Sets italic font formatting as the default for text boxes. This option is only available for a
text box.

Underline

Sets underline font formatting as the default for text boxes. This option is only available for
a text box.

Defaults

Resets the style settings of the selected object to the default, original style.

Positioning Objects in a Precision Report With the Precision Report Canvas Positioning Tab

The alignment commands on the Positioning tab enable you to select multiple objects in the
same layer and easily position them relative to one another. 

The availability of the commands is context-sensitive to the objects that are selected in the
canvas. You cannot select multiple objects in different layers.

The Positioning tab contains the Positioning, Distribution, Options and Composition groups, as
shown in the following image.
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Aligning Objects in a Precision Report Using the Positioning Group

The Positioning group contains commands to align the objects on the Precision Report canvas,
as shown in the following image.

Align Left

Aligns the selected object to the left of the last object selected.

Align Right

Aligns the selected object to the right of the last object selected.

Align Top

Aligns the selected object to the top edge of the last object selected.

Align Bottom

Aligns the selected object to the bottom edge of the last object selected.

Make Same Width

Makes two or more objects the same width.

Make Same Height

Makes two or more objects the same height.

Make Same Size

Makes two or more objects the same size.
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Controlling Spacing Between Objects in a Precision Report Using the Distribution
Group

The Distribution group contains commands to control the spacing on the Precision Report
canvas, as shown in the following image.

Space Evenly Across

Sets the horizontal spacing between three or more selected objects to be the same.

Tip: To select multiple objects, use the Shift key.

Space Evenly Down

Sets the vertical spacing between three or more selected objects to be the same.

Setting Grid and Ruler Options for a Precision Report Using the Options Group

The Options group contains commands to set grid visibility and ruler options on the Precision
Report canvas, as shown in the following image.

Grid Options

Sets grid visibility and snap option.

Guide Options

Sets guide visibility and snap option.

Note: These options are applicable when the page ruler is on.
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Adding or Removing Compositions in a Precision Report Using the Composition Group

The Composition group contains commands to name, add, or remove compositions on the
Precision Report canvas, as shown in the following image.

Composition Name

Displays a drop-down list of available compositions. You can rename composition names.

Add Composition 

Adds a composition. The name of the composition is derived by the system (COMP00).

Remove Composition 

Deletes a composition.

Working With Precision Report Tabs

The Precision Report canvas is characterized by a window containing multiple tabs. Each tab
contains tools that enable you to design and create positioned elements for your precision
report. The default tabs are:

Layers. Consists of the Page, Report Heading, Page Header, Data Matrix, Page Footer, and
Report Footing layers. For details, see Precision Report Canvas Layers Tab on page 267.

Sort Groups. Displays the sorting method being applied to each column in the Data Matrix
layer. For details, see Precision Report Canvas Sort Groups Tab on page 268.

Columns. View and modify the columns in the Data Matrix layer. For details, see Precision
Report Canvas Columns Tab on page 269.

Fields. View the fields used in the Data Matrix layer. For details, see Precision Report
Canvas Fields Tab on page 270.

Properties. Displays attributes and their editable values, grouped by category. For details,
see Precision Report Canvas Properties Tab on page 271.

Navigate. View the entire layout of the Precision Report. For details, see Precision Report
Canvas Navigate Tab on page 271.
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These tabs are described in the following sections.

Reference: Precision Report Canvas Layers Tab

By default, the Layers tab consists of the Page, Report Heading, Page Header, Data Matrix,
Page Footer, and Report Footing layers, as shown in the following image. You can add
additional layers as needed.

The Data Matrix layer inserts a placeholder for the reporting data. You can snap objects
(boxes, lines, images, text) to the layout.

The following commands are available on the Layers tab:

Command Definition

Shows or hides the selected layer in the Precision Report canvas.

Enables or disables styling changes.

Enables or disables data changes.
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Command Definition

Enables or disables all changes.

Creates a new layer for the precision report.

Deletes the selected object or layer. If a layer is deleted, all objects within
it are deleted as well.

Moves the selected object up or down in the selected layer.

Reference: Precision Report Canvas Sort Groups Tab

You can view and modify the sorting properties of fields in the Data Matrix from the Sort
Groups tab in the Precision Report canvas, as shown in the following image. 

The Sort Groups tab displays the sorting method being applied to each column in the Data
Matrix layer. You can change the sorting method (for example, from By to Across or from Detail
to Sum) by using the right-click context tab. The changes are reflected in the Columns and Sort
Groups tabs and in the Data Matrix layer.

You can also use the Sort Groups tab to create multi-verb requests.
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Reference: Sort Type Icons

The icons in the first column to the left of the field name display the type of sort field. The
icons and their meanings are defined in the following table:

Icon Definition

Across field.

By field.

Sum field.

Detail field.

For field.

Reference: Precision Report Canvas Columns Tab

You can view and modify the columns in the Data Matrix layer from the Columns tab in the
Precision Report canvas, as shown in the following image. 

Right-click a column and select Options from the context tab to open the Field Properties dialog
box, where you can format and style the column, as well as apply drill down capabilities. Any
changes made to the column properties are reflected in the Data Matrix layer.
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Reference: Precision Report Canvas Fields Tab

You can view the fields used in the Data Matrix layer as a: 

Tree separated by segments (the Field Tree).

List of fields (the Field List).

Tree separated by Dimensions (the Dimension Tree).

To change the view, right-click in the Fields tab and choose the view from the shortcut menu.

You can double-click or drag segments or fields from this tab to the Precision Report canvas,
where they become report columns.

You can customize how you view the fields list and save your settings. Right-click in the Fields
tab and select one of the Save Settings options from the shortcut menu.

You can also search for fields in the fields list. Right-click in the Fields tab and select Find Item
from the shortcut menu.
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Reference: Precision Report Canvas Properties Tab

The Properties tab displays attributes and their editable values, grouped by category, as shown
in the following image. 

Reference: Precision Report Canvas Navigate Tab

You may view the entire layout of the Precision Report in the Navigate tab. 

The slider bar enables you to increase or decrease the zoom percentage of the layout.
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Drag the red box in the Navigate tab to view different elements of the precision report in
the layout, as shown in the following image.

Creating Precision Reports Using the Data Matrix Layer

Precision reports are created in the Precision Report canvas by using the Data Matrix layer as
the reporting object, and by inserting objects in the other layers as fields.

Procedure: How to Build a Report in the Data Matrix Layer

1. To access the Precision Report canvas for a new report, do one of the following:

On the Home tab, in the Content group, click Report.

In the Environments Tree panel, right-click the desired folder, point to New, and click
Report.

The Report Wizard opens.

2. Navigate to the desired folder, choose a data source, and click Finish. For more
information on the Report Wizard, see How to Create a Report Using the Report Wizard on
page 232.

The Report canvas opens.
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3. On the Report tab, in the Report group, click Precision Report.

A style warning message appears, indicating that the report will be converted to a
precision report. Click Yes to close the message and open the Precision Report canvas.

4. If it is not already highlighted, click REGION under the Data Matrix layer in the Layers tab.
The REGION object is displayed as a highlighted placeholder in the Precision Report
canvas.

5. Double-click the REGION object in the Precision Report canvas. A hand icon displays,
indicating that the region is in selection mode.

6. Click the Fields tab. Select a field for the report, and drag it into the region. Repeat this for
all of the desired fields. You may resize the region placeholder as needed.

7. Click Save.

Procedure: How to Design the Page Layout for Precision Reports

Once the precision report has been built in the Data Matrix layer, you may design the page
layout using the Page layer. Objects you add to the page layer appear on each page of the
report at run time. You may add a box, line, or image to the page layer.

You can begin this procedure by opening the report you saved from the previous procedure 
How to Build a Report in the Data Matrix Layer on page 272.

1. From the Layers tab, click the Page layer to toggle to edit mode.

2. On the Tools tab, in the Objects group, click Add Line.

The pointer changes to an arrow over a line segment .

3. Drag the pointer to create a line.

Change the line color and style on the Tools tab, in the Default Style group.

Tip: After the line object has been added to the page layer, you may use the Properties tab
to change the appearance of the line.

4. On the Tools tab, in the Objects group, click Add Image.

The pointer changes to an arrow over a flower .

5. Click the canvas or drag the pointer to create a box.

The Open File dialog appears.

6. Select the desired image file, such as a company logo, and click OK.

The image appears on the page. Resize it as needed.

Note: You can click Select Object to toggle off the Add Image.
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As objects are added to the page layout, they appear under the Page layers.

7. Click Save.

When you run the report, the items added to the page layer appear on every page of the report
output.

Procedure: How to Add Heading or Footing Layers in the Precision Report Layout

Once the precision report has been built in the Data Matrix layer, you may add Heading and
Footing objects as placeholders for fields on your form. 

You can begin this procedure by opening the report you saved from the previous procedure 
How to Design the Page Layout for Precision Reports on page 273.

1. From the Layers tab, click the Report Footing layer to toggle to edit mode to add an object
to the report footing. Similarly, you could select the Report Heading, Page Header, or Page
Footer layer.

2. On the Tools tab, in the Objects group, click Add Box.

The pointer changes to an arrow over a box .

3. Click the canvas or drag the pointer to create a box.

Note: Objects snap to the grid for perfect alignment.

Change the color and style of the box on the Tools tab, in the Default Style group.

Tip: After the box object has been added to the page layer, you may use the Properties tab
to change the appearance of the box.

As items are added, they appear under the Heading/Footing layers.

4. Click Save.

Optionally, you can use the Layers tab to move or delete layer objects.

Procedure: How to Add Embedded Fields in the Heading/Footing Text Objects

You may embed fields and variables in your Heading/Footing layers as text objects. The
precision report retrieves the value for the field when the report is run. 

Note: Values for embedded fields are calculated differently in Heading and Footings. Headings
use the first value on the page of the report, and Footings use the last value on the page of
the report.
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You can begin this procedure by opening the report you saved from the previous procedure 
How to Add Heading or Footing Layers in the Precision Report Layout on page 274.

1. From the Layers tab, click the Report Heading layer to toggle to edit mode to add a text
object to the report heading. Similarly, you could select the Page Header, Page Footer, or
Report Footing layer.

2. On the Tools tab, in the Objects group, click Add Text.

The pointer changes to as an arrow over a letter T .

3. Click the canvas or drag your pointer to create a box, indicating where you want the text to
appear in the canvas. Type the desired text. Place the cursor at the position in the text
where you want to embed the value.

4. Double-click a field from the Fields tab in the Precision Report canvas.

This includes Report Variables, Computed, and Defined fields.

The field is added to the text object as <FIELDNAME.

5. Optionally, you may also perform a calculation on a field value in the text object:

a. Highlight <FIELDNAME in the text object.

b. Right-click and choose Prefix Operators and the desired operator from the context tab.

Tip: The list of available operators adjusts to show those that are appropriate for the
type of field you select.

Procedure: How to Control Spacing Between Wrapped Lines

You can use the Wrap Gap option in a style sheet to control spacing between wrapped lines in
PDF and PostScript report output. The Wrap Gap option is available only for an active object of
type Data.

You can begin this procedure by opening the report you saved from the previous procedure 
How to Add Embedded Fields in the Heading/Footing Text Objects on page 274.

1. On the Report tab, in the Style group, click the Report Width button.

2. The Width Options dialog box opens.

3. From the drop-down menu, click Wrap.

4. Click the ON radio button to enable the Wrap Gap option.

Type the number of inches to leave between wrapped lines and click OK.

5. Click Save.
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Procedure: How to Run Different Compositions for the Precision Report

You may run the precision report with different composition templates. Composition templates
enable you to run the same precision report with different attribute values. 

This can be beneficial if you need to run a precision report with modifications for internal and
external use. For example, you have an internal report that shows your trademark image in the
Report Heading Layer. You can create a composition template that hides your trademark image
for an external customer.

You can begin this procedure by opening the report you saved from the previous procedure 
How to Control Spacing Between Wrapped Lines on page 275.

1. On the Positioning tab, in the Composition group, note that DEFAULT is displayed as the
Composition Name.

2. To create an additional composition template, click Add Composition. Note the new
composition name derived by the system is COMP00. You can rename the composition by
typing over the old one in the Composition Name field.

3. Select the Properties tab and expand the IMAGE section. For the Visible attribute, change
the value to No.

4. Click Save.

The composition template is added to the selection list. The template in this example
hides the image in the precision report. When the report is run under the DEFAULT
template, the image will appear. When it is run under the COMP00 template, the image
will not appear.

To delete a composition template, select it from the Composition Name drop-down list and
click the Remove Composition command.

Editing a Precision Report to Fit a Form

After you create a precision report, you may need to edit the formatting of it to fit perfectly on a
preprinted form. The Properties tab of the Precision Report canvas makes it easy to fine-tune
the output to match your form.

Example: Matching Output to a Preprinted Form

The following example shows how to edit a precision report to match a preprinted form. 

1. Open the desired precision report. On the Format tab, Output Types group, click Output
Format. Click DHTML, PDF, or PS (PostScript).

2. On the Format tab, Output Types group, click Output Format Options. The Output Format
Options dialog box appears.
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3. Select the option values that will best assist in matching your form and click OK.

Note: Matching output to your preprinted form is an iterative process that will progress
through trial and error.

Click Save.

4. Put your preprinted form in your printer and print a single page of output from the precision
report. View the results.

5. Open the precision report. If you need to adjust the alignment of data columns, Open the
Properties tab and expand the REGION area. The Position attribute shows four values.

The first number (192 in the example above) controls the left side of the region box.

The second number (132 in the example above) controls the top of the region box.

The third number (588 in the example above) controls the right side of the region box.

The fourth number (276 in the example above) controls the bottom of the region box.

You can edit the numbers to move the region with great accuracy in matching your form.

In addition to the REGION attribute, you can also fine tune the TEXT attribute as described
above.

6. Edit the precision report, save it, and print it on your form again until the alignment is
correct.

Joining Data

You can join two or more related data sources to create a larger integrated data structure from
which you can report in a single request. The joined structure is virtual. It is a way of accessing
multiple data sources as if they were a single data source. Up to 511 joins can be in effect at
one time, for a total of 512 segments, depending on the number of active segments and the
number and length of the fields (there is a 256K limit on the length of all fields). Joined files
remain physically separate, but are treated as one data source structure throughout the
session or until you clear the join. 

You can also create a new file structure for reporting by joining existing synonyms of relational
tables using the Cluster Joins editor.

What Is a Join?

A join is a temporary connection between two or more data sources, based on a shared field or
on a condition you specify in the JOIN command. For example, since the wf_retail_sales data
source includes an ID_STORE field and the wf_retail_store data source also includes an
ID_STORE field, you can join the two data sources.
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The field type must be the same for the common fields, but the field name and field format do
not need to be the same.

After you join two files, each time a record is retrieved from the first file (host data source), it
also retrieves the matching records from the second file (cross-referenced data source).

Creating Joins Using Join Functionality

The following section describes the types of joins you can create using the Join functionality.

Equijoin. Used to join two or more data sources that share at least one field and create a
virtual structure for reporting. For more information, see Creating an Equijoin on page 278
and How to Create an Equijoin on page 281.

Conditional join (WHERE-based). Uses expressions to specify joins based on conditional
criteria, not just on equality between fields. For more information, see Creating a Join Based
on Conditional Criteria on page 278 and How to Create a Conditional Join on page 284.

Join based on virtual fields (DEFINE-based). Uses virtual host fields that you can join to
real cross-referenced fields. For more information, see Creating a Join Based on Virtual
Fields on page 279 and How to Use a Virtual Field as the Join Field on page 283.

Left outer join. Returns all matching rows, in addition to all rows from the host data source
that lack corresponding cross-referenced rows. For more information, see Creating a Left
Outer Join on page 279.

Full outer join. Returns all rows from the host data source and all rows from the cross-
referenced data source. Full outer joins are supported for use with relational data sources
that support this type of join. For more information, see Creating a Full Outer Join on page
279.

Creating an Equijoin

You can use an equijoin structure if you need to join two or more data sources that have two
fields, one in each data source, with formats (character, numeric, or date) and values in
common.

Joining a store ID field in a sales data source (host data source) to the store ID field in a store
data source (cross-referenced data source) is an example of an equijoin.

Creating a Join Based on Conditional Criteria

Conditional joins use WHERE-based syntax to specify joins based on conditional criteria, not
just on equality between fields. Additionally, the host and cross-referenced join fields do not
have to contain matching formats. 
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Suppose you have a data source that lists stores by their ID number (the host data source)
and another data source that lists sales for each store ID by date (the cross-referenced data
source). Using a conditional join, you can join the store ID in the host data source to the store
ID in the cross-referenced data source to determine which stores had sales in a given date
range (the WHERE condition).

Creating a Join Based on Virtual Fields

Joins that are based on virtual fields use DEFINE-based syntax to create a virtual field in the
host data source that you can then join to a real cross-referenced field. The DEFINE expression
that creates the virtual host field may contain only fields in the host data source and
constants. It may not contain fields in the cross-referenced data source. 

You can join a virtual field to more than one real field in more than one cross-referenced data
source using separate Join commands, each referring to the same host data source.

Creating a Left Outer Join

When a report omits host rows that lack corresponding cross-referenced rows, the join is called
an inner join. When a report displays all matching rows, in addition to all rows from the host
data source that lack corresponding cross-referenced rows, the join is called a left outer join.

For details on left outer join syntax, see the Creating Reports With WebFOCUS Language
manual.

Creating a Full Outer Join

The WebFOCUS Join command and conditional join command have a Full Outer Join option.

A full outer join returns all rows from the host data source and all rows from the cross-
referenced data source. Where values do not exist for the rows in either data source, null
values are returned. WebFOCUS substitutes default values on the report output (blanks for
alphanumeric columns, the NODATA symbol for numeric columns).

The full outer join is only supported for use with those relational data sources that support this
type of join, in which case the WebFOCUS Join syntax is optimized (translated to the full outer
join SQL syntax supported by the RDBMS). Use of this syntax for any data source that does not
support a full outer join, or the failure of the request to be optimized to the engine, produces
an error message.

For details on full outer join syntax, see the Creating Reports With WebFOCUS Language
manual.
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Specifying a Single (Unique) and Multiple (Non-Unique) Instance Join

When you create a join using the Join functionality, you can specify whether the join is a single
instance or a multiple instance.

A single instance, or one-to-one join structure matches one value in the host data source to
one value in the cross-referenced data source.

Joining a store ID field in a sales data source (host data source) to the store ID field in a
store data source (cross-referenced data source) is an example of a one-to-one join
structure.

A multiple instance or one-to-many join structure matches one value in the host data source
to multiple values in the cross-referenced data source.

Suppose you have a data source that lists stores by their ID number (the host data source)
and another data source that lists products sold for each store ID (the cross-referenced
data source). Joining one instance of each store ID in the host data source to the multiple
store IDs in the cross-referenced data source is an example of a one-to-many join structure
and would result in a listing of all products sold for each store ID.

Manipulating Data Sources in a Join Using the Join Tab

You can use the Join tab to manipulate data sources when using a join. The Join tab is
available only when you are creating a join. 

After you join two files, each time a record is retrieved from the first file (host data source), the
matching records from the second file (cross-referenced data source) are also retrieved.

Joining Data Sources Using the Join Group

Using the Join group, you can create a new join, add a new data source to the join, clear a join,
insert a Define field into a join, create a conditional join, show or hide the procedure (fex)
window, perform an automatic join within tables, or blend data sources. The Join group is
shown in the following image. 
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Displaying Data Sources in the Join Using the Windows Group

You can choose how to display the data sources currently in the join as cascading overlapping
tiles (default), horizontal tiles that do not overlap, or vertical tiles that do not overlap. The
Windows group is shown in the following image.

Creating a Join Using the Join Canvas

You can use the Join canvas to join two or more data sources. The Join component provides a
graphical method for creating and manipulating all types of joins. To create a join, you must
specify a host data source, and then a cross-referenced data source. 

You are responsible for placing the Join object in the correct position within your procedure
(that is, before a Define, Report, or Chart), and running it. The join remains active for the entire
session, unless you explicitly clear it.

After a join exists, you can retrieve it, report from it, view its syntax, and clear it.

Procedure: How to Create an Equijoin

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Join after, point to New and click Join.

3. Select a Master File (host data source), for example, wf_retail_sales, and click OK.

The Join canvas opens and displays the fields in the Master File.

4. On the Join tab, in the Join group, click Add.

You can also right-click the Join canvas and select Add File.

5. Select a Master File (cross-referenced data source), for example, wf_retail_store, and click
OK.
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The new Master File is added to the canvas. Common fields in both files are joined by a
Join connector line, as shown in the following image.

6. Click Save.

7. Click Run.

A dialog box opens, displaying the component code, and either an error message or text
stating that no error exists.

8. Click OK and close the Join canvas.

You can add another component to the procedure by right-clicking the Join component,
pointing to New, and clicking the component. When you are prompted to select a Master
File, select the same host file you used to create the Join component. This allows you to
use the joined data sources.

The following it the WebFOCUS Join syntax that is created:

JOIN WF_RETAIL_SALES.WF_RETAIL_SALES.ID_STORE IN wf_retail_sales
TO WF_RETAIL_STORE.WF_RETAIL_STORE.ID_STORE IN wf_retail_store AS J0
END

Creating Multi-Field Joins

In some cases, you might want to join more than one host field to one or more cross-
referenced fields.

There are two types of multi-field joins:

Multi-field joins in which you join multiple host fields to multiple cross-referenced fields.

Concatenated joins in which the field resulting from the concatenation of two host fields is
joined to a single cross-referenced field.
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Creating a Virtual Field as the Join Field

You can create a virtual host field that you can join to a real cross-referenced field.

Procedure: How to Use a Virtual Field as the Join Field

1. Open an existing procedure or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Join after, point to New, and click Join.

3. Select a Master File (host data source) and click OK.

The Join canvas opens and displays the fields in the Master File.

4. On the Join tab, in the Join group, click Define.

The Join Define in File dialog box opens.

5. You must associate the virtual field with a segment of the data source.

a. Type the name of the virtual field you are going to define in the Define Field box.

b. In the With Field drop-down list box, choose the name of any real field from the
segment in which you want to put the virtual field and click OK.

The virtual field appears in the Fields window of the host data source.

6. On the Join tab, in the Join group, click Add.

You can also right-click the Join canvas and select Add File.

7. Select a Master File (cross-referenced data source) and click OK.

The new Master File is added to the canvas. Delete any existing Join connector lines.

8. To complete the Join, drag the mouse pointer from the virtual field to a matching field in
the cross-referenced data source.

You cannot join multiple fields with this option. The virtual field must be the only Join field.

Creating Conditional Joins

Using conditional joins, you can establish joins based on conditions other than equality
between fields. In addition, the host and cross-referenced join fields do not have to contain
matching formats and the cross-referenced field does not have to be indexed. 

Because each data source differs in its ability to handle complex conditional criteria, the
optimization of the WHERE syntax differs depending on the specific data sources involved in
the join and the complexity of the conditional criteria.
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To display a list of joined data sources, select the following query subject in the Query tool, or
issue the command from the Command Console:

? JOIN

This query displays every join currently in effect and indicates any that are based on
conditional criteria.

Procedure: How to Create a Conditional Join

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the join after, point to New, and click Join.

3. Select a Master File (host data source) and click OK.

The Join canvas opens and displays the fields in the Master File.

4. On the Join tab, in the Join group, click Add.

You can also right-click the Join canvas and select Add File.

If you are developing in the Data Servers area or in the domain, a WebFOCUS Table List
dialog box opens. If you are developing in the Projects area, the Open dialog box opens.

5. Select a Master File (cross-referenced data source) and click OK.

The new Master File is added to the canvas. Common fields in both files are joined by a
Join connector line.

6. Select the Join (the connector line), and on the Join tab, click Where/If.

The Where Expression Builder dialog box opens.

7. After you have specified your WHERE criteria, click OK to return to the Join tool.

If you need to change the join type or join name, double-click the conditional join to launch
the Join Properties window.

Customizing a Join

You can customize an existing join by changing the files or fields involved. If no default join
was created, you can use the same technique to specify a connection explicitly.

You can also change the join name, make the join a single instance, use a virtual field as the
join field, and add tag names to the join files.

Procedure: How to Remove a Data Source From the Join

1. Click the data source you want to remove.
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2. Press the Delete key. A confirmation dialog box appears.

If you delete the host data source, all cross-referenced data sources are automatically
deleted.

Procedure: How to Delete a Join

1. Right-click the Join connector line.

2. From the shortcut menu, click Delete.

You can also select the Join connector line, and on the Join tab, in the Join group, click
Clear, or press the Delete key.

The data sources remain on the canvas with no connector line between them.

Procedure: How to Specify Join Fields

To create your own join (after deleting the existing join, if necessary):

1. Select a field in the host data source panel.

2. Click and hold the selected field.

3. Drag the selected field from the host data source panel onto the matching field located in
the cross-referenced data source panel. The pointer changes and displays the appropriate
icon when a join is possible.

4. Release the mouse button.

A Join connector line appears.

Procedure: How to Create Additional Joins

You can leave the Join window open and create another Join by:

Clicking New on the ribbon.

Clicking New Join from the shortcut menu on the Join canvas.

You can define up to 511 concurrent Joins that will have a maximum of 512 segments in the
new Join structure.

Procedure: How to Make a Join a Single Instance

By default, each join is a multiple instance.
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To make the join a single instance:

1. Right-click the Join connector line.

2. From the shortcut menu, click Single Instance.

Changing the Join Name

A default name is automatically assigned to each join.

You can use the Join name to later clear the join and to prevent another join from overwriting
it. If you remove the Join name completely, any subsequent unnamed join will overwrite this
join.

Procedure: How to Change or Remove the Default Join Name

1. Right-click the Join connector line and from the shortcut menu, click Join Name.

The Join Name dialog box displays the default Join name.

2. Edit or delete the name in the Join Name box and click OK.

You can also provide a description. This is not used in the Join command, but for
reference purposes. A comment (-*) is added to the procedure. For example, -*JOINDESC
J0.

Note: The following reserved words cannot be used as a Join name: ALL, AND, AS, IN,
JOIN, TAG, TO, WITH.

Procedure: How to Display Current Join Structures

To display a list of joined data sources, issue the following command from the Command
Console:

? JOIN

This command displays every join currently in effect.

Adding a Tag Name

Tag names provide a way of distinguishing between identical field names in the host and cross-
referenced data sources. They function as aliases for the file names in the join. Tag names are
useful when you join a file to itself because in such a join all field names, segment names,
and file names are the same in the host and cross-referenced data sources. Tag names are
also useful if a file is used as a target more than once in the join structure.

A procedure can use the tag name of a data source as a qualifier for field names and aliases.
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If you create a report using a recursive join without tag names, the field names in the cross-
referenced data source are prefixed with the first four characters of the Join name.

Procedure: How to Add a Tag Name

1. Double-click the connector line between the tables. The Join Properties dialog box opens. 

The Join Properties dialog box also opens if you right-click a selected link, and click
Properties on the shortcut menu. A thick line appears when a join is selected.

2. Enter names in the Host Tag and Cross Tag name fields and click OK.

Note:

The following reserved words cannot be used as a tag name: ALL, AND, AS, IN, JOIN,
TAG, TO, WITH.

Tag names can be up to eight characters in length.
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Reference: Join Properties Dialog Box

To view or modify the properties of a Join, right-click the Join link and select Properties, or
double-click the Join link. The Join Properties window appears, as shown in the following
image.

The Join Properties window has the following fields and options:

Host Tag

Enter a tag name for the data source.

Cross Tag

Enter a tag name for the cross-referenced file.
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Selected Fields

Displays the field that has been joined from the host file to the cross-referenced file. A
single arrow indicates a unique Join, and a double-arrow indicates a non-unique Join.

Join Name

Displays the name of the Join. To change the default Join name, type a new name in this
field and click OK.

Note: The Join name must be unique and cannot exceed eight characters.

Description

Enter a description. This is not used in the Join command. It is used for reference
purposes. A comment (-*) is added to the procedure.

Join Type

Indicates the type of Join. Choose from the following:

Multiple Instance (Non-Unique). A one-to-many Join structure that matches one value in
the host data source to multiple values in the cross-referenced field. Joining employee ID
in an employee data source to employee ID in a data source that lists all the training
classes offered by that company would result in a listing of all courses taken by each
employee, or a joining of the one instance of each ID in the host file to the multiple
instances of that ID in the cross-referenced file. This is the default selection.

Single Instance (Unique). A one-to-one Join structure that matches one value in the host
data source to one value in the cross-referenced data source. Joining an employee ID in an
employee data source to an employee ID in a salary data source is an example of a unique
Join.

Unspecified. This option is selected in the Join properties when a Join that was created in
an earlier release is opened in the Join tool. In earlier versions, the defaults for Join type
and other operators were assumed and not specified in the generated code. Since the Join
tool cannot determine the type of Join that was created and if there were other commands
set to control the Join, select the appropriate options (Inner Join, Left Outer Join, Multiple
Instances, Single Instances) from the Join tool to upgrade the generated code.

Inner Join. A Join that results when a report omits host rows that lack corresponding cross-
referenced rows.
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Left Outer Join. Extends the results of an Inner Join and retrieves records from both host
and cross-referenced tables, including all records from the left table (host) and any records
from the right table (cross-referenced) where the condition values match. If there are no
matching values in the cross-referenced table, the Join still retrieves records from the host
table.

Detecting and Handling of Fan Traps and Chasm Traps

WebFOCUS supports complex joins between a large number of data sources. Sometimes
requests against a complex join (or star schema) can cause individual columns to be
aggregated multiple time, generating inflated results. These constructions are referred to as
fan traps or chasm traps.

The relational adapters have a new context analysis process that detects the multiplicative
effect and generates SQL script commands that retrieve the correct values for each segment
context. These scripts are then passed to the RDBMS as subqueries in an optimized SQL
statement.

Blending Data

Blending data is the process of gathering data from various sources and combining the useful
data in to a customized, functioning data set. For example, you may have some of the basic
fields available in the current data source. You can use the Blend option to add relevant data
fields from a different data source to the current data source in order to create a unique data
set.

The Blend functionality allows you to explicitly select the data fields that you want to include.
More specifically, you can join multi-fact data structures and combine pertinent external data
into your current data source, creating a blended data resource. This can be from local or other
system resources.

You may want to blend data if you are reporting from two different fact tables that share a
common dimension, such as a product dimension. The Blend option allows a new external fact
table, for example an uploaded Excel worksheet, to be added to a multi-segment master as a
parent of an existing child segment.

For an example of this, you can view the sample retail database, wf_retail. The wf_retail
Master File contains a fact table, wf_retail_sales, and a dimension table,
wf_retail_store_sales. The wf_retail_sales segment is defined as the parent of the
wf_retail_store_sales segment. You may want to add a second fact table to the report. The
second fact table in this example can be an Excel spreadsheet that you upload to App Studio
for use with a report or chart. The data in the spreadsheet file that you upload will be joined to
the wf_retail database using a common dimension field.

Blending Data

290  Information Builders



The following are some general rules that apply to the Blend option:

The result of blending is that a single dimension is shared between two fact tables. The
table must be based on a cluster with at least two segments. One segment is for Fact table
1, the second segment is for the dimension.

Do not use the fields from the blended table as a sort field, since these fields will not have
a common field when used with fields from other fact tables.

Procedure: How to Blend Data Using the Join Tab

This procedure describes how to blend data from two existing data sources. It uses the
wf_retail Master File and the product_category_sales spreadsheet.

1. Create a new procedure or open an existing procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Join after, point to New, and click Join.

3. Select the wf_retail data source from the Select a Data Source dialog box and click OK.

The Join canvas opens and displays the fields in the Master File.

4. Select the Join tab on the ribbon and in the Join group, click Add.

You can also right-click in the Join canvas and select Add File to add the second part of
the join.

5. Select the product_category_sales spreadsheet from the Select a Data Source dialog box
and click OK.
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The new file is added to the canvas. Common fields in both files are linked by a Join
connector line, as shown in the following image.

6. To blend the data in the join, select the linked field in each file list, and click the Join
connector line.

7. In the Join tab on the ribbon, click the Blend option.

8. Select Inner (default) or Full Outer as the Blend type.

9. Click Run.

A dialog box opens, displaying the component code, and either an error message or text
stating that no error exists.

Example: Blending Data Using WebFOCUS Syntax

You can blend data using the following JOIN AS_ROOT command, which you can type into a
procedure using the Text Editor. In this example, the Projected Excel worksheet is added as a
parent of the wf_retail Product dimension. The report output contains field values from the
wf_retail_sales fact table and the Projected Excel worksheet for each product category.

JOIN AS_ROOT PRODUCT_CATEGORY IN WF_RETAIL TO UNIQUE PRODUCT_CATEGORY IN 
PROJECTED
END
TABLE FILE wf_retail
SUM REVENUE_US
PROJECTED_COG
PROJECTED_SALE_UNITS
BY PRODUCT_CATEGORY
END
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Note: The AS_ROOT command is only supported with JOIN syntax as shown above and is not
supported for conditional JOIN syntax.

The output of the above syntax is shown below:

Styling Reports

A report consists of several components, each of which can you can format or style. App
Studio is installed with a set of StyleSheet files, each of which has a distinctive theme. You
can select one of these themes for your output and you can customize selected report
components individually. You can create your own styles or use the themes included with App
Studio.

Using a styling theme is an excellent way to easily style many different aspects of a report, for
example, headings, footings, column titles, backgrounds, fonts, grids, borders, images, and so
on. Many companies apply standard style themes to their reports so all of their reports look
consistent and professional.

A style theme, once it is applied to a report, is used every time the report is run. If you want to
display some of the data differently, you can customize individual styles either for all data or
for data that satisfies specific criteria (called conditional styling).

Styling Characteristics

The physical characteristics of a style for a report component consist of the following basic
attributes:

Text font. You can use different fonts and font sizes, and selectively apply text styles, such
as bold or italic.
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Color. You can select a color for the text or background.

Conditional styling. You can apply different styles to the same component based on report
values.

Column widths. You can have column widths based on the column content, the field format
specified in the Master File, or specify a width.

Column placement. You can specify the starting position of individual columns and arrange
columns in any order regardless of the sequence established in the report request. In
addition, you can indicate how much space to leave before and after individual columns.

Page size. You can select from a wide range of page sizes for PostScript and PDF reports.

Page orientation. You can select either portrait or landscape for PostScript, PDF, and
EXL2K reports.

Page margins. You can specify the top, bottom, left, and right margins, measured in
inches, centimeters, or points for PostScript and PDF reports.

Justification. You can justify individual report components.

Grids, borders, and images. You can emphasize headings, footings, and column titles in a
report by adding borders and grid lines around them. You can add and position images in a
report. An imaged, such as a logo gives corporate identity to a report, or provides visual
appeal.

Introducing StyleSheets

A StyleSheet describes how you want your report to look. You can create a StyleSheet within a
report request (useful when you are applying a set of styles to only one report) or as a
separate file (useful when you want to create a StyleSheet theme that you can apply to any
report). In addition, you can create a StyleSheet on one platform and then port it to, and run it
on, other platforms.

You use the Style group, on the Report tab, to apply stylistic changes to a report, including
data, title, and all other components of the report. The commands are:

Change Theme. Changes the theme of the report from a list of available StyleSheets.

Manage Theme. References or embeds an external StyleSheet or applies no styling to your
report. When you click this button, the StyleSheet Selection dialog box opens. If you do not
select a StyleSheet, a default StyleSheet is applied.

Save Theme. Saves your current style options as a stylesheet file (.sty) for future use.
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A StyleSheet consists of set of declarations, which:

Identify a report component or subcomponent.

Describe the formatting to apply to that component.

Optionally, if the component is a heading, footing, or column, specify a position and
justification for the component.

Optionally, specify the distance between columns, column sequence, and column width.

Optionally, specify a condition that must be true in order to apply the style. This technique
is called conditional styling.

In your StyleSheet, you only need to include declarations for those components whose format
you want to change. Within each declaration, you only need to include those attributes you
want to change.

Each declaration in a StyleSheet consists of attribute=value pairs separated by commas, and
terminated with a comma and dollar sign (,$). The syntax is:

TYPE=component, attribute=value, ... ,$

For example:

TYPE=Report, FONT=Times, SIZE=10, $
TYPE=Data, COLUMN=REVENUE_US, BACKCOLOR=Aqua, COLOR=Navy, STYLE=Bold, 
 WHEN=REVENUE_US GT 500, $
TYPE=Title, FONT='Helvetica', $
TYPE=Heading, FONT='Helvetica', STYLE=Bold, SIZE=14, JUSTIFY=Center,
 BACKCOLOR=Dark Turquoise, COLOR=White, $
TYPE=Heading, LINE=6, BACKCOLOR=White, COLOR=Dark  Turquoise,$

Procedure: How to Select a Styling Theme

The following procedure shows you how to change the default style to a predefined theme.

1. On the Home tab, in the Content group, click Report.

The Report Wizard opens.

2. Click Create Report.

The Selecting Data Source window opens.

3. Select the wf_retail.mas data source and click Finish.

The Report canvas opens.
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4. Select the Full Name, Product Name, and Revenue fields and click Run on the Quick
Access toolbar to view the report with no conditional styling.

5. On the Report tab, in the Style group, click Change Theme.

6. In the Open File dialog box, click the Legacy Style Templates folder, as shown in the
following image.
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Note: As of Release 8.2.01M, the following folders were added to the Open File dialog box
used by the Change Theme option.

Legacy Style Templates folder, which contains the legacy style files. Prior to Release
8.2.01M, this folder was named Predefined Template Files.

Reporting Server Style Templates folder, which contains style files from the Reporting
Server. Prior to Release 8.2.01M, this folder was named Reporting Server Stylesheet
Files.

Style Templates folder, which contains the new Warm, Flat, and Dark style files.

7. From the list of style files in the right pane, locate and select a template file, for example,
ENBlue_Light1.sty. The report styling in the canvas automatically changes, as shown in the
following image.

Procedure: How to Apply a Style Theme Using WebFOCUS Syntax

The following request applies the enblue_light1 theme to the report output. The ON TABLE SET
STYLE * and ENDSTYLE commands indicate the beginning and the end of an inline StyleSheet.

TABLE FILE WF_RETAIL
SUM REVENUE_US
BY FULLNAME
BY PRODUCT_NAME
ON TABLE SET HTMLCSS ON 
ON TABLE SET STYLE * 
INCLUDE = enblue_light1, 
$
ENDSTYLE
END
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Procedure: How to Create a StyleSheet in a Report Request

You can use the following commands in a report request to create a StyleSheet to indicate the
beginning and the end of an inline StyleSheet:

ON TABLE SET STYLE *
.
.
.
ENDSTYLE

For example, in the following report request, the StyleSheet syntax appears in bold.

TABLE FILE WF_RETAIL
SUM REVENUE_US BY FULLNAME BY PRODUCT_NAME 
ON TABLE SET STYLE *
TYPE=REPORT, FONT=ARIAL, SIZE=10, $
TYPE=REPORT, COLUMN=REVENUE_US, COLOR=RED, $
TYPE=REPORT, COLUMN=FULLNAME, COLOR=BLUE, $
TYPE=REPORT, COLUMN=PRODUCT_NAME, COLOR=GREEN, $
ENDSTYLE 
END 

The request produces the following report, in which the font for the entire report is Arial 10, the
Full Name column is blue, the Product Name column is green, and the Revenue column is red.

Conditionally Styling Components in a StyleSheet

You can conditionally format report components or display a graphic in your report based on
the values in your report. Using conditional styling, you can:

Draw attention to particular items in the report.

Emphasize differences between significant values.
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Customize the resources to which an end user navigates from different parts of the report.

Procedure: How to Apply Conditional Styling with the Traffic Lights Feature

This procedure shows how you can use the Traffic Lights feature to apply styling in your report
based on conditions that you define. You can apply the styling either to an entire row, or to
column data only. This example will use a red background to highlight revenue column data
amounts that are less than 500.

1. On the Home tab, in the Content group, click Report.

The Report Wizard opens.

2. Click Create Report.

The Report Wizard - Select Procedure Location window opens.

3. Select a location for your report and click Next.

The Report Wizard - Select a master file window opens.

4. Select the wf_retail.mas data source and click Finish.

The Report canvas opens.

5. Select the Customer Full Name, Product Name, and Revenue fields and click Run on the
Quick Access toolbar to view the report with no conditional styling.

6. Return to the Report canvas to create a condition for the Revenue field, for which you will
later specify styling. Click the Revenue field to highlight it.

7. On the Appearance tab, in the Traffic Lights group, click the drop-down list box and select
Add/Edit Conditions.

Note: The Traffic Lights group in the Appearance tab is used to highlight column data only.
To highlight an entire row, use the Traffic Lights group in the Reports tab instead.

The Condition List dialog box opens.

8. Click New.

The Edit Condition dialog box opens. In the Condition field, a default name COND0001 is
specified for your new condition, which you can change as required.

9. Complete the Edit Condition dialog box as shown in the following image.

Select Revenue for the field.

Select is less than for the Relation.

Select Value for the Compare Type.
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Type 500 for the Value.

 

 

10. Click OK to save your new condition and close the Edit Condition dialog box.

You are returned to the Condition List dialog box. Notice that the new condition COND0001
is now listed.

11. Click OK.

12. Select COND0001 from the Traffic Lights drop-down list box to specify styling for the new
condition.

13. On the Appearance tab, in the Style group, set the background color to red.

Note that the red background displays as a preview in the Report canvas when COND0001
is selected.

14. Click Run on the Quick Access toolbar to view the report with conditional styling.

Styling Reports

300  Information Builders



Note that only the Revenue amounts below 500 appear with the red background, as
shown in the following image.

The example above shows conditional styling applied to the column data only, because the
Traffic Lights group in the Appearance tab was used. To highlight the entire row, use the
Traffic Lights group in the Reports tab instead.

Procedure: How to Set Conditional Styling Using the WebFOCUS Syntax

This request sets conditional styling to use a red background to highlight revenue amounts
that are less than 500.

TABLE FILE WF_RETAIL
SUM REVENUE_US
BY FULLNAME
BY PRODUCT_NAME
ON TABLE SET HTMLCSS ON
ON TABLE SET STYLE *
   INCLUDE = endeflt,$ 
TYPE=DATA, COLUMN=REVENUE_US, WHEN=REVENUE_US LT 500, BACKCOLOR='RED' ,$ 
ENDSTYLE
END

Reference: Styling Report Components

The following chart lists all report components that you can style.

TYPE Report Component

REPORT The entire report.
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TYPE Report Component

PAGENUM Default page numbers.

TABHEADING A heading on the first page of a report.

TABFOOTING A footing on or after the last page of a report.

HEADING Headings at the top of each report page.

FOOTING Footings at the bottom of each report page.

SUBHEAD Headings before a particular sort field.

SUBFOOT Footings after a particular sort field.

DATA Report data.

TITLE Column titles.

ACROSSTITLE ACROSS field names (that is, field names used in ACROSS
phrases).

ACROSSVALUE ACROSS field values (that is, values of the ACROSS field).

SUBTOTAL Totals generated by SUBTOTAL, SUB-TOTAL, RECOMPUTE,
and SUMMARIZE.

GRANDTOTAL The last total on a report, which can either be a column
total generated by COLUMN-TOTAL or a grand total
generated by SUBTOTAL, SUB- TOTAL, RECOMPUTE, or
SUMMARIZE.

RECAP Lines generated by ON field name RECAP or ON field name
COMPUTE.

UNDERLINE Underlines generated by ON field name UNDER-LINE.

SKIPLINE Skipped lines generated by ON field name SKIP-LINE.

FREETEXT FML free text.
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Accessing Reporting Components

The following topics describe the tabs and panels that are available when you are developing
reports in the Report canvas.

Building a Report Using the Report Tab

You use the Report tab to modify report properties, change the style of rows and columns on
your report, or create filters. The Report tab contains the following groups: Filter, Report, Traffic
Lights, Style, and Links. The Report tab is located at the top of the App Studio interface and is
available only when you are creating or working with a report. The Report tab is shown in the
following image. 

Defining a Filter Field Using the Filter Group

You use the Filter group to define filter fields when creating a report. The Filter group is shown
in the following image. 

The commands are:

Filter

Filters fields using Where, If, Where Total, and Limits screening options. You can access
the Expression Builder by selecting Where, If, or Where Total from the Filter drop-down
menu.

Using the Expression Builder, you can create expressions quickly by selecting fields,
relations, operators, and values from lists. You can base selection criteria on a specified
value, a variable value, or a field value. For more information, see Creating Expressions
Using the Expression Builder on page 304.

If you select Limits, the Retrieval Limits dialog box opens, where you can set the record
limit and read limit values. This enables you to set how much data is displayed or
previewed.
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Creating Expressions Using the Expression Builder

The Expression Builder enables you to create expressions quickly by selecting fields, relations,
operators, and values from lists. You can base selection criteria on a specified value, a
variable value, or a field value. 

You can access the Expression Builder by clicking Where, If, or Where Total from the Filter
drop-down menu. The Expression Builder dialog box displays.

The Expression Builder is divided into four sections. The Data section is located in the upper-
left of the Expression Builder. The Criteria section is located to the lower-left of the Expression
Builder. The Expression Grid is located to the upper-right of the Expression Builder. The
Advanced section is located in the lower-right of the Expression Builder.

The Data section displays a list of all fields in the data source. Double-click or drag the field
into the Expression Grid to build an expression using the options provided. You can also drag
fields to the Criteria section and the Advanced section, once it is enabled.

The Criteria section displays which expression you are working on, as well as which
expressions, of the same type, you have already created. If you double-click a field and it is
added to the Expression Grid, the field will be shown in the Criteria section. Alternatively, you
can drag a field into the Criteria section to begin working on a new expression. Dragging more
than one field into the Criteria section allows you to create multiple of whatever type of
statement you selected (Where, If, or Where Total). For example, if you clicked Where to open
the Expression Builder, dragging more than one field into the Criteria section will create
multiple Where expressions. Selecting an expression in the Criteria section will show you the
details of that expression in the Expression Grid and/or the Advanced section.

Note: The type of expression you are creating is shown next to the Criteria section.

The Advanced section is where, instead of creating an expression using the Expression Grid,
you are creating the expression using syntax. The Advanced check box is only available to be
selected once a field is in the Criteria or Expression Grid. Once the Advanced check box is
selected, the Advanced section, the Function button, and the Variable button are available for
use.

The Expression Grid is where you build an expression using the drop-down options available.
You can add more fields to the Expression Grid to make a more complex expression by using
OR and AND.

Note: if you close the Expression Builder dialog box using the close icon (X), you are prompted
to save changes, if changes were made.
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Reference: Expression Builder Dialog Box

The Expression Builder dialog box has the following sections: 

Data section

Displays a list of all of the fields in the data source. Double-click or drag a field to add it to
the Expression Grid.

If the selected field has a title attribute defined in the Master File, the title will be used in
the prompt text for the variable. If the selected field does not have a title attribute, the
name of the field will be used in the prompt text for the variable.

Expression Grid

Create an expression by using the drop-down menus in correlation with a field.

You can delete expressions from the Expression Grid using the Delete key or right-click
Delete option when either the And/Or or Column to filter columns are selected. If you use
the Delete key or right-click Delete option on any other column, it will only delete that
column option. You can only delete entire expressions, using the Expression Grid, when
there are multiple expressions present. If you want to delete a single expression, you must
do it from the Criteria section.

And/Or

Displays the keyword used in the expression listed in the Expression list box. You must
select more than one field for the expression to activate this option.

Parentheses

Allows you to add one, two, or three parentheses before and after an expression.

Column to filter

The field you clicked or dragged from the Data section. This field can be changed after
being added by clicking the drop-down list and selecting a different field.

Logical Relation

Displays a list of possible relations between the selected data source field and the value,
parameter, or other field that WebFOCUS will compare it to. Select a relation to activate
the Compare Type column.

The following relations are available from the drop-down list:

equals

does not equal
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is greater than

is greater than or equal to

is less than

is less than or equal to

is

is not

contains

does not contain

matches the pattern

does not match the pattern

is like

is not like

is missing

is not missing

includes

excludes

is from

is not from

is in literal list

is not in literal list

is in external file of literals

is not in external file of literals

none

Note: The is and is not relations are only available for an IF statement. The matches the
pattern, does not match the pattern, is like, is not like, is in literal list, is not in literal list, is
in external file of literals, and is not in external file of literals relations are only available for
a WHERE statement.
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Compare Type

Indicates the nature of the comparison you wish to make to the field selected in the field
section.

The following is a list of the available Compare Types and a brief description of what each
is:

Value is a set value the user creates, using the Multiple or Single Value Builder, in the
Compare Value section.

Field is a selected field the user specifies, using the Multiple or Single Value Builder,
from the Compare Value section.

Parameter is a parameter created by the user, using the Variable Editor, in the
Compare Value section.

Parameter (Optional) is a parameter option that allows a user to create a parameter
that does not require a value at run time.

Parameter (Dynamic) is a parameter option that allows a user to multiselect values
using a button. This option automatically generates the required syntax so that the
Variable Editor does not need to be invoked.

Parameter (Static) is a parameter option that presents a value list to select from. This
option automatically generates the required syntax so that the Variable Editor does not
need to be invoked.

Parameter (Simple) is a parameter option that prompts the user to enter a value. This
option automatically generates the required syntax so that the Variable Editor does not
need to be invoked.

Function is a function created by the user, from the Compare Value section, using the
Function Arguments dialog box.

Import Values is a list of values, created by the user, using the Multiple or Single Value
Builder, in the Compare Value section.

Note: The external file should be a text file with new line delimiters.

Other allows you to enter your own expression.
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Note: After choosing Other and double-clicking on Compare Value to enter a value, you
will be prompted with the following warning message. You can choose to not show this
message again by selecting the option at the bottom of the warning window.

If using a literal value, it must be enclosed in single quotes. 
Please use "Compare Type" "Value" instead for quotes to be added 
automatically.

Compare Value

Specifies the literal value, parameter, or other field to which the selected field is
compared.

The choices available here are dependent on the selection you make in the Compare Type
column.

Criteria

The Criteria section shows the different expressions you created. Selecting an expression
in the Criteria section will show you details of the expression in the Expression Grid and/or
the Advanced section.

Advanced check box

This option can only be checked if there is an expression in the Criteria or Expression Grid
section. This option will enable you to use the Advanced section, the Function button, and
the Variable button.

Advanced section

In this section, you can type an expression using syntax, instead of using the Expression
Grid.

Function

Only available when Advanced is checked. Opens the Function Arguments dialog box to
assist in the creation of an expression that is being made with the Advanced section.

Variable

Only available when Advanced is checked. Opens the Variable Editor dialog box to assist in
the creation of an expression that is being made with the Advanced section.

Delete

Deletes an expression.

Up

Moves an expression up one.
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Down

Moves an expression down one.

Procedure: How to Display Records Based on Specified Values

In the Expression Builder dialog box: 

1. Select a field name from the Data section.

The field is added to the Expression Grid.

2. Select a relation from the Logical Relation column.

3. In the Compare Type column, select Value.

4. Double-click the Compare Value column. The Multiple Value Builder dialog box opens.

5. Click the Select a field button and select a value from the list.

6. Double-click the value to add the value to the list.

Note: Repeat this process to add other values to the list.

7. Click OK.

The values are shown in the Compare Value column.

Procedure: How to Display Records Based on a Variable Value

In the Expression Builder dialog box: 

1. Select a field name from the Data section.

The field is added to the Expression Grid.

2. Select a relation from the Logical Relation column.

3. In the Compare Type column, select Parameter (Dynamic).

This creates a Single Select parameter. If you want to create a Multiselect parameter,
double-click the Compare Value column to open the Variable Editor and change the
Variable Type to Multiselect.

Procedure: How to Display Records Based on Field Values

In the Expression Builder dialog box: 

1. Select a field name from the Data section.

2. Select a relation from the Logical Relation column.

3. In the Compare Type column, select Field.
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4. Double-click the Compare Value column to open the Single Value Builder dialog box.

5. Double-click a field from the Data Source section to move it to the Value List.

6. Click OK to close the Single Value Builder dialog box.

The field is added to the Compare Value column.

Procedure: How to Display Records Based on Imported Values From an External File

In the Expression Builder dialog box:

1. Select a field name from the field list.

The field is added to the Expression Grid.

2. Select a relation from the Logical Relation column.

3. Select Import Values from the Compare Type list options.

4. Double-click the Compare Value column.

The Multiple Value Builder opens.

Note: A Single or Multiple Value Builder dialog box opens, based on your Logical Relation
selection. In the Multiple Value Builder dialog box, you may select more than one value. In
the Single Value Builder dialog box, only one value may be selected.

5. Click the Select File button to import values from an external file.

6. Select a text file from your local machine and click Open.

Note: The external file should be a text file with new line delimiters.

The imported values are loaded into the Data Source area of the Multiple Value Builder
dialog box.

7. Double-click an imported value to add it to the Values List.

8. Click OK to close the Multiple Value Builder dialog box and return to the Expression
Builder.

The imported values are added to the Compare Value area.

Procedure: How to Select Multiple Values and Fields

In the Expression Builder dialog box, you can select multiple values or fields to be used for
record selection criteria by selecting options in the And/Or column. The And/Or column is only
available if you have more than one Column to filter.

1. Select more than one field name from the Fields window and drag them to the Expression
Grid.
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Note: For every Column to filter after the topmost one, And is already selected for you.

2. Click the down arrow in the And/Or column. Select one of the following:

And

To start a new expression that will be combined with the previous expression by the
keyword AND.

Or

To start a new expression that will be combined with the previous expression by the
keyword OR.

3. Select remaining criteria from the other columns in the Expression Builder to complete the
expression.

4. Click OK.

Note: When the keyword And is used, WebFOCUS only selects data that meet both conditions.
When the keyword Or is used, WebFOCUS selects data that meet either condition.

Using Filters in the Autoprompt Page

Filters that you define in the Report canvas appear at run time in the autoprompt page. The
autoprompt page appears before the report is run and allows users to select the filter values
that they want to see in the report.

In the example shown in the following image, there is one filter for Product Category, appearing
in the Filter Values area. Using the drop-down arrow in the Product Category field, select the
product category that you want to see. Accessories is the selected value in the following image.

If there were multiple filters, the user would see multiple fields in the Filter Values area.

Using the autoprompt page button bar, you can click:

Run with filter values. (Rightmost button) To run the report with the values displayed in the
filter fields.
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Reset filter values. (Center button) To remove the selected values and display the default
values. The default value for a filter is the first valid value, listed alphabetically.

Close filter panel. (Leftmost button) To hide the autoprompt filter panel.

Additionally, you can toggle the hamburger control on the top of the report to reveal or hide the
filter panel.

Chaining Input Controls in the Autoprompt Page

Chaining lets you link two or more input controls when they call the same dimension hierarchy.
For example, if you had chained input controls for State and City, the available list of cities
would automatically be limited to those in the specified state. This saves users from scrolling
through a list of invalid options when specifying a parameter value.

The Report canvas in App Studio allows for cascading or chaining input controls in the
autoprompt page. Chaining is also available in the HTML canvas. For more information, see 
Chaining in the HTML Canvas on page 589.

Procedure: How to Chain Input Controls in the Autoprompt Page

When you create a report with a dynamic WHERE filter, an input control prompt displays at run
time asking the user to select a value. When you have multiple WHERE filters that reference
the same dimension hierarchy, the input controls can be chained together, as detailed in the
following procedure.

1. Open the Report canvas and create a report that has two or more columns showing fields
from the same dimension. Position the columns in the same order in which they appear in
the dimension hierarchy.

In the example below, we use the Category, Subcategory, and Model fields from the
Product dimension of the WF_RETAIL database.

2. On the Report tab, click the down arrow under the Filter command and select Where.

The Expression Builder dialog box is opened.

3. In the Data area, expand the dimension that you used in your columns. Select the first
field (which appears in the first column) and drag it down to the Criteria (WHERE) window
below.

The Column to filter field in the main area of the Expression Builder is automatically
populated with the field you selected. In the example below, we selected Category.
Complete the main area as follows:

a. In the Logical Relation field, select equals.

b. In the Compare Type field, select Parameter. From the sub menu, select Dynamic.
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The first WHERE filter is complete.

4. Repeat Step 3 for the next field, in order, that you want to include in the chain.

In the example below, a second filter for Subcategory and a third filter for Model are
created.

Note: To support chaining, the WHERE filters must be created individually, as detailed
above, in the correct order. A single WHERE filter that references multiple fields will not
support chaining.

The following image shows three WHERE filters that will support chaining for the Product
dimension.

5. Click OK to close the Expression Builder. Click the Run button on the Quick Access
toolbar.

The Autoprompt Filter Values window is displayed.
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6. Select values for all filters and click the autoprompt Run button.

A report like the following sample is displayed.

Note the chain icon in the upper right corner of the Filter Values box. This indicates that
the input controls are chained.

Using a Calendar Control in the Autoprompt Page

The Report canvas in App Studio allows for calendar input controls in the autoprompt page,
when you filter on full date fields. The calendar control appears as shown in the following
image.
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The default date will display in the calendar control in the language that the user used at sign
in. The following image shows the filter pane with the default value in French and the calendar
control with the month expanded to show the month values are French.
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Calendar input controls are also available in the HTML canvas. For more information, see How
to Set Calendar Properties on page 485.

Procedure: How to Use a Calendar Control in the Autoprompt Page

1. Open the Report canvas and create a report that you want to filter by time.

2. On the Report tab, click the down arrow under the Filter command and select Where.

The Expression Builder dialog box is opened.

3. In the Data area, expand a dimension that includes a full date field. For example, in the
WF_RETAIL database, the Sales_Related dimension includes Transaction (Time). In this
hierarchy, Sale,Day has an attribute Sale,Date that you can use to filter with a calendar
control.

Drag the selected field down to the Criteria (WHERE) window.

The Column to filter field in the main area of the Expression Builder is automatically
populated with the field you selected.

a. In the Logical Relation field, select equals.

b. In the Compare Type field, select Parameter. From the sub menu, select Simple.

The WHERE filter is complete. The calendar is enabled by the (|FORMAT=YYMD) syntax
which is automatically inserted in this, and all other expressions.

Note: To support the calendar control, the WHERE filter must be created individually, as
detailed above. A single WHERE filter that references multiple fields will not support the
calendar control.

4. Click OK to close the Expression Builder. Click the Run button on the Quick Access
toolbar.

The Autoprompt Filter Values window is displayed with the calendar control.

Customizing a Report Using the Report Group

You use the options on the Report tab, in the Report group, to customize your reports. For
example, you can add a header and footer to your report and include column and row totals.
You can also sort the data on your report. The Report group is shown in the following image. 
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The commands are:

Header & Footer

Adds a header, footer, or both to your report. You can define a Report Header, Page
Header, Page Footer, or Report Footer. For more information, see Adding a Header and
Footer on page 318.

Column Total

Displays a menu of options for column totals:

No Totals. To show no column totals or to remove existing column totals.

Column Totals. To display totals below each numeric column.

Summarize. To display summarized totals below each alpha-numeric column.

For more information, see Adding Totals to a Report on page 320.

Row Total

Displays totals to the right of each numeric row.

Row and Column Titles

The default title for columns and rows appears in the reporting canvas as {TOTAL}. At run
time, this is automatically translated into the language that you have selected for App
Studio. For example, if you have selected Italian, the title appears as TOTALE. For more
information on setting a language, see General Tab on page 45.

To specify a different title:

1. Right-click the total and select Title (for row) or Column Title (for columns) from the
shortcut menu.

The Title dialog opens.

2. Clear the Default Title check box and type the desired title in the Enter Title field.

3. Click OK.

At run time, the title appears as entered. Manual titles are not translated into the
language that you have selected for App Studio.

For more information, see Adding Totals to a Report on page 320.

Precision Report

Converts your report to a precision report. For more information, see Creating Precision
Reports on page 258.
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Compound Document

Converts your report to a Compound document. The original report remains unchanged
while a copy of that report is placed on the Document canvas.

Universal Concatenation

Retrieves data from unlike data sources in a single request. Opens the Universal
Concatenation dialog box, where you can add the additional data sources to concatenate.
For more information, see How to Concatenate Data Sources on page 322.

Sorted Data

Assumes that the data is already sorted in the database. If the data you are accessing is
already in the correct sort order, you can prevent WebFOCUS from resorting it. This feature
provides a fast method of retrieving data if it is already stored in the order required for
display, and no further sorting is required.

Custom Field Placement

Allows sort fields to be moved from their default location.

Adding a Header and Footer

The Header & Footer option in the Report group enables you to add a header or footer to your
report, as well as to the page. The following options are available from the Header & Footer
drop-down list:

Report Header

Page Header

Page Footer

Report Footer

When you select one of the header or footer options, a text box displays in the appropriate
location on the Report canvas. Type your text or right-click inside the Header or Footer text box
to select one of the following options in the shortcut menu:

Footing Bottom. Available only in the Page Footer and Report Footer options, it adds a blank
line to the bottom of the page or report, as specified.

Page Break. Available only in the Report Header and Report Footer options, it adds a page
break either before or after the report, as specified.

Insert Date. Enables you to select the date format.

Insert Spotmarker. Enables you to refine the positioning of a header or footer.
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Alignment Grid. Inserts grid lines so you can align text with one or more columns in the report.

Procedure: How to Add Headers and Footers to a Report

The following steps provide details on adding headers and footers to a report.

1. On the Home tab, in the Content group, click Report, or in the Environments Tree panel,
right-click the desired folder, point to New, and click Report.
The Report Wizard opens.

2. Click Create Report.

3. On the Report tab, in the Report group, click Header & Footer. The following options are
available from the Header & Footer drop-down list:

Report Header

Page Header

Page Footer

Report Footer

4. Select the type of header or footer you would like to add.
A text box is added to the report where you can add the desired text.

Note: You may add ad many of the header and footer types as you like to your report or
page.

5. Use the Style group on the Report tab to change the font or placement of each header or
footer in relation to the report. For more information on the Style group, see Applying a
Theme and Style to a Report Using the Style Group on page 324.

The following image shows the Report canvas with content added to all four header
options.
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Adding Totals to a Report

To help interpret detailed information in a report, you can summarize the information using
column and row totals, grand totals, and subtotals. You can use these summary lines in a
report to clarify or highlight information. You can produce totals for columns or rows of
numbers in a report.

Column Total. Inserts a grand total row at the bottom of the report to sum numeric data in
each column.

On the Report tab, in the Report group, click Column Total. Click the down arrow next to
Column Total to launch a menu with the No Totals, Column Totals, and Summarize (for
calculated values in your row or column totals) options.

For more information, see How to Create a Report with a Column Total on page 320 and 
How to Create a Report with a Column Total on Selected Fields on page 321.

Row Total. Inserts a new column containing the sum of all numbers in each row.

On the Report tab, in the Report group, click Row Total.

For more information, see How to Create a Report with a Row Total on page 322.

You can use column totals and row totals in matrix reports (created by using a BY sort field
and an ACROSS sort field in your report request), rename column and row total titles, and
include calculated values in your column or row totals. You can also create row totals using
ACROSS-TOTAL.

Procedure: How to Create a Report with a Column Total

1. On the Home tab, in the Content group, click Report, or in the Environments Tree panel,
right-click the desired folder, point to New, and click Report.

The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For
example, select wf_retail.mas.

The Report canvas opens.

4. Add the following fields to your report in the order shown. You can double-click the fields in
the Object Inspector, or drag them to the Report canvas.

Product Category

Product Subcategory
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Revenue

Gross Profit.

5. On the Home tab, in the Report group, click Column Total and select Column Totals from
the drop-down menu.

A grand total row is added at the bottom of the report that sums numeric data in each
column.

Procedure: How to Create a Report with a Column Total on Selected Fields

1. On the Home tab, in the Report group, click Column Total, and select Column Totals from
the drop-down menu.

The Report Wizard opens.

2. Click Create Report.

3. Navigate to where you want to create the new procedure and select a data source. For
example, select wf_retail.mas.

The Report canvas opens.

4. Add the following fields to your report in the order shown. You can double-click the fields in
the Object inspector, or drag them to the Report canvas.

Product Category

Product Subcategory

Revenue

Gross Profit

5. On the Home tab, in the Report group, click Column Total, and select Column Totals from
the drop-down menu.

A grand total row is added at the bottom of the report that sums numeric data in each
column.

6. To add column totals to only specific columns in the report, right-click the Column Total row
and select Options.

The Properties for Column Total dialog box opens.

7. Select the columns for which you want a column total and click OK.

4. Creating Reports

WebFOCUS App Studio User’s Manual  321



Procedure: How to Create a Report with a Row Total

1. On the Home tab, in the Content group, click Report, or in the Environments Tree panel,
right-click the desired folder, point to New, and click Report.

The Report Wizard opens.

2. Click the Create Report button.

3. Navigate to where you want to create the new procedure and select a data source. For
example, select wf_retail.mas.

The Report canvas opens.

4. Add fields to your report. You can double-click the fields in the Object inspector, or drag
them to the Report canvas. For example, add the fields listed below to your report in the
following order.

Product Category

Product Subcategory

Cost of Goods

Discount

5. On the Report tab, in the Report group, click Row Total.

A grand total column that sums numeric data in each row is added at the far right of the
report.

Procedure: How to Concatenate Data Sources

Universal concatenation specifies how to combine data from sources with dissimilar Master
Files.

1. Create the main request.

This contains all the formatting for the resulting report and names the first file to be
concatenated. It also contains all printing and sorting information. The fields printed and
the sort fields must exist as real or DEFINE fields in each file.

2. On the Report tab, in the Report group, click Universal Concatenation.

The Universal Concatenation dialog box opens.
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3. Click the Add Source button to add additional data sources.

The Open File dialog box appears.

4. Select a Master File and click OK.

If there are temporary HOLD files associated with the procedure, HOLD files are available
from the Open dialog box.

The selected data source is added, showing the Report Field Resolutions and Filters.
Additionally, the Define Tool is activated.

Note: If the field names for the selected data source are not the same names and formats
as the fields being printed and sorted in the main request, the Universal Concatenation
dialog box indicates that you need to define these fields with status icons.

5. Create or modify a field for the universal concatenation with the Define Tool.

Click the Define button from the Universal Concatenation toolbar.

or

Double-click the field name from the Additional Data Sources list.

The Define Tool opens.

Note: The Define Tool opens automatically if the Create all needed fields for a data source
when launching the Define tool option is selected. This creates the missing defines for the
data source. A message appears before the Define Tool opens, stating which DEFINEs will
be created and require expressions, followed by a list of the created DEFINE fields. This
option is off by default.

Create the DEFINE expression using the selected universally concatenated Master File,
generating the required DEFINEs for the data source to have the same field names and
formats as the fields used in the main request.

Click OK to close the Define Tool.

The DEFINE expression is written in the procedure ahead of the TABLE request.

6. Create selection criteria for the universal concatenation with a filter.

You may create a filter through a WHERE clause.

Select the Where/If button to open the Expression Builder.

To modify or view the filter, double-click the filter expression from the Additional Data
Source list to open the Expression Builder.
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7. Click OK to close the Universal Concatenation dialog box and add the MORE command to
the procedure.

Setting Conditional Styling Using the Traffic Lights Group

You use the Traffic Lights group to set styling conditions. The Traffic Lights group is shown in
the following image. 

Traffic Lights 

Sets the current condition for styling and hyperlinks. Options include:

None. Displays a preview of the report with no visible conditional styling. This is the
default.

Forecast. Lets you apply conditional styling to the predictive analytics shown in a
forecast column. For more information, see Overview of Forecasting on page 361.

Add/Edit Conditions. Opens the Condition List dialog box. From this dialog box, you
can define new conditions, and then apply styling to them.

The styling you add to a condition appears as a preview in the Report canvas when you
select the condition in the Traffic Lights drop-down list box.

For a sample procedure, see How to Apply Conditional Styling with the Traffic Lights Feature
on page 299.

Applying a Theme and Style to a Report Using the Style Group

You use the tools in the Style group to apply stylistic changes to a report, including data, title,
and all other components of the report. The Style group is shown in the following image. 
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This section details the Style group of the Reports tab, which you can use to apply report-level
styles. The Style group also appears on the Appearance tab (excluding the Theme commands)
which you use to apply field-level styles. For more information, see Styling Data, Titles, and Text
Using the Style Group on page 385.

The commands are:

Change Theme

Changes the theme of the report from a list of available style sheets.

Manage Theme

References or embeds an external StyleSheet or applies no styling to your report. The
WebFOCUS StyleSheet is applied by default. When you click this button, the StyleSheet
Selection dialog box opens.

Save Theme

Saves your current theme options.

Scope

Indicates the scope to which your changes will apply. For example, if you choose Report,
your style changes will be applied to the whole report. If you choose Footing, your changes
will be applied to the footer only. You can use the Scope function to apply styling to
different areas of your report. The Scope options available from the Report tab are:

Report

Title

Data

Report Header

Report Footer

Page Header

Page Footer

Subhead

Subfoot

Subtotal

Subtotal Tag
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Across Title

Across Data

Column Totals

Column Totals Tag

Report Totals (Report)

Report Totals (Title)

Report Totals (Data)

Recap

Cell

Page Color

(Selected Item)

Note: The (Selected Item) scope is only available when you select a text or field item. The
type of item selected will come before (Selected Item). For example, if you have text
selected in the Page Footer, the Scope would display Page Footer (Selected Item).

Bold

Applies bold font formatting to the highlighted text or text within a selected object.

Italic

Applies italic font formatting to the highlighted text or text within a selected object.

Underline

Underlines the highlighted text or text within a selected object.

No Underline

Do not display underlines, even for drilldowns.

Left

Aligns the highlighted text or text within a selected object to the left.

Center

Aligns the highlighted text or text within a selected object to the center.

Right

Aligns the highlighted text or text within a selected object to the right.
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Default

Aligns the highlighted text or text within a selected object to the default alignment option.
This aligns numbers to the right and text to the left.

Report Width

Sets report width options.

Copy Style

Copies the current style settings, enabling the Paste Style button.

Paste Style

Pastes the copied style settings.

Font Name

Changes the font of the highlighted text or text within a selected object. Fonts are listed in
alphabetical order.

Font Size

Changes the font size of the highlighted text or text within a selected object. Font sizes
range from 8 to 72 (whole numbers only).

Color

Changes the font color of the highlighted text or text within a selected object. Applies the
color change to the selected Scope. Opens the Color dialog box, where you can select the
font color.

Background Color

Changes the background color of the highlighted text or text within a selected object.
Applies the color change to the selected Scope. Opens the Color dialog box, where you can
select the background color.

Defaults

Resets the style settings of the highlighted text or text within a selected object to the
default (original) style.

Borders/Grid

Turns on or disables borders and grid lines. You can apply borders and gridlines to HTML,
Excel, and PDF reports. For all other report types, this option is disabled.

User Style

Enables you to set User Format Style Blocks, if available.
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Referencing or Embedding a Style Sheet Using the StyleSheet Selection Dialog Box

The StyleSheet Selection dialog box enables you to reference or embed an external style
sheet, use the default WebFOCUS StyleSheet, or apply no styling to your report. You may also
save and include multiple style sheets. The StyleSheet Selection dialog box is accessible from
the Style group on the Report canvas ribbon. 

The StyleSheet Selection dialog box provides the following capabilities:

Include a StyleSheet.

Apply an external cascading style sheet (CSS).

Embed a StyleSheet.

Apply the default WebFOCUS StyleSheet.

Save the modified style sheet as a new style sheet file (.sty).

To open the StyleSheet Selection dialog box, on the Report tab, in the Style Group, click
Manage Theme.

Note: The StyleSheet Selection dialog box opens to the Include StyleSheet File section, since
every procedure has existing embedded styling, by default. You may click Change Options and
choose to embed or reference an external StyleSheet, use the WebFOCUS default StyleSheet,
or turn off all report styling, as described in the following procedures.

Procedure: How to Include a StyleSheet in a Report

Since every procedure has existing styling, the Include StyleSheet File section opens, by
default.

When a StyleSheet is included, part of the styling is embedded in the report. You may include
StyleSheets up to an INCLUDE depth of three in your report, with the last selected StyleSheet
having precedence.

1. On the Report tab, in the Style group, click Manage Theme.

The StyleSheet Selection dialog box opens.

2. Click the Add new item button.

The Open File dialog box opens.

3. Select a StyleSheet file and click OK.

4. Optionally, you may select to include additional StyleSheets, up to an INCLUDE depth of
three in your report.
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Note: The last selected StyleSheet has precedence in the report. You may use the arrows
to reorder the arrangement of StyleSheets.

The following syntax will be added to the procedure for the included StyleSheets.

ON TABLE SET STYLE *
     INCLUDE = citrus,
$
     INCLUDE = teal,
$
     INCLUDE = olive,
$
.
.
.

5. Click Finish to close the StyleSheet Selection dialog box.

6. Optionally, you may apply styling options from the Report canvas and save the StyleSheet
code using the Save Theme command, in the Style group, on the Report tab.

Procedure: How to Apply an External Cascading Style Sheet (CSS)

In addition to applying StyleSheets to your report, you may apply an external cascading style
sheet to your report. An external cascading style sheet (CSS) is an extension to HTML that
enables you to specify formatting for an HTML document. To link the CSS to the report, use
the External Cascading Style Sheet URL field in the StyleSheet Selection dialog box. 

Note: An external cascading style sheet is only applicable when using the HTML report output
format.

1. On the Report tab, in the Style group, click Manage Theme.

The Stylesheet Selection dialog box opens.

2. Type a name of the customized StyleSheet (.css) in the External Cascading StyleSheet URL
input field.

Note: The external CSS (cascading style sheet) file should be saved in an alias on the web
server.

3. Optionally, you may include StyleSheets to be added to the report.

Note: A CSS file is separate from a StyleSheet file and can exist on its own.

4. Click Finish to close the StyleSheet Selection dialog box.
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Procedure: How to Embed a StyleSheet in a Report

Embedding a StyleSheet stores your style information within the report, from which you can
read an existing file as a starting point, start with an empty style, or leave the current
StyleSheet contents without any modifications.

1. On the Report tab, in the Style group, click Manage Theme.

The StyleSheet Selection dialog box opens.

2. Click Change Options to change the StyleSheet Selection dialog box options. The
StyleSheet Selection dialog box displays.

3. Accept the default, Normal Embedded Styling, and click Next.

4. To read an existing file as a starting point:

a. Select Initialize with the contents of a pre-existing file.

Note: Preserve referenced StyleSheets so any “INCLUDE=name” will not be deleted is
selected, by default. When a StyleSheet is included, a reference of the StyleSheet is
added to the report syntax as INCLUDE=name. This reference is added to the existing
style information already in the TABLE request.

b. Click Next.

The StyleSheet File Selection dialog box appears.

c. Select a Predefined Template file to use as your starting point and click OK.

The selected StyleSheet file is shown as the origin embedded StyleSheet file.
Optionally, you may include additional StyleSheets or add an External cascading style
sheet (CSS).

d. Click Finish to close the StyleSheet Selection dialog box.

The selected StyleSheet code is imported into the procedure and overwrites any existing
styling in the report.

5. To start with an empty style:

a. Click Change Options to change the StyleSheet Selection dialog box options.

b. Keep Normal Embedded Styling selected and click Next.

c. Select Start fresh with an empty StyleSheet.

Note: Preserve referenced StyleSheets so any “INCLUDE=name” will not be deleted is
selected, by default. When a StyleSheet is included, a reference of the StyleSheet is
added to the report syntax as INCLUDE=name. This reference is added to the existing
style information already in the TABLE request.
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d. Click Next.

The Include StyleSheet File section opens indicating that the origin of the embedded
StyleSheet file is unknown.

Tip: You may select StyleSheet files to embed to your currently empty style.

e. Click Finish to close the StyleSheet Selection dialog box.

f. Click OK to close the StyleSheet Selection dialog box.

Starting with an empty style clears any styling from the report and initializes a procedure
with the WebFOCUS default style code (basic styling that is used when styling is not
specified).

6. To leave Report canvas generated styling untouched:

a. Click Change Options to change the StyleSheet Selection dialog box options.

b. Keep Normal Embedded Styling selected and click Next.

c. Select Leave current StyleSheet contents without modification.

Note: Preserve referenced StyleSheets so any “INCLUDE=name” will not be deleted is
selected, by default. When a StyleSheet is included, a reference of the StyleSheet is
added to the report syntax as INCLUDE=name. This reference is added to the existing
style information already in the TABLE request.

d. Click Next.

The Include StyleSheet File section opens indicating that the origin of the embedded
StyleSheet file is unknown.

Tip: You may include StyleSheets to be added to the report.

e. Click Finish to close the StyleSheet Selection dialog box.

7. Optionally, you may apply styling options from the Report canvas and save the StyleSheet
code.

Procedure: How to Apply the Default WebFOCUS StyleSheet

The WebFOCUS Default Styling section applies the default StyleSheet to your report, with no
styling visible in the procedure.

Note: The default WebFOCUS StyleSheet disables any styling options in the report. No further
styling options of any kind can be applied to the report.

1. On the Report tab, in the Style group, click Manage Theme.

The StyleSheet Selection dialog box opens.
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2. Click Change Options to change the StyleSheet Selection dialog box options.

3. Select WebFOCUS Default Styling and click Finish.

Tip: To remove the default WebFOCUS StyleSheet and enable styling, click the Style File
Selection button to open the StyleSheet Selection dialog box and select the Normal
Embedded Styling option.

Procedure: How to Reset the Default Report Canvas Styling

To reset the default the Report canvas styling in the StyleSheet Selection dialog box:

1. On the Report tab, in the Style group, select Manage Theme.

The StyleSheet Selection dialog box opens.

2. Highlight the added StyleSheet files (.sty) listed in the Include StyleSheet File section and
click Delete selected items (Del).

Procedure: How to Save a StyleSheet

After including StyleSheets and applying styling options from the Report canvas, you may save
the StyleSheet as a new StyleSheet file (.sty).

1. On the Report tab, in the Style group, click Save Theme.

The Save As dialog box opens.

2. Type a name for the StyleSheet in the File name input field and click OK.

The .sty file is saved in the working directory. You may browse to select a different
location.

Tip: The saved StyleSheet can be included in other reports from the StyleSheet File
Selection dialog box.

Reference: Usage Notes for the StyleSheet Selection Dialog Box

The following apply when using the StyleSheet Selection dialog box in the Report canvas:

Applying StyleSheets through the StyleSheet Selection dialog box follows the same rules of
WebFOCUS StyleSheet inheritance. For details, see WebFOCUS StyleSheet Attribute
Inheritance in the Creating Reports With WebFOCUS Language manual.

When including or referencing a StyleSheet that is not in the current application, the
StyleSheet gets copied to the working directory.
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If the StyleSheet already exists in the current application, it does not get overwritten.

To refresh an existing StyleSheet, you must copy the new StyleSheet to the working
directory or remove the StyleSheet from the procedure, delete it from the working directory,
and then add it back to the procedure.

The default location for StyleSheets that are Included or referenced in App Studio is drive:
\AppStudionn\ibi_html\javaassist\intl\locale\combine_templates, which contains a set of
sample StyleSheets. You can also search other WebFOCUS locations for available
StyleSheets.

When a StyleSheet is used in the procedure and the StyleSheet Selection dialog box is
opened, it opens in the Include StyleSheet File section, enabling you to change the
included StyleSheet. You may also change the StyleSheet options. This occurs even when
the Defaults option (located in the Style group on the Report canvas ribbon in App Studio) is
clicked.

Note: If you go back and select to embed or reference a StyleSheet, or use the WebFOCUS
default option, the StyleSheet that was in the report will get overwritten.

If the report does not have any styling, the StyleSheet Selection dialog box opens to the
Change Options section. The report code contains the command:

ON TABLE SET STYLE OFF

Assigning a Color Value Using the Color Dialog Box

The Color dialog box lets you choose a color by selecting it from the color palette or entering a
hexadecimal value.

Procedure: How to Access the Color Dialog Box

1. On the Report tab, in the Style group, click Color or Background Color.

The Color dialog box displays.

2. Click Default to restore the formatting back to its original state.

3. Click Custom to access custom coloring.

4. Click OK to close the Color dialog box.

Adding Borders to a Report Using the Borders Dialog Box

You use the Borders dialog box to add borders to your report.
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Procedure: How to Add Borders to an HTML, Excel, or PDF Report

You can add borders to an entire report, a column, or another object area, such as a heading
or footing.

Note: You must remove grids from the report, column, or object area before you can apply
borders.

You can set borders to a report globally, so that they will apply to all objects you subsequently
add to the report.

Note: Ensure that HTML, Excel, or PDF is selected as the report output format on the Format
tab.

To set global borders:

1. On the Report tab, in the Style group, click Borders/Grid and then click Borders.

The Borders dialog box opens.

Note: By default, the Make all borders the same option is selected.

2. To specify border settings for the top, bottom, left, and right borders, click the Make all
borders the same check box to disable that option. Make your border selections:

Select the following options from the Width drop-down list:

OFF to turn borders off. (This is the default.)

LIGHT to apply thin border lines.

MEDIUM to apply medium border lines.

HEAVY to apply thick border lines.

From the Style drop-down list, select a line style.

From the Color drop-down list, select a color.

After you select your border width, style, and color selections, you can see them in the
Border Preview window in the Borders dialog box.

Note: You can restore the original default borders by clicking the Default button.

3. Click OK.

To apply a border to a column:

1. Select the column to which you want to apply a border.
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2. On the Appearance tab, in the Style group, select an option from the Scope drop-down
command. The options are:

Data and Title applies grids to the column title and data.

Data Only applies grids to the column data.

Title Only applies grids to the column title.

3. On the Appearance tab, in the Style group, click Borders.

The Borders dialog box opens.

4. To specify border settings for the top, bottom, left, and right borders, select the Make all
borders the same check box to turn off that option.

5. Make your border selections:

Click the down arrow in the Width drop-down list box and select:

OFF to turn borders off. (This is the default.)

LIGHT to apply thin border lines.

MEDIUM to apply medium border lines.

HEAVY to apply thick border lines.

From the Style drop-down list, select a line style.

From the Color drop-down list, select a color.

After you select your border width, style, and color selections, you can see them in the
Border Preview window in the Borders dialog box.

Note: If the OFF option is selected in the Width drop-down list, no borders will be shown.

6. Click OK.

To apply a border to another object area:

1. On the Report tab, in the Style group, select an option from the Scope drop-down command
The options are:

Report

Title

Data

Report Header
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Report Footer

Page Header

Page Footer

Subhead

Subfoot

Subtotal

Subtotal Tag

Across Title

Across Data

Column Totals

Column Totals Tag

Report Totals (Report)

Report Totals (Title)

Report Totals (Data)

Recap

Cell

Page Color

(Selected Item)

2. On the Report tab, in the Style group, click Borders/Grid and then click Borders.

The Borders dialog box opens.

3. To specify border settings for the top, bottom, left, and right borders, select the Make all
borders the same check box to turn off that option.

4. Make your border selections:

Select the following options from the Width drop-down list:

OFF to turn borders off. (This is the default.)

LIGHT to apply thin border lines.

MEDIUM to apply medium border lines.
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HEAVY to apply thick border lines.

From the Style drop-down list, select a line style.

From the Color drop-down list, select a color.

After you select your border width, style, and color selections, you can see them in the
Border Preview window in the Borders dialog box.

Note: If the OFF option is selected in the Width drop-down list, no borders will be shown.

5. Click OK.

Specifying a Width Limit for a Value Using the Width Options Dialog Box

The Width Options dialog box allows you to set how values will be handled if they extend the
report cell. You can also enter a value to specify a limit for how large or small a value can be
before these options take effect.

Procedure: How to Set Width Options for a Report

1. On the Report tab, in the Style group, click Report Width.

The Width Options dialog box displays.

2. From the <not set> drop-down dialog box, select one of the following options:

Minimum

Maximum

Truncate

Wrap

Wrap Off

3. Indicate a value (in inches) by which to limit the width of the report.

Note: This only applies to Truncate and Wrap.

4. Click OK.
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Creating Drill-Down Hyperlinks using the Drill Down Command

You can use the Drill Down command in the Links group to create hyperlinks in your report.
These hyperlinks allow you to see more detail in the ad-hoc reports that are automatically
created when you click a link. The Drill Down command is shown in the following image. 

The Drill Down command appears in both the Report and the Appearance tabs. The resulting
hyperlinks differ, depending on the tab you invoke the command from.

The Report tab Drill Down command creates hyperlinks in every field in the report.

The Appearance tab Drill Down command creates hyperlinks only in the fields of the
specified column.

Procedure: How to Create Drill-Down Hyperlinks

1. On the Report tab (for links in every field) or Appearance tab (for links in a column only), in
the Links group, select Drill Down.

The Drill Down dialog box displays.

2. Click the Add new item button on the Drill Down dialog box toolbar.

The Drill Down fields are enabled.

3. In the Drill Down dialog box:

a. The Drill Menu Items field is automatically populated with a default drill-down name.
You may rename it as needed, or delete the name if you are using only one drill down.

b. Select one of the following Drill Down Types from the drop-down menu:

Execute Procedure

Execute Guided Procedure

URL

URL from field

JavaScript
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Refresh BI Portal

Note: The Refresh BI Portal drill-down type will be displayed only when you are working
with a report that was created in the Content development area.

c. Double-click in the Source field.

If you selected the Execute Procedure Drill Down Type, the Open File dialog box
opens.

Select the procedure to drill to and click OK.

If you selected the Execute Guided Procedure Drill Down Type, the Guided
DrillDown dialog box opens. For more information, see How to Create Guided Drill
Down Hyperlinks on page 340.

If you selected the URL Drill Down Type, type a fully qualified URL to drill to.

If you selected the URL from field Drill Down Type, select a source field from the
drop-down menu which contains the URL to drill to.

If you selected the JavaScript Drill Down Type, enter the function to drill to. In the
Parameters field (Step 4 below), type the arguments for the function.

If you selected the Refresh BI Portal Drill Down Type, select Current page only or All
pages in portal to refresh when the drill down is triggered.

d. Select a Target Frame from the drop-down menu:

_blank opens the target procedure in a new window.

_self opens the target procedure in the same window as the source. This is the
default. In addition, it is the only option available if you selected the Refresh BI
Portal drill down type.

_parent opens the target procedure in the same frame as the anchor.

_top opens the target procedure in the current window.

e. Double-click in the Parameters field.

The Parameters dialog box opens.

4. Click the Add new item button on the Parameters dialog box toolbar.

The Parameter fields are enabled.
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5. In the Parameters dialog box:

a. The Parameter Name field may appear, depending on the Drill Down Type you
selected. Select a name from the drop-down menu or, if no drop-down menu appears,
type a parameter name.

b. Select a parameter type from the drop-down list box:

Field allows you to select a specific field from the Parameter Value drop-down
menu.

Constant Value allows you to specify a constant value for the parameter in the
Parameter Value field.

Variable allows you to specify a variable for the parameter in the Parameter Value
field.

6. Click OK.

The Parameters dialog box closes and you return to the Drill Down dialog box.

7. Click OK.

The Drill Down dialog box closes.

Procedure: How to Create Guided Drill Down Hyperlinks

1. On the Report tab (for links in every field) or Appearance tab (for links in a column only),
select Drill Down.

The Drill Down dialog box opens.

2. Click the Add new item button on the Drill Down dialog box toolbar.

The Drill Down fields are enabled. The Drill Menu Items field is automatically populated
with a default drill-down name. You may rename it as needed, or delete the name if you
are using only one drill down.

3. In the Drill Down type list, click Execute Guided Procedure.

4. Double-click in the Source field.

The Guided DrillDown dialog box opens.

5. Click Browse.

The Open File dialog box opens.

6. Select the drill-down procedures that you want to use.

To select multiple procedures, hold down the Ctrl key and click the procedures.
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7. Click OK.

You are returned to the Guided DrillDown dialog box, with the selected procedures
displayed in the procedures list box.

8. Optionally, use the procedures list box toolbar to change the order of the procedures, undo
or redo changes, or delete a procedure from the list.

9. To add parameters for a procedure, select it in the procedures list box, then click Add in
the Parameters list box.

The Drill Down Parameter dialog box opens.

10. In the Drill Down Parameter dialog box, do the following:

a. Type a parameter name in the Parameter name field.

b. To specify a field as a parameter value, select Field and use the drop-down list to
select a field from the highlighted procedure.

c. To specify a constant value as a parameter value, select Constant value and type the
value in the available field.

d. To change the wording of the prompt that displays when users select a drill down
procedure, type the new wording in the Prompt field.

11. Click OK.

You are returned to the Guided DrillDown dialog box.

12. Click OK.

You are returned to the Drill Down dialog box.

13. In the Drill Down dialog box, select a Target Frame from the drop-down menu. The
available options are:

_blank opens the target procedure in a new window.

_self opens the target procedure in the same window as the source.

_parent opens the target procedure in the same frame as the anchor.

_top opens the target procedure in the current window.

14. Click OK.

The Drill Down dialog box closes.
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Managing Output Formats Using the Format Tab

You use the Format tab to change the output type of the report, control the navigational
settings of a report, and access the special features of a report. Accordingly, this tab contains
the Output Types, Navigation, and Features groups. The Format tab is located at the top of the
App Studio interface and is available only when you are creating a report. The Format tab is
shown in the following image.

Selecting a Type of Report Using the Output Types Group

The Output Types group enables you to choose the type of report (for example, PDF, Excel, or
active report) that you would like to produce. You can also set the output format and the
destination of the report using the elements in this group. The Output types group is shown in
the following image. 

The report type options are:

HTML

Changes the report output type to HTML. This is the default value. For more information,
see Output Format Options Dialog Box for an HTML Report on page 344.

Active Report

Changes the report output type to HTML active report (AHTML).

PDF

Changes the report output type to PDF. For more information, see Output Format Options
Dialog Box for a PDF Report on page 345.

Active PDF

Changes the report output type to active PDF, which creates a PDF report for Adobe Flash
Player.
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Excel

Changes the report output type to Excel. You can select the following types of Excel
Reports: Excel XLSX, Excel XLS, Excel XLSX Formula, Excel XLS Formula, or the Excel XLS
PivotTable. For more information, see Output Format Options for Excel Reports on page
345.

PowerPoint

Changes the report output type to PowerPoint. You can select PowerPoint PPTX or
PowerPoint PPT. For more information, see Output Format Options for PowerPoint Reports
on page 346.

Output Format

Changes the output format of a report. The options that are available to you change
depending on which output format you select. Formats are grouped into the following
categories: Styled report formats, Unstyled formats, and Database formats.

Output Format Options

Opens the Output Format Options dialog box where you can set a report title, turn on
cascading style sheets, set how to expand report rows and turn on line suppression.

Destination

Opens the Output Destination dialog box, where you can set the destination of your output
to Web Browser, Temporary File, or Save File. If you select Temporary File or Save File, you
can set the name and location of that file using the Name text box and directory selection
icon. For more information, see How to Set the Output Destination on page 343.

Procedure: How to Set the Output Destination

1. On the Format tab, in the Output Types group, click Destination (PCHOLD). 

The Output Destination dialog box displays.

2. For Destination, select one of the following options:

Web Browser

Temporary File

Save File

Default

Note: If you select Temporary File or Save File, the Name field is activated.

3. Enter a file name and click the ellipsis button (...)
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The File name and location dialog box displays.

4. Select where you want to save the file.

Note: The file name that you specified on the Output Destination dialog box is carried over
to the Filename field in the File name and Location dialog box.

5. Click OK.

6. Click OK on the Output Destination dialog box.

Reference: Output Format Options Dialog Box for an HTML Report

The following options are available for an HTML report:

Report Title

You can type a report title into the text box.

Cascading Style Sheets

You can select whether or not to include cascading style sheets in your report. You can
select On or Off. On is selected by default.

Expand By Row

You cans select how you would like rows to be expanded. Only show top level is the
default.

Only show top level. Creates a report which initially displays only the highest sort field
level. To see rows on lower levels, click the plus sign (+) next to one of the displayed
sort field values.

Off. Does not create a report where you can expand rows.

Expand everything. Creates a report in which all sort field levels are initially expanded.
To roll up a sort field level, click the minus sign (-) next to one of the sort field values
on that level.

Note: If you want to set your report rows to expand to a specific number, you must type an
integer into the text box rather than selecting one of the options.

Suppress blank lines

You can select whether to suppress blank lines or not.

Off. The suppression of blank lines will not occur.
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Only within report body. The suppression of blank lines will only occur within the body
of the report.

Reference: Output Format Options Dialog Box for a PDF Report

The following options are available for a PDF report:

Repeat sort fields per panel

Enables the display of By fields in the left portion of each panel of a multi-panel report.

Repeat headings/footings per panel

Repeats headings/footings on each panel page when the columns presented on PDF
reports cannot be displayed on a single page.

Use settings for Postscript printing

Sends the page settings to a PostScript printer when printing in PS format.

Display grid for object placement evaluation

Displays a grid in the report output, which enables you to evaluate the correct placement
of data and objects during your report design.

Align borders in subheading/subfooting with data

Aligns the borders in a subheading or subfooting with the data in the report output.

Reference: Output Format Options for Excel Reports

The following options are available for an Excel report:

Create separate worksheets for each primary sort value

Adds the highest-level sort field and its values as a TOC in the report. This option
deactivates all other options on the Format tab.

Report Title

You can type a report title into the text box.

Generate overflow sheets

This indicates where the overflow rows of data break in the Excel worksheet. The default is
65,000 rows of data before an overflow sheet is generated.

Note: When you change formats from XLSX to EXL2K and ROWLIMIT exceeds 65,000, you
will receive a message asking you if you want to proceed. If you decide to continue,
ROWLIMIT will be set to 65,000. If you decide not to continue, the format will revert to
XSLX, with no change to ROWLIMIT.
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Rows per sheet

Specifies the number of rows per sheet. This option is set to max and unable to be edited
when Generate overflow sheets is turned off.

Define a range name for the data

Assigns a named range to a group of cells in Excel. There is a 256 character limit for
named ranges.

Template

You can set which template to use in your Excel report.

Item to populate

Sets the number of items to populate.

Reference: Output Format Options for PowerPoint Reports

The following options are available for a PowerPoint report:

Template

You can set which template to use in your Excel report.

Item to populate

Sets the number of items to populate.

Reference: User Format Selection Dialog Box

You can use the User Format Selection dialog box to choose which formats and options are
available, at run time, when you select the User output format from the Styled report formats,
from the Output Formats command. You can select which formats a user can choose from, and
customize the options specific to each format.

The options are:

Selection

Provides a list of check boxes that indicate whether or not an output format is available to
the user. All formats are selected by default. You can click the check box for a format to
clear it.

Format

Displays a list of available output formats.

Description

Provides a brief description of the output format which is displayed to the user, at runtime.
You can edit the description by double-clicking the description text box.
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Options

Indicates which output formats have options you can customize. You can click the double-
arrow to open the Output Format Options dialog box, which displays the options available
for that format. For example, if you click the double-arrow for the HTML output format, the
Output Format Options dialog box opens, displaying the options for the HTML output
format.

Enter text for the WFFMT prompt:

You can type what the user sees when prompted to choose an output format, at run time.

OK

Accepts the changes and closes the dialog box.

Cancel

Discards the changes and closes the dialog box.

Setting Navigational Options for a Report Using the Navigation Group

The navigation group contains the functionality for setting navigational options for your report
(for example, adding a Table of Contents or freezing an area of the report). You can also create
drilldowns with the Auto Drill command. The Navigation group is shown in the following image.

The commands are:

Table of Contents

Displays every value of the highest-level sort field as a hyperlink, and then toggles between
a display of the entire report and a designated section. It also applies a dynamic table of
contents to the first By field in an HTML report. You can select Report, Heading, or None.

Note: You create a Table of Contents on a BY field.

For more information, see How to Add a TOC or Disable the TOC Feature on page 348.
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Freeze

Freezes the scrolling area of a report so that Headings or Footings display with the full
report in a narrow browser window. You can select Off, On, Top, Bottom, or Custom. For
more information, see How to Freeze the Scrolling Area for HTML Report Output on page
349.

On-Demand Paging

Displays one page of an HTML report at a time. You use controls on your browser to
display the next or previous page, all pages, or to navigate to a specific page. You can
select On or Off (default). For more information, see Navigating Large Reports with On-
Demand Paging on page 349.

Auto Drill 

Creates an automatic drill down. This changes the Enable Auto Drill property value to Yes.
You can use the Auto Drill with the HTML or Active Report output types only. For more
information, see Link to Ad Hoc Reports, Charts, and Visualizations Using Auto Drill on page
411.

OLAP Options
Opens the Auto Drill & Analysis dialog box. You can select options related to OLAP and
automatic drill downs. For more information, see Working With Auto Drill & Analysis
Functionality on page 352.

Note: This option only appears if you select the Enable OLAP check box in the Reporting
tab of the App Studio Options dialog box.

Procedure: How to Add a TOC or Disable the TOC Feature

1. Select a BY column in your report. 

2. On the Format tab, in the Navigation group, click Table of Contents.

3. Choose one of the following options:

Report to embed the TOC in the executed report as an expandable tree control.

Heading to add the By columns as the last objects in the page heading. The TOC
appears in a drop-down list in the heading when the report is executed.

None to turn the TOC feature off.

Tip: Click the Properties tab in the Object Inspector to verify that the Table of Contents
is turned on.
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or

1. Right-click the first By column in the Report canvas and click Table of Contents.

2. Select one of the following options: Report, Header, or None.

Procedure: How to Freeze the Scrolling Area for HTML Report Output

You can freeze page headings/footings, report headings/footings, column titles, and totals for
your report output. The freeze option is available from the Navigation group of the Format tab.

1. On the Format tab, in the Navigation group, select Freeze.

2. Select the freeze type from the drop-down list.

The options are:

Off. This is the default.

On. Freezes the headings/footings, column titles, and totals.

Top. Freezes the headings and column titles.

Bottom. Freezes the totals and footings.

Custom. Enables you to set the scroll height for the freeze type.

3. Save and run your report.

Navigating Large Reports with On-Demand Paging

On-Demand Paging is a feature that minimizes load time by opening requested pages only
when you run a report. This is particularly useful when running large reports that can otherwise
take a long time to load.

When On-Demand Paging is enabled, your browser consists of the following two sections:

Report frame. The Report frame is the main section of the browser and contains one page
of report output. When you first run a report, the Report frame contains the first page of
report output.

On-Demand Paging Toolbar. Located at the bottom of the screen, this toolbar contains the
navigational controls you use to display the next or previous page, the first or last page, or
to display a specific page.
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The following image provides an example of a report with On-Demand Paging.

Procedure: How to Enable On-Demand Paging in a Report Canvas

1. Create a report with HTML as the output type. (This is the default.)

2. On the Format tab, in the Navigation group, click On-Demand Paging.

3. Run the report.

On-demand paging delivers the first page of the report output to the browser and holds the
remaining pages on the server disk. A page of report output is determined by the Margins,
Report Page, and Page Type selections on the Page Setup group of the Layout tab.

Procedure: How to Use the On-Demand Paging Toolbar

The On-Demand Paging Toolbar offers you several ways to view pages in your report or search
for a string of text.

To display a specific page:

1. Enter a page number in the Page field.

2. Click the Go to Page button.
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To display the previous or next page in the sequence, click the Previous or Next arrow
button.

To display the first or last page of the report, click the First Page or the Last Page button.

To download the entire report to your browser as a single document, click the All Pages
button.

Your browser displays the entire report without the On-Demand Paging toolbar. You can
return to viewing a single page of your report by clicking the Back button on your browser
toolbar.

To search for string of text or numbers:

1. Enter or paste the string into the Search field.

2. Click the Find button.

To match the case of your search text, click the Match Case button. The default setting is
unmatched.

To change the direction of your search, click the Search Direction button. The default
setting is forward.
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Working With Auto Drill & Analysis Functionality

This section describes the functionality for Auto Drill & Analysis.

Auto Drill and Analysis

OLAP Options

Disable. OLAP options are disabled and not shown in the OLAP report. By default,
the Enable OLAP option is set to Disabled.

Off. Turns off the OLAP Control Panel and the OLAP Selections pane, but allows
OLAP functionality from the report itself. You can access options on right-click
menus, drag columns within the report, and use up and down arrows to sort
columns from high-to-low or vice versa.

On. Provides access to the OLAP Selections pane from a square button to the left
of the column titles. You can open the Control Panel by clicking the OLAP button in
the OLAP report.

Top Panel. Opens the OLAP Selections pane above the report. The Measures,
Graph, and Dimension controls, the band containing the OLAP, Run, and Reset
buttons appear above the report output. You can open the Control Panel by clicking
the OLAP button on the Selection pane.

Bottom Panel. Opens the OLAP Selections pane below the report. The Measures,
Graph, and Dimension controls, the band containing the OLAP, Run, and Reset
buttons appear below the report output. You can open the Control Panel by clicking
the OLAP button on the Selection pane.

Hidden Panel. Opens the OLAP report with the OLAP Selections pane hidden. You
can perform a variety of analytic tasks from the report itself. Selection Criteria is
shown next to the OLAP button.

Show Tabbed. For OLAP reports that have multiple dimensions, this option groups
the dimension elements under a tab labeled with the dimension name.

Auto Drill Options

Automatic Drill Down controls access to automatic drill downs in a report:

None. Disables automatic drill downs. By default, the Automatic Drill Down option
is to None.

Dimensions. Enables automatic drill downs on dimensions in a report.
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Dimensions and Measures. Enables automatic drill downs on dimensions and
measures in a report.

Working With the Features Group Commands

Options in the Features group enable to you control the appearance of pop-up descriptions,
whether a report is an Accordion Report, whether to repeat a sorted value, whether to use
special active report options, and if accessibility options are on. The Features group is shown
in the following image.

The commands are:

Popup Description

Enables the display of pop-up field descriptions for columns in your report. You can select
On or Off. The default is <not set>. For more information, see Displaying Pop-up Field
Descriptions for Column Titles on page 354.

Accordion Report

Changes a report to an Accordion Report. You can select On or Off. The default is <not
set>. Accordion reports provide a way to control the amount of sorted data that appears on
an HTML report page. You can produce reports with expandable views of data for each
vertical sort field. When an Accordion Report first appears, only data values of the first
(highest-level) vertical sort field are shown. All other data is hidden. You can manually
expand your view to expose data values of lower-level sort fields. For more information,
see Controlling the Display of Sorted Data With Accordion Reports on page 355.

Repeat Sort Value

Displays all repeated sort values instead of blanks in the output after the first instance of
a new sort value, which is the default behavior. You can select On or Off. The default is
<not set>. For more information, see How to Use the Repeat Sort Value Option on page
356.

Lines per Page

Determines how many lines are displayed on each report page. Options are 10, 20, 30,
40, 50, and Show All. The default is 20. For more information, see How to Use the Lines
per Page Option on page 357.
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Accessibility

Offers options that help users with disabilities to interact with the report.

Mailing Labels

Opens the Mailing Label Options dialog box, which allows you customize the layout,
dimensions, spacing, and print order of your mailing label. This option is only available for
PDF and PostScript reports.

For more information, see Customizing Mailing Labels Using the Mailing Labels Options
Dialog Box on page 357.

Displaying Pop-up Field Descriptions for Column Titles

You can have pop-up field descriptions display in an HTML report when the mouse pointer is
positioned over column titles. Field description text displays in a pop-up box near the column
title using the default font for the report.

Note: Pop-up Field Descriptions are available for HTML Web Document (HTML), HTML Table
(HTMTABLE), Default, and User styled report formats.

The pop-up text displayed for a column title is defined by the Description attribute in the
Master File for the corresponding field. If a column title has no Description entry in the Master
File, then no pop-up box is generated when your mouse is positioned over the title.

The following procedure provides information on displaying pop-up descriptions in an HTML
report.

Procedure: How to Display Pop-up Field Descriptions in an HTML Report

1. Open a report in App Studio.

2. On the Format tab, in the Features group, click Popup Desc.

The selection menu displays.

3. Select one of the following options:

On. Turns Pop-up Field Descriptions on.

Off. Turns Pop-up Field Descriptions off.

<not set>. Indicates that a value has not been set for Pop-up Field Descriptions. This is
the default value.
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Controlling the Display of Sorted Data With Accordion Reports

Accordion Reports provide a way to control the amount of sorted data that appears on an
HTML report page. You can produce reports with expandable views of data for each vertical
sort field. When an Accordion Report first appears, only data values of the first (highest-level)
vertical sort field are shown. All other data is hidden. You can manually expand your view to
expose data values of lower-level sort fields.

When you create an Accordion Report, a plus sign (+) appears to the left of each data value in
the column under the highest-level sort heading. For data associated with lower-level sort
fields, a plus sign (+) is placed to the left of each data value, but the data does not appear
unless manually expanded. Data values of the lowest-level sort field are not expandable.

To expand your view of data for any expandable sort field, click a plus sign (+) and all data
associated with the next lower-level sort field appears. When you expand a data value under
the next to lowest sort heading, all of the remaining associated data values in the report
appear.

Note: Two vertical (BY) sort fields are required. If your report does not contain two vertical sort
fields, then the Accordion Reports option is ignored and a standard HTML report is created.

The use of horizontal (ACROSS) sort fields is supported with Accordion Reports. The horizontal
sort headings that appear above vertical sort headings in a standard HTML report are not
displayed in an Accordion Report until at least one sorted data value has been manually
expanded in each expandable sort column.

PDF and Excel formats are not supported with Accordion Reports.

Reference: Requirements for Accordion Reports

The following requirements must be taken into consideration when creating Accordion Reports:

Adding a drill-down link to an Accordion Report requires that the TARGET parameter must be
set to a value that specifies a new HTML frame.

Once an Accordion Report is created and delivered to the user, there are no subsequent
calls to the WebFOCUS Reporting Server required when the user is interacting with the
report. However, the collapsible folder controls on the sort fields require JavaScript and
images that reside on the WebFOCUS Client. The user must be connected to the
WebFOCUS web tier components in order to use this feature. For online connected users of
WebFOCUS, no change is required to the report.
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Procedure: How to Create an Accordion Report

1. Create a report in the Report canvas using the GGSALES Master File. 

2. In the Report canvas main window, add the following fields:

UNITS, ST, DOLLARS, CITY, REGION, CATEGORY

3. Highlight the UNITS and DOLLARS fields and Sum these fields.

4. Highlight the ST, CITY, and CATEGORY fields and make them By fields.

5. On the Format tab, in the Features group, select Accordion Report.

Note: Accordion Reports are available for HTML Web Document (HTML), HTML Table
(HTMTABLE), Default, and User styled report formats.

6. Select one of the following options:

On to turn on Accordion reports.

Off to turn off the feature and display the Accordion report.

<not set> to indicate no choice.

Note: The default value is <not set>.

Procedure: How to Use the Repeat Sort Value Option

The Repeat Sort Value option enables you to choose to display all repeated sort values in the
output after the first instance of a new sort value.

1. Open an existing report or create a new one that has at least one sort parameter specified
in a Where clause.

2. In the Features group of the Format tab, select Repeat Sort Value.

3. Select one of the following options:

On to turn on the Repeat Sort Value option and display all the repeated sort values
after the first instance.

Off to turn off the Repeat Sort Value option and display blanks instead of repeated sort
values.

<not set> to indicate no choice.

Note: The default value is <not set> and is the same as selecting No.
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Procedure: How to Use the Lines per Page Option

The Lines per Page option allows you to adjust the number of lines displayed on a single page.

1. Open an existing report or create a new one using the Report Wizard.

2. In the Features group of the Format tab, select the Lines per Page drop-down list.

3. Select the number of lines you want displayed. The options are 10, 20, 30, 40, 50 or
Show All.

Note: The default value is 57.

Customizing Mailing Labels Using the Mailing Labels Options Dialog Box

You can use the Mailing Labels Options dialog box to customize the settings for your mailing
label. You can customize the layout, dimensions, spacing, and print order of your label.

Label type

None. Removes all label settings in the cascading style sheet.

Custom label. Enables you to specify custom label settings.

All other preset label types automatically load the appropriate settings into the
cascading style sheet.

Label layout

Sets the number of rows and columns for the labels.

Label dimensions

Determines the height and width of each label.

Label spacing

Determines the amount of horizontal and vertical spacing between each label (in the
current units of measure).

Print order

Determines whether the data output flows down a column or across a row.

Down. Labels are printed top-to-bottom and moves left-to-right until each column is
filled.

Across. Labels are printed left-to-right and then moves down until all rows are
complete.
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Manipulating Mathematical Data Using the Data Tab

You use the options on the Data tab to manipulate mathematical data in a report. 

This tab contains the Calculation, Forecast, and Guided Reports groups. The Data tab is
located at the top of the App Studio interface. It is only available when you are creating a
report. The Data tab is shown in the following image.

Creating Computations Using the Calculation Group

You can use the options in the Calculation group to include temporary calculated values or
computations in your report. A temporary calculation field is a computed field whose value is
not stored in the data source, but is calculated from the data that is there, or assigned an
absolute value. A temporary field takes up no storage space in the data source, and is created
only when needed. 

When you create a temporary field, you determine its value by writing an expression. You can
combine fields, constants, and operators in an expression to produce a single value. For
example, if your data contains salary and deduction amounts, you can calculate the ratio of
deductions to salaries using the following expression: deduction/salary.

You can specify the expression yourself, or you can use one of the many supplied functions
that perform specific calculations or manipulations. In addition, you can use expressions and
functions as building blocks for more complex expressions, as well as use one temporary field
to evaluate another.

Choose a calculated value when you want to:

Evaluate the temporary field using total values or prefix operators (which operate on total
values). You cannot use a virtual field, since it is evaluated before any totaling takes place.

Evaluate the temporary field using fields from different paths in the data structure. You
cannot use a virtual field, since it is evaluated before the relationship between data in the
different paths is established.
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The Calculation group is shown in the following image.

The commands are:

Summary (Compute)

A calculated value (COMPUTE) is evaluated after all of the data that meets the selection
criteria is retrieved, sorted, and summed. Therefore, the calculation is performed using the
aggregated values of the fields. Calculated values are available only for the specified
report request. You specify the COMPUTE command in the body of the report request,
following the display command and optionally, introduced by AND. You can compute more
than one field with a single COMPUTE command.

The Computed Field Creator (COMPUTE) dialog box allows you to create a computed field,
type a name for the field, and enter a format. The Field List provides similar functionality,
including options to display data source fields in a Logical, List, or Structured view. You
can also view a complete set of functions, instead of data source fields, by clicking the
Functions button. Using the Options button allows you to specify how missing values are
handled. For details, see How to Create Computed Fields on page 359.

Across Compute

Opens the Across Compute dialog box, where you can create a calculated value to be used
in a report. You can open the Field List which provides similar functionality, including
options to display data source fields in a Logical, List, or Structured view. You can also
view a complete set of functions, instead of data source fields, by clicking the Functions
button. For details, see How to Use the Across Compute Option on page 360.

Note: An Across Compute can only be applied to an Across field. For example, if Sort
Across is indicated on the Field tab, you can then apply an Across Compute to that field.

Procedure: How to Create Computed Fields

1. Open an existing report or create a new report.

2. Click the Summary (Compute) option on the Data tab in the Calculations group.

The Computed Field Creator dialog box opens.

3. Enter a name in the Computed Field Name field.
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4. Click Format.

The Format dialog box opens.

5. Select the formatting options you want to apply to this calculation and click OK.

The entry in the Format field reflects any changes you made.

6. Click Options to enable or disable the display of missing values for a COMPUTE field.

The Override Missing Values Handling check box allows you to determine how missing
values are displayed.

7. Build an expression in the expression box.

Double-click fields from the Fields List to add them to the expression.

Use the calculator buttons under the expressions window to provide numbers and
operators in the expression.

8. Use the Functions button to open the Function Arguments dialog box which enables you to
view a complete set of functions that can be selected for this computation.

The Select a category drop-down list provides the category for the new function.

The Select a function list box lets you choose the type of function you want to create.

Field descriptions and the appropriate fields are displayed for each function.

Click OK when all selections are made.

9. Click OK to close the Computed Field Creator dialog box.

Procedure: How to Use the Across Compute Option

1. Open an existing report or create a new one.

2. Click the Across Compute option on the Data tab in the Calculations group.

The Across Compute dialog box opens.

3. Select a Field using the drop-down arrow or click the Fields button to display the available
fields in the Insert Field dialog box.

4. Build an expression in the expression box.

Double-click fields from the Fields List to add them to the expression.

Use the calculator buttons under the expressions window to provide numbers and
operators in the expression.

5. Click Format.
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The Format dialog box opens.

6. Select the formatting options you want to apply to this calculation and click OK.

The entry in the Format field reflects any changes you made.

7. Use the Functions button to open the Function Arguments dialog box which enables you to
view a complete set of functions that can be selected for this computation.

The Select a category drop-down list provides the category for the new function.

The Select a function list box lets you choose the type of function you want to create.

Field descriptions and the appropriate fields are displayed for each function.

Click OK when all selections are made.

8. Click OK to close the Across Compute dialog box.

Calculating Data Trends Using the Forecast Group

You can calculate trends in numeric data and predict values beyond the range of those stored
in the data source by using the Forecast feature. The Forecast group is shown in the following
image. 

For more information on Forecasting, see Overview of Forecasting on page 361.

The command is:

Forecast

Opens the Forecast dialog box, where you can calculate trends in numeric data and predict
values beyond the range of values stored in the data source. You can also add a Forecast
column to the report. For more information, see How to Calculate a Simple Moving Average
on page 362.

Overview of Forecasting

You can calculate trends in numeric data and predict values beyond the range of those stored
in the data source by using the Forecast feature. 
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The calculations you can make to identify trends and forecast values are:

Simple Moving Average. Calculates a series of arithmetic means using a specified number
of values from a field.

Exponential moving average. Calculates a weighted average between the previously
calculated value of the average and the next data point. There are three methods for using
an exponential moving average:

Single Exponential Smoothing. Calculates an average that allows you to choose
weights to apply to newer and older values.

Double Exponential Smoothing. Accounts for the tendency of data to either increase or
decrease over time without repeating.

Triple Exponential Smoothing. Accounts for the tendency of data to repeat itself in
intervals over time.

Linear Regression Analysis. Derives the coefficients of a straight line that best fits the
data points and uses this linear equation to estimate values.

When predicting values in addition to calculating trends, Forecast continues the same
calculations beyond the data points by using the generated trend values as new data points.
For the linear regression technique, the calculated regression equation is used to derive trend
and predicted values.

Forecast performs the calculations based on the data provided, but decisions about their use
and reliability are the responsibility of the user. Therefore, Forecast predictions are not always
reliable, and many factors determine how accurate a prediction will be.

Conditional Formatting

You can create conditional formatting and data visualizations for forecast data. This makes it
easy to distinguish between actual and forecast values in a column. For more information, see 
How to Set Conditional Styling for Forecast Data on page 363 or How to Set Data Visualizations
for Forecast Data on page 364.

Procedure: How to Calculate a Simple Moving Average

1. Select the By and Across fields that you want to use for your calculations.

2. On the Data tab, in the Forecast group, click Forecast. 

The Forecast dialog box opens.

3. If you want to change the name of the output field that displays the Forecasted values,
edit the default name that exists in the Field Name field.
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4. Select Moving Average from the Step 1: Choose a Method drop-down list.

5. Select an input measure field from the Step 2: Choose a Measure drop-down list.

If you select the same field as the By or Across field, this field will not appear in the
output even if it is included in a display command.

6. Select the increment number to count each instance of the By or Across field from the
Step 3: Choose The Interval field.

7. Select the number of predictions to be calculated for the Forecast field from the Step 4:
Choose Number of Predictions field.

8. Select the number of values to average from the Step 5: Choose Number Of Values to
Average field.

9. Optionally, change the default field format by clicking the Change Format button and
selecting a different format from the Format dialog box.

10. Click OK.

Procedure: How to Set Conditional Styling for Forecast Data

This procedure shows how you can use the Traffic Lights feature to set styling in your report for
forecast data.

1. Open a report that contains one or more columns of forecast data.

2. Click in the data area of a forecast column.

The Field and Appearance tabs open.

3. On the Appearance tab, in the Display group, click Forecast from the Traffic Lights drop-
down menu.

4. In the Style group, click Data Only from the Scope drop-down.

5. In the Style group, click the Color button.

The Color dialog box opens.

6. Click a color, for example, red.

This means that forecast data will appear in red and actual data will appear in the default
black.

Apply other style attributes from the Style group as needed to visually distinguish your
forecast data.

Note: In cases where you have multiple forecasts in a report, all forecasts will appear with
the same styling that you specify in this procedure.

7. Save and run the report.
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Procedure: How to Set Data Visualizations for Forecast Data

This procedure shows how you can use the Traffic Lights and Data Bars features to set data
visualizations in your report for forecast data.

1. Open a report that contains one or more columns of forecast data.

2. Click in the data area of a forecast column.

The Appearance tab opens.

3. In the Display group, click Forecast from the Traffic Lights drop-down menu.

4. In the Display group, click Data Bars.

The Data Visualization dialog box opens.

5. Click Visualize.

The Conditional Styling button becomes active.

6. Click Conditional Styling.

The Data Visualization Conditional Styling dialog box opens.

7. Click Forecast.

8. In the Forecast area, specify the desired visualization and click OK.

You are returned to the Data Visualization dialog box.

9. Click OK.

10. Save and run the report.

Note: The Data Visualization Conditional Styling dialog box allows you to remove a
Forecast data visualization after it has been saved. However, if you click Remove, it will
also remove any conditional styling that you applied to the forecast. In this case, you
would need to reset the conditional styling after the data visualization has been removed.

Creating a Parameterized Report Using the Guided Reports Group

A Guided Report is a highly parameterized report that allows you to select fields and options
that participate in a report at run time. Fields and options that have been added to the Guided
Report are displayed in controls and are available for selection. Selecting fields from controls
and running the report will display the data that correlates to the field values. For more
information, see Overview of Guided Reports on page 365. 
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You use the options in the Guided Reports group to generate and delete parameter groups.
The Guided Reports group is shown in the following image.

The commands are:

Generate Parameter Group

Generates a parameter group from the selected column or columns. It opens a drop-down
menu that has the One variable for each selected column and One variable for all selected
columns options. One variable for each selected column creates one control for every
selected column with all the selected field names as values. One variable for all selected
columns creates one control for all selected columns with all the selected field names as
values. For more information, see How to Generate a Parameter Group for One or More
Columns on page 366.

Remove from Parameter Group

Removes a column or columns from the parameter group. This command is available only
when the selected columns are part of a parameter group. For more information, see How
to Remove One or More Columns from a Parameter Group on page 366.

Overview of Guided Reports

A Guided Report is a highly parameterized report that allows you to select fields and options
that participate in a report at run time. 

Fields and options that have been added to the Guided Report are displayed in controls and
are available for selection. Selecting fields from controls and running the report will display the
data that correlates to the field values.

The advantage of using a Guided Report is that you can create one streamlined, highly
parameterized report, and from that one report, you can generate thousands of different report
outputs at run time. It requires no knowledge of code to customize the final report with the
data you want displayed.
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Procedure: How to Generate a Parameter Group for One or More Columns

You use this procedure to assign one or more columns to a Parameter Group with either a
unique or common variable. 

1. Create a report with multiple columns.

2. Select the column or columns to include in the Parameter Group.

3. On the Data tab in the Guided Reports group, click Generate Parameter Group.

4. Select one of the following options:

One variable for each selected column. Assigns a unique variable to each column.

One variable for all selected columns. Generates one unique variable for all selected
columns.

Note: To reverse a parameter group assignment, you can press Ctrl-Z, provided that this is
immediately following the assignment and no other action has taken place on the canvas.

Procedure: How to Remove One or More Columns from a Parameter Group

You use this procedure to remove one or more columns from a Parameter Group assignment.

1. Open or create a report with multiple columns.

2. Review the Parameter Group assignment.

Note: Parameter Group assignments are indicated by an ampersand (&) in the top-left to
signify that it is a member of a parameter group. If multiple variables were indicated, each
column icon will have a different color scheme. For example, COLUMN1 may have a blue
background with a yellow ampersand (&) and COLUMN2 may have a blue background with
a white ampersand (&). The color scheme varies depending on how the Parameter Groups
were assigned (one variable for each selected column or one variable for all selected
columns).

3. Select the column or columns for which you want to remove the Parameter group
assignment.

4. On the Data tab in the Guided Reports group, click Remove from Parameter Group.
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Controlling the Page Properties of a Report Using the Layout Tab

You can control the page properties of a report using the functionality available on the Layout
tab. You can change the margin size, page layout, type of material the report will be printed on,
the unit of measurement the report uses, page numbering, cell padding, and whether to autofit
columns. The Layout tab is located at the top of the App Studio interface. It is available only
when you are creating a report. The Layout tab is shown in the following image. 

Changing the Page Properties Using the Page Setup Group

You can change the margins, orientation, paper type, unit of measurement, and page
numbering of a report. The Page Setup group is shown in the following image.

The commands are:

Margins

Changes the margin dimensions. You can change the margin dimensions using the
Custom option or use one of the other four preset margin types, Normal, Narrow,
Moderate, or Wide. Selecting Custom opens the Margins dialog box, where you can set
each margin value.

Report Page

Changes the orientation of the report page. You can select Landscape or accept the
default, Portrait.

Paper Type

Displays a list of paper types and media outlets for the report output.

Units

Displays the unit of measurement in inches, centimeters, or points.
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Page Numbering

Adds page numbering or removes lead space. You can select On, Off, or OFF without lead
space. Select On to turn page numbering on. Select Off to turn page numbering off. Select
OFF without lead space to turn off page numbering and the two leading blank lines on each
page.

Applying Cell Padding Using the Report Group

You can change the way that columns are shown. The Report group is shown in the following
image.

The commands are:

Cell Padding

Edits the space between the gap values in the cascading style sheet. The cell padding
displays values that indicate the top, left, bottom, and right margins. The values increment
by 1/100 of an inch. For more information, see How to Access the Cell Padding Dialog Box
on page 368.

Procedure: How to Access the Cell Padding Dialog Box

1. On the Layout tab, in the Report group, click Cell Padding.

The Cell Padding dialog box displays.

2. Enter values for Top, Bottom, Left, and Right.

Note: Values increment by 1/100 of an inch.

3. Click OK.
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Applying Data or Field View Preferences Using the View Tab

You use the View tab to change the way that you view your data or fields. The View tab is
shown in the following image. 

Changing the Data or Field View Using the Object Inspector Group

You can change the way that you view your data or fields. When a command is used on the
Object Inspector group, that same option is respected on the Object Inspector shortcut menu.
The Object Inspector group is shown in the following image.

The command types are:

Dimension View

Enables you to view the hierarchical structure of the data if there is a dimension view
defined in the Master File. Options include No Extended Information, Alias, Title, and
Description. The default is No Extended Information.

List View

Enables you to view fields in a list. You can select one or more field categories to view,
including Sort Field List, Name, Alias, Title, Description, Format, and Type. Name and
Description are selected by default.

Tree View

Enables you to view fields by type in a tree showing the relationship between the
segments. Options include No Extended Information, Alias, Title, and Description. The
default selection is No Extended Information.

Show Qualified Fields

Enables you to display any list of field names as qualified field names, which includes data
sources and table names.
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Field Details Section

Enables you to display the field details section in the Object Inspector.

For more information, see Creating Metadata on page 133.

Displaying and Hiding View Components Using the General Group

Allows you to display boundaries, test data, tooltips, invisible fields, and the ruler. The General
group is shown in the following image.

Boundaries

Enables you to show or hide the boundaries for report objects, such as headings and
footings.

Test Data

Enables you to display test data in design mode.

Show Field Tooltips

Enables you to display tooltips.

Show Invisible Fields

Enables you to display hidden fields.

Show Ruler

Enables you to display the standard ruler at the top of the Report canvas.
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Limiting the Field Length of Data Using the Field Length Group

Allows you to edit the amount of data displayed by a field. The Field Length group is shown in
the following image.

Limit Field Lengths

Enables you to limit the length of data displayed by a field at design time.

Field Limit Length

Enables you to set the maximum length of a field in your report. This option is only
available when Limit Field Lengths is selected.

Specifying the Number of Test Data Instances Using the Repetitions Group

Allows you to edit the amount of data displayed by a field. The Repetitions group is shown in
the following image.

Repetitions

Enables you to specify the number of test data instances that appear for a field. The
default value is 2. You can select 1, 2, or 3.

4. Creating Reports

WebFOCUS App Studio User’s Manual  371



Specifying the Size of the Report Canvas Using the Zoom Group

Allows you to edit the amount of data displayed by a field. The Zoom group is shown in the
following image.

Zoom

Enables you to specify the size (magnification/scale) of the Report canvas. For example,
100%, 75%, 50%, or 25%. The default value is 100%.

Viewing Report-Generated SQL Using the SQL Group

Allows you to view the SQL code your report generates. The SQL group is shown in the
following image.

View Generated SQL

Allows you to view the SQL code generated by your report in a separate viewer. This
command in only available if you are creating a report using an RDBMS data source.

Determining Report Space in an HTML Page Using the Virtual Screen Size Group

The Virtual Screen size group lets you set how much space the report will occupy when
displayed in an HTML page. The Virtual Screen Size group is shown in the following image.

Width

Sets the width your report will occupy when displayed in an HTML page.
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Height

Sets the height your report will occupy when displayed in an HTML page.

Adding or Editing Images in a Report Using the Images Tab

You use the Images tab to add images to your report or edit images that are already inserted
into your report. The Images tab is shown in the following image. 

Inserting a New Image in a Report Using the New Image Group

Allows you to insert a new image into your report. The New Image group is shown in the
following image.

File

Enables you to select an image file to insert into your report.

Field

Inserts a new image into your report by using a field that specifies the image file name.
This option is enabled if the image is placed in an alpha-numeric field in a header or
footer. The app path must contain an image that has the same name as a value in the
field. That image will be available to be selected when the Field button is clicked.
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Managing a Selected Image Using the Current Image Group

Allows you to select a specific image, delete an image, make an image a drill down, change
the location of the selected image, and add a pop-up description to the selected image. This
group is unavailable if there is no image in your report. The Current Image group is shown in
the following image.

Image

Displays the name of the selected image. You can change the selected image by clicking
the arrow and selecting the image name.

Delete

Deletes the selected image.

Drill Down

Opens the Drill-down dialog box, where you can make your image a drill-down procedure or
a hyperlink to a URL.

Image Location

Displays where the image is located. You can click the arrow to change the image location
to either the page or the background.

Popup Desc.

Displays the pop-up description for an image.
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Changing the Position of an Image in a Report Using the Position Group

Allows you to change the horizontal and vertical position of the selected image. The Position
group is shown in the following image.

X

Displays the horizontal position of the selected image.

Y

Displays the vertical position of the selected image.

Specifying Image Size Using the Size Group

Allows you specify whether the selected image will have a set size or custom size. The Size
group is shown in the following image.

Custom Size

Allows you to select whether the image will have a set size or a custom size. When
selected, you can enter values into the Width and Height fields.

Width

Specifies the width of the selected image. This field is unavailable when Custom Size is
not selected.

Height

Specifies the height of the selected image. This field is unavailable when Custom Size is
not selected.
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Setting Options for a Selected Image Using the Options Group

Allows you to set various options pertaining to the selected image. The Options group is shown
in the following image.

Line Break

Adds a line break after the selected image, when selected.

Include As Reference

Includes the current image as a reference, when selected.

Preserve Ratio

Keeps the aspect ratio of the selected image.

Show Images in Design View

Shows images when in Design view. This option is selected, by default.

Setting Field Preferences Using the Field Tab

You use the Field tab to change the field type, filter specific fields, sort data in fields, and style
the titles and data of a field. The Field tab is located at the top of the App Studio interface. It
is accessible only when a field is selected on the Report canvas. The Field tab is shown in the
following image. 
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Specifying the Type of Field Using the Column Type Group

You can change the field type of a selected field. The Column Type group is shown in the
following image.

The command types are:

Detail

Changes the field type of the selected field to Detail.

Aggregate

Changes the field type of the selected field to Aggregate.

Sort Down

Changes the field type of the selected field to Sort Down.

Sort Across

Changes the field type of the selected field to Sort Across.

For Row

Changes the field type of the selected field to For Row.

Delete

Deletes the selected field or column.

The Report canvas uses smart context functionality to determine what column type a field
should be, given the metadata of the field and/or the position of the field on the canvas.

If smart context is on, and the metadata indicates that a field should be a measure or
dimension, when you add that field to the canvas, it will automatically be added as an
aggregate or sort down field type, respectively.

If smart context is on, but the metadata does not indicate whether a field is a measure or
dimension, then alphanumeric fields and date fields are added as BY fields, while numeric
fields are added as SUM fields.

If smart context is off, all fields are added as DETAIL fields.
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If smart context is on, and you try to add a numeric field between two alphanumeric fields, a
message will appear, prompting you to either add the field as a sort or an aggregate. If you try
to add an alphanumeric field between two numeric fields, a message will also appear,
prompting you to either add the field as a COUNT or as an aggregate.

Applying a Filter to a Field Using the Filter Group

You can filter fields when creating a report. The Filter group is shown in the following image. 

The commands are:

Filter

Filters fields using Where, If, Where Total, and Limits screening options. You can access
the Expression Builder by selecting Where, If, or Where Total from the Filter drop-down list.

Using the Expression Builder, you can create expressions quickly by selecting fields,
relations, operators, and values from lists. You can base selection criteria on a specified
value, a variable value, or a field value. For more information, see Creating Expressions
Using the Expression Builder on page 304.

If you select Limits, the Retrieval Limits dialog box opens where you can set the Record
Limit and Read Limit values. This enables you to set how much data is shown or
previewed.

Sorting, Ranking, and Limiting Data Using the Sort Group

You can sort data, rank data, or limit the amount of data shown. These options are enabled
only when Sort Down is selected in the Column Type group. If Sort Across is selected, the
options for Up and Down are available. The Sort group is shown in the following image. 
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The commands are:

Up

Sorts column data from lowest to highest value. If the values were alphabetical, this option
would place the columns in alphabetical order.

Down

Sorts column data from highest to lowest value. If the values were alphabetical, this option
would place the columns in reverse alphabetical order.

Variable

Enables the user to select the sort order at run time.

Rank

Allows you to enable or disable numeric ranking for the selected column. This is
particularly useful when sorting a report vertically.

Hierarchy

Sorts and formats a hierarchy, showing the parent and child relationships.

Note: This option is only available when using a multidimensional data source.

Limit

Limits the number of sort values shown. The options are 5, 10, 15, None, and Variable.
When you use Limit with Up, the chosen number of lowest values is shown. When you use
Limit with Down, the chosen number of highest values is shown. Limit is available only
when the selected field is a By field.

Specifying Sort Field Break Options Using the Break Group

You can add a page break, line break, subheading or subfooting, and subtotal columns. You
can also recompute calculated values and recap calculated values. The Break group is shown
in the following image.
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The commands are:

Page Break

Starts a new report page when the value of a selected sort field changes. Options include
On, Off, Variable, or Restart Page Numbering. The default value is Off.

No Split

Breaks sort fields logically and regenerates the field heading on the next page or screen.
Options include On, Off, or Variable. The default value is Off.

Line Break

Inserts a line break at a specified point in the report. The options are On, Off, or Variable.
The default value is Off.

Fold Line

Causes columns to be placed on a separate line when the value of the sort field changes.
This feature is not supported for HTML styled report formats. Click Variable to make the
option a parameter whose value is prompted for at run time. Click the ampersand (&) to
change the parameter name suffix, display text, order of values, and display or return
values.

Skip Line

Skips a line on a report when the value of the selected sort field changes. To apply this
action in HTML styled report formats, ensure that a cascading style sheet is selected.
Click Variable to make the option a parameter whose value is prompted for at run time.
Click the ampersand (&) to change the parameter name suffix, display text, order of
values, and display or return values.

Subtotal

Adds a subtotal for the selected column or on all outer sort fields. The options are Apply to
selected column or Apply to all outer sort fields. The Layout tab appears, where you can
modify the Page Setup.

Subheader

Inserts a subheader for the selected column into the report. The Layout tab appears,
where you can modify the Page Setup.

Subfooter

Adds a subfooter for the selected column into the report. The Layout tab appears, where
you can modify the Page Setup.
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Recompute

Recalculates totals for the selected column or on all outer sort fields. Recalculates only at
the specified sort break, similar to Subtotal.

Recap

Creates subtotal values in a calculation for the selected column.

Accessing the Field Properties Dialog Box

The Field Properties dialog box contains options that pertain to the selected field. You can
access the Field Properties dialog box by using the shortcut menu of a field, on the Report
canvas, and clicking Options. You can also access the Field Properties dialog box by double-
clicking a field on the Report canvas.

Reference: Field Properties General Tab

Select a Detail or Aggregate field on the Report canvas and click Options from the shortcut
menu to open the Field Properties dialog box at the General tab.

Output

New Line (OVER) places field names over one another. This is one way to decrease the
width of a report, particularly when you are sorting horizontally (Across).

Within

Select a WITHIN phrase, which requires a BY phrase and/or an ACROSS phrase. A
maximum of two WITHIN phrases can be used per display command.

First Within (BY)

Select a first WITHIN phrase.

Second Within (ACROSS)

Select a second WITHIN phrase, if necessary.

Reference: Field Properties Sort Tab

Select a Sort By field on the Report canvas and click Options from the shortcut menu to open
the Field Properties dialog box at the Sort tab. 
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Sorting Tab

The sorting tab contains options for how to sort the selected field data.

Current Sort Statement

Reflects the sort conditions that are in effect.

Sort Limit

Limits the number of sort values to display.

Subtotal others

Subtotals the items selected.

Title

The title of the limit item.

Total

These options pertain to the total of an item.

On. Calculates and displays the total.

Off Does not calculate or display the total. This is the default option.

Variable. Makes the option a parameter whose value is prompted for at run time.
Clicking the ampersand (&) button opens the Guided Variable Definition dialog box,
which enables you to change the parameter name suffix, display text, order of values,
and display or return values.

Sort Sequence

The Sort Sequence button opens the Sort Sequence Builder, which allows you to pull in
data from a field and customize sorting priorities.

Accessing Reporting Components

382  Information Builders



Grouping Tab

The Grouping tab is only available when you sort a report using a numeric sort field.

Current Sort Statement

Reflects the sort conditions that are in effect.

Grouping

None

No grouping option will be in effect. This is the default option.

IN-GROUPS-OF

Groups sort field values in specified increments.

IN-RANGES-OF

Defines the range by which sort field values are grouped.

Variable
Variable makes the option a parameter whose value is prompted for at run time. Click
the ampersand (&) button to open the Guided Variable Definition dialog box, which
enables you to change the parameter name suffix, display text, order of values, and
display or return values.

Range or Number of Tiles

Allows for a range of number tiles to be present with the grouping.

None is the default option.

Variable makes the option a parameter whose value is prompted for at run time. Click
the ampersand (&) button to open the Guided Variable Definition dialog box, which
enables you to change the parameter name suffix, display text, order of values, and
display or return values.

Limit

If specified, this value limits the number of groups of the specified interval to be retrieved.

On. Allows for a limit to be in place.

Off. Does not allow for a limit to be in place. This is the default option.
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Variable. Makes the option a parameter whose value is prompted for at run time. Click
the ampersand (&) button to open the Guided Variable Definition dialog box, which
enables you to change the parameter name suffix, display text, order of values, and
display or return values.

Highest Value

In order to use the Highest Value option, Limit must be set to On or Variable. This option
enables you set the highest value for the limit.

None is the default option.

Variable makes the option a parameter whose value is prompted for at run time. Click
the ampersand (&) button to open the Guided Variable Definition dialog box, which
enables you to change the parameter name suffix, display text, order of values, and
display or return values.

Tiles

Select this option to group numeric data into any number of tiles (percentiles, deciles,
quartiles, and so on). A new column, labeled TILE by default, is added to the report output
and displays the tile number assigned to each instance of the tile field.

Title

You may type in a unique title name.

You can combine these selections with the list of defined Actions.

Formatting and Styling Report Fields Using the Appearance Tab

You use the Appearance tab while creating or editing a report to filter specific fields, sort data
in a field, and style the titles and data of a field. The Appearance tab is located at the top of
the App Studio interface. It is only accessible when a field is selected on the Report canvas.
The Appearance tab is shown in the following image. 
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Styling Data, Titles, and Text Using the Style Group

You can style data, titles, and text of a selected field. The Style group is shown in the following
image.

This section details the Style group of the Appearance tab, which you can use to apply field-
level styles. The Style group also appears on the Reports tab, which you can use to apply
report-level styles. For more information, see Applying a Theme and Style to a Report Using the
Style Group on page 324.

The commands are:

Scope

Indicates whether style options apply to the data, title, or both.

Bold

Applies bold font formatting to the text or selected object.

Italic

Applies italic font formatting to the text or selected object.

Underline

Underlines the text or selected object.

No Underline

Do not display underlines, even for drilldowns.

Left

Aligns the text or selected object to the left.

Center

Aligns the text or selected object to the center.

Right

Aligns the text or selected object to the right.

Default

Applies the default alignment options. In this case, numerals are aligned to the left and
text is aligned to the right.
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Column Width

Sets column width options.

Copy Style

Copies the style of the selected object, enabling the Paste Style command.

Paste Style

Pastes your copied style settings to the selected field.

Match Style

Copies the specific style settings from one column to another.

Font Name

Changes typed or highlighted text to the selected font.

Font Size

Changes typed text or a selected object to the selected size.

Color

Changes typed text or a selected object to the selected color.

Background Color

Changes the background color. Opens the Color dialog box, where you can select the
background color.

Defaults

Resets the typed text or a selected object to the default style settings.

Borders

Turns borders and gridlines on or off.

Changing the Format of Numeric Detail Fields Using the Format Group

Use the tools in the Format group to change the formatting of numeric detail fields. For
example, you can add percentage signs to data and indicate currency (with or without
symbols). This group is unavailable when the format option or edit option for the selected field
are eight characters in length or attempt to go over eight characters in length.

Note: If you select Sort Down, Sort Across, or For Row, the options in the Format group will be
unavailable.
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The Format group is shown in the following image.

The commands are:

Currency

Adds a currency symbol in front of the field data. Enables the selection of a currency, for
example Floating Dollar or Fixed Euro. The symbol used is that of the currency selected. If
a Fixed currency is selected, no symbol appears. If a Floating currency is selected, the
currency symbol appears.

Percent

Adds a percentage symbol after the field data.

Comma

Enables the display of commas in the field data.

More Decimals

Increases the number of decimal positions shown.

Less Decimals

Decreases the number of decimal positions shown.

Managing Data Visualizations Using the Display Group

You can add a data visualization column to a report, display numeric data differently, and add
conditional styling. The Display group is shown in the following image. 
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The commands are:

Data Bars

Enable the Data Visualization dialog box, through which you can add a data visualization
column to the right of a selected numeric field. The column displays values in each row
using horizontal bars that extend from left to right in varying lengths, depending on the
corresponding data values. For more information, see Accessing the Data Visualization
Dialog Box on page 389.

Aggregation

Displays numeric data using a variety of aggregation types. Different aggregation types are
available depending on the field and the column type for that field. These aggregation
types are:

None

Sum

Average

Count

Count Distinct

Percent of Count

Distinct Values

First Value

Last Value

Minimum

Maximum

Total

Percent

Row Percent

Median

Mode

Average Square
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All

Traffic Lights

You use the Traffic Lights functionality to set styling and hyperlinks conditions. Adds
conditional styling or modifies existing conditional styling by applying colors to a field in the
output when the field meets specified criteria. Options include None, Forecast, or Add/Edit
Conditions. If you select Add/Edit Conditions, the selection option changes to Sorted Data.

To style a specific condition, select a condition and then use the Style group. This will only
style the condition you selected.

The styling you add to a condition appears as a preview in the Report canvas when you
select the condition in the Traffic Lights drop-down list box.

Hide Field

You can hide or show a selected field in the output. Fields added to a report or chart are
visible in the output by default. Options include On, Off, or Variable. The default value is
Off. When a data field is invisible, it appears on the Report canvas (dimmed) and is not
visible in the report output.

Note: An invisible column or field may be used in the report as part of a calculation, even
though it is set to invisible and will not display in the output.

Accessing the Data Visualization Dialog Box

You use the Data Visualization dialog box to define the data visualization bar graphs that
appear in your report.

If you are setting conditions to control the display of bar graphs, you use the Data Visualization
Conditional Styling dialog box instead of this one. 

The Data Visualization dialog box contains the following fields or options:

Visualize

Initiates the Data Visualization feature.

Color

Specifies the color of the bar graphs. Select a color from the drop-down list. Black is used
as the default color.

The color option is the default for HTML, PDF, and PS formats.

Pattern

Specifies the shading patterns for bar graphs. Select a shading pattern from the drop-down
list.
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This option is only available for PDF and PS formats to make graphs in black and white
reports more readable. If the report format is HTML, the Pattern option button is inactive
because the shading option is only available for PDF and PS formats.

Graphlook

Specifies how the graph looks. Select a look from the drop-down list.

Note: Graphlook Gauge or Quality do not support negative values. Use Bar Graphs instead.

Scale

Specifies the relative bar graph scaling for multiple report columns under a common
Across sort field to which you have applied data visualization.

Note: This option only appears when applied to the entire report.

Choose one of the following options from the Scale drop-down list:

Uniform

Specifies that each vertical bar graph be scaled based on the minimum and maximum
values of the entire set of values compiled from each Across column to which you
have applied data visualization bar graphs.

Distinct

Specifies that each vertical bar graph be scaled based on the distinct minimum and
maximum values for each Across column to which you have applied data visualization
bar graphs.

Maximum Length

Specifies the length of the longest bar graph.

Default. The default length of 60 pixels is used for a vertical bar graph and 80 pixels
for a horizontal bar graph.

Custom. Sets the value for displaying the vertical or horizontal bar graph for the
maximum data value in the associated report column. This value must be a positive
number.

This value is initially expressed in the current windows measurement units (inches,
centimeters), then converted into the corresponding number of pixels.

Width

Specifies the width of the bar graphs in a report.

Default. This value is preset based on the current font size.
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Custom. Sets the value for displaying the width of the bar graphs in a report. This
value must be a positive number.

This value is initially expressed in the current windows measurement units (inches,
centimeters), then converted into the corresponding number of pixels.

Default Values button

Resets all defaults.

Conditional Styling button 

Opens the Data Visualization Conditional Styling dialog box where you can define
conditions and colors for bar graphs.

Links Group

You can add a hyperlink or drill-down procedure to a selected field in a report. 

Note: The Links group also appears in the Report tab. For more information, see Creating Drill-
Down Hyperlinks using the Drill Down Command on page 338.

Showing or Hiding Columns in an Active Technologies Report Using the Active
Reports Group

You can choose to show or hide columns in an active report, as shown in the following image. 

Present Hidden

You can select which columns are hidden from view, in the report output, when using the
HTML active report output format.

Setting Active Technologies Report Options Using the Options Tab

You can change the options that apply to an active report. The active report Options tab is
located at the top of the App Studio interface and is accessible only when you have selected
an active report output. The active report Options tab is shown in the following image. 
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Changing the Paging of an Active Report Using the Active Cache Group

You can change the paging of a report and the number of rows retrieved. The active cache
group is shown in the following image. 

The commands are:

On-Demand Paging

When on-demand paging is enabled, the viewer displays one page of report output and
navigational controls. You use the navigational controls to change the report page that
appears in the viewer.

Your browser consists of two frames, the Report Frame and the Viewer Control Panel
frame. The Report Frame is the larger frame and contains one page of report output. When
you first run a report, the Report Frame contains the first page of report output.

The Viewer Control Panel frame contains the controls you use to navigate through the
report and to search for a string. The navigational controls allow you to display the next or
previous page, the first or last page, or to display a specific page. You use the searching
function to locate a page of the report that contains the search string you specify.

Rows Retrieved

Sets the number of rows displayed in the output. The default value is 100.

Setting a Password and Expiration Date of an Active Report Using the Viewing
Restrictions Group

You can set a password to access an active report, and set an expiration date so that an
active report is no longer viewable past that date. The Viewing Restrictions group is shown in
the following image.
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The commands are:

Password

Sets a password that must be entered to view the active report output.

It is a character string up to 32 characters in length. Only standard alphanumeric English
characters are allowed in the password for an active report in AHTML format. National
Language Support (NLS) characters are not allowed in the password. Any NLS character in
the password for an AHTML report makes the password invalid.

Expire

The date when an active report expires and the report output can no longer be viewed
(displayed).

Enter the expiration date in year, month, day (yymmdd) format or in day format (1-999
DAYS) where the value indicates the number of days from the current date that the report
expires. Valid values are 1 to 999 days. Note that you must enter the number and the
word DAYS as part of the value.

Setting Preferences for Calculations Using the Calculations Group

You can set the color, position, and options available for calculations. The Calculations group
is shown in the following image.

The commands are:

Calculation Options

Enables you to turn on calculations for fields in the report. All visible fields in the report
appear in the Column list in the order they appear in the report. Hidden fields do not
appear in the Column list.

You can select a calculation for each field in the Column list from the Calculations dialog
box. Calculation options are determined by the field type. If the field is in an alphanumeric
format, the drop-down list contains Count and Count Distinct. If the field is a numeric
format, the drop-down list contains Sum, Average, Count, Count Distinct, Minimum, and
Maximum.
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Values

Opens the Color dialog box, where you can set the color of calculation values.

Background

Opens the Color dialog box, where you can set the background color of calculations.

Top

Displays calculations at the top of the report.

Bottom

Displays calculations at the bottom of the report.

Setting Preferences for Legends Using the Legend Options Group

You can change the visibility, collapsibility, and position of the legend. The Legend Options
group is shown in the following image.

The commands are:

Fixed

Sets the legend to always be visible.

Collapsible

Sets the legend to be collapsible.

Bottom Left

Minimizes the legend and moves it to the bottom left.

Bottom Center

Minimizes the legend and moves it to the bottom center.

Bottom Right

Minimizes the legend and moves it to the bottom right.
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Setting Display Options for Multiple Reports Using the Window Display Group

You can display multiple reports differently. The Window Display group is shown in the following
image.

The commands are:

Default

View multiple reports with default windows.

Cascade

View multiple reports with cascading windows.

Tabs

View multiple reports in one window with a tab for each report.

Freezing Columns of a Report Using the Freeze Columns Group

You can freeze the selected column and all columns to the left of that column. The Freeze
Columns group is shown in the following image.

The command is:

Freeze columns
Freezes the report at a particular point so that columns to the left of the freeze point
remain in view while you scroll through the other report columns. You can select any of the
fields present on the Report canvas to freeze the report at that point, or you can select
None to turn off the Freeze option.

If the report can be fully viewed in the browser window, then freeze is not applied.

The Freeze columns option is not available for expandable report (Accordion) views.
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Setting Display Options for the Status Bar and Navigation Bar Using the Pagination
Group

You can set the location and color of the status bar and page navigation bar. You can also
specify whether or not to display these bars. The Pagination group is shown in the following
image. 

The commands are:

Top Left

Sets the record status bar and page navigation bar to display on the top left.

Top Center

Sets the record status bar and page navigation bar to display on the top center.

Top Right

Sets the record status bar and page navigation bar to display on the top right.

Bottom Left

Sets the record status bar and page navigation bar to display on the bottom left.

Bottom Center

Sets the record status bar and page navigation bar to display on the bottom center.

Bottom Right

Sets the record status bar and page navigation bar to display on the bottom right.

Off

Sets the record status bar and page navigation bar to not display.

Text

Sets the text color for the record status bar and page navigation bar. Opens the Color
dialog box.

Background

Sets the background color for the record status bar and page navigation bar. Opens the
Color dialog box.
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Designating Colors for Positive and Negative Values in a Report Using the Visualize
Group

You can apply data visualization to numeric fields in an active report. You can designate the
colors of the bars and set different colors for positive and negative values. The default color
for positive and negative values is black. The Visualize group is shown in the following image. 

The commands are:

Positive

Sets the color for positive numeric values. Opens the Color dialog box.

Negative

Sets the color for negative numeric values. Opens the Color dialog box.

Icons

Sets which icon set to use for your active report.

Setting the Color of a Row in a Report Using the Row Selection Group

You can set the color of a row of data when you pause the mouse pointer on the row or when
you select the row. The Row Selection group is shown in the following image. 

The commands are:

Hover

Sets the color of a row of data when you pause the mouse pointer on the row. Opens the
Color dialog box.

Selected

Sets the color of a row of data when you select that row. Opens the Color dialog box.

4. Creating Reports

WebFOCUS App Studio User’s Manual  397



Setting the Color of Menu Items in a Report Using the Menu Options Group

You can make specific options available in the active report and set the color of menu items.
Click the Launch button on the bottom of the Menu Options group to display the Customize
User Interactivity box. 

The options are:

Show Records

Adds pagination options when selected.

Filter

Adds filter options when selected.

Freeze

Adds freeze options when selected.

Calculations

Adds calculation options when selected.

Hide/Unhide

Adds hide options when selected.

Chart

Adds chart options when selected.

Export

Adds exportation options when selected.

Visualize

Adds visualization options when selected.

Sorting

Adds sorting options when selected.

Rollup

Adds rollup options when selected.

Pivot (Cross Tab)

Adds pivot options when selected.

Comments

Adds comment options when selected.
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Window Type

Adds window options when selected.

Restore Original

Adds restoration options when selected.

Send as Email

Adds email options when selected.

Save Changes

Adds save options when selected.

Print

Adds print options when selected.

Accordion

Adds accordion options when selected.

Advanced Tools

Adds tool options when selected.

Grid Tool

Adds grid options when selected.

Font Text

Sets the color of menu text. Opens the Color dialog box.

Font Hover

Sets the color of menu text when you pause the mouse pointer on menu text. Opens the
Color dialog box.

Menu Background

Sets the background color of menu text. Opens the Color dialog box.

Menu Hover

Sets the background color of menu items when you pause the mouse pointer on the menu
items. Opens the Color dialog box.

Menu Border

Sets the color of the border for menu text. Opens the Color dialog box.
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User Level

Sets predefined options for the following user levels:

Default. Enables all options listed above except Advanced Tools and Grid Tool.

Power. Enables all options listed above.

Analytical. Enables the following options: Show Records, Filter, Freeze, Calculations,
Hide/Unhide, Chart, Export, Visualize, Sorting, Window Type, Restore Original, Send as
Email, Save Changes, Accordion.

Business. Enables the following options: Show Records, Freeze, Calculations, Hide/
Unhide, Visualize, Sorting, Restore Original, Send as Email, Save Changes, Print.

Custom. If you select a combination of options that does not match one of the
predefined user levels (Default, Power, Analytical, Business), the name Custom appears
in the User Level field. This is not a default user type or a selectable user type. It is
used to show that options for this user do not match any of the predefined user levels.

Setting the Width and Height for an Active Report Using the Application Container
Group

Sets the width and height of FLEX or APDF formatted active reports. The Application Container
group is shown in the following image. 

Width

Sets the width of the active report container for FLEX or APDF formatted reports.

Height

Sets the height of the active report container for FLEX or APDF formatted reports.
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Creating Financial Reports Using the Matrix Tab

You can create, calculate, and present financially oriented data such as balance sheets,
consolidations, profit and loss statements, budgets, and certain government mandated
reports. These reports are distinguished from other WebFOCUS reports because calculations
are inter-row as well as inter-column. Each row or line represents a unique entry or series of
entries that can be aggregated directly from the input data, or calculated as some function of
the data. The Matrix tab is located at the top of the App Studio interface and is only accessible
when a FOR field is selected on the Report canvas and the Matrix tab is selected from the
bottom of the Report canvas. The Matrix tab is shown in the following image. 

Changing the Report Mode Using the View Group

You use the View group to change the type of a field. The View group is shown in the following
image. 

The commands are:

Design Mode

Toggles the report between Design mode and Preview mode. Design mode is used to
assist you in the creation of your report, and Preview mode allows you to preview what a
user will see at run time.

In Preview mode, the Report canvas displays the following: 

In the first column, a label assigned to each row in the report, such as R1 and R2 (or
an explicit row label if you have supplied one).

In the second column, default titles, or titles you assigned to rows in the report,
representing TAG values of the FOR field and other row types.

In subsequent columns, any other fields you specified for the report.
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Display Properties

Shows the properties of the selected row in a dialog box named after the row type. For
example, if your row was the DATA type, the DATA dialog box opens. You can edit the
properties for that row from this dialog box.

Inserting a Specific Row Type Using the Insert Group

You can use the Insert group to insert or change a row in a report. The type depends on which
button you click. You can choose between Tag, Recap, Text, Bar, Data, and Pickup. You can
also change a row to a different type using the shortcut menu on the Report canvas. The Insert
group is shown in the following image.

The commands are: 

Tag

Inserts a tag row or changes a row to a tag row. Tags identify the data values of the FOR
field in your report. A report row can be associated with a tag that represents:

A single data value of the FOR field.

The aggregate of two or more data values of the FOR field.

The aggregate of a range of data values of the FOR field.

The aggregate of a related group of data values of the FOR field.

You can also identify tag values that are organized in a parent/child hierarchy up to 99
levels deep and extending over many rows in the matrix.

The Tag command opens the TAG dialog box, from which you can define all of these
variations.

Recap

Opens the RECAP dialog box, where you can create an expression that derives the value of
the RECAP row and assign row properties. Recaps enable you to perform calculations on
data in the rows of a report to produce new rows.
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To initiate a Recap operation, you must supply the format of the value that will receive the
result of the calculation, and an expression that defines the calculation you wish to
perform. Initially, the default row label (R1, and so on) serves as the identifying label for
the calculated value. However, it is good practice to provide a more descriptive label for
reference in other calculations.

Text

Opens the TEXT dialog box, where you can enter a row of text, or a blank row. Type up to
256 characters in the text field or leave it blank to insert a blank row to the report.

Bar

Opens the BAR dialog box, where you can add an underline character below columns of
numbers. The options include a single (_) or double underscore (__) character.

Data

Opens the DATA dialog box, where you can assign properties, such as title and label, to a
row whose data you supply directly in the request, rather than retrieving it from a data
source.

Pickup

Opens the PICKUP dialog box, where you can assign row properties, such as title and
label, and indicate the name of a file from which to pick up a row of previously posted
data.

Creating and Editing Rows and Cells Using the Row/Cell Group

You use the Row/Cell group to create and edit rows and cells. The Row/Cell group is shown in
the following image. 

The commands are:

Add Row

Adds a blank row at the bottom of the matrix.

Insert Row

Inserts a blank row between two existing rows.
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Delete Row

Deletes the selected row.

Make Recap (Rows)

Creates a RECAP row based on the sum of other values in the matrix.

Make Recap (Cells)

Creates a RECAP cell based on the sum of other values in the matrix.

Controlling Report Properties Using the Report Properties Group

You use the Report Properties group to control report properties. The Report Properties group
is shown in the following image. 

The commands are:

Use Multiple Values

Allows you to add the same data value to multiple rows.

First Instance

When enabled, adds the .FST to all summed numeric columns, ensuring that the shared
value is only counted once.

Controlling Row Properties Using the Row Properties Group

You use the Row Properties group to control row properties. The Row Properties group is
shown in the following image. 

The commands are:

Invisible

When enabled, hides the selected row.
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When Exists

When enabled, you can hide a row, if no data exists in that row.

Post To

You can enter the name of a file you want to add to a row of output.

Accessing WebFOCUS RStat Using the Modeling Tab

You can use the Modeling tab to access WebFOCUS RStat, a statistical modeling workbench
that is embedded in App Studio. You can perform common statistical and data mining tasks,
and develop models that can be deployed as scoring applications on every platform. RStat
enables data miners and Business Intelligence developers to collaborate with the same tools
used to access, manipulate, or transform data, develop predictive models, and create and
deploy scoring applications along with associated reports to any worker within their
organization. 

You can pass any data generated from the Report canvas directly into RStat. After you pass
the data to RStat, you can develop your data, join various data sources, build virtual fields, and
create data sets to pass to RStat for modeling. The Launch button extracts the data defined
within your report and loads it directly into RStat. Within each report, you can customize the
name of the hold file that you create, and the location at which it is stored. If you do not
customize the name and location of the hold file, a default name and location are assigned.

Note: The Modeling tab is only accessible when RStat is installed.

Launching RStat Using the Modeling Group

You can run RStat and edit the RStat configuration model options. You can also conduct
sampling activities. The commands are: 

Launch

Extracts the data defined in your report and loads it directly into RStat. RStat opens in a
new window.

Note: The file name that loads in RStat is that which you define on the RStat Model
Configuration dialog box. The default file name is HOLD (HOLD.CSV).

Parameters

When you click the Parameters button, the RStat Model Configuration dialog box displays.
In this dialog box, you can name the hold file that will be used to pass the model data
from the Report canvas into RStat (the default file name is HOLD). You can also define the
directory in which the hold file should be placed. You can customize the default hold path
for your procedures (.fex files). Your model configuration parameters are saved when you
exit the RStat Model Configuration dialog box.
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Sampling

Opens the Sampling dialog box. You can generate statistically representative data extracts
for data examination and modeling purposes. You can select Random, Numeric Stratified,
or Categorical Stratified sampling.

You can also disable sampling. Each option contains a set of criteria that you can edit for
the sampling.

Note: In order for sampling to work, you must select a data field prior to clicking Sampling.
If you do not select a data field, the message No field is available for sampling will be the
only item that appears in the dialog box.

Procedure: How to Launch RStat

1. Create a report in App Studio.

2. Add fields to the report.

3. On the Modeling tab, in the Modeling group, click the RStat icon.

RStat launches in a separate window.

4. Optionally, customize the variables that are imported into RStat.

Note: The fields that you define on your Report canvas are imported into RStat in the order
specified in your report.

For more information on using RStat, see the Using WebFOCUS RStat for Predictive
Analytics manual.

Procedure: How to Set Parameters Using the RStat Model Configuration

You use the Parameters option to specify a name for the data file, as well as an output
directory.

1. On the Modeling tab, in the Modeling group, click Parameters.

The RStat Model Configuration dialog box displays.

2. In the Hold File Name field, enter a name for the file or optionally browse to select an
existing file.

Note: The default Hold file name is HOLD and displays in the file name field on the Data
tab in RStat. If you change the name of the file on the RStat Model Configuration dialog
box, this revised file name is reflected in RStat.

3. In the Hold File Path field, enter or select a path in which to save the file.

Note: You can restore the original drive and directory by clicking Default.

Accessing Reporting Components

406  Information Builders



4. Click OK.

When you launch RStat, this file name is the default Hold file used upon entry into the
application.

Working With Sampling Functionality

The sampling functionality is accessible through the Modeling tab in App Studio. Sampling
offers three sampling techniques: Random, Numeric Stratified, and Categorical Stratified.

Random Sampling is a basic sampling technique where you select a group of subjects (a
sample) from a larger group (a population). Each individual is chosen entirely by chance and
each member of the population has an equal chance of being included in the sample.

Stratified Sampling is obtained by taking separate samples from each sub-group of a
population (commonly referred to as a stratum).

When you sample a population, stratified sampling allows us to ensure that the proportion
of each stratum in the sample is the same as in the population. Numeric stratified
sampling is used when the field identifying the strata is a number and can be defined in
terms of a range. Categorical stratified sampling is used for all other data.

Accessing sampling criteria within the Modeling tab requires that at least one field is defined
within the report extract. If no fields have been defined, you will receive a warning message
informing you that no fields are available for sampling and the Sampling tab will be present,
but no actions will be available. For Random Sampling, which is not tied to a specific field
value, any field will open the option. For Stratified sampling, the stratum field (the field on
which the strata will be defined) must be included in the report.

Basic Sampling Concepts and Terminology

To produce a valid output sample, each sampling definition requires information about the file
to be sampled. In each sampling routine, you can use the sample calculator to calculate the
values for each of the following or enter your own values:

Population Size. The number of records in the overall data set to be sampled. Before
performing a sampling routine, the population size must be determined. Within the
sampling function, the population size can be retrieved at design time, generated live at run
time, or defined as a fixed value. Although the population size is usually the total number of
records in the file, there will be times when you want to sample a subset of the file. To
ensure a statistically valid sample, the specified population size must be the same as the
number of records sampled.
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Confidence Level. Is the probability, expressed in percent, that the selected sample will
represent the total population. Most guidelines establish a minimum acceptable confidence
level of 90%, 95%, or 98%.

Margin of Error. Represents the amount of error, expressed in percent, that you can
tolerate. Lower margins of error require larger sample sizes. 

Response Distribution. Allows you to correct for skewness in the sample (if the sample
deviates from the normal standard deviation). Use the Response Distribution percentage to
account for the skewness in population.

Seed. The statistical sampling routines use a seed value for the pseudo random number
generator. This generator produces a series of random numbers from the entered seed.
These random numbers are then used to determine each record to include in the sample.
The seed has no affect on the number of records included in the sample, it only affects
which records are selected. A single seed will produce the same set of random numbers,
so if you want to replicate a sample, use the same seed, population size, and record order.
To generate a unique sample, enter a new seed value each time.

Sample Size. The number of records that you want to store in the output file. The number
should be a positive integer, greater than zero and less than the population size.

Linking Reports with Auto Linking and Auto Drill

When you view a report, you can enhance your analytical insight by drilling down from a
summary to a detailed report. Similarly, you may want to drill up from a detailed report, to a
summary report, or drill across to see similar information in different contexts.

App Studio provides two features that automate the creation of links that enable these
drilldowns:

Auto Linking lets you connect predefined reports, charts, and visualizations together
through common filters.

Auto Drill lets you create ad hoc reports, within a dimension hierarchy, that connect to a
source report.

These features magnify your analytical capabilities while saving you the significant
development and maintenance time required by numerous manual links.

However, you can also create individual drill-down procedures, in cases where that may be
advantageous. For more information, see Creating Drill-Down Hyperlinks using the Drill Down
Command on page 338.
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Link to Predefined Reports, Charts, and Visualizations Using Auto Linking

Use the Auto Linking feature to connect a source procedure to one or more predefined target
reports, charts, or visualizations. The links that enable these connections are created
automatically by the Auto Linking feature.

The Auto Linking source/target relationship is structured as follows:

Auto Linking Source Report. The source report has the Enable Auto Linking property set to
Yes. Also, the source report contains one or more columns that correspond with
parameters that can be passed to the target reports. For example, if the source report has
a Product Category column, it can Auto Linking to target reports that have Product Category
as a parameter.

Auto Linking Target Reports. The target reports have both the Enable Auto Linking
property, and the Auto Link Target property set to Yes. Also, they must have one or more
parameters that correspond with columns in the source report.

Because Auto Linking reports, charts, and visualizations are manually tagged with the Auto
Linking property values, you control the allowable drilldowns. This can prevent report users
from drilling down too far and losing focus.

In the following image, the source report on the left shows all Product Categories. Since Auto
Linking is enabled in the source, the Product Categories all appear as hyperlinks. The Auto
Linking Target property has been set for 3 reports that all have filters for Product Category.
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In the following example, the user clicked Camcorder and selected a drill-down report, shown
on the right. The source passed the camcorder parameter to the predefined target report,
which includes a WHERE filter for Product Category. The resulting drill-down report shows
camcorder information only, down to the model level.

Once the target reports are tagged with the Auto Linking property values, they are eligible to be
used as targets for other source reports in the domain that use the same parameter. They will
automatically appear in the Auto Linking lists for those reports.

Procedure: How to Connect Reports, Charts, and Visualizations with Auto Linking

1. Select a report, chart, or visualization that you wish to designate as a source. The source
report must contain one or more columns that correspond with parameters that can be
passed to the target reports. In the File/Folder Properties panel, change the Enable Auto
Linking property to Yes.

Close the source.

2. Select a report, chart, or visualization that you wish to designate as a target. The target
report must have one or more parameters that correspond with columns in the source
report. In the File/Folder Properties panel, change the Enable Auto Linking property to Yes
and change the Auto Link Target property to Yes.

Close the target. Repeat this step for additional targets, as needed.

3. Run the source report.
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Hyperlinks automatically appear for columns that support Auto Linking. Click a hyperlink
and select a target report from the context menu. Note that the resulting report opens in a
new tab on your browser.

Link to Ad Hoc Reports, Charts, and Visualizations Using Auto Drill

Use the Auto Drill feature to connect a source procedure to one or more ad hoc target reports,
charts, or visualizations, within a dimension hierarchy. The links that enable these connections
are created automatically by the Auto Drill feature, and the resulting target reports are created
automatically, on the fly, when invoked. 

The Auto Drill source/target relationship is structured as follows:

Auto Drill Source Report. A report, chart, or visualization may be a source for Auto Drill
when the following conditions are met:

The Enable Auto Drill property is set to Yes.

The report contains one or more sort columns that exist within a dimension hierarchy in
the master data. Either BY or ACROSS sorting will generate hyperlinks automatically in
the source report.

The report output type must be HTML or active report.

Auto Drill Target Reports. An ad hoc target report is generated automatically when you
click a hyperlink in a source report. The parameter that you clicked in the dimension
hierarchy is automatically passed to the target report. A target report can also contain links
to drill down further in the hierarchy.

Because Auto Drill target reports, charts, and visualizations are generated automatically on the
fly, you can drill down anywhere within a dimension hierarchy. This gives you an open-ended,
high-capacity analytical capability.

In the following image, the Auto Drill source report on the left shows all Product Category and
Product Subcategory fields as hyperlinks, since these two columns are in the same dimension
hierarchy.
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In the following example, the userclicked the Standard subcategory under the Camcorder
category. From the resulting menu, the user chose Drill down to Model. An ad hoc report was
generated, shown on the right. The source passed the camcorder and standard parameters to
the target, which shows those parameters only, down to the model level.

Since Model, in the above example, is the bottom of the dimension hierarchy, we cannot drill
down further. Clicking a hyperlink in the Model column results in two options: Restore Original
or Drill up to Product Subcategory. You can also return to the original source by clicking the
Home breadcrumb trail, at the top of the target report.

Ineligible Conditions

Auto Drill functionality is not supported under the following conditions:

You may run your source report, chart, or visualization in deferred mode, or you may
distribute it through ReportCaster. However, under these conditions, Auto Drill functionality
is not supported.

Auto Drill functionality is not supported for all HTML output format charts. It is not
supported for HTML5 output format charts that do not support the new chart attribute
syntax.

Auto Drill functionality is not supported on Across fields in active reports.

Auto Drill functionality is not supported when Accessibility options are on.

Imported Auto Drill reports are not supported in the HTML canvas. Only Referenced Auto
Drill reports are supported.
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Procedure: How to Connect Reports, Charts, and Visualizations with Auto Drill

1. Select a report, chart, or visualization that you wish to designate as a source. The source
must contain one or more sort columns that exist within a dimension hierarchy in the
master data.

2. On the Format tab, click the Auto Drill button.

In the File/Folder Properties panel, the Enable Auto Drill property value is changed to Yes.

3. Run the source report.

Hyperlinks automatically appear for columns that support Auto Drill. Click a hyperlink to
drill down. Note that the resulting ad hoc report overwrites the source report on your
browser, but you can navigate back using the breadcrumb trail, at the top of the report.

Note: If you have created a chart that has multiple dimension sort fields in the request,
some of which belong to the same dimension hierarchy, multiple links to the same target
may result.

Reporting Syntax Summary

This topic summarizes the WebFOCUS reporting commands and options that you can type
directly into the Text Editor. For detailed information about these commands and options, see
the Creating Reports With WebFOCUS Language manual.

TABLE FILE filename 
HEADING [CENTER]
"text"
{display_command} [SEG.]field   [/R|/L|/C] [/format]
{display_command} [prefixop.] [field] [/R|/L|/C] [/format]
  [NOPRINT|AS 'title1,...,title5'] [AND|OVER] [obj2...obj1024]
[WITHIN field] [IN n]
COMPUTE field [/format] = expression; [AS 'title,...,title5'] [IN n]
[AND] ROW-TOTAL [/R|/L|/C] [/format] [AS 'name']
[AND] COLUMN-TOTAL [/R|/L|/C] [AS 'name']
ACROSS [HIGHEST] sortfieldn [IN-GROUPS-OF qty]
  [NOPRINT|AS 'title1,...,title5']
BY [HIGHEST] sortfieldn [IN-GROUPS-OF qty]
  [NOPRINT|AS 'title1,...,title5']
BY [HIGHEST|LOWEST{n}] TOTAL  [prefix_operator]  {field|code_value}
RANKED [AS 'name'] BY {TOP|HIGHEST|LOWEST} [n] field 
  [PLUS OTHERS AS 'othertext'] 
  [IN-GROUPS-OF qty [TILES [TOP m]] [AS 'heading']]
  [NOPRINT|AS 'title1,...,title5']

{BY|ACROSS} sortfield IN-RANGES-OF value [TOP limit]
ON sfld  option1 [AND] option2   [WHEN expression;...]
ON sfld RECAP fld1  [/fmt] = FORECAST (fld2, intvl, npredct,
  '{MOVAVE|EXPAVE}',npnt);
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ON sfld RECAP fld1[/fmt] = FORECAST(fld2, interval, npredict, 'DOUBLEXP',
  npoint1, npoint2);

ON sfld RECAP fld1[/fmt] = FORECAST(fld2, interval, npredict, 'SEASONAL',
  nperiod, npoint1, npoint2, npoint3);

ON sfld RECAP fld1  [/fmt] = FORECAST (fld2, intvl, npredct, 
'REGRESS');

ON {sortfield|TABLE} RECAP y[/fmt] = REGRESS(n, x1, [x2, [x3,]] z);
ON sfld RECAP fld1  [/fmt] = FORECAST (infield, interval, npredict,
  'DOUBLEXP',npoint, npoint2);
ON sfld RECAP fld1  [/fmt] = FORECAST (infield, interval, npredict,
  'SEASONAL', nperiod, npoint, npoint2, npoint3);{BY|ON} fieldname 
SUBHEAD
  [NEWPAGE]
"text"

{BY|ON} fieldname SUBFOOT [WITHIN] [MULTILINES][NEWPAGE]
"text" [<prefop.fieldname ... ]"        [WHEN expression;]

WHERE [TOTAL] expression 
WHERE {RECORDLIMIT|READLIMIT} EQ n 
IF [TOTAL] field relation  value [OR value...]
ON TABLE SET parameter value 
ON TABLE HOLD [VIA program][AS name] [FORMAT format] [MISSING {ON|OFF}]
ON TABLE {PCHOLD|SAVE|SAVB} [AS name] [FORMAT format] [MISSING {ON|OFF}]
ON TABLE NOTOTAL
ON TABLE COLUMN-TOTAL [/R|/L|/C] [AS 'name']  fieldname 
ON TABLE {ROW-TOTAL|ACROSS-TOTAL}[/R|/L|/C][format] [AS 'name'] fldname 
{BY|ON} sfld [AS 'text1']   {SUBTOTAL|SUB-TOTAL|SUMMARIZE|RECOMPUTE}
  [MULTILINES] [pref. ] [field1 [pref. ] field2 ...] [AS 'text2']
  [WHEN expression;]
{ACROSS|ON} sfld [AS 'text1'] {SUBTOTAL|SUB-TOTAL|SUMMARIZE|RECOMPUTE}
  [AS 'text2'] [COLUMNS c1 [AND c2 ...]]
ON  TABLE {SUBTOTAL|SUB-TOTAL|SUMMARIZE|RECOMPUTE}
  [pref. ] [field1 [pref. ] field2 ...] [AS 'text2']
FOOTING [CENTER] [BOTTOM]
"text"
MORE
FILE file2 
  [IF field relation value [OR value...]|WHERE expression]
{END|RUN|QUIT}
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Chapter5
Creating Charts and Visualizations

A chart often conveys meaning more clearly and effectively than data displayed in tabular
form. A chart enables you to visually communicate quantitative information. On a chart,
you can give data a shape and form, and reveal patterns and relationships among many
data values. A chart can highlight anomalies that require further investigation.

It is important that you choose a chart that is appropriate for your data. App Studio
provides a complete chart library of both basic and advanced charts. You can choose
from a wide variety of charts to best represent the data that you want to display.

In App Studio, you can create and edit charts using the Chart canvas. When you create a
new chart, you use the Chart Wizard.

This topic provides an overview of the types of charts you can create with WebFOCUS
App Studio and how to launch the Chart Wizard to create charts.

For more information on creating visualizations, see the InfoAssist User's Manual, or click

the Help icon , located in the upper-right corner of the canvas.

In this chapter:

Chart Types

Launching the Chart Wizard

Creating Visualizations

Chart Types

Once you connect to the data that you want to analyze, you can build simple or complex charts.
These chart types including the following:

Bar chart. Plots numeric data by displaying rectangular blocks against a scale. The length
of a bar corresponds to a value or amount. Viewers can develop a clear mental image of
comparisons among data series by distinguishing the relative heights of the bars. Use a
bar chart to display numeric data when you want to present distributions of data. You can
create horizontal, as well as vertical bar charts.

WebFOCUS App Studio User’s Manual  415



Line chart. Emphasizes the movement or trend of numeric data over time, since they allow
a viewer to trace the evolution of a particular point by working backwards or interpolating.
Highs and lows, rapid or slow movement, or a tendency toward stability are all types of
trends that are well suited to a line chart.

Area chart. Similar to a line chart, except that the area between the data line and the zero
line (or axis) is usually colored or textured. An area chart allows you to stack data on top of
each other. Stacking allows you to highlight the relationship between data series, showing
how some data series approach or shadow a second series.

Pie chart. Emphasizes where your data fits in relation to a larger whole. Keep in mind that
a pie chart works best when your data consists of several large sets. Too many variables
divide the pie into small segments that are difficult to see. Use color or texture on
individual segments to create visual contrast.

Scatter chart. Shows the relationship between two different numeric measures. A scatter
chart gives you a sense of trends, concentrations, and outliers that pinpoint where to focus
further investigation efforts.

Bubble chart. Plots data similar to a scatter chart, where the size of each marker is
proportional to the value of a third measure.

Treemap chart. Displays large amounts of hierarchically structured data. Using a set of
nested rectangles to illustrate data relationships, sections of a treemap represent
branches of a tree.

Gauge chart. Indicates the current position of a single data value within a given spectrum.
This chart has a circular shape. A gauge thermometer chart indicates the current position
of a single data value within a given scale. This chart has the shape of a thermometer. It is
not available in HTML5.

Pareto chart. Uses the X axis to show group members, and the Y axis to show the percent
of the total of all groups that each group represents. This chart highlights the differences
between groups of data.

Box Plot chart. Shows the distribution of data, vertically or horizontally, through five-
number summaries: Upper limit, Upper Quartile, Median, Lower Quartile, and Lower Limit.
This chart can be represented with or without outliers, also known as whiskers.

Funnel chart. Displays only one group of data at a time, from the first series to the last
series at the bottom of the funnel. Funnel charts are similar to pie charts.

Pyramid chart. Displays only one group of data at a time, from the first series to the last
series at the top of the pyramid. A pyramid chart is similar to a pie chart.

Chart Types
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Heatmap chart. Displays data in a table where the color of each cell is dependent on the
value in the cell. A heatmap chart is similar to a spectral map.

Tagcloud chart. Displays text data, typically used to depict keywords on websites or to
visualize free form text. This format is useful for quickly perceiving the most prominent
terms.

In addition to the charts that you can create, you can also create interactive, informative maps.
Using the lightweight mapping feature, you can view important information for a region and drill
down to view and analyze trends, population changes, or sales data. These chart types include
the following:

Choropleth map. Uses color to differentiate between value groups on a map. It is useful for
visualizing location-based data, trends, and distributions across a geographic area.

Proportional Symbol map. Uses marker size and color to differentiate between the data on
a map.

Launching the Chart Wizard

To open the Chart Wizard: 

On the Home tab, in the Content group, click Chart.

In the Environments Tree panel, right-click an application folder, point to New, and click
Chart.

Note: If you choose to create a new chart using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify
whether you are creating a chart or SQL chart. You will instead be brought to the Select
Data Source window, with the location for your chart already selected.
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The Chart Wizard opens, as shown in the following image.

From the Chart Wizard, you can create a new chart or SQL chart procedure or open a recent
procedure.

Procedure: How to Create a Chart Using the Chart Wizard

After you launch the Chart Wizard, you can begin to create your chart procedure. 

Note: If you choose to create a new chart using the shortcut menu in the Environments Tree
panel, you will skip the first screen of the Chart Wizard. You will not have to specify whether
you are creating a chart or SQL chart. You will instead be brought to the Select Data Source
window, with the location for your chart already selected.

1. Click Create Chart.

The Chart Wizard - Choose location for the new chart window opens.

2. Navigate to where you want to create the new chart and click Next.

The Select Data Source window opens.

3. Choose an application folder in the application folder tree, and select a Master File. You
can select the Use Qualified Path check box if you want to only display the data sources in
the application folder.

4. Click Finish.

The Chart canvas opens.
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5. Double-click fields in the Data Panel to add them to the chart.

You can use the features and functions on the ribbon that is located in the Chart canvas
to format the chart.

6. To save your chart, click the Save button on the App Studio Quick Access Toolbar, or
select Save from the Application menu.

7. To run your chart, click the Run button on the App Studio Quick Access Toolbar.

Procedure: How to Create an SQL Chart From an External .sql File

After you launch the Chart Wizard, you can begin to create your SQL chart procedure. 

Note: If you choose to create a new SQL chart using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify
whether you are creating a chart or SQL chart. You will instead be brought to the SQL Chart
Wizard - Welcome window, with the location for your chart already selected.

1. Select Create SQL Chart.

The Chart Wizard - Choose location for the new chart window opens

2. Navigate to where you want to create the new chart and click Next.

The SQL Chart Wizard - Welcome window opens.

3. Click the Included from an external ‘.sql’ file option. This enables you to browse and select
external procedures that exist in the domain of the project.

4. Click Next.

The SQL Chart Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list.
The drop-down list changes depending on your Reporting Server configuration.

6. In the Select the connection area, choose a connection from the drop-down list generated
from the engine you selected.

7. Click Next.

The SQL Chart Wizard - Include external SQL file window opens.

8. Click Browse to select an external SQL file name or type the external SQL file name in the
field.

Optionally, you can run with limited records by clicking Run SQL. By default, the Run with
limited records check box is selected so you can test your procedure with a read limit if the
engine supports it. There is a field box next to the check box in which you can enter the
number of records to be read. 100 is the default limit.
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9. Click Next.

The SQL Chart Wizard - Summary of SQL options window opens.

10. Review your options and click Finish.

The Chart Wizard - SQL Data Source window opens.

11. Navigate to where you want to create the new procedure.

12. In the Enter a Procedure Name field, type a name for the SQL chart.

Note: Typing a procedure name is not required to create a new chart. If you do not type a
procedure name in the Enter a Procedure Name field, a default procedure name will be
provided until you save the procedure.

13. Click Finish.

The Chart canvas and the Procedure View panel open. You can now add data to your chart
and format the data using the tabs in the ribbon.

Procedure: How to Pass SQL Commands to the RDBMS Using SQL Passthru

After you launch the Chart Wizard, you can begin to create your SQL chart procedure.

Note: If you choose to create a new SQL chart using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify
whether you are creating a chart or SQL chart. You will instead be brought to the Chart Wizard -
Choose location for the new SQL Chart window, with the location for your chart already selected.

1. Click Create SQL Chart.

The Chart Wizard - Choose location for the new SQL Chart window opens.

2. Navigate to where you want to create the SQL chart and click Next.

The SQL Chart Wizard - Welcome window opens.

3. Click Type SQL statements in the chart request. This enables you to type SQL commands
that will be passed on to the RDBMS with the SQL Passthru feature.

4. Click Next.

The SQL Chart Wizard - Data access information window opens.

5. In the Select the SQL database engine area, select a database from the drop-down list.
The drop-down list changes depending on your Reporting Server configuration.

6. In the Select the connection area, choose a connection from the drop-down list generated
from the engine you selected.

7. Click Next.

The SQL Chart Wizard - Enter the SQL statements window opens.
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8. In the field box, type the SQL statements you want to pass to the RDBMS.

Optionally, you can run with limited records by clicking Run SQL. By default, the Run with
limited records check box is selected so you can test your procedure with a read limit if the
engine supports it. There is a field box next to the check box in which you can enter the
number of records to be read. The default limit is 100.

9. Click Next.

The SQL Chart Wizard - Summary of SQL options window opens.

10. Review your options and click Finish.

The Chart Wizard - SQL Data Source window opens.

11. Navigate to where you want to create the new procedure.

12. In the Enter a Procedure Name field, type a name for the SQL chart.

Note: Typing a procedure name is not required to create a new chart. If you do not type a
procedure name in the Enter a Procedure Name field, a default procedure name will be
provided until you save the procedure.

13. Click Finish.

The Chart canvas and the Procedure View panel open. You can now add data to your chart
and format the data using the tabs in the ribbon.

Procedure: How to Import SQL Commands From an Existing .sql File

You can import commands from existing .sql files.

Note: If you choose to create a new SQL chart using the shortcut menu in the Environments
Tree panel, you will skip the first screen of the Chart Wizard. You will not have to specify
whether you are creating a chart or SQL chart. You will instead be brought to the Chart Wizard -
Choose location for the new chart window, with the location for your chart already selected.

1. Open the Chart Wizard and click Create SQL Chart.

The Chart Wizard - Choose location for the new chart window opens.

2. Navigate to where you want to create the new chart and click Next.

The SQL Chart - Welcome window opens.

3. Click Import from an existing ‘.sql’ file and click Next. This enables you to modify SQL code
after importing it from an external file to the procedure being built. You can modify the
request using bits of the code.

The SQL Chart - Data access information window opens.
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4. In the Select the SQL database engine area, select a database from the drop-down list.
The drop-down list changes depending on your Reporting Server configuration.

5. In the Select the connection area, choose a connection from the drop-down list generated
from the engine you selected.

6. Click Next.

The SQL Chart Wizard - Import external SQL file window opens.

7. Type the SQL file name that you want to import or click Browse to select it.

Optionally, you can run with limited records by clicking Run SQL. By default, the Run with
limited records check box is selected so you can test your procedure with a read limit if the
engine supports it. There is a field box next to the check box in which you can enter the
number of records to be read. The default limit is 100. You can edit these options here or
in the next step.

8. Click Next.

The SQL Chart Wizard - Enter SQL statements window opens.

9. In the field box, type the SQL statements you want to pass to the RDBMS.

10. Click Next.

The SQL Chart Wizard - Summary of SQL options window opens.

11. Review your options and click Next.

The Chart Wizard - SQL Data Source window opens.

12. Navigate to where you want to create the new procedure.

13. In the Enter a Procedure Name field, type a name for the SQL chart.

Note: Typing a procedure name is not required to create a new chart. If you do not type a
procedure name in the Enter a Procedure Name field, a default procedure name will be
provided until you save the procedure.

14. Click Finish.

The Chart canvas and the Procedure View panel open. You can now add data to your chart
and format the data using the tabs in the ribbon.

Creating Visualizations

In App Studio, you can create and build visualizations. Visualizations centralize information by
providing different views of data that are pertinent to a particular objective (for example,
reviewing trends or fluctuations in data over a period of time or within a region).
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A visualization provides you with a quick glance of information on a single screen.
Visualizations support the use of different types of charts, maps, and grids. For example, you
may want to use a bar, pie, and line chart to show different views of the same data.
Alternatively, you may want to offset a particular visual by showing other types of related data
that employ a different type of visual. You can also add a text cell to your visualization to
provide explanatory text or information that other users can reference. Visualizations allow you
to monitor changes in data. They also serve to provide information in real-time, based on
changes in underlying data or other components. A visualization can be updated, changed, or
revised at any time to account for shifts in data needs.

Using InfoAssist

You can create visualizations from the Domains node in the Environments Tree panel or
Environments Detail panel.

To access the online Help for visualizations, click the Help icon , located in the upper-right
corner of the canvas.

Procedure: How to Create a New Visualization

1. From the Domains node in the Environments Tree panel or Environments Detail panel,
right-click a folder, point to New, and click Visualization.

2. Select a Master File from the list and click Open.
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The WebFOCUS InfoAssist interface opens, as shown in the following image, where you
can create charts, maps, and grids to visually represent your data.
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The following image shows a visualization that contains multiple visuals, including a bubble,
gauge, ring pie, and treemap.

Note: For more information on creating visualizations, see the InfoAssist User's Manual, or click

the Help icon , located in the upper-right corner of the canvas.
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Chapter6
Creating Procedures

A procedure is a .fex file that defines how data is retrieved and displayed. Procedures
request data from the data source using a Master File to understand how the data is
organized. When you run a procedure, it executes a series of commands that process
your data and transform it into a readable output.

In App Studio, you can develop multi-component procedures using the Procedure View
panel.

This topic explains the components that can make up a procedure and identifies the
Procedure View panel.

In this chapter:

Using the Procedure View Panel

Using Dialogue Manager

Displaying Data Sources

Using the Procedure View Panel

The Procedure View panel contains the panel customization commands and the Procedure
View tree. This panel displays all components in a procedure. You can add new components to
a procedure, such as a Report, Define, Define Function, Chart, Set, Join, Use, and others.

If a component in the procedure is open, a green arrow appears next to the component icon.

When a new procedure is created, the Comment component opens automatically. In a
previously created procedure that is reopened, the last report component or chart component
opens automatically.
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The Procedure View panel is available when you create or open a procedure or report. The
Procedure View panel is shown in the following image.

For more information on customizing the Procedure View panel, see Customizing the Panels on
page 128.

Displaying Components of a Procedure Using the Procedure View Tree

The Procedure View tree displays the components and folders associated with a procedure.

Open Folder Node

Displays different options depending on the selected component or components in the
procedure.

Procedure Contents Tree

Shows the components in a procedure.

Defining the Components of a Procedure

A procedure is a .fex file that defines how data is retrieved and displayed. Procedures request
data from the data source using a Master File to understand how the data is organized. When
you run a procedure, it executes a series of commands that process your data and transform it
into a readable output.

Procedures can consist of the following components:

Report

MAGNIFY Engine

Engine

SQL Report

Define

Using the Procedure View Panel
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Define Function

Chart

SQL Chart

Set

Join

Use

Allocation

Execute

HtmlForm

Include

Olap Dimensions

Match

Other

Dialogue Manager

You can add these components to new or existing procedures, and are responsible for the
order in which you add them. For more information, see Order of Components in the Procedure
View Panel on page 435. The following topics describe how these components modify a
procedure.

Report

You can add a report to a procedure. In report mode, you can create and style simple or
complex reports, add data to the Report canvas, and style that data creating a graphical
representation of the report page. This allows you to view how the report displays at run time.

MAGNIFY Engine

The MAGNIFY Engine canvas contains the following ENGINE SET statements which are
available for selection.

ACTION. Possible values are add or delete. The add option is the default and inserts or
updates a record. A record is updated if its WF_INDEX_UNIQUE_KEY value already exists in
the index. The delete option finds the WF_INDEX_UNIQUE_KEY of the record value and
deletes it from the index.
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BASEURL. The WebFOCUS Report base URL.

BATCHSIZE. The number of records to burst at one time. It is recommended that the
BATCHSIZE property is always used.

CONNECTION ATTRIBUTES. The Magnify Indexing Servlet.

DATASOURCE. The Magnify index library directory.

DELIMITER. The separator for multiple categorizations. This is used in conjunction with
aggregation-based alias names.

FEEDTYPE. Possible values are incremental or full. The incremental option is the default
and updates an existing record in the index or adds the data as a new record. This mode
prevents duplicate records from being added to the index library. The full option adds all
data to the index from the data source. If a record is repeated in the feed, it is duplicated
in the Magnify index library.

MIME. The document mime type, required for file indexing. Possible values are text/plain or
application/openurl. The text/plain option is the default.

Engine

The Engine component exposes the WebFOCUS ENGINE SET statement and enables you to
enter ENGINE commands or connection attributes, and override parameters.

Note: The Engine component is only used to create ENGINE statements. You are responsible
for having the knowledge of the ENGINE SET command or the Connection Attribute needed.

SQL Report

The SQL Report component launches the SQL Report Wizard, where you can create a new SQL
report, create an SQL report from an external .sql file, pass SQL commands to an RDBMS
using SQL passthru, or import SQL commands from an existing .sql file.

Define

You can use the Define feature to create a virtual field as a component in a procedure.

Note: To enable the objects when creating a Define, click the New button.

A virtual field is evaluated on each retrieved record that passes any selection criteria on real
fields. Define the virtual field by assigning a format and typing an expression, or composing it
using the calculator fields and functions. The result of the expression is treated as though it
were a real field stored in the data source.
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Define Function

You are able to create your own functions by using the Define Function Wizard. The Define
Function Wizard assists in the creation of a user function. The created functions can later be
retrieved through the Function Arguments dialog box using the Retrieve User Functions button.
By clicking Retrieve User Functions, your created functions will be available for use.

Chart

You can add a chart to a procedure. In chart mode, you can easily transform almost any type of
data into effective, custom charts. You can create a variety of charts, such as bar charts, line
charts, scatter charts, or pie charts to help users analyze data in a different way. You can
include selection criteria by defining parameters for your data. Additionally, you can apply drill-
down capabilities and conditional styling to highlight specific data on a chart.

The Chart canvas contains a ribbon of features and options that allow you to add and style the
data in your chart. Contextual tabs open within the Chart canvas, rather than on the App Studio
ribbon.

SQL Chart

The SQL Chart component launches the SQL Chart Wizard, where you can create a new SQL
chart, create an SQL chart from an external .sql file, pass SQL commands to an RDBMS using
SQL passthru, or import SQL commands from an existing .sql file.

Set

You can add the Set component to a procedure to select Environment Parameters and
customize the procedures. The Set component controls the way that reports and charts appear
on the screen or printer, the content of reports and charts, data retrieval characteristics that
affect performance, and system responses to user requests. It also helps you set up your
metadata and manipulate information, such as dates.

Join

If a report requires data from two or more related data sources, you can temporarily join the
files and report from them as if they were one. Joined files remain physically separate, but are
treated as one data source structure.

The Join component provides a graphical method for creating and manipulating all types of
Joins. To create a Join you must specify a host data source, and then a cross-referenced data
source. Both host and cross-referenced files are Master Files.
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You create the Join as an component that is separate from any other component or procedure.
You are responsible for placing the Join object in the correct position within your procedure,
(that is, before a Define, Report, or Chart), and running it. The Join remains active for the
entire session, unless you explicitly clear it.

Use

When you access a WebFOCUS data file, WebFOCUS searches for a Master File with the
specified file name, and then searches for a data source with the same name. With the Use
component, you can specify the name and location of a WebFOCUS data source.

You can apply the Use component to a procedure in App Studio when the default naming
convention is not used, the data source cannot be found in the standard search path, or an
explicit extra option is desired.

When you identify a WebFOCUS data source with the Use component, a Use directory is
created, which is a list of data source definitions. When a Use directory is in effect, WebFOCUS
locates a data source using the information in the directory instead of searching for it using
the default name and search path. A Use directory enables you to access up to 1022 data
sources and applies only to WebFOCUS data sources.

Allocation

For a file managed by the operating system, such as a comma-delimited data file, the physical
file name is the actual name of a file as it appears to the operating system. A logical name is
the shorthand name that points to a physical file name. Logical names simplify code by
allowing short names to be used in place of the longer physical file name. 

With the Allocation Wizard, you can create a FILEDEF command and generate platform
independent file paths for all portable platforms by creating FILEDEF syntax with application
names.

Execute

The Execute component allows one procedure to execute or call another procedure. The called
procedure behaves as a completely separate procedure, with its own context. The Execute
component allows you to view and select available procedures, supply values for parameters in
the called procedure, and test the called procedure. 

Using the Procedure View Panel

432  Information Builders



Once this procedure is specified, Execute displays these parameters and prompts you to
provide values for them. You can provide values for all parameters in the procedure, or you can
choose to provide values for only some of the parameters. If you provide values for only some
of the parameters, you must provide values for the other parameters using another method.
For example, values are passed from another part of the application. After providing parameter
values, you can test the called procedure.

Execute is available from all development areas of the product.

HtmlForm

The HtmlForm component enables you to add HTML code to the active procedure. HTML forms
are used to display HTML content. You can choose to reference or embed HTML forms in your
procedure.

Note: HTML pages created in the HTML canvas are not meant to be used with an -HTMLFORM
that uses run-time references. The HTML canvas cannot evaluate -HTMLFORM when run-time
references to file names and objects are used.

Include

The Include component allows you to include a whole or partial procedure in another
procedure. A partial procedure might contain heading text or syntax that should be included at
run time based on a test in the calling procedure. It enables the reuse of code, making
projects easier to write and maintain. After an included procedure runs, control returns to the
calling procedure.

An Include component can be placed anywhere in a procedure.

Olap Dimensions

The Olap Dimensions component allows you to create a temporary OLAP hierarchy and
dimensions to build reports from, without modifying the Master File. Instead, you create a local
hierarchy, where the information is stored in the active procedure. After you create the local
hierarchy, you can build a report.

Match

The Match component launches the Match Wizard, where you can merge two or more data
sources and specify which records to merge and which to sort out. The wizard creates a new
data source (a HOLD file) which merges fields from the selected records. You can report from
the new data source and use it as you would any other HOLD file. The merge process does not
change the original data sources.
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You select the records to be merged into the new data source by specifying sort fields in the
Match Wizard. You specify one set of sort fields (using the BY phrase) for the first data source,
and a second set of sort fields for the second data source. The Match Wizard compares all
sort fields that have been specified in common for both data sources, and then merges all
records from the first data source whose sort values match those in the second data source
into the new HOLD file. You can specify up to 32 sort sets, which includes the number of
common sort fields.

In addition to merging data source records that share values, you can merge records based on
other relationships. For example, you can merge all records in each data source whose sort
values are not matched in the other data source. Yet another type of merge combines all
records from the first data source with any matching records from the second data source.

You can merge up to 16 sets of data in one Match request. For example, you can merge
different data sources, or data from the same data source.

Note: The limit of 16 applies to the most complex request. Simpler requests may be able to
merge more data sources.

Other

The Other component enables you to enter commands that connect other components. This
feature is useful for writing code that does not have a graphical tool (such as Dialogue
Manager). However, you can also use Other for any kind of manual coding, for example, to
code a virtual field or a report. When used this way, the Other component automatically
converts to the corresponding component type.

An Other component can be placed anywhere in a procedure.

Dialogue Manager

Dialogue Manager is the part of the WebFOCUS language that controls the execution of your
application components. You can add flexibility to your application design by dynamically
managing the flow of control in procedures using Dialogue Manager commands and variables
whose values are supplied at run time.

You can select five different types of Dialogue Manager components to add to your procedure.

DM If. Creates a Dialogue Manager IF statement by having you type an expression and
choosing a label. You can choose to create an IF template if you want.

DM Goto. Creates a Dialogue Manager GOTO statement by having you type a label.

DM Label. Creates a Dialogue Manager label by having you type a label name.
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DM Repeat. Creates a Dialogue Manager REPEAT statement by having you choose labels,
amper values, steps, times, and expressions. You can choose to create a REPEAT template
if you want.

Dialogue Mngr. Opens the Dialogue Manager canvas where you can manually create your
Dialogue Manager code. For more information, see Using Dialogue Manager on page 449.

Order of Components in the Procedure View Panel

Components can be added to the Procedure View panel in any order. After adding a component
you may need to change the order.

The order of components in the Procedure View panel can be significant. For example, suppose
you have a report component and a define component, where the define component is a field
used in the report. In this case, the define component must appear before (above) the report
component in the Procedure View panel. Otherwise, the system will display a message when
you try to run the report.

To move a component, click and drag it over another component until the target component is
highlighted. As the component is moved, the pointer displays a box image. Release the mouse
button and the moved component will appear after the highlighted component.

To copy a component, hold down the Ctrl key, click the component and drag it up or down. As
the component is copied, the pointer displays a plus (+) sign. Release the mouse button and
Ctrl key and the copied component will appear after the highlighted component.

Note: You can move or copy a component in the Procedure View panel even if the component
is open in its respective canvas.

Creating Procedures and Procedure Components

This section describes how to create procedures and procedure components.

Procedure: How to Create a New Procedure

1. In the Environments Tree panel, right-click a folder, select New, and then select Procedure. 

The Procedure View panel opens.

2. To add components to your procedure, right-click the procedure folder or component that
you want to add a new component after, select New, and click the component name.

3. To run a procedure at any time, in the Procedure View panel, right-click any component and
select Run complete procedure from the shortcut menu. The current state of the procedure
is used even if it has not been saved.
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Note: If you select Run complete procedure when the procedure is in an invalid state you
will get an error message asking if you would like to run the procedure with the last good
content.

Procedure: How to Create a Report as a Component of a Procedure

1. Create a new procedure, or open an existing procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Report after, point to New, and click Report.

The Report Wizard - Select a Master File dialog box opens.

3. Select a Master File from the list and click Finish.

The Report canvas and the Procedure View Panel open.

4. Double-click fields in the Object Inspector to add them to the report.

5. Format your report by using the options on the Report tab, Format tab, Data tab, and
Layout tab.

Tip: The Field tab appears when you select a data column on the Report canvas.

6. To save your report, click the Save button on the Quick Access Toolbar, or select Save or
Save As from the Application menu.

7. To run your report, click the Run button on the Quick Access Toolbar, or select Run from
the Application menu.

Procedure: How to Create an Engine Statement

1. From the Procedure View panel, right-click the procedure folder or the component that you
want to create the Engine statement after, point to New, then click Engine.

The Engine canvas opens.

2. Select an Engine from the Engine list, or manually type in an Engine name.

3. Select an existing connection from the Connection list, or type a parameter statement in
the SET parameters field.

4. Click the Test button to test the Engine statement.

Procedure: How to Create an SQL Report

1. From the Procedure View panel, right-click the procedure folder or the component that you
want to create the SQL report after, point to New, then click SQL Report.

The Welcome to the WebFOCUS SQL Report Wizard window opens.
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2. Depending on the type of SQL report you wish to create, follow the respective instructions
in Launching the Report Wizard on page 231.

Procedure: How to Define a Virtual Field

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the virtual field after, point to New, and click Define.

The Open File dialog box opens.

3. Select a Master File from the list and click OK.

The Define canvas opens.

4. Type a name for the virtual field in the Define Field Name input box.

5. Click the Format button.

The Format dialog box opens.

6. Select the formatting options you want to apply to the virtual field and click OK.

7. Build an expression in the expression box. You can double-click fields from the Fields List
to add them to the expression. Use the calculator buttons under the expressions window
to provide numbers and operators in the expression.

8. Click the Check button to validate the generated code.

The Check dialog box opens displaying the component code and either an error message,
or text stating that no error exists.

9. Click OK and close the Define canvas.

You can define multiple virtual fields for a procedure. After you define a virtual field, you
can create a report that uses the virtual field. Right-click the Define component, point to
New, and click Report.

Procedure: How to Create a User Define Function

To create a user define function:

1. Right-click a procedure component in the Procedure View panel, point to New, and click
Define Function.

The Welcome to the Define Function Wizard window opens.

2. Click Next.

The Name dialog box opens.
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3. Type a name and description for the function and click Next.

The Parameters dialog box opens.

4. Click the Add new item button to add new parameters to the function.

You can rename the parameters by double-clicking on the name column. For each
parameter, clicking the ellipsis button in the Format column will open the Format dialog
box, allowing you to edit the format of that parameter. Double-clicking in the Description
column for each parameter will allow you to edit the description for parameter.

5. Click Next.

The Defined Fields dialog box opens. One defined field (with the same name as your
function) is already entered.

Note: A function is comprised of expressions that returns a value to the caller of the
function.

6. Click the Add new item button if you want to add more defined fields.

You can rename the fields by double-clicking on the name column. For each field, clicking
the ellipsis button in the Format column will open the Format dialog box, allowing you to
edit the format of that field. Clicking the ellipsis button in the Expression column will open
a dialog box where you can edit what the function will do.

Note: The last defined field must have the same name as the function. This is why one
defined field is already entered with the same name as the function. If multiple
expressions are present, then the defined field with the same name as the function must
be in the last position. If no defined field has the same name as the function, or if the
defined field is not in the last position, you will be unable to progress to the next window.

7. Click Next.

The Define Function Wizard Complete window displays. The function, as well as its
parameters and logic, are displayed before completion.

8. If you want to create more functions, click New to bring up the Define Function Wizard
again, allowing you to create another function.

This can be done as many times as needed, allowing you to create multiple functions in
the procedure, without having to exit and repeat certain steps.

Selecting a Define Function component and clicking Open will open the Define Function
Wizard. Here, you can change any part of the already created function by going through
each window.

Selecting a Define Function component and clicking Delete will delete the function.
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Procedure: How to Create a Define Function Library

To create a define function library:

1. Right-click a Data Servers folder in the Environments tree panel, point to New, and click
Define Function Library.

The Welcome to the Define Function Wizard window opens.

2. Click Next.

The Name dialog box opens.

3. Type a name and description for the function and click Next.

The Parameters dialog box opens.

4. Click the Add new item button to add new parameters to the function.

You can rename the parameters by double-clicking on the name column. For each
parameter, clicking the ellipsis button in the Format column will open the Format dialog
box, allowing you to edit the format of that parameter. Double-clicking in the Description
column for each parameter will allow you to edit the description for parameter.

5. Click Next.

The Defined Fields dialog box opens. One defined field (with the same name as your
function) is already entered.

Note: A function is comprised of expressions that returns a value to the caller of the
function.

6. Click the Add new item button if you want to add more defined fields.

You can rename the fields by double-clicking on the name column. For each field, clicking
the ellipsis button in the Format column will open the Format dialog box, allowing you to
edit the format of that field. Clicking the ellipsis button in the Expression column will open
a dialog box where you can edit what the function will do.

Note: The last defined field must have the same name as the function. This is why one
defined field is already entered with the same name as the function. If multiple
expressions are present, then the defined field with the same name as the function must
be in the last position. If no defined field has the same name as the function, or if the
defined field is not in the last position, you will be unable to progress to the next window.

7. Click Next.

The Define Function Wizard Complete window displays. The function, as well as its
parameters and logic, are displayed before completion.
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8. If you want to create more functions within the Define Function Library, click New and
select Define Function, allowing you to create another function.

This can be done as many times as needed, allowing you to create multiple functions in
the procedure, without having to exit and repeat certain steps.

Selecting a Define Function component and clicking Delete will delete the function within
the Define Function Library.

Procedure: How to Create a Chart as a Component of a Procedure

1. Create a new procedure, or open an existing procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the chart after, point to New, and click Chart.

The Chart Wizard - Select a Master File dialog box opens.

3. Select a Master File from the list, and click Finish.

The Chart canvas opens.

4. Double-click fields in the Data Panel to add them to the chart.

You can use the features and functions on the ribbon that is located in the Chart canvas
to format the chart.

5. To save your report, click the Save button on the App Studio Quick Access Toolbar, or
select Save or Save As from the Application menu.

6. To run your report, click the Run button on the App Studio Quick Access Toolbar, or select
Run from the Application menu.

Procedure: How to Create an SQL Chart

1. From the Procedure View panel, right-click the procedure folder or the component that you
want to create the SQL chart after, point to New, then click SQL Chart.

The Welcome to the WebFOCUS SQL Chart Wizard window opens.

2. Depending on the type of SQL chart you wish to create, follow the respective instructions
in Launching the Chart Wizard on page 417.

Procedure: How to Set Parameters for a Procedure

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Set after, point to New, and click Set.

The Set canvas opens.
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3. From the Available Settings list, double-click a parameter.

The selected parameter is added to the Used Settings list. The available values for that
parameter display in the Current Value list.

Note: You can also select a parameter and click the Add button to add it to the Used
Settings list.

4. Select a value from the Current Value list.

5. Click the Check button to validate the generated code.

The Check dialog box opens displaying the component code and either an error message,
or text stating that no error exists.

6. Click OK, and close the Set canvas.

This setting is now on, and will affect the way the procedure works.

Procedure: How to Join Data Sources

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Join after, point to New and click Join.

The Open File dialog box opens.

3. Select a Master File (host file) and click OK.

The Join canvas opens and displays the fields in the Master File.

4. On the Join tab, in the Join group, click Add.

You can also right-click the Join canvas and select Add File.

5. Select a Master File (cross-referenced file) and click OK.

The new Master File is added to the canvas. Common fields in both files are joined by a
Join connector line.

6. Click Save.

7. Click Run.

A dialog box opens, displaying the component code, and either an error message or text
stating that no error exists.

8. Click OK and close the Join canvas.
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You can add another component to the procedure by right-clicking the Join component,
pointing to New, and clicking the component. When you are prompted to select a Master
File, select the same host file you used to create the Join component. This allows you to
use the joined data sources.

Note: For more information on how to create each type of Join, see Creating Joins Using Join
Functionality on page 278.

Procedure: How to Identify a Data Source With the Use Feature

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Use after, point to New, and click Use.

The Use canvas opens.

3. Select a USE action:

Clear/Replace current list of USE databases clears all entries or replaces the current
list of USE data source with those in the list box.

Append to the present database list adds data sources to the current USE directory.

Replace only specified files in list changes one or more data source assignments in the
current USE directory.

4. In the Use canvas, do one of the following:

Type the name of a WebFOCUS data source in the Database Filename field.

Click Browse to search the network drives and directories for the file you want to add.

Type the Universal Naming Convention (UNC) name of the file in the Database
Filename field. For example:

\\Server1\Disk1\filename.ext

The Universal Naming Convention (UNC) allows you to type the server name without
entering the explicit path to the server. However, in order to take advantage of the UNC
you must first attach to the server. For information on attaching to a server or mapping
network drives, consult your Network Administrator.

Enter the Master File name to be associated with the data source in the MASTER File
field.

5. If the data source is not located locally, type the name of the server on which the file
resides, in the Database Server field.
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6. Click Add.

7. Repeat steps 3 through 6 for any additional data sources you want to identify.

8. Click the Check button to validate the generated code.

The Check dialog box opens displaying the component code and either an error message,
or text stating that no error exists.

9. Click OK and close the Use canvas.

Procedure: How to Define a Logical Name With the Allocation Wizard

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Allocation after, point to New, and click Allocation.

The Welcome to the Allocation Wizard window opens.

3. Click Next and specify the logical name for the allocation.

The name can be from one to eight characters. If you are identifying a data source, the
name must be the same as the name of the Master File.

4. Click Next and select the device for the logical name.

Disk associates the logical name with a file. This is the default option.

Printer associates the logical name with a printer.

Http associates the logical name with a URL, by allocating the Master File to the result
of running the URL.

Terminal indicates that the keyboard and monitor are the input source and output
destination for the file.

Clear clears the allocation assigned to a file name.

5. Click Next to select additional options.

Note: The options vary depending on which device is selected. The steps below detail how
the Allocation Wizard continues with the selected device.

Tip: At any time, you may click Back to go back and change the device, or any of the
device settings.

6. When selecting Disk as the device:

a. Select the application folder that contains the physical file.
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Note: The application folders from the Reporting Server are shown by default and
depend on the area from which the Allocation Wizard is invoked. Some examples of
the Reporting Server application folders are Projects (if available), Data Servers, and
domain.

b. Click Next and type the new file name.

or

Click the Browse button to display the Open dialog box and select from the list of
existing files.

Note: The default file type is Data Files (*.dat). You may also select Temporary Files
(*.ftm), and All Files (*.*), as the type of file.

c. Click Next to specify additional options for the Disk device.

These additional options are:

Appends records to the end of the file (without this option, the file is overwritten).

Fixed length records indicates that you are assigning a logical name to a file with
a fixed record length.

Record Size specifies the record length of the file, when using the Fixed length
records option.

d. Click Next to view the summary of the allocation settings you selected for the Disk
device.

7. When selecting Printer as the device:

a. Select the application folder that contains the physical file.

Note: The application folders from the Reporting Server are shown by default and
depend on the area from which the Allocation Wizard is invoked. Some examples of
the Reporting Server application folders are Projects (if available), Data Servers, and
domain. You may specify a file in a directory that is not in the Reporting Server
Application Path by using the Advanced option from the completed Allocation.

b. Click Next and enter the new file name.

or

Click the Browse button to display the Open dialog box and select from the list of
existing files.

Note: The default file type is Data Files (*.dat). You may also select Temporary Files
(*.ftm), and All Files (*.*), as the type of file.
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c. Click Next to type the name of the printer.

d. Click Next to view the summary of the allocation settings you selected for the Printer
device.

The following syntax is applied to the FILEDEF statement when using a Printer device:

FILEDEF OFFLINE PRINTER BASEAPP/TEMPOFFLINE.FTM (PRINTER \\ibiprint
\28C1

8. When selecting Http as the device:

a. Type the full URL path.

b. Click Next to view the summary of the allocation settings you selected for the Http
device.

9. When selecting Terminal as the device:

a. Click Next to specify additional options for the Terminal device.

You may choose to send the keyboard input to WebFOCUS as entered (lowercase
or mixed-case). The default is mixed-case. Select this option to specify lowercase.

b. Click Next to view the summary of the allocation settings you selected for the Terminal
device.

10. When selecting Clear as the device:

a. Click Next to view the summary of the allocation settings that you cleared.

Procedure: How to Call a Procedure From Another Procedure

In the following example, you will create two procedures: a report procedure and an Execute
procedure. The first procedure, named salesrep, will contain a sales report with parameter
prompts. The second procedure, called svalues, will contain the values for the parameters in
salesrep, and will execute the called procedure, salesrep. The result will be a sales report with
parameter values filled in.

1. Create a report called salesrep, with two multiselect parameter fields, for example, State
and Region and two sum fields, for example, Quantity Sold and Revenue.

2. Create a procedure, called svalues. From the Procedure View, right-click Comment, point to
New, and then click Execute.

3. From the Open File dialog box that displays, select the procedure to call (for example,
salesrep).
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The Resolve procedure parameters dialog box opens, as shown in the following image.

4. Select values for the Statename and Region parameters. For example, Connecticut and
Florida for Statename and NorthEast and SouthEast for Region.

5. Click OK.

The code in the Execute canvas shows the Execute code, with the selected parameter
values, as shown in the following image.

6. Run the svalues procedure.

The Sales Report displays, as show in the following image.
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Procedure: How to Merge Data Sources Using the Match Wizard

1. Open an existing procedure, or create a new procedure.

2. In the Procedure View panel, right-click the procedure folder or the component that you
want to create the Match after, point to New, and click Match.

The Open File dialog box opens.

3. Select a Master File to use first in the MATCH logical expression.

4. Click OK.

The Match Wizard opens in a new canvas. It uses typical wizard behavior in which you click
a series of Next buttons to navigate from one window to the next. You can also use the
Match Preview area to navigate the Match Wizard.

5. From the Available fields list, select the fields you want to use to build the Match request.

You can add a Match Alias (how the field appears in the HOLD file field list) and a Prefix
Operator for each field.

Note: You can remove fields from this list by clicking the Delete button. If you add more
than one field, you can also use the Move Up and Move Down buttons to rearrange the
orders of the fields.

6. Select either PRINT, SUM, or LIST from the drop-down list.

7. To add a field as BY field, click a field in the Available Fields list and click the Add field
button in the BY fields list box.

Note: You must have at least one BY field.

8. Click the Where/If tab if you want to create a WHERE expression or IF condition. This limits
the records that are merged together.

9. Click the Add WHERE expression or Add IF condition button to open the Expression Builder.
Use the Expression Builder to create the Where/If condition.

10. Click Next.

Step 3 of the Match Wizard opens.

11. Click the Browse button to select the data source you want to merge with the original data
source.

The Open File dialog box opens.

12. Select a Master File and click OK.

13. Click Next.

Step 4 of the Match Wizard opens.
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14. Add the fields for the second data source, including a Where/If field criteria if you want, as
in step 5.

15. Click Next.

Step 5 of the Match Wizard opens.

16. Type a name for the HOLD file and select the type of MATCH phrase.

17. Click Finish.

The Match Wizard - Summary window opens, where you can review the final MATCH
request.

Syntax: How to Use -HTMLFORM Syntax

-HTMLFORM sends report output to the HTML file you create for a webpage, and displays that
page in the browser. The output can be saved as an HTML file that can be displayed later. 

The syntax is:

-HTMLFORM filename [SAVE AS htmlpage]

or

-HTMLFORM BEGIN
.
.
.
-HTMLFORM END

where:

filename

Is the HTML file that contains placeholders for the report or reports that WebFOCUS
creates with the command:

ON TABLE HOLD HTMTABLE AS report                  

SAVE

Indicates that the HTML page, created when the HTML file filename and the report or
reports generated by WebFOCUS are combined, is to be saved.

AS htmlpage

Is the file name for the HTML page that is created when the HTML file filename and the
report or reports generated by WebFOCUS are combined. This file is saved so that it can
be displayed later.
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-HTMLFORM BEGIN

Indicates the beginning of an inline HTML form in a procedure.

-HTMLFORM END

Indicates the end of an inline HTML form in a procedure.

Using Dialogue Manager

Dialogue Manager is the part of the WebFOCUS language that controls the execution of your
application components and allows you to control the flow of your application with the use of
commands and variables. You can dynamically control the execution of procedures, giving you
flexibility in application design. Dialogue Manager also enables you to use variables in your
procedures and supply values for them at run time.

The following are some of the ways you can use Dialogue Manager: 

Customizing a procedure with variables. You can dynamically change the execution of a
procedure by including variables, or retrieve information from the system.

Navigating a procedure. You can conditionally execute requests, repeat execution with
program loops, or call another procedure.

Enhancing an HTML webpage. You can increase the functionality of your webpage by
including HTML commands in your procedure.

Issuing operating system commands. You can issue an operating system command to set
up an environment in which a request must run.

Controlling passwords. You can directly assign and change passwords.

Sending a message to the application. You can send a message to an application while a
procedure is processing to explain the purpose of the procedure, display results, or present
useful information.

You can create Dialogue Manager IFs, GOTOs, Labels, and REPEATs. You can also open the
Dialogue Manager canvas and create any of the other items manually.
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Dialogue Manager Variables Overview

You can write procedures containing variables with values that are unknown until run time,
allowing a user to customize the procedure by supplying different values each time it executes.
Variables fall into two categories: 

Local and global variables. Local and global variable values must be supplied at run time.
Local variables retain the values only for one procedure. Global variables retain the values
across procedures unless you explicitly clear them. You create a local variable by choosing
a name that starts with a single ampersand (&) and you can create a global variable by
choosing a name that starts with a double ampersand (&&).

System and statistical variables. System and statistical variable values are automatically
supplied by the system when a procedure references them. System and statistical
variables have names that begin with a single ampersand (&). For example, the variable
&LINES indicates how many lines of output were produced, and the variable &DATE
indicates the current date.

Dialogue Manager Processing

You can modify your application at run time with user input and environment conditions by
using Dialogue Manager stored procedures, which include commands and variables.

In App Studio, stored procedures are referred to as procedures. 

1. Processing begins from the command processor when a procedure is invoked for execution.

2. The FOCEXEC Processor reads each line of the procedure. Any variables on the line are
assigned the current values.

3. All Dialogue Manager commands execute as soon as Dialogue Manager reads them.

4. When a command line containing no Dialogue Manager commands is fully expanded with
any variables resolved (through either a -SET command or prompting), it is placed onto the
command execution stack.

5. Dialogue Manager execution commands and statistical variables route all currently stacked
commands to the WebFOCUS Command Processor.

By the time your procedure is ready for execution, the following has happened:

All variables have received values and these values have been integrated into the
command lines containing variables.

Dialogue Manager commands have been used to place WebFOCUS commands into proper
sequential order for execution.
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At this point the WebFOCUS Command Processor no longer sees any Dialogue Manager
commands. It only sees WebFOCUS command lines in the stack.

You can use the -TYPE command to send a message to the display while a procedure is
processing. Typically, the message serves the following purposes: 

Explains the purpose of the procedure.

Displays the results of a procedure or calculation during testing of a procedure.

Presents other useful information.

Indicates what type of information to supply in response to a prompt.

Navigating a Procedure

You can navigate a procedure in the following ways: 

Unconditional branching. Transfers control to a label.

Conditional branching. Transfers control to a label depending on the outcome of a test.

Looping. Performs a function repeatedly in your procedure.

Calling another procedure. Incorporates a whole or partial procedure into your procedure.

Branching Unconditionally

You can perform unconditional branching, which transfers control to a label with the -GOTO
command. 

The first time through a procedure, Dialogue Manager notes the addresses of all the labels so
they can be found immediately, if needed again. If Dialogue Manager has not stored the
address of the label in the -GOTO command, it searches forward through the procedure for the
target label. If no label is found, it begins searching at the top of the procedure.

Dialogue Manager takes no action on labels that do not have a corresponding -GOTO. If a
‑GOTO does not have a corresponding label, execution halts and a message is displayed.

Syntax: How to Branch Unconditionally

-GOTO label 
  .
  .
  .
-label [TYPE text]
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where: 

-label

Is a user-defined name of up to 64 characters. Do not use embedded blanks or the name
of any other Dialogue Manager command. Do not use arithmetic or logical operations,
words that can be confused with functions, or reserved words, such as CONTINUE.

The label text may precede or follow the -GOTO command in the procedure.

Note: When the label is specified in the -GOTO command, a dash does not precede it.

TYPE text

Sends a message to the display.

Example: Branching Unconditionally

The following example comments out all the WebFOCUS code using an unconditional branch,
instead of the user typing -* in front of every line: 

-GOTO DONE
TABLE FILE SALES
PRINT UNIT_SOLD RETURNS
BY PROD_CODE,CITY
END 
-RUN 
-DONE

Branching Conditionally

Conditional branching performs a test of the values of variables and, based on the test,
transfers control to a label in the procedure with the -IF... GOTO command. This helps control
the execution of requests and builds a dynamic procedure by choosing to execute or not
execute parts of a procedure. 

For example, you can check whether an extract file was created from a production data source.
If the extract file exists, the program runs a set of reports against the extract. If it does not
exist, the program branches around the reports and writes a message to a log file.

Note: Generally, a -IF test does not require that each test specify a target label. However, in a
compound IF test, where a series of tests are nested within each other, a specified target label
is required for each test.

Syntax: How to Branch Conditionally

-IF expression [THEN] {GOTO label1|CONTINUE} [ELSE IF...] [ELSE {GOTO 
label2|CONTINUE}] ;
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where: 

expression 

Is a valid expression. Literals do not need to be enclosed in single quotation marks unless
they contain embedded blanks or commas.

THEN

Is an optional word that increases readability of the command.

label1

Is a user-defined name of up to 64 characters to which to pass control if the -IF test is
true. Do not use embedded blanks or the name of any other Dialogue Manager command.
Do not use arithmetic or logical operations, words that can be confused with functions, or
reserved words, such as CONTINUE.

The label text may precede or follow the -IF criteria in the procedure.

CONTINUE

Continues to the command that follows the semicolon (;) of the -IF command.

Note: CONTINUE cannot be used as a label in a -IF statement.

ELSE IF

Specifies a compound -IF test. The command -IF must end with a semicolon (;) to signal
that all logic has been specified.

ELSE GOTO label2

Passes control to label2 when the -IF test fails.

If a command spans more than one line, continuation lines must begin with a hyphen (-) and
one or more spaces.

Example: Conditional Branching Based on User Input

In the following example, the first report request or the second report request, but not both,
executes. Suppose that for the procedure to run a user must supply a value for a variable
named &PROC. The user may enter SALES or EMPLOYEE. 
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1. -IF &PROC EQ 'EMPLOYEE' GOTO EMPLOYEE; 
2. -SALES
   TABLE FILE SALES
   SUM UNIT_SOLD
    BY PROD_CODE
   END 
3. -EXIT
   -EMPLOYEE
   TABLE FILE EMPLOYEE
   PRINT PLANT_NAME
    BY DEPARTMENT
   END

The procedure processes as follows:

1. The user enters the value SALES for &PROC. A -IF test is done, and since the value for
&PROC is not EMPLOYEE, the test fails and control is passed to the next line, -SALES.

If the value for &PROC had been EMPLOYEE, control would pass to -EMPLOYEE.

2. The WebFOCUS code is processed, and stacked to be executed later.

3. -EXIT executes the stacked commands. The output is sent to the display and the procedure
is terminated.

The request under the label -EMPLOYEE is not executed.

Looping in a Procedure

You can perform an action repeatedly by looping in your procedure with the -REPEAT command.
Looping can be used for many tasks. For example, you can populate an indexed variable using
a loop or use the output of a request in a second request. 

A process loop can be executed a designated number of times or until a condition is met. A
loop ends when any of the following occurs:

It is executed in its entirety.

A -EXIT command is issued.

A -GOTO is issued to a label outside of the loop.

Note: If you issue another -GOTO later in the procedure to return to the loop, the loop
proceeds from the point at which it left off.

Note that the -SET command provides another method for implementing loops.
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Tip: During loop processing, the search for labels that indicate the target of a -REPEAT or a -
GOTO command takes longer in a procedure with variable, rather than fixed (80 character),
record lengths. To speed execution in this situation, consider replacing loops with EX or -
INCLUDE commands.

Syntax: How to Specify a Loop

-REPEAT label n TIMES

or

-REPEAT label WHILE condition;

or

-REPEAT label FOR &variable [FROM fromval] [TO toval] [STEP s]

where:

label 

Identifies the code to be repeated (the loop). A label can include another loop if the label
for the second loop has a different name than the first.

n TIMES

Specifies the number of times to execute the loop. The value of n can be a local variable,
a global variable, or a constant. If it is a variable, it is evaluated only once, so you cannot
change the number of times to execute the loop. The loop can only be ended early using -
EXIT.

WHILE condition;

Specifies the condition under which to execute the loop. The condition is any logical
expression that can be true or false. The loop executes if the condition is true.

Note: The condition must be followed by a semicolon (;).

&variable 

Is a variable that is tested at the start of each execution of the loop and incremented by s
with each execution. It is compared with the value of fromval and toval, if supplied. The
loop is executed only if &variable is greater than or equal to fromval or less than or equal
to toval.

fromval

Is a constant that is compared with &variable at the start of the execution of the loop. The
default value is 1.
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toval

Is a value that is compared with &variable at the start of the execution of the loop. The
default value is 1,000,000.

STEP s

Is a constant used to increment &variable at the end of the execution of the loop. It may
be positive or negative. The default increment is 1.

Note: The parameters FROM, TO, and STEP can appear in any order.

Example: Repeating a Loop

These examples illustrate each syntactical element of -REPEAT. 

-REPEAT label n TIMES

For example:

-REPEAT LAB1 2 TIMES
-TYPE INSIDE
-LAB1 TYPE OUTSIDE

The output is:

INSIDE
INSIDE
OUTSIDE

-REPEAT label WHILE condition;

For example:

-SET &A = 1;
-REPEAT LABEL WHILE &A LE 2;
-TYPE &A
-SET &A = &A + 1;
-LABEL TYPE END: &A

The output is:

1
2
END: 3

-REPEAT label FOR &variable FROM fromval TO toval STEP s              
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For example:

-REPEAT LABEL FOR &A STEP 2 TO 4
-TYPE INSIDE &A
-LABEL TYPE OUTSIDE &A

The output is:

INSIDE 1
INSIDE 3
OUTSIDE 5

Using Variables in a Procedure

Using interactive variable substitution, you can create procedures that include variables (also
called amper variables) and supply values for them at run time. These variables store a string
of text or numbers and can be placed anywhere in a procedure. For example, a variable can
refer to a field, a command, descriptive text, or a file name. 

Note: A Dialogue Manager variable contains only alphanumeric data. If a function or expression
returns a numeric value to a Dialogue Manager variable, the value is truncated to an integer
and converted to alphanumeric format before being stored in the variable, unless you specify
the precision to use.

Variables fall into two categories:

Local and global variables have values supplied at run time. Local variable values remain in
effect for the respective procedure, while global variable values remain in effect for all
procedures executed during an entire session.

Leading double ampersands (&&) denote global variables. All other Dialogue Manager
variables begin with a single ampersand (&). For this reason, they are known as amper
variables.

System, statistical, and special variables have values that the system automatically
resolves whenever you request them.

The maximum number of local, global, system, statistical, special, and index variables
available in a procedure is 1024. Approximately 40 are reserved for use by WebFOCUS.

Variables can be used only in procedures. They are ignored if you use them while creating
reports live at the display.

You can query the values of each type of variable you use.

The values for variables may be supplied in a variety of ways.
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Reference: Naming Conventions for Local and Global Variables

Local and global variable names are user-defined, while system and statistical variables have
predefined names. The following rules apply to the naming of local and global variables:

A local variable name is always preceded by an ampersand (&). The variable can be named
or positional.

A positional variable consists of a single ampersand (&) followed by a numeric string (for
example, &1). The value of a positional variable is passed to a procedure when it is
executed.

A global variable name is always preceded by a double ampersand (&&).

A variable name can consist of up to 100 characters.

Embedded blanks are not permitted in a variable name.

If a value for a variable might contain an embedded blank, comma, or equal sign, enclose
the variable in single quotation marks when referred to.

A variable name may be any combination of the characters A through Z, 0 through 9, and
the underscore (_). The first character of the name should be a letter.

You can assign a number instead of a name to a variable to create a positional variable.

The underscore may be included in a variable name, but the following special characters
are not permitted: plus sign (+), minus sign (-), asterisk (*), slash (/), period (.), ampersand
(&), and semicolon (;).

Syntax: How to Specify a Variable Name

&[&]name

where:

&

Denotes a local variable. A single ampersand (&) followed by a numeric string denotes a
positional variable.

&&

Denotes a global variable.
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name

Is the variable name. The name you assign must follow the rules outlined for Dialogue
Manager.

Local Variables

Local variables are identified by a single ampersand (&) preceding the name of the variable.
They remain in effect throughout a single procedure. 

Example: Using Local Variables

Consider the following procedure, SALESREPORT, in which &CITY, &CODE1, and &CODE2 are
local variables:

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR &CITY"
"PRODUCT CODES FROM &CODE1 TO &CODE2"
" "
SUM UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ &CITY
BY PROD_CODE
IF PROD_CODE IS-FROM &CODE1 TO &CODE2
END

Assume you supply the following values when you call the procedure:

EX SLRPT CITY = STAMFORD, CODE1=B10, CODE2=B20

Dialogue Manager substitutes the values for the variables as follows:

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR STAMFORD"
"PRODUCT CODES FROM B10 TO B20"
" "
SUM UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ STAMFORD
BY PROD_CODE
IF PROD_CODE IS-FROM B10 TO B20
END

After the procedure executes and terminates, the values STAMFORD, B10, and B20 are lost.
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Global Variables

Global variables differ from local variables in that once a value is supplied, it remains current
throughout the WebFOCUS session unless set to another value with -SET or cleared by the LET
CLEAR command. Global variables are useful for gathering values at the start of a work
session for use by several subsequent procedures. All procedures that use a particular global
variable receive the current value until you exit from WebFOCUS. 

Global variables are specified through the use of a double ampersand (&&) preceding the
variable name. It is possible to have a local and global variable with the same name. They are
distinct and may have different values.

Example: Using Global Variables

The following example illustrates the use of three global variables: &&CITY, &&CODE1,
&&CODE2. The values are substituted in the first procedure, PROC1, and the values are
retained and passed to the second procedure, PROC2.

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR &&CITY"
SUM UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ &&CITY
BY PROD_CODE
IF PROD_CODE IS-FROM &&CODE1 TO &&CODE2
END
EX PROC2

TABLE FILE SALES
HEADING CENTER
"MONTHLY REPORT FOR &&CITY AND PRODUCT &&CODE1"
PRINT UNIT_SOLD AND RETURNS AND COMPUTE
RATIO/D5.2 = 100 * (RETURNS/UNIT_SOLD);
BY CITY
IF CITY EQ &&CITY
IF PROD_CODE EQ &&CODE1
END

Querying the Values of Variables and Parameters

Two Dialogue Manager commands enable you to: 

Display the values of all types of local, global, and system variables.

Store the value of a parameter in a variable. The stored value can then be queried with
the ? SET command.
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In addition, you can issue two QUERY (?) commands to display the values of:

Global variables. Since global variable values remain current throughout the WebFOCUS
session, it is helpful to be able to display the values on demand. The syntax is: 

? &&

Statistics stored in variables. You can query the current value of all statistical variables
(except &FOCDISORG and &FOCERRNUM). The syntax is:

? STAT

Syntax: How to Display the Value of a Variable

You can query all Dialogue Manager variables (local, global, system, and statistical) from a
stored procedure. The syntax is:

-? &[&variablename]

where: 

&

Issued alone, displays variables of all types.

variablename

Is the variable name, including the ampersand (&). Only amper variables starting with the
specified string are displayed.

The command displays the following message, followed by a list of currently defined amper
variables and the values:

CURRENTLY DEFINED & VARIABLES:

Since local variables do not exist outside a procedure, no similar query is available from the
WebFOCUS command line.

Displaying Data Sources

The Use Qualified Path Command is available when creating content. A qualified path is one
that includes all names in the hierarchic sequence above the object and the name of the
object itself.

You can select the Use Qualified Path check box to only display data sources in the selected
application folder. When the Use Qualified Path check box is unselected, all data sources in the
application path are displayed.
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When creating content or adding components to a procedure, selecting the Use Qualified Path
check box will display an application folder selection area and a data source selection area.
When the Use Qualified Path check box is unselected, only a data source selection area is
displayed.

Procedure components that use a mix of qualified and non-qualified paths for the same data
source will not work together. For example, the components that use the qualified path of a
data source will work together and the components that use the non-qualified path of the same
data source will work together.

If you want all components to work together, then all components need to either use the
qualified path of a data source, or all components need to use the non-qualified path of a data
source.
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Chapter7
Creating HTML Pages

In App Studio, you can create and edit HTML pages using the HTML canvas. When you
create a new HTML page, you use the HTML/Document Wizard.

This topic describes how to launch the HTML/Document Wizard to create HTML pages. It
also identifies and explains the tabs and panels that are available when you are
developing HTML pages in the HTML canvas.

In this chapter:

Launching the HTML/Document Wizard

Accessing HTML Page Components

Creating a Widget to Autoplay Control
Values

Using Parameters

Viewing Object Attributes

Modifying Object Population Settings

Using Tasks & Animations

Working with Requests & Data Sources

Displaying Applications in Different
Languages

Specifying Browser Defaults

Chaining in the HTML Canvas

Using JavaScript Code with HTML
Canvas Pages

Creating Responsive Web Pages

Designing Content for Smartphones

Cascading Style Sheet Support Matrix for
Internet Explorer

Cascading Style Sheet Class Mapping
List

Launching the HTML/Document Wizard

The HTML/Document Wizard allows you to create a new HTML Page, Guided Report Page, or
Document, and open a recent procedure. 

To open the HTML/Document Wizard:

On the Home tab, in the Content group, click HTML/Document.

In the Environments Tree panel, right-click an application folder, point to New, and click
HTML/Document.
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Note: If you choose to create a new HTML page using the shortcut menu in the
Environments Tree panel, your screen will not include a Navigator panel since the location
for your HTML page is already selected.

The HTML/Document Wizard opens, as shown in the following image.

From the HTML/Document Wizard, you can open a recent HTML Page/Document or create a
new one.

Procedure: How to Create an HTML Page Using the HTML/Document Wizard

After you have launched the HTML/Document Wizard, you can begin to create your HTML Page. 

1. In the File Type area, select HTML Page.

2. Navigate to where you want to create the new procedure or select a recent procedure and
click Next.

Note:

The Next button is available after you select a valid path.

If you used the shortcut menu in the Environments Tree panel to create your HTML
page, a location is already selected.

3. Optionally, you can add themes and settings to your HTML page.
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4. Click Finish.

The HTML canvas, File/Folder Properties panel, Properties panel, Settings panel,
Requests & Data sources panel, and Tasks & Animations panel open. You can now add
data to your HTML page and format the data using the tabs in the ribbon.

5. To save your HTML page, click the Save button on the Quick Access Toolbar or select Save
from the Application menu.

6. To run your HTML page, click Run on the Quick Access Toolbar or click Run from the
Application menu.

Procedure: How to Create a Guided Report Page Using the HTML/Document Wizard

After you have launched the HTML/Document Wizard, you can begin to create your own Guided
Report page. 

1. In the File Type area, select Guided Report Page.

2. Navigate to where you want to create the new procedure or select a recent procedure.

Note: If you used the shortcut menu in the Environments Tree panel to create your Guided
Report page, a location is already selected.

3. Optionally, click Next if you want to add themes and settings to your Guided Report page.

4. Click Finish.

Note: The Finish button is unavailable until you select a valid path.

The HTML canvas, File/Folder Properties panel, Properties panel, Settings panel,
Requests & Data sources panel, and Tasks & Animations panel open. You can now add
data to your HTML page and format the data using the tabs in the ribbon.

5. To save your Guided Report page, click the Save button on the Quick Access Toolbar or
select Save from the Application menu.

6. To run your Guided Report page, click Run on the Quick Access Toolbar or click Run from
the Application menu.

Accessing HTML Page Components

The following topics describe the tabs and panels that are available when you are developing
HTML pages in the HTML canvas.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  465



Inserting Components in an HTML Page Using the Components Tab

You can add a variety of components to an HTML page found in the command groups in the
Components tab. For example, suppose you want to add a button to your page that a user can
click to refresh the data. The button is a component. You select it from the Generic Elements
command group in the Components tab, then add it to your page as desired.

The Components tab contains the Reports, Generic Elements, Containers, and Objects groups,
as shown in the following image.

When you click a command from a ribbon, your mouse pointer turns into a cross-hair to let you
draw the object in the HTML canvas. If you click a command in error, press the Escape key to
return your mouse to a pointer.

Inserting a Report or Chart in an HTML Page Using the Reports Group

From the Reports group, you can add a report or chart to your HTML page. The Reports group
is shown in the following image.

The commands in the Reports group are:

Report

Inserts a report object. You can add reports to the HTML canvas that will display when you
run the layout. You can either embed or reference reports. Double-clicking a blank report
object opens the Report canvas where you can create and style a report to be used in the
HTML page.

You can also include parameters in a report whose values can be assigned with controls
that are added with the HTML canvas.
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Chart

Inserts a chart object. You can add charts to the HTML canvas that will display when you
run the layout. You can either embed or reference charts. Double-clicking on a blank chart
object will open the Chart canvas where you can create and style a chart to be used in the
HTML canvas.

Procedure: How to Add a New Report or Chart to an HTML Page

1. Insert a report or chart object by doing one of the following: 

On the Components tab, in the Reports group, click the Report or Chart.

Right-click in the layout and select New Report or New Chart from the shortcut menu.

The pointer changes into a crosshair.

2. Drag the crosshair to create a report or chart object and adjust it to the size that you want.

A report or chart object is created in the layout and assigned the name report(n) or
chart(n), where n is a number. The object will appear in gray and white to indicate that the
placeholder does not have a report or chart associated with it. Once a report or chart is
associated with the object, the object displays the contents of the report or chart if live or
simulated data is active (live data is the default) or a colored placeholder if preview is off
in the HTML Page tab, located in the App Studio Options dialog box.

3. Create a report or chart by doing one of the following:

Double-click the placeholder.

or

Right-click the placeholder and select New Report for a report, or New Chart for a chart.

The Open File dialog box appears.

4. Select the Master File you want to use and click OK.

The Report canvas opens for reports and the Chart canvas opens for charts.

5. Optionally, after creating the report or chart, you can change its properties by adjusting the
properties displayed in the Properties panel.

Procedure: How to Add an Existing Report or Chart to a Layout

1. Insert a report or chart object by doing one of the following: 

On the Components tab, in the Reports group, click Report or Chart.

Right-click in the layout and select New Report or New Chart from the shortcut menu.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  467



The pointer changes into a crosshair. Drag the crosshair to create a report or chart object
and adjust it to the size you want.

A report or chart object is created in the layout and assigned the name report(n) or
chart(n), where n is a number. The object will appear in gray and white to indicate that the
placeholder does not have a report or chart associated with it. Once a report or chart is
associated with the object, the object displays the contents of the report or chart if live or
simulated data is active (live data is the default) or a colored placeholder if preview is off
in the HTML Page tab, located in the App Studio Options dialog box.

2. Right-click the report or chart.

Select Reference existing procedure.

For a report, right-click the report object and select Import existing report.

For a chart, right-click the chart object and select Import existing chart.

The Open File dialog box appears.

3. Enter the name of the procedure you want to add to the layout.

4. Click OK.

The report or chart object appears in the Design view of the HTML canvas.

Adding Basic Elements to an HTML Page Using the Generic Elements Group

You can add a variety of basic elements. The Generic Elements group is shown in the following
image.

The commands in the Generic Elements group are:

Image

Inserts an image. You can add an image to the layout. This is useful for including graphics,
such as a company logo.

You can insert an image into your report layout and add a hyperlink. After you run your
report and click the image, you can launch a URL or run a report the same way by clicking
a hyperlink or push button.
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Note: When inserting images, images must be referenced from a specific directory
location.

Hyperlink

Inserts a hyperlink.

Button

Inserts a button. A push button enables you to execute a report or link to a URL or HTML
file. This behavior is similar to a hyperlink.

Note: You can either double click to change the text or can use the Text property in the
Properties panel.

Reset

Inserts a reset button. A reset button enables you to revert the entire page back to its
initial settings.

Save Selection

Inserts a Save Selection button. At run time, the user can select given parameters and
save them in a snapshot by clicking the Save Selection button. This creates a static HTML
file in the same folder as the source file.

The static Save Selection files are not editable in the HTML canvas or in the text editor. To
verify that a file is a Save Selection file:

1. Right-click the file in the Configured Environments tree and select Properties from the
shortcut menu.

The File/Folder Properties panel opens.

2. The value for the Properties attribute is tool=saveparam. This indicates that the file is
not editable in the HTML canvas or in the text editor.

Label

Inserts a label. The label component lets you create and name a label, and link it to a
control. To link a label to a control, you can select a value from the HtmlFor property drop-
down list in the Properties panel, or you can select the Bind label to option from the
shortcut menu, when the label and control are both selected.

Text

Inserts a text box. You can add text to the layout. This is useful for including headings for
your webpage, or adding directions or explanations for your report or chart.
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Line

Inserts a line. You can add a horizontal or vertical line to the layout. This is useful for
distinguishing between sections of your launch or display page.

Menu

Inserts a menu. You can add a horizontal or vertical menu to the layout. This component
can be used with Maintain code.

Table

Inserts a table. This component can be used with Maintain code.

Grid

Inserts a grid.

Procedure: How to Format Text in an HTML Page

You may apply various formatting and style options to words and individual text characters
within the text object. 

Note: Any formatting and styling that you have applied to individual text strings within the text
object will remain unchanged. Changes made to the entire text object are only applied to part
of the text string that has not been formatted.

1. On the Components tab, in the Generic Elements group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Select the text that you wish to format:

To format the entire text object, single-click the text object in the layout.

To format an individual word or text character, highlight part of the text within the text
object.

4. Right-click the text, point to Style, and then click Font.

The Style Composer dialog box opens with Font selected automatically.

Note: You can also access font formatting options in the Properties panel.

5. Select from the formatting options available. You can change the type, style, color, size,
and effect of the font.

Note: When you enter a Specific font size, the unit defaults to px (pixels).
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6. Click OK to close the Style Composer dialog box.

The formatting options that you selected are applied to the text.

Procedure: How to Insert a Bulleted List or Numbered List Into a Text Element

To insert a bulleted list or numbered list into a text object: 

1. On the Components tab, in the Generic Elements group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Add multiple lines of text to the text object.

4. Highlight and right-click the text that you want to include in the list.

5. In the shortcut menu, select one of the following list options:

Bullets

Disc

Circle

Square

None

Numbering

Numbers

Lowercase Letters

Uppercase Letters

Small Roman numerals

Large Roman numerals

None

Note:

Alternatively, you can select a bullet type before typing text to begin the list. Pressing
enter will begin the next item in the list on a separate line.
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To change the bullet or number list type of an existing list, place your pointer on the list
level you want to change and reselect a bullet or number list type. Selecting None will
remove the bullets or numbers for that level and move any nested lists up one level. In
order to switch between bullets and numbers, you must first remove the current list
option by selecting None and then applying the list option you want.

Procedure: How to Insert Nested Lists Into a Text Element

To insert a nested list into the text object:

1. On the Components tab, in the Generic Elements group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Add a list to the text object. For more information, see How to Insert a Bulleted List or
Numbered List Into a Text Element on page 471.

4. Place your pointer after a list item.

5. Right-click, point to Nested List and then select a bulleted or numbered list option.

A list is started within the current list, allowing you to enter text on that list level.

Note: Pressing Tab while your pointer is on the same line as a list item will move that item
one level down, resulting in a nested list. The bullet or number type selected is the next
list type in the right-click shortcut menu. For example, if you have a bulleted list that uses
the disc bullet type, pressing Tab to move an item down one level will cause that nested
list to have the circle bullet type.

You can continue to nest lists within other lists by using the same steps shown above.

Note: You cannot skip a list level. For example, in order to insert a nested bulleted list or
nested numbered list on a lower level, there must be a list one level up from it.

Adding Containers to an HTML Page Using the Containers Group

You can add specific containers that group objects together on an HTML page. The Containers
group is shown in the following image.
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The commands in the Containers group are:

Form

Inserts either a multi-layer form or single-layer form.

Tab

Inserts a tab control. Tab controls enable you to create multiple pages in one HTML form
and present a better display for viewing secondary information. You can select Top,
Bottom, Left, or Right. This means you can choose to add a tab control that displays tabs
at the top, bottom, left, or right on the control.

You can drag and resize this object, at run time, if the Enable dragging and Enable resizing
properties, in the Properties panel, are set to Yes.

To change the header text, you can either double click and change the header text or enter
a value in the Selected Page: Title property.

When a tab control object is added to the layout, each tab control consists of:

A tab item.

A tab item is the tab label. You may edit the name of the tab item, style the tab item,
and add multiple tab items. Each tab item is associated with a tab body.

A tab body.

A tab body is the tab page where you associate your components, such as report and
graph objects, images, and lines.

The Tab control can be displayed as a full screen or part of an HTML page.

Accordion

Inserts an Accordion styled box. You can drag and resize this object, at run time, if the
Enable dragging and Enable resizing properties, in the Properties panel, are set to Yes.

To change the header text, you can either double click and change the header text or enter
a value in the Selected Page: Title property.

Window

Inserts a window. You can drag and resize this object, at run time, if the Enable dragging
and Enable resizing properties, in the Properties panel, are set to Yes.

To change the header text, you can either double click and change the header text or enter
a value in the Selected Page: Title property.
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Output Widget

Inserts an output widget. The output widget container includes buttons in the widget title
bar that let you display or hide filter controls and that let you maximize to display full-
screen, and minimize to return it to its original size.

Maintain Data App

Inserts a Maintain Data app window. You can drag and resize this object, at run time, if the
Enable dragging and Enable resizing properties, in the Properties panel, are set to Yes.

Group Box

Inserts a group box. A group box can be used to create a border around a group of objects,
for example, forms or reports and charts.

Panel

Inserts a panel to group objects together. The panel is invisible at run time.

Procedure: How to Use a Form Object to Create a Pop-Up Dialog Box

You can use a form object to create a pop-up dialog box.

1. Create a form object.

2. Create a button.

3. Select the form.

4. In the Properties panel, change the Display container as property to As popup dialog.

5. Create a new task in the Tasks section of the Tasks & Animations panel.

6. Use the button you create as the trigger.

7. Make the button object toggle the visibility of the form you created.

8. Run the page and click the button to display the form as a dialog box.

Procedure: How to Create a Pop-Up Dialog Box or Pop-Up Window From a Form Control

1. Add a button object to your HTML page.

2. Add a form control to your HTML page.

3. Delete the run and back buttons created with the form control.

4. While the form control is selected, in the Properties panel, change the Display container
as property to either As popup dialog or As popup window.

As popup dialog causes the form to display as a pop-up dialog box. When the dialog box is
displayed, you must click Close to return to your HTML page.
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As popup window causes the form to display as a pop-up window. When the window is
displayed, you can resize and move the window around your screen.

5. Create a new task in the Tasks section of the Tasks and Animations panel that uses the
button object to toggle the visibility of the form you created.

6. Run your HTML page.
When you click the button you added to the HTML page, the form will be displayed as
either a pop-up dialog box or a pop-up window, depending on what option you selected.

Reordering Tabs, Accordions, and Windows

You can reorder tabs, accordions, and windows by dragging the page that you want to appear
first onto the page that you want it to display before. For example, if you have 3 tabs, Tab1,
Tab2, and Tab3, and you drag Tab3 onto Tab1, Tab3 will now display ahead of Tab1. The order
of the tabs will then be Tab3, Tab1, Tab2. You can reorder windows when they are in tile view.

Adding Objects to an HTML Page Using the Objects Group

You can add objects other than reports, charts, elements, or containers to customize your
HTML page. The Objects group is shown in the following image.

The commands in the Objects group are:

Frame

Inserts a frame object. You can use a frame to embed additional web sources or run
reports. You can also use a frame as the output location or target for a drill-down report.
You can also use a frame to run a table of contents report, an OLAP report, a PDF report,
or an Excel® report.

Flash

Inserts a Flash component. You can add SWF files that are Adobe® Flash Player
compatible to accompany reports or graphs on an HTML page.

Note: When inserting Flash animations, only files that are 1 MB or smaller can be run
using the HTML canvas.
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Map

Inserts a map object. You can add a Google™ or ESRI map to your HTML page. Maps are
services offering powerful, user-friendly mapping technology that can be customized to
show points on a map with drill-down capabilities. You can customize the map properties
and bind them to a report or chart.

GIS Flex Viewer

Inserts a GIS Flex Viewer object. The GIS Flex Viewer contains numerous controls, a report,
and a map object. This command is available only from the Data Servers area.

HTML

Inserts an HTML object. Developers can use the Settings panel to type a valid snippet of
HTML code for the HTML object, such as HTML code to browse for a file.

ESRI Map

Inserts an ESRI map object. You can use the Settings panel to configure the properties
and components.

Changing Load Order With HTML Object Manipulation

In an HTML page, objects load in the order in which they were added to the canvas. A
developer using raw HTML has the option of editing the source code to change the load order.
Such edits leverage the Document Object Model (DOM) for HTML and XML documents.

In App Studio, however, the source code cannot be edited. Therefore, the HTML object
manipulation menu is provided to allow you to change the load order, if necessary.

To change the load order, select multiple objects or components in the HTML canvas, then
right-click and select HTML object manipulation. The following menu options are available:

Add selected to new container. To put a container around two or more multiselected
objects. Objects in a container load at the same time.

Append selected. Available when the last multi-selected object is a container. Use this
option to move one or more multi-selected objects into the container.

Insert selected before. To load the last multiselected object before the other selected
objects.

Insert selected after. To load the last multiselected object after the other selected objects.

Swap selected. To swap positions for two multiselected objects.
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Accessibility Support for Displaying Objects in the Order of the Document Object Model

You can add elements/objects independently of screen reading order and then change the
order later on during the development process.

Using the Accessible property, available on the Properties panel for a document, you can
indicate that the Document Object Model (DOM) should be rewritten in the order of objects on
the page, left to right, top to bottom. In addition, all tab index values should be set to the
value -1.

Procedure: How to Display Objects in the Order of the DOM

1. Create a new HTML page with multiple controls on the page.

2. On the Properties panel for the document, select Yes from the Accessible drop-down
menu, as shown in the following image.
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The following tab order warning message appears, as shown in the following image.

Note: The Warning message displays only once, when the Accessibility property is set to
Yes.

Selecting Yes will write the tab order of objects on the page, left to right, top to bottom.
Selecting No will keep the tab order in the page.

Inserting Controls in an HTML Page Using the Controls Tab

You can use the Controls tab and group to insert controls in an HTML page or a Guided Report
page. Controls enable you to prompt users for a parameter value. When you create a
parameter as part of a report or graph, the HTML canvas automatically adds a control, Submit
button, and Reset button for the parameter to your layout, and the parameter appears on the
Parameters tab. You can also add an input control and bind it to a parameter. 

Controls, with the exception of a text box which does not supply a list of possible values, can
supply values with a dynamic or static list of values:

A dynamic list retrieves values from a specified data source when the request is run.

A static list consists of a list of values you supply. These values do not change unless you
change them.

An active report control lists active report values that mimic active report menu items. The
active report controls cannot be associated to any parameters in the layout. This type of
control can only be associated with an active report in the layout.
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The properties of a control, as well as the parameters associated with each control, can be
controlled with the Properties tab of the Properties window, and with the Parameters tab. The
Controls tab is shown in the following image.

The controls are:

Edit Box

Inserts a text box. A text box enables you to enter a value in an entry field. You can specify
a list of static or dynamic accepted values in Settings panel and, at run time, when you
type the first letter of a value into the text box, that value will be listed as an autocomplete
suggestion.

Hidden

Inserts a hidden control. A hidden input control allows parameter values to be used in a
control without the user seeing them. When a hidden control is used, the current input
control assigned to the parameter will not be visible. The value of the parameter can be
entered in the Properties panel of the Parameters tab, or supplied through chaining.

Drop Down

Inserts a drop-down list. A drop-down list enables you to select single or multiple values
from a list of supplied values. In order to provide multiple values, the procedure must be
set up to accept multiple values.

A single-select drop-down list enables you to select only one value for each time a
request is run.

A multiselect drop-down list enables you to select multiple values using the check
boxes adjacent to the values.

You can use a dynamic or static list of values for the drop-down list.

List Box

Inserts a list. This enables you to select single or multiple values at one time:

A single-select list enables you to select only one value for each time a request is run.

A multiselect list enables you to select multiple values by using the Ctrl key while
selecting values.
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In order to provide multiple values, the procedure must be set up to accept multiple
values.

List box values can be dynamic or static.

Double list

Inserts a double list. Displays multiselect values. This enables you to view a list of the
available values and add or remove them from one list to another. At run time, a report is
generated based on the values that are added.

Radio Button

Inserts a radio button. Radio buttons enable you to select a single value from a list of
supplied values. Radio button values can be static or dynamic.

Use the Type property to control the appearance of the radio buttons. From the drop-down
list box in the Type field, select Standard to display standard radio buttons.

From the drop-down list box in the Type field, select Push button to display push buttons.

Check Box

Inserts a check box. Check boxes enable you to select a single value from a list of
supplied values. Note that if there are multiple check box input controls that are grouped
together, you may select the Multiple properties for each control. Multiple ensures that you
can select a single value from each check box control. Check box list values can be
dynamic or static.

Use the Type property to control the appearance of the check boxes. From the drop-down
list box in the Type field, select Standard to display standard check boxes.

From the drop-down list box in the Type field, select Push button to display push buttons.

Text area

Inserts a text area. A text area is a single-select control that enables you to enter multiple
lines of text that can be assigned to a single variable. The behavior is similar to a text box,
but you are not restricted to entering just one line of text. For example, if you want to
assign a paragraph (multiple lines of text) to a variable that can be referenced by a
procedure, you can add the paragraph to a text area from the Properties panel on the
Parameters tab.

If you want to display text in the control:

When hard wrap is enabled, at run time, a line break is shown at the point where it was
specified.
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For soft wrap, the line should wrap automatically depending on the size of the text area
control.

If you want to submit values in the control:

For single-select text area controls, only the first value up to the end of the line will be
submitted.

For multiselect text area controls, all of the values separated by OR or AND will be
submitted.

Tree

Inserts either a single-source tree control or multi-source tree control. By using a tree
structure in an HTML report, you can show hierarchical data from a multi-dimensional data
source (for example, SAP BW), that uses the parent/child model. You may also use a tree
control for non-hierarchical data sources. Level hierarchies are not supported. The behavior
of the tree control is integrated with the parameter definition. If a parameter is defined as
a single value and that parameter is bound to a tree control, the tree control uses option
buttons for each node in the hierarchy. If the parameter is defined as Multiselect OR or
Multiselect AND, and that parameter is bound to a tree control, then the tree control uses
check boxes for each node in the hierarchy, enabling you to select multiple nodes.

Calendar

Inserts a calendar. Date parameters can utilize a built-in calendar control that enables you
to select the desired date or range of dates in a pop-up dynamic calendar. A procedure or
parameter that is added to or referenced in the HTML canvas, and contains date
parameters, will have a Calendar control type available in the New Parameters dialog box.
When you select the Calendar control type, a text box with a calendar icon displays in the
Design view of the layout. The text box is the only control available for the calendar, and
the icon always displays to the right of the text box. The icon cannot be positioned
independently from the text box. Note that when programmatically returning a date to the
calendar, the date must be in a WebFOCUS date format that specifies the complete date
from the list of supported data types in Calendar Properties.

Slider

Inserts a horizontal or vertical slider control that has a numeric range of values to be used
with a report or chart. This enables you to use a slider bar to select from a range of
values.
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Adding Paging/Search Capabilities to a Control

With a List Box, Drop Down List, or the first control of a Double List, you can add additional
paging and search capabilities. Designed for controls that have a large number of valid values,
this functionality enables you to:

Page through a large list of values before making a selection.

Search for a value within a control.

These options give you a quick way of narrowing your search when you know the value, or
partial value, that you want to use to filter your page.

The Add 'Paging/Search' control function is available on the HTML canvas through the right-
click context menu for the List Box, Drop Down List, and the first control of a Double List.

Use this function to enhance the capabilities of an individual control. If you want to create a
single Paging/Search option that applies to multiple controls on a page, see Adding a Paging/
Search Control to an HTML Page on page 483.

Procedure: How to Add Paging/Search Capability to a Control

To add paging and search capabilities to a control that has a large number of valid values:

1. On the HTML canvas, select a List Box, Drop Down List, or the first control of a Double
List, then right-click the control and select Add 'Paging/Search' control from the context
menu.

The paging/search control is added to the canvas below the input control. The following
image shows the paging/search control added below a Drop Down List for Product
Subcategory:

Note, the blue left and right arrow buttons are for paging. The gray magnifying glass and
arrow buttons are for searching.

At run time, the paging/search control shows a number or page range of values. The
default range is 1-50, meaning the input control starts at the first value and displays a
range of 50 values per page.

To change the default range, click the paging/search control and view the Number or
Range attribute on the Properties tab. Change the value here as needed.
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2. Run the HTML page.

The paging/search control shows the specified range. For example, 1-50.

3. Use the arrow buttons to page through the values to be displayed for the input control.
You may select First, Previous, Next, or Last.

For searching, enter a search term in the paging/search control and press the Enter key or
click the Search (magnifying glass) button.

To display search criteria, click the search arrow button on the far right. The search criteria
list is displayed. You can select any of the following options:

Match Prefix. Search value prefix must match the prefix of the value in the input
control.

Match Case. Search value must match the value in the input control exactly.

Match Whole Word Only. Search value word must exist in the string.

Instant Search. The value is automatically searched as you type in the input control.

Toggle the search arrow button to hide the search criteria list.

4. Click the Run button to refresh the report, showing the value selected in the input control.

Adding a Paging/Search Control to an HTML Page

The Global search/paging control property lets you add additional capabilities to an HTML page
that contains multiple instances of the following controls: List Box, Drop Down List, and the
first control of a Double List. Designed for controls that have a large number of valid values,
this functionality enables you to:

Page through a large list of values before making a selection.

Search for a value within multiple controls.

The Global search/paging control is a DOCUMENT level property.

Use this option to enhance the functionality of an HTML page. If you want to enhance the
functionality of an individual control, see Adding Paging/Search Capabilities to a Control on
page 482.

Procedure: How to Add a Paging/Search Control to an HTML Page

Use this procedure to add global paging and search capabilities to an HTML page with multiple
controls.
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The Global control option overrides individual control options. If Keep selected values is
selected for Global searching/paging, that will override whether the double-list has it,
regardless of whether it is set for the control itself.

1. Click the Global search/paging control property in the Properties tab for the DOCUMENT
object and select Yes from the drop-down menu.

2. Run the HTML page.

The Search/Paging control appears in the upper right corner of the window (Home
position).

3. Click an input control.

The Search/Paging control appears below the selected input control.

The label for the input control is displayed showing that it is linked to that input control. If
no label is associated with the input control, the window will show the unique identifier for
the input control, for example, combobox1.

If you want multiple pages, type a range in the Search/Paging field in the format 1-2 of 4
and press the Enter key.

4. Click the Show settings button on the Global Search and Paging window to expand the
window and show the search and paging options.

The Search/Paging options are:

Match Prefix. Search value prefix must match the prefix of the value in the input
control.

Match Case. Search value must match the value in the input control exactly.

Match Whole Word Only. Search value word must exist in the string.

Instant Search. The value is automatically searched as you type in the input control.

Auto-link to selected control. Link the Search/Paging control to the selected control
(default).

Keep selected values. This option only affects a double-list. When selected, this option
accumulates the values you searched for, in the right-side pane. When you search for
another value, the previously searched values will not be deleted.

Toggle the Up arrow button to display and collapse the Search/Paging options. Click the
Home icon on the Search/Paging window to move the window back to the Home position.
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Procedure: How to Format Selected and Unselected Push Buttons for Radio Button and Checkbox
Controls

This procedure shows how you create a push button form from a radio button or checkbox
control. It also shows how you can apply background color to push buttons to distinguish
between selected and unselected values.

1. In the HTML canvas, create a radio button or check box control by clicking Radio Button or
Check Box on the Controls tab of the ribbon. Populate the control with multiple values.

2. Select the control and open the Properties panel.

3. In the Properties panel, from the Type drop-down menu, select Push button.

Two additional properties appear: Selected pushbutton background color and Unselected
pushbutton background color.

4. From the Selected pushbutton background color drop-down menu, select a background
color.

5. From the Unselected pushbutton background color drop-down menu, select a different
background color.

6. Save and run the HTML file.

The specified background colors appear for the selected and unselected values.

Procedure: How to Set Calendar Properties

1. Add a calendar to the HTML page by clicking the Calendar command on the Controls tab.

Position the cursor over the HTML canvas. The pointer changes to a crosshair.

2. Drag the crosshair to create a calendar and adjust it to the size you want.

A calendar placeholder is created in the layout and assigned the name calendar(n), where
(n) is a number.

3. Optionally, change the calendar properties by adjusting the properties displayed in the
Properties panel.

4. Bind an existing parameter to the calendar.

Binding a parameter to a calendar control creates an incoming parameter. The incoming
parameter value must be in a WebFOCUS date format that specifies the complete date
from the list of supported data types in Calendar Properties. The incoming parameter value
will populate the calendar with date values.

Click the Parameters view tab.

Select the center of the parameter name object, drag the parameter to the center of
the calendar object, and release the mouse to complete the binding.
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To unbind the parameter from the calendar, select the arrow head on the line, so that
the line is bold. Right-click and click Break binding.

5. Bind the calendar to a parameter.

Binding the calendar to a parameter will populate the parameter with a date value.

Click the Parameters view tab.

The Settings panel opens, showing the calendar setup options. The calendar setup
options enable you to set the range of dates available to the user at run time. Available
dates are represented as an active hyperlink (blue and underlined). Unavailable dates
are static (black without underlines).

Note: The Settings panel for a calendar contains different options depending on the
selected data type.

Create the values for the calendar. You can create Static or Dynamic values.

When the Current/Start date option is checked, the current date will be used in the
calendar control at run time.

The Date Range options for setting up the calendar include:

Static. This option will set a static date range in which the developer will select a
start date and an end date using a pop-up calendar icon, or by clicking the month,
day, or year from the controls.

The pop-up calendar icon appears in the From and To sections when the Static Date
Range is selected. If you click the pop-up calendar icon, a pop-up calendar appears
and shows the current date selected and circled in red by default. As you scroll
through the calendar with the left/right arrows, the currently selected day will
remain highlighted for each month. Clicking a date will add that date to the control.
Dates can be selected by scrolling left to right, entering the month, day, and year as
text, or by selecting the month, day, and year from the drop-down list and spin
boxes.

Relative. This option allows you to set a specific number of days, months, and
years relative to the current date. The current date (at run time) will always be the
reference or starting point and the calendar will show a number of days, months,
and years relative to the current date. The range could be all in the past (for
example, five years prior to the current date) or all in the future (for example, five
years in the future). This is selected as the default Date Range.
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Dynamic. This option allows you to point to a request that returns a range of dates.
Clicking the Select custom request drop-down list box allows you to choose a
preexisting request. The request must return two date values on the same data line
in XML format. The date values must be returned in a format that returns two digits
for the month and day, and four digits for the year, for example, MM/DD/YYYY.

Select the center of the calendar, drag the calendar to the center of the parameter
object, and release the mouse to complete the binding.

Working With a Double-Head Slider Control

A double-head slider control is a new control you can access from the HTML canvas. A double-
head slider control is a type of slider control in which you can select a range of values for
displaying data in a report or chart. Rather than having one slider head, you have two. In order
to use a double-head slider control, you must have two variables in the report or chart that will
be controlled by the double-head slider control. One variable will be controlled by one head of
the double-head slider control and the other variable will be controlled by the other head of the
double-head slider control. The variables need to be specified in the procedure as FROM and
TO. 

Note: You can use the Report canvas to create a parameter that accepts a range of values
using the Expression Builder dialog box. The Chart canvas requires you to manually create a
parameter that accepts a range of values.

Procedure: How to Create a Report That Can Be Used With a Double-head Slider Control

1. Create a new report.

2. Add the fields you want displayed in your report.

3. On the Report tab, in the Filter group, select Filter, and then click Where to create a Where
filter.

The Expression Builder dialog box opens.

4. Double-click the field you want to use in conjunction with the Double-head slider control.

5. From the Logical Relation drop-down list, select Is From.

This indicates that the parameter that you are creating is a range of values.

6. Double-click the Compare Value cell to open the Range Builder dialog box.

In the Range Builder dialog box, you can name the parameters you will use for the Double-
head slider control or select a field whose values you want to create a range from.

7. Type an amper variable name in the From text box. For example, &Value1.

This is the FROM value.
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8. Type an amper variable name in the To text box. For example, &Value2.

This is the TO value.

These are the names of the two parameters that will be controlled by the double-head
slider control.

9. Save and close the report.

This report can now be used with a double-head slider control once you set up your HTML
page.

Procedure: How to Create a Double-head Slider Control From the Ribbon

1. While in the HTML canvas, click either Horizontal or Vertical, from the Slider command, in
the Controls group, on the Controls tab.

The pointer changes to a crosshair.

2. Drag the crosshair to create a single-head slider control.

3. While the single-head slider control is selected, in the Properties panel, change the Range
property from No to Yes.

Changing the Range property to Yes changes the single-head slider control to a double-
head slider control. You can now use this control to select a range of values to display.

Procedure: How to Create a Double-head Slider Control Using the New Parameters Dialog Box

1. Create a report object or chart object on the HTML canvas.

The pointer changes to a crosshair.

2. Drag the crosshair to create a report or chart

3. Create, import, or reference a report or chart with two variables used in a FROM... TO...
relationship.

The New Parameters dialog box opens.

4. In the Control Type column of the New Parameters dialog box, right-click the first
parameter and then click Slider, and select either Double-head Horizontal or Double-head
Vertical.

Note that the Control Type for the second parameter changes to Append to Above. This
means that the second parameter has been recognized as being part of a range and will
be controlled by the double-head slider control specified in the first parameter.
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Procedure: How to Create an HTML Page That Uses a Double-head Slider Control

1. Create a new HTML page.

2. Add a report object to the HTML canvas.

3. Create, import, or reference a report that contains a variable that accepts a range of
values.

The New Parameters dialog box opens.

4. In the Control Type column of the New Parameters dialog box, right-click the first
parameter, click Slider, and then select either Double-head Horizontal or Double-head
Vertical.

Note that the Control Type for the second parameter changes to Append to Above. This
means that the second parameter has been recognized as being part of a range and will
be controlled by the double-head slider control specified in the first parameter.

5. Click OK to close the New Parameters dialog box and add the double-head slider control to
the HTML page.

6. Click the Parameters view tab at the bottom of the HTML canvas.

7. Drag the unbound parameter out of the Unbound Parameters box.

8. Drag the second half of the slider control to the unbound parameter.

9. Click the slider control and click the Settings panel.

10. In the Input Control Population section, change the Data type to Dynamic.

11. Select the data source you used in the Data Source drop-down list.

12. In the Value Field, click the ellipsis (...) and select the field being controlled by the double-
head slider control.

13. Save and run your HTML page.

The double-head slider control controls what you see in your report or chart by allowing you
to select a range of values rather than one specific value or all values. The first head
updates the FROM value and the second head updates the TO value.

Procedure: How to Enter Masked Text in a Text Box

When entering a value in a text box at run time, you may set the Mask text property so that the
text is not displayed as text, but masked by default characters. This is recommended when
using passwords or other sensitive information. 

1. Select the Edit Box object to view the associated properties in the Properties panel.
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2. From the Mask text property field, select Yes.

3. Run the report and enter a value in the text box.

The value being entered appears as masked text.

Using Multi-Select Lists

Two types of multi-select lists can be used in a report: a regular list box or a drop-down list.
When using either type of multi-select input control to supply parameter values, the Multiple
property value indicates whether multiple values can be selected from a list of supplied values
at run time.

Procedure: How to Create a List Box with Multiple Values

A multi-select list box enables you to select multiple values by using the Ctrl key while
selecting values. In order to select multiple values in the list box, the procedure must be set
up to accept multiple values. Ensure that the Variable Type for the parameter value is
Multiselect OR or Multiselect AND in the procedure.

1. From the HTML canvas, insert a report with parameters that accept multiple values.

For example, create a report with Multiselect OR as the variable type for the parameter,
accepting a dynamic list of values from a Master File.

2. When the New Parameters dialog box is displayed, accept the default control type of List
box and click OK.

A list box is created in the layout and assigned the name listbox(n), where (n) is a number.

3. Select Multiple from the Multiple drop-down list in the Properties panel.

This indicates that multiple items can be selected from the list box.

4. Save and run the HTML page.

5. Select multiple values by using the Ctrl key while selecting values from the list box.

6. Click the Run button to run the report with the selected value parameters.

Procedure: How to Create a Drop-Down Check Box List with Multiple Values

A multiselect drop-down list enables you to select multiple values using the check boxes
adjacent to the values. In order to select multiple values in the drop-down list, the procedure
must be set up to accept multiple values. Ensure that the Variable Type for the parameter
value is Multiselect OR or Multiselect AND in the procedure. 

1. From the HTML canvas, insert a report with parameters that accept multiple values.

For example, create a report with Multiselect OR as the variable type for the parameter,
accepting a dynamic list of values from a Master File.
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2. When the New Parameters dialog box appears, accept the default control type of List box
and click OK.

A list box is created in the layout and assigned the name listbox(n), where (n) is a number.

3. Right-click the control, select Set Control Type, and select Drop down list to change the
control type.

Note: In the Properties panel, the Multiple property for the control is automatically set to
Multiple.

4. Save and run the HTML page.

5. Select multiple values using the check boxes displayed when you click the down arrow.

6. Click outside of the control to close the drop-down list.

7. Click the Run button to run the report with the selected value parameters.

Saving Control Selections in a Browser Session

You can link the controls on HTML pages so that they automatically default to the same
selected value when you switch between multiple pages in the same browser session. To do
this, you need to assign a common value to the Global name property for each control that you
want to link.

For example, you may have two HTML pages that contain controls with information that relates
to regional sales. You can assign a value to the Global name property, such as Region, to each
of the controls that you want to link. When you run those pages in the same browser session,
and choose a value from one of the linked controls, such as Southeast, the controls on the
other pages will refresh and display the information for the Southeast, by default.

Note: A selected value is retained as the default only during a single browser session. The
value is not retained after you close the browser.

Procedure: How to Save Control Selections in a Browser Session

This procedure describes how to assign a value to the Global name property, which enables
you to save control selections within a browser session.

Note: A selected value is retained as the default only during a single browser session. The
value is not retained after you close the browser.

1. Create or open an HTML page that contains a control.

2. Click the control to highlight it.

3. In the Properties panel, under Miscellaneous, type a value in the Global name field. This
value can be any alphanumeric string, such as GlobalRegion1.
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4. Save the HTML page.

5. Repeat steps 1-4 for any controls that you want to link. You must assign the same Global
name property value for each control that you want to link.

Using Tree Controls

You can insert a single-source tree control or a multi-source tree control in an HTML page.

Procedure: How to Add a Tree Control to an HTML Page Using a Default Procedure

This procedure describes how to add a tree control for a multi-dimensional data source, using
a default procedure. 

Note: In prior releases, a default procedure was known as an “Embedded Procedure.”

1. In the HTML canvas, insert a tree control from the Controls tab.

Tip: You may select Single source Tree control or Multi source Tree control. If no type is
selected, Single source Tree control is the default. Single source Tree controls must be
populated from a multi-dimensional data source such as SAP BW, SSAS, or Essbase.

The pointer changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name treecontrol(n), where (n) is a
number.

3. Optionally, you may click the Expanded property from the Properties panel to show the tree
control expanded at run time.

4. Optionally, you may click the Hyperlink property from the Properties panel to show the tree
nodes as hyperlinks, instead of radio buttons at run time.

5. From the Settings panel, click Dynamic as the Data type.

6. Keep Default selected and click the browse (...) button adjacent to the Data Source field.

The Open File dialog box appears.

7. Select a multi-dimensional data source and click OK.

The multi-dimensional data source is added as the default procedure.

8. Click the browse (...) button adjacent to Value from field to select a field from the
hierarchy.

The Value from field is the data source field from which the values will be retrieved.

9. Click the browse (...) button adjacent to Display from field to select a field from the
hierarchy.

The Display field is the text that represents the parameter value in the tree control.
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10. Save and run the page to view the multi-dimensional data source in the tree control.

Procedure: How to Add a Tree Control to an HTML Page Using an Existing Procedure

You can select an existing procedure to add to the tree control in an HTML page. When you
select a procedure, it should use fields from the parent/child hierarchy and be set up as
follows: 

TABLE FILE file 
SUM FST.dispfield 
BY ParentUniqueField 
BY UniqueField 
BY datafield 
ON TABLE PCHOLD FORMAT XML 
END

where:

file

Is the name of the data source.

dispfield 

Is the field whose values display in the tree control.

ParentUniqueField

Is the field that represents the parent for the parent/child hierarchy (PROPERTY =
PARENT_OF).

UniqueField

Is the field that represents the unique IDs for the hierarchy members (PROPERTY=UID).

datafield 

Is the field whose values are passed as the parameter value.

After the procedure is set up, follow these steps:

1. From the Controls tab, insert a tree control.

Tip: You may select Single source Tree control or Multi source Tree control. If no type is
selected, Single source Tree control is the default. Single source Tree controls must be
populated from a multi-dimensional data source such as SAP BW, SSAS, or Essbase.

The pointer changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name treecontrol(n), where (n) is a
number.
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3. Optionally, you may click the Expanded property from the Properties panel to show the tree
control expanded at run time.

4. Optionally, you may click the Hyperlink property from the Properties panel to show the tree
nodes as hyperlinks, instead of radio buttons at run time.

5. From the Settings panel, click Dynamic as the Data type.

6. Select Explicit (Requests panel), select a procedure from the Request drop-down list, and
then click OK.

The procedure name is added as the explicit procedure.

Note: In prior releases, an explicit procedure was known as an “external” procedure.

7. Click the browse (...) button adjacent to Value from field to select a field from the hierarchy
or type the field manually.

The Value from field is the data source field from which the values will be retrieved.

8. Click the browse (...) button adjacent to Display from field to select a field from the
hierarchy or type the field manually.

The Display field is the text that represents the parameter value in the tree control.

9. Save and run the page to view the multi-dimensional data source in the tree control.

Procedure: How to Populate a Multi Source Tree Control

You can show a tree structure for a non-hierarchical data source by using a tree control. By
identifying the number of levels for the tree control, you are able to populate each level of the
tree control with its own procedure. Setting the number of levels creates a tree structure by
which each level is its own subcontrol, chained together with no conditions.

This procedure describes how to add parameters for a tree control, where the number of levels
property is set.

1. In the HTML canvas, insert a Multi source tree control.

Click Multi source Tree control from the Tree control drop-down list, located on the
Controls tab.

The pointer changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name treecontrol(n), where (n) is a
number.

3. From the Properties panel, type in the Number of levels for the tree control, and press the
Enter key.

This enables you to specify the number of levels to populate.
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4. Optionally, you may click the Expanded property from the Properties panel to show the tree
control expanded at run time.

5. With the tree control selected, click the Parameters tab.

The tree control object shows the set number of levels.

6. Select each level of the tree control and create the settings for its data population.

When creating a Multi source Tree control, the static data type is not available. If creating
static values for the tree control, you must create a single source tree control.

7. Optionally, to add an additional level for the tree control, right-click the tree control object
on the Parameters tab and select Add level.

Note: Add level only appears for a Multi source tree control object.

8. Click the added level to view the Settings panel for that level.

9. Switch to the Design tab of the HTML canvas to preview the populated tree control.

Note that the Properties window drop-down list for the tree control shows each level of
input values.

10. Save and run the page.

Note: If a user selects a lower level node in one level and a higher level node in another
level, when the procedure is executed, only the lowest level selections will take effect. For
example, you have 3 levels: COUNTRY, CAR, and MODEL. Under ENGLAND, TRIUMPH you
select TR7. Under FRANCE, you select PEUGEOT. At run time you will only receive the
records for TR7 because you did not select a MODEL under the FRANCE node.

The tree control populates each level with values.

Note: A value must be selected for each level before you can click the Save Selection
button.

If a selected value is specified for a field that is not in level1, then corresponding selected
values must also be specified for the preceding levels.

Only the first and second levels load at run time. If a selected value is specified for a field
in level1, only values from the first two levels will be selected.

Procedure: How to Add a Tree Control to an HTML Page Using Static Values

This procedure describes how to add static data type parameters for a tree control, where the
Number of levels property for the tree control is not set. This enables you to add a static list of
values. 

1. In the HTML canvas, insert a tree control.
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2. From the Settings panel, select Static as the Data type.

Static is selected, by default. You may select an item, delete it, or add a subitem.

3. Create the parameter values for the control:

Click the New button to add a list of values. The values are added in a sequential
hierarchical structure. The last value added appears in the Value and Display Value
fields.

To edit the value, manually type the desired value in the Value and Display Value
fields.

Click Append child item from the Static values drop-down list to append a value at the
level currently selected, and create a new value as the child of the selected value.

Click Insert before from the Static values drop-down list to insert a value before the
selected value. Note the number of the value.

Click Insert after from the Static values drop-down list to insert a value after the
selected value. Note the number of the value.

Repeat these steps until the list contains all of the values you want to include.

Optionally, click the Delete button to eliminate any values.

4. Click the Selected check box to show the entry in the Value field as the default value.

5. Select the Send display value check box to send the display value, rather than the actual
data, to the parameter.

6. Save and run the page to populate the tree control with static values.

Procedure: How to Create a New Tree Control From the New Parameters Dialog Box

When a report contains one or more new amper variable parameters, the New Parameters
dialog box opens when you save the report and return to the HTML canvas. You can assign a
new Single source or Multi source Tree control from the HTML page to the parameter from the
New Parameters dialog box.

For each parameter, you will find Name and Control Type fields, a Create control check box,
and options to set the Control Type to a Single source or Multi source Tree control.

1. Import or create a report that contains parameters.

When importing a report with parameters, the New Parameters dialog box opens,
prompting you to create the control type.

2. Select the new tree control from the New Parameters dialog box.
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The Control Type column refreshes, showing the selected control.

3. Click OK to close the New Parameters dialog box.

The report is added and the associated parameters are bound to the tree control.

Reference: Usage Notes for Chaining Tree Controls

The following usage notes apply when chaining tree controls. You may chain controls from the
New Parameters dialog box and from the Parameters tab. 

When the Multi source Tree control is a link in the chain, the New Parameters dialog box
enables you to share parameters with the same multi source control.

You can chain a Multi source Tree control to a Single source Tree control.

You can chain a Single source Tree control to another Single source Tree control.

You can chain a Multi source Tree control to another Multi source Tree control.

You can chain a tree control to another non-tree control, such as Drop down list or List box.

Chaining cannot be done with only field names.

Dynamic population of controls with field names need to use SYSCOLUMN calls.

Positioning Objects in an HTML Page Using the Positioning Tab

Positioning options enable you to multi-select objects and position them relative to one
another. The Positioning tab contains the Positioning, Relationships, Text Alignment, and
Responsive Design groups, as shown in the following image. 

Aligning Objects in an HTML Page Using the Positioning Group

The Positioning group contains the Left, Right, Top, Bottom, Center, Middle, Same Width,
Same Height, Same Size, Toggles Grid, and Drag and Drop commands. 

Left

Aligns the objects to the left. This works in relationship positioning.

Relates an object to the left of another object.
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Right

Aligns the objects to the right. This works in relationship positioning.

Relates an object to the right of another object.

Top

Aligns the objects to the top of the highest selected object. This works in relationship
positioning.

Bottom

Aligns the objects by the bottom of the lowest selected object. This works in relationship
positioning.

Center

Aligns the objects to the center of the page. This works in relationship positioning.

Aligns objects at the horizontal center point of the object.

Middle

Aligns the objects to the middle of the page. This works in relationship positioning.

Aligns objects at the vertical center point of the object.

Same Width

Makes two or more objects the same width.

Same Height

Makes two or more objects the same height.

Same Size

Makes two or more objects the same size.

Toggles Grid

Turns the grid on and off.

Drag and Drop

Turns parent/child Drag and Drop on and off.

When this command is off (default), drag and drop is used only to reposition objects on the
HTML canvas.

When this command is on, drag and drop is used to designate a parent/child relationship
between two objects.
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Procedure: How to Designate a Parent/Child Relationship using Drag and Drop

There are instances where you want an object in your HTML canvas to be a child to another
object. For example, you may have a report (child) that you want to place within a tab container
(parent).

1. Open an HTML file in which the two objects have been created.

2. Click the Positioning tab.

3. Click the Drag and Drop command to toggle it on.

Alternatively, you can select Toggle Drag and Drop from the HTML canvas shortcut menu.

The Drag and Drop command on the Positioning tab is now highlighted.

4. Click the designated child object and drag it toward the designated parent object.

A small rectangle appears below your cursor, but the child object itself does not move.

5. Move your cursor to the designated parent object and drop.

The parent/child relationship is now created.

6. To restore the default drag and drop, click the Drag and Drop command to toggle it off.

Note: When the Drag and Drop command is on, you are unable to reorder tabs or page
containers, when using the Tab, Accordion, or Window components.

Relating Objects in an HTML Page Using the Relationships Group

The Relationships group contains the Top Left, Top Right, Bottom Right, Bottom Left, Break,
and Show commands. The Top Left, Top Right, and Bottom Right commands are only available
for HTML pages and Guided Report pages. 

Top Left

Relates two or more objects on a page. Two objects must be selected. Relates an object
to the top left of another object.

Top Right

Relates two or more objects on a page. Two objects must be selected. Relates an object
to the top right of another object.

Bottom Right

Relates two or more objects on a page. Two objects must be selected. Relates an object
to the bottom right of another object.
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Bottom Left

Relates two or more objects on a page. Two objects must be selected. Relates an object
to the bottom left of another object.

Note: The above four commands have been deprecated and will be removed from a future
release of App Studio.

Break

Breaks the relationship between the objects selected.

Show

Shows or hides the relationship between objects.

Aligning Text in an HTML Page Using the Text Alignment Group

The Text Alignment group contains the Left, Center, Right, and Full Justification commands.
These commands align text within the HTML page. 

Left

Aligns selected text to the left.

Center

Aligns selected text to the center.

Right

Aligns selected text to the right.

Full Justification

Fully justifies the selected text, meaning that the text fills the width of the text box.

Enabling Responsive Design for an HTML Page Using the Responsive Design Group

The Responsive Design group contains the Toggle Editing, Toggle Selection, and Update Layout
commands. These commands are enabled when the Responsive design property is set to Yes. 

Toggle Selection

Toggle on to allow containers that include content to be dragged to a new position. Toggle
off to prevent those containers from being repositioned.

Update Layout

Click to refresh the HTML canvas after you reposition containers, to show how the
containers will stack when folded. This command is activated when the Autosize Enable
property is set to Yes for both the document and the object.

Accessing HTML Page Components

500  Information Builders



Changing HTML Page Properties Using the Utilities Tab

You can change HTML page properties using the Utilities tab. For example, suppose you want
to test your HTML page in a specific browser. The default browser specification is considered a
property of your HTML page. To run your page in a different browser, open the Utilities tab and
select the desired browser from the Preview command group.

The Utilities tab is shown in the following image.

Chaining Objects in an HTML Page Using the Chaining Group

You can add or remove chaining options using the Chaining group. The Chaining group is
shown in the following image. 

The commands are:

Add

Chains two or more objects that are selected in the Parameters tab.

Remove

Unchains two or more selected, chained objects in the Parameters tab.

Synchronizing an Active Technologies Report in an HTML Page Using the Active
Reports Group

You can synchronize an active report. This group is available only for an HTML page and a
Guided Report page. The active reports group is shown in the following image. 
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The commands are:

Sync

Syncs an active report.

Show

Shows the synchronization of the canvas.

Unlocking a Template for an HTML Page Using the Template Group

You can unlock a template to add controls, text, and buttons. This group is available only for
an HTML page and a Guided Report page. The Template group is shown in the following image. 

The commands are:

Unlock

Unlocks the template that you are using and allows for full control of the page.

Report Set

In template mode, this adds a title bar and a form with controls, text, and buttons as a
set.

Working With the Miscellaneous Group in the HTML Canvas

The Miscellaneous group contains the Visibility, Tab order, Delete Container, and Refresh All
commands. This group is available only for an HTML page and a Guided Report page. The
Miscellaneous group is shown in the following image. 
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The commands are:

Visibility 

Toggles the visibility of hidden objects. Hidden objects are objects that have the Visibility
property, in the Properties panel, set to hidden.

For more information on using the Visibility command, see How to Toggle the Visibility of a
Hidden Object on page 503.

Tab order

Shows the order of the tabs.

Delete Container

Deletes the selected container, without deleting the container content.

Refresh All

Refreshes the HTML page.

Procedure: How to Toggle the Visibility of a Hidden Object

1. Insert an object into the HTML canvas.

2. Select the object you created, if it is not already selected.

3. In the Properties panel, change the Visibility property to hidden.

The object on the canvas is hidden from view.

4. On the Utilities tab, in the Miscellaneous group, click the Visibility command.

The hidden object is now displayed on the canvas. You can click the Visibility command
again to hide the object again. At run time, this object will be hidden.

Previewing HTML Output Using the Preview Group

The Preview group, as shown in the following image, allows you to preview HTML output in
Internet Explorer, Chrome, Firefox, and Edge browsers to be sure that your content displays
correctly. 

The Preview Runtime option is available for Responsive HTML pages only. It uses your default
browser to preview your HTML run time layout with simulated data. This may be faster than
running the page if it contains large amounts of data.
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Note: Alternatively, you can right-click in the HTML canvas, select Preview, and select a
browser or Preview Runtime.

The browser preview options are:

Internet Explorer

Preview your HTML output in Internet Explorer.

Chrome

Preview your HTML output in Chrome.

Firefox

Preview your HTML output in Firefox.

Edge

Preview your HTML output in Edge.

Preview Runtime

Available for Responsive HTML pages only. It uses your default browser to preview your
HTML run time layout with simulated data.

Displaying Panels in an HTML Page Using the View Group

The View group allows you to display or hide the panels associated with an HTML Page or
Guided Report page. This group is accessible in the Utilities tab of the HTML canvas and in the
Text Editor tab when accessing the Embedded JavaScript and Embedded CSS view tabs. The
View group is shown in the following image. 

The commands are:

Properties

Toggles the visibility of the Properties panel.

Settings

Toggles the visibility of the Settings panel.

Thumbnails

Toggles the visibility of the Thumbnails panel.
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Tasks & Animations

Toggles the visibility of the Tasks & Animations panel.

Requests & Data sources

Toggles the visibility of the Requests & Data sources panel.

Creating a Widget to Autoplay Control Values

You can insert a widget on an HTML page to automatically submit values in a control at
specific intervals. The control can be linked to a report, chart, or map.

You can enable the autoplay setting for the widget in the Tasks & Animations panel. The
widget selected may require the following configurations:

Setting the timing for the autoplay action to indicate the amount/length of time it should
take for a value to change.

Setting the play interval for a date slider to specify the interval in terms of days, weeks,
months, or years.

Procedure: How to Create a Widget to Autoplay Control Values

1. Create an XML parameter report to use for the map. For example:

TABLE FILE BASEAPP/WF_RETAIL_LITE
SUM
WF_RETAIL_LITE.WF_RETAIL_SALES.REVENUE_US
WF_RETAIL_LITE.WF_RETAIL_SALES.GROSS_PROFIT_US
BY WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_STORE.COUNTRY_NAME
WHERE WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_DATE_YEAR_COMPONENT EQ 
&TIME_DATE_YEAR_COMPONENT.(FIND 
WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_DATE_YEAR_COMPONENT,
WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_DATE_YEAR_COMPONENT IN 
baseapp/wf_retail_lite|FORMAT=YYMDy).Sale,Year:.QUOTEDSTRING;
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET ASNAMES ON
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
ON TABLE SET HTMLCSS ON
END

2. Create a new HTML page.
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3. In the Objects group, click ESRI Map to draw an Esri map component on the canvas, as
shown in the following image.

4. From the Requests & Data Sources panel, select the New drop-down arrow, point to
External Request, and then click WebFOCUS Procedure.
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5. Right-click the report in the Requests & Data Sources panel and click Create Controls for
Parameters, as shown in the following image.

6. In the New Parameters dialog box:

a. In the Control Type column, right-click Calendar.

b. Select New control.

c. Select Slider.

d. Select Horizontal.
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The populated New Parameters dialog box is shown in the following image.

7. Click OK.

The horizontal slider is added to the HTML page, as shown in the following image.
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8. Select the Parameters tab and drag the slider over emfobject1 (the map object) to draw a
line to symbolize the chaining of objects. The arrow indicates the direction of the chaining,
as shown in the following image.

9. Return to the Design tab, select the map object, and open the Settings panel.

10. On the Settings panel:

Select Layer1.

For the Request value, select the name of the XML report.

For the Geographic Role, select Country (Name).

For the Column(s) that match the role, select COUNTRY_NAME.

For the Layer Attributes, select REVENUE_US and GROSS_PROFIT_US.

For the Enable Popups attribute, select On.

For the Default Extent attribute, select On.

For the Use attribute, select Color.

For the Using Field attribute, select GROSS_PROFIT_US.

For the Color Scheme attribute, select red to green.
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The populated Settings panel is shown in the following image.
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11. Multi-select the Submit, Reset, and Schedule buttons in the form and delete them, as
shown in the following image.

12. On the Tasks & Animations panel:

Delete task 2 and task 3.

Create a new task.

For the Trigger Type attribute, select Click.

Select the form of the control to add the Trigger Identifier.

Select form1.

For the Requests/Actions attribute, select Show Autoplay widget.

The populated Tasks & Animations panel is shown in the following image.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  511



13. On the Tasks & Animations panel:

Create a new task.

For the Trigger Type attribute, select Selection Changed.

Select the form of the control to add the Trigger Identifier.

Select slider1.

For the Requests/Actions attribute, select Execute Task and then select load.

The populated Tasks & Animations panel is shown in the following image.

14. Select the slider control in the HTML canvas.
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15. On the Settings panel, select Limit values returned and change the value to 6, as shown in
the following image.

16. Select the map component in the HTML canvas.
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17. From the Properties panel, change Map: Basemap to Dark Gray Canvas Map, as shown in
the following image.
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18. Run the HTML page, as shown in the following image.

19. Click within the slider form.
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20. Select Sale,Year: from the Autoplay Widget drop-down list, as shown in the following image.

21. Drag to reposition the widget, so that it does not cover the map or the control.

22. Click the play button.

Note: As the slider moves automatically, from year to year, the map is refreshed with the
data for the corresponding year.

Using Parameters

Parameters, or "variables," are a good way to make a single HTML page valuable to a wide
range of end users. For example, if you have a parameter for region, the end users can select
their own region at run time. This improves performance, saves users from scrolling through
data that is not pertinent, and saves you from having to build multiple pages. 

Parameter values and input controls can be created with a dynamic or static list of values:

A dynamic list retrieves values from a specified data source when the request is run. These
values are always current to your data source.

A static list consists of a list of values you supply. These values do not change unless you
change them.
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An active control lists active report values that mimic active report menu items.

Note: The active controls cannot be associated to any parameters in the layout. This type
of control can only be associated with an active report in the layout.

The TOC control list gives you the ability to integrate a report with a Table of Contents and
On Demand Paging in the HTML canvas.

Note: TOC controls cannot be associated to any parameters in the layout. This type of
control can only be associated with certain input controls in the layout.

Working With the Parameters Tab

The Parameters tab enables you to create and modify parameter values, input controls, and
customize parameter conditions. You can also bind parameters to controls and chain controls
to one another. The Parameters tab consists of the following components: 

Input control objects.

You may select the input control object to view and edit the settings of the control.

Creating an input control from the Design view prompts you to create a bound
parameter on the Parameters tab.

Editing an input control, which is inserted when setting input controls for new
parameters.

Add new parameters.

Right-click anywhere on the Parameters tab to add a new parameter.

Note: Manually adding a parameter creates an unbound parameter.

Rearrange the order of objects.

When you move a parameter on the Parameters tab, a property value is automatically set.
On the Properties panel, under Document properties, the Parameters tab: auto arrange
property is automatically set to No when you move a parameter. This means the parameter
will remain where you moved it after you navigate away, then navigate back to the
Parameters tab.

You can rearrange the order of parameters and controls on the Parameters tab, which will
automatically set the Parameters tab: auto arrange property value to No. This means that if
you navigate away from the Parameters tab, and then return to it, the objects remain the in
the position you placed them. Additionally this means that the Auto Arrange Objects option,
which is selected in the HTML tab of the App Studio Options dialog box by default, will be
overridden.
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You can change the Parameters tab: auto arrange property value to Yes, to undo any moves
that you made previously, and to ensure that the objects on this tab use the auto arrange
functionality.

To inherit the Auto Arrange Objects option value, you can set the Parameters tab: auto
arrange property value to <Not Set>.

The Parameters tab: auto arrange property is available in the Properties panel. To access
this property, you must select DOCUMENT, from the list at the top of the panel.

When you select an object on the Parameters tab, the properties for that object will
automatically display on the Properties panel. When you select a parameters object from
the Properties panel drop-down, the object is automatically selected in the Parameters tab.

Refresh unresolved parameters.

All parameters on the Parameters tab are parsed every two minutes to check if any are
unresolved. If there are, their surrounding polygon is colored red. If you want to check for
unresolved parameters on demand, right-click and select Refresh unresolved.

Binding controls and parameters.

Input controls and parameters can be bound and unbound from the Parameters tab.

You may bind a parameter to an input control, or bind an input control to a parameter.

Binding a parameter to a control makes it an incoming parameter that will populate the
control. Drag a parameter object to a control object on the Parameters tab.

Binding a control to a parameter will populate the parameter. Drag a control object to a
parameter object on the Parameters tab.

Chain one control to another.

Chaining will populate controls based on the selected value from the prior control in the
chain. You can chain static and dynamic controls, link or unlink parts of a chain, and create
conditions on links in a chain. Chains are represented by lines connecting control objects
on the Parameters tab. By clicking the arrow head in a link of a chain, the Settings panel
enables you to modify and set properties and conditions of the chain.

Note: Chaining is applicable only for controls, not parameters.
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Adding a New Unbound Parameter

An unbound parameter is useful when passing a parameter value used on another page. You
may also bind the new parameter to a control to create an incoming parameter, or bind a
control to the parameter. 

Procedure: How to Add a New Unbound Parameter

The following steps describe how to add a new parameter:

1. Right-click anywhere on the Parameters tab and select Add parameter.

Enter the parameter value information. Options are Single select, Multiselect OR, and
Multiselect AND.

2. If using single value, select Single select.

Note: Single select is the default option when adding a new parameter.

a. Enter the Selected Value to be assigned to a single variable.

b. Enter the name for the parameter in the Name field, or keep the default name.

c. Optionally, you may use the Format field to define the format of the parameter, such
as A20, or D12.2.

If this field is left blank, it automatically applies the Alphanumeric format to the value
field.

3. If using a multiselect value, select Multiselect OR or Multiselect AND.

The Value, Display, and Selected columns appear.

a. Click the New button to enter a list of static values.

b. In the Value column, enter the value to be passed to the selected parameter.

c. In the Display column, enter the text that represents the parameter value in the
control the user views.

d. In the Selected column, check the box for the value you want to be selected by
default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

4. Optionally, you may select values and click the Delete button to eliminate any values, and
use the up and down arrows to rearrange the order of the values.

5. To modify the parameter value, right-click the parameter on the Parameters tab and select
Settings to make your edits.

Tip: You may also use the Undo and Redo buttons located on the Standard toolbar. Note
that undo/redo treats the entire Settings panel as one action.
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6. Optionally, bind a control to a parameter to populate the parameter. Select the center of
the parameter name object and drag the parameter to the center of the control object.

7. Optionally, bind the new parameter to a control to create an incoming parameter. Select
the center of the control object and drag the control to the center of the parameter object.

Procedure: How to Link an Unbound Parameter to a Procedure

The following steps describe how to link an unbound parameter to a procedure. As an example,
a heading is added to a report in the steps below.

1. Create a new HTML page.

2. From the Requests & Data Sources panel, click the New drop-down arrow and select
External Request - WebFOCUS Procedure.

3. Select any simple or parameterized procedure.

Note: In this example, we are using a report.

4. Insert a frame in the canvas.

5. In the Tasks & Animations panel, select the load task.

6. Click the arrow in the Requests/Animations section, select Run Request and select your
procedure.

7. Select the Target type as Frame.

8. Select the frame from the Target/Template Name drop-down list.

9. In the Requests & Data Sources panel, right-click Parameters Created in Current Page and
select New Parameter.

Note: You can also create a new unbound parameter as described in How to Add a New
Unbound Parameter.

10. Navigate to the Parameters tab and drag Parameter1 outside the Unbound Parameters
box.

11. Select Parameter1 and in the Settings panel, enter A20 in the Format field.
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12. Select the checkbox in the Apply To field next to the procedure you want to link, as shown
in the following image.

13. Enter an alphanumeric value in the Selected Value field.

14. Open the procedure.

15. From the Report group on the Report tab, use the Header & Footer option to add a Report
Header.

16. Enter &Parameter1 in the Report Heading text box.

17. Run the HTML page.

Notice that the value entered in the Settings panel for Parameter1 is displayed in the
report heading.

Creating a Static List of Values

When creating a list of static values, you can select from the following options: 

Add ignore value
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Add everything value

Add ‘No Selection’ value

Use values from procedure

Use values from external file

Use values from Library

Use values from Library (include versions)

When the options are added to the Value list, the display text can be customized, but the value
cannot be changed.

You may create an unbound static parameter, an incoming static parameter (a parameter that
is bound to a control), or a control that is bound to a static parameter.

Reference: Settings Panel (Incoming Static Parameter and Unbound Control)

The Settings panel appears when creating or editing a static value on the Parameters tab. 

The options available depend on the type of static value.

The Settings panel contains the following fields and options when Static is selected as the
Data type.

Data type

Determines whether values are obtained from a static or dynamic list, an active report, or
table of contents.

Static. Uses a static list of values you supply. A list of static values can also be created in
the Report canvas.

Static values

Is a list of supplied values for a static list.

Value. The value to be passed to the selected parameter.

Display. The text that represents the value in the control the user views. Press the Ctrl +
Shift keys to add a value to the Display field.

Selected. The value to act as the default value. If the control is multiselect, more than one
value can be selected.

New. Creates a new value.

Delete. Deletes a supplied value from the list.
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Move Up. Moves the selected value up in the list.

Move Down. Moves the selected value down in the list.

Send display value

Select this option to send the display value, rather than the actual data, to the parameter.

Values are procedures names

Select this option to have a control populated with procedure names, so that when a value
is selected, that procedure executes. The Value column is the procedure name itself and
cannot be edited. The Display column is editable.

Reference: Settings Panel (Unbound Parameter)

The Settings panel appears when creating or editing a static value on the Parameters tab. 

The options available depend on the type of static value.

The Settings panel contains the following fields and options when adding an unbound
parameter with Single select. Single select is the default option when adding a new parameter.

Name

The default name assigned to the parameter. Optionally, you may enter a new name for
the parameter.

Format

The Format field defines the format of the parameter, such as A20, or D12.2.

This field is optional. If this field is left blank, it automatically applies the Alphanumeric
format to the value field.

Selected Value

Enter the selected value to be assigned to the parameter.

Static values

Is a list of supplied values for a static list.

Value. The value to be passed to the selected parameter.

Display. The text that represents the value in the control the user views. Press the Ctrl +
Shift keys to add a value to the Display field.

Selected. The value to act as the default value. If the control is multiselect, more than one
value can be selected.

New. Creates a new value.
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Delete. Deletes a supplied value from the list.

Move Up. Moves the selected value up in the list.

Move Down. Moves the selected value down in the list.

Reference: Settings Panel (Bound Parameter)

The Settings panel appears when selecting a bound parameter on the Parameters tab. The
Settings panel for a parameter is read-only, and displays the values for the bound control.

The Settings panel contains the following read-only values:

Value

Shows the selected value for the static parameter data.

Display

Shows the static parameter display value.

Procedure: How to Add a New Static Value

The steps below describe how to manually add a new static value: 

You may create an unbound static parameter, an incoming static parameter (a parameter that
is bound to a control), or a control that is bound to a static parameter.

1. Create a new parameter.

a. Right-click anywhere on the Parameters tab and select Add parameter.

b. Enter the parameter value information in the Settings panel. Options are Single select,
Multiselect OR, and Multiselect AND.

c. If using single value, select Single select.

Single select is the default option when adding a new parameter.

Enter the Selected Value to be assigned to a single variable.

Enter the name for the parameter in the Name field, or keep the default name.

Optionally, you may use the Format field to define the format of the parameter,
such as A20, or D12.2.

If this field is left blank, it automatically applies the Alphanumeric format to the
value field.

d. If using a multiselect value, select Multiselect OR or Multiselect AND.
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The Value, Display, and Selected columns appear.

Click the New button to enter a list of static values.

In the Value column, enter the value to be passed to the selected parameter.

In the Display column, enter the text that represents the parameter value in the
control the user views.

In the Selected column, check the box for the value you want to be selected by
default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

Optionally, you may select values and click the Delete button to eliminate any
values, and use the up and down arrows to rearrange the order of the values.

An unbound static parameter is useful when passing a parameter value used on another
page. You may also bind the new parameter to a control to create an incoming parameter,
or bind a control to the parameter.

2. Bind the new parameter to a control.

Binding a new parameter to a control creates an incoming parameter. An incoming
parameter is a static parameter that is bound to a control. The parameter value will
populate the control.

a. Select the Design tab and create an input control. For example, insert a list box or a
drop-down list.

b. Click the Parameters tab.

The Settings panel appears for the control.

c. Select the center of the parameter name object and drag the parameter to the center
of the control object.

d. To unbind the parameter, select the arrow head on the line, so that the line is bold,
right-click, and select Break binding.

3. Create a control that is bound to a parameter.

Create a control with static values and bind the control to a parameter to populate the
parameter with the control values.

a. From the Design view of the HTML canvas, select a control.

The pointer changes into a crosshair.

b. Drag the crosshair to create the control and adjust it to the size you want.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  525



c. Click the Parameters tab.

The Settings panel appears for the control.

d. Select Static as the Data type.

Static is selected, by default.

e. Create the parameter values for the control:

In the Value column, enter the value to be passed to the control.

In the Display column, enter the text that represents the static parameter value in
the control the user views.

In the Selected column, check the box for the value you want to be selected by
default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

Optionally, you may select values and click the Delete button to eliminate any
values, and use the up and down arrows to rearrange the order of the values.

f. Bind the new control to a parameter: Select the center of the control object and drag
the control to the center of the parameter object.

g. To unbind the control, select the arrow head on the line, so that the line is bold, right-
click and select Break binding.

h. To change the default type of control, right-click the control object on the Parameters
tab or the Design tab and select Set Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button,
Text Area, Edit box, Single source Tree control, and Multi source Tree control.

4. To modify the static value, right-click the control, or parameter, on the Parameters tab and
select Settings to make your edits.

Reference: Adding Static Field Values From the Report Canvas

Instead of adding new static values, you may also import static value parameters that you
created from the Variable Editor dialog box. Parameter values can be data values to limit your
data or field names to select the fields in your report. Both types of static lists can be created
in the Report canvas. This example details how to supply field values to a report through the
HTML canvas and the Report canvas. 

For the purposes of this example, use the CAR Master File (car.mas) that is supplied with App
Studio.

1. From the HTML canvas, insert a new report.
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The pointer changes into a crosshair.

2. Drag the crosshair to create a report object and adjust it to the size you want.

3. Double-click the report object.

The Open File dialog box appears.

4. Select the car.mas Master File and click OK.

The Report canvas opens.

5. From the Object Inspector, expand Variables, right-click Report Variables, and click New
Report Variable Field.

The Variable Editor dialog box opens.

Enter SORTVAR in the Name and Prompt input fields, and keep the Variable Type as
Single Select.

Click Static list from the Accept List section.

Double-click COUNTRY and BODYTYPE from the Fields from database Data Context area.

The fields are added to the Static Accept List.

Click OK to save the variable.

6. Create a second variable.

Right-click Report Variables and click New Report Variable Field.

The Variable Editor dialog box.

Enter MEASURES in the Name and Prompt input fields.

Click Multiselect AND from the Variable Type drop-down list.

Click Static list from the Accept List section.

Double-click CAR, DEALER_COST, RETAIL_COST, and SALES from the Fields from
database Data Context area.

The fields are added to the Static Accept List.

Click OK to save the variable.

7. Double-click &SORTVAR and &MEASURES from the Report Variables in the Object Inspector.

The variables are added to the report.

8. Click &SORTVAR and select Sort Down from the Column Type group on the ribbon.
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Note: If the parameter is to be used as a By field in a report, it must be the single-select
variable type.

9. Save and close the report.

You are returned to the HTML canvas and since you are adding a report with parameters,
the New Parameters dialog box appears.

10.From the New Parameters dialog box:

Select Double list control from the Control Type list for MEASURES.

Select Do not create a form from the Parameter grouping options drop-down list.

Click OK to close the New Parameters dialog box.

The report and associated parameters are added as static field values. You may rearrange
or lengthen the controls in the layout.

11.Save and run the layout.

Select the static field values (By field and the associated measures) and run the report.

Procedure: How to Add an Ignore Value

The add ignore value option sends _FOC_NULL to the server at run time and is intended for
use with complex applications. The add ignore value option is available for Multiselect OR and
Multiselect AND static parameters. 

1. From the HTML canvas, use controls to supply parameter values for a report.

A report with parameters requires that you to select values (at run time) in order to
generate the output.

2. Click the Parameters tab.

The parameters associated with each control can be controlled with the Parameters tab.
The properties of a control can be controlled with the Properties tab.

3. Select a multiselect control object from the Parameters tab.

The Settings panel opens.

4. Select Add ignore value from the Static values drop-down list.

5. Optionally, select Send display value to send the display value, rather than the actual data,
for the parameter values in the report.

6. Close the Settings panel.

7. Run the HTML page and select the Ignore All value to ignore the parameter values.
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Note: Sending _FOC_NULL to a procedure will result in any clause of that procedure that uses
that variable to be ignored.

Procedure: How to Add an Everything Value

The add everything value option uses JavaScript to send every value present in the parameter
list to the server at run time. The add everything value option is available for Multiselect OR
and Multiselect AND static parameters. 

The add everything value option is not available for a Double List Control.

1. From the HTML canvas, use controls to supply parameter values for a report.

2. Click the Parameters tab.

3. Select a multiselect control object from the Parameters tab.

The Settings panel opens.

4. Select Add everything value from the Static values drop-down list.

5. Optionally, select Send display value to send the display value, rather than the actual data,
for the parameter values in the report.

6. Run the HTML page and click the Select All parameter value to view all the parameter
values.

Procedure: How to Use Values From a Procedure

This is the default option which populates the static list with field names predefined in the
procedure. The use values from procedure option is available for Multiselect OR and
Multiselect AND static parameters, and when adding static field values from the Report
canvas. 

1. From the HTML canvas, use controls to supply parameter values for a report.

2. Click the Parameters tab.

3. Select a multiselect control object from the Parameters tab.

The Settings panel opens.

4. Select Use values from procedure from the Static values drop-down list.

The field names from the procedure appear in the Settings panel.

5. Optionally, select Send display value to send the display value, rather than the actual data,
for the parameter values in the report.

6. Run the HTML page and select the parameter values from the procedure.
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Procedure: How to Import Values From an External File

This option enables you to use a local external file to provide values for the parameter. The
import values from an external file option is available for Multiselect OR and Multiselect AND
static parameters. 

1. From the HTML canvas, use controls to supply parameter values for a report.

2. Click the Parameters tab.

3. Select a multiselect control object from the Parameters tab.

The Settings panel opens.

4. Select Use values from external file from the Static values drop-down list.

The Open File dialog box appears.

5. Select a text file from your local machine and click Open.

The external file can be a file with single values on each line, or two values per line,
comma-delimited.

For example, in the following text file, BOS is the data value and Boston is the display
value.

The imported values are loaded into the Static values area of the Parameters tab.

If there is only one value on the line in the text file, the value will populate both the data
value and the display values.

6. Run the HTML page to see the imported values for the selected parameter.

Creating a Dynamic List of Values

Dynamic values are available by default if a parameter used in the procedure is associated
with the selected control. A dynamic list retrieves values from a specified data source when
the request is run. 

Reference: Settings Panel (Dynamic Values)

The Settings panel appears when creating or editing a dynamic parameter on the Parameters
tab.

The Settings panel contains the following fields and options when Dynamic is selected as the
Data type:

Data type

Determines whether values are obtained from a static or dynamic list, an active report, or
table of contents.
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Dynamic uses a list of values retrieved from a selected data source when the request is
executed. This is the default if you use an Accept clause in a Master File to create an
amper variable parameter within a procedure.

Default

Is the data source from which the values will be retrieved. This is the default value when
Dynamic is selected as the Data Type.

Explicit (Requests panel)

Is the existing procedure that will be called.

You may modify the explicit procedure directly from the Settings panel on the Parameters
tab. If you modify the request, you can save the explicit procedure and overwrite the
original request.

Data Source

Is the data source from which the values will be retrieved.

Value from field

Is the data source field from which the values will be retrieved.

Display from field

Is the text that represents the parameter value in the control the user views.

There should be a relationship between the Value from field and the Display from field. The
Display from field is user-friendly text corresponding to the Value from field.

Source Code for the procedure

When the Value from field is selected for the default procedure, the corresponding
source code appears.

Tip: You may manually edit the source code if you are familiar with WebFOCUS syntax.
For example, you may right-click and choose Select a field from the data source to add
to the request. You can also right-click and choose Use the default request.

The source code for a default procedure includes the line // TODO: Add your filters here
to replace defaults, as a placeholder for you to enter filters, or WHERE clauses, for the
request to resolve at run time. If entering filters, only dynamic filters can be specified.

The //TODO line must remain in the source code in order to resolve filters at run time.
One such example of this is when filters are based on chains that have conditions. If
you want your own filters specified, then delete this line.

When an explicit procedure is selected, the corresponding source code appears.
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Tip: You may manually edit the source code if you are familiar with WebFOCUS syntax.
For example, you may right-click and choose Select a field from the data source to add
to the request. After editing the procedure that is associated with a control, right-click
and choose Reload explicit procedure to reload and display the new syntax in the
Settings panel. You can also right-click and choose Save explicit procedure. Saving the
explicit procedure overwrites the original requests.

Sort

Clicking Sort enables you to set the sort order for displaying values in dynamic list
controls. This option is useful when you want to sort each control independently of the
others.

By default, the request retrieves dynamic display values from the BY sort field in the
request. The results display values based on the value field.

Sort by

When Sort is enabled, you may sort the display value by the Value field or the Display field
selected from the Settings panel. The default is Value field.

Sort order

When Sort is enabled, you may select the sort order as Ascending or Descending. The
default sort order is Ascending.

Check for duplicate values

When creating a dynamic list of values for a report, you may remove duplicate values from
input controls.

Add "ALL" Option

Adds the option to select ALL data source values to the control. Alternate text can be
substituted for "ALL" using the text field to the right.

Add ‘No selection' option

Optimizes performance by populating a chain one control at a time, instead of all the
controls when the page initially loads. Selecting the Add ‘No selection’ option enables you
to populate controls when necessary.

Cache run time data

When adding dynamic parameters to the HTML page, input controls retrieve data through
procedures. Select this option to cache the run-time data for the selected input control.
This setting is off by default.

This setting overrides the Default caching option from the HTML Page tab, which is located
in the App Studio Options dialog box.
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Limit values returned

Indicates that a specific number of field values will be retrieved from the data source. The
specific number of fields is selected with the menu to the right.

Use last modified filter only

Send display value

Select this option to send the display value, rather than the actual data, to the parameter.

Selected Value

Enter the value to be selected as the default value whenever the procedure is run.

Reference: Settings Panel (Bound Parameter)

The Settings panel appears when selecting a bound parameter on the Parameters tab. The
Settings panel for a parameter is read-only and displays the values for the bound control.

The Settings panel contains the following read-only values:

Data Source

Shows the selected Master File for the parameter data source.

Value from

Shows the value field for the dynamic parameter data.

Display from

Shows the dynamic parameter display field.

Multiselect

Shows OR or AND, if there is a Multiselect OR or Multiselect AND dynamic parameter.

Selected Value

Shows the selected value, if there is one assigned to the variable.

Procedure: How to Create a Dynamic Value

The steps below describe how to create a dynamic list of values.

You may need to create a dynamic control that is bound to a parameter. Creating a control with
dynamic values and binding the control to a parameter will populate the parameter with the
control values.

1. From the Design view of the HTML canvas, select a control from the Controls submenu of
the Insert menu. For example, insert a list box or drop-down list.

The pointer changes into a crosshair.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  533



2. Drag the crosshair to create the control and adjust it to the size you want.

3. Click the Parameters tab.

The Settings panel opens.

4. Select Dynamic as the Data type.

The dynamic value options appear.

5. Create the dynamic values for the control.

a. If you are using a default procedure to supply dynamic values, follow the steps below.

Click the browse (...) button adjacent to the Data Source drop-down list.

The Open File dialog box appears.

Select the Master File name and click OK.

Click the browse (...) button adjacent to the Value from field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value from field.

Tip: You may also use the Object Inspector icons to select a field and close the
Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a
value will select the value and close the dialog box without using any button, and
pressing the Esc key will cancel the dialog box without using any button.

The selected field is automatically added to the Display field and the source code
for the procedure appears.

Optionally, you may click the browse (...) button adjacent to the Display from field to
select a different field name for the Display field. (You may also use the Object
Inspector icons to select a field and close the Object Inspector).

You may manually edit the source code if you are familiar with WebFOCUS syntax.
Right-click and choose Select a field from the data source to add to the request.
For example, add an additional BY sort field to the request.

To remove any syntax that you added, right-click and select Use the default
request.

The source code for a default procedure includes the line // TODO: Add your filters
here to replace defaults, as a placeholder for you to enter filters, or WHERE
clauses, for the request to resolve at run time. If you are entering filters, only
dynamic filters can be specified. For example, enter a filter for the CITY in the
request.
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The //TODO line must remain in the source code in order to resolve filters at run
time. One example of this is when filters are based on chains that have conditions.
If you want your own filters specified, then delete this line.

b. If you are using an explicit procedure to supply dynamic values, follow the steps
below.

Select Explicit (Requests Panel).

Select a procedure from the Requests drop-down list.

The parameter names from the procedure are automatically added to the Value
from field and Display from field, and the source code for the explicit procedure
appears.

Optionally, you may click the browse (...) button adjacent to the Value from field and
Display from field to select different field names.

Tip: You may also use the Object Inspector icons to select a field and close the
Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a
value will select the value and close the dialog box without using any button, and
pressing the Esc key will cancel the dialog box without using any button.

Only the parameter names from the explicit procedure will be available for
selection.

You may manually edit the source code if you are familiar with WebFOCUS syntax.
Additionally, you may right-click and choose Select a field from the data source to
add to the request.

If you modify the request that is associated with a control, you can right-click and
choose Reload explicit procedure to reload and display the new syntax in the
Settings panel. Or right-click and choose to Save explicit procedure. Saving the
explicit procedure overwrites the original requests.

6. Optionally, select Add "ALL" option to add the select ALL data source values to the control.

7. Optionally, select Add 'No selection' option to optimize performance by populating a chain
one control at a time instead of all the controls when the page initially loads.

8. Optionally, select Cache run time data to cache the run time data for the selected input
control.

9. Optionally, select Limit values returned, and select or type the number of field values you
want to retrieve from the data source in the box to the right of this option.

10. Optionally, click the Sort option to enable and select the sort order options for displaying
values in dynamic list control.
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11. Optionally, select Check for duplicate values to remove any duplicate value entries from the
input control at run time.

12. Bind the new control to a parameter. Select the center of the control object and drag the
control to the center of the parameter object.

13. To unbind the control, select the arrow head on the line, so that the line is bold, right-click
and select Break binding.

14. To change the default type of control, right-click the control object on the Parameters tab
or the Design tab and select Set Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text
Area, Edit box, Single source Tree control, and Multi source Tree control.

15. To modify the dynamic value, right-click the control and select Settings to make your edits.

Procedure: How to Create Dynamic Parameters by Adding a Filter

You may create new dynamic parameters by adding a filter to a report or graph component in
the layout. 

1. To create dynamic parameters for your report or graph in the Design view, right-click the
report or graph object and select Add a filter from the shortcut menu.

The Filter options dialog box opens.

2. Select the field to be used for the parameter, the Multiselect option, and click OK.

The New Parameters dialog box appears.

You may select a control type for the parameter from this dialog box, or adjust them later
using the Settings panel on the Parameters tab.

If the New Parameters dialog box does not appear, ensure that Show New Parameters
dialog is selected from the HTML Page tab. To access the HTML Page tab, select Options
from the Window menu to open the App Studio Options dialog box. From the App Studio
Options dialog box, select the HTML Page tab.

3. Click OK to close the New Parameters dialog box.

4. The filter appears above the report or graph object.

Repeat this procedure for each additional parameter for the report or graph.

Procedure: How to Sort the Dynamic List of Values

This option is useful when you want to sort each control independently of the others. 
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Note: If sort options are not selected, the request retrieves dynamic display values from the
BY sort field in the request, and the results display values based on the value field. Sort
options are not selected by default.

1. Select a dynamic control from the Parameters tab.

The Settings panel opens.

2. Select Sort to enable the sort options.

You may select the Sort by and Sort order options for the control.

3. Select the Sort by options:

Sort by Value sorts the value by the field name from the Value field. This is the default
Sort by selection.

Sort by Display sorts the value by the field name from the Display field.

4. Select the Sort order options:

Sort order Ascending sorts the value from lowest to highest. This is the default Sort
order selection.

Sort order Descending sorts the value from highest to lowest.

5. Run the HTML page to see the sort results.

Procedure: How to Check for Duplicate Values

When creating a dynamic list of values for a report, you may remove duplicate values from
input controls. This is useful if you are using your own procedure that does not use a
structured data source. 

The Check for duplicate values option is turned off by default.

1. From the HTML canvas, create an input control with a dynamic list of values.

2. Select the input control and click the Parameters tab.

The Settings panel opens for the input control.

3. Select the Check for duplicate values check box.

The Check for duplicate values option is only available when creating a dynamic list of
values for an input control.

4. Save and run the HTML page.

The input control removes duplicate value entries.
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The following example shows a list box with a list of city values. The first list box shows
the list of values with duplicate entries. The second list box shows the list with duplicate
values removed.

Using Custom Procedures to Retrieve Dynamic Values

You have the option to allow customized retrieval of dynamic parameter values. By using a
custom procedure, you can use the WebFOCUS language to utilize temporary HOLD files,
filtering, and so on. This allows the HTML canvas to better integrate with a multitude of large
and/or proprietary data sources that may require unique retrieval methods. The procedure
must meet the following criteria: 

The procedure must return a name and value pair for each parameter value that will
populate the list. The first value is the submission value which is passed to the control
when you click the Submit button. The second value is the display value which is what you
will see in the control. These two values can be the same or different.

The procedure must return the two data values on a single data line in XML format
(PCHOLD FORMAT XML).

Note: Different parameters in the same procedure can use both this option and the data
source method.

For chained controls, there are two options based on whether caching is enabled:

By default, caching is not enabled. Each parameter control must be mapped to its own
procedure and the developer is responsible for writing filters or WHERE criteria to properly
filter the hierarchy of controls.

If caching is enabled for the parameter values, a single procedure can be used to populate
the controls of the chained variables. In this case, the HTML canvas writes the WHERE
criteria.

Limit values returned, will not be applied. When using chaining, HTML canvas does not
generate filters because it does not produce the request to create the population.

Example: Retrieving Dynamic Parameter Values With One Value

The following example shows the same value being used for the submission value and display
value.
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TABLE FILE GGSALES
PRINT DST.PRODUCT
BY PRODUCT
ON TABLE SET HOLDLIST PRINTONLY
ON TABLE PCHOLD FORMAT XML
END

The XML output is:

<?xml version="1.0" encoding="ISO-8859-1" ?> 
- <fxf version="1.0" data="hold"> 
- <report records="4317" lines="10" columns="2" rows="10"> 
    <target format="" version="" type="" destination="HOLD" /> 
  - <column_desc> 
      <col colnum="c0" fieldname="PRODUCT" alias="E01" datatype="char"
         width="16" focus_format="A16" description="Product name"
         accept="" help_message="" title="Product" within="" property=""
         reference="" valign="left" />
      <col colnum="c1" fieldname="PRODUCT" alias="E02" datatype="char"
         width="16" focus_format="A16" description="Product name"
         accept="" help_message="" title="Product" within="" property=""
         reference="" valign="left" />
    </column_desc> 
  - <table>
    - <tr linetype="data" linenum="1"> 
        <td colnum="c0">Biscotti</td>
        <td colnum="c1">Biscotti</td>
      </tr>
    - <tr linetype="data" linenum="2">
        <td colnum="c0">Capuccino</td>
        <td colnum="c1">Capuccino</td>
      </tr>
    - <tr linetype="data" linenum="3">
        <td colnum="c0">Coffee Grinder</td>
        <td colnum="c1">Coffee Grinder</td>
      </tr>
    - <tr linetype="data" linenum="4">
        <td colnum="c0">Coffee Pot</td>
        <td colnum="c1">Coffee Pot</td>
      </tr>

Example: Retrieving Dynamic Parameter Values With Two Values

The following example shows two different field values being used for the submission value
and display value. In this case, PRODUCT (Product Description) is used for the display value
and PCD (Product Code) is used as the submission value.

TABLE FILE GGSALES 
PRINT DST.PRODUCT 
BY PCD 
ON TABLE SET HOLDLIST PRINTONLY 
ON TABLE PCHOLD FORMAT XML 
END
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The XML output is:

<?xml version="1.0" encoding="ISO-8859-1" ?>
- <fxf version="1.0" data="hold">
  - <report records="4317" lines="10" columns="2" rows="10">
     <target format="" version="" type="" destination="HOLD" />
      - <column_desc>
        <col colnum="c0" fieldname="PCD" alias="E01" datatype="char"
           width="4" focus_format="A04"
            description="Product Identification code (for sale)" accept="" 
           help_message="" title="Product ID" within=""
           property="" reference="" valign="left" />
        <col colnum="c1" fieldname="PRODUCT" alias="E02" datatype="char"
           width="16" focus_format="A16"
           description="Product name" accept="" help_message=""
           title="Product" within="" property="" reference=""
            valign="left" />
        </column_desc>
     - <table>
       - <tr linetype="data" linenum="1">
           <td colnum="c0">C141</td>
           <td colnum="c1">Espresso</td>
         </tr>
       - <tr linetype="data" linenum="2">
           <td colnum="c0">C142</td>
           <td colnum="c1">Latte</td>
         </tr>
       - <tr linetype="data" linenum="3">
           <td colnum="c0">C144</td>
           <td colnum="c1">Capuccino</td>
         </tr>

Note: The procedure does not have to follow this WebFOCUS syntax exactly, but the end result
must be two values per data line in XML format.

Example: Retrieving Values for Chained Variables With Caching Disabled

In the following procedures, there are three parameters (REGION, ST, CITY). Caching is
disabled, so each parameter control must be mapped to its own procedures.

Procedure 1 (REGION)

TABLE FILE GGSALES 
PRINT DST.REGION 
BY REGION 
ON TABLE SET HOLDLIST PRINTONLY 
ON TABLE PCHOLD FORMAT XML 
END
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Procedure 2 (ST)

TABLE FILE GGSALES 
PRINT DST.ST 
BY ST WHERE REGION EQ '&REGION'; 
ON TABLE SET HOLDLIST PRINTONLY 
ON TABLE PCHOLD FORMAT XML 
END

Procedure 3 (CITY)

TABLE FILE GGSALES 
PRINT DST.CITY 
BY CITY WHERE REGION EQ '&REGION'; WHERE ST EQ '&ST'; 
ON TABLE SET HOLDLIST PRINTONLY 
ON TABLE PCHOLD FORMAT XML 
END

Example: Retrieving Chained Variable Values With Caching Enabled

In the following example, caching is enabled, so a single procedure is used to populate the
controls. 

TABLE FILE GGSALES 
PRINT DST.REGION DST.ST DST.CITY 
BY REGION 
BY ST 
BY CITY 
ON TABLE SET HOLDLIST PRINTONLY 
ON TABLE PCHOLD FORMAT XML 
END

The XML output is:

- <table>
 - <tr linetype="data" linenum="1">
     <td colnum="c0">Midwest</td>
     <td colnum="c1">IL</td>
     <td colnum="c2">Chicago</td>
     <td colnum="c3">Midwest</td>
     <td colnum="c4">IL</td>
     <td colnum="c5">Chicago</td>
   </tr>

Automatically Populating Fields With Dynamic Values

When the name of a dynamic parameter matches a corresponding field name in a data source,
the HTML canvas automatically populates the field name values for the parameter. 
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The data source is populated by a default based on the first data source specified by a TABLE
FILE or GRAPH FILE command. The data source field is populated for the Value and Display
fields in the Settings panel of the Parameters tab (when Dynamic is selected as the Data
type). This generates a layout report that is ready to run as long as the parameter names
match the field names.

Example: Automatically Populating Fields With Dynamic Parameter Values

When the following report request is called from the HTML canvas with a push button control,
the Settings panel for the PRODUCT parameter on the Parameters tab is automatically
populated to dynamically retrieve the values of the PRODUCT field. 

TABLE FILE GGSALES 
SUM UNITS 
BY PRODUCT WHERE ( PRODUCT EQ '&PRODUCT.Product:.' ); 
END

Creating a Static or Dynamic Parameter Value List

When creating a static or dynamic list of values, you may add an ALL value to the list of values
and/or send the display value in a parameter.

The ALL feature allows developers to automatically add an ALL value to a list of values. An ALL
value does the following:

For dynamic parameters, the ALL feature sends a value of FOC_NONE to the Reporting
Server alerting the server to bypass or ignore the parameter altogether. Ignoring the
parameter would return all values in the data source.

With static parameters, the ALL value typically uses JavaScript to return all of the values
displayed in the list. This prevents you from having to select every value in the list
manually. When using the ALL feature with static parameters, you can select from the
following options:

Add ignore value. This option sends FOC_NONE to the server at run time, alerting the
server to bypass or ignore the parameter altogether. It is intended for complex
applications.

Add everything value. This option uses JavaScript to send every value present in the
control list to the server at run time. The Add everything value option is only available
with a Multiselect OR variable type.

When using a Dynamic or active report Data type, you may enter the value(s) to be selected as
the default value whenever the procedure is run.
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Note: You may also enter the selected value when adding a new unbound parameter on the
Parameters tab.

Procedure: How to Send the Display Value for Static and Dynamic Controls

From the HTML canvas, you may send the display value, rather than the actual data, to the
parameter. The display value can also be used for headings and footings in the report output. 

1. From the HTML canvas, import or create a report that contains a parameter.

When importing a report with parameters, the New Parameters dialog box appears
prompting you to create the control type.

The report and control is added to the HTML canvas.

2. To send the display value for the parameter selection, select the control object (for
example, select listboxn) in the Design view and click the Parameters tab.

3. Navigate to the Settings panel.

Note: The options available in the Settings panel vary, depending on the type of values
(static or dynamic) you are creating.

4. For a static list of values, the Value, Display, and Selected columns appear on the
Settings panel.

In the Value column, enter the value to be passed to the control.

In the Display column, enter the text that represents the static parameter value in the
control the user views.

In the Selected column, check the box for the value you want to be selected by default.
More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

Select Send display value.

Tip: You may also update the display values from the Variable Editor dialog box in the
Report canvas.

Optionally, you may select values and click the Delete button to eliminate any values,
and use the up and down arrows to rearrange the order of the values.

Click the Design tab to view the display values in the control object of the HTML
canvas.
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5. For a dynamic list of values, the Value from field and the Display from field appear on the
Settings panel.

Add the request to the Requests & Data sources panel.

Select Explicit (Requests Panel).

Select the procedure from the Requests drop-down list.

Click the ellipsis button from the Value field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value field.

The selected field is automatically added to the Display field and the source code for
the default procedure appears.

Optionally, you may click the Display field ellipsis button to select a different field name
for the Display field.

Optionally, select Add "ALL" option to automatically add an ALL value to a list of
parameter values.

Optionally, select Add 'No selection' option to optimize performance by populating a
chain one control at a time instead of all the controls when the page initially loads.

Select Send display value.

When Send display value is selected, the &Variable gets the display value, instead of
the actual value.

6. Optionally, you may add a heading to the report to show the display value. Double-click the
report from the HTML canvas to open and edit the report.

The report opens in the Report canvas.

7. Add &Variable_TEXT to the report heading or footing.

Note: If the report procedure uses it, &Variable_TEXT will always be passed, regardless of
if Send display value is selected.

The heading as Display Value: &STCD_TEXT, where Store Code (STCD) is the variable
name.

Tip: This is different from adding the actual value from the data source, where clicking the
variable name would add <STCD to the report heading.

8. Save and close the report to return the HTML canvas.
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When you create the Text variable (&Variable_TEXT), you are not prompted to set a control
type for this variable when returning to the HTML canvas, as no control type is needed.

9. Run the HTML page.

10. Select the parameter for the report and run the report.

The display value is shown in the report heading.

Note: The HTML canvas passes &Variable_TEXT if the report procedure uses it, regardless
of whether the send display value check box is checked or unchecked.

Procedure: How to Use Procedure Names as Values

The Values are procedures names option lets you populate a control with procedure names or
HTML file names. When that procedure name is clicked, the procedure executes.

1. Create an HTML page that contains a listbox, a push button, and a report.

Note: In this procedure a listbox is used, however, the following controls are also able to
use the Values are procedures names option: double list, drop-down, radio button, and
check box.

2. Select the listbox to bring up the Settings panel.

Note: If the Settings panel does not open, select View and click Settings.

3. Select Static as the Data type.

4. At the bottom of the Settings panel, select Values are procedures/html names.

5. Click the New button and select procedures from your directory.

Note: You can add multiple procedure names to the Settings panel by multi-selecting
procedures while in the Open File dialog box.

6. Once the procedures have been added to the Settings panel, edit the display names of the
procedures by double-clicking the display contents if they are not already highlighted.

7. Right-click the button you created and click Create Hyperlink.

The Hyperlink Properties dialog box opens.

8. Create a hyperlink that opens a selected procedure from a control in the report frame
created earlier.

a. For the Action, select Procedures from control from the drop-down list.

This option coincides with the Values are procedures names option found in the
Settings panel. This option will point to an entire procedure for the hyperlink, rather
than a simple value. This option is only available when a control on the HTML page is
using the Values are procedures names option.
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b. Select listbox1 as the Source.

The source can be different if you use a different control. For example, combobox1,
customselect1, radio1, or checkbox1.

c. Select Frame as the Target Type.

You could also select New Window as the target if you wanted the procedure to open
in a new window.

d. Select report1 as the Target/Template Name.

9. Run the page.

10. Select the procedure from the listbox and click the button.

The report is run.

Procedure: How to Use Selected Values as the Default Value

When using a Dynamic or active report Data type, you may enter the values to be selected as
the default value whenever the procedure is run.

If you import a procedure (.fex) that has a dynamic prompt value then the input box is
populated with values retrieved from the data source. If the selected value is available in the
data source, the values are selected by default. If the selected value is not available in the
data source, then the value(s) that you entered are ignored and the first value retrieved from
the data source is selected. 

1. Create or import a report that contains a parameter value.

The report and control is added to the HTML canvas.

2. To enter the selected value to be used as the default value, select the control object (for
example, select listboxn) in the Design view and click the Parameters view tab.

The Settings panel opens.

Note: The options available in the Settings panel vary, depending on the type of values
(static or dynamic) you are creating.

3. For a dynamic list of values, the Value from field and the Display from field appear on the
Settings panel.

a. If using a default procedure to supply dynamic values, follow the steps below.

Select Default.

Click the ellipsis button adjacent to the Data Source field.

The Open File dialog box appears.
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Select the Master File name and click OK.

Click the ellipsis button adjacent to the Value from field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value from field.

The selected field is automatically added to the Display from field and the source
code for the default procedure appears.

Optionally, you may click the Display from field ellipsis button to select a different
field name for the Display from field.

Optionally, select Add "ALL" option to automatically add an ALL value to a list of
parameter values.

Optionally, select Add 'No selection' option to optimize performance by populating a
chain one control at a time instead of all the controls when the page initially loads.

Enter the exact parameter value in the Selected Value input field, as it appears in
the data source.

Parameter values are case sensitive.

Optionally, you may enter more than one value by using a semicolon (;) between
the values. For example, CA;GA.

You may enter selected values with a semicolon or a comma. Additionally, you may
also have embedded commas or semicolons in the data values. If you have these
embedded characters, you must enclose all of the values in the input area in
double quotation marks ("). For example:

ENGLAND;ITALY

ENGLAND,ITALY

“ENGLAND”,”IT,ALY”

Note that even though one value in the last set has the embedded comma, both
values need to be enclosed in double quotation marks (").

b. If using an explicit procedure to supply dynamic values, follow the steps below.

Select Explicit (Requests Panel).

Select the procedure from the Requests drop-down list.
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The parameter names from the procedure are automatically added to the Value
from field and Display from field, and the source code for the explicit procedure
appears.

Optionally, you may click the Value from field and Display from field ellipsis button
to select a different field name or to type the field name manually.

Note: Only the parameter names from the explicit procedure will be available for
selection.

Optionally, select the Add "ALL" option to automatically add an ALL value to a list
of parameter values.

Enter the exact parameter value in the Selected Value input field, as it appears in
the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon (;) between
the values. For example, CA;GA.

You may enter selected values with a semicolon (;) or a comma (,). Additionally,
you may also have embedded commas or semicolons in the data values. If you
have these embedded characters, you must enclose all of the values in the input
area in double quotation marks ("). For example:

ENGLAND;ITALY

ENGLAND,ITALY

“ENGLAND”,”IT,ALY”

Note that even though one value in the last set has the embedded comma, both
values need to be enclosed in double quotation marks (").

4. For an active report list of values, the Available active reports, Menu Option Types, and
Common Columns appear on the Settings panel.

Select one or more active reports from the list of Available active reports. The selected
report will be bound to the active report control in the layout.

When an active report is selected, Refresh for active reports is enabled, by default.

Select the Menu Options Types for the active report control to sort, filter, list or select
columns, and/or change presentation styles of the bound active report and the
associated report and graph objects synchronized to the active report.
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Optionally, select the Add "ALL" option to automatically add an ALL value to a list of
parameter values.

Enter the exact parameter value in the Selected Value input field, as it appears in the
data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon between the
values. For example, CA;GA.

You may enter selected values with a semicolon or a comma. Additionally, you may
also have embedded commas (,) or semicolons (;) in the data values. If you have these
embedded characters, you must enclose all of the values in the input area in double
quotation marks ("). For example:

ENGLAND;ITALY

ENGLAND,ITALY

“ENGLAND”,”IT,ALY”

Note that even though one value in the last set has the embedded comma, both values
need to be enclosed in double quotation marks (").

5. For a single-select unbound parameter, the Selected Value input field appears on the
Settings panel.

Enter the exact parameter value in the Selected Value input field, as it appears in the
data source.

Parameter values are case sensitive.

Optionally, you may enter more than one value by using a semicolon between the
values. For example, CA;GA.

You may enter selected values with a semicolon or a comma. Additionally, you may
also have embedded commas or semicolons in the data values. If you have these
embedded characters, you must enclose all of the values in the input area in double
quotation marks. For example:

ENGLAND;ITALY

ENGLAND,ITALY

“ENGLAND”,”IT,ALY”

Note that even though one value in the last set has the embedded comma, both values
need to be enclosed in double quotation marks (").
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Even though it is a Single select parameter, multiple values are specified and selected.

6. Click the Run button to run the report with the selected value parameters.

The report output appears.

The selected value, if available from the data source, is automatically selected
(highlighted) in the parameter list.

If the selected value is not available in the report results, then the value that you entered
is ignored and the first value retrieved from the data source is shown.

Parameterizing Properties in the Properties Panel

You can parameterize properties in the Properties panel for all objects in an HTML page. This
enables you to add values to amper variables and pass these variables to the corresponding
property settings in App Studio so the HTML page behaves a specific way.

You can pass values using the !IBI.AMP.VarName variable or a URL call.

Procedure: How to Parameterize Properties in the Properties Panel

The following procedure shows how to parameterize properties in the Properties panel, using
the !IBI.AMP.VarName variable and a procedure call to the HTML page.

1. From the Environments tree, right-click a folder, point to New, and click HTML/Document to
create a new HTML page.

2. On the Components tab, in the Generic Elements group, click Button and draw a button on
the canvas.

3. On the Controls tab, click the Tree drop-down arrow, and select Multi source Tree to draw
the control on the canvas.

4. On the Requests & Data Sources panel, click the New drop-down arrow, and then click Add
Data Source.

5. Navigate to the ibisamp folder and select a Master File. For example, movies.mas.

6. Select the button component on the HTML canvas.

7. On the Properties panel:

Next to the Color property, type !IBI.AMP.MYCOLOR;.

Next to the Background-color property, type !IBI.AMP.BCOLOR;.
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The Properties panel with Color and Background-color values are shown in the following
image.

8. Select the Multi source Tree control on the HTML canvas. On the Properties panel, next to
the Direction of text property, type !IBI.AMP.DIRECTION;.

The Properties panel with the Direction of text value is shown in the following image.
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9. On the Settings panel, click the ellipsis for Value from and double-click Movie, as shown in
the following image.

10. Save and close the HTML page.

11. From the Environments tree, right-click an application folder (for example, baseapp), point
to New, and then click Procedure.

12. Type the following code:

-DEFAULT &DIRECTION='rtl';
-DEFAULT &MYCOLOR='RED';
-DEFAULT &BCOLOR='BLUE';
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13. From the Procedure View panel, right-click Comment, point to New, point to HtmlForm, and
then click Referenced.

14. Double-click the HTML page to reference.

15. Close the procedure and save the file.

16. From the Environments tree, right-click the procedure, and click Run.

The following screen displays with the specified default values.

17. Click the Run icon.

Notice that the background color is blue, the button text is red, and the movie titles are
right-justified.

18. Click the Show filter panel icon, as shown in the following image.
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19. Change the direction to ltr (left to right) and the background color to yellow, as shown in
the following image.
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20. Click the Run icon. Notice that the background color for the button is yellow and the movie
titles are left-justified, as shown in the following image.

Note: You can also parameterize properties in the Properties panel using a URL in a browser.
For example:

http://host:port/app_directory/htmfilename.htm?bcolor=red

In this example:

&Varname (for example, &bcolor) must be added to the Properties panel for the parameter
value.

bcolor refers to the background color.
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Viewing Object Attributes

The Properties panel shows the attributes of the object or objects selected on the canvas. For
example, if you select a hyperlink object, the Properties panel shows the different attributes
associated with a hyperlink, such as Enable Dragging. General attributes for the entire HTML
page or Document are shown when no object is selected. The Properties panel is available
when you are using the HTML canvas or Document canvas. The attributes can be sorted by
category or alphabetically. 

You can also select Events. When Events is selected, a list of all available JavaScript events
that can be used in conjunction with an object appears. The events that are available change
depending on what type of object is selected. For example, a report object has different events
available than a button object. When no object is selected, events for the HTML page are
displayed. Double-clicking on an event will create a function block for the selected object, using
that event. You can view the created functions in the Embedded JavaScript and Embedded
CSS tabs, where you can type the JavaScript code to execute when the selected event occurs.

For more information on customizing the Properties panel, see Customizing the Properties
Panel for HTML Objects Using the Properties Toolbar on page 557.

Color Selection

For properties that affect color, such as Background-color, Border-color, and Color, you can
enter the hexadecimal value of the color you want to use directly into the property, rather than
opening the Color Picker dialog box. If you use the Color Picker dialog box to select a color, the
hexadecimal value of that selected color will be entered into the selected property. For more
information on the Color Picker dialog box, see Color Picker Dialog Box on page 562.

Sizing

Size property fields for a selected object can be set using the Left, Top, Width, and Height
fields. The default setting is in pixels (px), and the settings are also displayed in the Locations
field. You can also select <Not set>, auto, or inherit in the Left, Top, Width, and Height fields
but only pixels are displayed in the Location field.

The Position field also contributes to the location of an object in the HTML canvas. The default
value is absolute, but you can change it to one of the values in the list below:

<Not Set>. The element is positioned relative to its first positioned (not static) ancestor
element.

inherit. Inherits this property from its parent element

absolute. The element is positioned relative to its first positioned (not static) ancestor
element. This is the default value.
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fixed. The element is positioned relative to the browser window.

relative. The element is positioned relative to its normal position, so setting the Left field
to 20px adds 20 pixels to the elements left position.

static. Elements render in order, as they appear in the document flow.

initial. Sets this property to its default value.

Controls

The Name or Unique Identifier attribute settings for controls appear automatically in the
Parameters tab of the HTML canvas.

When you change the Name attribute for a control, the new name automatically appears in
the Parameters tab.

Some controls do not have a Name attribute. For these controls, the Unique Identifier
setting automatically appears in the Properties panel instead.

Customizing the Properties Panel for HTML Objects Using the Properties Toolbar

The Properties toolbar contains the buttons and menus that you need to navigate and
customize the contents of the Properties panel.

Categorized 

Groups the attributes by category.

Alphabetical 

Sorts the attributes alphabetically, without categories.

Properties 

Shows the property names and values. This is the default setting. Properties and Events
cannot be selected at the same time.

Events 

Shows the JavaScript events that can be associated with the selected object on the
canvas. Properties and Events cannot be selected at the same time.

Resizing HTML Components Using the Autosize Children Option

The Autosize Children option can resize all child components on an HTML page to
automatically fit the maximum available screen space on any monitor or device where it might
be viewed. For example, a single component will take up one hundred percent of the available
space, while two components will take up fifty percent each. 
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This option is used so that when your HTML page is run on different devices, components and
controls do not appear off the screen and have to be scrolled to in order to use them. To
accommodate this, the orientation of components may be different on different devices. For
example, a report and chart that appear side-by-side when run on a desktop monitor, may
appear stacked one above the other when run on a tablet. Similarly, this difference could occur
when run on a 24-inch desktop monitor and a 26-inch desktop monitor.

There are autosize Enable properties that work at both the document and component levels:

Autosize Children Enable. This property is set at the document level. When set to Yes, it
enables some or all of the child components in the document to resize automatically.

The Autosize Children Enable property is also available at the component level for the form,
group box, and panel container objects.

Autosize settings Enable. This property is set for each component in the document. The
setting for this option may be:

Yes. Enables the component to resize automatically.

You can prevent the component from becoming too small using the Min-width and Min-
height options. Type the minimum number of pixels for the width, height, or both, in the
appropriate fields. When a component reaches the minimum width or height that you
specified, a scroll bar appears and the size of the component does not decrease
further.

No. Prevents the individual component from resizing automatically, even when the
document and other components resize. Components tagged in this way are rendered
first, when the HTML page runs.
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The following image shows a report component and a chart component on the HTML canvas
where Autosize Children is enabled. Both components share the available space equally.

You can enable Autosize Children for an existing HTML file or create a new file with the option
enabled.

Procedure: How to Enable Autosize Children for an Existing HTML File

1. Open the HTML file.

The HTML canvas opens.

2. In the Properties panel for the document, set the Autosize Children Enable property to Yes.

3. For each component on the page that you want to resize automatically, set the Autosize
settings Enable property to Yes.

4. Right-click the HTML canvas and click Update Layout.

The components are resized to occupy all of the space on the canvas.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  559



Procedure: How to Create a New HTML File with Autosize Children Enabled

1. On the Home tab, in the Content group, click HTML/Document.

You can also create a new HTML file from the Application menu or by using the shortcut
menu in the Environments Tree panel, for a folder that supports content creation.

The HTML/Document Wizard opens.

2. Navigate to where you want to create your HTML page and click Next.

The Themes and Settings window of the HTML/Document Wizard opens.

3. In the Other settings area, select the Autosize reports/charts check box.

Selecting this option sets the Autosize Children Enable property for the document to Yes.

4. Click Finish.

The HTML canvas opens.

5. For each component on the page that you want to resize automatically, set the Autosize
settings Enable property to Yes.

Working With Autosize Children

Working with Autosize Children entails some practices and conditions beyond those found in
the native HTML canvas. This is because, when Autosize Children is enabled, components
automatically move and resize themselves on the canvas.

Adding Components to the HTML Canvas

When you add a component to the canvas with the Autosize Children option enabled, the
existing components will temporarily move out of the way so that you can draw the new one.
The components will then reposition and resize automatically. 

If the screen does not refresh, you can right-click the canvas and click Update Layout. There is
a small amount of canvas space shown to the bottom and right of the screen, which allows you
to access the shortcut menu. This extra canvas space is not shown at run time.

Note: If Update Layout does not resize the component automatically, check the properties. The
Autosize Children Enabled property for the document must be set to Yes, and the Autosize
settings Enable property for the component must be set to Yes. Components with an Autosize
settings Enable property set to No will not resize automatically on the canvas or at run time.

To change the order of the components, drag a component to the front or to the left of another
component.
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The following items apply to form, group box, and panel containers:

Forms, group boxes, and panels that contains components and controls must have the
Autosize Children Enable property set to Yes, and the Autosize settings Enable property set
to Yes.

The components that are children of a form, group box, and panel have their Autosize
settings Enable property automatically set to Yes. For controls that are children of a form,
group box, or panel, you must manually set the Autosize settings Enable property to Yes.

The form, group box, or panel should have the Number of Columns property set to the value
you want. For example, if you want three reports or charts to be next to each other, set the
value for the Number of Columns property to 3.

If an object has the Autosize settings Enable property set to No, and you want that object to
occupy the entire width of the available space, you must set the Width property to 100%.

Note: Reports and charts do not automatically re-execute once the page loads and the screen
size changes. You must re-execute reports and charts to ensure that the content refreshes. If
the output format of a chart is HTML5, the chart content refreshes automatically and you will
not have to re-execute.

Procedure: How to Add Content Inside a Container

You can easily add content inside a container, such as a panel, in the native HTML canvas.
However, if the Autosize Children property is enabled, the container moves when you try to add
content to it. To prevent this movement, use the following steps:

1. Click to select and freeze the container to which you want to add content.

2. On the Components tab, in the Generic Elements group, choose an object, such as a text
box, that you want to add to the container.

3. Click in the container again to add the element. For example, draw the text box and type
the text.

4. Click the element to select it.

In the Properties panel, set the Autosize settings Enable property to Yes, if you want the
element to resize automatically.

Click No, if you want the element to remain fixed in the container.

5. Right-click the canvas and click Update Layout.

The content now appears inside the container.
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Working With Containers

If you place an object that has Autosize settings Enable property set to No inside a container
that has Autosize Children Enable property set to Yes, the object will move to the upper-left
corner of the container.

When a container has Autosize Children Enable property set to Yes, and a report or chart is
added to that container, the Autosize Children settings property for the report or chart is
automatically set to Yes.

When a Tab, Accordion, or Window container has Autosize Children Enable property set to Yes,
and multiple reports or charts are added to it, use the Number of columns property. Select the
number of columns you want from the drop-down list and arrange the contents in the container,
as desired. This ensures the contents will be arranged the same for all browsers. If you do not
use the Number of columns property, different browsers may arrange the contents in different
ways.

Reference: Color Picker Dialog Box

The Color Picker dialog box contains the Web Palette tab, Named Colors tab, System Colors
tab, and Custom Color tab. From these tabs, you can pick different colors.

Web Palette. You can choose a color from common web colors.

Named Colors. You can choose a color from common named colors.

System Colors. You can choose a color based on the colors of App Studio.

Custom Color. You can drag red, green, and blue sliders to create custom colors.

The hexadecimal value for any color you select or create is displayed at the bottom of the
dialog box. If you want to enter a specific hexadecimal value, you must enter using the
Properties panel or the Style Composer dialog box, in the appropriate area. For example, you
can enter a hexadecimal value on the Background-color property line.

Modifying Object Population Settings

In App Studio, you use the Settings panel to modify the population settings of components,
controls, and parameters. The Settings panel has context-sensitive sections that are displayed
or hidden, depending on the object selected on the canvas. When you select an object, the
settings for that object are displayed in the Settings panel. 
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Settings are grouped under the following sections, and the sections and settings change,
depending on which component, control, or parameter is selected.

Manage CSS and Scripts Section

When no object is selected on the canvas, you can manage your cascading style sheet files
and JavaScript files using the Manage CSS and Scripts section. The Settings panel displays
this section by default.

Using the CSS button  and JavaScript button , you can search for cascading style sheet
files and JavaScript files, located in your WebFOCUS environment. You can reference web-
accessible Cascading Style Sheet files and JavaScript files by typing the URL, of those
files, in the URL/Find File area.

Parameter Created In Current Page Section

To create a parameter in the current page, right click in the Parameters tab and click Add
Parameter. The Settings panel displays the Parameter Created in Current Page section.
Type the parameter name and format. Click the radio button to specify Single select,
Multiselect OR, or Multiselect AND. Type a value in the Selected Value field.

The Dynamic Parameter Data Section

When a dynamic parameter is selected on the Parameters tab, the Settings panel displays
the data source file, Value field, and Display field. If the value is multiselect, you can click
the drop-down list in the Multiselect field and choose OR, AND, BY, ACROSS, or NONE.
Next, type the Selected Value and the Preview Value.

Input Control Population Section

When a control is selected on the canvas and the Data type is set to Dynamic, you can
drag fields and parameters from the Requests & Data sources panel to the Settings panel.

Working With the Selection To Area in the Settings Panel

The Selection to area in the Settings panel, assists in directing where control and grid
selections are sent. For example, you can choose to send any selections made from a drop-
down control to a specific parameter.

You can click the Use ‘Requests_Data sources’ panel button to open the Requests & Data
sources panel next to the Selection to area. This allows you to drag any parameter from the
Requests & Data sources panel, to the Selection to area.
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Using Tasks & Animations

Using the Tasks & Animations panel, you can submit requests for parsing, execute tasks when
specific criteria are met, and add jQuery animations to your HTML page. The Tasks &
Animations panel is shown in the following image. 

For more information on customizing the Tasks & Animations panel, see Executing jQuery
Animations Using the jQuery Animations Section on page 570.
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Executing a Task Using the Tasks Section

The Tasks section of the Tasks & Animations panel allows you to execute a request when
specific criteria are met. For example, you can create a task that runs an embedded report
when a button is clicked. 

For more information, see How to Automatically Execute a Request When a Page is Loaded on
page 577.

Tasks 

Toggle details 

Opens the Tasks dialog box which displays the Tasks section of the Tasks &
Animations panel horizontally rather than vertically. Tasks are displayed in a list. This
list shows the Task Name, Trigger Type, Trigger Identifier, Requests/Actions, Target
Type, and Target Name, of each task, next to each other. When the Tasks dialog box
is opened, the Tasks section of the Tasks & Animations panel is collapsed.

List of 

A list of tasks defined in the HTML page.

New task 

Creates a new task. A task is an actionable item.

Delete 

Deletes a selected task. You can use the drop-down list to delete a selected task or to
delete all untriggered tasks.

Trigger Type 

Determines when a task should start. You can choose:

Click

Click link

Double click

Mouse down

Mouse enter

Mouse leave

Mouse move

Mouse over
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Mouse out

Mouse up

Blur

Selection Changed

Checkbox: Check

Checkbox: Uncheck

TBD

Maps: Selected marker drill down

Maps: anywhere click

Grids: Cell Modified

Grids: Cell Selection Changed

Grids: Cell Edit Start

Grids: Cell Edit Finish

Grids: Column Sized

Grids: Column Selection Changed

Note: The TBD trigger type can be used when a task is executed by an API call.

Trigger Identifier list 

A list of all possible triggers based on what option you have selected from the Trigger
filters list.

Clear Triggers Selection 

Deselects any object you have selected in the Trigger Identifier list.

Buttons, Images, Hyperlinks/Selected Only 

You can select whether to display buttons, images, hyperlinks, or other objects as
possible Trigger Identifiers. The options are:

Buttons, Images, Hyperlinks

Buttons

Images
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Hyperlinks

Menu Items

All

Selected Only

When All is selected, objects that are not buttons, images, or hyperlinks become
available for use as Trigger Identifiers. For example, with All selected, a text object can
be a Trigger Identifier.

Selected only will make objects you have selected on the canvas appear in the Trigger
Identifier list.

Requests/Actions list 

A list that displays the order in which the requests, for the selected tasks, will execute
any Wait for completion requests and any refresh requests. You can use Wait for
completion requests to have certain requests execute before others. For example, if
request1 is above the Wait for completion action and request2 is below that, then
request1 will run first and when that is completed, request2 will then run.

Requests selections 

Allows you to select which request(s) to add to the Requests/Actions list. Each
request selected populates the Target type field with the available targets in which
that request can be executed.

Run Request. Displays the available reports, created in the Request & Data
sources panel.

Schedule Request. Displays the available reports, created in the Request & Data
sources panel.

Run Animation. Displays the available jQuery animations.

Execute Task. Displays the available tasks, to enable you to execute one task
from within another.

Refresh. Creates an action to refresh the selected target.

Wait for completion. Allows you to specify that one request musts complete before
the next one begins.
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JavaScript call. Creates a JavaScript call action. When using the JavaScript call,
different results occur depending on what is returned. If the JavaScript call returns
0, then all actions after it run. If the JavaScript call returns 1, then one action after
the call is skipped, and all actions after that are then run. If the JavaScript call
returns 2, all actions after it are skipped.

Delete 

Deletes a request from the Requests/Actions list.

Move Up 

Moves an item on the Requests/Actions list up one place.

Move Down 

Moves an item on the Requests/Actions list down one place.

Target type 

The Target type option contains a list of targets in which the request can be executed.
These targets can be controls, frames, windows, or distribution methods when the
Request is set to Schedule. These options can be different for specific actions.

The Window Target type will execute the request in a window.

The InfoWindow Target type will execute the request in the WebFOCUS generated
InfoWindow.

The Ajax call Target type will execute the request as an asynchronous call in
JavaScript.

The Frame Target type will execute the request in a selected frame.

The Deferred Target type will run the report deferred.

The Input Control Target Type is only available when you have a refresh request
selected in the Requests/Actions list. This Target Type specifies that an input control
will be refreshed. You specify which control should be refreshed by selecting one from
the Target/Template Name list.

The active report Target Type is only available when you have a refresh request
selected in the Requests/Actions list. This Target Type specifies that an active report
will be refreshed. You specify the active report that will be refreshed by selecting one
from the Target/Template Name list.
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The Refresh BI Portal Target Type is only available when you have a refresh request
selected in the Requests/Actions list. This Target Type specifies that a WebFOCUS BI
Portal page will be refreshed. If you select All pages of the portal, all BI Portal pages
will be refreshed. If you select Current page only, only the current BI Portal page will be
refreshed.

The JavaScript function Target Type is only available when you have selected
JavaScript call in the Requests/Actions field. This Target Type specifies that the
selected task will call a JavaScript function that you type in the Function name field.

Target/Template Name 

Contains options that are associated with the Target type option.

Note: When you type a frame name in the Target/Template Name field, if the frame
does not exist, a dialog box displays, asking if you want to create a new frame.

This field title changes to Function name under the following conditions:

The Trigger Type TBD was selected.

The Requests/Actions JavaScript call was selected.

The Target type JavaScript function was selected.

In the Function name field, you can type the function that you want to call. You can
also include any parameters that are required. Parameters must be included in
parentheses and multiple parameters separated by commas. If you had previously
typed a function in this field, you can select it from the drop-down menu.

Size (Width / Height) 

Sets the Width and Height of an InfoWindow. Only available for the InfoWindow Target
Type.

Current pages only 

Refresh the current WebFOCUS BI Portal page. Only available when there is a request
to refresh the WebFOCUS BI portal.

All pages of portal 

Refresh all WebFOCUS BI Portal pages. Only available when there is a request to
refresh the WebFOCUS BI portal.
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Executing jQuery Animations Using the jQuery Animations Section

The jQuery Animations section, in the Tasks & Animations panel, allows you to execute jQuery
animations on your HTML page. The animation effects in the jQuery Animations section can be
used individually or in conjunction with each other to create more complex animations. 

For more information, see How to Animate an Object Using the Tasks & Animations Panel on
page 572.

List of 

A list of all animations present in the HTML page. This list will change when animations
are added or deleted.

New 

Adds a new animation to the HTML page. The newly added animation appears in the List of
area.

Delete 

Removes an animation from the HTML page. The deleted animation is removed from the
List of area.

All Targets 

A list of all possible targets that can be used in the current animation being defined.

Selected Targets 

A list of all targets that will be used in the current animation.

Add canvas selection 

Adds the currently selected object on the canvas to the Selected Targets list. Multiple
objects can be selected and added at the same time.

Add from list 

Adds a selected object from the All Targets list to the Selected Targets list. Multiple
objects can be selected and added at the same time.

Remove 

Removes an object from the Select Targets list when that object is selected. Multiple
objects can be selected and removed at the same time.

Visibility 

You can select whether or not to animate the target so that it is hidden or displayed. You
can also select not to animate the target for visibility. The options are No Change, Hide,
and Show.
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Effect 

The Effect group contains animation effects and the options you can use to customize
those animations. Animation effects can make the target bounce, shake, pulsate, and
much more. You can also customize the options associated with that animation effect. The
options correlate to the effect used. Such options can be how many times the target
bounces after you specify that you want the bounce effect.

Type 

A drop-down list where you can select the animation effect you want to use.

Option 

You can select which option value you would like to edit, if available. For example,
selecting the Bounce animation type allows you to select Distance and Times in the
Option drop-down list. When you select Distance or Times, you can then edit the value
of either of those options in the Value area. If you select Times and then enter 3 into
the Value area, your object will bounce 3 times. The options available are different
depending on the effect type you choose.

Value 

You can enter a number that pertains to the currently selected option and that affects
the animation. For example, if you select the Slide type and the Distance option, the
number you enter in the Value area will be the distance the object will slide when it is
animated. The value options available are different depending on the effect type you
choose.

Effect text area 

As the options for the effect are set, the syntax for that effect are displayed here. You
can manually adjust this syntax to affect the animation.

Additional Properties 

The Additional Properties group contains animations that change the location and size of
the target and the components of that target (text size, text width, border size).

Name 

A drop-down list where you can select different properties that can be animated. Such
properties include height, opacity, font size, and others.

End value 

The value for the property you choose from the Name field. For example, if you choose
Left and enter 10, the object you are animating would move 10 pixels to the left. The
reason you do not need to specify a start value is because the current location of the
object is the start value.
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Location setting 

You can animate the target so that the location and size of that target is changed
once the animation is activated.

Use location of selected target 

This will use the location of the currently selected target. Coordinates, height, and
width of the object are entered automatically into the Location setting box. This is
used when the developer plans to move the selected target object and the
animation will move it back.

Start location setting 

Inserts an adjustable placeholder object into the canvas, at the location of the
selected target. You can move and resize this placeholder object. This object
represents where the animation will move and what size it will be when the
animation is complete.

Set location settings 

Sets the adjustable object location and size. This will be where the animated
object moves and what size it will be. It is the ending location of the selected
target.

Cancel setting 

Cancels the setting of the location for the animation.

Additional Properties text area 

Once the location has been determined using the Location setting commands, the
syntax for that location is displayed here. You can manually adjust this syntax to affect
the animation.

Duration 

How quickly the animation will execute. You can choose either Slow or Fast.

Toggle animation 

Allows you to revert to the pre-animation state. For example, if the target moves from right
to left, the next invocation of the trigger will move the target back to the original position at
the right.

Procedure: How to Animate an Object Using the Tasks & Animations Panel

The following are examples for how to create and animate an HTML page with jQuery
animations. 
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Note: Any of the jQuery animations in the jQuery Animations section can be used individually or
together. Using different jQuery animations together will create a more complex animation.

1. Create an HTML page.

2. Insert an image object and a button object onto the HTML page.

3. On the Tasks & Animations panel, in the jQuery Animations section, click New.

A new animation is added to the animation list.

4. To make the image object, image1, the target, do one of the following:

Select the image object on the canvas and click the Add canvas selection command.

Select image1 from the All Targets area and click the Add from list command.

Double-click on image1 in the All Targets area to move it to the Selected Targets area.

The image object, image1, is added to the Selected Targets area.

5. Select Hide for the Visibility option.

This animation option will cause the image to be hidden when the button is clicked.

6. On the Tasks & Animations panel, in the Tasks section, click New.

A new task is added to the tasks list.

7. Select Click from the Trigger Type drop-down list.

8. From the Trigger Identifier list, select the button object, button1.

The button will be used to activate the animation.

9. Select Animation1 from the Requests/Actions option.

When the animation is activated using the button, the image will hide.

Procedure: How to Select an Effect and Customize the Options for an Animation

The following is an example for how to select an effect for an animation and customize the
options for the effect. 

Note: Any of the jQuery animations in the jQuery Animations section can be used individually or
together. Using different jQuery animations together will create a more complex animation.

1. Create an HTML page.

2. Insert an image object and a button object onto the HTML page.

3. On the Tasks & Animations panel, in the jQuery Animations section, click New.

A new animation is added to the animation list.
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4. To make the image object, image1, the target, do one of the following:

Select the image object on the canvas and click the Add canvas selection command.

Select the image1 from the All Targets area and click the Add from list command.

Double-click on image1 in the All Targets area to move it to the Selected Targets area.

The image object, image1, is added to the Selected Targets area.

5. Select an Effect and customize the options for that effect.

a. Select Blind from the Type drop-down list.

This will cause the image to appear as if window blinds have been pulled over it.

b. Select Direction from the Option drop-down list.

Note: Each Effect has different options available to customize. Blind has the Direction
option to customize where Bounce has the Distance and Times options.

c. Select Horizontal from the Value field.

This will cause the image to be animated with a horizontal blind effect.

Note: The Value field will either be a drop-down list or a text entry box depending on
what you selected for the Option drop-down list. For example, Direction will use this as
a drop-down list while Times will use this as a text entry box.

6. On the Tasks & Animations panel, in the Tasks section, click New.

A new task is added to the tasks list.

7. Select Click from the Trigger Type drop-down list.

8. From the Trigger Identifier list, select the button object, button1.

The button will be used to activate the animation.

9. Select Animation1 from the Requests/Actions option.

When the animation is activated using the button, the image will animate with a blind effect.

Procedure: How to Create a Move or Resize Animation

The following is an example for how to create a move or resize animation. 

Note: Any of the jQuery animations in the jQuery Animations section can be used individually or
together. Using different jQuery animations together will create a more complex animation.

1. Create an HTML page.

2. Insert an image object and a button object onto the HTML page.
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3. On the Tasks & Animations panel, in the jQuery Animations section, click New.

A new animation is added to the animation list.

4. To make the image object, image1, the target, do one of the following:

Select the image object on the canvas and click the Add canvas selection command.

Select image1 from the All Targets area and click the Add from list command.

Double-click on image1 in the All Targets area to move it to the Selected Targets area.

The image object, image1, is added to the Selected Targets area.

5. Use the Location setting options, found in the Additional Properties area, to animate the
object so that it moves when activated.

a. Click the Start location setting command.

A placeholder object is shown overlapping your image.

b. Move the placeholder object to a different location on the HTML page.

c. Click the Set location setting command.

This removes the placeholder object and adds syntax to the Additional properties text
area. When your animation is activated, it will move to a different location that you
specified using the placeholder object.

6. Select Fast from the Duration drop-down list.

This will make the animation run at a faster speed.

7. Check the Toggle Animation check box.

Checking the Toggle Animation check box will allow you to click the button after the
animation has run and restore the image to its original state (in its original location and
unhidden).

8. On the Tasks & Animations panel, in the Tasks section, click New.

A new task is added to the tasks list.

9. Select Click from the Trigger Type drop-down list.

10. From the Trigger Identifier list, select the button object, button1.

The button will be used to activate the animation.

11. Select Animation1 from the Requests/Actions option.

When the animation is activated using the button, the image will move to the location that you
set. If you click the button a second time, it will move back to the original location.
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Procedure: How to Create a Hyperlink in App Studio to Drill to a WebFOCUS Procedure

You use the Hyperlink component and the Tasks & Animations panel to create hyperlinks. The
following is an example of creating a hyperlink to drill to a WebFOCUS procedure.

1. In the Components tab, in the Generic Elements group, click Hyperlink.

A task is added to the Tasks section of the Tasks & Animations panel with a trigger type
and trigger identifier already chosen.

2. In the Requests & Data sources panel, create a new external request for a WebFOCUS
Procedure.

3. Drag the request on to the canvas to create a frame.

4. In the Tasks section of the Tasks & Animations panel, in the Requests/Actions list, click
the Requests selection command and select the request you created in step 2.

5. In the Trigger Type drop-down list, select Frame.

6. In the Target/Template Name drop-down, select the frame you created in step 3.

When the HTML page is run and you click on the hyperlink, the WebFOCUS Procedure you
chose will run in the frame.

Procedure: How to Create a Hyperlink in App Studio to Execute a URL

1. In the Components tab, in the Generic Elements group, click Hyperlink.

A task is added to the Tasks section of the Tasks & Animations panel, with a trigger type
and trigger identifier already chosen.

2. In the Requests & Data Sources panel, click the New drop-down arrow and select Url
Request.

3. Type the URL in the Enter Url dialog box.

4. Navigate to the Tasks & Animations panel, select the task for the hyperlink, and verify that
the trigger identifier displays the unique ID of the hyperlink object.

5. Click the arrow in the Requests/Actions section, select Run Request, and then select the
URL request.

6. Select the Target type from the drop-down list (for example, Window or Frame).

7. Select the appropriate Target/Template name from the drop-down list.
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Procedure: How to Automatically Execute a Request When a Page is Loaded

You can use the Requests and Tasks sections to create a request that executes when your
HTML page is loaded. To do this, you must use the load task, in the Task Section. The load
task is automatically added to every page and runs all selected requests when the page
initially loads.

1. Select the load task.

2. Select the Load trigger type in the Trigger Type drop-down list. This option is selected by
default for a load task.

3. Select a request from the Requests/Actions list.

4. Select the destination of the procedure by using the Target type drop-down list. For
example, you can have the procedure run in a new window or in a report frame on the
HTML page.

5. Select the frame in which the procedure will run. This option is only needed if you want to
run the procedure, in a frame, on the HTML page, and not a new window.

Working with Requests & Data Sources

A request is a definition of something that can be executed. For example, you can execute a
default procedure, explicit procedure, HTML page, URL, and more. If a request has
parameters, those parameters will be indented and listed under the request name. By default,
all parameters are sent to the Reporting Server. However, you can choose to not send a
parameter in the request section by using the shortcut menu of the parameter, and clicking
Don’t Send. If you choose to not send a parameter, you must verify that your procedure can
work without that value. For example, it contains a -DEFAULT value for the parameter.

When creating an external request that uses an existing file, the request inherits the name of
that external file. For example, if you create an external request that uses an existing
WebFOCUS procedure called Parameter_Report, then your external request will inherit the
name Parameter_Report.

Each request displays two folders beneath it, the Columns and Parameters folders. The
Columns folder contains the fields used in the request. The Parameters folder contains the
parameters used in the request. The Parameters folder is expanded by default, while the
Columns folder is collapsed by default.

The Data Sources folder contains all data sources, used for default procedures and default
control population requests, in the HTML page. Referenced data sources are not displayed in
the Requests & Data sources panel. You can add additional data sources to the HTML page by
embedding additional requests. You can also add additional data sources by right-clicking on
the Data Sources folder, and using the shortcut menu to click Add Data Source.
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You can refresh all requests, except empty requests, using the shortcut menu. Right-click a
request and click Refresh.

You can also duplicate a request by using the shortcut menu, on the request you want to
duplicate, and clicking Clone. When you clone an embedded request, you create a copy of the
default request with the name, name_1. Name is the name of the original default request. For
example, if you clone a request named SalesReport, the cloned request would be called
SalesReport_1. Cloning an explicit request does not make a second copy of the referenced
procedure.

You can also make edits to a selected procedure using the shortcut menu and clicking Open in
text editor, as shown in the rightmost image below. For a default procedure, the new procedure
tab opens with an extension of .vrt to show it is virtual. With a referenced procedure, the
procedure tab opens with an extension of .fex.

In the Requests & Data sources panel, each icon next to an item indicates the type of request
or parameter. For example, a parameter that was created in the current HTML page has the
parameter symbol and an addition sign on it. Another example is how an external URL request
has the word URL on it.

Two sample Requests & Data sources panels are shown in the following images.

You can drag parameters and fields to the Settings panel to configure the selected component
or control. You can drag requests from the Tasks & Animations panel to the HTML canvas, to
create objects and controls for the request.

New request 

Creates a new request. A request is an item that can be executed.
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Delete 

Deletes a selected request.

Refresh parameters 

Refreshes the parameters used in the request.

Create Input Controls 

Opens the New Parameter dialog box where you can select which input controls to create
for parameters that are checked off in the Parameters list box, and if you want those
controls chained to the parameter.

Save Selection 

Saves the parameters you currently have checked off in the Parameters list box. You can
choose to send more or less parameters than the procedure in the request requires. If you
send less parameters, then you need to make sure the remaining parameters are handled
by a -DEFAULT, -SET, or some other construct in the request.

Clear Selection 

Clears all selected items in the Requests & Data sources panel.

Procedure: How to Create a Default Procedure Request in App Studio

1. Add an embedded procedure to the Requests & Data source panel. Click the New drop-
down arrow, point to Embedded Request, and then click New Report, New Chart, or New
Document to create and embed a new procedure. Point to Import Existing to embed an
existing procedure file.

A new request is created in the Requests & Data sources panel. If you are creating a new
procedure, the Open File dialog box appears, prompting you to select a Master File. If you
are embedding an existing file, the Open File dialog box appears, prompting you to select a
procedure file.

2. Select a Master File or procedure file and click OK.

If you are creating a new procedure, the canvas for that type of procedure opens. Once you
are done creating the procedure, save and close the canvas.

3. In the Requests & Data sources panel, you may drag the request that you created on to
the canvas.

A procedure object is created on the canvas. If the procedure contains parameters, a form
control is also added to the canvas. A task is created in the Tasks section of the Tasks &
Animations panel.
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Displaying Applications in Different Languages

You can translate HTML pages within App Studio to display applications in different languages
in the portal. A translation XML file can be an embedded file or a referenced file.

When creating an HTML page in the HTML canvas, you can use the Dynamic Language Sets
group on the Properties panel for the DOCUMENT object to:

Select a language, to allow for development.

Select a default language for run time, if the selected language is not yet defined.

Use an embedded or external file for translation.

See a visual representation of the selected language. The open tab for the HTML file
displays the language in parentheses next to the file name. This is for display purposes
only. The file will not be saved with the additional language information.

The Dynamic Language Sets group on the Properties panel for the DOCUMENT object is shown
in the following image.
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The Dynamic Language Sets properties are as follows:

Selected.Is a drop-down list, which contains a list of WebFOCUS languages, as selected in
the WebFOCUS Administration Console. This is based on the selected code page. The
default value is the language that is set in the General section of the App Studio Options
dialog box.

Default. Is a drop-down list of the languages that will be available in the embedded or
referenced file (XML). When you select a language in the Selected drop-down list, the
language is added to the Default drop-down list and a section in the XML file is added for
the language. If you run the page from the Web Console (BIP tree), and if the selected
WebFOCUS language is not available for the HTML file, then the page runs in the language
selected in the Default drop-down list. When a new value is selected in the Selected drop-
down list, the Default will automatically be set for the Language drop-down list in the
General section of the App Studio Options dialog box.

Locale file. Indicates whether the translation XML file is an embedded file or a referenced
file, as shown in the following image.

Possible values are:

Embedded. Indicates that all the XML language strings are written in the HTML file. This
is the default value.
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Referenced. Prompts you to select an existing XML file from the Open File dialog box.
You can type a name in the Filename field in order to create a new XML file. Selecting
Yes in the App Studio dialog box creates a new file.

Note: When creating a locale file for the first time, the referenced file must be created as a
new file.

Yes populates the page with the localized strings in the file. No writes the information in the
page to the file at the time when the HTML file is saved.
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You can also set Locale options by right-clicking the document and selecting Locale Sections
from the right-click menu, as shown in the following image.

The following options are available:

Create All. Creates sections in the XML file for all languages listed in the Selected drop-
down list in the Properties panel. All the languages will also be populated in the Default
drop-down list. Once the Create All option is selected, it will be grayed out until a section is
removed from the XML file.

Update. Updates sections in the XML file when you develop the HTML page and when
saving the page.

Note: If the XML file is not written for any sections in the HTML page, selecting Update will
update the XML file sections for those missing sections.

Remove Selected. Removes the section in the XML file for the language in the Selected
drop-down list. The value in the Selected drop-down list will be the default language. The
language will also be removed from the Default drop-down list.

Procedure: How to Display Applications in Different Languages

1. Right-click a folder, point to New, and then click HTML/Document to create a new HTML
page.
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Notice that the open tab for the HTML file displays the default language in parentheses,
as shown in the following image.

2. Add a report and a heading control to the HTML page, as shown in the following image.
Type the text for the heading in English.

3. Save the HTML page.

4. In the Properties panel, click the Selected drop-down list and select a different language,
for example, French, as shown in the following image.

Notice that the open tab for the HTML file changes to the selected language, as shown in
the following image.

5. Type the text for the heading in French, as shown in the following image.

Displaying Applications in Different Languages

584  Information Builders



6. Save the HTML page.

7. Select English for the Selected property in the Properties panel for the Document.

8. Run the HTML page. The report heading is in English, as shown in the following image.

9. Select French for the Selected property in the Properties panel for the Document.

10. Run the HTML page. The report heading is in French, as shown in the following image.

Specifying Browser Defaults

You can use the Style Composer to control default settings for font, background properties,
position mode, flow control, margins, list styles, and visual effects. 

To access the Style Composer, right-click an object on your HTML page and select Style from
the shortcut menu.

Reference: Specifying Font Styles Using the Style Composer

To specify the font styles that will be used in the browser for your HTML page, make your
selections in the Font window of the Style Composer.
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The Font window of the Style Composer is comprised of the following elements:

Font name 

Determines the font displayed in a browser.

You can specify: Family (launches the Font Picker dialog box) or System Font.

Font attributes 
Determines the attributes of the font displayed in a browser.

The options include: Color, Italics, Small Caps.

Size 

Determines the size of the font displayed in a browser.

The options include: Specific, Absolute, Relative.

Bold 

Determines whether the font is displayed as bold in a browser.

The options include: Absolute, Relative.

Effects 

Determines whether the font effects are displayed in a browser.

The options include: None, Underline, Strikethrough, Overline, Capitalization.

Reference: Specifying Background Properties Using the Style Composer

To specify the background styles that will be used in the browser for your HTML page, make
your selections in the Background window of the Style Composer.

The Background window of the Style Composer is comprised of the following elements:

Background color 

Determines the background color of the HTML page.

You can specify: Color, Transparent.

Background image 

Determines the properties of the background image displayed in a browser.

The options include: Image, Tiling, Scrolling, Position (Horizontal and Vertical), Do not use
background image.
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Note: When using a background image with scrolling enabled, you must specify the
horizontal and vertical positions. If you do not specify these positions, your background
image will not show. The horizontal and vertical positions are relative to the window and
not the individual element.

Reference: Specifying Text Styles Using the Style Composer

To specify the text styles that will be used in the browser for your HTML page, make your
selections in the Text window of the Style Composer.

The Text window of the Style Composer is comprised of the following elements:

Alignment 

Determines the alignment of text.

You can specify: Horizontal, Vertical, Justification.

Spacing between 

Determines the spacing between text.

You can specify spacing between the following text elements: Letters, Lines.

Text flow 

Determines the flow of the text.

You can specify: Indentation, Text direction.

Reference: Specifying Position Mode Using the Style Composer

To specify the position mode that will be used in the browser for your HTML page, make your
selections in the Position window of the Style Composer.

The Position window of the Style Composer is comprised of the following elements:

Position Mode 

From which you can specify: Position in normal flow, Offset from normal flow, Absolutely
position.

Height/Width 

When Absolutely Position is selected, you can specify position indicators in the
measurements.

You may specify: Top, Left, Z-Index.

Note: Z-Index is optional. It sets or retrieves the stacking order for absolute or relatively
positioned objects.
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Reference: Specifying Layout Styles Using the Style Composer

To specify the layout styles that will be used in the browser for your HTML page, make your
selections in the Layout window of the Style Composer.

The Layout window of the Style Composer is comprised of the following elements:

Flow control 

From which you can specify: Visibility, Allow text to flow, Display, Allow floating objects.

Content 

From which you can specify: Overflow.

Clipping 

From which you can specify whether or not to clip the layout from the following positions:
Top, Bottom, Left, Right.

Printing page breaks 

From which you can specify: Before, After.

Reference: Specifying Edge Styles Using the Style Composer

To specify the margins, padding, and border styles that will be used in the browser for your
HTML page, make your selections in the Edges window of the Style Composer.

The Edges window of the Style Composer is comprised of the following elements:

Margins 

From which you can specify: Top, Bottom, Left, Right.

Padding 

From which you can specify: Top, Bottom, Left, Right.

Reference: Specifying List Styles Using the Style Composer

To specify the list styles that will be used in the browser for your HTML page, make your
selections in the Lists window of the Style Composer.

The Lists window of the Style Composer is comprised of the following elements:

Lists 

From which you can specify: Bulleted, Unbulleted.

Bullets 

From which you can specify: Style, Position, Custom bullet.
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Reference: Specifying User Interface Effects Using the Style Composer

To specify the interface styles and visual effects that will be used in the browser for your HTML
page, make your selections in the Other window of the Style Composer.

The Other window of the Style Composer is comprised of the following elements:

User interface 

From which you can specify: Cursor.

Tables 

From which you can specify: Borders, Layout.

Reference: Specifying Border Settings Using the Style Composer

To specify the Border settings that will be used in the browser for your HTML page, make your
selections in the Border window of the Style Composer.

The Borders window of the Style Composer is comprised of the following elements:

Borders 

Determines which border should be styled, what type of style should be applied, the width
of the border, and the color of the border.

Rounded Border 
Determines the whether your border corners will be rounded. You can style each individual
corner to be rounded. You can also specify by how much they are rounded and whether all
corners should be equally rounded.

Chaining in the HTML Canvas

You may chain controls to one another on the Parameters tab and apply conditions to links in
the chain. Chaining will populate controls based on the selected value from the prior control in
the chain. You can chain static and dynamic controls, link or unlink parts of a chain, and
create conditions on links in a chain. Chains are represented by lines connecting control
objects on the Design or Parameters tab. Note that chaining is applicable only for controls, not
parameters. 

Note:

Although you may chain controls from the Design tab, you may only create conditions to
links in the chain through the Parameters tab.

By clicking the arrow head in a link of a chain, the Settings panel enables you to modify and
set the properties and conditions of the chain.
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If using static controls, you must apply conditions for each link in the chain. Conditions
need to be created for each value of the control chained from, and those values must be
mapped to the correct value(s) that will be displayed in the control that it is being chained
to.

Automatically Chaining Parameters From the New Parameters Dialog Box

The auto chain option enables you to automatically chain selected controls from the New
Parameters dialog box. Chaining populates controls based on the selected value from the prior
control in the chain. The auto chain option is useful since it creates the chain, or links of a
chain, automatically.

Note: Automatic chaining creates a basic chain with default functionality that does not include
any conditions. You may create conditions for a chain through the Parameters tab.

When importing or referencing a report with parameters to an HTML page, the controls are not
chained by default. You may choose to include or exclude individual controls in a chain with the
Chain control column from the New Parameters dialog box.

Additionally, when the auto chain option is selected, a separator is added to the parameters
list on the New Parameters dialog box. A separator is used to separate controls into multiple
chains and can be moved up or down in the chain sequence.

Procedure: How to Auto Chain Controls From the New Parameters Dialog Box

The auto chain option creates the chain, or links of a chain, automatically. When the auto
chain option is selected, a separator is added to the parameters list. A separator is used to
separate controls into multiple chains and can be moved up or down in the chain sequence.

1. In the HTML canvas, import or reference a report with parameters.

The New Parameters dialog box opens.

2. Select Auto chain controls in above specified order.

Tip: You may use the up or down arrows to change the order of the selected control before
selecting this option.

The Chain control option is selected for all controls and a separator is added as the last
object to the list of parameters.

3. To create multiple chains, click the separator row and use the up or down arrows to
change the location of the separator in the chain.

Note: If the default separator is moved up, another separator is added to the end of the
list.
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4. Click OK to close the New Parameters dialog box and add the control to the HTML page.

On the Design tab, when creating multiple chains from the New Parameters dialog box,
each set of chained parameters appears on a new line, regardless of the grouping option
selected from the New Parameters dialog box. This behavior is set through the Start each
chain on a new line option, located on the Form Settings dialog box in the HTML Page tab
of the App Studio Options dialog box. This enables you to see the relationship of the
chains within the form. Start each chain on a new line is selected by default.

On the Parameters tab, chains are represented by lines connecting control objects.

5. You can remove a chain by clicking Break binding from the shortcut menu when a chain
link is selected.

Procedure: How to Chain Controls From the New Parameters Dialog Box

The Chain control column enables you to include or exclude individual controls in a chain, from
the New Parameters dialog box.

1. In the HTML canvas, import or reference a report with parameters.

The New Parameters dialog box opens.

2. Select the Chain control check box for the controls to be included in the chain.

The controls are chained in the order that they appear on the New Parameters dialog box.
You may use the up or down arrows to change the order of the selected control before
chaining controls.

Note: If a control is excluded from a chain, the chain automatically links only the selected
controls.

3. Click OK to close the New Parameters dialog box and add the control to the HTML page.

On the Design tab, when creating multiple chains from the New Parameters dialog box,
each set of chained parameters appears on a new line, regardless of the grouping option
selected from the New Parameters dialog box. This behavior is set through the Start each
chain on a new line option, located on the Form Settings dialog box in the HTML Page tab
of the App Studio Options dialog box. This enables you to see the relationship of the
chains within the form. Start each chain on a new line is selected by default.

On the Parameters tab, chains are represented by lines connecting control objects.

4. You can remove a chain by clicking Break binding from the shortcut menu when a chain
link is selected.
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Creating Pop-Up Controls

For a DOCUMENT object, you can use pop-up controls to:

Create modern looking controls that will run seamlessly on any device.

Create controls that look the same, but offer different functionality based on single or
multiple value selection.

To create pop-up controls, you can:

Set the Create popup controls property on the Properties panel for the DOCUMENT object.

Use the Popup style right-click shortcut option, which allows a control to be an original or a
pop-up style control. (Disabled for Edit Box, Text Area, Calendar, and Slider).

Use the New Parameters dialog box. This is available as:

An item in the Parameters grid as a check box (Popup).

A check box to select all parameters in the grid to be a Popup Control (Create popup
controls).
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The Create popup controls property on the Properties panel is shown in the following image.
Possible values are Yes and No. No is the default value.
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The Popup style right-click shortcut option for a drop-down control is shown in the following
image. (Disabled for Edit Box, Text Area, Calendar, and Slider).
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The New Parameters dialog box is shown in the following image. This options is available as a
item in the Parameters grid as a check box (Popup) and also as a check box to select all
parameters in the grid to be a Popup Control (Create popup controls).
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The following image shows an example of a pop-up control.

Using the Chain Separator and Line Separator

The chain separator and line separator options allow for chains and parameters to be grouped
or split depending on which settings are turned on. When used, the two separators do the
following:

Chain separator. When Start each chain on a new line is on, this separator creates new chain
groups on new lines. When Start each chainon a new line isoff, this separator starts a new
chain wherever it is placed in the New Parameters dialog box. The controls are positioned in
one row and wrap at the end of the form.
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Note: Start each chain on a new line is turned on, by default. This option can be found in the
Form Settings dialog box, in the HTML Page section of the App Studio Options dialog box, as
shown in the following image.

Line separator. This separator creates a line break wherever it is placed.

Procedure: How to Use the Chain Separator and Line Separator

1. Create a new procedure that uses the GGSALES Master File and prints REGION,
CATEGORY, PRODUCT, and BUDDOLLARS.

2. Create a WHERE statement with the same fields detailed in step 1, using a dynamic
parameter.

3. Save the procedure, naming it separator_example.fex.

4. Create a new HTML file.

5. Insert a new report.
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6. Right-click the report and select Reference existing procedure, as shown in the following
image.

7. Select the previously created procedure, separator_example.fex, and click OK.
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The New Parameters dialog box opens, as shown in the following image.

8. Select the Auto chain controls in above specified order option.

9. Move Line Separator above BUDDOLLARS, using the up arrow key.

A copy of the line separator is moved up while the original stays in the starting position.
This is so you can add multiple line separators.

10. Move Chain Separator above PRODUCT, using the up arrow key.

A copy of the chain separator is moved up while the original stays in the starting position.
This is so you can add multiple chain separators.
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The New Parameters dialog box will look like the following image.

11. Click OK.

The report is added to the HTML page. REGION and CATEGORY are on the first line and
make up one chain. PRODUCT is on the second line, while BUDDOLLARS is on a separate,
third line.
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The parameters are shown in the following image.

Chaining Controls on the Parameters Tab

Chaining enables you to associate two or more related values. When you chain controls
together, chained values are filtered as selections are made to each parameter control. For
example, if you chain the PLANT parameter to the STATE parameter, only PLANT values for the
currently selected STATE value will be available instead of all the plants in the data source.
Each time a selection is made, all chained controls that come after will be dynamically
updated. Chaining also enables you to add, remove, and reverse the order of controls in the
chain. 

Values are processed with a caching mechanism that gathers all of the necessary values prior
to loading the page. This method automatically combines all of the necessary requests into a
single HTTP request and maps the result sets to the appropriate controls, greatly reducing the
load time involved with sending multiple requests for data.

If a parameter has two or more incoming bindings, the value selected last will be displayed as
the parameter.

Note: When a parameter is populated by two or more controls, the value of the last control
used will be assigned to the parameter.

Procedure: How to Chain Controls on the Parameters Tab

1. Create an HTML page using input controls to supply parameter values.

2. Click the Parameters tab.

3. Select the center of the control object and drag the control to the center of the next
control object in the chain.

Repeat this step for each link in the chain.
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4. Optionally, apply condition settings to the chain to determine how parameters are
populated.

If using static controls, you must apply conditions for each link in the chain. Conditions
need to be created for each value of the control chained from, and those values must be
mapped to the correct value(s) that will be displayed in the control that it is being changed
to.

Procedure: How to Remove a Link in the Chain

1. While on the Parameters tab, select the arrow head on the line so that the line is bold.

2. Right-click and select Break binding.

3. Repeat this step for each link in the chain that you want to break.

Procedure: How to Reverse the Order of Chained Controls

1. While on the Parameters tab, select the arrow head on the line so that the line is bold,
right-click and select Break binding.

2. Select the center of the control object and drag the control to the center of the next
control object in the chain.

Notice the direction of the arrow between the control objects. You may reverse the
direction of the link in the chain or reverse the order of the chain by changing the direction
of each link.

If reversing the direction of a link in the chain, drag the control object in the desired
order.

If reversing the order of a chain, drag the control objects in the desired order.

Tip: In some scenarios, when reversing the order of chained values, you may want to move
the controls from the default location on the Parameters tab so that you can better see
the direction of the chain. Moving objects on the Parameters tab will not affect the Design
view of your layout.

Press the Shift key and select the control object and bound parameter to move the
objects as a set.

Chain the control objects together.

3. Optionally, apply condition settings to the chain to determine how parameters are
populated.
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Arranging Controls

You can choose the arrangement of controls in the New Parameters dialog box, without any
additional steps, after the parameter controls are generated. This gives you the flexibility to
design your HTML page, without the need for moving the controls after creation.

The Controls arrangement option, as shown in the following image, indicates the placement of
controls.

The following are possible values for the Controls arrangement option:

Auto. This value depends on the value in the Number of columns property in the Form
settings dialog box. This dialog box is in the HTML Page section in the App Studio Options
dialog box. Based on this value, the controls will fold to the next line. The valid values for
Number of columns are 1 to 99. Auto is the default value.

Row. Places the controls horizontally within the form.

Column. Places the controls vertically within the form.
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Applying Conditions to a Chain

A chain contains conditions for each link in the chain. The conditions are linked to the values
being selected in the control object. You may apply multiple conditions to one link. The
settings for the condition describe how the link should behave. The following options are
available:

Apply Actions for the links on the chain.

Apply the Values compare operator for the condition.

Apply Selected values with a Multiselect operator for the condition.

Apply the Resolves parameter values for the condition.

Apply the Compare operator for the condition.

If using static controls, you must apply conditions for each link in the chain. Conditions need to
be created for each value of the control chained from, and those values must be mapped to
the correct values that will be displayed in the control that it is being changed to.

Reference: Settings Panel (Conditions)

The Settings panel appears when creating a condition for a chain link on the Parameters tab. A
chain contains conditions for each link in the chain. 

The conditions are linked to the values being selected in the control object. The settings for
the condition inherit the values of the prior bound control and provide additional condition
settings. This section describes the additional condition settings.

The Settings panel contains the following fields and options when creating a condition:

Conditions 

The conditions list enables you to create multiple conditions for the link. Default is the only
initial condition.

To create a new condition, click the New icon. Condition(n) is created, where (n) is the
number, and added to the Conditions drop-down list. You may type in a unique
condition name, choose Selected values, and set the condition settings.

Click the Delete icon to remove the selected condition from the list. Note that the
Default condition name cannot be deleted.
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Actions 

Select an action for the chain link to control. The options offer variations to populate,
show, hide, execute, and select the values. The list of available options are:

Populate, show. Populates the control and displays it at run time. This is the default
action for all conditions.

Populate, hide. Populates the control and does not display it at run time.

Populate with alternate, show. Populates the control with alternate values derived
from a procedure, or value list, that is not the default and displays the control at run
time.

Populate with alternate, hide. Populates the control with alternate values derived from
a procedure, or value list, that is not the default and does not display the control at run
time.

Show. Shows the control, but does not populate it.

Hide. Hides the control, but does not populate it.

Execute. Executes the bound object. For example, if you bind a control to a Submit
button and change the value in the control at run time, the report/chart automatically
executes when you change the value, without having to click the Submit button.

Select. Selects the bound object. For example, if you bind a control to a tab item and
select a value in the control at run time, the bound object (the tab item) is
automatically selected as the active tab on the page.

Use As Target. This action is used in conjunction with a control whose values are
procedure names or HTML file names. Selecting this option, binds the control to a
frame for the output.

Values compare operator 

Values compare operator provides chaining logic scenarios to include such options as
Equal, Not Equal, Greater Than, Less Than, and so on. This option sets the condition for
how to populate the control being linked to.

Equal is the default Values compare operator.

Selected values 

Selected values enable you to provide the values used in the condition. When creating a
new condition, the Selected values section is activated. You may type selected values in
the input box or click the ellipsis button to select values from the list.
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The list of values that appears is based on the values of the prior bound control in the
chain.

When selected values are entered, the Multiselect operator field is activated.

Multiselect operator 

The Multiselect operator options are activated when selected values are entered for the
condition. Options are One of or All of. One of is based on one of the values shown in the
Selected values, being selected in the prior control, in the chain. All of is based on the
value of all of the Selected values, being selected in the prior control, in the chain.

One of is the default multiselect operator.

Resolves parameter (“To:” field is required) 

From. The From field specifies where to get the value used in the To field, if the control
being chained from is a map or activeX control.

To. The To field is used to dynamically generate the selection list used to populate the
control being chained to. This field displays the parameter whose value will drive the
condition evaluation. The parameter name linked to the prior control in the chain is
displayed by default. The ellipsis button provides a pop-up dialog of the other parameter
values (from the report) to be resolved.

Compare operator 

The compare operator provides parameter chaining logic scenarios to include such options
as Equal, Not Equal, Greater Than, Less Than, and so on. This sets the compare operator
to populate the control.

Equal is the default Compare operator.

Procedure: How to Create a New Condition

1. Insert a report with parameters in the HTML canvas. 

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain.

3. Click a link in the chain.

The Settings panel shows the bound control values and the Default condition settings for
the link in the chain.

4. Click the New icon to create a multiple condition for the chain.
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Condition(n) is created, where (n) is the number, and added to the Conditions drop-down
list, and the Selected values section is activated. You may type in a unique condition
name.

5. You may type in a unique condition name, choose Selected values, and set the condition
settings for the new condition.

6. Optionally, you may click the Delete button to remove the selected condition from the list.

Note: Default, the initial condition, cannot be deleted.

Procedure: How to Select the Action for a Condition

1. Insert a report with parameters in the HTML canvas. 

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain.

3. Click a link in the chain.

4. In the Setting panel, select the action for the condition from the Actions drop-down list. For
example, to hide the control being chained to, select Hide.

Populate, show is the default option.

When running the HTML page, the action for the chained control is applied.

Procedure: How to Select the Values Compare Operator for a Condition

1. Insert a report with parameters in the HTML canvas.

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain.

3. Click a link in the chain.

4. In the Setting panel, select the chaining logic for the parameter being chained to, in the
condition, from the Values compare operator drop-down list.

Equal is the default option.

The compare operator is applied to the value selected.
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Procedure: How to Apply Selected Values With a Multiselect Operator to a Condition

1. Insert a report with parameters in the HTML canvas. 

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls of the chain.

3. Click a link in the chain.

4. In the Settings panel, click the New icon to create a multiple condition for the chain.

Condition(n) is created, where (n) is the number, and added to the Conditions drop-down
list, and the Selected values section is activated. You may type in a unique condition
name.

5. You may type selected values in the input box or click the ellipsis button to select values
from the list.

The list of values that appears is based on the values of the prior bound control in the
chain.

Tip: You may also use the pop-up icons to select a field and close the pop-up dialog box.
The green icon is OK, the red icon is Cancel, double-clicking a value will select the value
and close the dialog box without using any button, and pressing the Esc key will cancel the
dialog box without using any button.

When selected values are entered, the Multiselect operator field is activated.

6. Select the chaining logic for the selected values from the Multiselect operator drop-down
list.

One of is based on one of the values shown in the Selected values, being selected in
the prior control, in the chain. This is the default selection.

All of is based on the value of all of the Selected values, being selected in the prior
control, of the chain.

The selected values and multiselect operator are applied to the condition.
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Procedure: How to Resolve Parameters for a Condition

It is recommended that you populate the controls first, before chaining. When you populate
first, certain information is obtained that allows the determination of the best choice for
Resolves parameter. If you chain first and then populate, the information cannot be obtained
because the chaining is already established. If you chain first, you must manually set Resolves
parameter.

1. Insert a report with parameters in the HTML canvas. 

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain.

3. Click a link in the chain.

4. In the Setting panel, click the Resolves parameter ellipsis button to select a parameter
name to resolve. If a custom procedure that has a filter (or filters) populates the control,
the values list shows the parameters from the filters. If a data source populates the
control, the values list shows all of the fields from the data source shown in the Object
Inspector.

The value in the Resolves parameter field should be either:

The field name that limits the values for the next control in the chain, if a data source
populates the control.

The parameter name from the procedure, if a procedure populates the control.

In most cases, this value will be populated by default and will not need to be changed.

Tip: You may also use the pop-up icons to select a field and close the pop-up dialog box.
The green icon is OK, the red icon is Cancel, double-clicking a value will select the value
and close the dialog box without using any button, and pressing the Esc key will cancel the
dialog box without using any button.

The parameter value is resolved in the chain if no filter is specified.
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Procedure: How to Select the Compare Operator for the Parameter

An example of when to apply chaining logic is when a form offers two lists of dates so that you
can select a FROM/TO date range. By chaining these parameters together and applying the
Greater than parameter compare operator, this ensures that when a date is selected for the
FROM parameter, only dates that follow the FROM date display in the TO date control,
eliminating the possibility of selecting an invalid date range.

1. Insert a report with parameters in the HTML canvas.

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain.

3. Click a link in the chain.

4. In the Setting panel, select the chaining logic option from the Compare operator drop-down
list. This sets the compare operator to populate the control.

Equal is the default option.

The compare operator is applied to the parameter selected.

Procedure: How to Enable Cache Processing for Chained Values

You may enable cache processing for chained values in two ways: 

Enable the caching option for the HTML page and all objects on the page.

Enable cache run time data for a dynamic control or a condition.

A chain contains conditions for each link in the chain. The conditions are linked to the
values being bound to the control object. If you change the options for the condition, it will
also be applied to the control, and vice versa.

Caching options are turned off by default.

1. To enable caching options for all objects on the HTML page, in the App Studio Options
dialog box:

Select the HTML Page tab.

Select Default caching option.

Click OK to close the App Studio Options dialog box.

2. To enable caching options for a dynamic control or condition:

Chaining in the HTML Canvas

610  Information Builders



A chain contains conditions for each link in the chain. The conditions are linked to the
values being chained to the control object. If you change the options for the condition, it
will also be applied to the control, and vice versa.

For a dynamic control:

1. Create a dynamic input control to supply parameter values.

2. Select the dynamic control object from the Parameters tab.

The Settings panel opens, showing the dynamic control options.

3. Select Cache run time data to cache the run time data for the selected input control.

Note: This setting overrides the Default caching option from the HTML Page tab, in the
App Studio Options dialog box.

4. Select the center of the control object and drag the control to the center of the next
control object.

When binding controls, the conditions inherit the values set in the dynamic control
settings.

For a dynamic condition:

1. Click a link on the chain to open the Settings panel for the condition.

2. Select Cache run time data to cache the run time data for the selected input control.
This option is only available for dynamic controls.

This setting overrides the Default caching option from the HTML Page tab, in the App
Studio Options dialog box.

When running the HTML page, data for the chained value is cached to improve
performance.

Using JavaScript Code with HTML Canvas Pages

Although the HTML canvas is fully integrated with JavaScript, it is suggested that you do not
create custom JavaScript that manipulates the HTML canvas generated controls, as
WebFOCUS cannot support such custom JavaScript code. Additionally, there is no guarantee
that the JavaScript code will work correctly in future releases. 

Note:

The HTML canvas run time is a set of JavaScript files. You should not be calling the
functions within them directly. Should you call these functions directly, your code may not
function in future releases and Information Builders cannot be held responsible.
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If you want JavaScript to run after a page loads completely, but before any reports are
executed, you need to create a function called onInitialUpdate (this function was called
onInitialUpdate() in previous releases). If you have another function, in that function, you
can call IbComposer_onInitialUpdate(). Your code should be added inline in the HTML file
after the line:

//End function window_onload

The HTML canvas run time will call onInitialUpdate() if it exists.

Function: IbComposer_removeSelectOption

IbComposer_removeSelectOption removes values from a listbox, drop down, or the 'from'
listbox of a double list control.

Syntax: How to Remove Listbox or Drop Down Values

IbComposer_removeSelectOption(controlID,arr[]);

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

arr[]

Alphanumeric Array

Is the array that contains single or multiple values.

Note: When the IbComposer_removeSelectOption method is called, the values specified by the
second parameter (arr[]) will be removed.

Example: Removing Values From a Listbox

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   var readVals = [];
   readVals = IbComposer_getCurrentSelection('listbox1');
   IbComposer_removeSelectOption('combobox1',readVals);
}
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Function: IbComposer_runAnimation

IbComposer_runAnimation runs the animation defined by the user in the Tasks and Animations
panel.

Syntax: How to Run an Animation

IbComposer_runAnimation(name);

name

Alphanumeric

Is the name of the animation specified by the user in the Tasks and Animations panel.

Example: Running an Animation

function submit1_onclick(event) {
   IbComposer_runAnimation('animation1');
}

Function: IbComposer_triggerExecution

IbComposer_triggerExecution allows the user to execute a specific task defined in the Tasks
section of the Tasks and Animations panel.

Syntax: How to Execute a Specific Task

IbComposer_triggerExecution(taskName,index);

where:

taskName

Alphanumeric

Is the name of the task specified by the user in the Tasks section of the Tasks and
Animations panel in the HTML canvas.

index

Numeric

Is the task number starting from the number 1.
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Example: Executing a Task

function submit1_onclick(event) {
   IbComposer_triggerExecution('task1',1);
}

Function: IbComposer_getRequestRefProcedure

IbComposer_getRequestRefProcedure returns the name of the procedure, given the unique
identifier of the request referencing the procedure. This was formerly available in the
myXmlRoot document.

Syntax: How to Return the Procedure Name

IbComposer_getRequestRefProcedure(Drilldown);

where:

Drilldown

Alphanumeric

Is the name of the request provided.

Example: Returning a Procedure Name

function button1_onclick(event) {
   IbComposer_getRequestRefProcedure('Drilldown');
}

Function: IbComposer_getRequestTarget

IbComposer_getRequestTarget returns the name of all the target frames used by the request.
This was formerly available in the myXmlRoot document.

Syntax: How to Return the Target Frame Names

IbComposer_getRequestTarget(Drilldown,bShow);

where:

Drilldown

Alphanumeric

Is the name of the request provided.

bShow

Boolean
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Is an operator that can be set to true to show the names, or set to false to hide them.

Example: Returning Target Frame Names

function button1_onclick(event) {
   IbComposer_getRequestTarget('Drilldown','true');
}

Function: IbComposer_getMapObject

IbComposer_getMapObject returns the map object for the map container that is passed as the
parameter. This object can then be used as a parameter in other API functions.

Syntax: How to Return a Map Object

IbComposer_getMapObject(mapId);

where:

mapId

Alphanumeric

Is the unique identifier of the map container.

Example: Returning the Map Object for a Map

function onInitialUpdate() {
   var map = IbComposer_getMapObject('mapcontrol1');
}

Function: IbComposer_getMarkers

IbComposer_getMarkers returns an array of markers for a specific layer of a map. 

Syntax: How to Return an Array of Markers for a Map

IbComposer_getMarkers(mapId,layerName);

where:

mapId

Alphanumeric

Is the unique identifier of the map container.

layerName

Alphanumeric
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Is the name of the layer for which the markers are returned.

Example: Returning an Array of Markers for a Map

function  onInitialUpdate() {
   var map = IbComposer_getMapObject('mapcontrol1');
   var markers = IbComposer_getMarkers('mapcontrol1','Customers');
}

Function: IbComposer_populateDynamicCtrl

IbComposer_populateDynamicCtrl allows you to determine from which control data is drawn
from to populate a destination control. 

Syntax: How to Populate a Control Dynamically

IbComposer_populateDynamicCtrl(controlID,fromControlId);

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

fromControlId

Alphanumeric

Is the unique identifier of the control from which values are obtained, when two or more
controls are chained to a destination control. For example, if listbox1 and listbox2 are both
chained to listbox3, by default, the values of listbox3 will be determined by listbox1. You
can use IbComposer_populateDynamicCtrl('listbox3','listbox2') to make listbox2 determine
the values of listbox3. This identifier is optional.

Example: Populating a Control Dynamically

function button3_onclick(event) {
   var acc = IbComposer_populateDynamicCtrl('listbox3','listbox2');
   acc.selectNextPage();
}

Function: IbComposer_getComponentById

IbComposer_getComponentById obtains a component by using its ID. 
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Syntax: How to Obtain a Component by Using Its ID

IbComposer_getComponentById(controlID);

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

Example: Obtaining the Accordion Report By Using Its ID

function button3_onclick(event) {
   var acc = IbComposer_getComponentById('accordion1');
   acc.selectNextPage();
}

Function: IbComposer_getCurrentSelection

IbComposer_getCurrentSelection retrieves the current selected values from a control. 

Syntax: How to Retrieve the Current Selected Value From a Control

IbComposer_getCurrentSelection(controlID,[layer],[bDateObj]);

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

layer

Integer

Is an optional parameter used to specify the layer number in a Multi source Tree control if
a Multi source Tree control is being used. The layer number starts with 1 for the first layer.

bDateObj

Boolean

Is an optional operator that can be set to true to return a date object or to false to return a
string. If you do not specify a value for this operator, it returns a string.

7. Creating HTML Pages

WebFOCUS App Studio User’s Manual  617



Example: Retrieving the Current Selected Value for a Drop Down List

function button1_onclick(event) {
   var values = IbComposer_getCurrentSelection('combobox1');
   for(var I = 0; i < values.length; i++)
   alert(values[i]);
}

Function: IbComposer_getCurrentSelectionEx

IbComposer_getCurrentSelectionEx retrieves the current selected actual or display values from
a control. The function can also be used to get the index values for List Boxes, Drop Down
Lists, and Double Lists.

Syntax: How to Retrieve the Current Selected Value, Actual Value, or Display Value From a
Control

IbComposer_getCurrentSelectionEx(controlID,[layer]);

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

layer

Integer

Is an optional parameter used to specify the layer number in a Multi source Tree control if
a Multi source Tree control is being used. The layer number starts with 0 for the first layer.

Example: Retrieving the Current Selected Index Value, Actual Value, and Display Value for a
Multi-Select List

function button1_onclick(event) {
   var values = IbComposer_getCurrentSelectionEx('combobox1');
   for(var i = 0; i < values.length; i++)
{
   alert("Index Value: " + values[i].getIndex() + "\n" +
   "Actual Value: " + values[i].getValue() + "\n" +
   "Display Value: " + values[i].getDisplayValue());
}

Function: IbComposer_getClickedRow

IbComposer_getClickedRow retrieves the current clicked row of an HTML table.
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Syntax: How to Retrieve the Current Clicked Row of an HTML Table

IbComposer_getClickedRow(clickEventTarget);

where:

clickEventTarget

Alphanumeric

Is the name of the event for the clicked row.

Example: Retrieving the Current Clicked Row of an HTML Table

function IbComposer_getClickedRow(clickEventTarget) {
    return getCurrentClickedRow(clickEventTarget);
}

Function: IbComposer_getClickedColumn

IbComposer_getClickedColumn retrieves the current clicked column of an HTML table.

Syntax: How to Retrieve the Current Clicked Column of an HTML Table

IbComposer_getClickedColumn(clickEventTarget);

where:

clickEventTarget

Alphanumeric

Is the name of the event for the clicked column.

Example: Retrieving the Current Clicked Column of an HTML Table

function IbComposer_getClickedColumn(clickEventTarget) {
    return getCurrentClickedColumn(clickEventTarget);
}

Function: IbComposer_getClickedCellValue

IbComposer_getClickedCellValue retrieves the current clicked cell value of an HTML table.

Syntax: How to Retrieve the Current Clicked Cell Value of an HTML Table

IbComposer_getClickedCellValue(clickEventTarget);
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where:

clickEventTarget

Alphanumeric

Is the name of the event for the clicked cell.

Example: Retrieving the Current Clicked Cell Value of an HTML Table

function IbComposer_getClickedCellValue(clickEventTarget) {
    return getClickedCellValue(clickEventTarget);
}

Function: IbComposer_setCurrentSelection

IbComposer_setCurrentSelection sets the current selected values for control parameters. 

Syntax: How to Set the Current Selected Value for a Control

IbComposer_setCurrentSelection(controlID,arrValues,bUpdateDependencies);

where:

controlID

Alphanumeric

Is the unique identifier of the control for which to set the values.

arrValues

Array

Is the array of values to be set.

bUpdateDependencies

Boolean

Is an operator that can be set to true to update chained controls and triggered events. The
default is false.

Example: Setting the Current Selected Value for a List Box

function button2_onclick(event) {
   var arr = [];
   arr.push('ITALY');
   arr.push('JAPAN');
   IbComposer_setCurrentSelection('listbox1',arr,'false');
}
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Function: IbComposer_execute

IbComposer_execute executes a report or chart. 

Syntax: How to Execute a Report or Chart

IbComposer_execute(reportID,[outputTarget]);

where:

reportID

Alphanumeric

Is the unique identifier of the report or chart to execute.

outputTarget

Alphanumeric

Is the optional parameter to set the target of the output. Is one of the following:

The name of a frame.

'_blank'.

'_target'.

The name of a new window.

Example: Executing a Report in a New Window

function button3_onclick(event) {
   IbComposer_execute('report1','newwin');
}

Function: IbComposer_isSelected

IbComposer_isSelected determines if a control or value is selected. 

Syntax: How to Determine If a Control or Value Is Selected

IbComposer_isSelected(controlID,[testValue]);

where:

controlID

Alphanumeric

Is the unique identifier of the control being tested.
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testValue

Alphanumeric

Is the optional parameter the control is being checked against.

Example: Determining If a Check Box Is Selected

function checkbox1_onclick(event) {
   var curValue = IbComposer_isSelected('checkbox1');    
   IbComposer_showHtmlElement('form1',curValue);
}

Function: IbComposer_showHtmlElement

IbComposer_showHtmlElement shows or hides an HTML element. 

Syntax: How to Show or Hide an HTML Element

IbComposer_showHtmlElement(elementID,bShow);

where:

elementID

Alphanumeric

Is the unique identifier of the element which is shown or hidden.

bShow

Boolean

Is an operator that can be set to true to show the element and false to hide it.

Example: Showing or Hiding a Check Box

function checkbox1_onclick(event) {
   var curValue = IbComposer_isSelected('checkbox1');
   IbComposer_showHtmlElement('form1',curValue);
}

Function: IbComposer_enableHtmlElement

IbComposer_enableHtmlElement enables or disables an HTML element. 

Syntax: How to Enable or Disable an HTML Element

IbComposer_enableHtmlElement(elementID,bEnable);
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where:

elementID

Alphanumeric

Is the unique identifier of the element which is enabled or disabled.

bEnable

Boolean

Is an operator that can be set to true to enable the element and false to disable it.

Example: Enabling or Disabling Elements

function checkbox2_onclick(event) {
   IbComposer_enableHtmlElement('listbox1', 
IbComposer_isSelected('checkbox2','country'));
   IbComposer_enableHtmlElement('combobox1', 
IbComposer_isSelected('checkbox2','car'));
   IbComposer_enableHtmlElement('listbox2', 
IbComposer_isSelected('checkbox2','model'));
   IbComposer_enableHtmlElement('combobox2', 
IbComposer_isSelected('checkbox2','dcost'));
}

Function: IbComposer_ResetDownChainControls

IbComposer_ResetDownChainControls resets the controls down the chain from the current
control to have correct corresponding values. 

Syntax: How to Reset Chain Controls

IbComposer_ResetDownChainControls(ctrl);

where:

ctrl

Alphanumeric

Is the unique identifier of the first control.

Example: Resetting the Chain Started by a List Box

function button4_onclick(event) {
   var arr = [];arr.push('ENGLAND');
   IbComposer_setCurrentSelection('listbox1',arr,'false');
   IbComposer_ResetDownChainControls('listbox1');
}
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Function: IbComposer_selectTab

IbComposer_selectTab selects the tab specified by the tabNumberToSelect and makes it the
active tab. 

Syntax: How to Select a Tab and Make It Active

IbComposer_selectTab(tabControlID,tabNumberToSelect);

where:

tabControlID

Alphanumeric

Is the unique identifier of the tab control being made active.

tabNumberToSelect

Integer

Is the number of the tab to make active.

Example: Making a Tab Active

<FORM id=form1 onsubmit="OnExecute(this);
   IbComposer_selectTab('tab1',1) name="form1">

Function: IbComposer_selectTemplateTab

IbComposer_selectTemplateTab selects a tab on a template page and makes it the active tab. 

Syntax: How to Select a Template Tab and Make It Active

IbComposer_selectTemplateTab(tabId);

where:

tabId

Alphanumeric

Is the unique identifier of the tab control being made active.

Example: Making a Template Tab Active

function submit1_onclick(event) {
   IbComposer_selectTemplateTab('tab5');
}
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Function: IbComposer_goToPageOfMultiPageControl

IbComposer_goToPageOfMultiPageControl selects a page in a multipage control, such as a
tab, accordion, or window.

Syntax: How to Select a Page in a Multipage Control

IbComposer_goToPageOfMultiPageControl(controlID, page)

where:

controlID

Alphanumeric

Is the unique identifier of the control from which values are obtained.

page

Alphanumeric

Specifies a page number (for example 1, 2, and so on), or true for the previous page and
false for the next page.

Example: Selecting a Page for a Multipage Control

The following example shows how to select a page in a window multipage control. In this
example, the control will start on page 3.

function button2_onclick(event) {
var eventObject = event ? event : window.event;
var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
// TODO: Add your event handler code here
IbComposer_goToPageOfMultiPageControl('windowPanel1', '3');
}

The following example shows how to select the previous page in a window multipage control.

function button2_onclick(event) {
var eventObject = event ? event : window.event;
var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
// TODO: Add your event handler code here
IbComposer_goToPageOfMultiPageControl('windowPanel1', 'true');
}

The following example shows how to select the next page in a window multipage control.
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function button2_onclick(event) {
var eventObject = event ? event : window.event;
var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
// TODO: Add your event handler code here
IbComposer_goToPageOfMultiPageControl('windowPanel1', 'false');
}

Function: IbComposer_getAllAmpersValues

IbComposer_getAllAmpersValues is used to retrieve the current selected values from all the
controls on your page layout. It then takes those values and assembles them as a string that
can be added to the end of a URL call. An example of this would be having a REGION control
and multiselecting MidEast, NorthEast, and NorthWest. It will assemble these selections as
shown below:

&REGION=%27MidEast%27%20OR%20%27NorthEast%27%20OR%20%27NorthWest%27

This function can be used in conjunction with the Business Intelligence Portal, where the
generated string is appended to all Business Intelligence Portal calls that run reports or charts.
This allows the parameter values to affect all portal components, even if new ones are added
or existing ones are removed at run time.

Syntax: How to Retrieve all Parameter Values

IbComposer_getAllAmpersValues([verifySelection]);

where:

verifySelection

Boolean

Is an optional parameter. When true and when the Selection required property for the
control is set to Yes, this returns an empty string for the parameter controls that do not
have a selection made.

Note: All controls have the Selection required property. This property is set to Yes by
default. If a control has no valid selection made at run time, a red box appears around it
and the following status bar message displays:

Please make required selections
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Example: Retrieving a List of All Parameters Selected in a Report

function button1_onclick(event) {
   var val = IbComposer_getAllAmpersValues();
   alert(val);
   OnExecute(event);
}

Function: IbComposer_showLayer

IbComposer_showLayer shows or hides the specified layer.

Syntax: How to Show or Hide a Layer

IbComposer_showLayer(layerName,bShow);

where:

layerName

Alphanumeric

Is the name of the layer, which will be shown or hidden.

bShow

Is an operator that can be set to true to show the layer or false to hide it.

Example: Showing or Hiding a Layer

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_showLayer('Customers','true');
}

Function: IbComposer_toggleMapLayer

IbComposer_toggleMapLayer toggles the visibility of the specified layer. 

Syntax: How to Toggle Map Layer Visibility

IbComposer_toggleMapLayer(mapId,layerName);

where:

mapId

Alphanumeric
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Is the unique identifier of the map control.

layerName

Alphanumeric

Is the unique identifier of a layer within the map.

Example: Toggling Map Layer Visibility

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_toggleMapLayer('mapcontrol1','Customers');
}

Function: IbComposer_toggleMapMarker

IbComposer_toggleMapMarker toggles the visibility of the specified marker.

Syntax: How to Toggle Map Marker Visibility

IbComposer_toggleMapMarker(mapId,layerName,markerName);

where:

mapId

Alphanumeric

Is the unique identifier of the map control.

layerName

Alphanumeric

Is the unique identifier of a layer within the map.

markerName

Alphanumeric

Is the unique identifier of a marker within the map.
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Example: Toggling Map Marker

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_toggleMapMarker('mapcontrol1','Stores','EMart');
}

Function: IbComposer_refreshMapLayer

IbComposer_refreshMapLayer refreshes the specified layer from the database.

Syntax: How to Refresh a Map Layer

IbComposer_refreshMapLayer(mapId,layerName);

where:

mapId

Alphanumeric

Is the unique identifier of the map control.

layerName

Alphanumeric

Is the unique identifier of a layer within the map.

Example: Refreshing the Layer

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target : 
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_refreshMapLayer('mapcontrol1','Customers');    
}

Function: IbComposer_panToAddress

IbComposer_panToAddress allows the user to pan to the point on a map for the specified
address and zoom level.

Syntax: How to Pan to an Address

IbComposer_panToAddress(address,mapId,zoom);
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where:

address

Alphanumeric

Is the address you want to pan to.

mapId

Alphanumeric

Is the unique identifier of the map control.

zoom

Integer

Is how much you wish to zoom.

Example: Panning to an Address

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_panToAddress('2 Penn Plaza,NY,NY','mapcontrol1',10);
}

Function: ibComposer_panToPoint

ibComposer_panToPoint allows the user to pan to the point on a map for the specified
coordinates and zoom level.

Syntax: How to Pan to a Point

IbComposer_panToPoint(lat,long,mapId,zoom);

where:

lat

Integer

Is the latitude coordinate of the point you want to pan to.

long

Integer

Is the longitude coordinate of the point you want to pan to.
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mapId

Alphanumeric

Is the unique identifier of the map control.

zoom

Integer

Is how much you wish to zoom.

Example: Panning to a Point

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_panToPoint(37.0625,-95.677068,'mapcontrol1',5); 
}

Function: IbComposer_preventModifyIFrameDocument

IbComposer_preventModifyIFrameDocument can prevent CSS modification of any iframe within
a document, by calling it from onInitialUpdate.

Syntax: How to Prevent Modification of a Document within an IFrame

function onInitialUpdate() {
   IbComposer_preventIFrameUpdates();}

Function: IbComposer_showAllMapMarkers

IbComposer_showAllMapMarkers displays all markers for the specified layer.

Syntax: How to Show All Map Markers

IbComposer_showAllMapMarkers(mapId,layerName);

where:

mapId

Alphanumeric

Is the unique identifier of the map control.

layerName

Alphanumeric
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Is the unique identifier of a layer within the map.

Example: Showing All Map Markers

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_showAllMapMarkers('mapcontrol1','Customers');  
}

Function: IbComposer_drawBullseye

IbComposer_drawBullseye draws a bullseye at a point on the map. This function has optional
parameters to select whether to display markers, the units of measure used for the bullseye,
the number of rings, the size of the rings, and the color of the rings.

Syntax: How to Draw a Bullseye

IbComposer_drawBullseye(mapId,lat,long,selectmarkers,units,
rings,[list-of-sizes],[list-of-colors]);

where:

mapId

Alphanumeric

Is the unique identifier of the map control.

lat

Integer

Is the latitude coordinate of the point you want to pan to.

long

Integer

Is the longitude coordinate of the point you want to pan to.

selectmarkers

Boolean

Is an operator that, when set to true, selects all markers within the Bullseye.

units

Alphanumeric
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The unit of measure for the Bullseye rings.

rings

Integer

The number of rings the bullseye uses.

list-of-sizes

Integer

Is an optional parameter, as a comma (,) separated list of sizes for the bullseye rings. For
example, 1, 3, 5.

list-of-colors

Alphanumeric

Is an optional parameter, as a comma (,) separated list of colors for the bullseye rings.
The colors can be RGB values or hexadecimal values. For example, Blue or #FFFF.

Example: Drawing a Bullseye

function button1_onclick(event) {
   var eventObject = event ? event : window.event;
   var ctrl = eventObject.target ? eventObject.target :
   eventObject.srcElement;
   // TODO: Add your event handler code here
   IbComposer_drawBullseye('mapcontrol1',37.0625,-95.677068,'true','mi',3);
}

Function: IbComposer_setCalendarDatesRange

IbComposer_setCalendarDatesRange sets the range for the target calendar, given the date on
the source calendar and a range in days.

Syntax: How to Set a Date Range for a Target Calendar

IbComposer_setCalendarDatesRange(elementId, fromDate, toDate)

where:

elementID

Alphanumeric

Is the unique identifier of the target calendar control for which you want to set the date
range.
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fromDate

Date object

Is the value of the date from the source calendar.

Note: This can be obtained by using the IbComposer_getCurrentSelection function. This
function should have the third parameter set to True to return a Date object.

toDate

Date object

This value must be calculated using fromDate and the number of days needed to show the
range.

Example: Setting the Date Range for a Target Calendar

function button1_onclick(event) {
var eventObject = event ? event : window.event;
var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
// TODO: Add your event handler code here
     var curDate = IbComposer_getCurrentSelection('calendar1', 0, true);
       var fromDate= new Date(curDate);
       var toDate = new Date();
       var nOfDays= IbComposer_getCurrentSelection('slider1');
       if (isNaN (nOfDays-0)&& nOfDays != null) {
            alert("Please enter a numeric value!!");
       }
       else {
           var time = fromDate.getTime()+(nOfDays*3600000 * 24);
           toDate.setTime(time);
           IbComposer_setCalendarDatesRange("calendar2", fromDate, 
           toDate);
       }
}
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Creating Responsive Web Pages

Responsive web design is an approach to webpage creation where content automatically
realigns to fit a variety of different window sizes and screen sizes. This allows the content from
one HTML file to automatically adapt to multiple footprints such as a desktop, laptop, tablet,
or smartphone. 

Unlike a generic HTML page, the containers in a responsive page reorder automatically as the
screen size changes. Where a generic page shows partial content with a horizontal scroll bar,
the responsive page shows full content, re-ordered, with no horizontal scroll bar.

How Responsive Containers Fold

The behavior that makes a page responsive is called “folding.” This section details the way
responsive containers fold, or re-arrange, as screen size changes. The order in which
responsive containers fold is illustrated in the following image. 

Figure A illustrates a responsive layout with a row-based 4-2 format, meaning there are four
containers on row one and two containers on row two.

Figure A also illustrates the filter row, containing four controls. At run time, the filter row can
either be hidden or displayed.
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Figure B illustrates the way containers fold responsively when the screen width decreases. The
content in each container resizes accordingly, as the screen width changes.

Note: Objects within a responsive container are positioned absolutely. That is, they do not fold.
Responsive containers fold in relation to one another, but the objects inside the containers
remain fixed.

Objects inside responsive containers can scale to defined limits, as detailed in How to Set
Minimum and Maximum Panel Sizes on page 649. However, the objects within a container
will not fold.

Procedure: How to Control Folding with the Flow Direction Property

You can control the column/row orientation by which responsive containers re-arrange
themselves.

1. Select a container in a responsive HTML page.

2. Click the drop-down arrow in the Flow Direction field of the Properties panel and select one
of the following:

Not Set. - Allows you to fold objects based on the available space (default).

Row. - Allows you to fold objects horizontally by row.

Column. - Allows you to fold objects vertically by column.
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Note: The Flow Direction property does not display for a responsive container that contains
an element that is not responsive. For example, a button contained in a responsive panel
will disable (hide) the Flow Direction property for the panel. To prevent this, right-click the
button and click Add selected to new container from the context menu. Then, when you
click the original panel, the Flow Direction property is available again.

3. Run the page. Resize the browser to observe the folding.
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Selecting a Responsive Method

There are two ways to create responsive pages in App Studio: using a Responsive Template,
and using the HTML Canvas in Responsive Mode. The following diagram shows the high-level
decision tree that lets you quickly find the best way to create your responsive page:

1. Using a Responsive Template. This method lets you create a page by populating
responsive Output Widget containers in a pre-defined template or a layout that you create
at design time. You use the HTML/Document wizard to specify a layout that is either row-
based or column-based.
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Key Characteristics

The Output Widget container, shown in the following image, is the key characteristic of a
Responsive Template.

The Output Widget container has the following features:

Title Bar. Including an editable text title.

Image. Such as a company logo, that can be inserted on the left side of the title bar.

Arrow Toggle. On the right side of the title bar, to display or hide widget-level controls.

Expand Toggle. On the right side of the title bar, to make the widget contents display
full screen or original size.

If you want to create a responsive page with one or more Output Widget containers, the
Responsive Template method is the most efficient approach. This method is used only for
creating new responsive HTML files. For more information, see Creating a Page With a
Responsive Template on page 640.

2. Using the HTML Canvas Responsive Mode. This “free form” method lets you create a
responsive page with no pre-defined layout. This manual approach is perhaps not as fast
as using a template, but may be preferable if you want to create a responsive page with
containers of many different types.
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This method can also be used to convert an existing HTML file to responsive. For more
information, see Creating a Page With the HTML Canvas in Responsive Mode on page
652.

Creating a Page With a Responsive Template

There are six pre-defined responsive templates available through the HTML/Document Wizard.
These represent the most commonly used page layouts. You can use the layout from a
template as-is, or modify the layout further after initiating it with a template.

As an alternative to using a pre-defined template, the HTML/Document Wizard allows you to
create a custom page layout at design time. You can specify the number of rows and columns,
and whether the page has a row- or column-based orientation. These and other page options
are detailed in the following sections.

Understanding Responsive Templates

When you select a responsive template from the HTML/Document Wizard, it generates a
responsive layout with the specified number of rows (or columns) and widget containers. The
parts of the responsive layout are highlighted in the following image, which was generated
using the 2-2 responsive template. The image is annotated numerically with corresponding
properties and explanations appearing below. 

Creating Responsive Web Pages

640  Information Builders



Document. Although not enumerated in the previous image, a responsive template generates
an HTML document that includes the following responsive properties, editable in the Properties
panel:

Load in iFrame object. To load the entire page as a widget (a single DIV item) for use in a
BI Portal. The default value for this property is Yes.

Responsive: min width. Sets the minimum width (in pixels or percentage) beyond which the
page size cannot be decreased. The default minimum width is 320 pixels.

Responsive: max width. Sets the maximum width (in pixels or percentage) beyond which
the page will not rescale larger. This also defines the width of the canvas at design time.
This limit is indicated by a black vertical line on the right side of the canvas, as shown in
item 3 in the previous image. The default maximum width is Full screen.

At run time, the layout populates the full browser.

Container alignment. Sets the alignment of containers within the page to the left (default)
or centered.

1. Main Widget. Defined as windowPanel1 <DIV> in the Properties panel, the default title is
Output widgets container.

Grid margin. Defines the margin around all four edges of a cell expressed in pixels.

Template orientation. Determines if the content folds by row or by column. The default
orientation is Row-based. To change this, you can select Column-based.

Widget Title. You can delete the default and type the desired title for the widget that
encompasses the entire page contents.

Display image. Enables you to display an image in the upper left corner of the widget. The
default setting is Yes.

Image source. Used to select the image to be displayed. Once selected, the path to the
image is provided.

Auto-hide inputs panel. The row of controls used to filter the content for the page is hidden
by default. To always display the row of controls, select No.

Select animation. Enables you to select any animations that have been set for this window
panel.

2. Widget display buttons. The page, and each widget within it, has two buttons in the upper-
right corner: an arrow and a box. Toggle the arrow to display or hide the row of controls. Toggle
the box to expand a widget to full screen or return it to original size.
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3. Vertical design boundary. This is a visual indicator on the far right side of the canvas that
shows the responsive maximum width set in the Properties panel for the document. The
default is 1500 pixels.

4. Widget Title. Defined as windowPanel2 <DIV> in the Properties panel (for the first widget),
the default widget title is Output Widget Title. You can delete the default and type the desired
widget title in the Properties panel. At design time, a red box appears around the widget title
and contents to indicate a responsive container.

5. Widget contents. Defined as iframe1 <IFRAME> in the Properties panel (for the first
widget), you can right-click to add content to the widget through the following shortcut menu:

New Report. To create a new report in the widget.

New Chart. To create a new chart in the widget.

New Document. To create a new document in the widget.

Import existing. To import an existing procedure into the widget.

Reference existing procedure. To reference an existing procedure in the widget.

Map. To create a new map control in the widget.

ESRI. To create a new emf object in the widget.

Use as Toolbox. A general option to use the widget as needed. For example, you may
decide to create a button to execute an action.

The content in pages derived from a responsive template loads in the following order at run
time: left to right - top to bottom.

To add a header to your responsive page, right-click in the title bar and select Add page header
from the shortcut menu. Alternatively, you could use the Add page header option in the HTML/
Document Wizard, as detailed in the following procedure.

Procedure: How to Select a Responsive Template

Select a responsive template from the HTML/Document Wizard as follows:

1. Open the HTML/Document Wizard using one of the following methods:

a. On the Home tab, in the Content group, click HTML/Document; or

b. In the Environments Tree panel, right-click an application folder, click New, and click
HTML/Document.
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The HTML/Document Wizard opens. If you used option a. above, the HTML/Document
Wizard contains a navigation window that you can use to specify the folder where you want
to save the new file.

2. Click Next.

The Templates, Settings, and Themes page opens, containing the Responsive Templates
section, as shown in the following image.

3. Click on a desired responsive template.

Selecting None results in a generic HTML canvas that is not responsive.

Selecting Custom lets you design a layout that differs from those offered by the
responsive templates. For more information, see How to Create a Custom Layout on
page 651.

For purposes of this procedure, do not select None or Custom.

4. Use the Input Controls section at the bottom of the page as follows:

Select Auto-hidden to hide the controls input panel. This is the default. At run time,
users display the panel by clicking the down arrow in the title bar.

Select Always show to display the controls input panel. At run time, users hide the
panel by clicking the up arrow in the title bar.

Clear the check box for Use a single input control panel if you want to use widget-level
controls instead of, or in addition to, page-level.

5. Select Run requests on load to load the contents of all the widgets when the page first
opens.

6. Select Add page header if you want to add space above the title bar, within the responsive
panel1 <DIV>. You could use this area to add a graphic and/or company logo, for
example.
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7. Click Finish to close the HTML/Document Wizard.

The HTML canvas opens with the automatically generated responsive layout corresponding
to the selected template.

Note: It is a best practice to expand App Studio to full screen when working with a
responsive layout. This lets you access the greatest number of widgets without having to
scroll.

Reference: Populating Widgets in a Responsive Template

A layout generated by a responsive template contains blank widgets in responsive containers.
This section contains guidelines for editing and adding objects to widgets.

To add content to a header, click the desired element from the Components tab and drag
and drop it on the header area to define it.

To increase the height of a page header, click the Title Bar and drag it down to expose
more room above it. Click the header area to highlight the responsive red box. Drag the
lower border of the red box down to increase the height of the header.

To change a widget title, click the default title, Output Widget Title, and open the Properties
panel. In the Widget Title field, type the new widget title.

To display an image in the top left corner of a widget title bar, set the Display image value
to Yes. Use the Image source field to lookup the desired image file.

To add objects to a widget, right-click in the widget to display the shortcut menu. Click the
desired object type, for example, Report, Chart, Document, Map, and so on. You can create
new content in the widget, import existing content, or reference existing content.

Note: When using a layout generated by a responsive template, you cannot add objects to
the canvas outside the layout.

To add multiple objects to a widget, drag the additional object from the ribbon to the
widget. For example, on the Home tab, in the Content group, click the Report button and
drag it to a widget that already contains an object, and drop it. A box is automatically drawn
within the widget to contain the new report object.

Note: All of the objects in a responsive container must be responsive. You cannot include
responsive and non-responsive objects in the same responsive container.

To set an equal margin around all four sides of a widget, enter a number of pixels in the
Margin property for the widget <IFRAME>.
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To move contents from one widget to another, click the Positioning tab and, in the
Responsive Design group, click Toggle Selection. Drag contents between widgets as needed
and click Preview Runtime, on the Utilities tab.

Procedure: How to Add or Remove a Widget

You can change the layout of your responsive page at design time by adding or removing a
widget, as detailed below. 

1. Open a responsive HTML page.

2. To add a widget, use one of the following methods:

a. Select a widget next to the location where you want to add a new one. Right-click on
the title bar of that widget and select Insert new widget before or Insert new widget
after from the shortcut menu.

The new widget is added.

b. Alternatively, you can right-click on the title bar of the HTML page and select Template
configuration... from the shortcut menu. The Template Configuration dialog box shows
the row (or column) numeric configuration. For example, 3-2.

Change the numeric configuration to include the new widget. For example, to add a
new widget to the second row, change the value to 3-3.

The new widget is added.

3. To remove a widget, use one of the following methods:

a. Select a widget that you want to remove. Right-click on the title bar of that widget and
select Delete from the shortcut menu.

The widget is removed.

b. Alternatively, you can right-click on the title bar of the HTML page and select Template
configuration... from the shortcut menu. The Template Configuration dialog box shows
the row (or column) numeric configuration. For example, 3-2.

Change the numeric configuration to reduce the number of widgets. For example, to
remove a widget from the first row, change the value to 2-2.

The widget is removed.

Procedure: How to Add an Additional Object to a Widget

You can put more than one object (such as a report or chart) in an output widget, as detailed
in this procedure. 
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Note: A widget that contains a map will not accept an additional object.

1. Click an object that has already been added to a widget.

If the widget contains a report or chart, you can add another report or chart, but not
any other type of object.

If the widget contains a toolbox, you can add an additional report or chart, but it will
not have the Autosize option set by default. You must set this option manually.

Open the Properties panel to verify that the IFRAME is selected.

2. On the Components tab, click the object that you want to add. For example, Report or
Chart.

The widget can be divided vertically (with the two objects, side by side) or horizontally (with
the two objects one above the other). Move your cursor to the right or left side, or the top
or bottom of the widget.

The existing content automatically moves to the opposite side of your cursor.

3. Click on the side where you want to insert the new object.

The widget is automatically divided into two equal columns or rows. The side you selected
contains the report or chart icon in an iframe.

Note: If you change your mind after you add the new iframe, you may right-click and delete
it. However, the original iframe will not automatically expand to fill the original space in the
widget. At run time, the content of the original iframe does fill the original space. But at
design time it remains partial. You can click the original iframe and manually drag its
border to fill the widget space, if you want the appearance of the page at design time to
more closely reflect the appearance at run time.

4. Right-click the icon and select the desired option from the shortcut menu to create the
new object. For example, Reference existing procedure.

5. Click the widget title bar and open the Properties panel. The Number of columns property
defaults to Auto. Use the drop-down menu to select the number of columns you want in
the widget. Select 2 if you have two objects side by side. Select 1 if you have two objects,
one above the other.

Run the page to preview widgets that have multiple objects to be sure the content remains
legible.
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Procedure: How to Apply Page-Level Controls in a Responsive Page

You may often have a responsive page that contains multiple reports that use the same
controls. For example, if users can select region and month, they may want to show the same
region and month selection for multiple reports in the page. In this case, you can apply
common controls at the page level. 

Your page can also include one or more reports that use controls that differ from the common
ones. In this case you can apply additional controls at the widget level, as defined in How to
Apply Widget-Level Controls in a Responsive Page on page 648.

This procedure details how you apply controls at the page level.

1. Create multiple reports or charts that use the same controls and add them to widgets in a
responsive layout as detailed in How to Select a Responsive Template on page 642.

When you add a report with controls to a widget, the New Parameters dialog box opens.
You can use this dialog to chain controls together. Chaining lets you filter control values
based on the selected value from the prior control in the chain. For example, if State and
City controls are chained, the City values will be filtered to show only cities in the selected
state.

For more information see Chaining in the HTML Canvas on page 589.

2. Run the page. Note that:

The control names and values are appended to the page title in the title bar.

The controls input panel does not display. This is the default.

3. Click the down arrow in the right corner of the title bar to display the controls input panel.

Close the HTML output and return to the HTML canvas.

4. If you want the controls input panel to display when the page opens:

a. Click the title bar and open the Properties panel.

The properties for windowPanel1 <DIV> are displayed.

b. Change the Auto-hide inputs panel value to No.

c. Run the page. Note that the controls input panel now does display.

5. To display the controls on the left side of the input panel:

a. Click the controls input panel and open the Properties panel.

b. Change the Control panel value to Yes.

c. Run the page and expand it to full screen. Note that the controls in the input panel
display together on the left side of the panel, where the user expects them to be.
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If you do not set the Control panel value to Yes, the controls will automatically expand to
the right to use the full width as the page size increases.

The selections that the user makes in the controls input panel are automatically applied to all
the reports on the page that share the controls.

Procedure: How to Apply Widget-Level Controls in a Responsive Page

You may often have a responsive page that contains multiple reports that use the same
controls. For example, if users can select region and month, they may want to show the same
region and month selection for multiple reports in the page. In this case you can apply
common controls at the page level, as defined in How to Apply Page-Level Controls in a
Responsive Page on page 647. 

Your page can also include one or more reports that use controls that differ from the common
ones. In this case you can apply additional controls at the widget level.

This procedure details how you apply controls at the widget level when different controls are
used at the page level.

1. Open a responsive HTML file that uses page-level controls, such as the one created in 
How to Apply Page-Level Controls in a Responsive Page on page 647.

Add a new widget to a row as detailed in How to Add or Remove a Widget on page 645.

2. Create a report or chart that uses controls and add it to the new widget. For purposes of
this procedure, use different controls than the ones used in the other reports in this page.

When you add a report with controls to a widget, the New Parameters dialog box opens. By
default, this dialog is set to create a control. Click OK.

3. Run the page. Note that the controls input panel displays in the new widget by default.

4. To hide the controls input panel in a new widget:

a. Add a new widget to a row as detailed in How to Add or Remove a Widget on page
645. Add the report you created in Step 2 to the new widget.

The New Parameters dialog box opens.

b. In the Parameter grouping options field select New single layer form and click OK.

The New Parameters dialog box closes. The input panel is hidden.

The selections that the user makes in the controls input panel at the page level are
automatically applied to all the widgets on the page that share controls. Additionally, the user
can make a selection in the independent widget that does not share controls.
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Procedure: How to Animate the Controls Input Panel

Creating a page with a responsive template enables you to add animation that appears when a
user opens or closes a controls input panel at run time. This consists of creating and naming
an animation, then applying it to the window panel that corresponds with the input controls, as
detailed below. 

1. Open an HTML page that was a) created with a responsive template; and b) contains input
controls.

2. Open the Tasks & Animations panel. In the JQuery Animations section, click the New
button.

The system gives the new animation a default name. For example, Animation1. If you wish
to rename the animation, click the default name and type the new name.

Note: It is not necessary to specify a selected target for the animation. Leave this field
blank.

3. In the Effect section, use the drop-down menu in the Type field to select an animation. If
you wish, you may select an Option and Value to apply to the selected animation.

4. At the bottom of the panel, click Toggle animation.

The animation is ready to be applied to the window panel.

5. In the responsive layout, click the title bar under which the control input panel appears.

6. Open the Properties panel. In the Output Widget section, click the Select animation field.
Use the drop down menu to highlight the desired animation name. For example,
Animation1.

7. Run the HTML page. Use the up/down arrow button on the title bar to see the animation
when you hide/reveal the controls input panel.

Procedure: How to Set Minimum and Maximum Panel Sizes

Responsive panels automatically resize as the viewing window changes, but panels do not
have a default minimum or maximum size. You can set minimum or maximum size, in pixels or
percentages, to best suit the panel contents, as follows. 

Note: Panels in a responsive page resize within the context of the minimum and maximum
page width. To view or edit these values, open the Properties panel and select DOCUMENT
from the drop-down menu at the top of the panel. For Responsive: min width, the default is
320px. For Responsive: max width, the default is Full screen.

1. Click a responsive panel that contains controls, or click the title bar of a widget, and open
the Properties panel.
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The Properties panel for the panel <DIV> includes the following properties: Min-width, Max-
width, Min-height, and Max-height. These values are blank by default.

2. You can manually type a number of pixels or a percentage. For example, 50px or 50%.

Alternatively, you can use the shortcut menu as follows:

3. Right-click a responsive panel that contains controls, or right-click the title bar of a widget.
From the shortcut menu, select Update Sizes.

The Update Sizes shortcut menu displays.

Select Update minimum size to populate the Min-width and Min-height properties with the
number of pixels or percentages used by the selected container. In other words, the
container will not scale smaller than the size shown in the responsive layout.

Note: Update minimum size does not change the object size in design time, but it does
change the size in run time.

Select Use Current to use sizes from the selected container as follows:

Size as min size. To populate the Min-width and Min-height properties with the number
of pixels used by the selected container.

Size as max size. To populate the Max-width and Max-height properties with the
number of pixels used by the selected container.

Height as min height. To populate the Min-height property with the number of pixels
used by the selected container.

Width as min width. To populate the Min-width property with the number of pixels used
by the selected container.

Height as max height. To populate the Max-height property with the number of pixels
used by the selected container.

Width as max width. To populate the Max-width property with the number of pixels
used by the selected container.

Procedure: How to Load a Widget at Run Time

In some cases, the content you add to a widget might not load at run time, leaving the widget
blank. This could occur if you did not select the Run requests on load option from the HTML/
Document wizard, or if you added a new widget to a layout. 

To cause widget content to load at run time:

1. Open the Tasks & Animations panel, select the Load Task, and then select Load Trigger
Type.
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2. In the Requests/Actions section, click the down arrow next to the Add Request button.

The shortcut menu is displayed.

3. Select Run Request and then select an iframe, for example iframe2.

The iframe is added to the Requests/Actions field and is highlighted.

4. In the Target Type field, select Frame. In the Target/Template field, select the iframe that
corresponds to the one that is highlighted, for example iframe2. Run the page.

The content loads at run time.

5. Repeat these steps for all the iframes in your page that do not load at run time.

Procedure: How to Create a Custom Layout

In the HTML/Documents Wizard, the Templates, Settings, and Themes page includes six
responsive templates that represent the most commonly used layouts. You can use these
layouts as-is, or use them as a point of departure for a modified layout that contains more or
fewer widgets. For more information, see How to Add or Remove a Widget on page 645. 

Instead of using a template, you can create a custom layout, as detailed in this procedure.

1. Open the HTML/Document Wizard using one of the following methods:

a. On the Home tab, in the Content group, click HTML/Document.

or

b. In the Environments Tree panel, right-click an application folder, click New, and click
HTML/Document.

The HTML/Document Wizard opens. If you used option a. above, the HTML/Document
Wizard contains a navigation window that you can use to specify the folder where you want
to save the new file.

2. Click Next.

The Templates, Settings, and Themes page opens, containing the Responsive Templates
section.

3. In the Responsive Templates section, click Custom. Click Finish.

The layout opens and the Template configuration dialog is activated.

4. In the Orientation field, select Row-based or Column-based.

5. Use the Select row number and Number of containers in a row field as follows:

a. With number 1 showing in the Select row number field, use the drop down list in the
Number of widgets in a row field to specify the number of widgets you want in row 1.

Note: Use the drop down list. Do not type in the field.
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b. Select 2 in the drop down list in the Select row number field.

c. Use the drop down list in the Number of widgets in a row field to specify the number
of widgets you want in row 2.

d. Repeat this sequence as needed to define your custom layout.

Close the Template configuration dialog.

6. Define the page-level behavior of input controls as follows:

In the Properties panel for windowPanel1 <DIV>, set Auto-hide inputs panel to Yes. At
run time, users reveal the panel by clicking the down arrow in the title bar. This
controls page-level behavior.

In the Properties panel for windowPanel2 <DIV>, set Auto-hide inputs panel to Yes. At
run time, users reveal the panel by clicking the down arrow in the title bar. This
controls widget-level behavior. Repeat this for each widget for which you want to use
widget-level controls.

Select No to display the controls input panel. At run time, users hide the panel by
clicking the up arrow in the title bar.

7. To add a page header, right-click in the title bar of the page and select Add page header
from the shortcut menu. You could use this area to add a graphic and/or company logo,
for example.

Creating a Page With the HTML Canvas in Responsive Mode

This “free form” method lets you create a responsive page with no pre-defined layout. This
manual approach is perhaps not as fast as using a template, but may be preferable if you want
to create a responsive page with containers of many different types. You can also use this
method to convert an existing HTML file to responsive. 

The following containers are responsive, by default:

Report

Chart

Form (Single Layer and Multiple Layer)

Tab (Top, Bottom, Left, and Right)

Accordion (Vertical and Horizontal)

Window
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Output Widget

Group Box

Panel

Frame

Map

Esri Map

Procedure: How to Create New Content in Responsive Mode

You can create new responsive content using the HTML canvas in responsive mode, as
defined in this procedure. 

1. Open the HTML/Document Wizard using one of the following methods:

a. On the Home tab, in the Content group, click HTML/Document; or

b. In the Environments Tree panel, right-click an application folder, click New, and click
HTML/Document.

The HTML/Document Wizard opens.

2. Click Next.

The Templates, Settings, and Themes page opens, containing the Page Settings section,
as shown in the following image.

3. In the Page Settings section, select Responsive design.
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Note:

The Create default responsive containers option is selected, by default. When you
create a control using the New Parameters dialog box, the forms and the controls will
be created with responsive containers.

If you clear the Create default responsive containers check box, no responsive
containers will be drawn for the form object.

Controls are not responsive, by default. If you draw a control, right-click the control and
select Add Selected to a new container to draw a responsive container around the
object.

You can make a non-responsive container responsive by selecting the container and, in
the Properties panel, selecting Yes for the Enable Responsive property.

4. Click Finish.

The HTML canvas opens. In the Properties panel, in the DOCUMENT properties, the
Responsive design value is set to Yes.

As an alternative to using the HTML/Document Wizard, you can open a file in the HTML
canvas and manually change the Responsive design property value to Yes.

You can add content to the HTML canvas before turning Responsive Design on. However,
there are advantages to turning Responsive Design on before adding content. Design time
benefits include:

Having the responsive minimum and maximum widths established

Having the maximum width visually indicated by the horizontal line on the right side of
the canvas

Having the Preview Runtime capability to preview the run-time appearance

Procedure: How to Convert an HTML File to Responsive

1. To enable responsive behavior in an existing HTML file, double-click the file in the
Environments Tree panel, or right-click it and click Open. 

The HTML file is open in the HTML canvas.

2. In the Properties panel, select DOCUMENT from the drop-down menu.

The Document properties are displayed.

3. In the Responsive design property, select Yes from the drop-down menu.
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A message appears asking of you want to group control elements into responsive
containers.

4. Indicate your preference for responsive containers as follows:

a. Click Yes to add multiple containers in the control area as shown in the following
image.

Note there are three containers within the fourth, larger container. The containers are
red, indicating that they are responsive.

b. Click No to add no containers. This may be preferable if your page contains many
nested objects, otherwise each object will get its own container.

You can add additional containers at a later time:

1. Multi-click the control objects you want to group in a container.

2. Right-click one of the highlighted objects and select HTML object manipulation
from the shortcut menu.

3. Select Merge containers.

4. To make a frame responsive, select it and open the Properties panel. Set the
Enable responsive property value to Yes.

The HTML canvas is now in responsive mode. The frames and controls on your HTML
canvas are each enclosed in a responsive container, indicated by a red box.

Note: if the HTML file had the Autosize Children option enabled, it will be superseded by
the new responsive behavior, which automatically controls sizing.

Two additional responsive properties appear in the Properties panel, whose values you
may edit:

Responsive: min width. Elements will not be repositioned or resized if the width of the
container is less than this minimum, specified in pixels or percentage.

Responsive: max width. Elements will not be repositioned or resized if the width of the
container is greater than this maximum, specified in pixels or percentage.
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A black vertical line appears on the right side of the HTML canvas in responsive mode, as
a visual indicator of the responsive maximum width. You may need to scroll right to see
this line.

5. To move contents from one container to another, click the Positioning tab and, in the
Responsive Design group, click Toggle Selection. Drag contents between containers as
needed and click Preview Runtime, on the Utilities tab.

6. Click the Run button on the Application menu and view the HTML output full screen.
Gradually decrease the width to observe the responsive folding.

Procedure: How to Restrict the First Row to Controls Only

When you create a page with a responsive template, the first row of the page is automatically
restricted to input controls (when applicable). Content such as reports or charts will not fold up
to populate the first row, regardless of how wide the browser may stretch at run time. 

When you create a page using the HTML canvas in responsive mode, this restriction is not
automatic. Therefore a report or chart could fold up to populate the first row, if the browser
width is increased. This behavior may be considered undesirable.

Ensure that the first row contains controls only, as follows:

1. Open an HTML page that was:

Created with the HTML canvas in Responsive mode

and

Contains input controls.

2. Verify that the input controls are all grouped within a single container. If not:

a. Hold down the Ctrl key and multi-select all the controls.

b. Right-click on one of the controls and select HTML object manipulation.

c. From the shortcut menu, select Add selected to new container.

Note that a box appears that contains all the selected controls. The box is red,
indicating it is responsive.

3. To display the controls on the left side of the input panel:

a. Click the controls input panel and open the Properties panel.

b. Change the Control panel value to Yes.

c. Run the page and expand it to full screen. Note that the first row contains controls
only. Also note that the controls in the input panel display together on the left side of
the panel, where the user expects them to be.
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If you do not set the Control panel value to Yes, the controls will automatically expand to
the right to use the full width as the page size increases.

Procedure: How to Create a Responsive Page for Use in a BI Portal

The WebFOCUS BI Portal gives users access to BI content, including dashboards,
visualizations, reports, charts, graphs, maps, and interactive InfoApps. The BI Portal allows
users to analyze vital information quickly, link content and reports together, and easily tailor
information to their needs. 

This procedure is comprised of two parts: creating a report for use in the responsive portal and
creating a responsive HTML page using the HTML canvas.

1. Select or create a report with the following criteria:

Has dynamic parameters specified in a WHERE clause.

Has _FOC_NULL as the default.

Has a parameter that is a Multiselect OR.

Has a value of No in the File/Folder Properties panel - Prompt for Parameters property.

2. Create a responsive HTML page as follows:

a. Open the HTML/Document Wizard from the Home tab, in the Content group, or from
the shortcut menu in the Environments Tree panel. Click Next.

The Templates, Settings, and Themes page opens.

b. In the Page Settings area, click Responsive design and click Finish.

The HTML canvas opens. In the Properties panel, in the DOCUMENT properties, verify
that the Responsive design object property is set to Yes and the Load in iFrame object
property is set to No.

The Load in iFrame object property is used to enable objects in a BI Portal to overlap
the edges of a container. For example, when you have a pop-up calendar that
populates a date field, the calendar can overlap the control container to allow the user
to select a date.

Note: The Load in iFrame object property creates a <DIV> for the page instead of an
<iFrame> tag. A BI Portal is limited to only one HTML Canvas page that is enclosed in
a <DIV> tag.

Note that the Responsive: min width is set to 320px and the Responsive: max width
is set to Full screen. These default values can be edited in pixels or percentages.
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c. In the Requests and Data sources panel, click the drop down arrow next to the New
icon, and select the option Requests-Parameters-Filter Panel.

The Open File dialog box opens.

d. Select the procedure you designated in Step 1 and click OK.

The New Parameters dialog opens.

e. Click Autochain controls in above specified order, and click OK.

The New Parameters dialog closes and the HTML canvas is opened, showing the
controls in containers. The red boxes indicate that responsive design is activated.

f. Open the Tasks & Animations panel and verify that the Submit button (task 2)
Requests/Actions value is Refresh1 and the Target Type is Refresh BI Portal.

g. Right-click the canvas and select Preview Runtime or click the Preview Runtime button
on the Utilities tab. Note that the content expands to the maximum width. The black
vertical line on the right side of the canvas is a visual indicator of the specified Full
screen max width.

h. Save the HTML page.

Reference: Tips for Using Responsive Design

The following are some best practices in working with Responsive Design to create responsive
HTML pages: 

When creating a new responsive HTML page:

Use a Responsive template to generate a layout with widgets. The HTML/Document
Wizard lets you control the number of rows and the number of widgets per row, lets you
determine how input controls will appear, lets you add a page header, and lets you run
requests automatically when the page loads at run time.

Use Responsive Design in the HTML canvas to generate a layout without widgets. This
method lets you design a page for a BI Portal.

On the Positioning tab, the Positioning group contains the Same Width, Same Height, and
Same Size commands that behave as follows in responsive design mode:

Same Width. Sets the minimum and maximum width to that of the control object (the
previously selected object).

Same Height. Sets the minimum and maximum height to that of the control object (the
previously selected object).

Same Size. Sets the minimum and maximum width and height to that of the control
object (the previously selected object).
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To use these commands:

1. Click the object whose size you want to duplicate.

2. User the Control key and click the secondary objects that you want to resize.

3. Click the desired command button from the Positioning group.

On the Positioning tab, the Responsive Design group contains the Toggle Selection and
Update Layout commands. These commands are enabled in responsive design mode.

Toggle Selection. Toggle on to allow responsive containers that include content to be
dragged to a new position. Toggle off to prevent those containers from being
repositioned.

Update Layout. This command is activated in a responsive page when the Autosize
children property is set to Yes. Click to refresh the HTML canvas after you reposition
containers, to show how the containers will stack when folded.

You can control the run-time alignment of contents within a responsive container using the
Content alignment property. This property appears for a parent responsive container that
contains multiple responsive objects.

Click the down arrow to display the following property values:

Blank <Not Set>. The objects are aligned toward the left side of the container by
default.

Start. The objects are aligned on the left side of the container.

End. The objects are aligned on the right side of the container.

Center. The objects are centered within the container.

Space between. The objects are evenly distributed by width. The first object is close to
the left side, the last object is close to the right side, and the objects in between are
spaced equally.

Space around. The objects are evenly distributed by width and height.

The alignment in the HTML canvas does not change after you specify a content alignment
property value. Click Run on the Quick Access Toolbar to see the specified alignment in the
browser.

A black vertical line appears on the right side of the HTML canvas in responsive mode, as a
visual indicator of the breakpoint width for desktop display. In order to control the behavior
of your responsive containers, position them to the left of this line on the HTML canvas.
Content appearing to the right of this line will fold arbitrarily.
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If you have both Mobile Design and Responsive Design enabled, Mobile Design takes
precedence when you view content on the smartphone. Mobile Design uses jQuery mobile
controls. Responsive Design uses browser-generated controls.

Designing Content for Smartphones

You can design content specifically to be used on smartphones. Content designed in this way
is automatically sized, and takes full advantage of the page-swipe navigation and touch-screen
capabilities of smartphones. 

Note: Tablets can display native App Studio HTML content without modification. This section
pertains to designing HTML content for smartphones only.

The following steps outline how you can design HTML content for smartphones:

1. Create and save your content in an HTML file that is built in the native App Studio HTML
canvas.

2. Enable Mobile Layout for the HTML file by using the Enable mobile property.

For more information, see Enabling Mobile Layout in an HTML File on page 665.

3. Select either the Basic or Advanced Mobile Layout.

For more information, see Working With the Basic and Advanced Mobile Layouts on page
666.

4. Populate the smartphone pages with your HTML content.

5. View the results on your smartphone.

For more information, see Viewing Mobile Output on a Smartphone on page 672.

Designing Output for Smartphones With the Mobile Layout Functionality

Before you use the Mobile Layout functionality, you must create and save your content on the
native HTML canvas. The example shown in the following image contains four objects: a text
box containing a title, a drop-down control, a frame containing a report, and a frame containing
a chart.
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Frames

Frames in your HTML content automatically appear in the Mobile Layout. In the Basic Mobile
Layout, individual frames appear separately on individual pages. In the Advanced Mobile
Layout, all frames appear together on a single page. You can change either layout to display
frames on pages as you like.

The page order, when viewed on a smartphone, is determined by the frame order in the Tasks
area of the Tasks & Animations panel. You can change the page order in the Mobile Layout, as
needed.

Animations that you have targeted to a frame included in the Mobile Layout will run on your
smartphone.

Controls

To maximize the capabilities of a touch screen, single-select and multi-select controls both
become listbox jQuery mobile controls, with one allowing single-select and the other
multiselect.
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Note: jQuery mobile controls do not display when you design your HTML page using the Mobile
Layout, but will display when the page is viewed on a smartphone.

Other Objects

Some objects that you add to the HTML canvas are not automatically promoted to pages in the
Mobile Layout. This is true for text boxes and images.

Objects that are not automatically promoted to pages appear below a horizontal line that
underlines the page preview. You can drag objects above the line onto pages, as needed.
Objects that remain below the line, and any animations targeted to them, will not appear when
you view the pages on your smartphone.

Note: The size of an object that you drag into a page is accurately previewed in the page, so
you can determine if the object needs to be resized. If so, you must resize it in the HTML
canvas.

When you drag an object from below the horizontal line onto a page, the system recognizes
this as a manual modification to the Mobile Layout. This triggers a message: Manual
modification of mobile layout will stop default generation of the pages. It will be your
responsibility to maintain it.

Accepting this means that changes to the underlying data will not flow automatically to the
mobile pages. You must open the HTML file, right-click the canvas, and select Update Layout.

To take advantage of the default generation of the mobile pages, it is recommended that you
avoid making manual modifications.

Note: You can undo manual modification of the Mobile Layout by right-clicking the canvas and
clicking Reset mobile to default. This restores automatic update of the HTML pages, and
removes any manual modifications.

A page in Mobile Layout appears as shown in the following image. In this example, the page
content displays in a frame, which is scrollable when you view it on a smartphone. Below the
frame is the navigation area.
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Styling for the components of the Mobile Layout is controlled by the cascading style sheet. For
more information, see Cascading Style Sheet Class Mapping List for Mobile Components on
page 673.

The Navigation Area

The following image displays the navigation area that appears below the page content.
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The icons in our example indicate that there is a home page, which is represented by the
house icon, and two additional pages, which are represented by two square icons. In addition,
there is a page combination tool, which is represented by a tile icon.

The default home page appears first in the page order. You can change the home page as
needed.

You can use the square icons  and the house icon  to navigate between the pages.

You can use the tile icon  to vertically combine objects in a page, in cases where there is
more than one object on a page. Toggle the tile icon to change vertical combinations.

Adding/Removing Pages

The following list describes the shortcut menu options on the Mobile Layout canvas, which you
can use to add and remove pages.

Show all pages. Displays all pages on the Mobile Layout canvas. Both the Basic and
Advanced Mobile Layouts show one page, by default.

Add empty page. Adds an empty page to the Mobile Layout canvas. You can then drag
content into the page.

Remove empty page. Deletes any empty pages on the Mobile Layout canvas.

Remove selected page. Deletes a page that has content. The system recognizes this as a
manual modification to the Mobile Layout. This triggers a message: Manual modification of
mobile layout will stop default generation of the pages. It will be your responsibility to
maintain it.

Accepting this means that changes to the underlying data will not flow automatically to the
mobile pages. You must open the HTML file, right-click the HTML canvas, and select Update
Layout.

Reset mobile to default. Restores automatic update of the HTML pages, and removes any
manual modifications.

Note: When you delete content from the HTML canvas, you must also manually delete it from
the Mobile Layout. Deleting content from the Mobile Layout that was previously deleted from
the HTML canvas is not interpreted as a manual modification, and will preserve the default
generation of the pages.

Moving Content Between Pages

You can change the order of the pages or display more than one object on a page.
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To display more than one object on a page horizontally, click the object in one screen and drag
it to another.

To display more than one object on a page vertically, use the tile icon . Toggle the tile icon
to remove vertical combinations.

To move a control or an object that appears below the horizontal line, drag the object to the
desired page. The system recognizes this as a manual modification to the Mobile Layout. This
triggers a message: Manual modification of mobile layout will stop default generation of the
pages. It will be your responsibility to maintain it.

Accepting this means that changes to the underlying data will not flow automatically to the
mobile pages. You must open the HTML file, right-click the HTML canvas, and select Update
Layout.

Note: You can undo manual modification of the Mobile Layout by right-clicking the canvas and
clicking Reset mobile to default. This restores automatic update of the HTML pages, and
removes any manual modifications.

To take advantage of the default generation of the pages, it is recommended that you avoid
making manual modifications.

Enabling Mobile Layout in an HTML File

An HTML file is designated for mobile output when the Enable mobile property is set to Yes.
This designation enables a Mobile Layout option, where you can edit and preview your mobile
output.

Note: An HTML file that has Mobile Layout enabled can additionally be viewed on a desktop or
tablet. In these cases, page design is derived from the HTML canvas and the page design on
the Mobile Layout is ignored. This eliminates the need to maintain different copies of the same
pages for different output.

You can enable mobile output for an existing HTML file, or create a new file with mobile output
enabled.

Procedure: How to Enable Mobile Output for an Existing HTML File

1. Open the HTML file.

The HTML canvas opens.

2. Open the Properties panel.

3. Change the Mobile property from No to Yes.
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The HTML canvas shortcut menu now includes mobile output options.

Procedure: How to Create a New File With Mobile Output Enabled

1. On the Home tab, in the Content group, click HTML/Document. You can also create a new
HTML file from the Application menu or by using the shortcut menu in the Environments
tree panel, for a folder that supports content creation.

The HTML/Document Wizard opens.

2. Navigate to where you want to create your HTML page and click Next.

The Themes and Settings window of the HTML/Document Wizard opens.

3. Select the Mobile design check box.

Selecting this option automatically sets the Mobile property to Yes in the Properties panel.

4. Click Finish.

The HTML canvas opens. The canvas shortcut menu now includes mobile output options.

Working With the Basic and Advanced Mobile Layouts

There are two different layouts for designing HTML output for smartphones, Basic and
Advanced.

Basic Mobile Layout. Enables you to build simple smartphone pages that you can navigate
using graphical icons and page-swipe. The Basic Mobile Layout displays individual frames
from your HTML canvas on individual mobile pages, by default. You can change this as
needed. 

Advanced Mobile Layout. Offers the same features as the Basic, but also gives you the
additional ability to add a table of contents with or without a logo, and add a logo on each
page. 

In the Advanced Mobile Layout, all frames from your HTML canvas appear together on a single
mobile page, by default. You can change this as needed.

Having selected one layout, you may choose to switch to the other, if needed. For more
information, see How to Change Between Basic and Advanced Mobile Layouts on page 668.

Procedure: How to Use the Basic Mobile Layout

You can work with the Basic Mobile Layout when you have saved content in the HTML canvas
and when you have set the Enable mobile property to Yes.

1. Right-click the HTML canvas and click Show Mobile Layout (basic).

The Basic Mobile Layout is displayed.

Designing Content for Smartphones

666  Information Builders



Styling for the components of the Mobile Layout is controlled by the cascading style sheet.
For more information, see Cascading Style Sheet Class Mapping List for Mobile Components
on page 673.

2. Edit the mobile content in the following ways:

To preview all pages, right-click the Mobile Layout canvas and click Show all pages.
This displays all pages side-by-side.

A horizontal line appears below the navigation area. Any objects that appear below the
line come from the HTML canvas, but were not automatically added to the Mobile
Layout.

To add objects to the Mobile Layout, drag them from the area below the line to the
desired place in the layout.

The system recognizes this as a manual modification to the Mobile Layout. This
triggers a message: Manual modification of mobile layout will stop default generation
of the pages. It will be your responsibility to maintain it.

Accepting this means that changes to the underlying data will not flow automatically to
the mobile pages. You must open the HTML file, right-click the HTML canvas, and
select Update Layout.

Note: You can undo manual modification of the Mobile Layout by right-clicking the
canvas and clicking Reset mobile to default. This restores automatic update of the
HTML pages, and removes any manual modifications.

To take advantage of the default generation of the pages, it is recommended that you
avoid making manual modifications.

To combine pages horizontally, drag one page to another.

To change the home page, select the desired page, right-click the Mobile Layout
canvas, and click Set current page as home page.

Additionally, you can drag a page to the home page screen. If necessary, drag the old
page to a different screen.

Note: When you change the page order by manually dragging in the Mobile Layout, it
overrides the page order specified in the Tasks & Animations panel.

If there are any empty pages in your preview, right-click the canvas and click Remove
empty pages.

3. Save the HTML file.
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You can now view the HTML file on a smartphone. The layout is derived from the Mobile
Layout. For more information, see Viewing Mobile Output on a Smartphone on page 672.

Additionally, you can view the HTML file on a desktop or tablet. The layout is derived from
the HTML canvas.

Procedure: How to Change Between Basic and Advanced Mobile Layouts

To change between Basic and Advanced Mobile Layouts:

1. Right-click the existing Mobile Layout canvas and click Reset mobile to default.

This restores the Mobile Layout to its original state.

2. Right-click the existing Mobile Layout canvas and click Back to desktop.

The HTML canvas opens.

3. Right-click the HTML canvas and click the new layout, Show Mobile Layout (basic) or Show
Mobile Layout (advanced).

Procedure: How to Create a Table of Contents for Mobile Output

With the Advanced Mobile Layout, you can include a table of contents page to help users
navigate quickly. This may be useful when your mobile output contains a large number of
pages.

To design output for smartphones that includes a table of contents:

1. Create an HTML page.

2. Right-click the HTML canvas and click Show mobile layout (advanced).

The Mobile Layout opens and displays the table of contents preview, as shown in the
following image.
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The Mobile Layout default display shows a single page, which previews the appearance of
the table of contents in a smartphone format.

In our example, this rectangle contains the title HtmlPage.

Styling for the components of the Mobile Layout is controlled by the cascading style sheet.
For more information, see Cascading Style Sheet Class Mapping List for Mobile Components
on page 673.

3. Edit your layout in the following ways:

To change the title, use the drop-down at the top of the Properties panel and select
table_of_contents. In the Title field, type the new title.

The new title now appears in the table of contents preview.
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You can choose to show or to hide the table of contents on a smartphone. The default
is to show it.

To hide the table of contents on a smartphone, select No from the Show at run time
property field.

In the preview, the rectangles for each page represent hyperlinks in the table of
contents, which open the selected page. In our example, there are hyperlinks for the
task2 and load page titles.

To change page titles, select the Title property field for a specified page and type the
desired title.

The new titles appear at the top of the page and on the table of contents.

4. Save the HTML file.

You can now view the HTML file with a table of contents on a smartphone. For more
information, see Viewing Mobile Output on a Smartphone on page 672.

Procedure: How to Add a Logo to a Mobile Table of Contents

You can add a logo to the table of contents page of your mobile layout.

1. Open the Advanced Mobile Layout of an HTML file that has a table of contents.

The logo placeholder is indicated by the cursor in the following image.

2. In the drop-down at the top of the Properties panel, click table_of_contents.

The table of contents properties display.

3. In the Logo field, click the ellipsis button.

The Open File dialog box appears.

4. Select the desired logo file and click OK.

The logo now appears in the table of contents preview.
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Note: The logo placeholder box provides an accurate preview of the way the logo will
appear on a smartphone. It will indicate if the graphic file you selected needs to be
resized.

5. Save the HTML file.

You can now view the HTML file with a table of contents on a smartphone. For more
information, see Viewing Mobile Output on a Smartphone on page 672.

Procedure: How to Add a Logo to Each Page of the Contents

You can add a logo to each page of the table of the contents in your mobile layout.

1. Open the Advanced Mobile Layout of an HTML file that has a table of contents.

2. Open a page, other than the table of contents page.

The small square near the top left of the page, indicated by the cursor in the following
image, is a placeholder for a logo.

3. In the drop-down at the top of the Properties panel, click table_of_contents.

The table of contents properties fields display.

4. In the All swipes logo field, click the ellipsis button.

The Open File dialog box appears.

5. Select the desired logo file and click OK.

The logo now appears on each page of the preview.

Note: The logo placeholder for the individual pages is a small box. It provides an accurate
preview of the way the logo will appear on a smartphone, and indicates whether the
graphic file that you selected needs to be resized.

6. Save the HTML file.

You can now view the HTML file with a table of contents on a smartphone. For more
information, see Viewing Mobile Output on a Smartphone on page 672.
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Viewing Mobile Output on a Smartphone

There are multiple ways that mobile output from App Studio can be viewed on a smartphone,
depending upon the configuration of your environment. These include: 

Data Servers

Mobile Favorites

The Mobile Faves App

These ways are outlined in the following section.

Note: Check with your system administrator for your best practice in viewing mobile output.

Data Servers - APPROOT

During installation, App Studio and WebFOCUS set certain variables that affect the
implementation. Your system administrator has the option of changing the values for these
variables to meet site-specific needs. Most sites use the default values supplied during
installation.

You can optionally specify the path in which files will reside on the web server and the
WebFOCUS Reporting Server. The path is defined by the APPROOT variable, which you can set
in two different files, one for the web server and one for the Reporting Server.

In App Studio, the Applications/baseapp folder typically resides on the APPROOT server. To
view mobile output through Data Services:

1. Copy the mobile-enabled HTML file to the baseapp folder.

2. Open the baseapp copy of the file and run it.

A browser window opens showing the HTML content.

3. Copy the resulting URL from the browser, and email it to an account that is available on
your smartphone.

4. Click the URL in your email.

The output opens in a browser, as designed in the Mobile Layout that you selected.

Note: Check with your system administrator if you need assistance viewing mobile output
on your smartphone through Data Servers - APPROOT.

Mobile Favorites

Mobile Favorites are HTML files, reports, graphs, hyperlinks, and other item types residing in
the Domains area, that you can add to the Mobile Favorites list in the BI Portal. Adding items
to the Mobile Favorites list enables you to display them on mobile devices. For more
information, refer to the Business Intelligence Portal manual.
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Note: Content residing on your local folder is not accessible through Mobile Favorites. It must
reside in the Domains area of App Studio.

Mobile Faves App

The Mobile Faves app is automatically set up to obtain content from a server on the Internet,
where you can view sample business content. You can add your own WebFOCUS servers to the
list, including those that contain the HTML files that are enabled for mobile output. You will
see a list of available folders saved to the selected server connection. These folders contain
all of the content previously selected as Mobile Favorites from your WebFOCUS portal.

iPhone or Android users can download the free Mobile Faves app from the App Store or the
Google Play Store. For more information, refer to the Mobile Faves for Android User’s Manual or
the Mobile Faves for iOS User’s Manual.

Cascading Style Sheet Class Mapping List for Mobile Components

This section contains a list of IBI classes that are used to style various components and
controls for Mobile design.

Components/Controls Classes Used

Smartphone container border color .IBI_SmartPhoneContainer {
    border-color:#4C5E76;
}

Control panel border color .IBI_MobileControlPanel {
    border-top-color: #4C5E76;
}

Control panel font .IBI_MobileControlPanel {
    font-size:small;
    color: green;
}

Page content font .IBI_MobilepageContent {
    font-size: large;
    color: Red;
}

TOC content font .IBI_MobileTocContent {    
    font-size: large;
    color: Blue;
}
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Components/Controls Classes Used

Label font .IBI_MobileLabel {
    font-size: large;
    color: Azure;
}

HTML title .IBI_MobileTocTitle {
    font-size: x-large;
    color: BlueViolet;
}

Task name in TOC .IBI_MobileTocItem {
    font-size: x-large;
    color: ForestGreen;
}

Control panel text .IBI_MobileSwipeHeaderText {
     font-size: small;
    color: Crimson;
}

Cascading Style Sheet Support Matrix for Internet Explorer

The following table is a list of all Cascading Style Sheet (CSS) properties and whether they are
supported in Internet Explorer 9 and Internet Explorer 10.

CSS Property Internet Explorer 9 Internet Explorer 10

Borders

border-radius Supported Supported

box-shadow Supported Supported

border-image Not Supported Not Supported

Background

background-size Supported Supported

background-origin Supported Supported

Animations
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CSS Property Internet Explorer 9 Internet Explorer 10

keyframes Not Supported Supported

animation Not Supported Supported

animation-name Not Supported Supported

animation-duration Not Supported Supported

animation-timing-function Not Supported Supported

animation-delay Not Supported Supported

animation-iteration-count Not Supported Supported

animation-direction Not Supported Supported

animation-play-state Not Supported Supported

Text

text-shadow Not Supported Supported

word-wrap Supported Supported

text-overflow Supported Supported

word-break Supported Supported

text-justify Not Supported Supported

2D and 3D Transforms

transform ms-transform - only 2D Supported - 2D and 3D

transform-origin ms-transform - only 2D Supported - 2D and 3D

transform-style Not Supported Supported

perspective Not Supported Supported

perspective-origin Not Supported Supported

backface-visibility Not Supported Supported
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CSS Property Internet Explorer 9 Internet Explorer 10

Fonts

font-feature-settings Not Supported Supported

hyphens Not Supported ms-hyphens

hyphenate-limit-zone Not Supported ms-hyphenate-limit-zone

hyphenate-limit-chars Not Supported ms-hyphenate-limit-chars

hyphenate-limit-lines Not Supported ms-hyphenate-limit-lines

Multi Column Layout

columns Not Supported Supported

column-count Not Supported Supported

column-gap Not Supported Supported

column-rule Not Supported Supported

column-rule-color Not Supported Supported

column-rule-style Not Supported Supported

column-rule-width Not Supported Supported

column-span Not Supported Supported

column-width Not Supported Supported

column-fill Not Supported Supported

break-after Not Supported Supported

break-before Not Supported Supported

break-inside Not Supported Supported

Transitions

transition Not Supported Supported
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CSS Property Internet Explorer 9 Internet Explorer 10

transition-property Not Supported Supported

transition-duration Not Supported Supported

transition-timing-function Not Supported Supported

transition-delay Not Supported Supported

User Interface

resize Not Supported Not Supported

border-box Not Supported Not Supported

outline-offset Not Supported Not Supported

appearance Not Supported Not Supported

Gradients

linear-gradient Not Supported Supported - ms-linear-
gradient

radial-gradient Not Supported Supported - ms-radial-
gradient

repeating-linear-gradient Not Supported Supported - ms-repeating-
linear-gradient

repeating-radial-gradient Not Supported Supported - ms-repeating-
radial-gradient

Cascading Style Sheet Class Mapping List

This section contains a list of IBI classes that are used to style various components and
controls.
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Components/Controls Classes Used

Body IBI_PageBg

Report IBI_Report-iFrame; IBI_rounded_m

Chart IBI_Report-iFrame; IBI_rounded_m

Hyperlink IBI_LinkItem

Button IBI_button

Reset IBI_button

Label IBI_ReportControlLabel

Form IBI_ReportControlPanel; IBI_rounded_m

Submit Button IBI_button; IBI_btn-run

Reset Button IBI_button; IBI_btn-reset

Save Selection Button IBI_btn-saveselection

Defer Button IBI_btn-defer

Schedule Button IBI_btn-schedule

Panel IBI_Panel; IBI_rounded_m

Map IBI_ReportControlTarget

Frame IBI_rounded_m

Edit box IBI_ReportControlTarget; IBI_rounded_s

Drop down IBI_ReportControlTarget; IBI_rounded_s

List Box IBI_ReportControlTarget; IBI_rounded_s

Double List IBI_ReportControlTarget, IBI_btn-up, IBI_btn-down,
IBI_btn-left, IBI_btn-right

Radio Button IBI_ReportControlTarget; IBI_Radio

Check Box IBI_ReportControlTarget; IBI_CheckBox
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Components/Controls Classes Used

Text Area IBI_rounded_m

Single Source Tree IBI_ReportControlTarget

Multi Source Tree IBI_ReportControlTarget

Horizontal Slider IBI_ReportControlTarget; IBI_rounded_s;
IBI_SliderInput; IBI_buttonSliderNav; IBI_btn-left;
IBI_btn-right; IBI_SliderTrack; IBI_SliderHandle

Vertical Slider IBI_ReportControlTarget; IBI_rounded_s;
IBI_SliderInput; IBI_buttonSliderNav;
IBI_buttonSliderNavVert; IBI_btn-up; IBI_btn-down;
IBI_SliderTrack; IBI_SliderTrackVert;
IBI_SliderHandle; IBI_SliderHandleVert

Info Window IBI_InfoWnd; IBI_InfoWndTitleBar; IBI_InfoWndFrame

Tab IBI_MultiContentPlugin

Tab Header IBI_pageHeader

TabHeader - Top Tab IBI_pageHeaderTab_TopBottom

TabHeader - Bottom Tab IBI_pageHeaderTab_Bottom

TabHeader - Left Tab IBI_pageHeaderTab_Left

TabHeader - Right Tab IBI_pageHeaderTab_Right

Tab Selected IBI_pageHeader_Selected

Vertical Tab/Accordion/Window
header

IBI_pageHeader_Vertical

Vertical Tab/Accordion/Window
Selected

IBI_pageHeaderVertical_Selected

Tab Heading Text IBI_pageHeaderText

Tab Heading Text - Left Tab IBI_textVerticalTopToBottom
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Components/Controls Classes Used

Tab Heading Text - Right Tab IBI_textVerticalBottomToTop

Tab/Window/Accordion Content IBI_pageContent

Tab/Window/Accordion Content -
Top

IBI_pageContentTab_Top

Tab/Window/Accordion Content -
Bottom

IBI_pageContentTab_Bottom

Tab/Window/Accordion Content -
Left

IBI_pageContentTab_Left

Tab/Window/Accordion Content -
Right

IBI_pageContentTab_Right

Tab/Accordion/Window Min/Max
box

IBI_windowNavBox

Tab/Accordion/Window images IBI_windowMaxRestore; IBI_windowMaximize;
IBI_windowMinimize; IBI_windowTiles;
IBI_windowFlipRight; IBI_windowFlipLeft

Mobile components

Smartphone container border color IBI_SmartPhoneContainer

Control panel IBI_MobileControlPanel

Page content IBI_MobilepageContent

TOC content IBI_MobileTocContent

Label IBI_MobileLabel

TOC title IBI_MobileTocTitle

TOC task name IBI_MobileTocItem

Control panel text IBI_MobileSwipeHeaderText
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Chapter8
Creating Documents

A document is a series of pages that can contains reports, images, charts, and other
information. A document is typically output as a PDF, or a Microsoft Excel or PowerPoint
file.

In App Studio, you can create and edit documents using the Document canvas. When you
create a new document, you use the HTML/Document Wizard.

This topic describes how to launch the HTML/Document Wizard to create documents. It
also identifies and explains the tabs and panels that are available when you are
developing documents in the Document canvas.

In this chapter:

Launching the HTML/Document Wizard

Accessing Document and Active Dashboard Components

Previewing the Document Canvas

Editing Document Canvas Properties

Supporting Template Masters and Slide Layouts in App Studio-Generated Presentations

Launching the HTML/Document Wizard

The HTML/Document Wizard allows you to create a new HTML Page, Guided Report Page, or
Document, and open a recent procedure. This section details how to create an HTML page
using the HTML/Document Wizard. 

To open the HTML/Document Wizard:

On the Home tab, in the Content group, click HTML/Document.

In the Environments Tree panel, right-click an application folder, point to New, and click
HTML/Document.

Note: If you choose to create a new HTML page or Document using the shortcut menu in
the Environments Tree panel, your wizard will not include a Navigator panel since the
location of your HTML page or Document is already selected.

WebFOCUS App Studio User’s Manual  681



The HTML/Document Wizard opens, as shown in the following image.

From the HTML/Document Wizard, you can open a recent procedure or create a new one.

Procedure: How to Create a Document Using the HTML/Document Wizard

Use the HTML/Document Wizard to create a FOCUS executable (.fex) document, as detailed
below. After you have launched the HTML/Document Wizard: 

1. In the File Type area, select Document.

2. Navigate to where you want to create the new procedure or select a recent procedure.

Note: If you used the shortcut menu in the Environments Tree panel to create your
document, a location is already selected.

3. Optionally, click Next to set the Document Properties. For more information, see How to
Select Document Output Format Using the HTML/Document Wizard on page 683.

4. Click Finish.

Note: The Finish button is unavailable until you select a valid path.

The Document canvas and Properties panel open. You can now add data to your document
and format the data using the tabs in the ribbon.

5. Click the page layout to add objects to the page.

6. To save your document, click the Save button on the Quick Access Toolbar, or select Save
from the Application menu.
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The document is saved with a .fex extension.

7. To run your Active Document, click Run on the Quick Access Toolbar, or click Run from the
Application menu.

Procedure: How to Select Document Output Format Using the HTML/Document Wizard

Use the HTML/Document Wizard to create a document that you can output in various formats. 

After you choose an output format, the program associated with that format opens when you
click the Run button on the Quick Access Toolbar. For example, if you select one of the
PowerPoint options (PPTX or PPT), PowerPoint opens to preview your document when you click
Run.

In the HTML/Document Wizard:

1. In the File Type area, select Document.

2. Navigate to where you want to create the new procedure or select a recent procedure.

Note: If you used the shortcut menu in the Environments Tree panel to create your
document, a location is already selected.

3. Click Next.

The Document Properties dialog box opens.

4. Use the Output Format list to choose one of the following output formats:

PDF

DHTML

PowerPoint (PPTX or PPT)

active report

Excel (XLXS or XLS)

Excel Formula (XLXS or XLS)

active PDF

User (to display a run time prompt for selecting the output format)

5. In the Coordinate Report list, select On if you want all reports and graphs that contain a
common sort field to be burst into separate page layouts. Each value for the first sort field
displays on a separate page.

Additionally, in this area, you can specify page size, page orientation, and units of
measure.
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To add additional pages, select Add Table of Contents and/or Add Master Page.

6. Click Finish.

The Document canvas opens.

7. Build your document in the Document canvas.

8. To view it in the selected output format, click Run on the Quick Access Toolbar, or click
Run from the Application menu.

Accessing Document and Active Dashboard Components

The following topics describe the tabs and panels that are available when you create a
document or active dashboard in the Document canvas.

Inserting Components and Controls in a Document or Active Dashboard Using the Insert Tab

You can insert components and controls in a document or active dashboard. The Insert tab
contains the Components, Controls, and Pages groups, as shown in the following image.

Inserting Components in a Document or Active Dashboard Using the Components
Group

You can insert a report, chart, image, text, or line component in a document or active
dashboard. The Components group is shown in the following image. 

The components are:

Report

Inserts a report object. You can add reports to the Document canvas that appear when you
run the layout. You can either embed or reference reports. Double-clicking a blank report
object opens the Report canvas, where you can create and style a report to be used on the
Document canvas.
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You can also include parameters in a report. The values of the parameters can be
assigned with controls that are added on the Document canvas.

Chart

Inserts a chart object. You can add charts to the Document canvas that appear when you
run the layout. You can either embed or reference charts. Double-clicking a blank chart
object opens the Chart canvas, where you can create and style a chart to be used on the
Document canvas.

Note:

HTML5 charts contain syntax that is currently not supported on the Document canvas,
unless the output format is active PDF or active report.

In the Domains area, when you reference or import an existing chart procedure, the
Open File dialog box will only show charts that contain an output format of active PDF or
active report.

In the Data Servers or Projects (optional) area, when you reference or import an existing
chart procedure, selecting an output format other than active PDF or active report may
result in a not enough data to draw chart message.

Image

Inserts an image. You can add an image, such as a company logo, to the layout.

You can insert an image into your document and add a hyperlink to it. After you run your
document, and click the image, you can launch a URL, or run a report.

Note: An inserted image must be referenced from a specific directory location.

Text

Inserts a text box. You can add text, such as headings, to your webpage. You can add
directions or explanations for your reports and charts.

Line

Inserts a line. You can add a horizontal or vertical line to distinguish between sections of
your launch or display page.
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Procedure: How to Format Text in a Document

You may apply various formatting and style options to words and individual text characters
within the text object. 

Note: Any formatting and styling that you may have applied to individual text strings within the
text object will remain unchanged.

1. On the Insert tab, in the Components group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Highlight the text that you wish to format.

4. Right-click the text, point to Style, and then click Font.

The Font dialog box opens.

Note: You can also access font formatting options in the Properties panel.

5. Select from the formatting options available. You can change the type, style, color, size,
and effect of the font.

6. Click OK to close the Font dialog box.

The formatting options that you selected applied to the text.

Procedure: How to Insert a Bulleted List or Numbered List Into a Text Element

To insert a bulleted list or numbered list into a text object: 

1. On the Insert tab, in the Components group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Add multiple lines of text to the text object.

4. Highlight and right-click the text that you want to include in the list.

5. In the shortcut menu, select one of the following list options:

Bullets

Disc

Circle
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Square

Numbering

Numbers

Lowercase Letters

Uppercase Letters

Small Roman numerals

Large Roman numerals

Note:

Alternatively, you can select a bullet type before typing text to begin the list. Pressing
enter will begin the next item in the list on a separate line.

To change the bullet or number list type of an existing list, place your pointer on the list
level you want to change and reselect a bullet or number list type. Selecting None will
remove the bullets or numbers for that level and move any nested lists up one level. In
order to switch between bullets and numbers, you must first remove the current list
option by selecting None and then applying the list option you want.

Procedure: How to Insert Nested Lists Into a Text Element

To insert a nested list into the text object:

1. On the Insert tab, in the Components group, click Text.

The pointer changes to a crosshair.

2. Drag your pointer across the canvas to create a text object.

A text object with the default text, Enter text, is created.

3. Add a list to the text object. For more information, see How to Insert a Bulleted List or
Numbered List Into a Text Element on page 686.

4. Place your pointer after a list item.

5. Right-click, point to Nested List and then select a bulleted or numbered list option.

A list is started within the current list, allowing you to enter text on that list level.
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Note: Pressing tab while your pointer is on the same line as a list item will move that item
one level down, resulting in a nested list. The bullet or number type selected is the next
list type in the right-click shortcut menu. For example, if you have a bulleted list that uses
the disc bullet type, pressing tab to move an item down one level will cause that nested
list to have the circle bullet type.

You can continue to nest lists within other lists by using the same steps shown above.

Note: You cannot skip a list level. For example, in order to insert a nested bulleted list or
nested numbered list on a lower level, there must be a list one level up from it.

Inserting Controls in an Active Dashboard Using the Controls Group

You can insert an edit box, drop-down list, list box, radio button, or check box control in an
active dashboard. The Controls group is shown in the following image. 

The controls are:

Edit Box

Inserts a text box. You can enter a value in the text box.

Drop Down

Inserts a drop-down list. A drop-down list enables you to select single or multiple values
from a list of supplied values. In order to provide multiple values, the procedure must be
set up to accept multiple values.

From a single-select list, you can select only one value each time a request is run.

From a multi-select list, you can select multiple values at once using the check boxes
adjacent to the values.

You can use a dynamic or static list of values for the drop-down list.

List Box

Inserts a list. You can select single or multiple values at one time from a list box:

From a single-select list, you can select only one value for each time a request is run.
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From a multi-select list, you can select multiple values all at once by holding down the
Ctrl key as you select values.

In order to provide multiple values, the procedure must be set up to accept multiple
values.

List box values can be dynamic or static.

Radio Button

Inserts a radio button. Using a radio button, you can only select a single value from a list
of supplied values. Radio button values can be static or dynamic.

Check Box

Inserts a check box into an active report or active PDF file. You can select multiple values
from multiple check boxes.

Adding Pages to a Document or Active Dashboard Using the Pages Group

You can add a new or existing page, or a Table of Contents, Page Master, or size and overflow
page in a document or active dashboard. The Pages group is shown in the following image. 

The commands are:

New

Inserts a new page to the Page Layout canvas. The new page appears below the current
page and is named Page layout n, where n is a number that increments by 1.

Note:

You can also right-click the Page Layout canvas and select Insert new page after or
Insert new page before to indicate where to include the new page.

To delete a page, select the page in the Page Layout canvas and press the Delete key
on the keyboard.

Existing

Inserts an existing page. This page can contain images, drawing objects, text, page
settings, reports, and charts.
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To insert an existing page into your document, it must be saved as a procedure and exist
somewhere in the WebFOCUS environment.

Note:

You can also right-click the Page Layout canvas and select Insert existing page after or
Insert existing page before to indicate where to include the existing page.

To delete a page, select the page in the Page Layout canvas and press the Delete key
on the keyboard.

Table of Contents

You can generate a Table of Contents page that shows a summary of the contents of the
document, along with page numbers, and that can be printed with the document.

The entries can link to any component of the compound output (page, report, or graph) and
vertical sort field values (BY field values) within each component report. The entries in the
Table of Contents enable you to easily navigate to a particular section while viewing the
document online.

When creating a compound layout report or a coordinated compound report, you can
enable bookmarks available in Adobe® Acrobat® for PDF formatted reports. Bookmarking
uses the Table of Contents descriptions, and the Table of Contents page and levels, to
show specific reference points in the compound document.

Note: You cannot add a report, chart, image, text, or line object to the Table of Contents
page. These commands are disabled when the Table of Contents is selected.

Master

Inserts a Page Master. A Page Master is a page that can be added in the Design View
where you can add and edit repeating elements, such as the company logo, or page
numbers. Any element placed on the Page Master repeats on every page in the resulting
report.

Note: You cannot add a report or chart to the Page Master. These options are disabled
when the Page Master is selected.

Overflow

Sets the size and overflow of a report object at run time.

You can control the overflow and relative (vertical) positioning of reports and graphs in
coordinated compound documents so that reports fill the entire page, as well as maintain
their relative position in the document.
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Overflow is defined as the area of a report that exceeds its defined space in the page
layout. For example, a multi-page report and a graph can both be added to a single page
layout with the graph positioned beneath the report.

The report can flow or fill the page and the graph can be relatively positioned to the report,
so it is placed at the end of the document following the complete rendering of the report.

Overflow and positioning options are available from the Properties window and from the
Positioning toolbar.

Add Dashboard Bar

Inserts a Dashboard Bar into an active dashboard. A Dashboard Bar is an additional page
layout where you can insert controls, reports, and charts that display above the dashboard
tabs.

The Dashboard Bar is only available for the active report formatted documents. A
Dashboard Bar can be a maximum of one page.

You can insert a Dashboard Bar into active PDF formatted documents. However, if you run
these documents, an empty page is returned.

Procedure: How to Create a Table of Contents Page

1. Create a new document, or open an existing document. 

2. From the Insert tab, in the Pages group, click Table of Contents.

The Table of Contents page appears in the document.

Table of Contents is the default title for the page. To edit the title, select the current title
and type your new title.

To style the title, select the text, right-click it, and in the shortcut menu that opens, point
to Style, and select from among the following options: Bold, Italic, Underline, or
Superscript.

In addition, you can select Font to open the Font dialog box, where you can set the font,
font style, font size, font color, and font effects.

Note: The text does not wrap and must fit within the width of the overall text element.

3. Click Run to load your document.

The Table of Contents appears as the first page in your output.

4. Click a hypertext link on the Table of Contents page to jump to that section within the
document.
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Procedure: How to Control Which Objects Appear in the Table of Contents

Note: The objects that appear in the Table of Contents depend on whether the document is
coordinated or uncoordinated. By default, all report, chart, and page layout objects appear in
the Table of Contents for uncoordinated documents.

To control which objects appear in the Table of Contents:

1. Select a report, chart, or page layout object.

Each object has a TOC description, TOC level option, and TOC Number of sort levels in the
Properties panel.

2. To change the name of the description for the object, type over the TOC description in the
Properties panel.

This description appears in the Table of Contents at run time.

3. To change the hierarchical order of how the object appears in the Table of Contents, type
a TOC level.

For example:

0 = the object is not shown in the Table of Contents.

1 = the object is shown as a first level item in the Table of Contents.

2 = the object is shown as a second level item in the Table of Contents.

Follow this sequence for additional levels.

These levels appear in the Table of Contents at run time.

4. To change the number of vertical sort fields (TOC levels) that appear in the Table of
Contents for the component, use the up or down arrow to adjust TOC Number of sort levels
in the Properties panel. If the value designated is greater than the count of BY fields in the
component report, then the value defaults to the total count of available BY fields.

Note: Coordinated reports do not support TOC Number of sort levels within a compound
TOC. Those entries are ignored for coordinated reports.

5. Run the procedure to see the updated TOC description and TOC levels.

Procedure: How to Use Bookmarks

1. Create a compound layout that is made up of multiple reports and/or charts.

2. Use the Properties panel to select each report/chart, and enter a bookmark (Table of
Contents) description, or use the default selections.
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Note: The Table of Contents page might or might not be included in the compound
document, however, the descriptions and levels that appear as bookmarks are set through
these options.

3. In the Properties panel, from the Properties list, select Compound document.

4. From the Bookmarking drop-down list, select On.

Note: Bookmarking is off by default.

5. Click Run to load your document.

The bookmark tab is expanded in the PDF output.

6. Click a bookmark link to jump to that section within the document.

Note: You can use the shortcut menu to change the bookmark properties.

Procedure: How to Create a Page Master

1. Create a new document, or open an existing document. 

The document opens on the Document canvas.

2. From the Insert tab, in the Pages group, click Master.

The Page Master is added to the document.

3. Add components (text, images, lines) and set their properties on the Page Master.

Note: Only text, images, and lines can be added to the Page Master.

4. Click Save to save your new Page Master or to save your changes to an existing Page
Master.

Procedure: How to Use an Existing Page Master in Another Document

1. Create a new document, or open an existing document.

2. From the Insert menu, in the Pages group, click Existing.

The Open dialog box opens.

3. Select the procedure file (.fex) that contains the Page Master.

4. Click OK.

If a Page Master has already been added to the document, a message appears stating
that a Page Master already exists in the current layout. You can respond in one of the
following ways:

Click Yes to replace the existing Page Master with the new one.

8. Creating Documents

WebFOCUS App Studio User’s Manual  693



Click No to merge the two Page Masters.

Click Cancel to use the existing Page Master, instead of the Page Master from the
Page Layout template.

5. Save the document.

Procedure: How to Customize the Overflow for a Fixed Report

1. Select an object from the Design View.

The Properties panel shows the available properties for the selected object.

2. Select Fixed from the Size and Overflow drop-down list.

Note: Fixed is the default selection. If Not Set is selected, Fixed is used as the default.

3. Right-click the fixed report in the Design View and select Customize Fixed Overflow.

The overflow page is added after the page layout in the Design View, displaying a copy of
the fixed component (with the original size and position) from the page layout. Scroll down
in the Design View until you see the overflow page.

4. Resize the report to fill the page. You can also reposition the report overflow.

5. Run the report.

Note: If the document contains multiple fixed reports, the report output maintains the
same size and position as the report objects on the Document canvas.

Procedure: How to Set the Flowing Report Property

1. Select an object from the Design View.

The Properties panel shows the available properties for the selected object.

2. Click Flowing from the Size and Overflow drop-down list.

Note: Repeat this step for any surrounding report objects to prevent the overlapping of
reports and charts at run time.

Tip: When set to Flowing, flow margins are available for the page layout. These margins
further enable you to adjust the page so that the report fills each page between the flow
margins.

3. Run the document.
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Note:

If the document contains multiple flowing reports, the reports might overlap at run
time. If you want one report to run until completion before the next report begins, you
must set the relationship between the reports.

If the document contains a flowing report and a chart, the chart might overlap the
report at run time. If you want the report to run until completion before the chart
begins, you must set the relationship between the chart and the report.

Procedure: How to Set Flow Margins for the Page Layout

When using Flowing overflow, each page layout has flow margins. Flow margins are set through
the top and bottom margins. Flowing reports utilize flow margins to ensure that all reports fill
the page, or the selected portion of the page, and that the header and footer information is
preserved in the output. 

Note: Flow margins are not available for Fixed overflow.

To set flow margins for the page layout:

1. On the Document canvas, select a page layout from the Design View.

Note: Ensure that the report object is set to Flowing overflow.

2. From the Properties panel, type a value for the flow margin: bottom property.

The flow margin bottom value sets the ending vertical coordinate where a flowing report
ends on each page.

3. From the Properties panel, type a value for the flow margin: top property.

The flow margin top value sets the beginning vertical coordinate where a flowing report
starts on each new page.

Note: When flow margins are changed from the default value, you can see the flow
margins in the Design View of the Document canvas.

4. Adjust the objects in the Design View between the flow margins and run the report.

The report fills each page between the flow margins until it reaches the end.

Procedure: How to Add a New Overflow Page to a Page Layout

Each page layout works independent of any other page layout in the coordinated compound
document. This enables you to add a new header and footer for each individual page layout
and associated overflow pages. The following procedure describes how to add a new overflow
page from the page layout. 
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You can use any of the following methods to create an overflow page.

From a fixed report component in a coordinated compound document.

Select the report component on the page and from the shortcut menu, right-click and select
Customize Fixed Overflow.

The overflow page, displaying a copy of the fixed component (with the original size and
position) from the page layout, is added after the page layout in Design View. This enables
you to move and resize the overflow object and add reports and charts (as header and
footer information) around the overflowing object.

On a page layout with a fixed or flowing report.

From the New Page Layout drop-down list, select Add New Overflow Page.

Click anywhere on the page layout, right-click and, from the shortcut menu, select Add New
Overflow Page.

The overflow page is added after the page layout in the Design View. You can add reports and
charts to the overflow page.

Note: If there is a flowing report component, any flow margins defined on the page layout will
also appear on the overflow page. This enables you to move and resize the flow margins and
add reports and charts (as header and footer information) around the flow margins.

The overflow page is identified as Page layout n, overflow object, where n is the number of the
corresponding page layout.

Procedure: How to Add Header and Footer Information to the Overflow Page

You can add report and chart components on the overflow page as header and footer
information for the overflow data, and position and size the components. You can copy existing
components from the page layout, or add new report and chart components. All components
added to the overflow page are automatically assigned as fixed components on the overflow
page. 

Note: The report and chart components added as headers and footers should not generate
additional overflow.

1. To copy an existing report or chart component from the page layout:

a. Select the component from the original page layout, right-click, and select Copy.

b. Select Page layout n, overflow object from the Properties panel list, or scroll down in
the Design View until you see the overflow page.

The overflow page appears in the layout.
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c. Right-click the current page and click Paste.

The component is copied to the overflow page, maintaining the size and position from the
page layout.

Note: If the component was flowing on the original page layout, it is automatically changed
to a fixed object on the overflow page.

2. To add a new report or chart component to the overflow page:

a. From the Properties panel list, select Page layout n overflow object.

The overflow page appears in the layout.

b. Right-click the current page and select New Report or New Graph.

Note: You can also add these components through the Insert tab.

The pointer changes into a crosshair.

c. Drag the crosshair to create a report object or a chart object, and adjust it to the size
you want.

d. Open, import, or reference report or chart information as usual. This behavior is
identical to adding a report or chart on the page layout.

Note: Keep in mind that these objects are acting as header and footer information, so
they should not generate additional overflow.

3. To edit the report or chart component on the overflow page, double-click the object to open
the associated tool and apply any styling or data changes.

Procedure: How to Insert a Dashboard Bar Into the Layout

1. Create a new active dashboard, or open an existing active dashboard.

The active dashboard opens in Document canvas.

2. From the Insert tab, in the Pages group, click Add Dashboard Bar.

The Dashboard Bar is inserted at the top of the document.

You can insert controls, reports, and charts to appear in the Dashboard Bar above the
dashboard tabs.

Note: Though the Dashboard Bar can be a full page, it is not recommended that you insert
large reports and charts, as this would make the Dashboard Bar appear to be the same
size, or larger, than the dashboard.
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Positioning Multi-Selected Objects in a Document or Active Dashboard Using the Positioning Tab

Positioning options enable you to multi-select objects and position them relative to one
another. The Positioning tab contains the Positioning, Relationships, and Text Alignment
groups, as shown in the following image. 

Positioning Objects in a Document or Active Dashboard Using the Positioning Group

The Positioning group contains the Left, Right, Top, Bottom, Center, Middle, Same Width,
Same Height, Same Size, and Toggles Grid commands, as shown in the following image. 

Left

Aligns the objects to the left. This works in relationship positioning.

Relates an object to the left of another object.

Right

Aligns the objects to the right. This works in relationship positioning.

Relates an object to the right of another object.

Top

Aligns the objects to the top of the highest selected object. This works in relationship
positioning.

Bottom

Aligns the objects to the bottom of the lowest selected object. This works in relationship
positioning.

Center

Aligns the objects to the center of the page. This works in relationship positioning.

Aligns objects at the horizontal center point of the object.
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Middle

Aligns the objects to the middle of the page. This works in relationship positioning.

Aligns objects at the vertical center point of the object.

Same Width

Makes two or more objects the same width.

Same Height

Makes two or more objects the same height.

Same Size

Makes two or more objects the same size.

Toggles Grid

Turns the grid on and off.

Relating Objects on a Page in a Document Using the Relationships Group

The Relationships group contains the Bottom Left, Break, and Show commands. Top Left, Top
Right, and Bottom Right commands are available for HTML pages and Guided Report pages.
The Relationships group is shown in the following image. 

Bottom Left

Relates two or more objects on a page. Two objects must be selected. Relates an object
to the bottom left of another object.

Break

Breaks the relationship between the objects selected.

Show

Shows or hides the relationship between objects.
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Aligning Text in a Document Using the Text Alignment Group

The Text Alignment group contains the Left, Center, Right, and Full Justification commands.
These commands align text within the text box. The Text Alignment group is shown in the
following image. 

Left

Aligns selected text to the left.

Center

Aligns selected text to the center.

Right

Aligns selected text to the right.

Full Justification

Fully justifies the selected text, meaning that the text fills the width of the text box.

Changing Properties of a Document or Active Dashboard Using the Utilities Tab

You can add or remove chaining in an active report, add pre-process or post-process code to a
document or active dashboard, or display or hide the panels associated with a document or
active dashboard. 
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Adding or Chaining Objects in a Document or Active Dashboard Using the Chaining
Group

You can add or remove chaining options. The Chaining group is shown in the following image. 

The commands are:

Add

Chains two or more objects that are selected in the Parameters tab.

Remove

Unchains two or more selected, chained objects in the Parameters tab.

Show Chain order

Shows the order of the chained objects.

Working With the Files Utility Group

You can import and export a page, save a page, and add pre-processing or post-processing
code to a document. The Files Utility group is shown in the following image. 

The commands are:

Save Document As

Saves the document. This command is available only for a document or active dashboard.

Save Page As

Saves the page you are currently on. This command is available only for a document or
active dashboard.
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Pre-process code

Creates code that is used before the document is processed. This command is available
only for a document or active dashboard.

Post-process code

Creates code that is used after the document is processed. This command is available
only for a document or active dashboard.

Refresh All

Refreshes the document.

Procedure: How to Add the Pre-Process Component to a Document

You can create pre-process code that applies to all components added to a document. For
example, if the components in your document all require the joining of two tables, you can
create pre-process code before adding the components. This feature eliminates the need to
create a Join before each component is added to the document. 

In addition, you can create post-process code that runs after all of the components have been
added to a document.

1. Create a new Document.

2. On the Utilities tab, in the Files Utility group, click Pre-process code.

A new canvas and the Procedure View panel open. The new canvas will show the
document name, an underscore, and the words, Pre-process. For example, if you are
applying a pre-process code to Document1, the canvas is titled, Document1_Pre-Process.

3. In the Procedure View panel, right-click the procedure folder, point to New, and click the
name of a procedure component.

4. Create your component, save, and close it.

5. When you are prompted to save the pre-process code changes, click Yes.

Now, you can add components to the document that will use the pre-process code.

Procedure: How to Add the Post-Process Component to a Document

After you have added components to your Document, you can apply post-process code that
removes the pre-process code when the procedure is run. For example, if you apply a Join pre-
process code, add a report, add a chart, and format the Document, you can apply post-process
code that removes the Join when the procedure is run.

1. On the Utilities tab, in the Files Utility group, click Post-process code.
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A new canvas and the Procedure View panel open. The new canvas will show the
document name, an underscore, and the words, Post-process. For example, if you are
applying a post-process code to Document1 the canvas will be, Document1_Post-Process.

2. In the Procedure View panel, right-click the procedure folder, point to New, and click the
name of a procedure component.

3. Click OK.

4. When you are prompted to save the post-process code changes, click Yes.

Viewing Panels Associated With a Document or Active Dashboard Using the View
Group

The View group allows you to display or hide the panels associated with a document or active
dashboard. The View group is shown in the following image. 

The commands are:

Properties

Toggles the visibility of the Properties panel.

Settings

Toggles the visibility of the Settings panel.

Thumbnails

Toggles the visibility of the Thumbnails panel.

Previewing the Document Canvas

The Thumbnails panel contains a preview of what is currently on the canvas. This can be a
faster way of seeing your layout, instead of using the Run command. 

The Thumbnails panel is available when you are using the HTML or Document canvas. The
Thumbnails panel is hidden by default. You can display it using the View group, on the Utilities
tab.

For more information on customizing panels, see Customizing the Panels on page 128.
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Editing Document Canvas Properties

You can edit the properties of your document in the Properties panel. When the Document
canvas is active, the Properties panel displays a list of properties that you can modify.

For example, you change the output format from the type that you may have selected in the
HTML/Document Wizard. You can also modify the size of a page, the page orientation, you can
add bookmarks, and give each page, including the table of contents page, a title and
description.

Procedure: How to Add a Template to a Document

1. On the Home tab, in the Content group, click HTML/Document.

The HTML/Document Wizard opens

2. For File Type, select Document.

3. Click Next.

4. In the Output Format list, choose either PowerPoint PPT or PowerPoint PPTX.

The Document canvas opens.

5. In the Properties panel, click the drop-down list at the top, and then click Compound
document.

Note: When using a PPT or PPTX template in a document, the template must be specified
at the document level, and not just the component level.

6. Click the ellipsis button next to the Template Name property.

The Open File dialog box opens.

7. Navigate to the template, and click OK.

Supporting Template Masters and Slide Layouts in App Studio-Generated Presentations

A Slide Layout is the style applied to a slide in a Microsoft PowerPoint template or
presentation created in Microsoft PowerPoint 2007 and higher. The style may consist of
images, background color, text, tables, or other objects. Slide Layouts are available in the
Slide Masters of PowerPoint templates. You can also create custom layouts.
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By default, the first Slide Layout in the first Slide Master is applied to slides on which
WebFOCUS data is displayed. With this new feature, WebFOCUS enables you to select any
Slide Layout in any Slide Master in a PowerPoint template (POTX/POTM) or Presentation file
(PPTX/PPTM). One Slide Layout may be applied to slides displaying the output of a standard
report, while one or different Slide Layouts may be applied to each Page Layout in a PPTX
formatted Compound Document. The selected Slide Layout is applied to the slide displaying
WebFOCUS output.

This feature enhances the output of WebFOCUS-generated presentations, as well as the
integration of WebFOCUS with Microsoft PowerPoint features.

Procedure: How to Apply a Slide Layout to an Entire Document

1. Create a PowerPoint PPTX format document.

2. Import a report to the Document canvas (for example, rep_ggsales.fex).

3. On the Properties panel, select Compound Document, as shown in the following image.

4. On the Properties panel:

From the Page size drop-down list, select Power Point Slide.

From the Page orientation drop-down list, select Landscape.
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Click the ellipsis button next to Template name.

The Open File dialog box opens.

5. Navigate to the template file (for example, Title_layout.potx).

The Title_layout.potx template is added to the Properties panel.

6. Click the down arrow next to the Slide number property and select 2.

7. Click the down arrow next to the Slide master property, and select TURQUOISE.

8. Click the down arrow next to the Slide layout property, and select TITLE AND CONTENT.

Note: You must specify both a Slide Master and a Slide Layout.

9. Run the document and click Open to confirm that the slide layout is applied to the
WebFOCUS output on slide #2, as shown in the following image.

10. Close the output and return to the Document canvas.

11. Click Save from the Quick Access Toolbar.

12. In the Save As dialog box, type slides_entire_doc for the file name.

13. Close the document.

14. If you want to see the syntax, in the Environments tree, right-click slides_entire_doc and
select Open in Text Editor.

The syntax for the slide applied at the document level is as follows:

SECTION=section1:
COMPOUNT LAYOUT PCHOLD FORMAT PPTX
UNITS=IN
SECTION=section1, LAYOUT=ON, SLIDE-MASTER=’TURQUOISE’, SLIDE-
LAYOUT=’TITLE AND CONTENT’,
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Note: In a Compound Document, if different Slide Layouts are applied to each Page Layout
in a PPTX formatted Compound Document, the syntax is as follows:

PAGELAYOUT=n, NAME='Page layout (n)', SLIDE-MASTER=‘slidemaster_name’,
SLIDE-LAYOUT='layout_name’,

For more information on the syntax for Template Masters and Slide Layouts, see the
Creating Reports With WebFOCUS Language manual.

15. Close the Text Editor.

16. Run the document.

The TITLE AND CONTENT Slide Layout is applied to the output on slide #2, as shown in the
following image.

Learn More

For more information, see the Supporting Template Masters and Slide Layouts in App Studio-
Generated Presentations in the App Studio technical content.
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Chapter9
Creating Maintain Data Applications

In App Studio, you can create Maintain Data files using the Maintain Data Editor and
create Maintain Data applications through the HTML canvas. You can use the
Components and Controls tabs, along with the Requests & Data Sources, Settings, and
Tasks & Animations panels to take full advantage of the HTML canvas and create robust
Maintain Data applications.

In this chapter:

Using the Maintain Data App

Using the Tasks & Animations Panel

Using the Maintain Data Editor

Using Functions in Procedures

Using Variables in Procedures

Using Data Source Stacks in Procedures

Using Import Modules

Executing Other Procedures

Migrating Legacy Maintain Procedures to Maintain Data

Using the Maintain Data App

The Maintain Data product has been fully integrated into App Studio. The Maintain Data App
icon, available in the Containers group of the Components tab, enables you to draw a Maintain
Data container on the HTML canvas. The Containers group of the Components tab is shown in
the following image.
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When a Maintain Data file is added to an HTML page, it displays as a request in the Requests
& Data Sources panel. Maintain Data requests display all functions, data sources, forms,
variables, stacks, and parameters that are used in the Maintain Data file. If the Maintain Data
request does not contain one of these components, it is not displayed beneath the request. A
Maintain Data request in the Requests & Data Sources panel is shown in the following image.
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You can create new functions, variables, and stacks, as well as add additional data sources
and parameters by using the shortcut menu on the nodes. To edit a Maintain Data component,
right-click the item and select Edit Source or Edit. The Edit Source option allows you to edit the
entire Maintain Data file. The Edit option opens the Edit Function dialog box, where you can
edit the signature and description of that function.

Many of the Maintain Data request components can be dragged to the canvas, or other panels,
to automatically create the components and tasks needed to run the Maintain Data
component. The following are examples of how you can drag Maintain Data components to a
canvas.

Drag a request to the canvas to create the objects necessary for running the Maintain Data
file. Tasks are automatically created in the Requests/Actions section of the Tasks &
Animations panel.

Drag forms, variables, and stacks from the Requests & Data Sources panel to the canvas
to create objects.

Drag functions onto components or controls on the canvas to create tasks that execute the
function when they are clicked.

Drag variables and stacks to the Selection to area in the Settings panel. This assists in
directing where control and grid selections are sent.

Automatically Running Converted Maintain Data Files

When adding an existing Maintain Data file to your HTML page, you are prompted to run that
Maintain Data file after the page is loaded. Clicking Yes (recommended) creates an action for
the load task in the Tasks & Animations panel. This means that the Maintain Data file will
connect once the HTML page is loaded. If you click No, no action is created for the load task.

Procedure: How to Use the Maintain Data App Container

The Maintain Data App container is created in the HTML canvas. This container enables you to
construct the application front-end (or user interface). Then, you develop the code that extracts
data from your data sources and updates the data sources with new data.

1. In your Domain, create an HTML page.

2. Click the Maintain Data App icon in the Containers group of the Components tab.

Your cursor turns into a crosshair.

3. Draw a box on the HTML canvas to create your Maintain Data App container. This is the
container in which you will create your form.
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Note:

You can also drag an existing form onto the HTML canvas. This prompts you to create
a multipage control.

When you place a Maintain form on the canvas, you can choose to use a multi-form
container. If you choose not to use a multi-form container, you can add it later.

If you have a Maintain form on the canvas, you can right-click the form name, the form,
or the Forms folder, and select Add form to container. All of the forms are added to the
object on the form.

If you decide to use the Maintain form container, after already having forms on the
canvas, the container must be big enough to contain the largest form.

Creating Maintain Data Requests

Maintain Data requests are submitted from the Request & Data Sources panel. There are two
basic types of requests to create new applications: Embedded and External. Both Embedded
and External requests allow you to create applications manually, or using Update Assist. When
you create a request manually, you design the forms, write the navigation and validation, and
update the procedures using the Maintain Data Editor. Update Assist enables you to create
simple applications and add, update, or delete records against any data source for which you
have read/write access.

Embedded Request. Creates a new procedure within the HTML file.

External Request. Creates a new Maintain Data file or edits an external procedure, not
embedded in Maintain Data.

Note: The External Request shortcut menu also provides the Maintain data: Existing option,
which imports a Maintain application created in the Maintain Development Environment
(MDE).

Procedure: How to Create an Embedded or External Request

The following steps walk you through the process of creating an Embedded request or External
request manually. Also used to migrate existing Maintain procedures.

1. In a Domain folder, create a new HTML page, using the HTML/Document wizard.

2. On the Requests & Data Sources panel, select the down arrow next to the New icon,
select Embedded Request or External Request, and then click New Maintain Data.

By default, for an Embedded request, Request1 is created.
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For an External request, provide a name for your request in the Save As dialog box and
click OK.

3. Right-click the Request1 parameter and select Use data sources.

4. From the Data Sources in Procedure dialog box, select New.

5. Browse to the location of your Maintain Data data sources, select the one to use, click
OK, and then click OK again.

6. Click HtmlPage1 to display the canvas.

7. On the Requests & Data Sources panel, expand the Forms folder and then expand
Request1.

By default, Form1 has been created.

Procedure: How to Create a Request Using Update Assist

You can create an application using Update Assist that adds records, updates records, or
deletes records against any data source for which you have read/write access. Data navigation
and input validation are automatic. This means you get an update application with no need to
design forms, or to write navigation, validation, or update procedures.

1. In a Domain folder, create a new HTML page, using the HTML/Document wizard.

2. On the Requests & Data Sources panel, select the down arrow next to the New icon,
select Embedded Request, and then select New Maintain Data with Update Assist or select
External Request and then select Maintain Data: New with Update Assist.

3. Select the Master File from the Open File dialog box. The Update Assist dialog boxes
correspond to the steps needed to generate Update Assist applications.

Note:

If you are using a single segment Master File, Update Assist consists of two steps.

If you are using a multi-segment Master File, Update Assist consists of three steps.
The additional dialog box asks you to first select the lowest segment in the hierarchy
that you want to update.

For more details on using Update Assist, see the WebFOCUS App Studio Maintain Data
Getting Started content.
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Using the Tasks & Animations Panel

Once you create a request, you want it to generate tasks that a user performs, such as clicking
a button or moving from one field to another. These tasks are created using Ajax calls, which
execute them as asynchronous calls in JavaScript. With Ajax, the JavaScript does not have to
wait for the server response, but instead can:

Execute other scripts while waiting for server response.

Deal with the response when the response is ready.

Requests/Actions

The Requests/Actions drop-down menu is used to select the type of request or action to be
taken. As a request is selected, it is displayed in the Requests/Actions list. You can use the
adjacent arrows to move actions into the desired execution order. Each request also populates
the Target type field with the available targets in which that request can be executed.

The Request selection types are described in the following list.

Run Request 

Lists the requests you have created in the Requests & Data Sources panel. Each request
selected populates the Target type field with the available targets in which that request
can be executed.

Note: You must include a Connect task or the load does not work. The format is: <request
type>/<procedure name>.<function>

For example,

Embedded procedure/Request1.Connect

Schedule Request

Lists the available requests created in the Requests & Data Sources panel.

Run Animation

Lists the available jQuery animations from the jQuery animation section.

Toggle Visibility

Toggles the selected Maintain Data form on and off.

Execute Task

Lists the available tasks to enable you to execute one task from within another.
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Refresh

Creates an action to refresh the selected target.

Wait for completion 

Allows you to specify that one request must complete before the next one begins. For
example, if request1 is listed above the Wait for completion action and request2 is below
it, request1 runs first and when completed, request2 runs.

JavaScript call

Creates a JavaScript call action. When using the JavaScript call, different results occur
depending on what is returned. If the JavaScript call returns 0, then all actions after it run.
If the JavaScript call returns 1, then one action after the call is skipped, and all actions
after that are then run. If the JavaScript call returns 2, all actions after it are skipped.

Target Types

The Target type option contains a list of targets in which the request can be executed. These
targets can be controls, frames, windows, or distribution methods when the Request is set to
Schedule. These options can be different for specific actions.

Window

Executes the request in a window.

InfoWindow

Executes the request in the WebFOCUS-generated InfoWindow.

Frame 

Executes the request in a selected frame.

Ajax call

Executes the request as an asynchronous call in JavaScript.
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Note: The Ajax call is the only Target Type used by Maintain Data.
Schedule

Schedules the report request for distribution.
Deferred 

Defers the running of the report.
Input Control

Specifies that an input control will be refreshed. This option is only available when you
have a refresh request selected in the Requests/Actions list. You specify which control
should be refreshed by selecting one from the Target/Template Name list.

Active Report

Specifies that an active report will be refreshed. This option is only available when you
have a refresh request selected in the Requests/Actions list. You specify the active report
that will be refreshed by selecting one from the Target/Template Name list.

Refresh BI Portal

Specifies that a WebFOCUS BI Portal page is refreshed. This option is only available when
you have a refresh request selected in the Requests/Actions list. If you select All pages of
the portal, all BI Portal pages are refreshed. If you select Current page only, only the
current BI Portal page is refreshed.

JavaScript 

Specifies that the selected task calls a JavaScript function that you type in the Function
name field. This option is only available when you have selected JavaScript call in the
Requests/Actions field.

Using the Maintain Data Editor

Underlying many of the graphical elements of App Studio Maintain Data is Maintain Data
language source code. The Maintain Data Text Editor enables you to create, view, and edit the
source code for procedures, procedure components, and other types of files required by your
Maintain Data applications. The Maintain Data Text Editor tab opens when you create a new
function or edit an existing one. It contains two groups, Find and Position. The Maintain Data
Text Editor tab is shown in the following image. 
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All App Studio Maintain Data procedures start with the keyword MAINTAIN (which must be in
uppercase) and end with the keyword END (also in uppercase), as shown in the following
image. When you create a procedure, App Studio Maintain Data includes these two keywords
automatically.

MAINTAIN FILE fannames

$$Declarations

Case Top
Infer fannames.CUSTOMER.SSN into AddFanStack;
Winform Show Form1;
EndCase

Case AddFan
EndCase

END

Note: The text in your window may wrap differently.

FILE fannames tells App Studio Maintain Data the data sources this procedure is going to
access. In the list of components, there is a Data Sources folder with a fannames data source
below it.

Data source names (up to 15) follow the MAINTAIN FILE command and are separated by the
word AND.

Following this line is a comment line beginning with $$. You can tell that this is a comment
since green (the default) is the color for comments. This comment line is automatically
generated when you create a procedure.

This particular comment, $$Declarations, is generated automatically by App Studio Maintain
Data when you created the procedure. If you create any new variables using the Request &
Data Sources panel, App Studio Maintain Data places the source code after this comment.

Case Top begins the definition of the Top function. This definition takes up several lines and
ends with the keyword EndCase. The first statement, which begins with Infer, defines the
AddFanStack data source stack.

The next line of the Top function, Winform Show Form1; is the code that displays Form1 at run
time. This code was generated automatically when you created the procedure.

Finally, the Case AddFan and EndCase define an additional function in this procedure.
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Finding or Replacing Text Using the Find Group

The Find group contains options that enable you to find or replace text. For information on the
Find group options, see the WebFOCUS App Studio Maintain Data Getting Started content.

Reference: Find Dialog Box

You can use the options on the Find dialog box to indicate how to search for information. For
information on the Find dialog box options, see the WebFOCUS App Studio Maintain Data
Getting Started content.

Reference: Replace Dialog Box

You use the options on the Replace dialog box to indicate how to use the find feature to find
and replace information. For information on the Replace dialog box options, see the WebFOCUS
App Studio Maintain Data Getting Started content.

Placing the Cursor Using the Position Group

The Position group allows you to place your cursor at the desired line and allows you to turn off
line numbers. For information on the Position group options, see the WebFOCUS App Studio
Maintain Data Getting Started content.

Using the Shortcut Menu in the Maintain Data Editor

The shortcut menu is available by right-clicking anywhere within the body of the Editor and
provides access to the Language Wizard, as well as New Variable, New Function, and New
Class dialog boxes.

Note: The New Variable, New Function, and New Class options are also available from the
Requests & Data Sources panel by right-clicking your Maintain Data request and selecting
them from the shortcut menu.

Language Wizard

Opens the Maintain Language Wizard which helps you build Maintain Data language source
code without typing the syntax yourself.

New variable

Opens the New Variable dialog box.

New function

Opens the New Function dialog box.

New class

Opens the New Class dialog box.
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Line Numbers

Provides line numbers to the left of the source code.

Outlining

Indents code by one position.

Auto Complete

Not enabled for the Maintain Data Editor.

Auto parse

Parses as you type. Recommendation is to not select this option for Maintain Data.

Parse

Enables you to parse on demand.

Procedure: How to Use the Language Wizard

Maintain Data provides a Language Wizard to help you construct Maintain Data language
source code.

1. Place the cursor where you want your source code to go.

2. Right-click at the insertion point and select Language Wizard from the shortcut menu.

The first screen of the Language Wizard opens.

3. Select the type of code you wish to create and follow the online instructions.

The Language Wizard can generate Maintain Data commands to perform the following tasks:

Retrieve records from a data source (NEXT).

Update records in a data source (INCLUDE/UPDATE).

Operate on a form (Winform).

Run another procedure (CALL or EXEC).

Operate on a stack (STACK).

Procedure: How to Create a New Variable

1. In the Requests & Data Sources panel, right-click the procedure name, and from the
shortcut menu, select New variable.

The Maintain Data Editor for the procedure opens and the New Variable dialog box
displays.
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2. Type a name for the variable and click OK.

The new variable is added to the end of the existing variables.

Note: You can also access the New Variable dialog box from within the Maintain Data Editor.
Place your cursor where you want the new variable added, right-click, and from the shortcut
menu, select New variable.

Procedure: How to Create a New Function

1. In the Requests & Data Sources panel, right-click the procedure name, and from the
shortcut menu, select New function (case).

The Maintain Data Editor for the procedure opens and the New Function dialog box
displays.

2. Type a name for the function and click OK.

The new function is added to the end of the existing functions.

Note: You can also access the New Function dialog box from within the Maintain Data Editor.
Place your cursor where you want the new function added, right-click, and from the shortcut
menu, select New function.

Procedure: How to Edit an Existing Function

In the Requests & Data Sources panel, right-click a function and from the shortcut menu,
select Edit or Edit source. The Maintain Data Editor opens, highlighting the code or text of the
selected function.

Procedure: How to Create a New Class

1. In the Requests & Data Sources panel, right-click the procedure name, and from the
shortcut menu, select New class.

The Maintain Data Editor for the procedure opens and the New Class dialog box displays.

2. Type a name for the class and click OK.

The new class is added to the end of the existing classes.

Note: You can also access the New Class dialog box from within the Maintain Data Editor.
Place your cursor where you want the new class added, right-click, and from the shortcut
menu, select New class.
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Using Functions in Procedures

A function, also known as a case, is a series of commands in a procedure grouped together as
a unit of control. A function accomplishes a task, such as calculating values, extracting data
from a data source to place in a data source stack, or writing information to a data source.
You can also call one function from within another function.

All executable code must be in a function. The only types of logic allowed outside of a
function are variable declarations, object declarations, and class definitions (CASE,
DECLARE, DESCRIBE, END, MAINTAIN, and MODULE statements).

Some functions have arguments, meaning when you invoke the function, you must supply
information that the function needs to complete its task.

Some functions also have a return value, meaning they calculate a value and return this
value to whatever called the function. Functions that are event handlers (that is, that are
invoked by some action in a form) cannot have return values.

The combination of the arguments and return value of a function is known as its signature.

Local variables (defined in a function using the DECLARE command) are available only
within that function. As soon as the function completes processing, these values are no
longer available.

Global variables (defined using the DECLARE command outside of a function or using the
COMPUTE command anywhere) are available for the entire procedure.

Note: For more information on local and global variables, see the WebFOCUS App Studio
Maintain Data Language Reference content.

Procedure: How to Create a Function

1. Select the procedure you would like the new function to be part of.

2. Right-click the procedure and click New function in the shortcut menu.

3. In the New Function dialog box, type a name for your function in the Name field (up to 66
characters with no spaces).

4. Use the New button to open the Function Parameter dialog box to add any arguments (not
all functions require arguments).

5. Use the Returns field to enter the name and format of a return value (not all functions
require return values). You can also click the ellipsis button to open the Function Return
dialog box. This is where you can define the function.

6. Click the Description tab, type a description, and click OK. (Optional)
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7. Right-click the function and select Edit Source from the shortcut menu.
The Maintain Data Editor opens the procedure containing your function in the code for the
function.

8. Locate your cursor just before the ENDCASE keyword and enter the Maintain Data
language commands that determine what this function does.

Note: The following Maintain Data language commands are not valid within the context of
a function: CASE, ENDCASE, MAINTAIN, END, MODULE, and DESCRIBE.

Tip: You can add Maintain Data language code to your function using the Language
Wizard. Place your insertion point where you want your code to go, right-click in the
Maintain Data Editor window and select Language Wizard in the shortcut menu.

Procedure: How to Edit a Function

1. Right-click the function in the Requests & Data Sources panel.

2. Click Edit Source in the shortcut menu.

3. Make your desired changes between the CASE funtionname and ENDCASE keywords.

Tip: You can add Maintain Data language code to your function using the Language
Wizard. Place your insertion point where you want your code to go, right-click in the
Maintain Data Editor window and select Language Wizard in the shortcut menu.

Procedure: How to Edit the Name, Arguments, Return Value, and Description of a Function

1. Right-click the function in the Requests & Data Sources panel.

2. Click Edit in the shortcut menu.

3. Make your changes in the Edit Function dialog box and click OK.
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Reference: Function Editor: Signature Tab

When you create or edit a function, App Studio Maintain Data opens the New Function,
Edit Function, or Member Function dialog box, as shown in the following image.

This dialog box contains the following options:

Name

The name you assign to your function (or case). This name can be up to 66 characters
long. It must begin with a letter and can include any combination of letters, digits, and
underscores (_).

Takes: (Name/Type)

Lists the arguments that the function requires. When you invoke the function, you pass to
it variable names or values to substitute for these arguments.

To create a new argument, double-click the gray rectangle or click the plus sign to the
right of the field.

To edit an existing argument, double-click its name.

To change the order of the arguments, select the argument to be moved and use the
arrows to move it up or down.
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To delete an argument, select it and click the red X to the right of the field.

Note: Not all functions require arguments. You cannot use a function with arguments as
an event handler.

Returns: (Name/Type)

Contains the name and data type of the return value that the function calculates. This
information can be entered directly in the field, or you can use the ellipsis button to open
the Function Return dialog box to enter it.

Using Variables in Procedures

A variable is a named storage location capable of containing a certain type of data that can be
modified during program execution. You also create variables as part of a class definition or
function.

Maintain Data variables have four attributes:

A name

A data type (for example: integer, alphanumeric, or a user-defined class)

A value (optional)

A description (optional)

Procedure: How to Create a New Variable

1. In the Requests & Data Sources panel, or within the Maintain Data Editor, right-click the
procedure that you want the variable to be part of and select New variable.

The New Variable dialog box is displayed.

2. Type a name for the variable.

3. Specify a data type for the variable. You can do this in one of two ways:

Select a Type using the drop-down list of recently-applied data types.

Click the ellipsis button to open the Type Wizard.

4. Specify an initial value for your variable by clicking the x=? Initialize tab and typing a value
in the box (Optional).

5. Click the Description tab and enter a description (Optional).

6. Click OK.
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This variable is global, meaning it is available to any code written in this procedure. To use
it in another procedure, you must pass it to the other procedure.

Procedure: How to Edit a Variable

1. Right-click the variable in the Resources & Data panel, and from the shortcut menu, click
Edit.

2. Make any changes in the Edit Variable dialog box and click OK.

Procedure: How to Edit Source Code in a Variable

1. The App Studio Maintain Data application generates Maintain Data language code for
variables. You can edit this code directly in the Maintain Data Editor.

2. Right-click the variable in the Resources & Data panel, and from the shortcut menu, click
Edit Source.

3. Make your changes to the code after the DECLARE variable name keyword and before the
semicolon (;).

For more information, see the WebFOCUS App Studio Maintain Data Language Reference
content.

Reference: Variable Editor: Declaration Tab

When you create or edit a variable, App Studio Maintain Data opens the New Variable or
Edit Variable dialog box. The Edit Variable dialog box is shown in the following image.

This dialog box includes the following options:

Name

Contains the name of the variable, argument, or return value you are specifying.
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Type

Contains the data type of the variable or argument or return value you are specifying. This
information can be entered directly in the field, you can select a recently used data type
from the drop-down list, or you can use the ellipsis button to open the Type Wizard. For
more information on the Type Wizard, see Using the Type Wizard on page 730.

Note: The Type Wizard does not create specifications for the following data types: date-
time, packed-decimal, and text. For more information on specifying packed-decimal or text,
see the Describing Data With WebFOCUS Language content.

Reference: Variable Editor: x=? Initialize Tab

When you are creating or editing a variable in an existing Maintain Data request, use the
x=? Initialize tab in the New Variable or Edit Variable dialog box to enter a value for your
variable, as shown in the following image. This value can be any expression. For more
information, see Expressions Reference in the Maintain Language Reference manual.

Using Data Source Stacks in Procedures

A data source stack is a non-persistent (or in-memory) array where you can store and
manipulate data from one or more data sources. In the Maintain Data language, you use data
source stacks to hold values you read from the data source and manipulate data before writing
it back to the data source. You can think of a data source stack as a staging area in memory
in which you can manipulate data before committing it to the data source or displaying it to the
user.

To use a data source stack, first create one using the Stack Editor, or by editing the procedure
as text and typing the appropriate syntax. The columns of a stack are usually based on actual
data source fields, but you can also add your own columns.

Fill the data source stack with data from one or more data sources. You can then use a form
to display the stack data to the user. The user has the option of changing this data. App
Studio Maintain Data stores the changes in the data source stack until the project issues an
UPDATE command to update the data source.

There are two ways to create a data source stack:

Explicitly, by declaring the data source stack using an INFER statement in your procedure
(use the Stack Editor to create the INFER statement or edit the procedure as text and type
the INFER statement directly). For more information on using the Stack Editor, see How to
Create a Data Source Stack Explicitly Using the Stack Editor on page 727.

Implicitly, by loading data into the data source stack using the NEXT or MATCH commands.
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For more information, see the WebFOCUS App Studio Maintain Data Language Reference
content.

Note: When you use a data source field as a column in a data source stack, App Studio
Maintain Data defines columns based on the rest of the fields in that data source or, if your
data source is hierarchical, the rest of the fields in the segment and the key fields in any
parent segment. These columns are called implied columns. Maintain Data includes all of
these fields in your data source stack so that when you update your data source from the data
source stack, it knows the path to these fields.

Procedure: How to Create a Data Source Stack Explicitly Using the Stack Editor

1. Ensure that all the data sources you want to reference in this stack are being used by the
procedure.

2. Select the procedure that you want the data source stack to be part of.

3. Right-click Stacks under the procedure and click New data source stack.

4. In the Stack Editor dialog box, type a name for your data source stack.

5. Define the columns that make up the data source stack. There are two ways to do this
(you can use one or both):

Base the columns on actual fields in your data source. Select a field under the list of
data sources in the Available fields list and click the right arrow button.

Note:

If no data sources appear in the Available fields list, you must specify which ones
to use in your procedure.

When you copy one of the fields in a segment into the definition of a stack, App
Studio Maintain Data automatically copies all of the rest of the fields in that
segment and the key fields from the ancestor segments. These columns are called
implied columns.

Create custom (user-defined) columns. You can use custom columns as temporary
work areas or to create calculated fields, such as Name = First || Last. Under the
Variables folder, click New Variable. In the Computed Stack Columns dialog box under
the Declaration tab, type a name and type for the new column and then click OK.
Repeat these steps, until all of your columns have been defined.

6. Click the Description tab and type a description (Optional).

7. Click OK.
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App Studio Maintain Data creates an entry for your new data source stack in the Project
Explorer under the procedure. When you open it, you see the columns that define the data
source stack.

Tip. You can create a data source stack based on the fields in a data source segment by
dragging the data source segment to the procedure in which you want to create the data
source stack. App Studio Maintain Data prompts you for the name of the data source
stack in the Create New Stack dialog box. Creating a data source stack this way also uses
the data source in the procedure, if you have not specified it already.

Reference: Stack Editor: Definition Tab

When you create or edit a data source stack, App Studio Maintain Data opens the Stack
Editor dialog box, as shown in the following image.
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This dialog box includes the following options:

Stack name

Is the name of the stack.

Available Fields

Lists the data sources that you have specified for use in this procedure. To define columns
for the data source stack, either use existing fields from the data sources or create new
ones by clicking New variable.

Arrow buttons

The forward arrow buttons copy a selected parameter or field into the list of data source
stack columns.

The back arrow buttons remove a selected column from the list of data source stack
columns.

Stack columns

Contains the columns that you have defined for your data source stack.

When you use a data source field to define a stack, App Studio Maintain Data defines
columns for all of the rest of the fields in the data source. If your data source is
hierarchical, App Studio Maintain Data defines columns for the rest of the fields in the
segment, and the key fields from parent segments. These are the implied columns.

Generated code

Contains the Maintain Data language code generated by the Stack Editor dialog box for
your data source stack. This can take the form of Infer datasource.segment.field into stack
and/or Compute stack.column/format.
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Reference: Using the Type Wizard

When you create a variable or define an argument or return variable, you must assign a data
type to it. A data type is either a format or a class and can be assigned using the Type Wizard.
There are two kinds of data types: Built-in Type (or format) and User-defined Class.

If you choose Built-in Type, you have three basic formats:

Alphanumeric. For values composed of alphabetic, numeric, or special characters.

Date. For dates or components.

Numeric. For values composed of the digits zero (0) through nine (9) and, optionally, a
minus sign (-). You have the following choices:

Double Precision. For whole numbers or fractions, using eight (8) bytes of storage and a
maximum number of 15 positions. This type of field automatically inserts a comma (,)
after every third significant digit.

Floating Point. For whole numbers or fractions using four (4) bytes of storage and
maximum number of nine (9) positions.

Integer. For whole numbers using four (4) bytes of storage and maximum number of
nine (9) positions. Numbers after the decimal are truncated.
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If you choose Class, you must already have defined a class. For more information, see the
WebFOCUS App Studio Maintain Data Language Reference content.

Note: The Type Wizard does not create specifications for the following data types: date-time,
packed-decimal, and text. You must manually enter the specification in the data type field. For
more information on specifying packed-decimal or text, see the Describing Data With
WebFOCUS Language content.

Using Import Modules

An import module is a non-executable procedure that contains Maintain Data language code.
You do not execute an import module as part of your project. Instead, you use it as a library of
functions or classes. Using the MODULE IMPORT command, you can bring an import module
into any procedure and use its functions and classes. An import module cannot be used for
data source access.

If you edit an import module, you will notice that, just as with a procedure, it starts with the
keyword MAINTAIN and ends with the keyword END. However, it does not contain a Top
function.

You can use the following in an import module:

Functions

Classes

Variables

You cannot use the following in an import module:

Forms

Data sources (the syntax MAINTAIN FILE filename is not supported)

Commands that read or write data to a data source (NEXT, MATCH, and so on)

Stacks that contain columns from a data source (defined with the INFER or NEXT
commands). You can, however, define stacks using Stack Of, DECLARE, or COMPUTE.

Note: When you move an import module into a procedure, the variables, functions, and
classes in an import module become part of the name space of the procedure. For example, if
you have a variable named COUNT in an import module and import it into a procedure, that
procedure cannot define its own variable named COUNT.
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Executing Other Procedures

Separating your application code into more than one procedure (called modularizing or
partitioning) can significantly speed up your development time and application performance.

The Maintain Data language contains two commands for executing procedures:

CALL. Executes Maintain procedures.

EXEC. Executes WebFOCUS procedures.

These two commands work more or less in the same way. Each command has some options
that enable you to do the following:

Determine the WebFOCUS Server where the called procedure is located.

Determine whether to keep or close the server session when the procedure finishes
executing (the server session is a process on the WebFOCUS Server that executes the
procedure).

Pass parameters to and receive parameters from the called procedure.

Advantages of Modularizing Source Code

Separating your application code into more than one procedure has many advantages:

You can use multiple procedures to share common source code among many developers,
thus speeding up development and maintenance.

For example, a generalized error message display procedure could be used by all App
Studio Maintain Data developers. After passing a message to the generalized procedure,
the procedure handles message display. The developers do not need to be concerned
about how to display the message and error messages always look consistent to end
users.

You can remove infrequently-executed source code from a procedure and move it into its
own procedure. This reduces the size of the original procedure, simplifying its logic, making
maintenance easier, and using less memory if the new procedure is not called.

You can split your application into presentation logic and database logic, and then run each
type of logic on a server optimized to support that type of logic.
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Using the CALL and EXEC Commands

To use the CALL or EXEC command, you must open the calling procedure in the Maintain Data
Editor and enter the command inside of a function (CASE/ENDCASE command). You can type
the command directly or use the Language Wizard. For more information on the CALL and EXEC
commands and syntax, see the WebFOCUS App Studio Maintain Data Language Reference
content.

Migrating Legacy Maintain Procedures to Maintain Data

You can run Maintain applications that were created in Developer Studio in App Studio, without
any changes or migration. However, if you wish to make changes to your application, you must
migrate it to App Studio.

You can migrate existing Maintain procedures to the App Studio Maintain Data application,
using the External Request option in the Requests & Data Sources panel.

Note: You cannot copy a Maintain file (.mnt) from the Projects area to a Domain. The Projects
area is not turned on, by default.

Procedure: How to Migrate Legacy Maintain Procedures

Note: When migrating legacy Maintain procedures to Maintain Data, back up your application
folder before starting this process.

1. If you do not see your application on the Configured Environments tree, create a New
Project by right-clicking the server and selecting New Project.

Note: Assign the project the name of the directory containing all of the files, including
Master and Access Files, needed for the Maintain application.

2. Create a new HTML page by right-clicking the application name, selecting New, and then
selecting HTML/Document.

Note: The Maintain application code is no longer a stand-alone application. It resides as
part of an HTML page.

3. In the HTML/Document Wizard, leave HTML Page selected and click Next.

4. On the Templates, Settings, and Themes pane, click Finish to continue.

5. Open the Requests & Data Sources panel and pin it to the canvas.

6. From the New drop-down menu, select External Request and then select Maintain data:
Existing from the shortcut menu.

7. From the Open File dialog box, select the Maintain file to be migrated, and the migration
process begins.
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Note: If there is more than one Maintain file, select the parent or main Maintain that
CALLs the others. If you do not see the name of your Maintain file, select the Show All
Files in Associated Paths radio button.

The following App Studio dialog box opens, asking you whether you want to start the
Maintain Data procedure after the page is loaded.

8. Click Yes.

Note: All Maintain applications must have a Load task that performs a Connect to the
code. Without this, when you run the application, the Maintain code will not be processed.
Clicking Yes to start the Maintain right after the page is loaded creates this task. All new
Maintain applications must also contain this task.

As the migration runs, you may receive a message that the Maintain procedure contains
multiple Winforms and that recommends that you use a multipage control for better layout
and presentation, as shown in the following image. The multipage control puts one
Winform on a page and the appropriate Winform is displayed automatically when needed.

9. Click Yes.

The migration process continues.
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If the conversion is successful, the following App Studio dialog box opens, indicating that
the conversion process is complete and asking if you want to see the log file.

10. Click Yes if you want to review the log file. Otherwise, click No.

11. Click OK if you receive a message stating that code in the Maintain procedure was found
that could not be migrated automatically and that you need to revise it.

The Maintain procedure opens in the App Studio Maintain Editor, as shown in the following
image. In addition, the Maintain request can be expanded in the Requests & Data Sources
panel to see its components.

12. In the App Studio Maintain Editor, search for the following line of code:

-* The following line of code is not consistent with the new design of 
Maintain. Please revise.

This line appears for constructs, such as when the Maintain code wants to directly
manipulate a control, or there is a Winform Set statement to make an object visible.
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Maintain Data Migration Considerations

The following are migration considerations when migrating legacy Maintain applications to
Maintain Data.

Maintain Data Licensing

Maintain Data has a license code on the Reporting Server. If Maintain Data is not licensed,
each Maintain Data page contains a diagonal watermark background image that says
"Maintain Data Trial" to indicate that the product is not licensed.

Naming Changes

An object in Maintain Data or JavaScript code is no longer referenced using Form.Objectname.
All migrated variables are changed to Form_Objectname.

Events

All Maintain code in the application event section is migrated into the application. A case is
created for each event, and a task is assigned to that case. Display the Tasks & Animations
panel. When you click on a control, you can see the task assigned to each case.

If the event contains JavaScript, you can view the JavaScript by clicking the Embedded
JavaScript tab at the bottom of the form. To see if an object is associated with a JavaScript
event, click the object and display the Properties panel. Click the lightning bolt to display the
events. Clicking on an event name brings you to the code in the Embedded JavaScript view.

Winform Set Commands

There are no longer Winform Set commands in Maintain Data. All of these commands are
replaced by computed variables. Assign these variables to an object property and when the
variable is evaluated, the property is set. Instead of the following Maintain command to make
something invisible:

Winform Set Form.Object.Visible to No;

In Maintain Data, you use a Compute command, and assign that to the visible property of the
object. For example:

Compute Var/a10 = 'Hidden';

You can assign variables by dragging them from the Requests & Data Sources panel directly
onto the Properties panel of the object.
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Winform Get Command

The Winform Get command is no longer supported. You can test the associated variable to get
the current value.

showLayer Command

The SetLayer command in Maintain has been replaced by the IbComposer_showLayer
command in Maintain Data. The IbComposer_showLayer command allows layers to be set as
visible or invisible at run time. It is used in a JavaScript event.

IWCTrigger Code

IWCTrigger code is no longer used for a JavaScript event to perform a Maintain case. Instead,
a new task is created to perform the Maintain case and assigned to a Trigger Type of TBD. You
can then drag that task into the JavaScript code and create:

IbComposer_triggerExecution("taskn",1);

This conversion is done for you at migration. If the IWCTrigger code was in a linked or
embedded JavaScript file, you will have to perform this code conversion yourself.

HTMLTable GetHTMLField

When embedding HTML objects in HTMLTables, GetHTMLField was used to retrieve the
selected or entered value at run time. You can now assign a Selection To field when creating
the HTMLTable, making this unnecessary.

HTMLTable ClickRow, ClickColumn, and Value

Retrieving the clicked row, column, or value from an HTMLTable has changed for using both
Maintain Data and JavaScript code.

The Developer Studio functions ClickColumn, ClickRow, and Value(cell value) are now
IbComposer_getClickedColumn, IbComposer_getClickedRow, and
IbComposer_getClickedCellValue.

The following Developer Studio Maintain code is removed.

compute X/13 = Form1.HTMLTable1.Clickrow;
compute Y/13 = Form1.HTMLTable1.Clickcolumn;
compute Z/13 = Form1.HTMLTable1.value;

X and Y are still created, but are assigned in the HTMLTable Settings panel to the ClickRow
and ClickColumn parameters.
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The statement: Form1.HTMLTable1.value; is no longer supported and will have to be replaced.
You can use the code:

compute Z/A10 = Stack(x).field;

where:

Stack

Is the name of the stack populating the HTMLTable.

x

Is the variable containing the ClickRow value.

field

Is the name of the field on which you are clicking.

This Developer Studio JavaScript code:

var col = Form1.HTMLTable1_ClickColumn.value;
var row = Form1.HTMLTable1_ClickRow.value;
var val = Form1.HTMLTable1_Value.value;

is replaced by:

var col = IbComposer_getClickedColumn(ctrl);
var row = IbComposer_getClickedRow(ctrl);
var val = IbComposer_getClickedCellValue(ctrl);

HTMLTable Dynamic Sizing

In Maintain, the command: Form1.HTMLTable1.RealBodyRowHeight = n was used to change
the height of a row in an HTMLTable. In Maintain Data, this is done in the HTMLTable
Properties panel.

Closing and Exiting a Form

Since the Maintain Data application is now part of an HTMLPage, the command self.Winexit or
formname.Winexit is no longer supported.

JavaScript onclick window.close Function

The JavaScript onclick window.close function only works with Internet Explorer 11.

Embedded or Linked JavaScript Files or CSS Files

To see the JavaScript or CSS files that are associated with your migrated application, click the
form and display the Settings panel. The names of your resource files can be found there.

Migrating Legacy Maintain Procedures to Maintain Data

738  Information Builders



Displaying Forms and Databases

When you expand the Forms folder on the tree, all application forms are displayed. You can
display one or multiple forms by checking the box next to their names.

Databases are displayed once for all the requests. They are not displayed for each request.

Property Functions in JSGrid

Two additional values for contentTypes were added to the ColumnSetContentType function.
The two values are 3 - CheckBox and 4 - Select.

The CellSetFont function has been enhanced to include additional styling information, as
follows:

grid1.CellSetFont(3,2,"italic bold 12px antique, serif");

The syntax for the SetTopRow function is now:

$('#Form1_Grid1_table').setTopRow

The syntax of the functions no longer includes the form name.

The Grid and JSGrid OnRowSized and OnRowSizing events are not available in App Studio.

Check Box Property

During the migration process, the TextOnLeft property does not migrate. If you require this
property in App Studio, set the Direction of text property in the Properties panel.
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Chapter10
Creating Esri Maps

Geographic Information Systems (GIS) enable you to integrate reports with maps and
leverage location-based information.

In this chapter:

Illustrating Trends

Using the WebFOCUS Esri HTML5 Viewer

Creating an Esri Component on an HTML
Page

Using Unified Geographic Roles

Configuring a Map Data Layer

Adding a Demographic Layer to a Map

Using Map Widgets

Configuring the Map Menu

Using IbComposer Functions to Invoke
Map Menu Options

Configuring Layer Visualizations

Configuring Symbology for a Data Layer

Configuring Symbology for a Point Data
Layer

Configuring Symbology for a Polygon
Data Layer

Configuring Symbology for a Line Data
Layer

Summary of Symbology and
Visualizations by Layer Type

Refreshing Markers on an ESRI Map
Without Refreshing the Entire Map

Retrieving the Esri Map Viewer Current
Extent Coordinates as Variables

Configuring Maps to Interact With Other
Components

Adding Before Load and After Load
Events

Configuring Geographic Information

Adding an Esri Proxy URL

Installing and Configuring Esri on
Premise
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Illustrating Trends

Using App Studio, you can create maps to identify patterns or trends in your data. By
converting data into values that can be displayed on a map, you are able to visualize
scenarios, illustrate hot spots, and identify potential problem areas. For example, a law
enforcement agency may use mapping functionality to identify areas of higher crime within the
locations they cover. You can also use maps to determine how places are related, understand
where things are located, and identify the best actions to take. By illustrating trends on a map,
a decision maker can identify patterns easily, and reach conclusions sooner. 

An early example of how maps can be used to illustrate trends is the case of Dr. John Snow,
an epidemiologist who was one of the first to use data to map occurrences of cholera to find
the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to
visualize a trend that showed higher incidences of cholera closest to water pumps. This
example is shown in the following image.
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Maps also allow you to measure size, shape, and distribution to detect and quantify patterns,
and even perform predictive analytics. An example of how maps can help detect and quantify
patterns is the scenario in which a state agency used a WebFOCUS mapping application to
solve a problem with their food stamp system. Using this application, odd food stamp
redemptions, such as rounded numbers transactions, were discovered. By plotting those
transactions on a map, the agency discovered that the redemptions appeared in the same
geographic location. Upon further investigation, the agency identified that individuals were
selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to
others instead using them as intended. This map example is shown in the following image.

When working with maps, the concepts of location intelligence and business intelligence are
important to understand. A Geographic Information System (GIS) captures, stores, analyzes,
manages, and presents data linked to a location, while Business Intelligence (BI) relies on the
conversion of raw data into meaningful information. Location intelligence is the process of
analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow
the recognition of patterns in your data, including the visualization and discovery of geospatial
outliers, which would not be easily discovered if you use the technology independently and
separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view
symbol layers for data bound to a geo-location, such as state, country, and ZIP code, in an
integrated map viewer. Using metrics from your data, you can also visualize geographic roles or
dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or
assigned to a data field when you create a map.
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Using the WebFOCUS Esri HTML5 Viewer

The Esri HTML5 Viewer for WebFOCUS is based on the Esri ArcGIS JavaScript API. The ArcGIS
JavaScript API is a robust API for creating maps with a variety of symbology options, enabling
you to embed maps and tasks in web applications. It is supported on all modern browsers on
any device. 

The App Studio Esri map component allows you to use online content published on ArcGIS
Online. ArcGIS Online publishes demographic and feature data that is location related. On the
App Studio Esri map component, you can place any number of these data layers on top of a
base map (background map image) of your choosing, and configure symbols and colors to
highlight any relevant information.

You provide the location dimension for drawing map layers from a standard WebFOCUS report
with XML output.

At run time, the map displays with a set of controls that let you show or hide individual layers,
change the basemap, access layer tools, and change the map viewing area. In addition, you
can add interactive widgets and other WebFOCUS content, including drilldowns to reports and
charts, to create complete applications that leverage Esri content.

WebFOCUS automatically gives you access to public content from ArcGIS Online. If you have
ArcGIS credentials, you can access any additional content for which you are licensed by signing
into your ArcGIS Portal.

ArcGIS Portal is software from Esri that you can deploy either on premises or in the cloud.
ArcGIS Online is the Esri Software as a Service offering that represents GIS as a Service and is
implemented using the same technology as ArcGIS Portal. Portals allow you to publish and
share content over the web.

A portal can have users who are unaffiliated with an organization or users who are part of an
organization. A portal has users, groups, and content. Users sign in to the portal and create
and share content. The system supports different types of items including the following:

Maps. Web maps can be displayed on all supported platforms (web, mobile, and desktop).

Layers. Layer types that are supported include feature, map, and image services that can
be added as layers in web maps.

Applications. You can create web and mobile applications whose content is provided by
web maps.

Tools. Your applications can include geocoding, routing, and other task-based services.

Data files. You can upload, store, download, and, in some cases, activate files to create
services (map layers).
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In order to run a map in the Business Intelligence Portal, you must configure the properties
panel of the HTML page as shown in the following image.

Note that you must set the property Load in iframe object to No. The default value is Yes.

Note: When building HTML pages for mobile devices, please use the Responsive Design
Templates available in App Studio.

Creating an Esri Component on an HTML Page

You insert an Esri map component in an HTML page by clicking the Esri Map button on the
right end of the Objects group on the Components tab, as shown in the following image.
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After clicking the button, use your mouse to draw an area on the HTML canvas for the map
component.

Configuring the Esri Map Component

Once you insert the Esri map component into the HTML page, you can configure the following
properties and objects.

The basemap on top of which the feature layers will display.

Layers (Esri feature layers).

The map view.

Geographic role or longitude and latitude for each layer.

Symbology using colors, shapes, sizes, and images.

The Esri viewer has widgets available at runtime that provide a table of contents (layer list) and
a set of tools for making selections and changing the viewing area on the map.

You have the following options for configuring the map component contents.

A map published on your own portal or on ArcGIS.com.

The initial spatial extent of the map component (the bounding box for the initial display of
the map).

Note: On the Properties panel, the Map type property defaults to Google map. This property is
not relevant to an Esri component and can be ignored in this context.

Reference: Choosing a Basemap

The Miscellaneous options on the Properties panel let you select one of the following default
basemaps:

Dark Gray Canvas Map. Provides a dark background that allows the focus to be on other
layers.

Light Gray Canvas Map. Provides a light gray neutral background. This is the default
basemap.

World Imagery with Labels. Provides a detailed World Imagery map layer with labels.

Oceans Map. Provides a background designed to be used as a reference map for ocean
data.

Open Street Map. Provides the OpenStreetMap community map layer.
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National Geographic World Map. Provides a general reference map from National
Geographic.

World Imagery. Provides a detailed World Imagery map layer.

World Street Map. Provides a multiscale street map for the world.

Terrain with labels. Provides a terrain base map with labels.

World Topographic Map. Provides a topographic map.

You can also add a custom basemap, as described in Configuring Geographic Information on
page 920.

Reference: Configuring Whether Selections on a Map Are Required to Run a Request

When selections on a map trigger a request to run, you can configure whether clearing the
selections reruns the request. To specify whether to rerun the request, use the Selection
Required property on the Properties panel for the map object.

"Selection Required" = yes runs the request only when features have been selected on the
map. When you click Clear Selection in the Selection Widget, the request is not run again.

"Selection Required" = no always runs the request. When you click Clear Selection in the
Selection Widget, the request is run again.
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Reference: Defining the Esri Component Layers

To define the layers that will display on your map component, you use the ESRI Object Settings
panel, shown in the following image: 
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On this panel, you configure:

The layers that will display on your map component.

Add a layer by clicking the New Layer icon at the top of the panel, and remove a selected
layer by clicking the X at the top of the panel. You can change the default layer name by
selecting the default name, clicking it, and typing over it when the edit box displays.

The visualizations for each layer.

The symbology used for each layer.

Using the arrow keys at the top of the panel, you can control the order of layers on the
resulting map.

Using Unified Geographic Roles

In addition to configuring standard Esri map services, the Reporting Server hosts and
configures geographic boundaries for 58 World Administrative regions. You can use these files
to generate Esri maps in App Studio. To support using these administrative boundaries in
maps that can show geographic locations down to the postal code level, the list of geographic
roles has been simplified and unified.

The server provides a Geographic Configuration Editor tool for uploading and configuring
additional shapefiles and geographic roles, basemaps, and demographic layers. For
information, see Configuring Geographic Information on page 920.

The list of geographic roles has been simplified and unified by adding hierarchical levels of
keys in the server geographic configuration file. Your request that provides the geography
dimension must provide the hierarchical keys needed to identify each target geography. For
example, if your geographic role is City, you must also provide values for State and Country.

The following is the list of unified geographic roles is available for generating maps:

Point of Interest.

City.

Continent.

Country.

County.

Geometry line.

Postal code.
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State.

Note: App Studio does not support aliasing or name variations in geographic roles. Users have
to cleanse the data and provide the right values for all the georoles. Only Names are
supported.

There is support for the lowest Administrative Level listed for the following countries:

Country Postal Code

(Number of Values)

Administrative Level

(Number of Values)

Argentina 5 - digit (1963) Departamentos (525)

Australia 4 - digit (2652) Local Government Areas
(569)

Belgium 4 - digit (1146) Arrondissements (43)

Brazil 5 - digit (17892) Municipios (5565)

Canada 3 - digit (1629) Census Divisions (293)

Denmark 4 - digit (1078) Kommuner (99)

Finland 5 - digit (3041) Seutukunnat (70)

France 5 - digit Cantons (1972)

Germany 5 - digit (8201) Municipilaties

Gibraltar 3/4/5 - digit (1)

Holy See (Vatican City State) 5 - digit (1)

India 6 - digit (20509) Districts (640)

Italy 5 - digit (4600) Provincias (110)

Japan 3 - digit (937) Prefectures (47)

Netherlands 4 - digit (4044) COROP Regions (40)

Portugal 4 - digit (507) Concelhos (308)

Serbia 5 - digit (1)
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Country Postal Code

(Number of Values)

Administrative Level

(Number of Values)

Spain 5 - digit (10866) Provincias (52)

Sweden 5 - digit (9876) Kommuner (290)

Switzerland 4 - digit (4078) Bezirke (148)

Taiwan 3 - digit (365) Township Districts (368)

United Kingdom 2 - digit Districts (391)

Albania 2 - digit (33) Qarke (12)

Andorra 5 - digit (7) Parroquies (7)

Austria 4 - digit (2216) Politische Bezirke (117)

Belarus 6 - digit (3417) Woblaszi (7)

Bosnia and Herzegovina 5 - digit (558) Kantone (18)

Chile 2 - digit (78) Provincias (54)

China 2 - digit (59) Counties City Districts
(2855)

Costa Rica 2 - digit (13) Cantones (81)

Croatia 2 - digit (20) Zupanije (21)

Cyprus 2 - digit (43) Eparchia (6)

Czech Republic 2 - digit (59) Orp (206)

Estonia 5 - digit (5318) Maakonnad (15)

Greece 5 - digit (1046) Nomoi (75)

Hong Kong 6 - digit (1) Shih Zizhiqu (18)

Hungary 2 - digit (83) Kistersegek (175)

Iceland 2 - digit (63) Landsvaedi (8)
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Country Postal Code

(Number of Values)

Administrative Level

(Number of Values)

Kenya 1 - digit (10) Wilaya (47)

Korea, Republic of 3 - digit (244) Si Gun (230)

Latvia 2 - digit (28) Rajons (33)

Liechtenstein 4 - digit (13) Landschaften (2)

Lithuania 2 - digit (93) Apskritys (10)

Luxembourg 4 - digit (4070) Cantons (12)

Macedonia, the former
Yugoslav Republic of

2 - digit (17) Statisticki Regioni (8)

Malta 3 - digit (72) Districts (6)

Mexico 3 - digit (954) Estados (32)

Monaco 5 - digit (1) Quartiers (9)

Montenegro 2 - digit (3) Opstina (21)

New Zealand 4 - digit (1064) Territorial Authorities (68)

Norway 4 - digit (3210) Okonomisk regioner (89)

Poland 5 - digit (20392) Gminy (2479)

San Marino 5 - digit (10) Castelli (9)

Singapore 2 - digit (79) Regions (5)

Slovakia 2 - digit (24) Okresy (79)

Slovenia 2 - digit (22) Statisticne Regije (12)

South Africa Postcodes2 (95) Municipalities (234)

Turkey 5 - digit (2876) Iller (81)
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Example: Creating a Map of World Cities

The following request, city1.fex, retrieves world city names, state names, and country names.

TABLE FILE wf_retail_lite
SUM COGS_US REVENUE_US
FST.CITY_NAME
BY COUNTRY_NAME
BY STATE_PROV_NAME
ON TABLE PCHOLD FORMAT XML
END
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The following Settings panel for the HTML page that will generate the map is shown in the
following image. CITY_NAME is the field that matches the geographic role. The keys needed to
correctly identify each city are State (STATE_PROV_NAME field) and Country (COUNTRY_NAME
field).
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Running the HTML page generates the following map.

Configuring a Map Data Layer

For each data layer that you place on your map component, you create an external WebFOCUS
request that generates location or point values and any other values you want to use on your
layer. The request must provide these values to the browser in XML format. You add this
request to the map component in the Requests & Data Sources panel.

In the top section of the ESRI Object Settings panel, you configure the geographic role, the
external request to be used for the geographic values of interest, and attributes for the layer.

Descriptions of the layer settings in the ESRI Object Settings panel follow.

Layers

Description. Is a unique name for the layer.

Type of field. Textfield VARCHAR2(20).

Required? Yes.

Populated by. User.

Limits. Maximum length = 20 characters. Special characters (' " \ / * + ? ^ $ [ ] ( ) { } < >
| & ,) are not allowed.

Example. Customer

Request

Description. Name of the request that provides locations or points.
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Type of Field. Drop-down list.

Required? Yes.

Populated by. System defined.

Limits. Defined earlier in the Requests & Data Sources panel to an external WebFOCUS
Procedure that outputs the values to the browser in XML format.

Example. customer_locations

Geographic Role

Description. Geography lookup column. By default, a unified list of geographic roles is
available for 58 World Administrative boundaries down to the postal code level.

Type of Field. Drop-down list.

Required? Yes.

Populated by. System Defined.

Limits. Choices are:

Point of Interest (Latitude/Longitude)

Note: Latitude and Longitude fields must be assigned a numeric data type.

City

Continent

Country

County

Geometry Line

Postal Code

State

You can also add customized geographic roles, basemaps, and context layers.
Geographic roles can be defined for existing Esri maps or for shapefiles that you upload
to the Reporting Server. For information, see Configuring Geographic Information on
page 920. Private custom geographies will only be available after authenticating
against ArcGIS Online or Esri on Premise credentials.

Example. Latitude/Longitude
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Column(s) that match the role

Description. Column or columns in the request that will provide values for the geographic
role.

Type of Field. Drop-down list box.

Required? Yes.

Populated by. System Defined.

Limits. Must be fields that are available in the request.

Example. LATITUDE/LONGITUDE

Unique ID

Description. This is the field that will be used as a parameter for other requests.

Type of Field. List box.

Required? Yes, for Point of Interest layers, no otherwise.

Populated by. System defined.

Limits. Must be a field available in the request.

Example. ID_CUSTOMER

Layer Attributes

Description. These are fields in the request that will appear in popups when a point or
location is clicked and the Enable Popups visualization is turned on. You can multi-select
fields using the Shift key and Ctrl key. Click the green button at the bottom to apply your
selections, or the red button to cancel your selections. The selection dialogue box is
shown in the following image.
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Note: In order to display customized names rather than field names in the popup, the
custom names must be defined with the TITLE attribute in the Master File. The TITLE
attribute cannot contain any commas. Using an AS name in the request to create a custom
name is not supported in the infoWindow.

Type of Field. List box.

Required? No.

Populated by. System defined.

Limits. Must be fields available in the request.

Example. COGS_US
Example: Configuring a Point of Interest Map Layer

This example configures a map layer using longitude and latitude point values that come from
an external WebFOCUS request named customer_locations.fex. 

You can create a request using the Report Canvas or by entering request syntax in the Text
Editor. For information about creating a WebFOCUS report request using the Report Canvas,
see Creating Reports on page 229.

Following is the syntax for the customer_locations procedure. Note that the fields that return
the longitude and latitude values must be named LONGITUDE and LATITUDE, and that a
request that returns these values for the geographic points must also have a unique ID field, in
this case ID_CUSTOMER. The values must be returned to the browser in XML format. Paste
this procedure into the Text Editor and save it as customer_locations.fex:

TABLE FILE WF_RETAIL_LITE
PRINT ID_CUSTOMER     
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY   STATE_PROV_NAME 
BY   ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE PCHOLD FORMAT XML 
END

Configuring a Map Data Layer

758  Information Builders



First, add the external WebFOCUS procedure customer_locations.fex to the HTML page using
the Requests & Data Sources panel, as shown in the following image:

Next, use the Settings panel to configure the map layer. The layer uses the default
visualizations and symbology, so only the top portion of the ESRI Object Settings panel needs
to be configured.

Each layer has a default name. To change the layer name, select and type over the default
name. The geographic role to use when you provide latitude and longitude values in your
request is called Point of Interest. The following image shows the configured Customers layer
with the layer name changed and the geographic role configured:

Note: For any Spatial Coordinate System under Layer Settings other than 4326 for a point of
interest layer, please use an internally hosted Geometry Service. This will require projection on
the fly. For more details about Geometry Service please see http://server.arcgis.com/en/
server/latest/publish-services/linux/about-the-geometry-service.htm.
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Run the HTML page. The output is shown in the following image:

Example: Configuring a US State Map Layer

This example configures a map layer using U.S. state names.

You can create a request using the Report Canvas or by entering request syntax in the Text
Editor. For information about creating a WebFOCUS report request using the Report Canvas,
see Creating Reports on page 229.

Following is the syntax for a WebFOCUS procedure that returns the state name for U.S. states.
Paste this procedure into the text editor and save it as customer_states.fex.

TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY STATE_PROV_NAME  
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE PCHOLD FORMAT XML
END
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First, add the external WebFOCUS procedure customer_states.fex to the HTML page using the
Requests & Data Sources panel.

Next, use the Settings panel to configure the map layer. The layer uses the default
visualizations and symbology, so only the top portion of the ESRI Object Settings panel needs
to be configured.

Each layer has a default name. To change the layer name, select and type over the default
name. The geographic role to use when you provide state names in your request is called
State. The field in the request that matches the geographic role is STATE_PROV_NAME. Since
the request screens only states where COUNTRY_NAME is 'United States', you can select that
as the user-defined value for Country in the Settings panel. The following image shows the
configured CustState layer:
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Run the HTML page. The output is shown in the following image:

Example: Configuring a Geometry Line Layer

In addition to drawing polygons and points on an Esri map, you can draw geography lines.
Lines are used to represent the shape and location of geographic objects such as
transmission lines, streets, pipelines, and routes. A line is built by joining two or more points.
The geographic role used for lines is called Geometry line in the Esri map Settings panel.

The request used to create the geometry lines uses a .csv file named
201709_citibike_tripdata that contains information about bike trips between bike stations. The
following image shows partial data from this file.
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The Master File contains the following DEFINEs that generate the geometry points and
geometry lines using the GIS_POINT and GIS_LINE functions.

DEFINE WKID/A10='4326';
           TITLE='WKID', $
DEFINE START_STATION_POINT/A200=GIS_POINT(WKID, START_STATION_LONGITUDE, 
START_STATION_LATITUDE); GEOGRAPHIC_ROLE=GEOMETRY_POINT,  $
DEFINE END_STATION_POINT/A200=GIS_POINT(WKID, END_STATION_LONGITUDE, 
END_STATION_LATITUDE); GEOGRAPHIC_ROLE=GEOMETRY_POINT,  $
DEFINE CONNECTION_LINE_A/A200=GIS_LINE(START_STATION_POINT, 
END_STATION_POINT); GEOGRAPHIC_ROLE=GEOMETRY_LINE,  $

The following request is used with the map.

TABLE FILE 201709_citibike_tripdata
SUM TRIPDURATION
FST.GENDER
FST.BIKE_PATH_ID AS 'BIKE_PATH_ID'
FST.START_STATION_NAME AS 'start station name'
FST.END_STATION_NAME AS 'end station name'
BY CONNECTION_LINE_A
WHERE END_STATION_LATITUDE NE 0;
WHERE END_STATION_LONGITUDE NE 0;
WHERE START_STATION_NAME EQ 'Newport Pkwy'
ON TABLE PCHOLD FORMAT XML
END
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The following image shows the Esri Settings panel that uses this request with the Geometry
line georole, using the default layer visualizations and symbol settings.
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The output is shown in the following image.

Adding a Demographic Layer to a Map

Esri demographic data enables you to add info-layers to a map that provide global
demographic, spending, lifestyle, and business data on your map application.

Procedure: How to Configure a Demographic Layer on an Esri Map

Once you have added an Esri map component to your HTML page, you can add one or more
preconfigured demographic layers.

1. In the Settings panel for the Esri map component, click the arrow next to the New Layer
icon and select Demographic Layer, as shown in the following image.
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The layer is created with a default name. You can rename the layer by clicking in the
default name and typing a new name.

2. Select a type of demographic layer from the Layer group pull-down list, as shown in the
following image.

3. Select a layer name from the Layer name pull-down list, as shown in the following image.

Note: If the layer is not freely available from Esri, you will be asked to provide your Esri
credentials before the layer can be added to the map.

4. Configure the layer visualizations you require, such as the transparency of the layer and
the default visibility.
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5. Save the HTML page.

When you run the HTML page, the demographic layer is added to the map output, as
shown in the following image.

Note: You may need to adjust the transparency values for each layer to make them all
visible.
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6. To open the demographic layer table of contents open the Change Base Maps widget and
select the Info Maps tab, as shown in the following image
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The following options are available on the Info Map table of contents.

Description Icon Example

Toggle Layer Legend

This icon toggles the
legend on and off.

Show Description

This icon toggles a layer
description on and off.

Visibility

This icon toggles the layer
visibility on and off.

Using Map Widgets

When you generate a map, a set of map widgets is generated that let you interact with the
map output. The following table describes each widget.

Widget Name Image Description

Default Extent Toggles between the default extent
(entire layer) and the extent that
includes the majority of points for the
layer.
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Widget Name Image Description

Table of Contents Opens a list of layers, their properties,
and an icon for opening a set of layer
tools. The tools differ depending on
the type of layer. In the layer list, this
widget toggles between showing the
list and hiding the list.

Selection Tools Provides selection tools and options
based on the layer type.

Change Base Map Opens thumbnails of the available
map base layers and lets you select a
new one, as shown in the following
image.
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Widget Name Image Description

Find my location
(Geolocation widget)

Zooms the map to your current
location.

Note: The Geolocation widget is
removed by the Esri API if this feature
is not supported by the browser or is
not used in a secure (https)
environment. For example, Chrome 50
or higher no longer supports obtaining
the location using the HTML5
Geolocation API from pages delivered
by non-secure connections. The widget
also does not work in the run-time Esri
Viewer with Safari browsers on mobile
devices.

Zoom in Increases the zoom level.

Zoom out Decreases the zoom level.

Close Closes the widget.

Reference: Layer Tools and Options

The following shows the options for a polygon layer in the table of contents:

The following shows the options for a point layer in the table of contents:
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The visible icons when you first open this widget are:

A polygon or point, which identifies this layer as a layer with polygon or point geometry.

A check box for showing or hiding the layer on the map.

The layer name.

The Show Tools icon. Clicking this icon toggles the tools widgets on and off.

The following image shows the table of contents widget with the tools widgets toggled on:

Option Name Image Description

Show tools Toggles the layer tools widgets on and
off.

Toggle layer legend Toggles the layer legend on and off.
The layer legend shows the fields,
markers, colors, and sizes
represented on the map layer. For
example:

 

 

Toggle options Shows or hides the layer visualization
options.
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Option Name Image Description

Zoom to layer extent Zooms to the extent configured for the
layer.

The following layer options are available.

Option Name Image Description

Opacity slider Enables you to adjust the layer
transparency.

Cluster (points only) Click the button to invoke clustering
(markers are combined into cluster
markers, depending on the range of
points they represent and the zoom).

A green button on the right shows that
this option is selected, and an icon
displays on the layer table of
contents.

Heat layer (points only) Click the button to draw a heat map
depicting the concentration of points.
The areas of highest concentration will
be red, the next highest will be yellow.

A green button on the right shows that
this option is selected.
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The following image shows cluster markers. The points are categorized into ranges and the
cluster markers are colored according to the range of points they represent.
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The following image shows a heat layer.

Reference: Selection Tools and Options

The selection widget has a drop-down list for selecting the layer on which to make a selection.

The following image shows the selection tools for a polygon layer.
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The following image shows the selection tools for a point layer.

The following selection tools and options are available.

Option Name Image Description

Zoom to layer extent Zooms to the extent configured for the
layer.

Select features within
an extent

Selects map points or locations
included in a rectangle. To draw a
rectangle, drag from the starting
position to the ending position on the
map and release the mouse pointer.

Select features within
a polygon

Selects map points or locations
included in a polygon. To draw a
polygon, click each position on the
map where you want a vertex. Double-
click to complete the polygon at the
last vertex you want to add.
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Option Name Image Description

Select features within
a distance (point
geography only)

When this option is selected, a
distance text box opens. You can
select miles or kilometers from a drop-
down list, and enter a distance. For
information, see Changing Default
Distance Settings From Miles to
Kilometers on page 778.

When you double-click a point, the
map zooms to show the points at that
distance around the selected point.

Note: There is no validation of the
characters you enter in the text box.
Make sure you enter valid numbers.

Select features
intersecting a line
(polygon geography
only)

Selects polygons that intersect a line.
To draw a line, click at the starting
position, and double-click at the
ending position.

Select features to
delete

Deletes previously selected points or
locations within a rectangle that you
draw over selected points or locations.

Pan Switches from making selections to
panning when you click and drag on
the map layer.

Clear selection Clears all selections.

Note: If making selections triggers a
report to run, you can specify whether
the report should be rerun when the
selections are cleared. For details,
see Configuring Whether Selections on
a Map Are Required to Run a Request
on page 747.
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Option Name Image Description

Zoom to Selection Identifies the number of points or
locations selected. If you click this
button, the map zooms in to the
selection.

Reference: Changing Default Distance Settings From Miles to Kilometers

In the Esri Viewer Selection widget, you can select features within a distance of a point you
select on the map, as shown in the following image.

Although you can select either the miles or kilometers distance unit from the drop-down list in
the widget, the default unit in which the distance is shown is determined by your browser
locale settings. For example, if your browser language is United States English, the distance
will be shown as miles, but if your language is Australian English or United Kingdom English,
the distance will be shown as kilometers.

For information about configuring locale settings in your browser, see the help content for your
browser.

Configuring the Map Menu

You can change background and hover colors of icons in the map menu by editing the .css
classes that represent the menu components. To edit the .css class definitions, you can use
the Embedded CSS tab on the HTML page that contains the map component or reference an
external .css file.
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To embed .css classes in the HTML page, click the Embedded CSS tab at the bottom of the
HTML page. The default embedded CSS tab is shown in the following image.

Add your customized classes outside of the .internal_default class (for example, starting on
line 3).

To create a new .css file, right-click an application in a domain, point to New, and select
Cascading Style Sheet from the context menu, as shown in the following image.
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The new .css file opens, as shown in the following image.

Add your customized classes outside of the body tag (for example, starting on line 4).

After you save the .css file, you can reference it in the HTML page:

1. Click on the HTML page outside of any of its components.

2. Open the Settings panel and click the .css icon, as shown in the following image.

The Open File dialog box opens.

3. Navigate to the application that contains the .css file, select the .css file, and click OK.

The .css file is added to the CSS Files list in the Settings panel.
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Reference: Map Menu Classes

This section describes the classes that color the map widgets. You can type them into the
Embedded CSS tab of the HTML page that contains the map, or you can access an
external .css file.

If you add them to an external .css file, place them outside of the body tag.

The following table lists the map menu classes with an image of the map menu component
affected by that class. The affected areas are outlined in or colored red.

Class Name Class Description Class Image (Outlined in or
Colored Red)

.mainMenuColor Main menu container colors

.HomeButton Home button hover color

.layersWidget Layers (Table of Contents)
button hover color

.selectionWidget Selection button hover color

.basemapBtn Basemap button hover color

.LocateButton .zoomLocateB
utton

Locate button hover color
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Class Name Class Description Class Image (Outlined in or
Colored Red)

.lyrCheckBoxColors Check boxes to turn layers
on and off in Table of
Contents

.lyrContainerColors Color of each layer container
in the Table of Contents
widget

.optionsListColors
Layer options box container
background color

.stContentColor Selection tools content
background color

.selectionInfoColors Number of selected features
box

.tabsHeaderColors Background color of
Basemaps and Info Maps
tabs
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Class Name Class Description Class Image (Outlined in or
Colored Red)

.imTabsTitlesColors Button color of Basemaps
and Info Maps tabs

.imContentColor Background color of the
Basemaps and Info Maps
content area.

.imActive Color of the active button,
either the Basemaps and
Info Maps tab
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Class Name Class Description Class Image (Outlined in or
Colored Red)

.dojoxFloatingPaneTitle Background and border
colors of the title pane of all
widgets

.esriPopup .titlePane Background color of the title
pane in the Esri pop-up
window

.tocContentColor Background color of the
content area in the Table of
Contents widget

.WidgetOn Color of any button in the
main menu when its
corresponding widget is
active
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Reference: Default Map Widget Class Definitions

The following syntax shows the .css definitions for the colors of the components in the map
menu. You can replace any color definition using a hexadecimal color value, an RGBA color
value, or a color name. Some classes contain multiple background color properties in order to
support browsers that may require color definitions in different formats (hexadecimal or RGBA).
The default color definitions are the same in both formats.

/*MAIN MENU STYLES*/

/*main menu container colors*/
.mainMenuColor{
    border-color: #FFFFFF;
    border-left-color: #66b2ff;
    background: #66b2ff;
}

/*Color of the home button in the main menu when mouse hovers*/
.HomeButton .home:hover {
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}

/*Color of the button in the main menu that invokes the table of contents 
widget when mouse hovers*/
.layersWidget:hover {
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}

/*Color of the button in the main menu that invokes the selection widget 
when mouse hovers*/
.selectionWidget:hover {
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}
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/*Color of the button in the main menu that invokes the basemaps widget 
when mouse hovers*/
.basemapBtn:hover {
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}

/*Color of the locate button in the main menu when mouse hovers*/
.LocateButton .zoomLocateButton:hover {
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}

/*Color any button in the main menu when its corresponding widget is 
active*/
.WidgetOn {
    background-color: #023858;
    background-color: rgba(2, 56, 88,1);
}

/*Color any button in the main menu when its corresponding widget is active 
and mouse hovers*/
.WidgetOn:hover {
    background-color: #023858;
    background-color: rgba(2, 56, 88,1);
}

/*background color of the content area in the Table-Of-Contents widget*/
.tocContentColor{
    background-color: #c9dbdf;
}

/*style of each layer container in the Table-Of-Contents widget*/
.lyrContainerColors{
    background-color: white;
    border-color: #00b2f3;
    color: #66b2ff; /*text color. All child nodes will inherit this color*/
}

/*check boxes to turn On and Off layers in Table-Of-Contents widget*/
.lyrCheckBoxColors{
    border-color: #66b2ff;
    color: #66b2ff;
}

/* layer options box container background color*/
.optionsListColors{
    background-color: rgba(243, 10, 21, 0.19);
}

Configuring the Map Menu

786  Information Builders



/*selection tools content background color*/
.stContentColor{
    background-color: #c9dbdf;
}

/*number of selected features box*/
.selectionInfoColors{
    color: #cd5c5c;
    border-color: #cd5c5c;
}

/*BASE MAPS WIDGET*/

/*basemaps and info-maps tabs background color */
.tabsHeaderColors{
    background-color: #66b2ff;
}

/*base-maps and info-maps tabs buttons colors*/
.imTabsTitlesColors{
    color: #ffffff;
    background-color: transparent;
}

/*base-maps and info-maps tabs buttons active colors*/
.imActive{
    background-color: #5390cf;
    border: 1px solid white;
}

/*base-maps and info-maps tabs buttons hover colors*/
.imTabsTitles:hover{
    background-color: #5390cf;
    background-color: rgba(83, 144, 207,1);
}

/*base-maps and info-maps content area background color*/
.imContentColor{
    background-color:  #00ff00;
}

/*Title pane of all widgets*/
.dojoxFloatingPaneTitle {
    background-color: #023858;
    border-color: #ffffff;
}

/*title pane in the esri pop-up window*/
.esriPopup .titlePane{
    background-color: #66b2ff; !important;
}
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Example: Changing the Map Menu Background Color

Place the following CSS commands above the .internal_default CSS command on the
Embedded CSS tab of the map object to make the background color of the map menu cyan.

.mainMenuColor{
 border-color: #FFFFFF;
 border-left-color: #66b2ff;
 background: cyan;
 }

The menu generated when you run the HTML page is shown in the following image.

Example: Changing the Hover Color of the Home (Default Extent) and Layers Buttons

The following .HomeButton .home:hover class changes the background hover color of the
Home (Default Extent) button to orange and the .layersWidget:hover class changes the
background hover color of the Layers (Table of Contents) widget to yellow.

.HomeButton .home:hover {
 background-color: orange;
 }
.layersWidget:hover {
 background-color: yellow;
 }

The following image shows the background hover color of the Home button:

The following image shows the background hover color of the Table of Contents button:
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Example: Coloring a Button When its Widget is Active

The following .WidgetOn class makes any button green when its widget is active.

.WidgetOn {
  background-color: green;
 }

The following image shows that the Table of Contents widget is green when the Table of
Contents is open.

Example: Changing the Background Color of the Table of Contents Content Area

The following .tocContentColor class makes the area directly around the layer container purple.

.tocContentColor{
 background-color: purple;

The following image shows the Table of Contents widget with the background color purple.

Example: Styling the Layer Containers

The following class definition makes the layer container background color yellow, the border
orange, and the text red.

.lyrContainerColors{
 background-color: yellow;
 border-color: orange;
 color: red;
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The following image shows a layer container whose background color is yellow, border color is
orange, and text color is red

Example: Styling the Widget Title Panes

The following class definition makes the background color of the title pane burlywood and the
border color navy.

.dojoxFloatingPaneTitle {
 background-color: burlywood;
 border-color: navy;

The following image shows the selection widget. Its title pane has a navy border and burlywood
background color.

Example: Changing the Background Color of the Pop-up Window Title Panes

The following class definition makes the background color of the pop-up window title panes
magenta.

 .esriPopup .titlePane{
 background-color: magenta;
 !important;
 }
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The following image shows a pop-up window with a magenta title pane.

Using IbComposer Functions to Invoke Map Menu Options

The following ibComposer functions invoke map menu options using API calls.

Toggle layer visibility. IbComposer_toggleLayer('mapId', 'layerId')

Toggle heatmap visibility on a layer. IbComposer_toggleHeatLayer('mapId', 'layerId',
'options')

Toggle visibility of clustering on a layer. IbComposer_toggleCluster('mapId', 'layerId',
'options')

Make selections on a layer by shape. IbComposer_selectLayerByShape(mapId, layerId,
shape)

Make selections on a layer by distance. IbComposer_selectByDistance('mapId', 'layerId',
'distance', 'units')

Clear a subset of selections. IbComposer_clearSelected('mapId', 'layerId')

Clear all selections. IbComposer_clearAllSelection('mapId', 'layerId')

Change basemap. IbComposer_changeBaseMap('mapId', 'baseMapName')

Procedure: How to Enable Map Menu Functions

By default, the map menu widgets display on the map output. You can prevent them from
automatically displaying so they can be controlled using the ibComposer functions.

1. With the Esri component selected on the HTML page, open the Properties panel.
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2. Change Map: Show Map Widgets to No, as shown in the following image.

Procedure: How to Invoke Map Menu Functions

The map menu functions must be invoked from a control on the HTML page that contains the
Esri map component.

Syntax: How to Toggle Layer Visibility on a Map

IbComposer_toggleLayer('mapid', 'layerid');

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'layerid'

Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
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Example: Toggling Layer Visibility

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
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On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add a button to the HTML page, and add the Click event in the Properties panel for the button,
as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the
IbComposer_toggleLayer function to the button1_onclick function, as shown in the following
image.
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Run the HTML page. The output is shown in the following image.
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Click the button. The layer is no longer visible, as shown in the following image.

Clicking the button again will make the layer visible again.

Syntax: How to Toggle Heatmap Visibility on a Map

IbComposer_toggleHeatLayer('mapid', 'layerid', options);

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'layerid'

Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
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'options'

Is an object with the following two properties.

{field: 'fieldname', colors: colorStops }

where:

field: 'fieldname'

Is the name of a numeric attribute field used to weight the heatmap points.

colors: colorStops

Is an array of color Stops objects describing the color ramp for rendering the heatmap
gradient. For example:

colors: ["#feebe2","#f768a1","#7a0177"]

Example: Toggling Heatmap Visibility

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
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On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add a button to the HTML page, and add the Click event in the Properties panel for the button,
as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the
IbComposer_toggleHeatLayer function to the button1_onclick function, as shown in the
following image.
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Run the HTML page. The output is shown in the following image.
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Click the button. The heatmap is now visible, as shown in the following image.

Clicking the button again will make the heatmap not visible again.

Syntax: How to Toggle Cluster Visibility on a Map

IbComposer_toggleCluster('mapid', 'layerid', options);

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'layerid'

Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
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options

Is an array of objects containing the properties of each cluster class. Following are the
properties of each cluster class:

{ min: minvalues, max: maxvalues, size: circlesize, color: [r, g, b] }

where:

min: minvalues

Are the minimum values (point locations) to group in this class.

max: maxvalues

Are the maximum values (point locations) to group in this class.

size: circlesize

Is the size of the circle symbol in this class.

color: [r, g, b]

Is the rgb value for the color of the circle symbol in this class.

For example:

[ ...
,
{ min: 10, max: 30, size: 35, color: [128, 255, 0] } 
,
{ min: 30, max: 100, size: 45, color: [255, 51, 51] } 
]

Example: Toggling Cluster Visibility

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.
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In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.

On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add a button to the HTML page, and add the Click event in the Properties panel for the button,
as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the
IbComposer_toggleCluster function to the button1_onclick function, as shown in the following
image.
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Run the HTML page. The output is shown in the following image.
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Click the button. The clusters are now visible, as shown in the following image.

Clicking the button again will make the clusters not visible again.

Syntax: How to Make Selections on a Map Using a Shape

IbComposer_selectLayerByShape('mapid', 'layerid', 'shape');

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'layerid'

Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
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'shape'

Is one of the following valid selection shapes.

'POLYGON'

'POLYLINE'

'FREEHAND_POLYLINE'

'FREEHAND_POLYGON'

'EXTENT'

Example: Making Selections on a Map Using a Polygon

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
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On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add a button to the HTML page, and add the Click event in the Properties panel for the button,
as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the
IbComposer_selectLayerByShape function to the button1_onclick function, as shown in the
following image.
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Run the HTML page and click the button. Then click on the map in each position that you want
a vertex of the polygon, as shown in the following image.
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Double-click to end the selection process. The points within the polygon are highlighted, as
shown in the following image.

For information on clearing your selections, see How to Clear Selections on a Map on page
817.

Syntax: How to Make Selections on a Map By Distance

This function is used to select a distance when the selection shape is a circle.

IbComposer_selectByDistance('mapid', 'layerid', distance, 'units');

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'layerid'

Is the layer ID from the Settings panel of the Esri component, for example, Layer1.
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distance

Is the distance expressed in the specified units (see below).

'units'

Is one of the following valid distance units.

'esriMeters'

'esriKilometers'

'esriInches'

'esriFeet'

'esriYards'

'esriMiles'

'esriNauticalMiles'

'esriMillimeters'

'esriCentimeters'

'esriDecimeters'

Example: Making Selections on a Map by Distance

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
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On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add a button to the HTML page, and add the Click event in the Properties panel for the button,
as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the
IIbComposer_selectLayerByDistance function to the button1_onclick function, as shown in the
following image. The selection distance shown is 100 miles.
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Run the HTML page. The output is shown in the following image.
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Click the button, then click on the map at the point that you want to be the center of the circle
where the points will be selected. The map is zoomed, and the points within the circle are
highlighted, as shown in the following image.

For information on clearing your selections, see How to Clear Selections on a Map on page
817.

Syntax: How to Clear Selections on a Map

Once you have made selections on a map, you have two choices for clearing selections.

You can clear all of the selections.

You can select a subset of the previously selected features and deselect only that subset
of features, leaving the other features still selected.

To clear a all selections, use the IbComposer_clearAllSelection function.

IbComposer_clearAllSelection('mapid', 'layerid');
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To clear a subset of the selected features, use the IbComposer_clearSelected function. This
enables you to select a subset of the previously selected features and clear only that subset.

IbComposer_clearSelected('mapid', 'layerid');

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'layerid'

Is the layer ID from the Settings panel of the Esri component, for example, Layer1.

Example: Clearing Selections on a Map

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
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On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add three buttons to the HTML page. For each button, add the Click event in the Properties
panel for the button, as shown in the following image.

The first button will create a selection based on the polygon shape. Name that button Select
Polygon. Click the Embedded JavaScript tab at the bottom of the window and add the
IbComposer_selectLayerByShape function to the button1_onclick function, as shown in the
following image.

Name the second button Clear Selected. For the second button, add the
IbComposer_clearSelected function to the button2_onclick function, using the following syntax.

IbComposer_clearSelected('emfobject1', 'Layer1'); 
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Name the third button Clear All. For the third button, add the IbComposer_clearAllSelection
function to the button3_onclick function, using the following syntax.

IbComposer_clearAllSelection('emfobject1', 'Layer1'); 

Run the HTML page. The output is shown in the following image.
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Click the Select Polygon button and select points, as shown in the following image.
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Click the Clear Selected button, and select some of the previously selected points, as shown in
the following image.
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Those points have been deselected, as shown in the following image.
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To clear all remaining selections, click the Clear All button. All selections are cleared, as
shown in the following image.

Syntax: How to Change the Basemap

 IbComposer_changeBaseMap('mapid', 'basemapname');

where:

'mapid'

Is the map unique identifier from the Properties panel of the Esri component, for example,
emfobject1.

'basemapname'

Is the name of one of the standard basemaps supplied with App Studio or the name of a
customized basemap configured by the user. Standard basemap names are:

'streets'

'satellite'

'hybrid'

'terrain'
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'topo'

'gray'

'dark-gray'

'oceans'

'national-geographic'

Example: Changing the Basemap

The following request named customer_locations will be used to generate a data layer on an
Esri map.

TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     COGS_US
     QUANTITY_SOLD
     COMPUTE LONGITUDE/D12.2 =CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY  STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Create a new HTML page, add an Esri map component, and add the external WebFOCUS
request named customer_locations in the Requests & Data Sources panel.

In the Settings panel, configure the layer (by default, named Layer1) to use this request, with
the Point of Interest geographic role, and the unique ID field ID_CUSTOMER.
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On the Properties panel for the Esri map component, set Show Map Widgets to No, as shown
in the following image.
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Add a button to the HTML page, and add the Click event in the Properties panel for the button,
as shown in the following image.

Click the Embedded JavaScript tab at the bottom of the window and add the
IbComposer_changeBaseMap function to the button1_onclick function, as shown in the
following image.
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Run the HTML page. The output is shown in the following image.
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Click the button. The basemap changes, as shown in the following image.

Configuring Layer Visualizations

The visualizations available in a map layer depend on the layer type.

The following image shows the Layer Visualizations section of the ESRI Object Settings panel.
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A list of layer visualizations you can configure in the Layer Visualizations section of the ESRI
Object Settings dialog box follows.

Clustering

Description. Enables clustering (grouping of symbols) on the selected layer.

Type of Field. Boolean.

Populated by. User.

Limits. On/Off. Default is Off.

Example. On

Transparency

Description. Transparency of the layer.

Type of Field. Numeric.

Populated by. User.

Limits. Values 0 - 100. 100 is 100% opaque, and 0 is 100% transparent. Default is 50.

Example. 50

Add Heatmap

Description. Applies to Point of Interest and Cities geographic roles. Colors the areas
around the points using a gradient in which the intensity of the color is based on the
concentration of points.

Type of Field. Boolean.

Populated by. User.

Limits. On/Off. Default is Off.

Example. Off

Enable Popups

Description. Shows an InfoWindow with the values of the layer attribute fields when a
polygon or point is clicked.

Type of Field. Boolean.

Populated by. User.

Limits. On/Off. Default is Off.

Example. Off

10. Creating Esri Maps

WebFOCUS App Studio User’s Manual  831



Default Visibility

Description. Makes the layer initially visible or not visible.

Type of Field. Boolean.

Populated by. User.

Limits. On/Off. Default is On.

Example. On

Default Extent 
Description. If Default Extent is Off, the map view is the extent of the first layer loaded. If
it is On, the map view is the full layer. The map extent is determined as follows:

If there are no layers, the extent is the entire map.

If any layer is configured with the default extent, the extent is determined by that layer
data.

If there are one or more layers and no layer is configured with the default extent, the
extent is determined by the data for the first layer.

Type of Field. Boolean.

Populated by. User.

Limits. On/Off. Default is Off.

Example. Off

Spatial Coordinate System

Description. Is the id of coordinate system used by the WebFOCUS procedure to provide
geographic data. For information about coordinate systems available with Esri, see https://
developers.arcgis.com/javascript/jshelp/ref_coordsystems.html.

Note: For any Spatial Coordinate System under Layer Settings other than 4326, please
use an internally hosted Geometry Service. This will require projection on the fly. For more
details about Geometry Service please see http://server.arcgis.com/en/server/latest/
publish-services/linux/about-the-geometry-service.htm.

Type of Field. ID.

Populated by. User.

Limits. Default option is decimal degrees (id=4326).

Example. 4326
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Example: Enabling Clustering

If you turn on Clustering in the Layer Visualizations section of the ESRI Object Settings panel,
groups of markers will be combined into one cluster icon, with the number of individual
markers included shown on the icon. The markers are categorized into ranges, and the cluster
markers are colored according to the range of markers they represent.

Using the customer_locations procedure described in Configuring a Map Data Layer on page
755, run the HTML page. The output is shown in the following image:

The clusters change as you zoom the map.

Example: Enabling Popups

When you enable popups in the Layer Visualizations section of the ESRI Object Settings panel,
and you click a marker or polygon, an InfoWindow opens that shows additional information for
the map layer drawn. This popup is dependent on the layer attributes enabled at design time.
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The following image shows an InfoWindow for a marker on the map layer:

Note: In order to display customized names rather than field names in the popup, the custom
names must be defined with the TITLE attribute in the Master File. Using an AS name in the
request to create a custom name is not supported in the infowindow.

To close the InfoWindow, click the X in the header or click another marker.

Clicking Zoom to zooms in the map to the location of the clicked marker.

Example: Enabling the Default Extent

With the Default Extent visualization Off (the default), the initial view of the layer shows the
map view of the data layer defined. If there are multiple data layers, only one layer can have
the Default Extent turned on. In this case, the map view will be determined by the map layer
that has the Default Extent turned on. If no layer has Default Extent turned on, the extent of
the first data layer defined for the map will be used.
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The following image shows a map that has two layers, one based on countries, and one based
on US states, as shown in the following image.

Running the HTML page shows both layers, with the default extent set by the Countries layer,
as shown in the following image.
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The following image shows the States map layer with the Default Extent turned on.
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The following image shows that the map now zooms to the default extent of the States map
layer.

If you have zoomed the map using the zoom controls, you can return to the default extent
using the Default Extent control, shown in the following image.

For any layer, you can zoom to the layer extent using the Table of Contents control, shown in
the following image.
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Configuring Symbology for a Data Layer

The symbology available for a layer depends on the type of layer and on whether the
geographic data provided to the layer consists of points (X/Y values in either decimal degrees
or other units) or polygons (geographic areas).

When the geographic data consists of points, each point is represented by a marker on the
map. Each marker can be drawn using a standard shape or an image file. Markers can be
assigned a size and can be colored based on several classification schemes, using any
metrics.

When the geographic data defines polygons, the areas on the map representing each polygon
can be colored based on several classification schemes, using any metrics. It can have an
outline that consists of a color, a thickness, and a line style. It can also have a fill style such
as solid, diagonal lines (forward or backward), or crosshatch.

Configuring Symbology for a Point Data Layer

Geographical point data places markers on the map layer that can be configured with a wide
range of shape, size, color, and image options. 

The following image shows the Symbol Settings section of the ESRI Object Settings panel for a
point-based data layer. Some selections may open additional options not shown in this image.
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The following table summarizes the types of symbology available for a point layer. Each type of
symbology is illustrated in one of the sections that follows.

Type of Symbol

(Subtype)

Description Configuration Fields

Single

(Shape)

User selects
from a list of
marker shapes.

Use. Selects the type of symbols, Single for this
option.

Color. User selects a marker color. The default is red.

Size. User specifies the marker size in pixels. The
default is 12 and the maximum is 99.

Shape/Image. Select Shape for this option.

Shape. User selects one of the following marker
shapes:

Circle (default)

Cross

Diamond

Square

X

For more information, see Configuring Point
Symbology Using a Single Standard Shape on page
843.
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Type of Symbol

(Subtype)

Description Configuration Fields

Single

(Image)

User provides
an image
source for the
markers.

Use. Selects the type of symbols, Single for this
option.

Color. N/A. The image has its own colors.

Size. User specifies the marker size in pixels. The
default is 12 and the maximum is 99.

Shape/Image. Select Image for this option.

Image Source. User must provide the path to the
image.

For more information, see Configuring Point
Symbology Using a Single Image File on page 844.

Color User specifies
a field to be
used to classify
marker colors.

Use. Selects the type of symbols, Color for this
option.

Using Field. User selects a field in the request to be
used to classify the markers by color.

By. User selects from the following classification
methods.

Natural Jenks (the default).

Quantile.

Equal Breaks.

Standard Deviation.

Geometrical Breaks.

Number of Classes. User specifies the number of
color breaks. The default is 5.

Color Scheme. User selects the color palette for the
markers. The default uses shades of green.

For more information, see Configuring Point
Symbology Using Color on page 846.
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Type of Symbol

(Subtype)

Description Configuration Fields

Size User specifies
a field to be
used to size
the markers.

Use. Selects the type of symbols, Size for this option.

Using Field. User selects a field in the request to be
used to classify the markers by size.

Color. User selects a color for the markers.

For more information, see Configuring Point
Symbology Using Size on page 848.

Dynamic The WebFOCUS
request that
provides the
location
dimension
defines the
marker
properties.

Use. Selects the type of symbols, Dynamic for this
option.

Label. User specifies a field in the request that
contains the label text for the legend. The default is
the AS name, title, or field name.

Color. User specifies a field in the request that
defines the colors for the markers. Not supported
when marker images are used, as each image has its
own colors.

Size. User specifies a field in the request that defines
the sizes in pixels for the markers. The default is 12
and the maximum is 99.

Image Source. User specifies a field in the request
that contains the path to the marker images.

For more information, see Configuring Dynamic Point
Symbology on page 850.
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Type of Symbol

(Subtype)

Description Configuration Fields

Unique User selects
marker
properties for
each value of a
dimension in
the request.

Use. Selects the type of symbols, Unique for this
option.

Using Field. User selects a dimension in the request
and assigns marker properties for each value.

Size. User specifies a size in pixels for the markers.
The default is 12 and the maximum is 99.

Shape / Image. User can select a standard shape or
specify an image source for the markers.

Dimension Values box. A box is populated with the
dimension values. The user can select values and
move them to the right, then assign marker
properties to those selected values.

Label. User specifies text to display in the legend for
each selected dimension value.

Color. If Single is the selected marker type, the user
selects a color for each selected dimension value.

Shape. If Shape is the selected marker type, the user
selects a standard shape for each selected
dimension value.

Image Source. If Image is the selected marker type,
the user specifies an image source for each selected
dimension value.

For more information, see Configuring Unique
Symbology for Points on page 854.

Note: The symbol dynamically changes size with the zoom level of the map output for a single
symbol, but not for a symbol that is unique, dynamic, based on size, or based on color.
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Configuring Point Symbology Using a Single Standard Shape

The default symbol used for points is a 12-pixel red circle, as shown in the following image.

You can open a color picker dialog box by clicking the Color field, can enter a size in pixels,
and select a different shape (square, diamond, cross, or X). The maximum size supported is
99.

Example: Configuring Point Symbology Using a Standard Shape

This example uses a blue diamond symbol as the marker. The following image shows the
symbol settings. The external WebFOCUS request used to provide the point data is the
customer_locations procedure created in Configuring a Map Data Layer on page 755. The
geographic role is Point of Interest, and the fields that match the role are LATITUDE/
LONGITUDE.
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Run the HTML page. The output is shown in the following image.

Configuring Point Symbology Using a Single Image File

You can select a valid image file to use as the marker for point data and specify its size, as
shown in the following image.

The default size is 12 pixels and the maximum is 99.

Configuring Symbology for a Point Data Layer

844  Information Builders



Selecting a color has no effect on the output, as the image file is placed on the points with no
manipulation, except for size.

The symbol can be located on your machine or at a URL reference.

Example: Configuring Point Symbology Using an Image File

The following example uses a US flag as the symbol for the Customer layer.

In the Symbol Settings section of the ESRI Object Settings panel, select Single in the Use drop-
down list and Image in the Shape / Image drop-down list.

Enter the following URL in the Image Source box.

http://ecl.informationbuilders.com/jschart/us.gif

Run the HTML page. The output is shown in the following image.
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Configuring Point Symbology Using Color

When you select Color in the Symbol Settings Use drop-down list of the ESRI Object Settings
panel, the markers are colored using a choice of color classification systems, as shown in the
following image.

Using Field

Description. This is a numeric field in the request whose values will be used by the
classification schema to define the class breaks.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one field. It should be a measure field or numeric.

Number of Classes

Description. This is the number of class breaks that will be rendered.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select values 2 through 9. The default is 5.

By

Description. This is the classification scheme to be used for assigning the breaks and
ranges.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

Natural Jenks, a classification scheme that uses breaks inherent in the data, grouping
similar values and maximizing differences between groups. This is the default choice.
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Quantile, a classification scheme in which each class contains an equal number of
points.

Equal Breaks, a classification scheme that breaks the data into equal ranges of
values.

Standard Deviation, a classification scheme that defines the breaks based on the
number of standard deviations from the mean.

Geometrical Breaks, a classification scheme that bases class breaks on intervals that
have a geometrical series.

Color Scheme

Description. This lets you select an array of color values, defining the color ramp. The first
color will be used to render the minimum data class, and the last color will be used to
render the maximum data class.

Type of field. Drop-down list.

Populated by. User.

User limitations. User can only select one color array. The default array uses shades of
off-white and green.

Example: Symbolizing Points Using Color

This example symbolizes the points using color. The external WebFOCUS request used to
provide the point data is the customer_locations procedure created in Configuring a Map Data
Layer on page 755. The geographic role is Point of Interest, and the fields that match the role
are LATITUDE/LONGITUDE. This example uses the Natural Jenks color classification scheme
based on the COGS_US field, as shown in the following image.
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Run the HTML page. The output is shown in the following image.

Configuring Point Symbology Using Size

When you choose Size in the Symbol Settings Use box in the ESRI Object Settings panel, each
symbol is sized based on a numeric field in the request. You can also select a single color for
the markers, as shown in the following image.
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Example: Symbolizing Points Using Size

This example uses the COGS_US field to size the markers and blue to color the markers, as
shown in the following image.

The WebFOCUS request that provides the values is customer_locations.fex, described in 
Configuring a Map Data Layer on page 755. Run the HTML page. The output is shown in the
following image.
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Configuring Dynamic Point Symbology

When the symbology for points is Dynamic, you can specify columns in the request that provide
labels, colors, sizes, and image sources for the points, as shown in the following image.

Descriptions of the fields available when you select Dynamic in the Symbol Settings Use drop-
down list follow.

Label

Description. This column will be used to provide the text in the Legend.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one column in the layer request.

Color

Description. This column will provide a value for the color of a marker. Any valid color value
is accepted for example, RGB, hex, or named. The default is red.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one column in the layer request. Not supported
when the markers are configured as images.

Size

Description. This column will provide a value for the size of a marker in pixels. The default
is 12 and the maximum is 99.

Type of field. Combo box.

Populated by. User.
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User limitations. User can only select one column in the layer request.

Image Source

Description. This column will provide a value for the image used as a marker. The value
needs to be a qualified URL. If no image source is specified, the default marker is a circle.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one column in the layer request.

Once Image symbology is selected, color and size are disabled.

Note: You cannot type characters in the combo boxes for dynamic symbols. You can only
select field names.

Example: Using Dynamic Symbols for Points

This example uses dynamic images, sizes, and labels for points.

You can create a request using the Report Canvas or by entering request syntax in the Text
Editor. For information about creating a WebFOCUS report request using the Report Canvas,
see Creating Reports on page 229.
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The following WebFOCUS procedure dynamically defines fields that supply the labels, sizes,
and images for the map points. Paste this procedure into the text editor and save it as
customer_locations2.fex.

DEFINE FILE WF_RETAIL_LITE
SIZE1/I4 = IF COUNTRY_NAME EQ 'United States' THEN 25
            ELSE IF COUNTRY_NAME EQ 'France' THEN 20
            ELSE IF COUNTRY_NAME EQ 'Japan' THEN 12
            ELSE IF COUNTRY_NAME EQ 'Italy' THEN 15
            ELSE 10;
LABEL1/A20 = IF COUNTRY_NAME EQ 'United States' THEN 'US'
            ELSE IF COUNTRY_NAME EQ 'France' THEN 'France'
             ELSE IF COUNTRY_NAME EQ 'Japan' THEN 'Japan'
             ELSE IF COUNTRY_NAME EQ 'Italy' THEN 'Italy'
            ELSE 'UK';
IMAGE1/A80 = IF COUNTRY_NAME EQ 'United States' 
             THEN 'http://ecl.informationbuilders.com/jschart/us.gif'
             ELSE IF COUNTRY_NAME EQ 'France' 
             THEN 'http://ecl.informationbuilders.com/jschart/france.gif'
             ELSE IF COUNTRY_NAME EQ 'Japan' 
             THEN 'http://ecl.informationbuilders.com/jschart/japan.gif'
             ELSE IF COUNTRY_NAME EQ 'Italy' 
             THEN 'http://ecl.informationbuilders.com/jschart/italy.gif'
             ELSE 'http://ecl.informationbuilders.com/jschart/uk.gif';
END
TABLE FILE WF_RETAIL_LITE
SUM
     WF_RETAIL_LITE.WF_RETAIL_CUSTOMER.ID_CUSTOMER
     WF_RETAIL_LITE.WF_RETAIL_SALES.COGS_US
     QUANTITY_SOLD
     LABEL1 SIZE1 IMAGE1
     COMPUTE LONGITUDE/D12.2 = CUSTOMER_LONGITUDE;
     COMPUTE LATITUDE/D12.2 = CUSTOMER_LATITUDE;
BY COUNTRY_NAME
BY WF_RETAIL_LITE.WF_RETAIL_CUSTOMER.ID_CUSTOMER NOPRINT
WHERE COUNTRY_NAME EQ 'United States' OR 'France' OR 'Italy' OR 'Japan' OR 
'United Kingdom';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END
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Add this request to the HTML page using the Requests & Data Sources panel. Then configure
the ESRI Object Settings panel to use this request for the Customer layer. Configure the
symbol settings by selecting the appropriate fields from the request, as shown in the following
image.

The output is shown in the following image, after zooming in to fill the frame. The Legend is
toggled on to show the labels, sizes, and images used.
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Configuring Unique Symbology for Points

When you configure Unique symbology, you can display a different shape or image for each
value of a dimension field in the request.

The following image shows the Symbol Settings properties for Unique symbology in the ESRI
Object Settings pane.

Descriptions of the fields for unique symbology for points follow.

Using Field

Description. Is a dimension field in the request whose values will determine the shape or
image to use.

Type of field. Combo box.

Populated by. User.

User limitations. Must be a dimension field in the request.

Size

Description. Is the size of a marker in pixels. The default is 12 and the maximum is 99.

Type of field. Text box.

Populated by. User.
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User limitations. Must be a measure field in the request.

Shape / Image

Description. Indicates which type of marker to use, a standard shape or an image file.

Type of field. Drop-down list.

Populated by. User.

User limitations. All values must use the same type of marker.

Values

Description. This is the list of values for the Using Field. You can select any value and
click the arrow keys to move it between the original list box and the user-selected values
list box. Any values not in the user-selected list will display with default markers.

Type of field. List box.

Populated by. System.

User limitations. The user can select values from the system-generated list.

Label

Description. For each value selected, you can enter a label to display in the legend.

Type of field. Text box.

Populated by. User.

User limitations. User can enter a single label for each value of the Using Field.

Color

Description. For each value selected, you can select a marker color. The default is red.
Note that color is disabled if the type of marker is image.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Shape

Description. For each value selected, you can select a standard shape.

Type of field. Drop-down list.

Populated by. System defined.
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User limitations. User can select a single shape for each value of the Using Field. Choices
are:

Circle. This is the default shape.

Diamond.

Cross.

Square.

X.

Image Source

Description. For each value selected, specify an image file. This file must have a valid
image format.

Type of field. Text box with Browse to button.

Populated by. User.

User limitations. User can specify a single image file for each value of the Using Field. It
can be a path to a file accessible by the user PC or a URL reference. This file must have a
valid image format.

Example: Configuring Unique Image Symbology for Points

This example configures a unique image for the markers for each country name.

Configure the map to use the customer_locations2 procedure and the Point of Interest
geographic role in the ESRI Object Settings panel. Configure the unique symbology to use the
COUNTRY_NAME field, as shown in the following image.
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Move the values of the COUNTRY_NAME field to the right using the > arrow and configure them
as follows.

For France, enter France in the Label box and enter the following in the Image Source box:

http://ecl.informationbuilders.com/jschart/france.gif

For Italy, enter Italy in the Label box and enter the following in the Image Source box:

http://ecl.informationbuilders.com/jschart/italy.gif

For Japan, enter Japan in the Label box and enter the following in the Image Source box:

http://ecl.informationbuilders.com/jschart/japan.gif

For the United Kingdom, enter UK in the Label box and enter the following in the Image Source
box:

http://ecl.informationbuilders.com/jschart/uk.gif

For the United States, enter US in the Label box and enter the following in the Image Source
box:

http://ecl.informationbuilders.com/jschart/us.gif
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The output is shown in the following image, after zooming in to fill the frame. The Legend is
toggled on to show the labels, sizes, and images used.

Configuring Symbology for a Polygon Data Layer

When the geographic data defines polygons, the areas on the map representing each polygon
can be colored based on several classification schemes and can have an outline that consists
of a color, a thickness, and a line style and a fill style.
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The following image shows the Symbol Settings section of the ESRI Object Settings panel for a
polygon-based layer. Some selections may open additional options not shown in this image.
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The following table summarizes the types of symbology available for a polygon layer. Each type
of symbology is illustrated in one of the sections that follows.

Type of Symbol Description Configuration Fields

Single User selects a
single color,
outline color,
outline
thickness, and
outline style for
the polygons.

Use. Selects the type of symbols, Single for this
option.

Color. User selects a polygon fill color. The default is
red.

Outline Color. User selects a color for the borders
around the polygons. The default is gray.

Outline Thickness. User specifies a thickness in
pixels for the polygon borders. The default is 1.

Outline Style. User selects one of the following
polygon border styles:

Solid (default)

None

Dot

Dash

For more information, see Configuring Polygon
Symbology Using a Single Color on page 863.
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Type of Symbol Description Configuration Fields

Color User specifies
a field to be
used to classify
polygon colors.

Use. Selects the type of symbols, Color for this
option.

Using Field. User selects a field in the request to be
used to classify the polygons by color.

By. User selects from the following classification
methods.

Natural Jenks (the default).

Quantile.

Equal Breaks.

Standard Deviation.

Geometrical Breaks.

Number of Classes. User specifies the number of
color breaks. The default is 5.

Color Scheme. User selects the color palette for the
polygons. The default uses shades of green.

For more information, see Configuring Polygon
Symbology Using Color on page 873.

Dynamic The WebFOCUS
request that
provides the
location
dimension
defines the
polygon
properties.

Use. Selects the type of symbols, Dynamic for this
option.

Label. User specifies a field in the request that
contains the label text to display in the legend. The
default is the AS name, title, or field name.

Color. User specifies a field in the request that
defines the fill colors of the polygons.

For more information, see Configuring Dynamic
Polygon Symbology on page 875.
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Type of Symbol Description Configuration Fields

Unique User selects
polygon
properties for
each value of a
dimension in
the request.

Use. Selects the type of symbols, Unique for this
option.

Using Field. User selects a dimension in the request
and assigns polygon properties for each value.

Dimension Values box. A box is populated with the
dimension values. The user can select values and
move them to the right, then assign polygon
properties to those selected values.

Label. User specifies text to display in the legend for
each selected dimension value.

Color. User selects a polygon fill color for each
selected dimension value. The default value is red.

Outline Color. User selects a polygon border color for
each selected dimension value. The default value is
gray.

Outline Thickness. User specifies a polygon border
thickness in pixels for each selected dimension
value. The default value is 1.

Outline Style. User selects a polygon border style
(Solid, None, Dot, Dash) for each selected dimension
value. The default value is Solid.

For more information, see Configuring Unique
Symbology for Polygons on page 866.

Configuring Symbology for a Polygon Data Layer

862  Information Builders



Configuring Polygon Symbology Using a Single Color

The default symbology for a polygon data layer is to color the polygons red with a light gray, 1-
pixel solid outline, as shown in the following image.

You can change the color for the polygon, the color for the outline, the thickness of the outline,
the line style for the outline, and a fill style for the polygon.

The following fields are available when you use Single as the symbology setting.

Color

Description. Opens a color picker dialog box that lets you select a color for the polygons.
You can select from a palette, select a named string, select a system color, or create a
custom color, and set this color instance to that value.

Type of field. Color value.

Populated by. User.

User limitations. User can browse to a single color. The default is red.

Outline Color

Description. Opens a color picker dialog box that lets you select a color for to outline the
polygons. You can select from a palette, select a named string, select a system color, or
create a custom color, and set this color instance to that value.

Type of field. Color value.

Populated by. User.

User limitations. User can browse to a single color. The default is light gray.
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Outline Thickness

Description. Is a thickness for the outline in pixels.

Type of field. Integer.

Populated by. User.

User limitations. User can enter a single number. The default is 1.

Outline Style

Description. Is the style of the polygon outline.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

Solid (this is the default value).

None.

Dot.

Dash.

Fill Style

Description. Is the fill style of the polygon.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

Backward Diagonal.

Cross.

Diagonal Cross.

Forward Diagonal.

Horizontal.

None.

Solid (this is the default value).
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Vertical.

Note: The hatch patterns are images from Esri whose color cannot be altered using the
Settings panel.

Example: Using Single Symbology for Polygons

This example makes the polygons blue and the outline a dashed light blue line. The
WebFOCUS request used is customer_states, as described in Configuring a Map Data Layer on
page 755. Add this request to the HTML page in the Requests & Data Sources panel.

Configure the map layer to use the customer_states procedure described in Configuring a Map
Data Layer on page 755. The geographic role is US state (Name), and the field that matches
the role is STATE_PROV_NAME. Configure the Symbol Settings in the ESRI Object Settings
panel as shown in the following image, by clicking the Color field and selecting a dark blue
color, clicking the Outline Color field and selecting a light blue color, and selecting Dash from
the Outline Style drop-down list.

10. Creating Esri Maps

WebFOCUS App Studio User’s Manual  865



Run the HTML page. The output is shown in the following image.

Configuring Unique Symbology for Polygons

When you configure Unique symbology, you can display a different color for each value of a
dimension field in the request. This is a good technique for defining categories.

Configuring Symbology for a Polygon Data Layer

866  Information Builders



The following image shows the Symbol Settings properties for Unique symbology in the ESRI
Object Settings pane.

Descriptions of the fields for unique symbology for polygons follow.

Using Field

Description. Is a dimension field in the request whose values will determine the shape or
image to use.

Type of field. Combo box.

Populated by. User.

User limitations. Must be a dimension field in the request.

Values

Description. This is the list of values for the Using Field. You can select any value and
click the arrow keys to move them between the original list box and the user-selected
values list box. Any values not in the user-selected list will display with default colors.

Type of field. List box.

Populated by. System.
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User limitations. The user can select values from the system-generated list.

Label

Description. For each value selected, you can enter a label to display in the legend.

Type of field. Text box.

Populated by. User.

User limitations. User can enter a single label for each value of the sing Field.

Color

Description. For each value selected, you can select a polygon color. The default is red.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Outline Color

Description. For each value selected, you can select a color for the polygon outline. The
default is light gray.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Outline Thickness

Description. Is a thickness for the outline in pixels.

Type of field. Integer.

Populated by. User.

User limitations. User can enter a single number. The default is 1.

Outline Style

Description. Is the style of the polygon outline.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

Solid (this is the default value).
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None.

Dot.

Dash.

Fill Style

Description. Is the fill style of the polygon.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

Backward Diagonal.

Cross.

Diagonal Cross.

Forward Diagonal.

Horizontal.

None.

Solid (this is the default value).

Vertical.

Note: The hatch patterns are images from Esri whose color cannot be altered using the
Settings panel.

Example: Configuring Unique Color Symbology for Polygons

This example configures a unique color for the polygons for each US region.

You can create a request using the Report Canvas or by entering request syntax in the Text
Editor. For information about creating a WebFOCUS report request using the Report Canvas,
see Creating Reports on page 229.
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Following is the syntax for a WebFOCUS request that defines regions based on state names.
Paste this request into the text editor and save it as customer_states4.

DEFINE FILE WF_RETAIL_LITE
STATE/A20 = STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR
       'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR
       'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
       ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio'
       OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri'
       OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
       ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland'
       OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR
       'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR
       'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR
       'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD 
BY REGION
BY STATE_PROV_NAME
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE PCHOLD FORMAT XML
END
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Configure the map layer to use this request in the ESRI Object Settings panel. The geographic
role is US state (Name), and the field that matches the role is STATE_PROV_NAME. Configure
the unique symbol settings using the REGION field, as shown in the following image.

10. Creating Esri Maps

WebFOCUS App Studio User’s Manual  871



Move each region value to the right using the > arrow, and configure the following entries and
selections for each:

For Northeast, enter Northeast in the Label box and select a green polygon color from the color
picker.

For West, enter West in the Label box and select a blue polygon color from the color picker.

For South, enter South in the Label box and leave the polygon color as red.

For Midwest, enter Midwest in the Label box and select and orange polygon color from the
color picker.

Run the HTML page. The output is shown in the following image. The table of contents is open
to show the labels and colors.
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Configuring Polygon Symbology Using Color

When you select Color in the Symbol Settings Use drop-down list of the ESRI Object Settings
panel, the polygons are colored using a choice of color classification systems, as shown in the
following image.

Using Field

Description. This is a numeric field in the request whose values will be used by the
classification schema to define the class breaks.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one field. It should be a measure field or numeric.

Number of Classes

Description. This is the number of class breaks that will be rendered.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select values 2 through 9. The default is 5.

By

Description. This is the classification scheme to be used for assigning the breaks and
ranges.

Type of field. Drop-down list.

Populated by. User.
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User limitations. Choices are:

Natural Jenks, a classification scheme that uses breaks inherent in the data, grouping
similar values and maximizing differences between groups. This is the default choice.

Quantile, a classification scheme in which each class contains an equal number of
points.

Equal Breaks, a classification scheme that breaks the data into equal ranges of
values.

Standard Deviation, a classification scheme that defines the breaks based on the
number of standard deviations from the mean.

Geometrical Breaks, a classification scheme that bases class breaks on intervals that
have a geometrical series.

Color Scheme

Description. This lets you select an array of color values, defining the color ramp. The first
color will be used to render the minimum data class, and the last color will be used to
render the maximum data class.

Type of field. Drop-down list.

Populated by. User.

User limitations. User can only select one color array. The default array uses shades of off
white and green.

Example: Symbolizing Polygons Using Color

This example uses the Natural Jenks color classification scheme based on the
QUANTITY_SOLD field, as shown in the following image. The WebFOCUS request that provides
the point data is the customer_states4 procedure. The geographic role is US state (Name),
and the field that matches this role is STATE_PROV_NAME.
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Run the HTML page. The output is shown in the following image.

Configuring Dynamic Polygon Symbology

When the symbology for polygons is Dynamic, you can specify columns in the request that
provide labels and colors for the polygons, as shown in the following image.

Descriptions of the fields available when you select Dynamic in the Symbol Settings Use drop-
down list follow.

Label

Description. This column will be used to depict values in the Legend.

Type of field. Combo box.

Populated by. User.
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User limitations. User must select one column in the layer request.

Color

Description. This column will provide a value for the color of a polygon. The default is red.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one column in the layer request.

Note:

Dynamic symbology automatically creates an Other category that is symbolized using a pink
color. With the Edge browser, the Other category does not show the default pink color, but
shows a white outline instead.

You cannot type characters in the combo boxes for dynamic symbols, you can only select
field names.

Example: Using Dynamic Symbols for Polygons

This example uses dynamic colors and labels for polygon.

You can create a request using the Report Canvas or by entering request syntax in the Text
Editor. For information about creating a WebFOCUS report request using the Report Canvas,
see Creating Reports on page 229.
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The following WebFOCUS procedure defines fields that supply the color and label for each
country. Paste this procedure into the text editor and save it as customer_countries.fex.

DEFINE FILE WF_RETAIL_LITE
COLOR/A10 = IF COUNTRY_NAME EQ 'United States' THEN 'blue'
      ELSE IF COUNTRY_NAME EQ 'France' THEN 'red'
      ELSE IF COUNTRY_NAME EQ 'Italy' THEN 'green'
      ELSE IF COUNTRY_NAME EQ 'Japan' THEN 'black'
      ELSE 'purple';
Label/A20 = IF COUNTRY_NAME EQ 'United States' THEN 'US'
      ELSE IF COUNTRY_NAME EQ 'France' THEN 'France'
      ELSE IF COUNTRY_NAME EQ 'Japan' THEN 'Japan'
      ELSE IF COUNTRY_NAME EQ 'Italy' THEN 'Italy'
      ELSE 'UK';
END
TABLE FILE WF_RETAIL_LITE
SUM
   COGS_US
   QUANTITY_SOLD
   Label 
   COLOR
BY COUNTRY_NAME
WHERE COUNTRY_NAME EQ 'United States' OR 'France' OR 'Italy' OR 'Japan' 
   OR 'United Kingdom';
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
END

Add this request to the Customer Layer using the Requests & Data Sources panel. Then
configure the map layer to use this request. The geographic role is Country (Name), and the
field that matches this role is COUNTRY_NAME. Configure the Symbol Settings section of the
ESRI Object Settings panel by selecting the appropriate fields from the request, as shown in
the following image. The Label is taken from the Label field in the request, and the Color is
taken from the COLOR field in the request.
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Run the HTML page. The output, zoomed in to fit the frame, is shown in the following image.
The Legend is toggled on to show the labels, sizes, and colors used.

Configuring Symbology for a Line Data Layer

Geographical line data places lines on the map layer that can be configured with a wide range
of size, color, and thickness options. 

The following image shows the Symbol Settings section of the ESRI Object Settings panel for a
point-based data layer. Some selections may open additional options not shown in this image.
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The following table summarizes the types of symbology available for a line layer. Each type of
symbology is illustrated in one of the sections that follows.

Type of Symbol

(Subtype)

Description Configuration Fields

Single Uses a single
line

Use. Selects the type of symbols, Single for this
option.

Color. User selects a line color. The default is red.

Thickness. User specifies the line thickness in
pixels. The default is 12 and the maximum is 99.

Style. User selects one of the following line styles:

Solid (default)

Dashes

Dash-dot

Dash-dot-dot

Dots

None

For more information, see Configuring Line Symbology
Using a Single Line Symbol on page 883.
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Type of Symbol

(Subtype)

Description Configuration Fields

Color User specifies
a field to be
used to classify
line colors.

Use. Selects the type of symbols, Color for this
option.

Using Field. User selects a field in the request to be
used to classify the lines by color.

By. User selects from the following classification
methods.

Natural Jenks (the default).

Quantile.

Equal Breaks.

Standard Deviation.

Geometrical Breaks.

Number of Classes. User specifies the number of
color breaks. The default is 5.

Color Scheme. User selects the color palette for the
lines. The default uses shades of green.

Thickness. User specifies the line thickness in
pixels. The default is 1 and the maximum is 99.

For more information, see Configuring Line Symbology
Using Color on page 884.
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Type of Symbol

(Subtype)

Description Configuration Fields

Thickness User specifies
a field to be
used to classify
the thickness
of the lines.

Use. Selects the type of symbols, Thickness for this
option.

Using Field. User selects a field in the request to be
used to classify the lines by thickness.

Color. User selects a color for the lines.

Minimum. Specifies the minimum thickness. The
default is 1.

Maximum. Specifies the maximum thickness. The
default is 10.

For more information, see Configuring Line Symbology
Using Thickness on page 891.

Dynamic The WebFOCUS
request that
provides the
location
dimension
defines the line
properties.

Use. Selects the type of symbols, Dynamic for this
option.

Label. User specifies a field in the request that
contains the label text for the legend. The default is
the AS name, title, or field name.

Color. User specifies a field in the request that
defines the colors for the markers.

Size. User specifies a field in the request that defines
the thickness in pixels for the lines. The default is 12
and the maximum is 99.

Style. User specifies a field in the request that
contains styles for the lines.

For more information, see Configuring Dynamic Line
Symbology on page 894.
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Type of Symbol

(Subtype)

Description Configuration Fields

Unique User selects
line properties
for each value
of a dimension
in the request.

Use. Selects the type of symbols, Unique for this
option.

Using Field. User selects a dimension in the request
and assigns marker properties for each value.

Thickness. User specifies a thickness in pixels for
the lines. The default is 12 and the maximum is 99.

Dimension Values box. A box is populated with the
dimension values. The user can select values and
move them to the right, then assign line properties to
those selected values.

Label. User specifies text to display in the legend for
each selected dimension value.

Color. The user selects a color for each selected
dimension value.

Style. The user selects a line style for each selected
dimension value.

For more information, see Configuring Unique
Symbology for Lines on page 887.

Note: The symbol dynamically changes size with the zoom level of the map output for a single
symbol, but not for a symbol that is unique, dynamic, based on thickness, or based on color.
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Configuring Line Symbology Using a Single Line Symbol

The default symbol used for lines is a 12-pixel thick solid red line, as shown in the following
image.

You can open a color picker dialog box by clicking the Color field, can enter a size in pixels,
and select a different style (dashes, dash-dot, dash-dot-dot, or dots). The maximum size
supported is 99.

Example: Configuring Line Symbology Using a Single Line Symbol

This example uses blue dashed line symbol that is three pixels thick. The following image
shows the symbol settings.

The external WebFOCUS request used to provide the point data is the citibike_tripdata_line1
procedure created in Configuring a Geometry Line Layer on page 762. The geographic role is
Geometry line, and the field that matches the role is CONNECTION_LINE_A.
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Run the HTML page. The output is shown in the following image.

Configuring Line Symbology Using Color

When you select Color in the Symbol Settings Use drop-down list of the ESRI Object Settings
panel, the lines are colored using a choice of color classification systems, as shown in the
following image.

Using Field

Description. This is a numeric field in the request whose values will be used by the
classification schema to define the class breaks.
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Type of field. Combo box.

Populated by. User.

User limitations. User can only select one field. It should be a measure field or numeric.

Number of Classes

Description. This is the number of class breaks that will be rendered.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select values 2 through 9. The default is 5.

By

Description. This is the classification scheme to be used for assigning the breaks and
ranges.

Type of field. Drop-down list.

Populated by. User.

User limitations. Choices are:

Natural Jenks, a classification scheme that uses breaks inherent in the data, grouping
similar values and maximizing differences between groups. This is the default choice.

Quantile, a classification scheme in which each class contains an equal number of
points.

Equal Breaks, a classification scheme that breaks the data into equal ranges of
values.

Standard Deviation, a classification scheme that defines the breaks based on the
number of standard deviations from the mean.

Geometrical Breaks, a classification scheme that bases class breaks on intervals that
have a geometrical series.

Color Scheme

Description. This lets you select an array of color values, defining the color ramp. The first
color will be used to render the minimum data class, and the last color will be used to
render the maximum data class.

Type of field. Drop-down list.

Populated by. User.
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User limitations. User can only select one color array. The default array uses shades of
off-white and green.

Thickness

Description. This lets you enter a thickness in pixels for the lines. The default value is 1
and the maximum is 99.

Type of field. Text Box.

Populated by. User.

User limitations. User enter only an integer value from 1 to 99.
Example: Symbolizing Lines Using Color

This example symbolizes the lines using color. The external WebFOCUS request used to
provide the point data is the citibike_tripdata_line1 procedure created in Configuring a
Geometry Line Layer on page 762. The geographic role is Geometry line, and the field that
matches the role is CONNECTION_LINE_A. This example uses the Natural Jenks color
classification scheme based on the GENDER field, as shown in the following image. Note that
the Number of classes is 3, as that is the number of values for gender in the data. Using the
default number, 5, would generate an error.
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Run the HTML page. The output is shown in the following image.

Configuring Unique Symbology for Lines

When you configure Unique symbology, you can display a different line style for each value of a
dimension field in the request.
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The following image shows the Symbol Settings properties for Unique symbology in the ESRI
Object Settings pane.

Descriptions of the fields for unique symbology for lines follow.

Using Field

Description. Is a dimension field in the request whose values will determine the line style
to use.

Type of field. Combo box.

Populated by. User.

User limitations. Must be a dimension field in the request.

Thickness

Description. Is the thickness of a line in pixels. The default is 12 and the maximum is 99.

Type of field. Text box.

Populated by. User.

User limitations. Must be a measure field in the request.

Values

Description. This is the list of values for the Using Field. You can select any value and
click the arrow keys to move it between the original list box and the user-selected values
list box. Any values not in the user-selected list will display with default line styles.
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Type of field. List box.

Populated by. System.

User limitations. The user can select values from the system-generated list.

Label

Description. For each value selected, you can enter a label to display in the legend.

Type of field. Text box.

Populated by. User.

User limitations. User can enter a single label for each value of the Using Field.

Color

Description. For each value selected, you can select a line color. The default is red.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color for each value of the Using Field.

Style

Description. For each value selected, you can select a standard line style.

Type of field. Drop-down list.

Populated by. System defined.

User limitations. User can select a single shape for each value of the Using Field. Choices
are:

Solid. This is the default style.

Dashes.

Dash-dot.

Dash-dot-dot.

Dots.

Example: Configuring Unique Symbology for Lines

This example configures a unique style for the lines for each gender value.
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Configure the map to use the citibike_tripdata_line1 procedure and the Geometry line
geographic role in the ESRI Object Settings panel. Configure the unique symbology to use the
GENDER field, as shown in the following image.
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Move the values of the GENDER field to the right using the > arrow, enter a label and select a
color and line style for each.

The output is shown in the following image. The Legend is toggled on to show the labels, and
line styles used.

Configuring Line Symbology Using Thickness

When you choose Thickness in the Symbol Settings Use box in the ESRI Object Settings panel,
each line has a thickness based on a numeric field in the request. You can also select a single
color for the lines, as shown in the following image.
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Descriptions of the fields for unique symbology for lines follow.

Using Field

Description. Is a numeric field in the request whose values will determine the line
thickness to use.

Type of field. Combo box.

Populated by. User.

User limitations. Must be a numeric field in the request.

Color

Description. Is a line color. The default is red.

Type of field. Color picker.

Populated by. User.

User limitations. User can select a single color.

Minimum

Description. Is the minimum thickness to be used

Type of field. Text box.

Populated by. User.

User limitations. The user can enter a value from 1 to 99. The default value is 1.

Maximum

Description. Is the maximum thickness to be used

Type of field. Text box.

Populated by. User.

User limitations. The user can enter a value from 1 to 99. The default value is 10.
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Example: Symbolizing Lines Using Thickness

This example uses the GENDER field to thicken the lines and green to color the lines, as
shown in the following image.

The WebFOCUS request that provides the values is citibike_tripdata_line1.fex, described in 
Configuring a Geometry Line Layer on page 762. Run the HTML page. The output is shown in
the following image.
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Configuring Dynamic Line Symbology

When the symbology for lines is Dynamic, you can specify columns in the request that provide
labels, colors, sizes, and line styles for the lines, as shown in the following image.

Descriptions of the fields available when you select Dynamic in the Symbol Settings Use drop-
down list follow.

Label

Description. This column will be used to provide the text in the Legend.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one column in the layer request.

Color

Description. This column will provide a value for the color of a marker. Any valid color value
is accepted for example, RGB, hex, or named. The default is red.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one alphanumeric column in the layer request. .

Size

Description. This column will provide a value for the thickness of a line in pixels. The
default is 12 and the maximum is 99.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one numeric column in the layer request.
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Style

Description. This column will provide a value for the style of the line. The default style is
Solid.

Type of field. Combo box.

Populated by. User.

User limitations. User can only select one alphanumeric column in the layer request.

Valid values in the field have the prefix STYLE_ followed by the combination of line styles
you want with no separators. For example, STYLE_LONGDASHDOT for long dashes followed
by dots.

Note: You cannot type characters in the combo boxes for dynamic symbols. You can only
select field names.

Example: Using Dynamic Symbols for Lines

This example uses dynamic colors, sizes, labels, and styles for lines.

You can create a request using the Report Canvas or by entering request syntax in the Text
Editor. For information about creating a WebFOCUS report request using the Report Canvas,
see Creating Reports on page 229.
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The following WebFOCUS procedure dynamically defines fields that supply the colors, styles,
and sizes for the map lines. Paste this procedure into the text editor and save it as
citibike_tripdata_line2.fex.

DEFINE FILE esri8203/201709_citibike_tripdata
COLOR/A10 = IF GENDER EQ 0 THEN 'blue'
            ELSE IF GENDER EQ 1 THEN 'red'
                           ELSE 'green';
SIZE/I2 =  IF GENDER EQ 0 THEN 2
           ELSE IF GENDER EQ 1 THEN 4
                          ELSE 6;
STYLE/A20=DECODE GENDER(0 'STYLE_DOT' 1 'STYLE_SHORTDASHDOT' 2 
'STYLE_LONGDASH' ELSE 'STYLE_SOLID');

END
TABLE FILE esri8203/201709_citibike_tripdata
PRINT  BIKE_PATH_ID
BY TRIPDURATION
BY GENDER
BY START_STATION_NAME AS 'start station name'
BY END_STATION_NAME AS 'end station name'
BY CONNECTION_LINE_A
BY COLOR
BY SIZE
BY STYLE
WHERE END_STATION_LATITUDE NE 0;
WHERE END_STATION_LONGITUDE NE 0;
WHERE START_STATION_NAME EQ 'Newport Pkwy'
ON TABLE PCHOLD FORMAT XML
END

Add this request to the HTML page using the Requests & Data Sources panel. Then configure
the ESRI Object Settings panel to use this request for the Customer layer. Configure the
symbol settings by selecting the appropriate fields from the request, as shown in the following
image.
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The output is shown in the following image.

Summary of Symbology and Visualizations by Layer Type

The following table lists the visualizations available by layer type. 

Feature Type Geographic Roles Available
Symbology

Available Visualizations

Point Latitude/Longitude

City

Shape/Image,
Color, Size

Popups,Clustering,
Heatmap, Popups,
Default Visibility,
Transparency

Polygon State

County

Country

Continent

Postal Code

Color Popups, Default
Visibility, Transparency
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Feature Type Geographic Roles Available
Symbology

Available Visualizations

Line Geometry Line Color, Size, Style Popups, Default
Visibility, Transparency

Note: The symbology and visualizations available for custom geographic roles depend on
whether they define points or polygons.

Refreshing Markers on an ESRI Map Without Refreshing the Entire Map

Markers on a Point of Interest layer may be used to represent the positions of objects (such as
vehicles or incidents) whose location changes over time. You can update these markers
without updating the entire map using the IbComposer_refreshEsriMapLayer JavaScript
function in a control.

The refresh will do the following:

Update the locations of the markers without refreshing the map layer or other map layers.

Maintain the extent (zoom level) of the map layer.

Maintain the symbols with which the map layer was configured.

Maintain the visibility of the map layer.

Allow infoWindows to be opened on click.

Syntax: How to Refresh Map Markers Without Refreshing the Map

Add the following JavaScript function call to the onclick event of the control created to refresh
the markers.

IbComposer_refreshMapLayer("mapid", "layerid") ;

where:

"mapid"

Is a map ID (for example, "emfobject1").

"layerid"

Is a layer ID (for example, "Layer1").
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Example: Refreshing Markers on an ESRI Map Without Refreshing the Entire Map

The following image shows a map layer that contains a map object and three buttons. The map
ID is emfobject1, and the layer ID is Layer1, which are the default IDs.

The WebFOCUS request associated with the map is fed the coordinates of the cars and prints
each car ID and its latitude and longitude as the car positions change.

The button labeled Start, whose name is button1, has the IbComposer_refreshMapLayer
function call in its onclick event, as shown on the Embedded JavaScript tab.

//Begin function button1_onclick
function button1_onclick(event) {
var eventObject = event ? event : window.event;
var ctrl = eventObject.target ? eventObject.target : eventObject.srcElement;
// TODO: Add your event handler code here
//IbComposer_refreshMapLayer("emfobject1", "Layer1") ; 
//IbComposer_triggerExecution("task2",1);
if (glbInterval) return;
glbInterval = setInterval(doMapRefresh,1000);
}
//End function button1_onclick
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The following image shows the map output before the Start button is clicked. The circles that
represent the map markers are in their starting positions within the large X's on the map.

After the Start button is clicked, the markers move on the map, but the map is not refreshed
and its zoom and position remain unchanged, as shown in the following image.
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Clicking a marker opens its InfoWindow. The values displayed in the InfoWindow update as the
marker moves. The following images show an open InfoWindow for the same marker in two
different locations.

Retrieving the Esri Map Viewer Current Extent Coordinates as Variables

The current extent of an Esri map can be retrieved as map parameters and used for
subsequent filtering of map layers and reports. The extent can be in any coordinate system
and must be a simple polygon.

The names of the map extent variables are:

&MINX, which defines the minimum longitude of the extent.

&MINY, which defines the minimum latitude of the extent.

&MAXX, which defines the maximum longitude of the extent.

&MAXY, which defines the maximum latitude of the extent.
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Example: Using the Current Extent Parameters in a Map

The following steps create a map with a procedure that shows the markers within the current
extent when the map is refreshed.

1. Create a domain named RetailExtent.

2. Right-click the domain, point to New, and click Procedure via Text Editor.

3. Copy the following procedure, paste it into the text editor, and save it as retail_map.fex.

-DEFAULT &MINX=_FOC_NULL
-DEFAULT &MAXX=_FOC_NULL
-DEFAULT &MINY=_FOC_NULL
-DEFAULT &MAXY=_FOC_NULL

DEFINE FILE WF_RETAIL_LITE
LATITUDE = STATE_PROV_CAPITAL_LATITUDE;
LONGITUDE = STATE_PROV_CAPITAL_LONGITUDE;
END
TABLE FILE WF_RETAIL_LITE
PRINT
     ID_CUSTOMER
     QUANTITY_SOLD
     MSRP_US
     FST.LATITUDE
     FST.LONGITUDE

WHERE RECORDLIMIT EQ 250
WHERE COUNTRY_NAME EQ 'United States'
WHERE LATITUDE GE &MINY
WHERE LATITUDE LE &MAXY
WHERE LONGITUDE GE &MINX
WHERE LONGITUDE LE &MAXX
ON TABLE SET PAGE-NUM NOLEAD
ON TABLE SET ASNAMES ON
ON TABLE NOTOTAL
ON TABLE PCHOLD FORMAT XML
ON TABLE SET HTMLEMBEDIMG ON
ON TABLE SET HTMLCSS ON

END

This procedure uses WHERE selection tests to show the markers only for the extent that is
displayed.
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4. Create a new HTML page and add a map object and a button, as shown in the following
image.

5. In the Requests & Data Sources panel, open the drop-down menu next to the New icon,
point to External Request, and click WebFOCUS Procedure. Select retail_map.fex.
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6. Select the map and configure the Settings panel as shown in the following image.
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7. In the Requests & Data Sources panel, right-click the retail_map request and select Create
Controls for Parameters.

The New Parameters dialog box opens.

8. Right-click the value in the first row of the Control Type column, point to Existing Control,
and click emfobject1, as shown in the following image.

9. Click OK.
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10.Select the button and in the Tasks & Animations panel create a task that will refresh the
map when the button is clicked, as shown in the following image.

11.Save the HTML page.
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When you run the page, all of the markers are displayed on the map, as shown in the following
image.

Zoom in and click the button. The map will be refreshed and only markers for that extent are
displayed, as shown in the following image.

Configuring Maps to Interact With Other Components

Variables in requests and maps can be used as parameters that are passed from one
component to other components on an HTML page. When selections are made on one
component, other components on the HTML page can be automatically updated to show those
same selected values.
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A point layer on a map has a unique ID field that App Studio automatically turns into a
parameter. When you use that same parameter in a filter in a report or chart component, any
selection on the map layer will change the output of the report or chart.

For a polygon layer, you must create the variables to be passed between the map and other
components.

A WebFOCUS report or chart request can have drill-down links that select and zoom to points
or polygons on a map layer.

Procedure: How to Update a Request Based on Map Selections

In order to cause map selections to update a report or chart, you need a parameter in the
request that supplies the location dimension for the map, and a matching parameter in the
request that will be updated when a selection is made on the map.

Note: You can specify whether to rerun the request when the map selections are cleared. For
information, see Configuring Whether Selections on a Map Are Required to Run a Request on
page 747.

For a point layer using the map unique ID field, the report or chart must have a parameter
matching the unique ID parameter automatically generated for the map. For a polygon layer,
you can define a parameter in the request that supplies the location dimension for the map.

Once you have the parameter in the request to be updated and the parameter in the map
defined, you must bind it to the map object on the Parameters tab by dragging the mouse from
the map object to the request parameter, as shown in the following image.

The example used in this section to provide the point data is the customer_locations
procedure created in Configuring a Map Data Layer on page 755. The unique ID field is
ID_CUSTOMER.
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The following version of the request populates a report and contains a parameter named
&ID_CUSTOMER. Paste the syntax into the Text Editor and save it as
customer_locations2b.fex.

-DEFAULT ID_CUSTOMER=FOC_NONE
TABLE FILE WF_RETAIL_LITE
SUM
  ID_CUSTOMER
  COGS_US
  REVENUE_US
  QUANTITY_SOLD
BY COUNTRY_NAME
BY STATE_PROV_NAME
BY  ID_CUSTOMER NOPRINT
WHERE ID_CUSTOMER EQ &ID_CUSTOMER
ON TABLE NOTOTAL
ON TABLE SET PAGE NOLEAD
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/
ENWarm.sty,$
ENDSTYLE
END

Note that the WHERE condition selects ID_CUSTOMER values that are equal to the
&ID_CUSTOMER parameter values. When selections are made on the map, the map
component will automatically pass the ID_CUSTOMER values selected to the report
component, and the report will update to display those selections only. The -DEFAULT
command causes the WHERE test to be ignored when no selection has been made.

The following steps set up the report and the task for updating it.

1. Add an Esri component to the HTML page.

2. Add the customer_locations.fex and customer_locations2b.fex external WebFOCUS
requests to the HTML page using the Requests & Data Sources panel.

3. Configure the Esri component to use the Point of Interest geographic role and the
customer_locations procedure, as described in Configuring a Map Data Layer on page 755.

4. Add a Frame component next to the map component on the HTML page.

5. With the map component selected, create a new task in the Tasks & Animations panel.

Set the following properties for the task.

Set the Trigger Type to Selection Changed.

For the Trigger, check the map layer whose selections should trigger the task.

For Requests/Actions, select Run Request and then customer_locations2b.

Note: The Load task should also run this request so that it is populated as soon as
the HTML page is run.
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For Target Type, select Frame.

For Target/Template Name, select the name of the frame where customer_locations2b
will be run.

The Tasks & Animations panel should look similar to the following:

6. Bind the parameter to the map object on the Parameters tab by dragging the mouse from
the map object to the request parameter, as shown in the following image.

Configuring Maps to Interact With Other Components

910  Information Builders



Run the HTML page. The output will be similar to the following:

Make a selection on the map using the selection widget. The report updates to show the
selected points on the map, as shown in the following image.

Procedure: How to Update a Request Based on Map Selections for a Polygon Layer

In order to cause map selections to update a report or chart, the report or chart must have a
parameter matching a parameter on the map.

The request used in this example to provide the polygon data is the customer_states3
procedure. It is similar to the customer_states procedure created in Configuring a Map Data
Layer on page 755, but it has a variable added to select regions.
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The customer_states3 procedure follows:

-DEFAULT REGION = FOC_NONE
DEFINE FILE WF_RETAIL_LITE
STATE/A20 = WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR
    'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR
    'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
    ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio'
    OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri'
    OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
    ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland'
    OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR
    'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR
    'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR
    'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION
BY STATE_PROV_NAME
WHERE REGION EQ &REGION
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE PCHOLD FORMAT XML
END

The DEFINE FILE command defines which states are in which regions. The WHERE phrase for
REGION sets the values of the REGION field to the values of the &REGION parameter. When a
selection has been made on the map, the parameter values will be passed to a report request.
The -DEFAULT command causes the WHERE test to be ignored when no selection has been
made.

Paste this syntax into the Text Editor, and save it as customer_states3.fex.
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The following version of the request, named customer_states3b, populates a report and also
contains a parameter named &REGION. Paste the syntax into the Text Editor and save it as
customer_states3b.fex.

-DEFAULT &REGION = FOC_NONE
DEFINE FILE WF_RETAIL_LITE
STATE/A20 = STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR
    'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR
    'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
    ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio'
    OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri'
    OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
    ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland'
    OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR
    'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR
    'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR
    'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION AS Region
BY STATE_PROV_NAME
WHERE REGION EQ &REGION
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE SET PAGE NOLEAD
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/
ENWarm.sty,$
ENDSTYLE
END

Note that the WHERE condition selects REGION values that are equal to the &REGION
parameter values. When selections are made on the map, the map component will pass the
REGION values selected to the report component, and the report will update to display those
selections only.

The following steps set up the report and the task for updating it.

1. Add an Esri component to the HTML page.

2. Add the customer_states3.fex and customer_states3b.fex external WebFOCUS requests to
the HTML page using the Requests & Data Sources panel.

3. Configure the Esri component to use the US state (Name) geographic role and the
customer_states3 procedure. The field that matches the geographic role is
STATE_PROV_NAME.

For clarity, the map component has been configured with unique symbology using the
REGION field, as described in Configuring Unique Symbology for Polygons on page 866.

4. Add a Frame component next to the map component on the HTML page.
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5. With the map component selected, create a new task in the Tasks & Animations panel.

Set the following properties for the task.

Set the Trigger Type to Selection Changed.

For the Trigger, check the map layer whose selections should trigger the task.

For Requests/Actions, select Run Request and then customer_states3b.

Note: The Load task should also run this request so that it is populated as soon as
the HTML page is run.

For Target Type, select Frame.

For Target/Template Name, select the name of the frame where customer_states3b
will be run.

The Tasks & Animations panel should look similar to the following:

Configuring Maps to Interact With Other Components

914  Information Builders



6. On the parameters tab, make the map parameter populate the report parameter (drag the
REGION parameter onto the emfobject1 parameter and back down), as shown in the
following image.

Run the HTML page. The output will be similar to the following:
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Make a selection on the map using the selection widget. The report updates to show the
selected points on the map, as shown in the following image, in which the South and West
regions have been selected on the map.

Syntax: How to Drill Down From a WebFOCUS Request to Selections on a Map

The JavaScript function IbComposer_selectEsriMap can be used in a WebFOCUS StyleSheet to
make a selection on a WebFOCUS request and zoom to that selection on a map. The syntax is.

TYPE=DATA,
     COLUMN=requestcol,
      JAVASCRIPT=parent.IbComposer_selectEsriMap( \
     'mapobject' \
     'maplayer' \
     'mapfield' [\
     fieldvalue]
     ),

where:

requestcol

Is a designation for the drilldown column in the request.

'mapobject'

Is the object name for the map component that is the target of the drilldown.

'maplayer'

Is the name of the map layer that is the target of the drilldown.
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'mapfield'

Is the name of the map field that is the target of the drilldown.

fieldvalue

Is the field value of the target field, passed from the request when a drill-down link is
selected.

Example: Creating a Drilldown From a Report to a Map

This example has a report component named customer_states4 that has a drilldown from the
REGION field to the map component. The syntax follows. Paste it into the Text Editor and save
it as customer_states4.fex.

DEFINE FILE WF_RETAIL_LITE
STATE/A20 = WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.STATE_PROV_NAME;
REGION/A10 = IF STATE EQ 'Connecticut' OR 'Maine' OR 'Massachusetts' OR
    'New Hampshire' OR 'Rhode Island' OR 'Vermont' OR
    'New Jersey' OR 'New York' OR 'Pennsylvania' THEN 'Northeast'
    ELSE IF STATE EQ 'Illinois' OR 'Indiana' OR 'Michigan' OR 'Ohio'
    OR 'Wisconsin' OR 'Iowa' OR 'Kansas' OR 'Minnesota' OR 'Missouri'
    OR 'Nebraska' OR 'North Dakota' OR 'South Dakota' THEN 'Midwest'
    ELSE IF STATE EQ 'Delaware' OR 'Florida' OR 'Georgia' OR 'Maryland'
    OR 'North Carolina' OR 'South Carolina' OR 'Virginia' OR
    'Washington D.C.' OR 'West Virginia' OR 'Alabama' OR 'Kentucky' OR
    'Mississippi' OR 'Tennessee' OR 'Arkansas' OR 'Louisiana' OR
    'Oklahoma' OR 'Texas' THEN 'South' ELSE 'West';
END
TABLE FILE WF_RETAIL_LITE
SUM QUANTITY_SOLD
BY REGION
BY STATE
WHERE COUNTRY_NAME EQ 'United States'
ON TABLE SET PAGE NOLEAD
ON TABLE SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/
ENWarm.sty,$
TYPE=DATA,
     COLUMN=REGION,
     JAVASCRIPT=parent.IbComposer_selectEsriMap( \
     'emfobject1' \
     'State' \
     'REGION' \
      REGION \
     ),
$
END

The drilldown in the StyleSheet is on the REGION column. It uses the
IbComposer_selectEsriMap function to target the map object on the State layer using the
REGION field and the REGION values passed from the selected drill-down link.
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The map component will use the customer_states3 procedure, as described in the previous
example.

Use the following steps to set up the report request and map component.

Add the customer_states3 and customer_states4 requests to the HTML page in the
Requests & Data Sources panel.

Add a Frame component on the HTML page.

Set the Load task to run the customer_states4 request in the Tasks & Animation panel,
with the target being the frame you created.

Add a map component next to the report frame on the HTML page. Configure it to use the
customer_states3 request, the US state (Name) geographic role, the STATE_PROV_NAME
field. Name the layer State, as shown in the following image.

The map component in this example has been configured for unique symbology based on
the REGION field, as described in Configuring Unique Symbology for Polygons on page 866.
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Run the HTML page. The output should be similar to the following.

Click the Northeast link on the report. The map component zooms to that region with all of the
states selected, as shown in the following image.

You can change the selection by clicking another drill-down link on the report. You can also
change the extent or clear the selection using the map widgets.

Adding Before Load and After Load Events

You can add JavaScript events to occur before and after a map layer is loaded:

1. Draw an ESRI map component.

2. Add a map layer.
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3. Open the Properties panel, click the Events icon to open the list of events, and either
double-click Before Load or After Load or select Before Load or After Load and click the
ellipsis.

The Embedded JavaScript tab opens with a template for your JavaScript function.

4. Add your JavaScript code.

Every time a layer is ready, meaning that the layer has all its graphics, the event geometry-
complete is fired. The afterload event fires when geometry-complete has fired as many times as
there are data layers in the application. The load event fires after base maps and the first layer
(if it exists) have been added to the map (not drawn, just added).

There is a time gap between the time the afterload event fires and when you actually see the
layer in the map. This time gap is related to the time the map takes to render the layer. So the
layer is already in the map, but it has not rendered yet. There is no event that will fire after the
layer is finished rendering in the map.

Configuring Geographic Information

Geographic roles have been unified to access 58 world administrative boundaries down to the
postal code level. The server has a geographic configuration editor for customizing the list of
geographic roles, basemaps, reference layers, and demographic layers. A customized
geographic role can reference either an uploaded shapefile or an existing Esri Feature Layer.

Note:

You must configure the Adapter for ESRI ArcGIS in order to use many of the geographic
features. See the Adapter Administration manual for information on configuring the adapter.

The server must be configured for Unicode.

Procedure: How to Edit Geographic Configuration Settings

By default, the server is configured for unified geographic roles. This configuration is controlled
by the following settings.

1. Go to Workspace and click Edit settings on the Geo Services button on the ribbon.
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The Change Settings for GEO services page opens, as shown in the following image.

2. The following settings control unified geographic roles.

GEO_UNIFIED_ROLE. This compatibility setting must be turned on (the default) to
activate unified geographic roles. Turn it off to use geographic roles from prior
releases. On indicates that the new shorter set of geographic roles that combines
subsets of previously used roles will be used. Off will use geographic roles from
previously shipped releases.

GEO_MAP_PROVIDER. Assigns names of the providers of geographic maps. The list of
names should be separated with slashes to be used by transformation code for
mapping. Default is ALL. The currently supported set of providers includes WFRS
(geographic boundaries distributed in the Reporting Server) and ESRI.

GEO_ALIASING. On enables aliasing to map administrative entities. Aliasing is a
mechanism to support alternative names/spellings to the administrative names used
as keys to find the corresponding geometry. Caution, incorrect results will be reported
on a map in the case where the column data contains variations of names/spellings
for the same administrative entity (resolved to the same key). Alias names are stored
in .csv files. Shipped aliasing files are located in the geomaps sub-directory of the etc
folder under EDAHOME. The naming convention is geo_srv_dbl_geo_role. Each data file
has an associated synonym with the same name. Aliasing is currently supported for
the four geo roles COUNTRY, STATE, COUNTY, and CITY. The STATE aliasing data file
includes the valid country name for each state. COUNTY and CITY files include valid
country and state names. Valid means the actual key value used to fetch a geometry
The default value is off.
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GEO_ALIASING_APP. Sets an application name for user-added .csv files with aliases.
DEFAULT means no user files. User-added alias data files are supported for the four
geo roles COUNTRY, STATE, COUNTY, and CITY (see the description for the
GEO_ALIASING setting). The default value is DEFAULT, which uses the server aliasing
files.

The best practice is to copy the desired. csv file from the _edahome/etc/geomaps
folder to the application folder named in this setting, and edit it, changing aliases or
adding records with new ones. There are four focexecs named
geo_srv_mapkey_<geo_role> that have mandatory parameter ISO2 country name. The
following is a request example that reports city names for South Africa sorted by state/
province name.

EX geo_srv_mapkey_city ISO2='ZA'

Following is an example of user-created records (based on the obtained report):

"South Africa", "Gauteng", "Johannesburg", "City of Johannesburg" 
"South Africa", "Western Cape", "Paarl", "Drakenstein"

GEO_ALIASING_FIPS. On enables FIPS aliasing to US map administrative entities. This
setting requires GEO_ALIASING to be on. The data file with the United State FIPS
aliases is processed as an extension to the main aliases data file The default value is
off.

GEO_COUNTRY. Assigns a default value for an automatically added DEFINE field with
GEOGRAPHIC_ROLE 'Country'. This mechanism is in effect during the create metadata
process when the setting GEOROLES-AUTO is ON and a column with geo role COUNTRY
is not detected. The genreated DEFINE field will be used to create geo hierarchies
required in mapping. The default value is 'United States'.

GEOROLE_2_MBRLEVEL. CUSTOM enables customized per country mapping of the geo
roles (STATE, COUNTY, and CITY) to the MBR administrative levels. STANDARD sets
uniform mapping of geo roles (STATE, COUNTY, and CITY) for all countries to the MBR
administrative levels (1, 3, and 5 respectively). There is a geo_role2mbrlev focexec to
list countries with customized admin levels. The report does not depend on this
setting.

3. Click Save.
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Procedure: How to Edit the Geographic Configuration

The GEO configuration editor provides a tool for editing or adding properties for geographic
roles, basemaps, reference layers, and demographic layers. In addition, it enables you to add
maps and shapefiles to the configuration.

1. Go to Workspace and click Edit Configuration on the Geo Services button on the ribbon.

The GEO configuration editor opens displaying the configured geographic roles, as shown
in the following image.

You can select the following objects from the Object drop-down list.

Role.

Basemap.

ContextLayer.

You can edit the properties for a basemap or context layer (reference layer or demographic
layer), or add a new one. You cannot edit the properties of a standard geographic role. To
add a customized geographic role, you first add an Esri map or a shapefile (WFRS map)
and assign the geographic role to the map or shapefile.

The following standard unified geographic roles are configured by default and cannot be
changed. These geographic roles create a hierarchy that can be used to drill down or up
between levels of administration in maps, reports, or charts.

CONTINENT.

COUNTRY.

STATE.

COUNTY.

CITY.
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POSTAL CODE.

The following describes columns for geographic roles in the configuration editor.

name

Is the unique name of the geographic role. It cannot have spaces, but it can have
underscores (_).

Next to the name is an indicator of whether the role is a standard role or a customized
role.

title

Is the description of the geographic role that is displayed in reports and in drop-down
lists in the WebFOCUS tools.

returned_geometry

Is the type of geographic data returned from the map service for rendering on the map.

Valid values include:

GEOMETRY_AREA

GEOMETRY_POINT

GEOMETRY_LINE

2. To add a new basemap or customize an existing basemap, select Basemap from the
Object drop-down list.

The following image shows the GEO configuration editor with the Basemap object selected.
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Following is a description of the properties used for basemap configuration.

name

Is the name of the basemap.

Next to the name is an indicator of whether the basemap is a standard basemap or a
customized basemp.

icon

Is the name of the thumbnail for the basemap (for a standard basemap) or the URL to
the thumbnail (for a customized basemap) that will appear on the Basemap drop-down
list in the WebFOCUS tools or the Change Basemap map widget.

title

Is a title to display on the Basemap drop-down list in the WebFOCUS tools or the
Change Basemap map widget.

url

Is the URL to the map service that provides the basemap, for a customized basemap.
For a standard basemap, the URL is already stored in the server geographic
configuration file and is not displayed.

type

Valid values are tiled and vector.

addon_json

Specifies additional JSON properties for rendering the map.

To customize the properties of an existing basemap, click the down arrow next to a
basemap name or right-click the basemap line and click Customize BASEMAP.
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The Customize Basemap dialog box opens, as shown in the following image.

Edit the properties you want to change. If you change the URL, you can click Verify to
make sure the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor
Basemaps page.

To add a new basemap to the configuration, click Add.
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The Create a BASEMAP dialog box opens, as shown in the following image.

Enter a name for the basemap, a URL to the thumbnail, a title to display, and the URL
to the map service that provides the basemap, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO
configuration editor Basemap page.

3. To add a new context layer or customize an existing context layer, select ContextLayer from
the Object drop-down list.
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The following image shows the GEO configuration editor with the ContextLayer object
selected.

Following is a description of the properties used for context layer configuration.

name

Is the name of the context layer.

Next to the name is an indicator of whether the context layer is a standard context
layer or a customized context layer.

authorization

Is the type of authentication needed to access this context layer. Valid values are:

silent. Credentials for your ArcGIS application are provided in the connection string
of the Adapter for Esri ArcGIS.

Note: For instructions for configuring the Adapter for Esri ArcGIS, see the Adapter
Administration manual.

none. No authorization is needed.

named. User credentials are provided in the connection string of the Adapter for
Esri.

on premises. User credentials for a locally hosted ArcGIS server are provided in the
connection string of the Adapter for Esri.

layer type

Is the type of context layer. For a cached layer, the layer type is tile. For a layer that is
rendered dynamically, the layer type is featurelayer.
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title

Is a title to display on the demographic layer drop-down list in the WebFOCUS tools.

uri

Is the URL to the map service that provides the context layer.

addon_json

Specifies additional JSON properties needed for rendering the context layer. For
example, smartMapping properties define the border styles within the context layer.

To customize the properties of an existing context layer, click the down arrow next to a
context layer name or right-click the context layer line and click Customize context layer.

The Customize CONTEXTLAYER dialog box opens, as shown in the following image.

Edit the properties you want to change. If you change the URI, you can click Verify to
make sure the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor
Context Layers page.
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To add a new context layer to the configuration, click Add.

The Create a Customized CONTEXTLAYER dialog box opens, as shown in the following
image.

Enter a name for the context layer, the authorization type, a layer type, a title to
display, any additional JSON needed for rendering the context layer, and the URI to the
map service that provides the context layer, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO
configuration editor Context Layer page.

Reference: Editing the List of Geographic Roles

To add a geographic role to the configuration, you can add a new Esri map or a shapefile
hosted by the Server and associate a geographic role with the new map. You can also
implement NUTS geographic roles support.
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Adding a New Role for an Esri Map

To add an Esri geographic role, click Add ESRI map on the Geographic Configuration Editor.

The Create a new ESRI map role dialog box opens, as shown in the following image.

Configure the following map service properties.

name

Is a name for the geographic role.

title

Is a title to display in the WebFOCUS tools.

returned_geography

Select the type of geometry that is returned from the map service for this role. Valid values
are:

GEOMETRY_AREA. Returns JSON polygon definitions.

GEOMETRY_LINE. Returns JSON line definitions.
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GEOMETRY_POINT. Returns a JSON point.

url

Is the URL to the map service that provides the geographic data.

Click Verify after entering the URL to verify that the map service is available by going to the
specified URL.

Service Parameters

Add as parameters any additional geographic roles needed to identify the exact location of
the new role. For example, a city name needs state and country parameters.

The following properties add the WebFOCUS Regions role to the configuration.

Note: The parameter name corresponds to the field name in the FeatureLayer referenced in the
following URL:

http://services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS/rest/services/
wfretail_sub_regions/FeatureServer/0

Click OK when you have finished configuring the properties.
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The new role is added to the configuration as a customized role, as shown in the following
image.

Click Save to save this role to the configuration.
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The following request uses the WebFOCUS Regions geographic role in a map request.

DEFINE FILE WF_RETAIL_LITE

REGION/A50 (GEOGRAPHIC_ROLE=REGION) = BUSINESS_SUB_REGION;
END
 
GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
BY REGION
WHERE COUNTRY_NAME EQ 'United States'
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH CHOROPLETH
ON GRAPH SET STYLE *
TYPE=REPORT, CHART-LOOK=com.esri.map, $
TYPE=DATA, COLUMN=N2, BUCKET=color, $
*GRAPH_JS_FINAL
"extensions": {
"com.esri.map": {
"overlayLayers":
[
{
"ibiDataLayer": {
"map-metadata": {
"map_by_field": "
REGION"
}
}
}
],
"baseMapInfo":
{
"customBaseMaps":
[
{
"ibiBaseLayer": "gray"
}
]
}
}
}
*END
ENDSTYLE
END

Configuring Geographic Information

934  Information Builders



The output is shown in the following image.

Adding a New Role for a Server-Hosted Map

A server-hosted map is based on a shapefile. You must upload the shapefile (.dbf) to an
application folder accessible to the server. The server will transform it to ibijson format.

An ESRI shape file is actually a collection of at least four files:

.dbf file. The .dbf file is a standard database file used to store attribute data and object
IDs. A .dbf file is mandatory for shape files.

.shp file. The .shp file is a mandatory Esri file that gives features their geometry. Every
shapefile has its own .shp file that represents spatial vector data.

.shx file. The .shx file is a mandatory Esri shape index position file. This type of file is used
to search forward and backwards.

.prj file. The .prj file is an optional file that contains the metadata associated with the
shapefiles coordinate and projection system.

All files must have exactly the same name and to be located in the same directory. If they are
not, the shapefile conversion will fail.

When there are several possible keys associated with a geometry, a drop down list of detected
key names will be displayed. Select any one of these fields. No selection required when there
is a single geometry key.

The shapefile should only be in the GCS_WGS_1984 - World Geodetic System 1984 (decimal
degrees) coordinate system.
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To add a geographic role for a Server-hosted map, click Add WFRS map on the Geographic
Configuration Editor.

The Add WFRS hosted map dialog box opens, as shown in the following image.

Configure the following properties.

role name

Is a name for the geographic role.

Geometry type

Select either POLYGON or POINT from the drop-down list.

Esri shape

Enter the name of the application directory where the shapefile resides, or click the ellipsis
(...) to navigate to the application directory. Then select the .dbf file for the role.

Load to app

Enter the name of the application directory where you want to place the ibijson file, or click
the ellipsis (...) to navigate to the application directory.

Quantization type

Quantization is the process of transforming a large set of input values to a smaller set of
values. When transforming the shapefile, the server will quantize points that are too close
together in order to optimize map rendering performance. Two methods are available for
quantization, LINEAR or GRID. The default is LINEAR.

Quantization_X

Is the threshold value for the x-axis.
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Quantization_Y

Is the threshold value for the y-axis.

If the map has multiple keys, a drop-down list displays so that you can select one, as shown in
the following image.

Click OK when you have finished configuring the properties.

The new role is added to the configuration as a customized role, as shown in the following
image.

Click Save to save this role to the configuration.
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You can test the role by right-clicking the role in the configuration editor and clicking Test. A
sample map will be generated, as shown in the following image.

Adding NUTS Support

Nomenclature of territorial units for statistics (NUTS) are geographic roles specific to the
European Union.

To add NUTS geographic roles to the configuration, click Add NUTS support on the Geographic
Configuration Editor.
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The NUTS geographic roles are added, as shown in the following image.

Click Save to save these roles to the configuration.

Adding Support for Extended Postal Codes

Click Add extended postal codes to add support for Level 1 and Level 2 postal codes used in
certain countries.

Customizing Vocabulary Rules

For each geographic role, a set of vocabulary rules define how to recognize when a field name
should automatically be assigned to that role. If you right-click a role, you can click Customize
vocabulary from the context menu.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be
satisfied). Each vocabulary element contains words enclosed with special characters. Words in
the rule element are connected by the Boolean logic operation AND (all need to be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a placeholder
for any sequence of characters. If an element contains more than one word, each word has to
be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in
the column name. Minus indicates that word must not be found in the column name.
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For example, the following are the vocabulary rules for the role COUNTRY.

To add another rule, click Add optional.

When you are finished, click OK.

Click Save to save these rules to the configuration.

Adding an Esri Proxy URL

All of the configured proxy URLs for retrieving data from Esri are stored in the file esri-arcgis-
rest.xml, which is located under your WebFOCUS configuration directory. For example, the
default configuration directory on Windows is, C:\ibi\WebFOCUSxx\config, where xx is your
release of WebFOCUS (for example, 82). The file contains configuration properties followed by
a list of Esri proxy URLs, which start with the characters <ESRI_URL.

To add a new proxy URL, add a new <ESRI URL line to the <WF_ESRI_ARCGIS_PROXY> list in
the esri-arcgis-rest.xml file. We recommend that you add the proxy URL prior to using the URL
to define a new geographic role.
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The syntax for a public proxy URL is:

<ESRI_URL URL="public_proxy_url" DESCRIPTION="Public access data" />

where:

public_proxy_url
Is your public proxy URL.

The syntax for a restricted proxy URL is:

<ESRI_URL PROFILE_ID="default" URL="restricted_proxy_url" 
DESCRIPTION="Restricted access data" />

where:

restricted_proxy_url
Is your restricted proxy URL.

Following are sample public Esri proxy URLs from the esri-arcgis-rest.xml file.

<ESRI_URL URL="http://services.arcgisonline.com/ArcGIS" DESCRIPTION="Public 
access data" />
    <ESRI_URL URL="http://services.arcgisonline.com/arcgis" 
DESCRIPTION="Public access data" />
     <ESRI_URL URL="http://static.arcgis.com/attribution" 
DESCRIPTION="Public access data" />

Following is a sample restricted Esri proxy URL from the esri-arcgis-rest.xml file.

<ESRI_URL PROFILE_ID="default" URL="http://www.arcgis.com/sharing/rest" 
DESCRIPTION="Restricted access data" />

Installing and Configuring Esri on Premise

The Esri on Premise feature enables customers to generate Esri maps using a locally hosted
Esri server, making it unnecessary to go to ArcGIS Online or another outside site for
basemaps, geographic roles, and the geometry task (the service that performs operations on
input geometries such as projecting geometries into a different spatial reference). This feature
enables the App Studio Esri Viewer feature to leverage all GIS Enterprise Data developed by a
customer with intranet connectivity.

When a site uses Esri on Premise, the following geographic elements must be customized to
be retrieved from the local Esri server.

Geographic roles. For information on configuring custom geographic roles, see Editing the
List of Geographic Roles on page 930.

Basemaps. For information, see How to Edit the Geographic Configuration on page 923.
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Geometry task.

Demographic layers.

Note: All on-premise published feature layers should be published on a CORS-enabled ArcGIS
Server and avoid proxy on client.

Procedure: How to Install and Configure Esri on Premise

1. Download the ArcGIS Online API for JavaScript.

a. Go to https://developers.arcgis.com/downloads/ > ArcGIS API for Javascript > Version
3.22, as shown in the following image.

Note:

You may be prompted to sign in with your Esri credentials.

Even if a newer version of the API is available, it is critical that you download and
use the 3.22 version.

b. Click API to download the API.

2. Unzip the API.

a. Create a folder called arcgis_api under:

webfocusdir\config\web_resource\

where:

webfocusdir
Is the directory where WebFOCUS is installed.

b. Navigate to the following subfolder in the zip file you downloaded:

arcgis_js_v322_api\arcgis_js_api\library\3.22\3.22
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Extract its contents to the folder you created in step 2:

webfocusdir\config\web_resource\arcgis_api

3. Configure the WebFOCUS Administration Console for Esri on Premise.

a. In the WebFOCUS Administration Console, click ESRI, and in the Esri on Premise text
box add the path to the folder in which you unzipped the API, as shown in the following
image.

This identifies the path to the internal ArcGIS Javascript API Source that develops Esri-
based maps. This setting is blank, by default, meaning that the use of the internal API
Source to develop Esri maps is not activated. The API referenced by default is https://
js.arcgis.com/3.22/. To direct WebFOCUS to use the internal ArcGIS Javascript API to
develop Esri maps, type the path to it in this text box.

This path should be a relative path accessible to the local WebFOCUS installation.
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b. Click Save.

4. Clear your browser cache.

Once you have installed and configured the API, you must configure the locally hosted
geometry task when creating a map.

The geometry task is the service that performs operations on input geometries, such as
projecting geometries into a different spatial reference. You configure the geometry task in the
Esri Viewer Properties panel when creating a map. Add the URL to the locally hosted geometry
task in the Map: Geometry Service text box of the Esri Viewer Properties panel, as shown in
the following image.

Using the Reporting Server Geographic Configuration tool, configure locally hosted, roles,
basemaps, and demographic layers.
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Chapter11
Working With Source Control

When you have multiple users working on the same files, you can prevent conflicting
updates by using a source code management (SCM) system, such as Team Foundation
Server. An SCM system allows a user to check out a file for editing and prevents other
users from checking it out until the first user checks it back in. 

This topic describes how to implement Source Control in App Studio.

In this chapter:

Using Source Control in App Studio

Microsoft Team Foundation Server Requirements and Configuration

Using Source Control in App Studio

Through the Source Control feature, you can use App Studio to manage files and add them to
the Source Control system repository. Your Source Control provider must first be configured in
the WebFOCUS Administration Console. For more information, see the WebFOCUS Security and
Administration manual.

Within an App Studio domain, you can add a published folder to Source Control. Within a
designated folder, you can add individual files to Source Control.

Source Control Benefits

Source Control is a feature that provides many benefits to developers, including the following:

A valuable feature for companies that need to audit changes made to their applications.

A repository to store your source code, providing backup in a central location.

A historical record of changes over time.

Ability to review and compare changes.

Ability to retrieve a specific version of a file.

Ability to compare files between WebFOCUS and Source Control.
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Source Control Requirements and Usage Notes

The following are requirements and usage notes when using Source Control:

WebFOCUS must be configured for Source Control.

You must be signed in to WebFOCUS and to Source Control.

Source Control operations are available while working in the Domains area.

Folders and files in the Domains area need to be Published.

Source Control operations are not available if an item is not Published.

Source Control is not available when accessing WebFOCUS from a browser. Development
against a WebFOCUS environment from a browser client should be avoided to ensure that
there are no conflicts in files, as files may be modified and changes may be overwritten.
When using Source Control, all development must be performed through App Studio.

Source Control operations are supported with the following file types:

.fex

.htm

.html

.css

.js

.pdf

.sql

.sty

.txt

.url

.xls

.xlsx
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Source Control operations are supported with the following image files:

.bmp

.gif

.jpg

.png

Currently, Source Control operations are not supported with the following:

ReportCaster related files

Distribution List: .adr

Access List: .acl

Schedules: .sch

Library content: .lib

Business Intelligence Portal related files

Portal files .page and .prtl

Blog files .blog

Source Control operations are not available for My Content files, including Shared files.

Single-file check out configuration needs to be implemented and enforced by the version
control system, meaning that the same file cannot be checked out by multiple users.

How Source Control Works

When you start App Studio, it checks the WebFOCUS instance to determine if it is configured
for Source Control.

If WebFOCUS is configured for Source Control and the App Studio user provides Source Control
credentials, App Studio enables options to perform Source Control operations against the
connected WebFOCUS environment.

11. Working With Source Control
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Procedure: How to Test Source Control From App Studio

1. When configuring a new WebFOCUS environment for App Studio, the product prompts you
to connect to WebFOCUS to validate the connection and, if App Studio detects that the
environment is configured for Source Control, it prompts you to connect to Source Control,
as shown in the following image.

If you select Yes, a prompt to provide Source Control credentials is presented. Source
Control credentials are validated and saved for the current and future sessions of App
Studio. The Environment Properties dialog box closes, you can proceed, use the new
environment, and perform Source Control operations without getting prompted to sign
in to WebFOCUS or Source Control. Source Control credentials are cleared when you
select the Disconnect from Source Control operation.

Note: If you type invalid credentials, you will receive an error message.

If you select No, the environment is saved and Source Control operations are disabled.
You can proceed and perform development against the new environment without
getting prompted to sign in to WebFOCUS or Source Control. Signing out of the
environment and attempting to work with the same environments properly prompts the
user to sign in to WebFOCUS and optionally to Source Control. The same applies when
restarting App Studio.

Note: If a WebFOCUS environment is configured for Source Control and you are not
connected to Source Control, App Studio starts and you are prompted to connect to both
WebFOCUS and Source Control when attempting to use the Source Control configured
environment.

2. You can also connect to or disconnect from Source Control, on demand.
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To connect to Source Control on demand, right-click the environment in the Configured
Environments Tree panel and select Connect to Source Control, as shown in the
following image.

To disconnect from Source Control on demand, right-click the environment in the
Configured Environments Tree panel and select Disconnect to Source Control, as shown
in the following image.

Procedure: How to Add Folders and Files to Source Control

As a first step, you must first add a published domain folder to Source Control or select
specific files to be added to Source Control.

Note: If files and folders are not published, Source Control options are not available. The same
applies if you are not connected to Source Control.

1. To publish a folder, right-click the folder and select Publish from the shortcut menu.
Content in this folder may now be accessed by other users.
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2. To add a published folder to Source Control, right-click the folder and select Source Control
from the shortcut menu.

The Source Control shortcut menu displays.

If the Source Control shortcut menu does not display, the WebFOCUS environment is not
configured for Source Control. For more information on configuring a WebFOCUS
environment for Source Control, see the WebFOCUS Security and Administration manual.

3. Select Add to Source Control from the shortcut menu, as shown in the following image.
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The Add to Source Control dialog box opens, as shown in the following image.

4. Select the Include Subfolders check box to add all items, including subfolders and files in
these folders, to the Source Control database.

This operation binds your selected folder to a folder with the same name in the Source
Control database, and adds all folders and files, based on your selection.

To verify this, select the folder and open the File/Folders Properties panel. The Source
Control Status property value is Added to Source Control.

A folder that has been added to Source Control may contain files that are added to Source
Control, and also files that are not.

Note: Files in a published folder are accessible to all developers.

Procedure: How to Remove a Folder From Source Control

1. To remove the association of a WebFOCUS folder from Source Control, right-click the folder
and select Source Control from the shortcut menu.

The Source Control shortcut menu displays.
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2. Select Unbind from Source Control from the shortcut menu, as shown in the following
image.

Reference: Source Control Icons

The following table describes how App Studio uses the icons in the Configured Environments
tree to indicate the status of a file in Source Control.

Icon Description

The folder has been added to Source Control.

The file has been added to Source Control.

The file has been checked out by the current user.

The file has been exclusively checked out by another user.

Note: Files not added to Source Control do not have overlay icons.
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Example: Source Control Icons in the Configured Environments Tree

The following image shows an example of Source Control icons for added and checked out
folders and files in the Configured Environments tree.

Procedure: How to Check Files In and Out of Source Control

1. To check out a file for editing, right-click the file and select Source Control from the
shortcut menu.

The Source Control shortcut menu displays.
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2. Select Check Out from the shortcut menu, as shown in the following image.
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The Check Out dialog box opens, as shown in the following image.

3. Select Do not update the file in the WebFOCUS repository to only mark the file as checked
out and not update the file currently in the WebFOCUS repository with the version of the
file that is in the Source Control database. This allows you to preserve changes that are
made to the WebFOCUS version of the file. A later check in operation will update the
Source Control file with the one from WebFOCUS. Optionally, you may type a comment
describing your edits and click OK.
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The Check Out dialog box closes, and the file is marked as checked out in App Studio and
in the Source Control repository. The Source Control Status property value in the File/
Folder Properties panel is Checked out by <user name>, as shown in the following image.

Note: If the Check Out option is not available from the shortcut menu, it means that
another user has checked out the file. To verify this, open the File/Folders Properties
panel. The Source Control Status property value is Checked out by <user name>.
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4. To check the file in after making edits, save the file, right-click the file, and then select
Source Control from the shortcut menu.

The Source Control shortcut menu displays.

5. Select Check In from the shortcut menu.

The Check In dialog box opens, as shown in the following image.

6. Select Keep checked out to update the file in Source Control and keep the file as checked
out. Optionally, you may type a comment describing your edits and click OK.

The Check In dialog box closes.

7. Close the file.

To verify, open the File/Folders Properties panel. The Source Control Status property value
is Added to Source Control.

Reference: Source Control Status

The following are the Source Control status values that display in the App Studio File/Folder
Properties panel:

Connection to Source Control is not available

Added to Source Control/Bound to a Source Control project (folder level)

Source Control status was not retrieved for the selected item/Not bound to a Source
Control project (folder level). This occurs when a folder has not been added to Source
Control or has been unbound.

Added to Source Control (file level)
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Not added to Source Control (file level)

Source Control status was not retrieved for the selected item (file level).

File type not supported by the WebFOCUS Source Control system

Checked out by <user name>. This status displays for the current user and also for an
exclusive check out by another user.

Procedure: How to Undo a Check Out From Source Control

If you decide that you do not want to make changes to a file, you can undo its check out from
Source Control.

1. To undo a check out, right-click the file and select Source Control from the shortcut menu.

The Source Control shortcut menu displays.
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2. Select Undo Check Out from the shortcut menu, as shown in the following image.
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The Undo Check Out dialog box opens, as shown in the following image.

If you select Update the WebFOCUS file, if the WebFOCUS file is different than the one
in Source Control, the WebFOCUS copy gets replaced with the latest version of the file
from the Source Control database. This is ignored if the WebFOCUS file has not
changed.

If you select Discard All Changes (Force Undo), it forces an undo check out if the file in
the WebFOCUS repository is different than the latest version of the file in the Source
Control database.

Note: Keeping the default options ensures that all changes will be discarded.

Procedure: How to Retrieve the Latest Version of a Folder or File

You can retrieve the latest version of a folder or file from the Source Control database and
update the file in the WebFOCUS repository.

1. To retrieve the latest version of a folder, right-click the folder and select Source Control
from the shortcut menu.

The Source Control shortcut menu displays.
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2. Select Get Latest Version from the shortcut menu, as shown in the following image.

The Get Latest Version dialog box opens, as shown in the following image.

11. Working With Source Control

WebFOCUS App Studio User’s Manual  961



3. Select one of the following options:

Update WebFOCUS Folder Properties Only to update WebFOCUS folders only.

Update WebFOCUS Folder Properties and Files to update WebFOCUS folders and
children (files under the selected folder), using the latest version from Source Control.

Update WebFOCUS Folder Properties, Subfolders, and Files to update WebFOCUS
folders, children (files under the selected folder), and subfolders, using the latest
version from Source Control.

Note: If you select this option, the Add New Projects check box is activated. Use this
option if you have a folder or file that is in Source Control that you want to add back to
WebFOCUS.

You can also use this option to get an entire new project from Source Control to
WebFOCUS (the folder does not exist in WebFOCUS). To do this, create an empty folder
in WebFOCUS that exactly matches the name and case of the folder name in Source
Control. On the Get Latest Version dialog box, select the Update WebFOCUS Folder
Properties, Subfolder, and Files and Add New Projects options.

Procedure: How to View the History for a Specific File

Using the History feature, you can view information about a file, such as version history, date
of creation or modification, and other details. You can also compare two versions of a file.

1. To view information about a file, right-click the file and select Source Control from the
shortcut menu.

The Source Control shortcut menu displays.
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2. Select Show History from the shortcut menu, as shown in the following image.
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This History dialog box opens, as shown in the following image.

The following table describes the options that are available on the History dialog box.

Button Description

Close Closes the History dialog box. This option is always enabled.

View Opens the selected version of the file in an editor. This option is
disabled for multi-select. The viewer program can be set by a user, and
is defaulted to notepad.exe.

Details Displays the summary of a selected revision in a viewer. The same
viewer is used for the View option. This option is disabled for multi-
select.

Get Updates the WebFOCUS version with the selected revision. This option
is disabled for multi-select.

Check Out Checks out the selected revision. This option is disabled for multi-
select.
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Button Description

Diff Enables you to compare two versions of a file from Source Control:

If a single row is selected, the selected revision and current
WebFOCUS version will be compared.

If two rows are selected, the two selected revisions will be
compared.

The diff program can be set by a user, and is defaulted to fc.exe.
Batch program RunFC.bat, located in the bin folder, is used to perform
the file comparison.

Report Displays a summary for all of the revisions. The same viewer is used
for the View option. This option is always enabled.

Diff and View
Setup

Opens the History Viewer and Diff Setup dialog box, which enables you
to configure the editor and application used as a Compare tool. This
dialog box includes edit input controls for specifying the following:

Text Viewer Command Line for viewing text content.

Binary Viewer Command Line for viewing binary content.

Text Diff Command Line for viewing the difference between text
content.

Binary Diff Command Line for viewing the difference between binary
content.

For more information, see Diff and View Setup Dialog Box on page
966.
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Reference: Diff and View Setup Dialog Box

The Diff and View Setup dialog box is shown in the following image.

You can type, copy-and-paste, or click the browse buttons located next to the edit controls to
update the configuration and specify other programs. The browse buttons open the standard
Windows Files Open dialog boxes.

By default, the product is configured to use the Windows built in editor notepad.exe. For
compare, file RunFC.bat is configured to use the Windows fc.exe Compare tool and passes as
arguments the two selected versions of the file, in addition to setting arguments /A and /N.

where:

/A

Abbreviates the output of an ASCII comparison. Instead of displaying all of the lines that
are different, fc displays only the first and last line for each set of differences.

/N

Displays the line numbers during an ASCII comparison.
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Performing a diff with these options displays the output in a command window, as shown in
the following image.

Optionally, you can customize the Compare tool and editor. The Compare application you
select needs to support the running from a command window and allow a user to pass, as
input, the file names to be compared, for example, as done in RunFC.bat and the new sample
Compare.bat.
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The following example uses Notepad++ as the editor and Compare.bat as a new batch file that
is configured to use the Compare tool KDiff3, as shown in the following image.

The following is in the compare.bat file:

ECHO OFF
cls
cmd /K "C:\Program Files (x86)\KDiff3\kdiff3.exe" %1 %2
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The following image shows an example of a diff request using the above configuration.

Note: This process opens a command window that needs to be closed manually.

Procedure: How to Show Differences Between WebFOCUS and Source Control Files

You can show the difference between a file in WebFOCUS and the file in the Source Control
database.

1. To show differences between files, right-click the file and select Source Control from the
shortcut menu.

The Source Control shortcut menu displays.
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2. Select Show Differences from the shortcut menu, as shown in the following image.

If there are no differences between the files, you will receive a no difference
encountered message.

If there are difference between the files, the differences display in the Compare tool
that is configured on your machine.

Note: Files for comparison get downloaded to the local temp folder on the user machine.
For example, %LOCALAPPDATA%\Temp, which is mapped to C:\Users\<username>
\AppData\Local\Temp.
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Reference: Supported Source Control Operations

Folder Level Operations

Get Latest Version. Select this option to retrieve the latest version of the folder from the
Source Control database and update the folder properties in the WebFOCUS repository.
This also contains options to update folders and files and to retrieve new files.

Add to Source Control. This is the first operation to add folders or files to Source Control.

The Include Subfolders option adds all items, including subfolders and files in these
folders, to the Source Control database.

Bind to Source Control. Associates the WebFOCUS item with a copy in the Source Control
database.

This is needed to perform further commands, such as Check In, Check Out, and Get.

The Bind to Source Control option is enabled only when a folder is added to Source
Control and it is later unbound.

Unbind from Source Control. Select this option to disassociate the connection of the
WebFOCUS item with the copy in the Source Control database and disable all Source
Control commands.

Note: Unbind does not remove the item from the Source Control database.

File Level Operations

Get Latest Version. Select this option to retrieve the latest version of the file from the
Source Control database and update the file in the WebFOCUS repository.

Check Out. To make changes to a file in Source Control, you must first check it out of the
Source Control database.

The Check Out option retrieves the latest version of the selected file and allows you to edit
it.

You can control the replacement of the local WebFOCUS file copy by selecting Do not
update the file in the WebFOCUS repository. When this option is selected, the file is only
marked as checked out and it does not update the file currently in the WebFOCUS
repository with the version of the file that is in the Source Control database. This allows
you to preserve changes that are made to the WebFOCUS version of the file. A later check
in operation will update the Source Control file with the one from WebFOCUS.
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Check In. Select this option to return a checked out file to the Source Control database.
Source Control stores any changes made to the file in the database.

The Keep checked out option updates the file in Source Control and keeps the file as
checked out.

Undo Check Out. Select this option to reverse a check out and cancel any changes made
to a file in your working area.

If you select the Update the WebFOCUS file option, if the WebFOCUS file is different than
the one in Source Control, the WebFOCUS copy gets replaced with the latest version of
the file from the Source Control database. This is ignored if the WebFOCUS file has not
changed.

If you select the Discard All Changes (Force Undo) option, it forces an undo check out if
the file in the WebFOCUS repository is different than the latest version of the file in the
Source Control database.

Note: Keeping the default options ensures that all changes will be discarded.

Add to Source Control. This is the first operation to add folders or files to Source Control.

The Include Subfolders option adds all items, including subfolders and files in these
folders, to the Source Control database.

Show History. Select this option to view information about a file, such as version history,
date of creation or modification, and other details. This also enables the comparison of two
versions of the file.

Show Differences. Allows a comparison between the file in WebFOCUS and the file in the
Source Control database.

Microsoft Team Foundation Server Requirements and Configuration

WebFOCUS App Studio supports Team Foundation Server (TFS) as a Source Control provider.
Information Builders has tested and certified Team Foundation Server version 2013 and 2015.

The following section describes the requirements and configuration for Team Foundation
Server.
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Procedure: How to Configure Team Foundation Server

A Team Project must exist on the Team Foundation Server. This project holds the files
associated with the WebFOCUS Repository.

1. In order to properly work with the WebFOCUS Source Control feature, configure the project
to allow only single check outs, as shown in the following image.
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2. The workspace type for the Team Project Collection needs to be configured by selecting
Server and clearing the Enable file merging and multiple check-out check box, as shown in
the following image.

3. Select the File Types tab and then click Edit.
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The Edit File type dialog box opens, as shown in the following image.

Note: WebFOCUS uses the Team Foundation Server API to automatically create a
workspace for each of the users that have access to the Team Project Collection. These
workspaces are created on the machine where WebFOCUS is installed.
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Working With Team Foundation Server in WebFOCUS

When WebFOCUS domains or folders are initially added to the configured Team Foundation
Project, a structure that matches the internal WebFOCUS Repository structure is created. For
example, if the project is called $/Test1, adding a WebFOCUS folder named Retail_Samples
creates the default top-level folder WFC/Repository. Under this location, WebFOCUS creates
the Retail_Samples folder, in addition to any other folders or files added to Source Control. An
example of this is shown in the following image.

For every folder, there is an additional file created, called .dmeta. The .dmeta file contains
the properties of the folder.

For every file added, there is a file item with the contents of the file, and an additional file
created, called .fmeta. The .fmeta file contains the properties of the file.

When performing operations, such as checking out a file, updating, and so on, both the file
and folder content and the properties files are retrieved and updated, based on the selected
Source Control operation.

Reference: Usage Notes

The following are usage notes for Team Foundation Server when using WebFOCUS.

WebFOCUS folders match to a folder with the same name in the Source Control repository.

Due to the Team Foundation Server single file check out feature, files can only be checked
out by a single user at a time.
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The option to check out a file is not enabled if a file is exclusively checked out by another
user. In this case, the Source Control status displays the user account that has the file
checked out, and the overlay icon shows that the file is exclusively checked out.
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AppendixA Creating, Viewing, and Editing Source
Syntax

In App Studio, you can create, view, and edit the source syntax for procedures, procedure
components, and other types of files required by your projects.

This topic describes the Text Editor that is available when you are developing the source
syntax for procedures, procedure components, and other types of files.

In this appendix:

Accessing the Text Editor

Accessing the Text Editor

App Studio provides a fully integrated Text Editor that you can use to create, view, and edit the
source syntax for procedures, procedure components, and other types of files required by your
applications. 

You can access the Text Editor tab by right-clicking a procedure in the Environments Tree
panel, selecting New and Procedure via Text Editor or Text Document. You can also access the
Text Editor tab by selecting the Embedded JavaScript or Embedded CSS view tabs in the HTML
canvas. Some commands are unavailable while in the Text Editor tab accessed through the
Embedded JavaScript or Embedded CSS view tabs.

The Text Editor tab is shown in the following image.

Note: The Text Editor tab shares groups with the Command Console tab. However, in addition
to these groups, the Command Console contains the Execution Path and Edit groups. For more
information, see Sending Commands to the Server Using the Command Console on page 78.

In addition, you can:

Take advantage of color-coded syntax designed to make writing, editing, and debugging
procedures easier.

Bookmark lines of a file for quick editing and easy reference.

Find and replace text.
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Run procedures or procedure components directly from the Editor.

Finding or Replacing Text Using the Find Group

The Find group contains options that enable you to find or replace text. The Find group is
shown in the following image. 

The commands in this group are:

Find 

Finds the specified text. You can also press Ctrl+F to activate the Find dialog box.

Next 

Finds the next instance of the specified text.

Previous 

Finds the previous instance of the specified text.

Replace 

Replaces specific text with different text.

Select All 

Selects all of the text in the procedure.

Reference: Find Dialog Box

You can use the options on the Find dialog box to indicate how to search for information.

The options on the Find dialog box are:

Find what 

Provides a text box where you can specify the text that you want to find. Optionally, you can
click the arrow to select a search term or phrase that was previously specified.

Match whole word only 

Select this option to match the whole word only.
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Match case 

Select this option to match the uppercase or lowercase value, as specified in the Find
what field.

Direction 

Select up or down to indicate the direction in which the Text Editor should search.

Find Next 

Allows you to find the next instance of your search term.

Mark All 

Marks all instances of your search term in the Text Editor.

Cancel 

Cancels the current search and closes the Find dialog box.

Reference: Replace Dialog Box

You use the options on the Replace dialog box to indicate how to use the find feature to find
and replace information.

The options on the Replace dialog box are:

Find what 

Provides a text box where you can specify the text that you want to find. Optionally, you can
click the arrow to select a search term or phrase that was previously specified.

Replace with 

Provides a text box where you can specify the text that is going to replace the text for
which you are searching. Optionally, you can click the arrow to select a replacement term
or phrase that was previously specified.

Match whole word only 

Select this option to match the whole word only.

Match case 

Select this option to match the uppercase or lowercase value, as specified in the Find
what and Replace with fields.

Replace In 

Enables you to specify where you would like the replacement to occur. Options include
Selection or Whole file.
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Find Next 

Allows you to find the next instance of your search term.

Replace 

Replaces the search information that you specified in the Find next field with the text or
other information that you indicated in the Replace with field.

Replace All 

Allows you to automatically replace all instances of the search term you indicated in the
Find next field with the information you specified in the Replace with field.

Cancel 

Cancels the current search and replaces and closes the Replace dialog box.

Working With Bookmarks Using the Bookmarks Group

The Bookmarks group enables you to turn bookmarks on or off, find the next bookmark, find
the previous bookmark, and delete all bookmarks. The Bookmarks group is unavailable when
you access the Text Editor tab through the Embedded JavaScript or Embedded CSS view tabs,
in the HTML canvas. The Bookmarks group is shown in the following image. 

The commands are:

Toggle 

Turns bookmarks on or off.

Next 

Goes to the next bookmark.

Previous 

Goes to the previous bookmark.

Delete All 

Deletes all bookmarks.
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Placing the Cursor Using the Position Group

The Position group allows you to place your cursor at the desired line and allows you to turn off
line numbers. The Position group is shown in the following image.

The commands are:

Goto Line 

Displays the current line your cursor is on. You can type a different line number into the
text box to place your cursor on that line.

Show Line Numbers 

When selected, displays line numbers. This option is selected, by default.

Changing the Case of Text Using the Case/Comment Group

The Case/Comment group contains options for changing selected text to uppercase or
lowercase. The Case/Comment group is unavailable when you access the Text Editor tab
through the Embedded JavaScript or Embedded CSS view tabs, in the HTML canvas. The
Case/Comment group is shown in the following image.

The commands are:

Upper 

Changes the selected text to uppercase (all capital letters).

Lower 

Changes the selected text to lowercase (all lowercase letters).

Change Case 

Changes the case of the selected text to lowercase or uppercase depending on how the
selected text appeared first. You can also change the case of selected text by using the
shortcut menu on the canvas, while text is selected.
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Add Comment 

Inserts a new comment line if your pointer appears on a new line or changes an active line
of text to a comment. You can also use the shortcut menu on the canvas to add a
comment.

Remove Comment 

Deletes the previous comment change. This option is similar to the Undo command on the
Quick Access Toolbar. You can also use the shortcut menu on the canvas to remove a
comment.

Formatting Text Using the Options Group

The Options group contains commands that you can use to format the text in a procedure. The
Options group is unavailable when you access the Text Editor tab through the Embedded
JavaScript or Embedded CSS view tabs, in the HTML canvas. The Options group is shown in
the following image.

Note: When you access the Text Editor through the Embedded JavaScript or Embedded CSS
view tabs, the only option in the Options group is Font Style.

The commands are:

Font Style 

Opens the Font and Color Settings dialog box from which you can modify the appearance of
the syntax in a procedure.

Show Whitespace 

Replaces spaces between characters with a visual indicator.

Tab Size 

Controls the number of spaces a tab character uses.

Tab Options 

Provides the options to control tab characters. You can substitute spaces for tab
characters or keep tab characters in the syntax.
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Auto Indent 

Automatically indents the syntax within a procedure.

Reset All 

Restores all options back to the default settings.
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AppendixB
Selenium Browser Support

App Studio uses Selenium WebDriver 3.0 and the corresponding stand-alone driver
executables for Mozilla Firefox, Google Chrome, and Microsoft Edge in order to support
multiple browsers.

In this appendix:

Selenium Browser Tiers

Updating the Selenium Software and Driver Executables

Selenium Browser Tiers

The following three-tier architecture explains how multi-browser support is implemented in App
Studio. It also provides steps for updating browser drivers for automatic browser updates for
Firefox, Chrome, and Microsoft Edge.

The first tier is an Information Builders browser dll (IBIWebBrowserDrivers_dotnet_35.dll). This
acts a bridge between App Studio and the second tier Selenium Web drivers (WebDriver.dll and
Webdriver.Support.dll). The Selenium drivers communicate with the browsers through the third
tier.

The third tier consists of stand-alone executables provided by the browser vendors:
geckodriver.exe for Firefox, chromedriver.exe for Chrome and MicrosoftWebDriver.exe for
Microsoft Edge.

The executables are located in the bin folder of the App Studio installation. For example,
C:\ibi\AppStudio82\bin.
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The following image shows the Selenium browser support tier setup.

Note:

Information Builders browser dll updates are available in new or maintenance releases of
App Studio.

The Selenium WebDriver and the corresponding stand-alone driver executables are
available as free downloads.

When new updates or versions of the browsers are installed, you may need to update the
other three tiers. Otherwise, the browser automation may yield unexpected results or may
not function at all.

Selenium browsers only retain the language selection for the request being run. For
example, if the result of a request is a drill-down report, clicking the drill-down link will
produce the report in the default language. Only HTML reports will be able to retain the
IBIWF_language cookie.

Updating the Selenium Software and Driver Executables

These topics describe how to update the Selenium software and the corresponding stand-
alone driver executables.
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The most frequently updated tier is the second tier (Selenium WebDriver.dll and
WebDriver.Support.dll modules). The updates to these two modules can be found at http://
www.seleniumhq.org/download/. Since App Studio uses C# and .Net version 4.0 to
communicate with Selenium, you need to download the .Net 4.0 version of the Selenium
modules.

Procedure: How to Download the Selenium Modules

1. Navigate to the following URL:

http://www.seleniumhq.org/download/

2. Locate the Selenium Client & WebDriver Language Bindings section.

3. Select the download link for the zip file that corresponds to C# language, as shown in the
following image.

4. Once the zip file is downloaded, extract the content to a folder and navigate to the net40
subfolder, as shown in the following image.

Note: Back up the existing .dll files prior to copying the files.

5. Copy the WebDriver.dll and WebDriver.Support.dll files to the bin folder of the App Studio
installation. For example, C:\ibi\AppStudio82\bin.

6. If you are familiar with NuGet, you can go directly to http://www.nuget.org/packages/
Selenium.WebDriver or select the WebDriver download link from the C# NuGet section of 
http://www.seleniumhq.org/download/.
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7. Copy the .Net 4.0 content of the NuGet package into the bin folder of the App Studio
installation. For example, C:\ibi\AppStudio82\bin.

Procedure: How to Update the geckodriver.exe for Mozilla Firefox Automation

Updates to the geckodriver.exe executable can be found at https://github.com/mozilla/
geckodriver/releases, which is a website used to track changes to the software. A typical entry
on the page will indicate what was done in a particular version of geckodriver.exe, followed by
a series of download links.

1. Select the download link relevant to the version of Windows you are running, as shown in
the following image.

2. Download the zip file to a folder and extract the content.

Note: Back up the existing geckodriver.exe file prior to the copy.

3. Copy the geckodriver.exe executable to the bin directory of the App Studio installation. For
example, C:\ibi\AppStudio82\bin.
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Procedure: How to Update chromedriver.exe for Google Chrome Automation

Updates to the chromedriver.exe executable can be found at https://sites.google.com/a/
chromium.org/chromedriver.

1. Navigate to the Latest Release section of the page and follow a series of download links,
locating a chromedriver_win32.zip file, as shown in the following image.

2. Download the zip file to a folder and extract the content.

Note: Back up the existing chromedriver.exe file prior to the copy.

3. Copy the chromedriver.exe executable to the bin folder of the App Studio installation. For
example, C:\ibi\AppStudio82\bin.
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Procedure: How to Update MicrosoftWebDriver.exe Needed for Microsoft Edge Automation

Updates to the MicrosoftWebDriver.exe executable can be found at https://
developer.microsoft.com/en-us/microsoft-edge/tools/webdriver/.

Make sure to follow instructions in the Installation and usage section to correctly detect the
build number of your Windows OS.

1. Once you have detected the build number, select a download link to a version of
MicrosoftWebDriver.exe that matches the build number. For example, if the build number
is 10586, then click the Release 10586 download link, as shown in the following image.

2. Download the provided MicrosoftWebDriver.msi file.

Note: Prior to running this installation file, back up the MicrosoftWebDriver.exe file in the
bin folder of the App Studio installation.

3. Run the MicrosoftWebDriver.msi file to remove the existing instance of
MicrosoftWebDriver.exe from your system.

4. Run the MicrosoftWebDriver.msi file again to install the new version.

Specify the bin directory of the App Studio installation as the destination.
For example, C:\ibi\AppStudio82\bin.
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AppendixC
Troubleshooting

The following topics explain how to troubleshoot App Studio.

In this appendix:

Troubleshooting Tips

Troubleshooting Tools

Troubleshooting Tips

Review the following tips when troubleshooting App Studio.

Updated Browser Issues

Newer browser versions may not immediately work with App Studio. In this case, the Selenium
support modules included with App Studio can be updated manually and may resolve the
issue. Selenium is a suite of tools specifically for automating web browsers.

1. Go to the http://seleniumhq.org/download web site.

2. Under the Selenium Client & WebDriver Language Bindings section, look for the C# line and
click the Download link to the ZIP file.

3. Unzip the file on the desktop machine.

4. Backup the WebDriver.dll and WebDriver.Support.dll files in the AppStudioxx\bin folder.

5. From the net40 folder in the unzipped file location, copy the WebDriver.dll and
WebDriver.Support.dll files into the AppStudioxx\bin folder.

6. Restart App Studio and test the installed browser version.

If there is still a problem, open a support case.

Note: If you are using Microsoft Edge, you may need to get an updated driver from Microsoft
which is usually available on the Microsoft web site.

Tomcat Configuration Options

Since Tomcat runs as a service, Tomcat Java settings and other parameters are written into
the registry. They can be configured through the Apache Tomcat Properties window. You can
launch this from the Start menu by selecting All Programs, Information Builders, Tomcat, and
Tomcat Configuration Utility.
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If you need to adjust the Java release, click the Java tab to change where Tomcat looks for
Java components. Be aware that Tomcat 8.0 requires Java 7 or later.

Note: Tomcat 8.0 requires Java 7 or later. If Tomcat 8.0 is configured to use Java 6, JSP page
compilations will fail. To fix this, update the paths to point to the jvm.dll file of a supported
Java version.

Java Memory Issues

If the App Studio installation configured Tomcat for you, the Tomcat Java VM memory settings
are automatically increased. This is done because default application server Java VM memory
options may not be sufficient for some WebFOCUS features. If you need to troubleshoot further
or if you manually install Tomcat or another application server, you may need to manually
increase the Java VM memory options.

The most common Java VM options you need to set involve the size of the Java heap and
stack, which determine memory availability for Java programs and the Java VM. Errors can
occur if not enough memory is available, and the heap size impacts performance, since it
determines how often garbage collection occurs.

The following are the most common Java VM options related to memory settings. Replace the
### with the size you wish to set:

-Xmx###M

Sets the maximum Java heap size. It is common to make this 1/4 of the system RAM.

-Xms###M

Sets the initial Java heap size. It is common to make this 1/8 of the system RAM.

-Xss###M

Sets the Java thread stack size. You do not need to set this unless you are fine tuning
your environment.

The size is normally set in megabytes, for example:

-Xms256M
-Xmx512M

Optimum sizes vary depending on your total memory, the needs of your application, how many
other processes require memory, the type of Java VM, and other considerations. A good
starting place is to set the minimum to 1/8 of the total RAM and set the maximum to 1/4 of
total RAM.
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Where to set these and other Java VM options depend on your application server.

For Tomcat on Windows, you can set these options using the Apache Tomcat Properties
window.

1. From the Start menu, select All Programs, Information Builders, Tomcat, and Tomcat
Configuration Utility.

2. Click the Java tab.

3. In the Initial memory pool (-Xms) field, specify the initial Java heap size in megabytes.
For example:

256

4. In the Maximum memory pool (-Xmx) field, specify the maximum Java heap size in
megabytes. For example:

512

5. Click OK.

6. Restart Tomcat.

For other application servers, refer to your application server documentation.

Starting App Studio

On rare occasions, App Studio may fail to initialize correctly. If this happens, you can start the
product in safe mode, or close the product manually.

Starting in Safe Mode

App Studio may fail to initialize correctly if a problem occurred during the previous close. In
rare cases, a file in the Configured Environments tree can remain persistent when it should
have closed. A file in this state will attempt to transact with the server before the application is
fully initialized.

Starting App Studio in safe mode initializes the product with its environments only.

1. In your windows start menu, navigate to the Information Builders section. Immediately
below WebFOCUS App Studio is WebFOCUS App Studio (Safe Mode). Click the Safe Mode
option.

Alternatively, you can navigate to the folder where App Studio is installed. Open a command
prompt and type appstudio-s.

App Studio opens with the environments displaying in the Configured Environments tree.

2. Double-click to expand the environment. Navigate to your content as needed.

C. Troubleshooting
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A file that remained persistent after the previous close will be able to transact with the
server without conflict. A file in this state will close normally the next time you close App
Studio.

After starting in Safe Mode, you may work normally in App Studio. The next time you start
App Studio, you can use the normal WebFOCUS App Studio option.

Closing Manually

If starting App Studio in safe mode fails to initialize the product, it may be that the underlying
AppStudio.exe process did not terminate correctly during the previous close. In this case, you
can manually end the AppStudio.exe process.

1. Press Ctrl + Alt + Delete and choose Task Manager.

2. Click the Processes tab.

3. Find and select an AppStudio.exe Image Name if it appears.

Note: You can click the Image Name column to sort by name.

4. Click End Process.

5. Start App Studio normally.

Manual Registration to Enable Multiple Browser Support in App Studio

Developers can use Chrome™, Firefox®, Internet Explorer®, Edge®, or the internal viewer when
running reports. To use Chrome or Firefox, the product requires registration of the
IBIWebBrowserDrivers_dotnet_35.dll .NET module that is included with the product.

To register this file, .NET version 4.0 is required. This version of .NET is preinstalled on most
machines. If your machine does not have this .NET version, it will be installed during the App
Studio installation process and the module needed to support multiple browsers will get
registered.

In a few cases, on Windows 8.1 machines where the registration of the module fails, the
developer will not be able to switch browsers. To address this issue, the developer must
register the required module manually. To do this, open a Command Window, with the option
Run as administrator, and run the following commands:

%SystemRoot%\Microsoft.NET\Framework64\v4.0.30319\RegAsm
C:\ibi\AppStudio82\bin\ibiwebbrowserdrivers_dotnet_35.dll /u

A message should display that the file unregistered successfully.

Then run:
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%SystemRoot%\Microsoft.NET\Framework64\v4.0.30319\RegAsm
C:\ibi\AppStudio82\bin\ibiwebbrowserdrivers_dotnet_35.dll

A message should display that the file registered successfully.

where:

%SystemRoot%

Is the location of the Windows folder on your machine. This includes the drive and path. It
is usually the C drive. For example, C:\Windows.

Note:

Adjust the above commands based on location of the App Studio installation location.

The commands in the documentation are shown in two separate lines, but they should be
issued as one command.

Troubleshooting Tools

Tools to troubleshoot App Studio are available in the WebFOCUS Administration Console, App
Studio program folder, and Reporting Server Console.

Accessing the Verification Tools in the WebFOCUS Administration Console

To run the verification tools installed with the WebFOCUS Administration Console, access the
console.

Procedure: How to Access the WebFOCUS Administration Console

1. Ensure that Apache Tomcat and/or IIS are started. 

2. From the Windows Start menu, select All Programs, Information Builders, WebFOCUS 82
App Studio, WebFOCUS App Studio Utilities, and then click WebFOCUS Administration
Console.

If you are using Apache Tomcat standalone, you can also go to:

http://localhost:8080/ibi_apps/console/webfocusconsole.jsp

For IIS with Tomcat, you can go to:

http://localhost/ibi_apps/console/webfocusconsole.jsp

C. Troubleshooting
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The WebFOCUS Sign In page opens, as shown in the following image.

If the WebFOCUS Sign In page does not appear, ensure that your web server is started. If
the web server is started and this page does not appear, you may need to manually
configure the web server.

3. Sign in using an administrator user ID. The initial default user name and password is
admin.

The WebFOCUS Administration Console opens, as shown in the following image.

Using this console, you can edit various configuration settings. Information about the
various settings in this console can be found by clicking Help. The WebFOCUS
Administration Console contains a verification tool to further test the configuration.
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4. Click Diagnostics, as shown in the following image.

Several tests are available from the Diagnostics tab. 

Testing the WebFOCUS Client

Click Client Verification to verify the client configuration settings.

A page similar to the following image appears on the right with a list of tests. The list varies
depending on your license and configuration. For a Tomcat standalone configuration, the
web/app server tests may not appear. 

If a test fails, a Possibilities link appears providing information on what the problem might be
and possible solutions. The verification tools are only supported with Internet Explorer, and you
may receive errors if you use other browsers.

C. Troubleshooting
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Procedure: How to Test the WebFOCUS Reporting Server

1. Click the Configuration tab and then expand the Reporting Servers and Server Connections
nodes.

2. Right-click the desired Reporting Server and select Test.

The Test sub menu is displayed, as shown in the following image. 

You can test the following areas:

TABLE Request. A new window opens, displaying the results of your test.

GRAPH Request. Returns information about server-side graphics (SSG). The
information that is displayed depends on whether SSG_EXTERNAL=YES (process-
based) or SSG_EXTERNAL=NO (thread-based).

Stored Procedure. The Remote Server Connection Test page opens, displaying the
results of your test.

For more information, see the WebFOCUS Security and Administration guide.

App Studio Trace Utility

The App Studio trace utility (Communication Layer Trace) generates trace files for tasks
performed by the App Studio development environment communication layer. It captures
information for tasks performed by App Studio when a request is submitted or retrieved by the
product. 
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You can use this utility to help troubleshoot issues, such as communication failures,
connection problems, and transfer of files.

To generate traces for issues you might encounter at startup, you should start the trace utility
prior to launching App Studio.

To generate traces for a failure to connect to a Data Server or to determine why applications
are not listed, you should start and enable the trace at the point prior to performing the task
that fails.

Procedure: How to Use the Communication Layer Trace

1. Launch the Communication Layer Trace from the Windows Start menu by selecting All
Programs, Information Builders, WebFOCUS 82 App Studio, WebFOCUS App Studio Utilities,
and Communication Layer Trace.

The Communication Layer Trace tool opens, as shown in the following image.

2. Click the On radio button to enable tracing.

3. The Trace File field indicates the location and name of the trace file. The default trace file
is created in the following location for Windows 7:
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drive:\Users\user_id\AppData\Roaming\Information Builders\
wfscom.xml

where:

user_id

Is your Windows user ID.

Note: The Application Data directory may not be visible by default. To see this directory,
open Windows Explorer, click Tools, choose Folder Options, and select the View tab. Then
select Show hidden files and folders and click OK.

4. In the Trace Levels area, keep the default All levels to capture all required information or
specify a specify level.

WebFOCUS Reporting Server Traces

You can turn WebFOCUS Reporting Server traces on when you start the server or dynamically
after the server has started.

To start the server with traces, you should start it before App Studio by selecting All
Programs from the Start menu, then Information Builders, WebFOCUS 82 App Studio,
WebFOCUS Server for App Studio, Diagnostic Functions, and Start Security OFF with Traces.

To turn traces on dynamically, access the Server Console and select Workspace,
Diagnostics, and Traces.

Note: Viewing traces is only available to a server administrator. 

You can use the Reporting Server Console to view server traces, as well as turn them
dynamically on or off for a running server.

If tracing is set to off and it was never turned on, the page shows that no traces are available
and enables you to turn traces on. If tracing is on, the page displays the available traces in
drop-down boxes. Which traces are available depends on what requests were made against the
server.

To turn traces on dynamically, click Enable Traces. Be aware that a dynamic trace is not the
same as turning traces on at server startup. A dynamic trace is usually not sufficient for
following a problem through with Customer Support, but it may suffice for other purposes, such
as seeing how something is parsed.

Note: The default for tracing is to trace all components when tracing is turned on. However,
the trace settings file (ibitrace.fex) may have been altered. Therefore, components that you
expect to be traced may not be traced.
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Procedure: How to View a Trace File

1. Open the Web Console by selecting All Programs from the Start menu, then pointing to
Information Builders, WebFOCUS 82 App Studio, WebFOCUS Server for App Studio, then
clicking Web Console.

2. Click the Workspace tab.

3. In the left panel, expand the Logs and Traces folder.

4. Double-click Traces, or right-click Traces and click View.

A list of traces displays in the right panel.

5. Right-click a specific trace file and then choose from the following options:

View. Displays the trace in the right-hand browser pane.

Open or Save. Enables you to open the trace in a local editor or to save it to a local
disk.

Delete. Deletes the selected trace.

The file opens, or is deleted, according to the option you choose.
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Objects group 475

Reports group 466

components

inserting 684

Compute calculator 191

computed fields 185

computed fields in Synonym Editor 185

concatenate data sources 322

conditional branching 452, 453

-IF ... GOTO command 452, 453

conditional joins 278, 283

creating 283

Conditional styling 324

conditions

actions 607

cache processing 610

creating 606
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conditions

multiselect operator 608

new 606

parameter compare operators 610

resolving parameters 609

Configured Environments tree 87, 89

Content node 94

Data Servers node 90

opening files 102

source code management 945

Web Applications node 98

Projects node 92

Controls group 478, 688

Controls tab

Controls group 478

controls

chaining 591, 601

settings 562

creating expressions 305

creating filters 187

creating joins 281

creating new projects 114

creating procedures 435

creating temporary fields 185

creating virtual fields 185

creating virtual measures with COMPUTES 209

CSS (cascading style sheets) 329

Cube data sources in Synonym Editor 206

custom procedures 538

customizing keyboard shortcuts 62

customizing the Quick Access Toolbar 60, 61

D

data access 222

levels of 221, 222

data encryption 225

data profiling 174, 175

statistics 175

data security 213, 218, 219

access levels 221, 222

central Master File 224

COMBINE command and 224

encrypting Master Files 225

encrypting segments 225

JOIN command and 224

passwords 221

Data Servers 90

data source 137

data source stacks

writing to data sources 716

data sources 213

joins 441

access control 222

joining 281

joins 280

security 219

Data tab 358

Calculation group 358

Forecast group 361

Guided Reports group 364
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data visualization 389

Data Visualization dialog box 389

DBA (database administration) 213

DBA Pane 216

DBAFILE attribute 224

debugging 993

Declarations comment 716

decrypting Master Files 218

default report styling 332

default WebFOCUS StyleSheet

applying 331

Deferred Report 83

DEFINE command

joins 279

DEFINE field for OCCURS 198

deleting a field from group fields 196

deleting dimensions or parent/child hierarchies

209

deleting group field from segment 196

deleting measures 209

deleting passwords 217

Derby Security database 31

developing models 405

diagnostic tools 999

App Studio 1000

WebFOCUS Reporting Server 1002

Dialogue Manager 434, 449

messages 451

processing 450

looping procedures 454

Dialogue Manager 434, 449

stacked commands 450

directories 32

display options 48

Document canvas 77, 556, 703

documents 463, 681–683

adding pages 689

creating 683

creating .fex documents 682

creating page masters 693

creating table of contents pages 691

inserting components 684

inserting controls 688

output options 683

post-processing 702

pre-processing 702

Domains 94

Domains node 94, 226

double-head slider control 487

Drill Down dialog box 338

drill-down procedures 338

hyperlinks 391

Drop Down List Properties window 490

drop-down lists

multiple values 490

dynamic values 530, 536

populating fields 541

retrieving 538–540

sorting 536
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E

editing existing environments 114

editing field names and titles 207

editing source code 979

editing titles for multiple languages 208

embedded procedures 492

embedding style sheets 328, 330

ENCRYPT command 225

ENCRYPT parameter 225

encrypting Master Files 218

encrypting procedures

in Master Files 225

END command 716

ENDCASE keyword 716

environment settings 104

Environments Detail panel 115

Environments tab 57

Environments Tree panel 86, 87

Environments Tree toolbar 87

sorting information 87

environments

adding 104

Data Server properties 113

editing 114

Local Machine properties 109

logging on 106

Project Development properties 113

Web Component properties 110

Esri HTML5 Viewer 744

basemaps 746

Esri HTML5 Viewer 744

color line symbology 884

color point symbology 846

color polygon symbology 873

dynamic line symbology 894

dynamic point symbology 850

dynamic polygon symbology 875

geographic roles 897

interactions 907

line symbology 878

map layers 748

map widgets 769

point of interest layer 758

point symbology 838

polygon layer 760

polygon symbology 858

single image point symbology 844

single line symbology 883

single polygon symbology 863

single shape point symbology 843

size point symbology 848

symbology 838, 897

thickness line symbology 891

unique line symbology 887

unique point symbology 854

unique polygon symbology 866

visualizations 830, 897

Esri

on Premise 941

Events 556
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everything value option 529

exponential moving average 362

Expression Builder 304, 305

expressions

combining 309

creating 305

External Tools tab 45

F

FANNAMES data source

using in procedures 716

field display options 48

Field tab 376, 384

active reports group 391

Break group 379

Column Type group 377

Filter group 378

Format group 386

Links group 391

Sort group 378

Specific group 387

Style group 385

fields 226

changing views 369, 373

viewing 369, 373

File/Folder Properties panel 116

Files Utility group 701

Filter calculator 191

Filter group 303

filters 187

autoprompt 311

finding text 980

Folding

responsive design 635

Forecast dialog box 362

Forecast group 361

Forecast

conditional styling 363

data visualization 364

exponential moving average 362

linear regression analysis 362

simple moving average 362

Format tab 342

Features group 353

Navigation group 347

Output Types group 342

formatting text 470, 686

bulleted lists 471, 686

nested lists 472, 687

numbered lists 471, 686

full-screen data entry 457

functions

editing 716

viewing source code 716

G

General tab 45

generating ad hoc reports 411
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global variables 450, 457, 460

naming 458

querying 461

group field attributes 196

Grouping Tab 383

Guided Drill Down 340

Guided Report pages 364, 365, 463, 465, 681

adding buttons 502

adding controls 502

adding text 502

creating 465

Guided Reports 365

parameters 366

H

handles 129

headings and footings 543

Help 86

Help Configuration tab 57

Help Wizard 38, 81, 82

Home tab 74

Consoles group 74

Content group 74, 75

Modeling group 80

Utilities group 74, 77

View group 74, 81

Window group 74, 82

HTML canvas 77, 556, 703

adding tree controls 492, 493

auto chain controls 590

HTML canvas 77, 556, 703

automatic chaining 590

chaining controls 589, 591, 601

controls 589

double-head slider control 487

embedded procedures 492

Parameters tab 589

HTML pages 463, 464, 681

adding buttons 502

adding charts 467

adding components 466, 467

adding controls 502

adding reports 467

adding text 502

adding tree controls 492, 493, 495

animating jQuery animations 572–574

components 466, 467

creating 464

creating jQuery animations 572–574

embedded procedure 492

existing procedures 493

jQuery animations 564, 570

HTML

advanced mobile layout 666

basic mobile layout 666

designing for smartphones 660

HTML/Document Wizard 463, 681

76

create active dashboards 76

create Documents 76
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HTML/Document Wizard 463, 681

create Guided Report Pages 76

create HTML Pages 76

creating 463, 681

creating .fex documents 682

creating documents 683

creating Guided Report pages 465

creating HTML pages 464

I

IbComposer_enableHtmlElement 622

IbComposer_execute 621

IbComposer_getCurrentSelection 613, 615–618,

627

IbComposer_isSelected 621

IbComposer_ResetDownChainControls 623

IbComposer_selectTab 624

IbComposer_setCurrentSelection 620

IbComposer_showHtmlElement 622

identifying procedures in fields 226

identifying procedures in Master Files 226

ignore value option 528

Impact Analysis 226

Impact Analysis tool 226

implied prompting 457

INFER command 716

Insert tab 684

Components group 684

Controls group 688

Pages group 689

interactive data entry 457

interface components 39

Application button 41

canvas 63

Quick Access Toolbar 59

J

Java

memory issues 994

JavaScript code 611

JOIN command

data security 224

Join tab 280

Join group 280

joins 277

conditional 278, 283

creating 280, 281

customizing 284

DEFINE command and 279

tag name 287

jQuery animations 564, 570

animating 572–574

creating 572–574

K

keyboard shortcuts 62

customizing 62

L

launching the Report Wizard 231
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Layout tab 367

Page Setup group 367

Report group 368

limiting number of records read 48

limiting number of records retrieved 48

line data layer 762

linear regression analysis 362

Links group 338

local variables 450, 457, 459

naming 458

looped procedures 454

-REPEAT command 454–456

-SET command 454

looping 454–456

M

Mailing Label Options dialog box 357

MAINTAIN command 716

Maintain Data procedures 716

viewing source code 716

Managed Reporting 94

map layers for Esri HTML5 Viewer 748

map widgets for Esri HTML5 Viewer 769

maps 744

introduction 742

mask text property 489

Master Files 213, 218, 226

encrypting 225

identifying procedures within 226

Match Wizard 434

Matrix tab 401

Design mode 401

Insert group 402

Preview mode 401

Report Properties group 404

Row Properties group 404

Row/Cell group 403

View group 401

merging data sources 434

messages 451

displaying 451

Metadata canvas 137

Metadata tab

Clipboard group 140

Editing group 141

Insert group 143

Reports group 145

Tools group 145

Undo/Redo group 140

View group 142

metadata

adapter 75

password 75

rebuild 75

Miscellaneous group 502

Mobile output

viewing 672

Modeling group 80

Modeling tab 405
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multilingual titles and descriptions in Synonym

Editor 173

N

naming 458

navigating procedures 451

branching 451, 452

looping 454

new environments 104, 106

nodes

inserting 143

normal embedded styling 330

O

OCCURS repetitions in a DEFINE field 198

Open dialog box 43

outliers 175

output formatting 48

Output Viewer Settings tab 58, 59

outputs 343

setting 343

P

page layout

adding overflow pages 695

flow margins 695

inserting dashboards 697

page masters

creating 693

using in another document 693

Pages group 689

panels 128

auto hide 129

customizing 129

docking 129, 130

floating 129

hide 129

pinning 129

unpinning 129

parameter values 460

querying settings 460

adding filters 536

creating 516

custom procedures 538

default 546

duplicate values 537

dynamic 530, 533, 536, 538, 546

everything value option 529

from a procedure 529

ignore value option 528

importing 530

list options 542

Parameters (Dynamic Values) tab 530

populating fields 541, 542

sending display values 543

sorting 536

static 521, 524, 526

parameters 519

generating 366

passwords 213, 217
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pattern columns 175

point of interest layer for Esri HTML5 Viewer 758

polygon layer for Esri HTML5 Viewer 760

Positioning group 497, 698

positioning objects 497, 698

Positioning tab 497, 698

Positioning group 497, 698

Relationships group 499, 699

Responsive Design group 500

Text Alignment group 500, 700

Precision reports

accessing 259

Columns palette 269

composition 276

creating precision reports 272

Data Matrix layer 273

embedded fields 274

Fields tab 270

heading/footing objects 274

Layers tab 267

matching output to a preprinted form example

276

Navigate tab 271

page layout 273

Positioning tab 263

Properties tab 271

Sort Groups tab 268

tabs 266

Tools tab 261

usage notes 260

preferences 45

Preview group 503

Procedure View panel 427

Procedure view

order of components 435

procedures

allocation 432

branching 451

charts 431

components 428

creating 435

define 430

define function 431

editing source code 979

execute 432

HTMLForm 433

joins 431

looping 454

match 433

navigating 451, 452

prompting 457

reports 429, 436

running 450

scheduling 98

set 431

use 432

variables and 457

branching 452

processing Dialogue Manager procedures 450

project-based development 34
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Projects 114

prompting for variable values 457

Properties and settings dialog box

unbound parameters 523

bound parameters 524, 533

dynamic values 530

Properties panel 556

Autosize Children 557

Properties toolbar 557

Q

Quick Access Toolbar 59

adding commands 61

customizing 61

R

read limits 48

read-only access 221

read/write access 221

records 48

selecting 309

Relationships group 499, 699

remote development 36

replacing text 980

Report canvas 76, 231, 232

fields 376, 384

report display options 48

Report group 316

Report Painter

formatting options 381

Report tab 303

Filter group 303

Links group 338

Report group 316

Style group 324

Traffic Lights group 324

Report Wizard 76

creating SQL reports 419

creating reports 231, 232

creating SQL reports 233

ReportCaster 83

reporting server 31

Reporting Server Console 83

Reporting tab 45, 48

reports 401, 402

adding to HTML pages 467

procedures 436

adding borders 333

creating 231, 232

data visualization 389

embedding style sheets 330

filters 378

formatting 381

including StyleSheets 299, 328

joining files 277

joins 277

layouts 367

manipulating mathematical data 358

mathematical data 358

modifying 303
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WebFOCUS App Studio User’s Manual  1017



reports 401, 402

output 342

setting width options 337

sorting 378, 381

requests 577

executing 565

Responsive Design group 500

Responsive

add objects to widgets 645

add/remove widgets 645

animate controls 649

BI portal 657

containers folding 635

controls, first row only 656

convert to responsive 654

custom layout 651

flow direction 636

folding 635

folding diagram 635

HTML canvas 639, 652

load widget at run time 650

methods 638

new content 653

output widget 638

page-level controls 647

panel sizes 649

populating widgets 644

selecting a template 642

template 638, 640

template diagram 640

Responsive

tips 658

web design 635

widget 638

widget-level controls 648

RESTRICT attribute 222

SAME option 222

SEGMENT option 222

VALUE option 222

retrieval limits 48

ribbon 73

organization 73

RStat 80, 405

developing models 405

S

sampling functionality 407

Save As dialog box 44

Save StyleSheet 332

scheduling 98

scheduling procedures 98

securing data 213, 218

securing data in Master Files 213

security 218, 219

ACCESS 219

access levels 221, 222

encrypting data segments 225

encrypting Master Files 225

identifying users 220, 221

passwords 220, 221
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security 218, 219

storing DBA information centrally 224

segments

encrypting 225

Selection Required 747

Server Console

troubleshooting 1002

server diagnostic trace files 1002

SET parameters 220

PASS 220, 221

USER 220, 221

setting output types 343

setting preferences 45

Settings panel 562

conditions 604

SHOW keyword in Winform command 716

side-by-side development 72

simple moving average 362

single column 175

Smart phones

advanced mobile layout 666

basic mobile layout 666

Smartphones

designing HTML output 660

Sort tab of Field Properties dialog box 381

Sorting Tab 381

sorting

reports 381

source code for procedures 716

Source code management 945

source code

editing 979

SQL reports 233, 419

creating 419

importing 421

creating 233

importing 235

stacked commands 453

stacks

writing to data sources 716

Startup Options 45

static parameters 522

importing 530

static values 521, 524, 526

adding 524

importing 526

Report canvas 526

statistical variables 450, 457

querying 461

Style Composer 585

background properties 586

edge styles 588

font styles 585

interface effects 589

layout styles 588

list styles 588

position mode 587

text styles 587

Style File Selector 332

Style group 324
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style menu 85

style sheets

embedding 328

StyleSheet File Selector 328

symbology for Esri HTML5 Viewer 838

symbology for lines 878

color 884

dynamic 894

single 883

thickness 891

unique 887

symbology for points 838

color 846

dynamic 850

single image 844

single shape 843

size 848

unique 854

symbology for polygons 858

color 873

dynamic 875

single 863

unique 866

synonym 137

adapter 137

creating 137

editing 137

enhancing 137

uses 136

synonyms

using variables 202

virtual columns 183

syntax color 716

system variables 450, 457

T

table of contents pages

creating 691

objects 692

table of contents

adding 348

disabling 348

Tasks & Animations panel 564

Animations section 570

Tasks section 565

Template group 502

temporary fields 185

Text Alignment group 500, 700

text boxes

masked text 489

text editor 979

Text Editor 98

Text Editor tab 979

Bookmarks group 982

Case/Comment group 983

Find group 980

Options group 984

Tomcat

Java configuration 993
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Tomcat

troubleshooting 993

Top function 716

tracing 997, 1000

App Studio 1000

WebFOCUS Reporting Server 1002

Traffic Lights group 324

tree controls

multi source 494

troubleshooting

App Studio 993

servers 1002

tools 997

U

unbound parameters 519, 522

adding 519

unconditional branching 451, 452

-GOTO command 451

-GOTO command 452

update access 221

usage notes stylesheet 332

USER attribute 220, 221

user defined functions

creating 437, 439

Utilities group 77

utilities in App Studio

Communication Layer Trace 1000

Utilities tab 501, 700

active reports group 501

Utilities tab 501, 700

Chaining group 501, 701

Files Utility group 701

Miscellaneous group 502

Preview group 503

Template group 502

View group 504, 703

V

value columns 175

values

querying 460, 461

supplying 457

variable types 450

amper 457

global 457, 460

local 457, 459

statistical 457

system 457

global 450

local 450

statistical 450

system 450

variables 457

procedures and 457

querying 460, 461

substitution 457

verification 999

automatic 999

WebFOCUS Reporting Server 1000
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View group 81, 504, 703

View tab 369, 373

viewing items based on type 87, 116

Viewing mobile output on a smart phone 672

Virtual Column calculator 191

virtual columns

creating 183

virtual field attributes 189

virtual field for OCCURS 198

virtual fields 185, 279

defining 437

joins 279

visualizations for Esri HTML5 Viewer 830

W

WebFOCUS Administration 83

WebFOCUS Administration Console

accessing 997

verification tool 999

WebFOCUS client 31, 113

properties 113

testing 999

WebFOCUS environment

properties 106

WebFOCUS environments 103

WebFOCUS Environments 89

WebFOCUS Reporting Server 1000

connection 1000

testing 1000

tracing 1002

WebFOCUS RStat 80, 405

developing models 405

WebFOCUS

architecture 30

components 30

configuration 31

network connections 30

Window group 82

windows 45

startup options 45, 57

Winform command 716

write-only access 221
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Feedback
Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented
individuals who work together to design and deliver quality technical documentation products.
Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and
services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor,
Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino,
Vice President, Technical Content Management at Frances_Gambino@ibi.com.



Information Builders, Inc.
Two Penn Plaza
New York, NY 10121-2898
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